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WHAT’S NEW FOR SERVICEMAX SPRING ’14 (MARCH
2014)

The ServiceMax Spring '14 release consists of the following new features and enhance-
ments for ServiceMax Suite, ServiceMax Mobile for Laptops, ServiceMax Spring ‘14 for
iPad, and the new ServiceMax Spring ’14 for iPhone app. If you would like to see the list of
new features in the previous release Winter '14, go here:What's New for Winter 14?

ServiceMax Suite
Spring '14 features and enhancements for the ServiceMax Suite application are described
below.

QuickBooks Export

ServiceMax customers can now extract ServiceMax data easily and import into Quick-
Books™, without using a middleware tool. The ServiceMax QuickBooks Export feature
enables export of work orders that are ready to be billed in IIF format, which is a pro-
prietary QuickBooks format. The exported data can be directly imported into QuickBooks
for billing.

For more information about this feature see,QuickBooks Export.

Reports and Analytics Enhancements

24 new reports have been added for the most common business scenarios. These reports
have been organized under new folders by purpose.

For more information about this enhancement see, Dashboards and Reports.

Scheduled SFM

The Scheduled SFM feature enables automatic execution of SFM Transactions at defined
intervals for qualifying records, without any manual intervention. This is useful when auto-
matic execution is required for a large volume of records frequently.

For more information about this feature see, "Scheduled SFM" on page 363.
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SFM Designer Enhancements

Qualifying Criteria and Mapping sections have been repositioned as horizontal tabs,
for more effective utilization of screen area

Field and Value Maps show only the Mapped fields by default, with option to toggle
between Mapped fields and All the fields

SFM Search Delivery Enhancements

SFM Search is now delivered with a new look and feel using a UI based on HTML5. Some of
the salient aspects of the new UI are as follows:

Search results can be viewed in horizontal tabs or vertical tabs, with option to toggle
between these views

When a search result is selected, the applicable SFMWizards are also delivered using
HTML5

Option provided to find the required SFM Search(es) through keyword search

Inline sorting of results on clicking the column header and freezing of columns is now
possible

Dispatch Console Map Enhancements (Pre-release)

Dispatch Console uses The Google Maps API for Flash for plotting routes of technicians and
locations of work orders and technicians. As The Google Maps API for Flash has been
deprecated and will work only until September 2, 2014, Dispatch Console Map is being
enhanced to use Google Maps JavaScript API v3.

Dispatch Console Map enhancements are related to the phased migration from Flash-
based map (referred to as Flash Map) to JavaScript-based map (referred to as JS Map)
starting from the Spring ’14 release of ServiceMax.

Following is the list of enhancements implemented in JS Map, which are not available in
Flash Map:

What’s New for ServiceMax Spring ’14 (March 2014)
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What’s New for ServiceMax Spring ’14 (March 2014)

Personalization of map width

Option to select traffic as an overlay option

Show Route enhancements including sequential numbering of stops for better visu-
alization of technician route and plotting the route for the rest of the day

For more information about this feature enhancement, see "JavaScript Map View" on
page 941.

Community Support

The following additional features are available for Partner and Customer Community
users: SFM Transactions of all types except Output Documents, Stock Lookup feature, and
all the custom Salesforce buttons and links included in the ServiceMax package.

ServiceMax Mobile for Laptops
Spring '14 features and enhancements for ServiceMax Mobile for Laptops are described
below.

Translation Workbench

ServiceMax Spring 14 for iPad application now supports the ServiceMax Translation Work-
bench. With this, translations defined in server for titles, description, and validation mes-
sages configured for SFM Transactions, SFMWizards, and SFM Search are displayed in the
Laptop App after configuration sync.

For more information about this feature, see "ServiceMax Translation Workbench" on
page 497.

Attachment and Sync UI Enhancements

Attachment handling and Sync UI are enhanced in ServiceMax Spring ’14 Mobile for
Laptops. Attachment support includes displaying additional file attributes in the Attach-
ments tab, the option to delete attachments, and an error message that displays when a
user tries to upload files that exceed 5MB. Sync UI enhancements consist of an enhanced
status bar (Progress indicator and status messages) and the ability to stop and resume
data and config sync.

ServiceMax Mobile for Laptops 35



ServiceMax Spring ‘14 for iPad
Spring '14 features and enhancements for ServiceMax Spring '14 for iPad are described
below.

Translation Workbench

ServiceMax Spring 14 for iPad application now supports the ServiceMax Translation Work-
bench. With this, translations defined in server for titles, description, and validation mes-
sages configured for SFM Transactions, SFMWizards, and SFM Search are displayed in the
iPad App after configuration sync.

For more information about this feature, see "ServiceMax Translation Workbench" on
page 497.

iPad Memory Optimization

With optimized memory handling, initial sync for complex implementations now gets com-
pleted successfully in 512 MB RAM iPads, without any issues related to insufficient
memory. This is true for both iPad 2 and iPad Mini.

Configurable Signature Size

This enhancement to Smart Documents enables configuration of signature size in Output
Documents Designer in the server, and rendering the signatures as per the configured size
in the iPad Mobile App. If not configured, the default values considered for height and width
are 186px and 350px respectively.

Data Purging

This feature enables purging of old records in the local database at regular intervals from
the iPad App, to ensure that the database stores only the relevant data and does not keep
growing in size, taking up space on the device. Till this release, the only way to purge old
data from the app’s local database was to do a Reset App.

For more information about the configuration options for this feature, see "Mobile Con-
figuration" on page 514.

What’s New for ServiceMax Spring ’14 (March 2014)
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What’s New for ServiceMax Spring ’14 (March 2014)

New App: ServiceMax Spring ’14 for iPhone
With the release of the new ServiceMax Spring 14 for iPhone app, ServiceMax support for
Smart Phones is now being introduced, starting with iPhones. This is a “lite” application
that includes these key features: Initial sync, Calendar View with Day View and Month
View, Viewing records and related records, Work Order Summary View including integ-
ration with native iOS features SMS, Phone, and Map, Rescheduling events, and Aggress-
ive and Manual incremental sync. Server configuration for iPhone App is similar to that for
iPad App, and is achieved using the "Mobile Configuration" on page 514 screen. This is
a fully native iOS app, which is supported on iPhones with iOS versions 7 and above.
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SERVICEMAX SPRING '14 (MARCH 2014)

About ServiceMax Suite
ServiceMax Suite is the first and only complete on-demand solution for post-sales service,
field service, and strategic service chain management. Built and delivered as a native
Force.com cloud application, the product gives you complete functionality to accurately
control, monitor, and track all the activities a field service organization performs. With Ser-
viceMax Suite, you are up and running quickly with a simple pay-as-you-go software-as-
a-service (SaaS) model. Visit ServiceMax to learn more about the modules and features
of ServiceMax Suite.

Language Support
ServiceMax Suite offers language support for Chinese (Simplified), French, Portuguese
(Brazilian), Chinese (Traditional), German, Japanese, Korean, Spanish, Italian, and Dutch.

To activate the language translation for one of the languages mentioned above, your
administrator must enable the Salesforce Translation Workbench and activate support for
the desired language.

About this Document
This document is intended to be a complete reference for administrators and end users of
ServiceMax Suite. End users include service desk operators, service managers, tech-
nicians, and service partners. This document details the standard functionality of all Ser-
viceMax features. Please contact ServiceMax professional services or your ServiceMax
administrator to learn about any custom functionality built during your ServiceMax rollout.
Typically, custom functionality includes workflow rules, approval processes, and custom
screens and fields specific to your business.
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Note: ServiceMax makes every effort to ensure the accuracy of the inform-
ation contained within this documentation, but assumes no responsibility or
liability for any errors or inaccuracies that may appear. If you do find any
errors or inaccuracies, please send your feedback to docfeed-
back@servicemax.com.

Copyright 2014 ServiceMax, Inc. All Rights Reserved.

Designated trademarks and brands are the property of their respective owners.

ServiceMax Spring '14 (March 2014)

40 About this Document

mailto:docfeedback@servicemax.com


SERVICEMAX SUITE INSTALLATION

Getting Started

Signing Up

In order to register as a ServiceMax user, your organization must first sign up for an appro-
priate edition of the Salesforce application. You can also sign up for a trial edition of Ser-
viceMax that is valid for a stipulated period. Please note that features included in your Trial
Edition many not be available in the ServiceMax Edition you select to purchase. To learn
about how to manage your Trial Edition data and users, see the Salesforce application user
guide on Salesforce.com.

Logging In

Your Salesforce administrator must first add you as a Salesforce standard user and grant
access to you to ServiceMax features. When your Salesforce profile is set up, you will
receive an initial e-mail with your user name and password. The password must be
changed upon your first login.

Prerequisites

In order to use ServiceMax modules effectively, familiarity with the standard capabilities
of the Salesforce application would be an added advantage, including navigation, cre-
ating/updating/deleting records, creating reports, using dashboards. To become familiar
with the Salesforce environment, visit Salesforce.com education on the web (select Ser-
vices, then Training) and use the interactive introductory online presentations.

Using the Application

Since ServiceMax is a native application (built and hosted entirely on the Force.com plat-
form), with the Salesforce web-based interface, you can enter and find data at various
points. As a ServiceMax user, typically you start at the Home tab and preview your day’s
events and tasks, and also view your critical activities such as Down Customers. You can
select one of the tabs to add, edit or review information, from the Home tab.
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Entering Data

Entering data in ServiceMax is much like entering data in any web page or in the standard
Salesforce application. Required fields are marked in Red. All other fields are optional and
may be left blank. If in doubt about the impact of leaving a field blank, see the User Guide
section that describes the specific application module.

Accessing Data

Your administrator can customize many different areas to secure your data. Additionally,
users in Salesforce Professional, Enterprise, Unlimited, and Developer edition organ-
izations can control the access that other users have to their data, by sharing records indi-
vidually with colleagues. See the online documentation on Salesforce.com to understand
the levels of permission required for various types of accessibility.

Navigating

You can navigate between pages and select options using standard text and button links.
On individual pages, you can also edit or update information using standard text fields,
picklists, and popup menus. The Case and Installed Product modules have special nav-
igation capabilities that are described in detail in the respective sections.

Using the Salesforce Help & Training Window

The Salesforce Help & Training window includes the resources you need to be successful
with the Salesforce application. You can find answers to your questions by typing
keywords in the search area or by navigating through the index on the left. You can also
download Tip sheets and best practice guides from the Help & Training window.

Note: ServiceMax assumes no responsibility or liability for any errors or inac-
curacies that may appear in the Salesforce Help & Training window. If you do
find any errors, please send your feedback to docfeed-
back@salesforce.com.

ServiceMax Suite Installation
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SERVICEMAX PROCESSES

To maximize the benefits from the ServiceMax implementation, your support and service
organization is required to have a good understanding of the business processes sup-
ported by ServiceMax. Once you have purchased ServiceMax, one or more of the following
processes are available to use:

Installed Base (IB), Warranty, and Service/Maintenance
Contracts

Figure 1: IB, Warranty Terms, and Service Contracts Processes

ServiceMax offers multiple ways to create and manage information about Installed
Products providing on-demand Entitlement Checks.

1. Configure a back-office Enterprise Resource Planning (ERP) application, like Oracle or
SAP to send processed shipment information at regular intervals to ServiceMax.

2. Configure Installed Products with ServiceMax's easy-to-use and rich user interface.

3. Locate IB data in Salesforce. Installed Product information is displayed in a hier-
archical tree-structure so that users have a snapshot view of the product’s con-
figuration and status of every component in the tree.
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Warranty Terms can be linked to individual part numbers or a group of products identified
by Product Family or Product Line. When an Installed Product record is created, warranty is
calculated automatically based on the warranty terms defined.

The Service/Maintenance Contracts module can be used to manage extended Service
Agreements for Serial or Lot, tracked as well as non-tracked items. Coverage in Ser-
vice/Maintenance Contracts can be based on a group of Products (identified by product
family or product line), Part Numbers, Installed Products, Customer Contacts, Locations,
and Service Types. An existing contract can also be renewed easily by a click of a button.
At renewal stage, users can retain all coverage details as is or modify some or all of the
coverage details.

ServiceMax Entitlement Verification is an intelligent collaboration of automation and
informed decision-making. After the product and customer are identified on a support
case, all available warranties and Service/Maintenance Contracts are displayed to the user
in a grid format. Users can then select the relevant warranty or service/maintenance con-
tract to entitle the customer.

The complete history of Service entitlements made to customers is tracked automatically
in ServiceMax. With the help of the powerful dashboards and reports, management users
can quickly learn the history of customer entitlements, grouped by products, regions, cus-
tomers and contacts.

ServiceMax Processes
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ServiceMax Processes

Parts Orders

Figure 2: Parts Orders Process

Returned Material Authorization (RMA) is an important transaction to authorize inbound
receipt of products returned by customers. RMA can be triggered from a support case
when a customer requests the return of a product for service/repair, or from a Work Order
when a field service engineer concludes that a product needs to be returned for factory or
depot repair. The RMA document can be printed using a configurable template, and can be
attached to the Case or Work Order in ServiceMax. When the returned products are
received at the factory or warehouse, ServiceMax users can process each RMA itemmanu-
ally or complete an entire RMA with the click of a button.

Shipment Orders are required for all outbound products. A shipment transaction can be ini-
tiated when a customer requests a loaner or demo product, when a replacement product is
sent during the repair life cycle, or when a repaired/serviced product is ready to be sent
back to the customer. Similar to the RMA, shipment orders can be printed using con-
figurable templates. When products are ready for shipping, ServiceMax users can process
each shipment itemmanually or complete an entire shipment with the click of a button.
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Work Orders

Work Orders Process
A Work Order is used to plan, execute, and manage Service events for Field and Depot ser-
vice activities. Service order creation can be triggered from a Case or an existing service
order can be cloned to manage related service events such as field and depot activities for
the same product. Service delivery in ServiceMax consists of many sub-processes:

First, the Service order is assigned to a service group or a group member.

Second, depending upon the customer entitlement, the service engineer can prepare
an estimate of parts, time and expenses, and submit a quotation to the customer.

Third, the service engineer can request one or more parts and receive them (if
required).

Fourth, during the course of service, the engineer can record the actual usage/-
consumption of parts, labor and expenses.

Finally, the Work Order is closed by capturing details of service activity as well as ana-
lytical information.

ServiceMax Processes
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ServiceMax Processes

Inventory

Inventory Process
Inventory provides end-to-end field or warehouse inventory management. It supports
stock adjustment, stock transfer, parts requests & receipts, and maintains the complete
history of stock transactions of items across multiple locations. This module also provides
interactive stock lookup tools.

ServiceMax inventory enables capturing, monitoring and automatic updates of parts
inventory. In order to track inventory in a warehouse, repair center or field location, a
stockable Locationmust be defined. With ServiceMax, you also have the option of track-
ing product inventory with serial numbers. Stock can also be tracked based on status such
as Available, In Transit, and Consumed. The inventory is updated automatically based
on user actions in various transactions such as RMA, Shipment, Work Order, or Stock
Transfer.

Inventory 47
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TRAINING

Overview
ServiceMax offers monthly webinars for administrators and end users for all major fea-
tures of the ServiceMax Suite application. We also can provide you with individual training
sessions specific to your configuration, process, and branding.

For more information about webinars and training services for your company, contact
training@servicemax.com.
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SERVICEMAX CUSTOMER COMMUNITY

Overview
The ServiceMax Customer Community is an integral part of ServiceMax and will host all
essential training materials, product documentation, and support solutions. The com-
munity is an online destination for all of our customers to connect with other ServiceMax
customers, share ideas, and best practices.

To log into the community, click the "Customer Community" link in the left sidebar of your
ServiceMax home page. If you do not see the link, please contact your ServiceMax Admin-
istrator and direct him or her to the following install instructions: http://www.ser-
vicemax.com/community/install.html. If you have any questions about installation
or using the community, contact community@servicemax.com.
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SERVICEMAX PRIVACY POLICY

Overview
ServiceMax Inc. complies with the U.S. EU Safe Harbor Framework and the U.S.-Swiss
Safe Harbor Framework as set forth by the U.S. Department of Commerce regarding the
collection, use, and retention of personal information from European Union member coun-
tries and Switzerland.

For more information about the Safe Harbor Privacy Principles and to view the complete pri-
vacy policy statement for ServiceMax Inc., visit http://www.ser-
vicemax.com/privacy.html.
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SETUP
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SERVICEMAX SUITE INSTALLATION
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INSTALL SERVICEMAX PACKAGE

ServiceMax Package
ServiceMax functionality is delivered through an AppExchange package named Ser-
viceMax. This is a Managed-Released (MR) package built on the Force.com platform and
is installed using the standard AppExchange user interface for installing/upgrading pack-
ages. Visit AppExchange to learn more about how to install or upgrade packages.

Installation Link
Once you have subscribed to ServiceMax and you have a valid Salesforce login, the Ser-
viceMax technical support team will send the installation links to you by email. An
example of this email is shown below:

Figure 1: Sample Email with Installation Link
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Installation Steps

Note: The steps listed below are examples only. Since Force.com continues to
optimize and enhance the installation experience, the actual steps you would
see may vary. See the online package installation guide atwww.appex-
change.com.

1. Open an internet browser. To learn if your browser is compatible with Salesforce, click
the Help link within the Salesforce application and search for Supported Browsers.

2. Copy and paste the installation link into the browser’s URL.

3. Enter your login credentials.

4. In the Package Installation Details screen, click Continue.

Figure 2: Package Installation Details Screen

5. The following dialog box appears. Check the Yes, grant access to these third-
party web sites checkbox and then click Continue to view the next screen.

Install ServiceMax Package
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Install ServiceMax Package

Figure 3: Approve Third-Party Access Pop-Up

6. The next screen shows Package API access for standard objects. Click Next to pro-
ceed.

Figure 4: Package API Access Screen
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7. In the next screen, click the Grant access to all users option in the Select Security
settings section and then click Next to proceed.

Figure 5: Security Settings Screen

8. Click Install. This process may take a few minutes to complete. You will either be
notified via email or the screen will be refreshed to indicate the completion of install-
ation.

Figure 6: Install Package Screen

9. After installing all the packages successfully, navigate to Setup > App Setup >
Installed Packages. The ServiceMax installed package appears in the list of

Install ServiceMax Package
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Install ServiceMax Package

installed packages as shown below:

Figure 7: Installed Packages Screen

10. Unless you have unlimited licenses, add your user account to the ServiceMax pack-
age license. To add your user account:

a. Click the Manage Licenses link for the ServiceMax package to view the following
screen:

Figure 8: Package Details Screen

b. Click Add Users to view the Add Users screen as shown below:
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Figure 9: Add Users Screen

c. Check the Action checkbox next to your user account, and then click Add to add
the user account.

See Also:

Loading Default Configuration and Page Layouts

Verifying Installation

PM Scheduler

OptiMax Authentication

Installing Offline Client

Troubleshooting Installation Issues

Next Steps after Installation

Install ServiceMax Package
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LOAD DEFAULT CONFIGURATION AND PAGE LAYOUTS

Purpose
Most ServiceMax functionality is driven by configuration parameters. This ensures scalab-
ility of architecture and deployment of multiple service processes within an organization.
When ServiceMax is installed or upgraded, the set of configuration parameters should be
loaded to ensure smooth functioning of all modules. Loading of page layouts accelerates
the configuration process and aids in better user adoption. It automatically creates Sales-
force profiles for a typical service organization and sets up their access rights to recom-
mended levels. It optimizes the ServiceMax page layouts for use by these profiles.
Additionally, it loads some sample Visual Force templates that can be used for generating
Salesforce Reports.

Note: This applies to Production and Sandbox installations. If you create a con-
figuration-only sandbox for development/testing purposes, ServiceMax con-
figuration data is not copied automatically to the sandbox. You must load the
configuration data in Sandbox as described in the process steps below.

Prerequisites
In order to run successfully, the deployment configurator requires certain default values to
be set in your Salesforce profile.

In Settings > Company Profile > Company Information, edit the following values.

Default Locale – Set it to English (United States)

Default Language – English

Default Timezone – (GMT-08:00)Pacific Standard Time(America/Los_Angeles)

If your settings are different from the above mentioned values, you should change them
before running the configurator. You can change them back once the configurator com-
pletes successfully.
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To load default configuration and page layouts:

1. Click the configuration link from the ServiceMax welcome email, or copy and paste it
into an internet browser’s URL. The following screen appears:

Figure 1: ServiceMax Configuration Screen

2.  In the ServiceMax Configuration screen:

a. Select the type of Salesforce instance in Deploy To picklist: (Production, Sand-
box, or I have a custom Salesforce domain). If you selected I have a cus-
tom Salesforce domain, enter the custom domain in the field below.

b. Under Deployment Options:

i. To install the preconfigured user profiles and page layouts for field service,
check the Load default profiles checkbox. To install the preconfigured doc-
ument templates for Service Report, Parts Order, RMA, and so on, check the
Load VF Utilities checkbox. Use extreme caution when using these two
options on an existing ServiceMax installation. If you have modified the pre-
configured profiles, page layouts, or document templates in your installation
(not recommended), they will be completely overwritten.

ii. To load the preconfigured SFM transactions and wizards, check the Load Stand-
ard SFM Transactions and Load Standard SFM Wizards checkboxes

Load Default Configuration and Page Layouts
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Load Default Configuration and Page Layouts

respectively. These options are available to preserve the limited space avail-
able for Sandbox instances. If you leave the checkboxes unchecked, none of
the standard SFM transactions and wizards will be functional.

iii. Leave the Check Schedule Usage Collection checkbox unchecked.

c. Enter a valid Email ID. At the end of processing, the configurator will send an
email to this email ID with the detailed status.

d. Enter the ServiceMax Installation Key.

3. Click the Login with Salesforce button. The Salesforce Login screen appears:

Figure 2: Salesforce Login Screen

4. Enter your Salesforce User Name and Password, and then click the Log in to
Salesforce button. The following screen appears:
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Figure 3: Salesforce Requesting Permission Screen

5. Click Allow.

6. The following message appears while the processing is in progress. You can either
close the browser window or navigate to any other page. Upon completion of the pro-

Load Default Configuration and Page Layouts
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Load Default Configuration and Page Layouts

cess, you will receive an email with the status of processing.

Figure 4: ServiceMax Configuration In Progress Message

See Also:

Installing Packages

Verifying Installation

PM Scheduler

OptiMax Authentication

Installing Offline Client

Troubleshooting Installation Issues

Next Steps after Installation
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VERIFY INSTALLATION

Purpose
Before you start to configure and extend ServiceMax application to your organization’s spe-
cific requirements, you must make sure the vanilla application has been installed suc-
cessfully.

To verify installation:

1. Log into Salesforce.

2. Navigate to Setup > App Setup > Customize > Home > Home Page Layouts.

3. In the Home Page Layouts screen:

a. Click Page Layout Assignment.

b. Click Edit Assignment.

c. Assign Sys Admin Home to the System Administrator profile, and then click
Save. This allows you to access the ServiceMax Setup Console from your home
page.

Note: To see Sys Admin Home, the preconfigured user profiles and
page layouts must have been installed by checking the Load default pro-
files checkbox in the deployment configurator. See Load Default Con-
figuration and Page Layouts.

4. Click ServiceMax from the application list on the top-right.

5. Click the ServiceMax Setup link from the left side pane. You will see the Setup
Home page as shown below. Click any of the group buttons such as App Admin-
istration or Service Organization, click any of the options such as Modules or Sub-
modules, and then click the Go button to make sure you are redirected to the
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appropriate screen.

Figure 1: ServiceMax Setup Home

Note: This step is required to ensure the configuration data was loaded suc-
cessfully.

6. Click the Accounts tab, click New and enter sample account data, and then click
Save. Click the Products tab, click New and enter sample product data, and then
click Save. Click the Installed Products tab, click New and enter sample data, and
then click Save. On the Installed Products screen, click Create Child. You should be
able to see the screen below. Enter a product name and serial number and then click

Verify Installation
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Verify Installation

Create Child.

Figure 2: Create Child Screen

Note: This step is required to verify that the default ServiceMax Profile was
automatically associated with the System Administrator profile, and that Ser-
viceMax features are using the default configuration settings.

See Also:

Installing Packages

Loading Default Configuration and Page Layouts

PM Scheduler

OptiMax Authentication

Installing Offline Client

Troubleshooting Installation Issues

Next Steps after Installation
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PM SCHEDULER

Purpose
If your organization plans to use the Preventive Maintenance feature of ServiceMax, you
must set up a schedule to run the ServiceMax process that creates PMWork Orders auto-
matically.

To set up a schedule to run the ServiceMax process:

1. Log into Salesforce.

2. Navigate to Setup > App Setup > Develop > Apex Classes > Schedule Apex.
The Schedule Apex screen appears.

3. In the Schedule Apex screen:

a. Enter Job Name as PM_Job.

b. Select Apex Class as PREV_PMApexScheduler.

c. Click theWeekly option for Frequency and then select all the weekday options.
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d. Select the appropriate values for Start, End, and Preferred Start Time, and
then click Save.

Figure 1: Schedule Apex Screen

See Also:

Installing Packages

Loading Default Configuration and Page Layouts

Verifying Installation

OptiMax Authentication

Installing Offline Client

Troubleshooting Installation Issues

Next Steps after Installation

PM Scheduler
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OPTIMAX AUTHENTICATION

Purpose
If your organization plans to use OptiMax for advanced dispatch optimization capabilities,
you must store the OptiMax login credentials within ServiceMax for authentication. This is
used when dispatch processes are created or updated in ServiceMax.

To store the OptiMax login credentials with ServiceMax:

1. Log into Salesforce.

2. Click ServiceMax from the application list on top-right.

3. Click the ServiceMax Setup link from the left side pane.

4. In the ServiceMax Setup Home page, click Dispatch Console > OptiMax Settings.
The following screen appears:

Figure 1: Customer Org Settings Screen
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5. Enter the User Name, Password, and Security Token. This login must be a Sys-
tem Administrator in Salesforce.

6. Enter the Success Email ID to receive notifications regarding successful OptiMax
runs. To ensure scalability, use a distribution list instead of a specific user’s email ID.

7. Enter the Error Email ID to receive notifications regarding any failures encountered
in OptiMax runs. To ensure scalability, use a distribution list instead of a specific
user’s email ID.

8. If this is a Sandbox instance, check the Is Sandbox checkbox.

9. Click Submit to save your changes.

The above steps will ensure that ServiceMax will be able to connect to the OptiMax engine
successfully.

See Also:

Installing Packages

Loading Default Configuration and Page Layouts

Verifying Installation

PM Scheduler

Installing Offline Client

Troubleshooting Installation Issues

Next Steps after Installation

OptiMax Authentication
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TROUBLESHOOTING INSTALLATION ISSUES

This section outlines some of the typical problems you may encounter while installing Ser-
viceMax.

Problem Solution

I do not have the ServiceMax
Installation links.

Please contact ServiceMax technical support or your
account executive. Please have your 15-digit Salesforce Org
ID ready.

I don’t have the installation
password or the installation
password does not work in
AppExchange.

The installation password is sent in the email with install-
ation links. Note that this password is case-sensitive and
cannot contain spaces. If you continue to have problems in
AppExchange installation, contact ServiceMax technical
support.

I did not get an email con-
firming the package install-
ation. I don’t see any
ServiceMax in the Installed
Packages section either.

The time it takes to install a package may vary anywhere
between a few seconds to several minutes. Try installing the
package again. If the problem persists, contact Salesforce
Customer Support.

The Installation key I received
in the email has expired.

The installation key is normally valid for 30 days. Please con-
tact your account executive or ServiceMax technical sup-
port to get a new installation key.

I get an error that the install-
ation key is not valid for this
instance.

The installation key can be used only on a specific Sales-
force instance uniquely identified by an Org ID. Note that
Production and Sandbox are considered as separate
instances since they have different Org IDs.

No licenses are available to
assign to users.

Your trial period may have expired. Contact your Ser-
viceMax account executive for further action.

I am unable to see ServiceMax
listed in the applications.

You may not have deployed the ServiceMax packages after
installation. See Install ServiceMax Packages for instruc-
tions.
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Problem Solution

When I click ServiceMax setup
home, an error appears:
'Installation is incomplete'.

In order for ServiceMax features to function properly, you
must load the default configuration data. This is not an
optional step. See Load Default Configuration and Page
Layouts for more information.

Can I install this Offline applic-
ation on a Mac?

ServiceMax offline client runs on Microsoft Windows oper-
ating systems only. See Offline Client System Require-
ments for more information.

I am unable to deactivate an
offline profile I created.

The offline profile must not be linked to any Salesforce pro-
file. Edit the offline profile and remove all Salesforce pro-
files associated with it before deactivating it.

I am unable to delete an off-
line profile I created.

The offline profile must not be linked to any Salesforce pro-
file. Edit the offline profile and remove all Salesforce pro-
files associated with it before deleting it.

I am unable to generate Parts
Order reports.

The following objects should be included the Offline Profile:
Parts Order as direct object, Location as direct object, and
Account, Contact, and Product as related objects.

I am unable to generate Work
Order reports.

The following objects should be included in the Offline Pro-
file: Work Oder as direct object and Account Contact, and
Product as related objects.

Troubleshooting Installation Issues
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NEXT STEPS AFTER INSTALLATION

See ServiceMax Configuration for a detailed description of various configuration options
available and how you can deploy ServiceMax for optimum use in your organization.

See ServiceMax Customization to learn how you can take advantage of the meta-data
driven architecture of ServiceMax and build custom extensions using VisualForce, Apex,
and other tools, yet retain the flexibility of out-of-the-box functionality.
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SERVICEMAX MOBILE FOR LAPTOPS
INSTALLATION
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SERVICEMAX MOBILE FOR LAPTOPS INSTALLATION

System Requirements and Limitations

The following sections describe the system requirements and limitations for the Ser-
viceMax Mobile for Laptops application.

Requirements

The list below represents the minimum requirements for running the ServiceMax Mobile for
Laptops application.

Operating System: Windows 7 and 8, 32 and 64 bit

Disk Space: At least 250 MB + space for offline data

Processor: Recommended 1 GHz Pentium processor or equivalent

RAM: Recommended 2 GB

Display Resolution: Recommended 1024 x 768 high-color, 32 bit

Other Requirement: Microsoft .NET Framework 4.0

Prerequisites

ServiceMax Mobile for Laptops includes the following limitations:

When installing the application, you must select "Run as Administrator."

If you cannot log in, install Visual C++ 2010 runtime (Redistributable Package). For
more information visit: http://www.microsoft.com/en-in/-
download/details.aspx?id=5555

Requires ServiceMax server package Summer '13
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INSTALLING THE APPLICATION

Follow the instructions below to install the ServiceMax Mobile for Laptops application.

To install the ServiceMax Mobile for Laptops application:

1. On your computer, double-click the setup.exe file you downloaded.

2. If you are installing the application, right-click setup.exe and select Run as Admin-
istrator.

3. If you are upgrading from a previous version, click Yes to continue installation, and
then click Next to resume installation.

4. Click Runwhen prompted.

The ServiceMax Mobile for Laptops Setup application prepares the InstallShield Wiz-
ard. Wait for this process to finish. If you need to cancel this process, click Cancel.

Figure 1: ServiceMax Mobile for Laptops - InstallShieldWizard
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When the setup is complete, the ServiceMax Mobile for Laptops installer displays, as
shown below.

Figure 2: ServiceMax Mobile for Laptops Installer

5. Click Next (if you need to cancel the installation process, click Cancel).

Installing the Application
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Installing the Application

6. Read the ServiceMax Mobile for Laptop Binary Code License Agreement, select the
option to accept the terms in the license agreement, and then click Next.

Figure 3: ServiceMax Mobile for Laptop Binary Code License Agreement

7. In the Destination Folder dialog box, click Next to install the application in the des-
ignated folder.
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Figure 4: ServiceMax Mobile for Laptops Destination Folder

8. To change the destination of the application, click Change. Browse for or create a
new folder, and then click OK.

Installing the Application
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Installing the Application

Figure 5: ServiceMax Mobile for Laptop Binary Code License Agreement
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9. Click Install to install the ServiceMax Mobile for Laptops program.

Figure 6: ServiceMax Mobile for Laptops Ready to Install the Program

Installing the Application
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Installing the Application

10. Click Finish to complete installation.

Figure 7: ServiceMax Mobile for Laptops Installation Completed
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SERVICEMAX MOBILE FOR IPAD INSTALLATION
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SERVICEMAX MOBILE FOR LAPTOPS SYSTEM
REQUIREMENTS

System Requirements

The following sections describe the system requirements and limitations for the Ser-
viceMax Mobile for iPad app.

Device Requirements

The ServiceMax iPad client will work with all models of iPad except iPad 1. The minimum
configuration is iOS v4.2. Internet connectivity is required, either through 3G or Wi-Fi. If
there is a proxy or firewall in your network, the iPad must be configured to get the appro-
priate access to salesforce.com.
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INSTALLING A SERVICEMAX IPAD APP

Follow the instructions below to install a ServiceMax iPad app.

To install a ServiceMax iPad app:

1. On your iPad, tap the App Store app to launch Apple's App Store.

2. Tap the Search box on the top right and enter servicemax using the iPad keyboard.

3. Tap Search on the iPad keyboard.

All ServiceMax apps appear as shown below.

Figure 1: ServiceMax Apps
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4. Tap the Download icon next to the ServiceMax app you want to download.

When the download completes, an Open button appears.

5. Tap the Open button on this screen or the ServiceMax app icon on
the iPad Home Screen to launch the app.

Installing a ServiceMax iPad App
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SERVICEMAX OFFLINE CLIENT INSTALLATION
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OFFLINE CLIENT INSTALLATION

System Requirements

Components Specifications

Operating System Windows Server 2003
Windows Server 2008
Windows 7
Windows XP with Service Pack 2 or higher

Disk Space At least 250 MB + space for your offline data

Processor Minimum: 400 MHz Pentium processor or equivalent
Recommended: 1 GHz Pentium processor or equivalent

Memory Minimum: 96 MB
Recommended: 256 MB

Display Resolution Minimum: 800x600 256 Colors
Recommended: 1024x768 high-color, 32-bit

Other Requirements Microsoft .NET framework 3.5 with Service Pack 1 or higher

Installation Steps

Note: ServiceMax offline client is a Windows-based installation program.
Depending upon your organization’s IT distribution infrastructure, this program
may be remotely installed or pushed through a silent-installer or your organ-
ization may require you to install the Offline client manually on your desktop.
Please contact your Salesforce/ServiceMax administrator for installation
details relevant to your organization. The instructions given below can be used
for manual download and installation of ServiceMax offline client.

1. If your administrator has made ServiceMax client available through your Salesforce
system, login to Salesforce.com using your login and password. Navigate to
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Documents > ServiceMax Documents > ServiceMax Offline Client. The fol-
lowing screen appears. In this screen, click Click here to view this file link.

Figure 1: ServiceMax Offline Client Document Screen

2. When prompted, save the file locally on your computer.

3. If your administrator has not made the installer available within Salesforce as shown
in Step 1, download the ServiceMax Offline client installer.

4. In Windows Explorer, navigate to the folder where you saved the zip file and unzip the
contents into the same folder.

Note: If installing on Windows 7, ensure that User Account Control and Win-
dows Firewall are turned off and your system is restarted to make the changes
effective.

5. Double-click setup.exe.

a. If MySql is not already installed, the following window displays for installing MySql.
Click Install to proceed with installing Offline client.

Offline Client Installation
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Offline Client Installation

Figure 2: MySql Installer Window

b. If the operating system is a 64-bit operating system, the following window dis-
plays for installing the prerequisites.

Figure 3: Installing Prerequisites Screen

6. Click Accept. The ServiceMax Offline client installation begins with the Welcome to
the ServiceMax Offline Setup Wizard as shown below.
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Figure 4: ServiceMax Offline Installation screen - Initial Window

7. Click Next. The License Agreement window appears as shown in the figure below.

Figure 5:  License Agreement Window

8. To proceed with the installation, select I Agree, and then click Next. The Select
Installation Folder window appears as shown below.

Offline Client Installation
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Offline Client Installation

Figure 6: Select Installation Folder Window

9. Select an installation folder on your computer by clicking Browse, and then click
Next to view the Programs Menu window.

Figure 7: Program Menu Window

10. Enter the name of the shortcut in the Program Menu window, as shown in the figure
above.
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11. Click Next to view the Shortcuts window as shown below.

Figure 8: Shortcut Window

12. Check whether you would like to have shortcuts to ServiceMax Offline added to your
Windows desktop and/or to the Quick Launch bar, and then click Next to view the
Confirm Installation window as shown in the figure below.

Figure 9: Confirm Installation Window

13. Click Next. ServiceMax Offline client installs. A window indicating the installation pro-
gress displays as shown below.

Offline Client Installation
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Offline Client Installation

Figure 10: Installation Progress Screen

Upon successful completion, the Installation Complete window appears as shown
below.

Figure 11: Installation Complete Window

14. Click Close to close the window.

15. To run ServiceMax offline, click the shortcut on your Windows desktop or select Ser-
viceMax Offline from the Windows Start menu. The Login to ServiceMax Offline dia-
log box appears indicating that ServiceMax offline client is installed and ready for use,
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as shown below.

Figure 12: ServiceMax Offline Login Screen

16. Enter your ServiceMax Credentials and Login Settings.

17. Click Login.

See Also:

Installing Packages

Loading Default Configuration and Page Layouts

Verifying Installation

PM Scheduler

OptiMax Authentication

Troubleshooting Installation Issues

Offline Client Installation

110 Installation Steps



TROUBLESHOOTING

Troubleshooting ServiceMax Offline Installation
If you receive the following error message when installing the ServiceMax Offline Client
(see figure below), download the Microsoft Visual C++ 2005SP1 Redistributable Package
(x86) to install the required missing runtime components at:

http://www.-
microsoft.com/download/en/details.aspx?displaylang=en&id=5638

Figure 1: ServiceMax Offline Installation Error Message
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Troubleshooting Application Launch for Windows 7 Users
If you are running Windows 7 and you are unable to launch the ServiceMax Offline Client
application, follow the steps below.

1. From your desktop, right-click the ServiceMax Offline client shortcut, and then click
Properties (see figure below).

Figure 2: Right-click Menu Options

The ServiceMax Offline Client Properties dialog box appears.

2. From the ServiceMax Offline Client Properties dialog box, click the Compatibility
tab.

Troubleshooting
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Troubleshooting

3. In the Compatibility mode area, check the checkbox titled, Run this program in
compatibility mode for. See figure below.

Figure 3: Compatibility Mode Area

4. In the Compatibility mode area, selectWindows XP (Service Pack 3) from the pick-
list as shown in the figure below.
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Figure 4: Select Windows XP (Service Pack 3)

5. In the Privilege Level area, check the Run this program as an administrator
checkbox.

6. Click Apply.

7. Click OK.

8. Launch the ServiceMax Offline Client application.

Troubleshooting Report Launch for Windows 8 Users
If you are running Windows 8 and you are unable to launch the Crystal Report, follow the
steps below.

Troubleshooting
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Troubleshooting

1. On Windows 8 OS, download the Microsoft Visual C++ 2005SP1 Redistributable Pack-
age (as per the system type for 32- bit OS and 64-bit OS) to install the required miss-
ing runtime components. This must be installed prior to the Offline installation as
described in Troubleshooting ServiceMax Offline Installation . 

2. Extract the Offline Client zip file to a new folder.

3. To install MySql database and generate the crystal report, run setup.exe with admin-
istrator privileges by right-clicking setup.exe and selecting Run as administrator
(see figure below).

Figure 5: Select Run as administrator
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"MALFORMED_QUERY: SOQL statements cannot be longer
than 10000 characters."
If the number of field names in an object exceeds 20,000, then querying the records for
these fields results in an error message indicating that the limit supported for SOQL state-
ments has been exceeded. SOQL statements cannot exceed 10,000 characters in length.
You can increase the limit size via Global Setting SET002 under Module ServiceMax Offline
under SubModule Manage Offline Profile. See figure below.

Figure 6: SET002 Setting

If your Org is not upgraded to the Winter'13 package and you cannot find this setting, you
can set the increased limit (up to 20,000) in the "SVMXOfflineApplication.exe.config" file
as value for the key "MaxSOQLQueryLimit" under the appSettings section in the Ser-
viceMax folder in the Offline Client application.

Troubleshooting
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PROXY DETAIL CONFIGURATION STEPS

If the Offline Client application has to connect to Salesforce through a proxy, use one of
the following two options to specify the proxy server details.

Option 1 – Using Internet Explorer:

1. Open Internet Explorer and go to the Tools > Internet Options menu.

2. In the Connections tab, click the LAN settings button.

3. In the Proxy Server section, check the checkbox Use a proxy server for your LAN,
and provide the Address and Port information.

Figure 1: LAN Settings Screen

Option 2 – Using Configuration XML file:

1. Go to the Windows folder where ServiceMax Offline application is installed (by default
it will be C:\Program Files\ServiceMax\ServiceMax Offline).
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2. Open the file SVMXProxySettings.xml.

3. Provide the Address and Port of the Proxy Server.

4. If the Proxy requires authentication, provide the user name and password.

Example:

       <?xml version="1.0" encoding="utf-8" ?>

       <ProxySettings>

            <Username>admin</Username>

            <Password>admin123</Password>

            <IPAddress>115.184.103.16</IPAddress>

            <Port>3128</Port>

       </ProxySettings>

Proxy Detail Configuration Steps

118 "MALFORMED_QUERY: SOQL statements cannot be longer than 10000 characters."



NEXT STEPS AFTER INSTALLATION

See the ServiceMax Offline Help launched from the Offline application for detailed descrip-
tion of all the functionality in ServiceMax offline client.

Talk to your ServiceMax administrator to learn about how ServiceMax offline client has
been configured for your field service processes, and for instructions on how to maximize it
for your organization’s success.
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SERVICEMAX SUITE CONFIGURATION
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GETTING STARTED

Prerequisites                         
In order to maximize your benefits from this document, the following prerequisites must
be met:

You must be well-acquainted with Salesforce administrative tasks and navigation
and familiar with Force.com’s AppExchange.

All the ServiceMax Installation Steps have been successfully completed and veri-
fied. You now have access to a vanilla ServiceMax application.

You have a valid Salesforce login that is setup as a System Administrator.

You are familiar with ServiceMax functionality.

Configuration Building Blocks
The picture below depicts the architecture of ServiceMax configuration and how func-
tionality is delivered to end users.
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Figure 1: ServiceMax Configuration Architecture

Found-

ation

ServiceMax foundation is made up of many meta-data constructs such as Modules,

Submodules, Settings, an so on. See the See Also section for more information on

these meta-data constructs.

Extensions During ServiceMax implementations, some features may be built to meet specific

business requirements. These extensions, typically built by professional services

teams, still follow the core architecture of ServiceMax for scalability and extens-

ibility.

Getting Started
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Getting Started

Delivery Since ServiceMax is built entirely on the Force.com platform, end users of Ser-

viceMax are always linked to a Salesforce user profile. Multiple Salesforce profiles

can be linked to one ServiceMax profile, which is a collection of settings. With this

flexible architecture, an end user’s experience of ServiceMax features can be easily

managed and controlled by customer administrators.

Configuration Model
A clear understanding of various configuration constructs in ServiceMax helps you con-
figure the application more efficiently. The picture below illustrates the relationship
between various logical entities involved in ServiceMax configuration and how they drive
end user experience. Note that these are logical, not physical entities.

Figure 2: ServiceMax Configuration Model

Configuration Types
Configuring ServiceMax can be categorized as:

Basic Configuration.

Advanced Configuration.
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Basic configuration includes adjusting picklist values, page layouts, field labels, and pro-
files. These activities require familiarity with Salesforce administration tasks.

Advanced configuration involves adjusting settings to influence the behavior of the Ser-
viceMax application for your end users. In order to manage ServiceMax configuration, you
must be a System Administrator in Salesforce.

To launch the advanced configuration of ServiceMax, click Home > ServiceMax Setup.
The following page will be displayed. Using this screen, you can configure ServiceMax func-
tionality for your end users.

Figure 3: ServiceMax Setup Home

Note: ServiceMax configuration is not the same as the Salesforce setup. The
Salesforce setup typically involves setting up user profiles, sharing rules, role
hierarchy, page layouts, and so on. Topics related to Salesforce setup are not
covered in this document.

Getting Started
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Getting Started

Standard Profiles
The following is a list of all the standard profiles installed with ServiceMax. Page layout
definitions and permissions such as object access, tab visibility, Apex class access, and
Visual Force page access are preconfigured for these profiles in ServiceMax.

ServiceMax Administrator

ServiceMax Call Center User

ServiceMax Contracts User

ServiceMax Dispatcher

ServiceMax Service User

ServiceMax Service Manager

ServiceMax Inventory User

ServiceMax Inventory Manager

Note: Do not modify the above profiles. These are available for reference
only. When you upgrade ServiceMax, the above profiles are overwritten com-
pletely by the upgrade process and restored to factory defaults. As a result,
any changes you have made to the standard ServiceMax profiles will be com-
pletely lost. To avoid any such loss, it is strongly recommended that you clone
the standard ServiceMax profiles into your own custom profiles.

See Also:

Advanced Configuration: Modules

Advanced Configuration: Submodules

Advanced Configuration: Display Tags

Advanced Configuration: Object/Record Map

Advanced Configuration: Configuration Profile

Advanced Configuration: Auto-Entitlement Rules

Advanced Configuration: Counter Rules
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Advanced Configuration: Inventory Process

Advanced Configuration: Dispatch Process

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings

Getting Started
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BASIC CONFIGURATION

Overview
Basic configuration includes adjusting picklist values, page layouts, field labels, and pro-
files. These activities require familiarity with Salesforce administration tasks.

Configuration Guidelines
Field Labels of ServiceMax fields can be changed using the Salesforce translation
workbench.

Organization Wide Defaults for ServiceMax objects can be adjusted to suit your secur-
ity requirements.

When ServiceMax is installed, a few profiles are automatically created for ease of
adoption. Settings of these profiles can be modified to meet specific requirements.

ServiceMax also contains several standard reports and dashboards. You can reor-
ganize report/dashboard locations to suit your organization’s requirements. To
modify the standard ServiceMax reports, clone and modify your copies.

Custom fields can be added to ServiceMax objects. Also, you can create lookup ref-
erences to ServiceMax objects in other objects.

Page layouts of ServiceMax can be modified to suit your presentation needs.
However, consult with ServiceMax Professional services before removing fields from
page layouts or making fields optional. Some ServiceMax functionality may expect
data to be present on required fields. Hence making fields optional may result in
errors or unpredictable behavior.

There are several formula fields in ServiceMax such as RMA Age Bucket, Days To War-
ranty Expiry, and so on. They are available for reference purposes only and cannot be
modified. Using these as a reference, you can create new formula fields to suit your
organization’s reporting requirements.
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Page Layout Assignments
ServiceMax is deployed with pre-configured ready-to-use profiles and page layouts that
are available for your organization’s use. See Standard Profiles for more information
about preconfigured profiles. While the assignment of ServiceMax page layouts to these
profiles is automatic, assignment of Home page layout and standard object page layouts
must be done manually.

Object Page Layout Assign To

Home Sys Admin Home System Administrator

SVMX Home - Admin ServiceMax Admin

SVMX Home - Call Center ServiceMax Call Center User

SVMX Home - Contracts ServiceMax Contracts User

SVMX Home - Dispatcher ServiceMax Dispatcher

SVMX Home - Inv Manager ServiceMax Inventory Manager

SVMX Home - Inv User ServiceMax Inventory User

SVMX Home - Svc Manager ServiceMax Service Manager

SVMX Home - Svc User ServiceMax Service User

Note: For ServiceMax Standard Read Only Profiles, clone the ServiceMax read
only profile, and make the necessary profile adjustments for non-ServiceMax
objects. You can assign these profiles to non service users to implement read
only licensing requirements.

Configurable Picklists
The table below lists the standard picklist values in ServiceMax objects. These picklists
can be modified to suit your organization’s requirements. ServiceMax picklist names not lis-
ted here should not be modified since it may affect functionality.

Basic Configuration
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Basic Configuration

Object
Picklist

Name
Standard Values

Applicable Products Product
Line

None

Product
Family

None

Available Services Service
Type

None

Case Billing
Type

Contract, Empowerment, Loan, Paid, Warranty, Courtesy

SLA Clock
Pause
Reason

Customer Not Available

Covered Products Product
Family

None

Product
Line

None

Included Services Service
Type

None

Installed Product Status Engineering, QA, Inventory, Shipped, Installed, Dein-
stalled, In-Transit-Return, Scrap

Country All country names

Location Country All country names

Locations Covered Country All country names
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Object
Picklist

Name
Standard Values

Parts Order Billing
Type

Contract, Empowerment, Loan, Paid, Warranty, Courtesy

Bill To Sender, Receipt, Third Party

Delivery
Option

AM, PM, Two Day, Saturday

Destination
Country

All country names

Order
Status*

Open, Closed, Canceled

Priority High, Medium, Low

Shipping
Terms

EXW, FCA, FAS, FOB, CFR, CIF, CIP, DAF, DES, DEQ,
DDU, DDP

Source
Country

All country names

Parts Order Line Disposition Scrap, Repair, Salvage, Restock

Expected
Condition

Good/Working, Defective, Shipping Damage

Line
Status*

Open, Processing, Completed, Canceled

Returned
Condition

As Expected, Shipping Damage

Parts Request Status* Open, Completed, Canceled

Parts Request Line Line
Status*

Open, Completed, Canceled

Preventive Main-
tenance Plan

Status* Active, Suspended, Canceled, Expired

Process Bottlenecks Issue Area Case, Work Order, ERP, Customer, Documentation, Pro-
cess

Issue Cat-
egory

Missing Information, Wrong Information, Need Review,
Need Approval

Basic Configuration
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Basic Configuration

Object
Picklist

Name
Standard Values

Product Product
Line

None

Unit of
Measure

Each, Gallon, Box, Pounds, Liter, Dozen, Kilogram, Ton

Products Serviced Product
Family

None

Product
Line

None

Quote Status Draft, Presented, Accepted, Rejected, Revised

Service/Maintenance
Contract

Billing
Schedule

Full Upfront, Annual, Semi Annual, Quarterly, Monthly,
Other

Service Team Group Type Internal, Partner, Both

Skill Skill Area Field Service, Depot Repair, Sales

Skill Cat-
egory

None

Stock Adjustment Adjustment
Type

Damaged, Excess, Expired, Missing, Physical Inventory,
Scrap

Team Labor Cost Cost Cat-
egory

Straight, Double Time, Time and a Half, After Hours, On
Call, Travel

Technician/Equipment Role Planner, Service Engineer, Support Engineer, Service
Manager, Support Manager, Sales Engineer, Sales Man-
ager, Repair Center Engineer, Repair Center Manager,
Partner Engineer, Partner Manager, Technician, R&D
Engineer, Consultant

Territory Coverage Type* Zip, City, State, Country
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Object
Picklist

Name
Standard Values

Work Order Billing
Type

Contract, Empowerment, Loan, Paid, Warranty, Courtesy

Failure
Location

Field, Floor

Failed
Assembly

None

How Fixed None

Order
Status*

Open, Closed, Canceled

Order Type Advance Replacement, Depot Repair, Replenishment,
Return For Credit, Return Only, Return Replacement,
Field Service

Priority High, Medium, Low

Purpose of
Visit

Installation, Deinstallation, Repair, Maintenance, Train-
ing, Courtesy

Root Cause None

Symptom None

SLA Clock
Pause
Reason

Customer Not Available

Work Details Activity
Type

Service, Calibration, Repair, Installation, Cleanup

Cost Cat-
egory

Straight, Double Time, Time and a Half, After Hours, On
Call, Travel

Expense
Type

Parts, Lodging, Airfare, Rental Car, Food - Breakfast,
Food - Lunch, Food - Dinner, Phone, Entertainment,
Mileage, Gas, Parking, Tolls, Miscellaneous

Line
Status*

Open, Completed, Canceled

Log Against Service Team, Technician/Equipment

   * New values can be added but the existing values should not be deleted.
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Basic Configuration

Note: Fields related to some standard objects such as Cases and Oppor-
tunities are available for use in setting picklist values only if allowed by your
ServiceMax license. Please contact your ServiceMax administrator to know the
type of license used by your organization.

See Also:

Standard Configuration Settings

Troubleshooting Configuration Issues
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MODULE

Overview
Module is a logical grouping of related functionality in ServiceMax. A module’s functionality
may be implemented using both standard Salesforce objects and custom objects. Func-
tionality in a module may be implemented using many technical components such as
Visual Force, Apex (Triggers & Classes), Flex, S-Controls, and so on. Some examples of
standard modules are:

Entitlement Verification

Installed Products

Service Contracts

Access and Permissions

Actions User Permissions Needed

To view modules: "Read" on ServiceMax Processes

To create or edit modules: "Create" and "Update" on ServiceMax Processes

To delete modules: "Delete" on ServiceMax Processes

To view submodules: "Read" on ServiceMax Processes
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Click Home > ServiceMax Setup > App Administration > Modules to view the Mod-
ules home page as shown below:

Figure 1: Modules Screen

In the Modules screen:

The top section shows the standard modules available in Service.

The bottom section shows custommodules built as extensions to meet customer-
specific requirements.

Click Back To Setup Home to return to the ServiceMax Setup Home page.

Module Fields

Fields Description

Module ID Unique ID of the module

Module Name User-friendly name of the module

Description Detailed description of the module

Module
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Module

Creating/Editing Custom Modules

To create a new module:

1. Click New Module in the Modules screen. An empty record is created at the bottom
of the list of records in the Custom Modules section. You can also modify information
in the existing custommodule records.

2. Enter a unique ID for the module. When naming a Module ID, remember the following:

Module ID must be alphanumeric.

Module ID must be at least 8 characters long.

Module ID should not contain spaces.

Module ID should not contain special characters.

5. Enter the module name. For example, "Preventive Maintenance or Labor Costing."

6. Enter a detailed description of the module.

7. To add more modules, click New Module.

8. Click Save. The changes are saved and the module list is refreshed.

Deleting Custom Modules

To delete one or more modules:

1. Check the checkbox adjacent to the module(s) which you want to delete.

2. Click Delete and then click OK when prompted for confirmation. The selected mod-
ules are deleted and the module list is refreshed.

Note: Standard modules cannot be deleted.
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Viewing Submodules in a Module

To view submodules in a module:

1. Select one of the modules by checking the checkbox adjacent to it.

2. Click List Submodules. You will be redirected to the Manage Submodules page. The
module is preselected in the list.

See Also:

Submodules

Display Tags

Object/Record Map

Configuration Profile

Auto-Entitlement Rules

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings

Module
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SUBMODULE

Overview
Submodule is a specific functionality within a module. A submodule may be implemented
using one or more technologies such as Visual Force, Apex (Triggers & Classes), Flex, S-
Controls, and so on. Depending upon the functionality implemented, a submodule may or
may not have a user interface. Optionally, submodules may also use their own settings,
display tags and/or record maps as required. See the See Also section to know more
about these constructs.

For example, in the Service Contracts module, Activation, Cancellation and Renewal are
submodules that perform specific functions using Visual Force and Apex. In the Installed
Product module, automatic creation of warranty is a submodule implemented using an
Apex trigger. Similarly, Stock Lookup is a common submodule built as an S-control.

Access and Permissions

Actions User Permissions Needed

To view submodules: "Read" on ServiceMax Processes

To create or edit submodules: "Create" and "Update" on ServiceMax Processes

To delete submodules: "Delete" on ServiceMax Processes

To view settings: "Read" on ServiceMax Processes

Click Home > ServiceMax Setup > App Administration > Submodules to view the
submodules home page as shown below:
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Figure 1: Manage Submodules Screen

Alternatively, click List Submodules from the Modules page to view the submodules
home page. The module is automatically selected, if the submodule page is launched from
the Modules page.

In the Submodules screen:

The top section shows the standard submodules in the selected module. This inform-
ation is not editable.

The bottom section shows the custom submodules built as extensions to meet cus-
tomer-specific requirements.

Click Back To Setup Home to return to the ServiceMax setup home page.

To view the list of standard and custom submodules in a module, select the module
name from the Select Module picklist at the top.

Submodule
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Submodule

Submodule Fields

Fields Description

Submodule ID Globally unique ID of the submodule. A submodule ID may not repeat under any
module.

Submodule
Name

User-friendly name of the submodule.

Description Detailed description of the submodule.

Creating/Editing Custom Submodules

To create or edit a submodule:

1. Click New Submodule. An empty record is created at the bottom of the list of
records in the Custom Submodules section. Alternatively, you can also modify the
existing custom submodules record.

2. Enter a unique ID for the submodule. When naming a submodule, remember the fol-
lowing:

Submodule ID must be alphanumeric.

Submodule ID must be at least 8 characters long.

Submodule ID should not contain spaces.

Submodule ID should not contain special characters.

3. Enter a detailed description for the module.

4. To add more submodules, click New Submodule.

5. Click Save. The changes are saved and the submodules list is refreshed.

Deleting Custom Submodules

To delete one or more submodule(s):

1. Select the submodules record you want to delete by checking the checkbox adjacent
to it.
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2. Click Delete and thenOK when prompted for confirmation. The selected records are
deleted and the submodules list will be refreshed.

Note: Standard Submodules cannot be deleted.

Viewing Settings in Submodules

To view settings in submodules:

1. Select one of the submodule by checking the checkbox in the submodules home page
list.

2. Click Setting. You will be redirected to the Manage Settings page. The module and
submodule are preselected in the list.

See Also:

Settings

Display Tags

Object/Record Map

Submodule
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SETTING

Overview
Setting is a configurable parameter in a submodule that can influence behavior of the sub-
module in runtime. Implementing a submodule with as many configurable settings as prac-
tically possible is very useful since it eliminates effort in coding and requires much less
maintenance. When user requirements change in the future, the administrator simply has
to change the setting values, and not the code itself. In addition, using configurable set-
tings allows greater flexibility in rolling out varied flavors of processes for different sets of
users.

For example, it is not always required to create product warranties when an installed
product record is created or updated. To achieve this, the submodule Create Warranty
for Installed Product uses two settings called Create Warranty Upon IB Create and
Create Warranty Upon IB Update. Depending upon a customer requirement, these
parameters can be switched on or off.

Access and Permissions

Action User Permissions Needed

To view Settings: "Read" on ServiceMax Processes

To create or edit Settings: "Create" and "Update" on ServiceMax Processes

To delete Settings: "Delete" on ServiceMax Processes
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Click Home > ServiceMax Setup > App Administration > Settings to view Manage
Settings page, as shown below:

Figure 1: Manage Settings Screen

Alternatively, you can also click List Settings in the submodules page to view the Manage
Settings page. The module and submodule are automatically selected, if the Manage Set-
ting page is launched from the submodules page.

In the Manage Settings screen:

The top section shows the standard settings in the selected submodule. This inform-
ation is not editable.

The bottom section shows custom settings built as extensions to meet customer-spe-
cific requirements.

Click Back To Setup Home to return to ServiceMax Setup home page.

Setting Fields

Fields Description

Settings ID Unique ID of the setting within a submodule.

Setting
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Setting

Fields Description

Setting
Name

User-friendly name of the setting.

Description Detailed description of the submodule.

Data Type Type of data stored in this setting. List of values are: Text, Number, Boolean,
Picklist, Date, User, Account, Contact, Service Team, Technician, and Loca-
tion.

Setting
Type

The granularity at which this setting can be applied at run time. Global indicates
this setting applies to all users. Group is when this setting applies to more than
one user. User is when this setting can vary for each user.

Search
Order

This is used to resolve conflicts if a setting has values specified in more than one
level. This is applicable only for Group and User level settings.

List of Val-
ues

A list of values if the setting type is picklist.

Default
Value

Default value for this setting.

Creating/Editing Custom Settings

To create or edit custom settings:

1. Click New Settings in the Manage Setting screen. An empty record is created at the
bottom of the list of records in the Custom Setting section. You can also modify the
existing custom setting records.

2. Enter unique ID for the setting. When naming a Setting ID, remember the following:

Settings ID must be alphanumeric.

Settings ID must be at least 8 characters long.

Settings ID should not contain spaces.

Setting ID should not contain special characters.

3. Enter the setting name. For example, Default Support Type or Show Closed
Orders.

4. Enter a detailed description for the setting.

5. Enter the setting type and search order.
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6. To add more setting records, click New Settings.

7. Click Save. The changes are saved and the setting list is refreshed.

8. To specify the list of values and/or default value for a setting, click the Add/Edit link
on the record. This link appears only for saved records. A popup window will appear in
which you can enter the list and default values. When specifying a list of values of a
picklist, use the value separator string carefully. The value separator is Carat, Pipe
and Carat. For example, to indicate A, B, and, C as valid values, the text must be
A~|~B~|~C.

Figure 2: Standard Setting Values Screen

Deleting Custom Settings

To delete one or more setting(s):

1. Check the checkbox adjacent to the setting record(s) which you want to delete in the
custom settings list.

2. Click Delete and then click OK when prompted for confirmation.

Note: Standard settings cannot be deleted.

See Also:

Modules

Submodules

Display Tags

Setting
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Setting

Object/Record Map

Configuration Profile

Auto-Entitlement Rules

Counter Rules

Inventory Process

Dispatch Process

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings
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DISPLAY TAG

Overview
Display Tags are language-specific translatable text used in ServiceMax screens. Also
referred to as Tags, these are used on buttons, labels and error/information/warning mes-
sages. Tags are translatable into any language supported by Salesforce.

Access and Permissions

Actions User Permissions Needed

To view tags: "Read" on ServiceMax Tags

To create or edit tags: "Create" and "Update" on ServiceMax Tags

To delete tags: "Delete" on ServiceMax Tags

To manage translation: "Create" and "Update" on ServiceMax Tags

Click Home > ServiceMax Setup > App Administration > Display Tags to view the
manage display tags home page, as shown below:

Figure 1: Manage Display Tags Screen

In the Manage Display Tags screen:
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Select a module from the Select Module picklist.

Select a submodule from the Select Submodule picklist.

The top section shows the standard display tags in the selected submodule. This
information is not editable.

The bottom section shows the custom display tags built as extensions to meet cus-
tomer-specific requirements.

Click Back To Setup Home to return to the ServiceMax Setup home page.

Display Tag Fields

Fields Description

Tag ID Unique ID of the tag within the submodule

Tag Text The text displayed when this tag is used

Creating/Editing Custom Display Tags

To create or edit a custom display tag:

1. Click New Tag in the Manage Display Tags screen. An empty record is created at the
bottom of the list of records in the Custom Tags section. You can also modify the exist-
ing custom display tag record.

2.  Enter the unique ID for the tag. When naming a Tag ID, remember the following:

Tag ID must be alphanumeric.

Tag ID must be at least 8 characters long.

Tag ID should not contain special characters.

Tag ID should not contain spaces.

3. Enter the tag text. This is the master text that will be used if no language-specific
translation is available for this tag.

4. To add more display tags, click New Tag.

5. Click Save. The changes are saved and the tag list is refreshed.

Display Tag

152 Display Tag Fields



Display Tag

Deleting Custom Display Tags

To delete one or more tag(s):

1. Select the tags by checking the checkbox adjacent to the tag records that you want
to delete in the custom tags list.

2. Click Delete and then click OK when prompted for confirmation.

Note: Standard Display Tags cannot be deleted.

Managing Translations for Display Tags

To manage translations:

1. Click Home > ServiceMax Setup > App Administration > Translations link to
view Manage Translations screen.

Figure 2: Manage Translations Screen

2. Select the module from the Select Module picklist.

3. Select the submodule from the Select Submodule picklist.

4. Select a language from the Select Language picklist. All the display tags for the
selected module, submodule, and language appear.

5. Enter the translation text for each row. Blank rows will be skipped.

6. To copy the master text as default translation for all tags, click Copy Master Text.
This provides an easy starting point to enter translations, especially for English.
Alternatively, to undo this, click Reset <Language> Text, where <Language> is
the currently selected language.
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7. Click Save.

8. Repeat the above steps for as many combinations of module, submodule, and lan-
guages as required.

It is important to note that the Manage Translations screen in ServiceMax is different from
the Translation Workbench and Custom Labels provided by Salesforce. Use the translation
workbench to translate standard Salesforce constructs such as fields, sections, picklists,
buttons, links, and so on. Use the New Local Translations/Overrides functionality available
for Salesforce Custom Labels to translate constructs such as labels of buttons and text dis-
played in standard ServiceMax VF pages. The Manage Translations screen provided by Ser-
viceMax applies only to custom ServiceMax functionality built on top of standard
ServiceMax functionality.

To demonstrate this with an example, see the Service Contracts screen figure below. This
is a standard Salesforce page layout that has fields, standard buttons, and custom but-
tons.

Figure 3: Service/Maintenance Contract Screen

Display Tag
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Display Tag

When you click the Renew Contract button, the Renew Service/Maintenance Contract as
shown in the screen below. This is a standard ServiceMax Visual Force page layout.

Figure 4: Renew Service/Maintenance Contract Screen

Use the Salesforce translation workbench to change the label of the Renew Contract but-
ton on the standard page layout.

Use the New Local Translations/Overrides functionality to change the labels of buttons
and text displayed in the Renew Contracts page.

To access the New Local Translations/Overrides functionality:

1. Enable Translation Settings by navigating to Setup > Administration Setup >
Translation Workbench.

2. Click the New Local Translations/Overrides button by navigating to Setup > App
Setup > Create > Custom Labels and then click the specific custom label name
link.

Use ServiceMax Manage Translations page to change the labels of buttons and text dis-
played in new custom Visual Force pages built as an extension for ServiceMax.
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See Also:

Modules

Submodules

Setting

Object/Record Map

Configuration Profile

Auto-Entitlement Rules

Counter Rules

Inventory Process

Dispatch Process

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings

Display Tag
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OBJECT/RECORD MAP

Overview
There are many instances when information is exchanged between two processes, for
example scenario would be when the call center creates a case and initiates a Work Order,
RMA, or Shipment. In such scenarios, the exchanged information comprise completely dif-
ferent objects/records in Salesforce, and are accessed by different sets of users. However,
it will be very productive and useful if the target record is automatically populated with
information that is already captured on the Case. This also helps in maintaining a high qual-
ity of data. In addition, the scope of such copying should include any custom fields added
to the Case and other objects.

An Object Map provides the ability to define field mapping between source and target
object records. The mapping defined is maintainable interactively by administrators and
applied at runtime when records are actually created.

See ServiceMax Customization for detailed instructions on how to use the Object Maps
in the new custom functionality you want to build.

Access and Permissions

Actions User Permissions Needed

To view object maps: "Read" on ServiceMax Processes and ServiceMax Config Data

To create or edit object
maps:

"Create" and "Update" on ServiceMax Processes and ServiceMax
Config Data

To delete object maps: "Delete" on ServiceMax Processes and ServiceMax Config Data
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Click Home > ServiceMax Setup > App Administration > Object Mapping to view
the Manage Object Mapping screen, as shown below:

Figure 1: Manage Object Mapping Screen

In the Manage Object Mapping screen:

A list of all the standard and custommaps are displayed. Though ServiceMax sup-
ports two types of maps, Field Map and Value Map, only field maps are listed here.
Value maps can be created/edited using Service flow designer only.

Click View to see field mapping details of an existing map.

Click New to create a custommap between Salesforce objects.

Click Clone to create a copy of an existing map.

Click Edit to edit the field mapping details of an existing map.

Click Back To Home to return back to the ServiceMax Setup home page.

Object Map Fields

Fields Description

Map ID Globally unique ID of the map.

Map Name Name of the map. Indicates how/where the map is used.

Description Detailed description of how this map is used.

Object/Record Map
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Object/Record Map

Fields Description

Source Record
Name

Source object/record name. It can be Account, Contact, Product, Case, or any
custom object.

Target Record
Name

Target object/record name. It can be Account, Contact, Product, Case, or any
custom object.

Target Record
Type

The record type of the target object, if applicable.

Source Field
Name

Name of the field from the source record.

Target Field
Name

Name of the field from the target record.

Creating/Editing Custom Object Maps

To create custom map objects:

1. Click New in the Custom Mapping section in the Manage Object Mapping screen.

Figure 2: Edit Mapping Details Screen

2. Enter unique ID for the map. When naming a map ID, remember the following:
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Map ID must be alphanumeric.

Map ID must be at least 8 characters long.

Map ID should not contain special characters.

Map ID should not contain spaces.

3. EnterMap Name and Description.

4. Select the source object.

5. Select the target object.

6. Select the target record type, if available. List of fields from the target object are lis-
ted with a possible list of matches against each field. This is automatically determined
by the data type of each field.

7. Select appropriate mapping for each field. If you do not want the field to be copied,
leave it blank or select None from the list.

8. Click Quick Save to save your entries and continue to make changes.

9. Click Save to save all your entries and return to the previous screen.

Note: Fields related to some standard objects such as Cases and Oppor-
tunities are available for use in setting picklist values only if allowed by your
ServiceMax license. Please contact your ServiceMax administrator to know the
type of license used by your organization.

Deleting Custom Object Maps

To delete one or more object map(s):

1. Check the Delete checkbox in the custom object map list.

2. Click Save. The selected rows are deleted and the object maps list is refreshed.

Note: Standard Object Maps cannot be deleted.

Object/Record Map
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Object/Record Map

See Also:

Advanced Configuration: Modules

Advanced Configuration: Submodules

Advanced Configuration: Display Tags

Advanced Configuration: Configuration Profile

Advanced Configuration: Auto-Entitlement Rules

Advanced Configuration: Counter Rules

Advanced Configuration: Inventory Process

Advanced Configuration: Dispatch Process

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings
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CONFIGURATION PROFILE

Overview
Configuration Profile represents a collection of all the settings and their values, and is thus
central to optimizing end user experience and functionality in ServiceMax. A profile con-
tains values for standard and custom settings. ServiceMax has two types of configuration
profiles:

Org-wide Profile: Org-wide profile contains configuration values for all settings, irre-
spective of the setting type.

Group Profile: Group profiles hold configuration values for settings of the type
Group or User.

See ServiceMax Customization for detailed instructions on how to use configuration pro-
files and setting values using ServiceMax API methods.

Access and Permissions

Actions User Permissions Needed

To view Configuration Profile: "Read" on ServiceMax Processes and ServiceMax Config
Data

To create or edit Configuration
Profile:

"Create" and "Update" on ServiceMax Processes and Ser-
viceMax Config Data

To delete Configuration Pro-
file:

"Delete" on ServiceMax Processes and ServiceMax Config
Data
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Click Home > ServiceMax Setup > App Administration > Configuration Profiles to
view the Configuration Profiles screen, as shown below:

Figure 1: Configuration Profiles Screen

In the Configuration Profiles screen:

The top section shows org-wide configuration profiles. The bottom section displays
group-wide profiles.

Click Activate to make an org-wide profile available for use, and deactivate all other
org-wide profiles.

Click Clone to create a copy of an existing configuration profile with all its settings.

Click Edit to edit setting values in an existing configuration profile.

Click Back To Setup Home to return to the ServiceMax Setup home page.

Configuration Profile Fields

Fields Description

Profile
Name

Name of the configuration profile.

Description Detailed description of the configuration profile.

Is Default Indicates if this is the default configuration profile.

Active Indicates if this profile is active or not. Only active ServiceMax profiles can be
linked to Salesforce users.

Configuration Profile
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Configuration Profile

Creating/Editing Custom Configuration Profiles

To create a new configuration profile:

1. Select an existing group-wide or org-wide configuration profile by checking the
Select checkbox in the list.

2. Click Clone. Alternatively, to edit an existing configuration profile, select the profile
and then click Edit. Clone and Edit Modes display the same screen.

Figure 2: Edit Configuration Profile Screen

The Information section at the top is used to capture general information about the
profile. The bottom section shows all applicable settings in the selected module
and submodule.
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If you are creating or editing an org-wide profile:

All settings are displayed in the bottom section.

The Profile Access section is hidden.

If you are creating or editing a group-wide profile:

Settings of the type Global are not displayed.

The Active checkbox is always to set to true and disabled.

The Profile Access section is visible.

If the profile is custom, the Default checkbox will be disabled.

3. Enter a unique profile name. Profile name must be alphanumeric and can contain
spaces.

4. Enter the profile description.

5. For group-wide profiles, select the Salesforce profiles that need access to this Ser-
viceMax profile. See ServiceMax Configuration Architecture to understand the
relationship between the Salesforce profile and the ServiceMax profile.

6. To configure submodules, select a module from the picklist and then select a sub-
module. All configurable settings applicable to the module are displayed.

7. Click Edit to edit the setting value. A popup window as shown below appears. Depend-
ing upon the setting’s data type, this screen will automatically capture the appro-
priate value. For example, if the setting data type is Boolean, this screen will show
an option to select True or False.

Figure 3: Standard Setting Values Screen

8. Repeat the above step for settings in each submodule.

9. Click Save.

Configuration Profile
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Configuration Profile

Deleting Custom Configuration Profiles

To delete one or more configuration profile(s):

1. Check the Select checkbox in the org-wide or group-wide profiles list.

2. Click Delete and then click OK when prompted for confirmation. The selected records
are deleted and the profiles list is refreshed.

Note: Default or Active configuration profiles cannot be deleted. Also, con-
figuration profiles that are linked to Salesforce profiles cannot be deleted.

See Also:

Modules

Submodules

Display Tags

Settings

Object/Record Map

Auto-Entitlement Rules

Counter Rules

Inventory Process

Dispatch Process

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings
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AUTO-ENTITLEMENT RULES

Overview
Auto-entitlement rules enable your organization to perform entitlements for Cases and
Work Orders automatically when the cases or work orders meet your pre-defined qual-
ification criteria. This saves significant time during call center interactions with customers
and avoids errors caused by end users. Moreover, ServiceMax allows you to define mul-
tiple rules to meet the automatic entitlement needs of various groups within your organ-
ization.

One of the most significant benefits of deploying auto-entitlement rules is that customers
are automatically entitled when they log cases from the ServiceMax customer portal. This
enables your organization to take the corrective action on the Cases or Work Orders dir-
ectly without having to spend time in customer interaction cycles.

To understand how the auto-entitlement rules are used dynamically, see the section on
Case andWork Orders.

Note: The auto-entitlement feature is available only if allowed by your Ser-
viceMax license. Please contact your ServiceMax administrator to know the
type of license used by your organization.

Access and Permissions

Actions User Permissions Needed

To view auto-entitlement rules: "Read" on ServiceMax Processes, ServiceMax Config Data,
and Case

To create or edit auto-enti-
tlement rules:

"Create" and "Update" on ServiceMax Processes, Ser-
viceMax Config Data

"Read" on Case

To delete auto-entitlement
rules:

“Delete” on ServiceMax Processes and ServiceMax Config
Data
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Click Home > ServiceMax Setup > Installed Base & Entitlement > Auto-Enti-
tlement Rules-Case to view the auto-entitlements home page as shown below. Use this
feature to define rules based on Case information to perform automatic entitlement for
cases created.

Figure 1: Auto-Entitlements-Case Screen

Click Home > ServiceMax Setup > Installed Base & Entitlement > Auto-enti-
tlement Rules-Work Order to view the auto-entitlements home page. Use this feature
to define rules based on Work Order information to perform automatic entitlement for
Work Orders created.

Figure 2: Auto-entitlements -Work Order Screen

In the auto-entitlement screens (Cases and Work Orders):

Auto-Entitlement Rules
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Auto-Entitlement Rules

Considering the unique nature of auto-entitlement rules, the ServiceMax installation
does not create any pre-configured rules. All auto-entitlement rules must be created
based on your organization’s requirements.

To create a new auto-entitlement rule, click New Rule.

To edit an existing auto-entitlement rule, select the rule from the list and then click
Edit Rule.

To remove an auto-entitlement rule, select the rule from the list and then click
Delete Rule.

Click the Save button to save the rule.

Click the Cancel button to cancel the rule.

Click the Rule Sequence button to change the order sequence of the rules.

Click Back To Setup Home to return to the ServiceMax Setup home page.

Auto-Entitlement Rule Fields

Fields Description

Rule Name Name of the rule. For example, Entitlement for A-Rated Customers.

Description Detailed description of the rule.

Entry Cri-
teria

An expression based on Case or Work Order Field values that defines the qual-
ification/entry criteria for a Case to be considered by this auto-entitlement rule.

Match
Account

Indicates if the account on the service contract should mandatorily be matched
with the account on the Case or Work Order.

Match
Contact

Indicates if the contact on the Case or Work Order must be matched with the list of
entitled contacts under a service contract.

Match Loca-
tion

Indicates if the location on the Case or Work Order must be matched with the
covered locations under a service contract.

Consider
Top-Level

When checking entitlements for a component, this flag extends the scope to check
for coverage based on the top-level installed product for the component.

Consider
Parent

When checking entitlements for a component, this flag extends the scope to check
for coverage based on the parent installed product for the component.

Auto-Entitlement Rule Fields 171



Fields Description

Scope of
Entitlement

Indicates if the entitlement check should include warranties, service contracts or
both.

Validation
Criteria

Indicates if the entitlement check should be performed based on the validity dates
(start & end dates of warranties/service contracts), counters or both.

Counter Vs.
Date Rule

If the entitlement check is done based on both validity dates and counters, this
field dictates whether both should be valid or one of them should be valid to qualify
the entitlement.

Tie-breaker
Rule

If the entitlement check yields more than one valid service contract and warranty
for a Case or a Work Order, this field defines which entitlement to use. Options are
to use the first warranty or the first service contract.

Creating/Editing Auto-Entitlement Case Rules

To create a new auto-entitlement rule for a Case:

1. Click New Rule in the Auto-Entitlements screen. A sample Auto-Entitlement rule
screen appears below. Alternatively, select the rule and then click Edit to edit an

Auto-Entitlement Rules
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Auto-Entitlement Rules

existing rule. Clone and Edit modes display the same screen.

Figure 3: Auto-Entitlement Rule for Cases Screen

2. In the Auto-Entitlement Rule for Cases screen:

Enter the rule name. Make sure this name distinctly identifies the purpose of the
rule and is readable. For example “High priority cases from ABC company.”

Enter a detailed description of the rule.

Using the combination of Case field name, operator and value, enter the applicable
entry criteria for this rule. Only those Cases that match the criteria will be entitled
using the rule. Make sure the entry criteria are exclusive to each rule. Use the but-
tons marked with x and + to remove and add conditions respectively. If required,
use the Advanced Expression to enter conditions such as (1 AND 2) OR 3.

When entering values in the expressions, in addition to literal values, you can use
the predefined values listed below for certain field types:
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Field Data Type Literal* Effect

Date TODAY Match date to today's date

Date TOMORROW Match date to today + 1

Date YESTERDAY Match date to today - 1

Date THIS_WEEK Check if date is in the current week

Date THIS_MONTH Check if date is in the current month

Date NEXT_WEEK Check if date is in the next week

Date NEXT_MONTH Check if date is in the next month

Date LAST_WEEK Check if date is in the last week

Date LAST_MONTH Check if date is in the last month

Date NEXT_90_DAYS Check if date is in (tomorrow + 90)

Date LAST_90_DAYS Check if date is in (yesterday - 90)

Date NEXT_N_DAYS:N Check if date is in (tomorrow + N)

Date LAST_N_DAYS:N Check if date is in (yesterday - N)

Lookup (User) SVMX.CURRENTUSER Use login user's ID

* Literals are case-sensitive.

3. Enter your preferences for various auto-entitlement parameters:

Match Accounts

Match Contacts

Match Locations

Consider Top-Level

Consider Parent

Find Warranties, Service Contracts, or both

Use Validity Dates, Counter, or Both, and their concurrent validity requirements

Tie-breaker rule

4. Click Save.

5. If you want to cancel the rule, click the Cancel button.

Auto-Entitlement Rules
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6. If editing a rule, click the Rule Sequence button to rearrange the order of rules.

7. Click the Return to Setup Home button to return to the Setup Home page.

Creating/Editing Auto-Entitlement Work Order Rules

To create a new auto-entitlement rule for a Work Order:

1. Click New Rule in the Auto-Entitlements screen. A sample Auto-Entitlement rule
screen appears below. Alternatively, select the rule and then click Edit to edit an
existing rule. Clone and Edit modes display the same screen.

Figure 4: Auto-Entitlement Rule for Work Orders Screen

2. In the Auto-Entitlement rule for Work Orders screen:
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Enter the rule name. Make sure this name distinctly identifies the purpose of the
rule and is readable. For example “High priority work orders from ABC company.”

Enter a detailed description of the rule.

Using the combination of Work Order field name, operator and value, enter the
applicable entry criteria for this rule. Only those Work Orders that match the cri-
teria will be entitled using the rule. Make sure the entry criteria are exclusive to
each rule. Use the buttons marked with x and + to remove and add conditions
respectively. If required, use the Advanced Expression to enter conditions such as
(1 AND 2) OR 3.

When entering values in the expressions, in addition to literal values, you can use
the pre-defined values listed in the table above for certain field types.

3. Enter your preferences for various auto-entitlement parameters:

Match Accounts

Match Contacts

Match Locations

Consider Top-Level

Consider Parent

Find Warranties, Service Contracts, both

Use Validity Dates, Counters or Both, and their concurrent validity requirements

Tie-breaker rule

4. Click Save.

5. If you want to cancel the rule, click the Cancel button.

6. If editing a rule, click the Rule Sequence button to rearrange the order of rules.

7. Click the Return to Setup Home button to return to the Setup Home page.
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Auto-Entitlement Rules

Deleting Auto-Entitlement Rules

To delete one or more auto-entitlement Case or Work Order rule

(s):

1. Select the rule(s) to be deleted by checking the Select checkbox adjacent to the rule
(s).

2. Click Delete Rule and then click OK when prompted for confirmation. The selected
rows are deleted and the rules list is refreshed.

See Also:

Modules

Submodules

Display Tags

Configuration Profile

Counter Rules

Inventory Process

Dispatch Process

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings
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COUNTER RULES

Overview
Counter rules are used to define various readings to be captured on installed products, and
subsequently to use the readings to define coverage in warranties and service contracts,
and finally to entitle customers on Cases. Counter rules are defined using Product attrib-
utes, for example, fields available on the Product object that include standard ServiceMax
fields as well as any custom fields created by your organization.

ServiceMax supports unlimited numbers of counter definitions.

See Service Contracts,Warranty Terms and Installed Products to learn about how
counter rules are used to define counter-based coverage and to capture current product
readings.

Access and Permissions

Actions User Permissions Needed

To view counter rules: "Read" on ServiceMax Processes, ServiceMax Config Data, and
Product

To create or edit counter
rules:

"Create" and "Update" on ServiceMax Processes, ServiceMax
Config Data

"Read" on Product

To delete counter rules: "Delete" on ServiceMax Processes and ServiceMax Config Data
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Click Home > ServiceMax Setup > Installed Base & Entitlement > Counter Rules
to view the counter rules home, as shown below:

Figure 1: Counter Rules Home

Considering the unique nature of counter rules, ServiceMax installation does not create
any pre-configured rules. All counter rules must be created based on your organization’s
requirements.

In the Counter Rules home screen:

To create a new counter rule, click New Rule.

To edit an existing counter rule, select the rule from the list and then click Edit Rule.

To remove a counter rule, select the rule and then click Delete Rule.

Click Back To Setup Home to return to the ServiceMax Setup home page.

Counter Rule Fields

Fields Description

Rule Name Name of the rule. For example, "Counters for XYZ line of Products".

Description Detailed description of the rule.

Entry Cri-
teria

An expression based on Product Field values that defines the criteria from which
a product’s counters are determined when defining coverage or capturing read-
ings.

Counter Name Name of the counter. For example, "Revolutions" or "Kilometers".

Counter Rules
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Counter Rules

Fields Description

Type The order in which the counter reading works. Options are Increasing and
Decreasing.

Grows/Reduces
by

The number of units by which the counter value grows or reduces. In this
release, no functionality is driven by this setting.

Min Value Minimum allowed value for the counter. Installed product readings that use this
counter cannot go below this value.

Max Value Maximum allowed value for the counter. Installed product readings that use this
counter cannot go above this value.

Active Indicates if this counter is actively used or not. Inactive counters will be ignored
in warranty/contracts coverage, readings and entitlement checks.

Creating/Editing Counter Rules

To create a new rule:

1. Click New Rule. Alternatively, to edit an existing rule, select the rule from the list and
then click Edit Rule. Clone and Edit modes display the same screen. A sample
counter rule screen is shown below.

Figure 2: Counter Rule Screen

2. In the above screen:
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Enter the rule name. Make sure this name distinctly identifies the purpose of the
rule and is readable. For example "Readings For XYZ Model of Electricity Meters".

Enter a detailed description for the rule.

Using the combination of Product field name, operator and value, enter the applic-
able entry criteria for this rule. When defining counter-based coverage in warranty
terms and service contracts, all products that match this expression will be con-
sidered. Make sure the entry criteria are exclusive to each rule. Use the buttons
marked with x and + to remove and add conditions respectively. If required, use
the Advanced Expression to enter conditions such as (1 AND 2) OR 3.

When entering values in the expressions, in addition to literal values you can use
the predefined values listed below for certain field types:

Field Data Type Literal* Effect

Date TODAY Match date to today's date

Date TOMORROW Match date to today + 1

Date YESTERDAY Match date to today - 1

Date THIS_WEEK Check if date is in the current week

Date THIS_MONTH Check if date is in the current month

Date NEXT_WEEK Check if date is in the next week

Date NEXT_MONTH Check if date is in the next month

Date LAST_WEEK Check if date is in the last week

Date LAST_MONTH Check if date is in the last month

Date NEXT_90_DAYS Check if date is in (tomorrow + 90)

Date LAST_90_DAYS Check if date is in (yesterday - 90)

Date NEXT_N_DAYS:N Check if date is in (tomorrow + N)

Date LAST_N_DAYS:N Check if date is in (yesterday - N)

Lookup (User) SVMX.CURRENTUSER Use login user's ID

* Literals are case-sensitive.
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Enter Counter Name. Though not mandatory, ensure the counter name does not
conflict with counters used by other groups of products.

Enter Counter Type, Grows/Reduces by,Minimum Value, andMaximum
Value.

Check the Active checkbox.

3. To add a new Counter for the rule, click New Counter. An empty row will be inserted
at the bottom of the counter list.

4. To delete one or more existing counters, check the left-most checkbox on the rows to
be deleted, and then click Delete Counter. Click OK when prompted for con-
firmation.

5. Click Save.

Note: Fields related to some standard objects such as Cases and Oppor-
tunities are available for use in setting picklist values only if allowed by your
ServiceMax license. Please contact your ServiceMax administrator to know the
type of license used by your organization.

Deleting Counter Rules

To delete one or more counter rules:

1. Select the rule(s) to be deleted by checking the Select checkbox adjacent to the rule
from the list.

2. Click Delete Rule and then click OK when prompted for confirmation. The selected
rows are deleted and the rules list is refreshed.

See Also:

Standard Configuration Settings

Defining Counter Rules in Service/Maintenance Contracts

Defining Counter Rules in Installed Product

Defining Counter Rules in Warranty Terms
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Troubleshooting Configuration Issues
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INVENTORY PROCESS

Overview
The Inventory Process is a collection of configurable settings used by the ServiceMax
inventory engine in the specific context of an inventory-related transaction such as Stock
Transfer, RMA, or Parts Order. Examples of inventory processes are Posting of Stock
Transfer to Inventory and Processing Receipts in an RMA. Inventory processes can
be enabled on standard ServiceMax objects as well as custom objects. When users run an
inventory process, product stock will be updated depending upon how the process is con-
figured.

See Sample Inventory Processes for examples of creating and deploying custom
inventory processes.

The following is a list of preconfigured inventory processes provided in ServiceMax.

Object Record Type Process Name

Parts Order RMA Process Receipts

Parts Order Shipment Process Shipments - Basic

Parts Order Shipment Process Shipments - Advanced

Work Order Usage/Consumption Post Usage to Inventory

Work Details Request/Receipt Process Receipts

Parts Request N/A Process Receipts From Internal Locations

Parts Request N/A Process Receipts From Suppliers

Stock Transfer N/A Post To Inventory

Stock Adjustment N/A Post To Inventory

Steps in Creating an Inventory Process
The following picture depicts the complete flow involved in setting up an inventory process
and deploying it to end users. The key to successful rollout of an inventory process is
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identifying all the process rules and needs for your organization (first 6 steps listed below)
before defining the process using ServiceMax screens. It is recommended to use an Excel
workbook to capture answers to all the configurable parameters of an inventory process.

Figure 1: Inventory Process Steps

Access and Permissions

Actions User Permissions Needed

To view Inventory Processes: "Read" on ServiceMax Processes and ServiceMax Config Data

To create or edit Inventory
Processes:

"Create" and "Update" on ServiceMax Processes and Ser-
viceMax Config Data

To delete Inventory Pro-
cesses:

"Delete" on ServiceMax Processes and ServiceMax Config
Data

Inventory Process
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Click Home > ServiceMax Setup > Service Flow Manager > Inventory Process to
view the standard inventory process screen, as shown below.

Figure 2: Standard Inventory Process Screen  

In the Standard Inventory Process screen:

The top section shows standard (pre-configured) inventory processes. The bottom
section shows custom inventory processes.

Select a standard process and then click View to see the details of the preconfigured
process. Standard inventory processes cannot be modified.

To create a custom inventory process from scratch, click New.

To create a custom inventory process from an existing standard or custom process,
select the process and then click Clone.

To edit a custom inventory process, select the process from the list and click Edit.

To remove a custom inventory process, select the process from the list and click
Delete.

Click Back To Setup Home to return to the ServiceMax Setup home page.

Inventory Process Fields
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Fields Description

ServiceMax
Module

The ServiceMax module this inventory process is related to.

Inventory
Process ID

A unique ID to identify the inventory process.

Process Name Name of the process. For example, "Process RMA Receipts."

Description Detailed description of the inventory process.

Parent
Object Name

Name of the parent/main object on which this inventory process is used.
Examples are Parts Order, Work Order and Parts Request.

Is Multiline
Transaction?

Indicates if this inventory transaction involves only one product (in the main/-
header object) or if it involves multiple line items (typically in a child/related
object).

Child Object
Name

Name of the child/related object if it is a multiline transaction.

Child Record
Type

Name of the record type to filter the child records.

Error Mes-
sage for Par-
ent

Error message to be displayed if the header record does not meet the entry cri-
teria for the process. For example, if an RMA is Closed or Canceled.

Error Mes-
sage for
Child

Error message to be displayed if no line records meet the entry criteria for the
process. Example, all lines in a Parts Request have been received fully or closed.

Product
Field

The Product field (in header or line object) to be considered for the inventory pro-
cess.

Product
Attribute

Product attribute to be displayed by the inventory engine for this process.
Example: Model Number, Name or Description.

Original
Quantity
Field

Name of the field in the header or line object that indicates the original trans-
action quantity. For example, in a parts request, it will be the Requested Quant-
ity.

Is Actual
Quantity
Entered

Indicates if users are allowed to enter an Actual Quantity against the expected
quantity. This is typically set to false in ‘Post to inventory’ transactions like Work
Order Usage or Stock Transfer.

Actual Quant-
ity Field

Name of the field in the header or line object that indicates the actual transaction
quantity. For example, in a parts request, it will be the Received Quantity.

Inventory Process
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Fields Description

Allow Excess
Quantity

Flag indicates if users should be allowed to enter an actual quantity more than the
expected quantity.

Allow Par-
tial Quant-
ity

Flag indicates if users should be allowed to enter an actual quantity less than the
expected quantity.

Close Par-
tial Lines

Flag indicates if users can close a line after entering a partial actual quantity.

Serial Selec-
tion
Required

Indicates if this inventory process requires selection of serial numbers.

Serial Num-
ber Unique-
ness

Indicates the level of enforcement required on uniqueness of serial numbers.
Options are Do Not Enforce, Soft (Warning only) and Strict (Do not allow
duplicates).

Number of
Stock Loca-
tions

Number of stock locations used/impacted by this process. Can be None, One or
Two.

First Loca-
tion Field

Name of the field in the header or line object that indicates the source (first) loc-
ation. For example, in a stock transfer, it will be Source Location.

First Loca-
tion Stock
Status

Stock status to be used to locate the stock records from the source (first) loc-
ation.

First Loca-
tion Stock
Action

Action to be performed on stock records from the source (first) location. Options
are Increase, Decrease , or Set.

Second loc-
ation Field

Name of the field in the header or line object that indicates the target (second)
location. For example, in a stock transfer, it will be Destination Location.

Second Loca-
tion Stock
Status

Stock status to be used to locate the stock records from the target (second) loc-
ation.

Second Loca-
tion Stock
Action

Action to be performed on stock records from the target (second) location.
Options are Increase, Decrease, or Set.

Non-Stock-
able Loca-
tions

Indicates which, if any, of the two locations are required to be stockable. Options
are Location 1 Non-Stockable, Location 2 Non-Stockable, and Both are
Stockable.
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Fields Description

Notify on
Negative
Stock

Email ID to which notifications regarding negative stock are sent for this invent-
ory process.

Send Email
to Location
Owner

Flag indicates if negative stock alerts must be sent to the stock location’s owner
in addition to the above email ID.

Stock His-
tory
Required

Indicates if this inventory process is required to post a history record.

History
Tracking
Level

Level of history tracking required for this inventory process. Options are Stock
History, Serial History and Both.

Stock His-
tory Header
Field

Name of the field in ServiceMax Stock History object that points to the head-
er/parent object.

Stock His-
tory Line
Field

Name of the field in ServiceMax Stock History object that points to the line/child
object.

Related
Object Name

Name of the related object on which updates should be performed as part of this
inventory process. For example, when a shipment is initiated for a parts request,
the parts request line could be updated with the ‘initiated quantity.’

Related
Object Field
Name

Name of the Quantity field to be updated in the related object.

Related
Object Field
Action

Type of action to be performed on the related object quantity field. Options are
Increase, Decrease, and Set.

Closure
Action Field
Name

Name of the field in the header or child object that should be updated when the
header/child no longer meets the entry criteria as a result of user’s inputs. For
example, when a parts request line is fully received, the line status could be set
to Closed.

Closure
Action Field
Value

Value to be set in the header or child object field.
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Creating/Editing Custom Inventory Processes

To create a new inventory process:

1. Select an existing standard or custom process by checking the Select checkbox in
the list and then click Clone. Alternatively, to edit an existing inventory process,
select the process from the list and then click Edit. Note that Clone and Edit modes
display the same screen. A sample ServiceMax Processes screen appears when the
Process Information tab is selected as shown below:

Figure 3: Process Information Screen

2. In the Process Information tab:
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Select the ServiceMax module to which this process is linked.

Enter a unique ID for this process. ServiceMax automatically creates a submodule
with the same ID.

Enter the process name. The name entered here appears on the ServiceMax
Inventory Processing screen when the user launches the process.

Enter a detailed description of the process.

Select the main or parent object for this inventory process. This can be a standard
ServiceMax object or a custom Salesforce object created in your implementation
of ServiceMax.

Inventory processes can be configured for the standard Salesforce object 'Quote'
and any other standard Salesforce object depending on the ServiceMax license.

Note: Fields related to some standard objects such as Cases and Oppor-
tunities are available for use in setting picklist values only if allowed by
your ServiceMax license. Please contact your ServiceMax administrator to
know the type of license used by your organization.
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Indicate if this process involves multiple line records. This is true for most trans-
actions that involve processing of more than one product.

If this is a multi-line process, select the child object that contains the line inform-
ation. For example, if the main/parent object for this process is Stock Transfer, the
child will be Stock Transfer Line.

If the child object contains only one lookup field to the parent object, it is selected
automatically. However, in some cases, it is possible that the child object may
have more than one reference to the parent object. In such cases, select the spe-
cific field that links the child to the parent.

If this process applies to only a subset of child records, select the record type to fil-
ter the child records.

Click the Entry Criteria or Entry Criteria tab. An Entry Criteria screen appears
as shown below.

Figure 4: Entry Criteria Tab

3. In the Entry Criteria tab:
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Using the combination of field name, operator and value, enter the applicable entry
criteria for the main/parent object. Use the buttons marked with x and + to
remove and add conditions respectively. If required, use the Advanced Expression
to enter conditions such as
(1 AND 2) OR 3.

When entering values, in addition to literal values you can use the predefined val-
ues listed below for certain field types:

Field Data Type Literal* Effect

Date TODAY Match date to today's date

Date TOMORROW Match date to today + 1

Date YESTERDAY Match date to today - 1

Date THIS_WEEK Check if date is in the current week

Date THIS_MONTH Check if date is in the current month

Date NEXT_WEEK Check if date is in the next week

Date NEXT_MONTH Check if date is in the next month

Date LAST_WEEK Check if date is in the last week

Date LAST_MONTH Check if date is in the last month

Date NEXT_90_DAYS Check if date is in (tomorrow + 90)

Date LAST_90_DAYS Check if date is in (yesterday - 90)

Date NEXT_N_DAYS:N Check if date is in (tomorrow + N)

Date LAST_N_DAYS:N Check if date is in (yesterday - N)

Lookup (User) SVMX.CURRENTUSER Use login user's ID

* Literals are case-sensitive.
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When a user initiates this process, the Inventory screen appears only if the ori-
ginating record matches the entry criteria. You can specify the error message to
display to the end users if the record does not match criteria.

Similar to the header entry criteria, you must also qualify the line records for this
inventory process. Enter the appropriate line criteria and the error message.

Using the ServiceMax translation workbench, you can enter various language trans-
lations for the header and line error messages. To do so:

Navigate to Home > ServiceMax Setup > Translations.

Select the module you entered in the Process Information tab for this inventory
process.

Select the submodule name that matches this inventory process name.

Click the User Inputs or User Inputs tab. The User Inputs screen appears as
shown in the image below.

Figure 5: User Inputs Screen

4. The User Inputs tab is used to define rules related to capturing information when
this process is initiated by users. In the User Inputs tab:
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If the header or child objects contain only one reference to the Product object, it is
selected automatically. However, in some cases, it is possible that the header or
child objects may have more than one reference to the Product. In such cases,
select the specific Product field that should be used by the inventory screen. If this
is a multi-line process, only the Product fields from the line object appear.

Select the Product attribute you want the end users of this process to see in the
inventory screen. If you want a combination of Product Name and model number,
you can create a formula field in the Product object and select it here.

Select the quantity field that should be considered by the inventory screen as the
original quantity. If this is a multi-line process, all Number fields from the line
object appear.

If this process requires the users to enter an actual quantity against the original
quantity, indicate the same. Some processes may not require this capability. For
example, when posting Work Order usage to inventory, the used quantity is
already captured in the Work Details screen.

In the above case, select the actual quantity field. The inventory screen will
prompt the user to enter a valid quantity for this field.

Indicate if this process allows the actual quantity to be more than the original
quantity.

Indicate if this process allows the actual quantity to be less than the original quant-
ity.

If the process allows the actual quantity to be less than the original quantity, indic-
ate if the users can short-close the lines when the quantity is less. The Inventory
screen will show/enable the Close Line checkbox only if this feature is enabled.

Indicate if this process requires capturing of serial numbers for the products. While
there could be exceptions, it is recommended that this feature be used con-
sistently across all the inventory processes.

If serial numbers are captured, indicate how you want ServiceMax to enforce
uniqueness of serial numbers. To ensure high quality of data, Strict (Block Duplic-
ates) is the recommended setting. If you select Soft (Warning only), a warning
message appears about duplicate serial numbers but users will be allowed to com-
plete the transaction.

Click the Stock Updates button or the Stock Updates tab. The Stock Updates
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screen appears as shown in the figure below:

Figure 6: Stock Updates Screen

5. The Stock Updates tab is used to configure how stock information is retrieved and
saved by the ServiceMax inventory screen. In the Stock Updates tab:

If no stock updates are needed for this inventory process, select None in the num-
ber of locations. If the inventory process updates stock in only one stock location,
select One. If the inventory process updates stock in two stock locations, select
Two.

Note: Stock location is a combination of location and status. Even if the
inventory process deals with only one location, you must select Two if
the stock moves from one status to another. For example, when posting
Work Order usage to inventory, stock is consumed from only one location
but it moves from Available to Consumed status. Hence it is configured
to use two locations.
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Indicate if the first location is in the header or child object. Depending on this, all
Location lookup fields from the corresponding object are displayed for selection.

Select the first location, status and type of stock update action to be performed on
the first location.

Indicate if the second location is in the header or child object.

Select the second location, status and type of stock update action to be performed
on the second location.

Select the stockability requirements for the process. For example, when shipping
parts to a customer or receiving parts from a supplier, you may not want to track
stock in the customer or supplier location. If the inventory process requires both
locations to be stockable, select Both Are Always Stockable. If either location 1
or location 2 can be a non-stockable location, select the appropriate value. Note
that one of the locations must be a stockable location.

If your organization does not block transactions that result in negative stock, you
can get email notifications after inventory is updated. Enter an email ID to receive
negative stock alerts. To avoid ongoing maintenance, it is recommended to use a
distribution list or group email ID.

In addition to the above email ID, indicate if you want the location record’s owner
to receive negative stock alerts. This can be useful to enforce process discipline.

Indicate if you want ServiceMax to automatically post a history record for this
inventory process.

If you select to track history, indicate the level of granularity required in history
tracking. Stock History maintains history at the product and location level. Serial
History maintains history at the serial number level, resulting in more history
records to be created. Stock & Serial History will result in creating both types of his-
tory records. One of the key factors to consider when choosing this is the volume
of inventory transactions and the average number of serial numbers in each trans-
action. This will directly impact the space usage in Salesforce.

If you enabled history tracking, select the fields in the Stock History object that
points to the parent and child objects, as applicable.
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Click the Related Transactions button or the Related Transactions tab. The
Related Transaction screen appears as shown in the figure below:

Figure 7: Related Transactions Screen

6. The Related Transactions tab is used to configure automatic quantity updates in
related transactions. For example, when a shipment is processed against a parts
request, the shipped quantity in the parts request can be increased to provide better
visibility to the requestors. In the Related Transactions tab:

Select the related object that requires an update.

Select the quantity field that needs to be updated.

Select the action to be performed on the quantity field. Increase or Decrease will
result in the quantity field being increased/decreased by the actual quantity
entered by the user.

Add or remove as many field updates as you require using the buttons marked with
+ and x.

Click the Closure Actions button or the Closure Actions tab. The Closure
Actions screen appears as shown in the figure below.
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Figure 8: Closure Actions Screen

7. In the Closure Actions tab, you can specify the field updates required on the parent
and child records when the user completes the inventory transaction. In the Closure
Actions tab:

Select the field name to be updated.

Enter the value to assign to the field. In addition to literal values, you can use the
predefined values listed below for certain field types.

Field Data Type Literal* Effect

Date TODAY Set to today's date

Date TOMORROW Set to today + 1

Date YESTERDAY Set to today - 1

Date NEXT_Nth_DAYS:N Set to Tomorrow + N

Date LAST_Nth_DAYS:N Set to Yesterday - N

Lookup (User) SVMX.OWNER Set to ID of the record owner

Lookup (User) SVMX.CURRENTUSER Set to ID of the login user

* Literals are case-sensitive.

Add or remove as many field updates as you require using the buttons marked with
+ and x.

ServiceMax automatically performs the line closure actions when:

The actual quantity entered is greater than equal to the expected quantity.

When the user explicitly closes the line.

Note: ServiceMax automatically performs the header closure actions
when none of the lines match the entry criteria specified in the Entry Cri-
teria tab. If you have specified any header-level closure actions, you
MUST specify line level entry criteria. Header closure actions will be
ignored otherwise.

8. Click Save.
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Deleting Custom Inventory Process

To delete one or more inventory process:

1. Check the Select checkbox adjacent to the process you want to delete in the custom
processes list.

2. Click Delete and then click OK when prompted for confirmation. The selected rows
are deleted and the process list is refreshed.

Note: Standard ServiceMax inventory processes cannot be deleted.

Deploying Inventory Process
Once you have defined a custom inventory process, follow the steps below to enable and
deploy it.

1. Navigate to Setup > App Setup > Create > Objects.

2. Click the main object for which you have built the inventory process. For example, if
you have created a custom Process Shipments process that works on the Parts Order
object, select Parts Order.

3. Navigate to the Custom Buttons and Links section and then click New.

4. In the New Button or Link screen:

a. Enter a name for the button or link.

b. Select the applicable Display type.

c. In Behavior, select Display in the existing window without sidebar or header.

d. In Content Source, select URL.

e. In the content, enter the following link: /apex/SVMXI_INVT_SmartEngine?h-
drId={ObjectId}&SMid={InventoryProcessID}

f. Select the text {Object Id} and insert the field name of the Id field from the
object. For example, if the process is set up on Parts Order object, insert:
{!SVMXP__RMA_Shipment_Order__c.Id}
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g. Select the text {Inventory Process Id} and replace it with the inventory pro-
cess ID.

h. Click Save.

5. Add the above button/link to the applicable page layouts.

See Also:

Modules

Submodules

Display Tags

Configuration Profile

Auto-Entitlement Rules

Counter Rules

Inventory Process

Dispatch Process

Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings
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MANAGE PM PROCESS

Overview
Use this option to qualify Preventive Maintenance (PM) Plans for processing and con-
figuring rules for creating work orders and cases. You can also setup the process(es) to
run automatically on a schedule.

Access and Permissions

Actions User Permissions Needed

To view PM Processes: ʺReadʺ on ServiceMax Processes and ServiceMax Config Data.

To create or edit PM Pro-
cesses:

ʺCreateʺ and ʺUpdateʺ on ServiceMax Processes and ServiceMax
Config Data.

To delete PM Processes: ʺDeleteʺ on ServiceMax Processes and ServiceMax Config Data.

Click Home > ServiceMax Setup > Service Contracts > Manage PM Process to
view the Preventive Maintenance Process screen as shown below.

Figure 1: Standard/Custom Preventive Maintenance Processes

Standard Preventive Maintenance Process
As shown in Figure 1, in the Standard Preventive Maintenance Process area you can:

View a standard preventive maintenance process.

Clone a standard preventive maintenance process.

Return to the Setup Home screen.
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Viewing a Standard Preventive Maintenance Process

To view a pre-configured map:

1. In the Standard Preventive Maintenance Process area, click the View button.

2. View the process in the appropriate window.

Cloning a Standard Preventive Maintenance Process

To clone a pre-configured map:

1. In the Standard Preventive Maintenance Process area, click the Clone button.

2. In the next screen, edit the necessary fields.

Custom Preventive Maintenance Process
As shown in Figure 1, in the Custom Preventive Maintenance Process area, you can:

Create a new custom preventive maintenance process.

Edit a custom preventive maintenance process.

Clone a custom preventive maintenance process.

Delete a custom preventive maintenance process.

Creating/Editing Custom Preventive Maintenance Pro-
cesses

To create a new custom preventive maintenance process:

1. In the Custom Preventive Maintenance Process area, click the New button.

2. Alternatively, to edit an existing preventive maintenance process, select the process
and then click Edit.

3. In the General Info area, enter the Process Name, Process Id, and a Description
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204 Viewing a Standard Preventive Maintenance Process



Manage PM Process

of the process.

4. Check the Active checkbox to make the process active.

Note: The PM Process engine will only consider processes that are active.

Figure 2: Setup Preventive Maintenance Process

5. In the Preventive Maintenance Plan Configuration area, enter the number of days you
want the process engine to create the work order prior to the scheduled date in the
field titled, Create Work Order 'n' days before scheduled date (see figure
below).

Figure 3: Plan Configuration Area

Note: The scheduled date represents the date you have scheduled the
process engine to run to create the preventive maintenance process.

6. Use the expression builder to select the criteria to determine how the PM plan records
will qualify when creating Work Orders (see figure below). Select one of the options
below.

a. Select an option from the Use Existing Criteria picklist.

i. Click the View/Edit link to view the existing criteria.
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ii. Edit the criteria by entering an Advanced Expression (see figure below).

Figure 4: Expression Builder (Use Existing Criteria)

7. Create new criteria by clicking the Create New link (see figure below).

a. In the Expression Name field, enter an expression name.

b. In the Expression Id field, enter an expression Id.

c. In the Field Name picklist, select a field name.

d. Select an operator in the Operator picklist.

e. Enter a value in the Value field.

f. Use the +/- icons to add or delete expressions.

g. If applicable to your process, enter an Advanced Expression.

Figure 5: Expression Builder (Create/New)

8. Click theWork Order Rules tab to set up the work order rules.

9. In the Mapping & Rules to Create Work Order area (see figure below):

a. Select the number of Work Orders you want created in the Number of Work
Orders picklist.

b. Chose the field map from the Field map to use picklist.

c. Assign the work order (Technician,Queue, Dispatcher) in the Assign To pick-
list.
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d. Based on your Assign To picklist selection, select a name from the appropriate
picklist.

Figure 6: Mapping & Rules to Create Work Order Area

10. In the Mapping & Rules to Create Task and Required Parts area (see figure
below):

a. Select a task object from the Select task object picklist.

b. Select a task map from the Task map to use picklist.

c. Select a required parts map from the Required Parts map to use picklist.

Figure 7: Mapping & Rules to Create Task and Required Parts

11. In the Mapping & Rules to Create Case area (see figure below):

a. Check the Create a Case checkbox to create a case.

b. If you checked the Create a Case checkbox:

i. Select a field map for it in the Field map to use picklist.

ii. Assign the case by choosing a name from the Assign To picklist.

Figure 8: Mapping & Rules to Create Case
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12. Click the Schedule & Notifications tab.

13. In the appropriate area, select the time and day you want your process to run (see fig-
ure below).

a. From the Run At picklist, select the time you want your process to run.

b. Select Day of the Week from the appropriate picklist.

c. From the picklist titled,On these days, select the days you want the process to
run.

i. Select a day from the Available list.

ii. Click the Add arrow to move the day from the available list to the Chosen list.

iii. To remove a day from the Chosen list, select the day and click the Remove
arrow to move the day from the Chosen list to the Available list.

14. You can set up your process to run at multiple days/times. Use the +/- icons to add
or delete process runs.

15. Select your time zone from the Time zone picklist.

Note: The Chosen list represents the days you want your process to run.

Figure 9: Day/Time Schedule

16. In the Specify recipients of notifications and alerts area (see figure below):

a. Enter an email address for successful notifications in the appropriate text field.

b. Enter an email address for error notifications in the appropriate text field.

Manage PM Process
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c. Check the Enable Login checkbox.

d. Check the Create an activity in the PM plan upon successful execution
checkbox if applicable.

e. Check the Create an activity in the PM plan if errors occur in execution
checkbox if applicable.

17. Click any of the previous tabs (Work Order Rules, General Info) to make any
changes.

18. Click the Quick Save button to save the process and keep the process open.

19. Click the Save and Close button to save and close the process.

20. Click the Cancel button to cancel the process.

Note: You cannot retrieve processes after you have canceled them.

Figure 10: Notifications and Alerts

Cloning a Custom Preventive Maintenance Process

To clone a custom preventive maintenance process:

1. Select a process and click the Clone button.

2. In the General Info area, change the Process Name and Process Id.

3. Make any necessary changes to theWork Order Rules and the Schedule & Noti-
fications.

4. Click the Quick Save button to save the process and keep it open. Click the Save &
Close button to save and close the process.
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Note: When cloning a process, you must change the following fields: Process
Name and Process Id.

Deleting a Preventive Maintenance Process

To delete a custom preventive maintenance process:

1. Select a process and click the Delete button.

2. Confirm that you want to delete the process.

Note: You cannot retrieve a process once you have deleted it.

Manage PM Process
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PM PLAN TEMPLATES

Overview
Use this option for creating preventive maintenance plans. The template includes defin-
itions for products, schedules, and tasks to be performed as part of Preventive Main-
tenance. You must create the work templates you want associated with your PM plan prior
to setting up your PM Plan template.

Access and Permissions

Objects Read Create Update/Modify Delete

PM Plan Template Yes Yes Yes Yes

PM Schedule Template Yes Yes Yes Yes

PM Applicable
Products

Yes Yes Yes Yes

You can access the PM Plan template screen by either clicking the PM Plan Template link
from the Home Page or via the following path: Home > ServiceMax Setup > Installed
Base & Entitlement > PM Plan Template. The PM Plan Templates screen appears as
shown below.

Note: You must set up your Work/Task Template prior to setting up your PM
template.

Figure 1: PM Plan Template Home Page
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To create a new PM plan template:

1. Click the New button in the PM Plan Template screen. If updating an existing PM plan
template, click a link from the Recent PM Plan Templates area. All recent PM Plans
will display in this area.

2. Enter the PM Plan Template name in the appropriate text box. See figure below.

3. Enter or use the Lookup feature to enter the Installed Product Criteria.

4. Select one of three options for the coverage type (Account, Product, and Location)
from the Coverage Type picklist.

a. Account (Visit Only). If you select Account, you will not have install product
information. You can use the template in Accounts and in Service Contracts.

b. Product (Must Have IB). If you select a Product, you must have an Installed
Based (IB) product. You can use the template in IB or in Service Contracts if it has
a covered product.

c. Location (Must Have Location). If you select Location, you must have a location.
You can use the template for Locations or Service Contracts with a covered loc-
ation.

5. Create the schedule for the PM plan in the Schedules tab (see figure below):

a. Enter the sequence number in the Sequence field. (The sequence field is for those
non reoccurring PM templates. It designates when a particular PM template plan.

b. In theWork Order Purpose field, enter the task template or use the Lookup
search tool to find it. (You must set up your Work/Task Template prior to setting
up your PM template).

c. Enter the Frequency number.

d. Select a frequency unit (Years,Months,Weeks) in the Frequency Unit picklist.

e. Check the Recurring checkbox. If you do not check the Recurring checkbox, the
sequence only occurs once.

PM Plan Templates
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f. To add a row in the grid, click the Add a row icon. Add data to the required files in
the row.

g. To delete a row in the grid, click the Delete icon next to the row you want to
delete.

Figure 2: PM Plan Template Screen (Schedules Tab)

6. Click the Applicable Products tab. In the Applicable Products tab (see figure
below):

a. In the Product field, enter a product name or use the Lookup tool to search for the
product.

b. In the Product Line picklist, select a product line (Accessory,Network, Soft-
ware, and so on).

c. In the Product Family picklist, select a product family.

d. To add a row in the grid, click the Add a row icon. Add data to the required files in
the row.

e. To delete a row in the grid, click the Delete icon next to the row you want to
delete.

Figure 3: PM Plan Template Screen (Applicable Products Tab)

Creating/Editing PM Plan Templates 213



7. Click the Save button to save the plan template and remain in the PM plan template
screen.

8. Click the Save & New button to save the PM plan template and create a new one.

9. Click the Cancel button to cancel the PM plan template.

PM Plan Templates
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DISPATCH PROCESS

Overview
Dispatch process is a collection of configurable settings used by ServiceMax dispatch
engine to queue, assign or schedule Work Orders. Dispatch processes are used to auto-
matically route inbound Work Orders to dispatchers or technicians. A dispatch process can
be based on simple assignment rules or on the OptiMax engine's use of weighted con-
straints to assign Work Orders to technicians and perform route optimization. Depending
on your organization’s dispatching needs you can create and deploy a combination of
simple (Immediate dispatch) and advanced (Optimized Batch) dispatch processes. Ser-
viceMax also allows you to deploy unlimited dispatch processes for various service ter-
ritories.

If your organization uses advanced dispatch management using OptiMax, it is important
that all the prerequisite information is set up properly. Successful dispatching relies on the
following information:

Service Teams and technicians with product specialization, expertise and geographic
codes

Territories with adjacency and coverage

MTTS (Mean-Time-To-Service) Rules

Territory Matching Rules

See MTTS Rules and Territory Matching Rules to learn more about MTTS Rule and Ter-
ritory Matching Rules. To learn more about setting up ServiceMax territories, service
teams and technicians, see the appropriate topic in the See Also section.

In addition, see Dispatch Optimization Using OptiMax for more information regarding
OptiMax functionality.
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Access and Permissions

Actions User Permissions Needed

To view dispatch pro-
cesses:

"Read" on ServiceMax Processes, ServiceMax Config Data, Tech-
nician, Territory, and Work Order

To create or edit dis-
patch processes:

"Create" and "Update" on ServiceMax Processes and ServiceMax
Config Data

"Read" on Technician, Territory, and Work Order

To delete dispatch pro-
cesses:

"Delete" on ServiceMax Processes and ServiceMax Config Data

Click Home > ServiceMax Setup > Dispatch Management > Dispatch Processes
to view the Dispatch Processes screen as shown in the figure below.

Figure 1: Dispatch Processes Screen

Considering the unique nature of dispatch processes, there is no sample or standard pre-
configured process available with the ServiceMax installation. All dispatch processes must
be created based on your organization’s requirements.

In the Dispatch Processes screen:

Dispatch Process
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To create a new dispatch process, click New Process.

To create a dispatch process from an existing process, select the process from the
list and click Clone.

To edit a dispatch process, select the process from the list and click Edit.

To remove a dispatch process, select the process from the list and click Delete.

To view the history of OptiMax jobs for a dispatch process, select the process from
the list and click Show Jobs. The bottom section of the screen shows the list of jobs
for the process, both completed and scheduled as shown in the figure below.

Figure 2: Show Jobs list
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Click a job number to see its details in the Job Details tab. This information is typ-
ically used in the troubleshooting of jobs. The screen will indicate if there were any
errors and also statistics returned by the OptiMax engine.

Figure 3: Job Details Screen

Dispatch Process
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If any of the jobs had failed, it will be indicated in the Job Status field. Depending
upon the type of error, you may want to simply re-run the job without having waiting
for the next scheduled run. To do so, select the job entry from the list and click Run
Job Now. Once the job starts, a new entry will appear in the jobs list. Use this option
with extreme caution as it may interfere with other jobs that may be running and
may impact performance.

To avoid conflicts between Work Order dispatch rules, you must define the sequence
in which the rules must be processed. The first matching rule will be considered for a
Work Order. To define this, click Dispatch Process Sequence. In the popup screen
(sample below), arrange the dispatch processes as needed and then click Save.

Figure 4: Dispatch Process Lists Screen

Click Back To Setup Home to return to the ServiceMax setup home page.

Dispatch Process Fields

Fields Description

Process Name Name of the process. For example "North America Automatic Dispatch –
Field Service."

Description Detailed description of the dispatch process.
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Fields Description

Dispatch Method Indicates the method of dispatch to be used when a Work Order matches
the entry criteria for this process. Options are Immediate Dispatch that
uses assignment rules and Optimized Batch that uses OptiMax dispatch
optimization engine.

Entry Criteria An expression based on Work Order Field values that defines the qual-
ification/entry criteria for Work Orders to be processed using this dispatch
process.

Assignment Rule
Name

Name of the simple assignment rule. Applicable for Immediate Dispatch.
For example, "California PM Work Orders."

Description Detailed description of the simple assignment rule. Applicable for Imme-
diate Dispatch.

Rule Criteria An expression based on Work Order Field values that defines the qual-
ification/entry criteria for Work Orders to be processed by this assignment
rule.

Assign Work Order
To

Type of the target recipient of the Work Order if the assignment rule cri-
teria are met. Options are Technician, Dispatcher or Queue.

Technician The technician to assign the Work Order to. This is a lookup to an existing
technician record in ServiceMax. Applicable for Immediate Dispatch.

Queue Name of the Salesforce Queue to assign the Work Order to. Applicable for
Immediate Dispatch.

Dispatcher The dispatcher to assign the Work Order to. This is a lookup to an existing
Salesforce user. Applicable for Immediate Dispatch.

Assign Work Order
To (Exception)

Type of target recipient if the Work Order does not match any simple assign-
ment rule criteria. Options are Technician, Dispatcher or Queue.

Territory Name of the territories that use this dispatch process. This is a lookup to an
existing territory in ServiceMax.

Prioritization
Rule Name

Name of the prioritization rule. Set automatically to four predefined buck-
ets as P1, P2, P3 and P4. P1 indicates the highest priority.

Prioritization
Rule Description

Detailed description of the prioritization rule.

Consider Expert-
ise/Product Spe-
cialization

Indicates if OptiMax should consider the technician’s expertise or product
specialization to schedule a Work Order.
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Fields Description

Consider Pre-
ferred Technician

Indicates if OptiMax should consider the technician’s status as a preferred
technician to schedule a Work Order.

Route Type Type of route to be applied when performing route optimization. Closed
Route results in a circular route with technicians returning to the home base
at the end of the day. Open Route does not return the technician to home
base.

Retain Appoint-
ment

Flag indicates if OptiMax should try to honor existing Work Order appoint-
ments on technician calendars.

Retain Assignment Flag indicates if OptiMax should try to honor existing Work Order assign-
ments to technicians.

Time Window
Cost/Weight

On a scale of 1 to N, indicates the relative weight or cost of adherence to
Work Order time windows. Work Order time windows are dictated by book-
ing window, SLA or access hours. Use a higher value to achieve higher
levels of conformance to time window commitments.

Total Distance
Cost/Weight

On a scale of 1 to N, indicates the relative weight or cost of total distance
traveled by a technician. Use a higher value to reduce the average total dis-
tance traveled.

Route Distance
Cost/Weight

On a scale of 1 to N, indicates the relative weight or cost of distance of any
given route of a technician on a given day. Use a higher value to reduce the
average route distance.

Route Time
Cost/Weight

On a scale of 1 to N, indicates the relative weight or cost of time taken by a
route. Higher value will ensure the maximum time is not exceeded while
scheduling.

Expertise/Product
Cost/Weight

On a scale of 0 to N, indicates the relative weight or cost of expertise and
product specialization required for a Work Order.

Overtime Tol-
erance

Number of minutes to extend past technician’s working hours to accom-
modate scheduling.

Schedule Days Days of the week during which the OptiMax job should run.

Time zone The time zone in which the scheduled jobs must run.

Start Date Date on which the OptiMax job for this process should go into effect.

Type of run Full or Incremental. Indicates the scope of work orders to be considered for
the job run. Full applies the broader entry criteria for the dispatch process,
Incremental applies additional criteria to select a narrow set of work
orders.
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Fields Description

Run at Schedule time for the OptiMax job in the given time zone.

End Date Expiry date for the OptiMax job.

Planning horizon
lead time

Amount of time to be skipped from now when scheduling work orders on
technician calendars.

Lead-time type Unit of measure for lead-time: Hours or Days.

Planning Horizon
Start

Earliest day on which Work Orders can be scheduled by OptiMax. 0 indic-
ates today, 1 indicates today + 1 and so on.

Planning Horizon
End

Starting from the planning horizon start, number of days for which tech-
nician capacity is calculated.

Success Email Email ID to send notifications of successful completion of OptiMax jobs.

Error Email Email ID to send notifications regarding errors occurred in OptiMax jobs.

Steps in Creating Dispatch Processes
The following picture depicts the complete flow involved in setting up and deploying a dis-
patch process. The key to the successful rollout of a dispatch process is documenting the
scope, end-to-end workflow and dispatch priorities for your organization before starting to
enter data on ServiceMax screens. It is recommended to use an Excel workbook to cap-
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ture answers to all the configurable parameters of a dispatch process.

Figure 5: Dispatch Processes Steps

Creating/Editing Dispatch Processes

To create a new dispatch process:

1. Click New Process. Alternatively, to edit an existing process, select the process
from the list by checking the checkbox adjacent to it and then click Edit. Clone and
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Edit modes display the same screen. A Dispatch Process tab appears as shown below:

Figure 6: Dispatch Process Tab

2. In the Dispatch Process tab:

Enter the dispatch process name. Make sure this name distinctly identifies the pur-
pose of the process and is readable. For example "Northern California PM Dispatch
Process".

Enter a detailed description of the process.

Select the dispatch method. Select Immediate Dispatch if this process will use
simple assignment rules based on which Work Orders will be assigned directly. If
your organization has subscribed to OptiMax and if this process requires using the
OptiMax dispatch optimization engine, select Optimized Batch.

Using the combination of Work Order field name, operator and value, enter the
applicable entry criteria for this process. Only those Work Orders that match the
criteria will be dispatched using the definition of this process. Ensure the entry cri-
teria are exclusive to this dispatch process. Use the buttons marked with x and +
to remove and add conditions respectively. If required, use Advanced Expression
to enter conditions such as (1 AND 2) OR 3.

When entering values in the expressions, in addition to literal values, you can use
the predefined values listed below for certain field types:

Dispatch Process
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Field Data Type Literal* Effect

Date TODAY Match date to today's date

Date TOMORROW Match date to today + 1

Date YESTERDAY Match date to today - 1

Date NEXT_NTH_DAY:N Check if date is in (tomorrow + N)

Date LAST_N_DAY:N Check if date is in (yesterday - N)

Date Time SVMX.NOW Match date and time to current date time

Lookup (User) SVMX.CURRENTUSER Use login user's ID

* Literals are case-sensitive.

3. Click Next >>.

If you selected Immediate Dispatch as the dispatch method, the Assignment Rules
tab as shown below appears. Alternatively, if you selected Optimized Batch as the
dispatch method, continue from Step 5.

Figure 7: Assignment Rules Tab

4. In the Assignment Rules tab:
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If you are in Edit mode, all existing assignment rules in this dispatch process are
displayed.

To edit an existing rule, check the Select checkbox against the rule and then click
Edit.

To delete an existing rule, check the Select checkbox against the rule and click
Delete.

To create a new assignment rule, click New Rule.

Enter a rule name. Make sure the rule name is readable and indicates the pur-
pose of the assignment. For example "San Francisco Work Order Assignment".

Enter a detailed description of the rule.

Using the combination of Work Order field name, operator and value, enter the
qualification criteria for this rule. Make sure the criteria are exclusive between
each rule.

Use the buttons marked with x and + to remove and add conditions respect-
ively. If required, use Advanced Expression to enter conditions such as (1 AND
2) OR 3.

Note: Since the dispatch process entry criteria have already been applied
on the Work Orders, it is not required to repeat the criteria for assign-
ment rules. For example, if the process entry criteria is “State = Cali-
fornia”, the assignment rules do not have to include a condition on State.
The rules can be based simply on the next level of filtering (City, for
example).

5. In the Assign Work Order To field:
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Select Queue to assign the Work Order to a Salesforce queue. Any queues enabled
for the Work Order object are displayed in a list.

Select the appropriate queue name from the list.Select Dispatcher to assign the
Work Order to a specific Salesforce user. Select a Dispatcher name using the Sales-
force user lookup.

Select Technician to assign the Work Order to a technician. Select a technician
name using the Technician lookup.

To schedule the Work Order on the technician’s calendar in the next available slot,
check the Schedule an Event checkbox. The next available slot is automatically
determined based on MTTS (service duration) and the technician’s working hours.

After you have created or edited each rule, click Save.

If no matching assignment rules are found for a Work Order use the Assign Work
Order To field at the bottom of the screen as a catch-all mechanism.

To dictate the sequence in which these rules are processed, click Rule Sequence.
In the popup screen (sample below), arrange the rules as needed.

Figure 8: Rule Sequence Popup

Note: The first matching rule in the list will be applied. If you have hier-
archical rules, you must keep the most granular rules at the top. For
example, if Rule1 is “State = California” and Rule2 is “State = California
and Product = Laptop”, Rule2 must be moved before Rule1. Otherwise,
Rule2 will never be considered for Work Orders with State as California.
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To return to dispatch processes home without saving any changes, click Cancel.

To save the rules and return to dispatch processes home, click Save and Close.

If you selected Optimized Batch as the dispatch method, the Territories tab as
shown below appears:

Figure 9: Territories Tab

6. The Territories tab is used to select the territories that will use this dispatch pro-
cess. In the Territories screen:
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To add a territory, click Add Territory. A blank row will be inserted to the list on
the left. Select the territory using the Lookup icon.

To add multiple territories, enter a keyword on the right and click Go!. The match-
ing territories will be listed at the bottom of the search. Select the territories from
the result set and then click Add Selected.

To remove territories selected already, select the territories by checking the
Select checkbox and then click Delete Territory.

Click Prioritization or the Prioritization tab to view the Prioritization screen as
shown below:

Figure 10: Prioritization Tab

7. The Prioritization tab is used to define up to 4 prioritization rules to sort the list of
qualified Work Orders. In the Prioritization screen:
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It is not required to use all the 4 prioritization rules.

If you are in Edit mode, all existing prioritization rules in this dispatch process are
displayed.

To edit an existing rule, check the Select checkbox against the rule and then click
Edit.

Enter the sorting order in ascending order. The prioritization rule with the lowest
order value will be processed first.

Enter the Rule Name. Make sure the rule name is readable and indicates the pur-
pose of the prioritization. For example "Premier Accounts And Down Situations".

Enter a detailed description of the rule.

Using the combination of Work Order field name, operator and value, enter the pri-
oritization criteria for each rule. Ensure the criteria are exclusive between each
rule. Use the buttons marked with x and + to remove and add conditions respect-
ively. If required, use Advanced Expression to enter conditions such as (1 AND 2)
OR 3.

After you have created or edited each rule, click Save. Alternatively, to undo any
changes you have made, click Cancel.
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Click Constraints or the Constraints tab. A Constraints screen appears as shown
below:

Figure 11: Constraints Tab

8. The Constraints tab indicates the constraints OptiMax should use when dispatching
Work Orders. In the Constraints screen:
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Assign a weight value to Technician attributes to be mapped against Work Orders.
Select a weight value from 1 to 10, with 10 being the highest weight. Move your
cursor along the sliding weight scale to assign a value (from 1 to 10) to the fol-
lowing attributes: (see figure below).

Match Eligibility

Match Expertise

Match Product Specialization

Consider Preferred Technician

Indicate if a technician’s expertise or product specialization should be considered
as a factor. If you select No Match Required, the skill and product specified in
the Work Order will be ignored and will not be a factor when finding suitable tech-
nicians.

Specify any additional Technician parameters to be considered by OptiMax.

Indicate if the nature of the Technician's route should be Open or Closed. (Use
the appropriate picklist to specify the route parameters). A closed route ensures
the Technician returns to the starting location. Select Closed Route if tech-
nicians are expected to return to their home base after the day’s Work Order
assignments. Select Open Route if technicians do not return to home base.

Enter any Overtime Tolerance minutes in the appropriate text box.

Indicate how OptiMax should handle existing Work Orders assignments.

Select Yes or No (via picklist) to answer the question, "Keep existing Schedule
of Work Orders?" If you select Yes, technicians that are designated as Pre-
ferred at the Work Order’s Component, Service Contract or Account level will be
given a higher preference for scheduling than other technicians.

Select Yes or No (via picklist) to answer the question, "Keep existing assign-
ment of Work Orders?"

Note: If you select a zero from the 1-10 sliding scale, no weightage will
be given to the attribute. OptiMax will not consider it.
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Note: Quality of location data on Work Order and technician records is
extremely critical for successful and effective assignment, routing and
optimization. In order to obtain high quality output from OptiMax, make
sure the location data is maintained diligently in ServiceMax. Avoid using
PO Box and Suite numbers in addresses since they are normally rejected
by mapping services.

The options at the bottom of the screen indicate how OptiMax must process exist-
ing Work Order appointments on a technician’s calendar. Though not guaranteed
always, OptiMax will attempt to accommodate these preferences as much as pos-
sible considering all other constraints and costs.

To allow Work Orders to extend into a technician’s overtime hours, enter the
amount of tolerance in minutes allowed for overtime processing. This provides an
additional cushion for you to accommodate high priority Work Orders without com-
promising customer commitments.

If a Work Order should be kept in its current schedule (as practically as possible),
select Yes in the Retain Appointment field.

If the Work Order’s technician assignment must also be retained, select Yes in the
Retain Assignment field.

Click Cost Factors or the Cost Factors tab. The Cost Factors screen appear as
shown below:

Figure 12: Cost Factors Tab
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9. In the Cost Factors screen you can fine tune the relative cost/weight of various
factors that influence the choice of the technician for a Work Order and also the appro-
priate slot in the technician’s calendar. In the Cost Factors screen:

Note: When the Slider is dragged to 100, the handle of the slider will not
be visible. Click anywhere on the slider area to view the handle.
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Adjust the slider value between 1 and 100 to set the weight of Work Order time
windows. This indicates how important it is for your organization to adhere to the
time window commitments indicated on a Work Order. Work Order time windows
are dictated by booking window, SLA or access hours in that order. Use a higher
value to achieve higher levels of conformance to time window commitments.

Adjust the slider value between 1 and 100 to set the weight of total distance for all
technicians in a given optimization run. A higher value will force the optimizer to
keep the total distance covered by all the technicians in the given optimization run
to the minimum possible.

Adjust the slider value between 1 and 100 to set the weight of Route Distance for
a technician. When set to a higher value, the total distance traveled by a tech-
nician is kept within the maximum distance limit configured for the technician or
territory (whichever is available).

Adjust the slider value between 1 and 100 to set the weight of time taken by a
route. When set to a higher value, the total time spent by a technician traveling
and servicing Work Orders will be kept within the maximum time limit configured
for the technician or territory (whichever is available).

Adjust the slider value between 1 and 100 to set the relative weight of matching
qualified technicians required for a Work Order. By considering the qualifying tech-
nicians, OptiMax considers the skills, eligibility, and product specialization required
for the Work Order.

The relative values of the above parameters determine what takes precedence.
For example, if the first 4 parameters have the same weight, say 100 (the max-
imum value allowed), then the Work Orders will be scheduled in such a way that:

 All Work Order time windows will be adhered to.

Then, the total distance is kept to the minimum.  

Then, the route distance will be kept within the specified limits.  

Then, the route time will be kept within the specified limits.

When running dispatch optimization in non-STRICTmode, if a constraint has to be
violated, the optimizer will allow the violation of route time constraint first, route
distance constraint next, total distance constraint next, and finally the Work Order
time window.
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Click Scheduling or the Scheduling tab. The Scheduling tab appears as shown
below:

Figure 13: Scheduling Tab

10. In the Scheduling tab, you can specify the schedule for running the OptiMax jobs for
this dispatch process. You can configure jobs to run at different times of the day. Jobs
can be of two types: Full and Incremental. Full run considers all work orders that
match the entry criteria for the dispatch process. Incremental run applies additional
criteria to narrow the scope of work orders considered for dispatching. Typically full
runs are scheduled less frequently (once a day for example), and incremental runs
are scheduled in a higher frequency between two full runs. The purpose of incremental
runs is to process critical work orders that need to be dispatched during the working
hours by rearranging the active schedule of technicians. In the Scheduling screen:

Dispatch Process

236 Creating/Editing Dispatch Processes



Dispatch Process

Use the top left section to specify the job schedule:

If you know the specific times at which a job must run, click Add Schedule. A
blank record will be inserted at the bottom of the job list. Select Type of run
and the time the job must run.

If you like to create multiple job records in one go, click Quick Add. A popup
screen appears. Select Start Time, End Time, and Type of run. Enter the fre-
quency of job and click Add. Multiple job records will be created between the
start time and end time in the specified frequency.

Select the days on which the OptiMax jobs should run and the time zone in which
the job times are specified. This applies to all types of jobs, full and incremental.

Enter a start date, which is mandatory. This allows you to setup a process ahead of
time and deploy it in the future in alignment with your organizational readiness.

Enter an end date. To leave the process perpetually running, leave the end date
blank. Enter a valid date only if you expect to revisit the process later or for trial
deployments.

If the schedule involves incremental runs, define the criteria using the expression
builder. In order to be considered for incremental runs, a work order must qualify
the entry criteria for the dispatch process and the additional criteria specified here.

Enter your planning horizon for full runs. Planning horizon has two elements: Lead-
time and Number Of Days to plan.

Lead-time can be specified as Hours or Days. Use Hours when you have more
than one full run within a day and need more immediate scheduling impact.

For example, to plan for the next week excluding the current day, enter 1 and 5
in the start and number of days. OptiMax calculates the resource capacity based
on this entry.

It is strongly recommended to provide adequate capacity in order to accom-
modate your peak work volumes.

If applicable, enter the lead-time as number of hours to be used for incremental
runs.

Enter an email ID to receive email notifications regarding successful completion of
OptiMax jobs. While this is optional, it is recommended to use this field to receive
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notifications in the initial stages of a process deployment. In addition, to avoid
ongoing maintenance, use a distribution list or group email ID.

Enter an email ID to receive email notifications regarding any errors encountered
from OptiMax jobs. Besides ServiceMax administrators, it is recommended to
include the owners of this dispatch process (service managers) as recipients of
this email. This allows them to resolve any data related issues immediately.

11. Click Save And Close. Saving dispatch process definition might take some time
since the screen connects to the OptiMax engine to perform the necessary validations
before saving. See Manage OptiMax Credentials below.

Note: Fields from some standard objects such as Cases and Opportunities
are available for use in Dispatch processes only if allowed by your ServiceMax
license. Please contact your ServiceMax administrator to know the type of
license used by your organization.

Deleting Dispatch Processes

To delete one or more dispatch processes:

1. Check the Select checkbox adjacent to the dispatch process records you want to
delete.

2. Click Delete and then click OK when prompted for confirmation.

Note: Dispatch processes referred to in other dispatch processes cannot be
deleted.

Manage OptiMax Credentials
When OptiMax was provisioned and enabled for your organization, one of your Salesforce
user logins with System Administrator privileges would have been configured as the
OptiMax User. The purpose of this login is to enable ServiceMax to authenticate with
OptiMax, as well as for the OptiMax engine to connect to ServiceMax to perform dispatch
optimization.
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Whenever the password or security token for the OptiMax user changes, you must imme-
diately publish the change to OptiMax. Not doing so in a timely fashion will result in failure
of OptiMax jobs.

To update OptiMax login credentials and success/error notification

settings for OptiMax:

1. Click Home > ServiceMax Setup > Dispatch Management > OptiMax Set-
tings. The OptiMax Credentials screen appears:

Figure 14: OptiMax Credentials Screen

2. Enter the user name, password, and security token.

3. Enter the email ID to receive notifications regarding successful OptiMax runs. To
ensure scalability, use a distribution list instead of a specific user’s email ID.

4. Enter the email ID to receive notifications regarding any failures encountered in
OptiMax runs. To ensure scalability, use a distribution list instead of a specific user’s
email ID.

5. Check Is Sandbox if your Org type is Sandbox.

6. Click Submit to save your changes.

Configuring MTTS Rules
MTTS (Mean Time To Service) is a combination of the industry standard terms MTTR and
MTTI.

Configuring MTTS Rules 239



MTTR is an abbreviation for Mean Time To Recovery or Mean Time To Repair which
represents the average time taken to put a defective component or system back in
working order.

MTTI is an abbreviation for Mean Time To Install.

MTTS is represented in minutes in ServiceMax and is used by the OptiMax engine to sched-
ule an appropriate duration on a technician’s calendar.

To set up MTTS rules in ServiceMax:

Click Home > ServiceMax Setup > Dispatch Management > MTTS Rules. The MTTS
Rules screen appears with the list of all existing MTTS rules.

Figure 15: MTTS Rules Screen

In the MTTS Rules screen:

To edit an existing rule, check the Select checkbox against the rule and then click
Edit Rule.

To delete an existing rule, check the Select checkbox against the rule and click
Delete Rule.

To create a new MTTS rule, see the section below.
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To create a new MTTS rule:

1. From the MTTS Rules screen, click New Rule.

2. Enter Rule Name. Ensure the rule name is readable and indicates the purpose of the
MTTS rule. For example "Hard Disk Replacement On Dell Notebooks."

3. Enter a detailed description of the rule.

4. Using the combination of Work Order field name, operator and value, enter the cri-
teria for each rule. Make sure the criteria are exclusive between each rule. Use the
buttons marked with x and + to remove and add conditions respectively. If required,
use the Advanced Expression to enter conditions such as (1 AND 2) OR 3.

5. Enter MTTS in minutes.

6. Click Save. Alternatively, to undo your changes and return to the list view, click
Cancel.

7. To dictate the sequence in which these rules are processed, click Rule Sequence. In
the MTTS Rules list popup screen (sample below), arrange the rules as needed.

Figure 16: MTTS Rules List

8. Note that the first matching rule in the list will be applied. If you have hierarchical
rules, you must keep the most granular rules at the top. For example, if Rule1 uses
City only, and Rule2 uses Zip and City, Rule2 must be moved before Rule1. Otherwise,
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Rule2 will never be considered for determining MTTS of a Work Order.

9. Click Back To Setup Home to return to the ServiceMax setup home page.

Note: Fields from some standard objects such as Cases and Opportunities
are available for use in MTTS rules only if allowed by your ServiceMax license.
Please contact your ServiceMax administrator to know the type of license used
by your organization.

Configuring Territory Matching Rules
Since ServiceMax provides a flexible way of defining territory coverage, an organization
can potentially use multiple ways of territory coverage for different territories. For
example, a global organization could use Zip codes to define territory coverage in North
America, Country to define territory coverage in Europe, and a combination of Country and
Product to define coverage in Asia-Pacific.

One of the key first steps in dispatching is to identify the Primary Territory of a Work
Order. If your organization uses varying flavors of territory coverage, you must define Ter-
ritory Matching Rules to indicate the specific territory coverage attributes to be used for
various Work Orders. In the above example, we must define three rules that say:

Use Zip for all North America Work Orders.

Use Country for all Europe Work Orders.

Use Country and Product for all Asia-Pacific Work Orders.

To set up Territory Matching rules in ServiceMax:

Click Home > ServiceMax Setup > Territory Matching Rules. The list of all existing
territory match rules is displayed in Territory Matching Rules screen as shown below:
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Figure 17: Territory Matching Rules Screen

In the Territory Matching Rules screen:

To edit an existing rule, check the Select checkbox against the rule and then click
Edit Rule.

To delete an existing rule, check the Select checkbox against the rule and then click
Delete Rule.

To create a new territory match rule, see the section below.

To create a new Territory Match rule:

1. From the Territory Matching Rules screen, click New Rule.

2. Enter Rule Name. Make sure the rule name is readable and indicates the purpose of
the territory match rule. For example "Zip Based Territories In United States".

3. Enter a detailed description of the rule.

4. Using the combination of Work Order field name, operator and value, enter the cri-
teria for each rule. Make sure the criteria are exclusive between each rule. Use the
buttons marked with x and + to remove and add conditions respectively. If required,
use the Advanced Expression to enter conditions such as (1 AND 2) OR 3.

5. All available territory coverage attributes are displayed in the bottom section. Against
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each applicable coverage attribute, select the corresponding Work Order field to use.
Leave the unused coverage attributes blank. For example, if North America uses Zip
to define territory coverage, select the Zip field fromWork Order and leave City, Coun-
try and State blank.

6. To dictate the sequence in which these rules are processed, click Rule Sequence. In
the Territory Rule Sequence screen (sample below), arrange the rules as needed.

Figure 18: Territory Rule Sequence Screen

7. Note that the first matching rule in the list will be applied. If you have hierarchical
rules, you must keep the most granular rules at the top. For example, if Rule1 uses
City only, and Rule2 uses Zip and City, Rule2 must be moved before Rule1. Otherwise,
Rule2 will never be considered for Territory Matching Rule.

8. Click Save. Alternatively, to undo your changes and return to the list view, click
Cancel.

9. Click Back To Setup Home to return to the ServiceMax setup home page.

Note: Fields from some standard objects such as Cases and Opportunities are
available for use in Territory Match rules only if allowed by your ServiceMax
license. Please contact your ServiceMax administrator to know the type of
license used by your organization.
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Configuring Event Hover
When the mouse is moved on a calendar event in Dispatch Console, relevant information
about the event and the corresponding Work Order is displayed as a hover. Fields used to
display the hover information can be fully configured in ServiceMax.

To set up Hover rules in ServiceMax, click Home > ServiceMax Setup > Event Hover
Rules. The list of all existing hover rules appears. A hover rule lists Work Order fields to be
used in the hover display.

Figure 19: Event Hover Rules Screen

In the Event Hover Rules screen:

To edit an existing rule, check the Select checkbox against the rule and then click
Edit Rule.

To delete an existing rule, check the Select checkbox against the rule and then click
Delete Rule.

To create a new rule, see the section below.
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To create a new Event Hover rule:

1. In the Event Hover Rules screen, click New Rule.

2. Enter Rule Name. Make sure the rule name is readable and indicates the purpose of
the hover rule. For example “Critical Work Orders”.

3. Enter a detailed description of the rule.

4. Using the combination of Work Order field name, operator and value, enter the cri-
teria for each rule. Make sure the criteria are exclusive between each rule. Use the
buttons marked with x and + to remove and add conditions respectively. If required,
use the Advanced Expression to enter conditions such as (1 AND 2) OR 3.

5. Select the relevant Work Order fields from the list on the left and move them to the
right. Use the Up and Down buttons to set the display order of the selected fields in
the hover.

6. Click Save. Alternatively, to undo your changes and return to the list view, click
Cancel.

7. To dictate the sequence in which these rules are processed, click Rule Sequence. In
the Event Hover Rule Sequence screen (sample below), arrange the rules as needed.

Figure 20: Events Hover Rule Sequence Screen
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8. Note that the first matching rule in the list will be applied. If you have hierarchical
rules, you must keep the most granular rules at the top. For example, if Rule1 uses
City only, and Rule2 uses Zip and City, Rule2 must be moved before Rule1. Otherwise,
Rule2 will never be considered for determining MTTS of a Work Order.

9. Click Back To Setup Home to return to the ServiceMax setup home page.

Note: Fields from some standard objects such as Cases and Opportunities are
available for use in event hover rules only if allowed by your ServiceMax
license. Please contact your ServiceMax administrator to know the type of
license used by your organization.

Configuring Event Subject
When a new event is created in Dispatch Console either by clicking New Event or by drag
‘n’ drop of the Work Order into the calendar, the default value for the event’s Subject is
fully configurable.

To set up Event Subject rules in ServiceMax, click Home > ServiceMax Setup > Event
Subject Rules. The list of all existing subject rules appear. A subject rule lists the work
order fields to be used in the subject.

Configuring Event Subject 247



Figure 21: Event Subject Rule Screen

In the Event Subject Rule screen:

To edit an existing rule, check the Select checkbox against the rule and then click
Edit Rule.

To delete an existing rule, check the Select checkbox against the rule and then click
Delete Rule.

To create a new rule, see the section below.

To create a new Event Subject rule:

1. In the Event Subject Rule screen, click New Rule.

2. Enter Rule Name. Make sure the rule name is readable and indicates the purpose of
the hover rule. For example “Critical Work Orders.”

3. Enter a detailed description of the rule.

4. Using the combination of Work Order field name, operator and value, enter the cri-
teria for each rule. Make sure the criteria are exclusive between each rule. Use the
buttons marked with x and + to remove and add conditions respectively. If required,
use the Advanced Expression to enter conditions such as (1 AND 2) OR 3.

5. Select the relevant Work Order fields from the list on the left and move them to the
right. Use the Up and Down buttons to set the display order of the selected fields in
the subject. Value from the selected fields will appear in the Event Subject separated
by a semi-colon in the dispatch console.

6. Click Save. Alternatively, to undo your changes and return to the list view, click
Cancel.

7. To dictate the sequence in which these rules are processed, click Rule Sequence. In
the Event Subject Rule Sequence screen (sample below), arrange the rules as
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needed.

Figure 22: Event Subject Rule Sequence Screen

8. Note that the first matching rule in the list will be applied. If you have hierarchical
rules, you must keep the most granular rules at the top. For example, if Rule1 uses
City only, and Rule2 uses Zip and City, Rule2 must be moved before Rule1. Otherwise,
Rule2 will never be considered for determining the default subject for an event.

9. Click Back To Setup Home to return to the ServiceMax setup home page.

Note: Fields from some standard objects such as Cases and Opportunities are
displayed in Event Subject rules only if allowed by your ServiceMax license.
Please contact your ServiceMax administrator to know the type of license used
by your organization.

Configuring DC Field Updates
Click Home > ServiceMax Setup > Dispatch Management > Dispatch Console
field updates to launch the screen as shown below:
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Figure 23: Configure Work Order & Event Fields Screen

In this screen, you can configure up to ten Work Order and Event fields to be updated from
Dispatch Console. Standard Event fields cannot be configured. Fields configured here will
appear in the Create/Edit Event screen in Dispatch Console. Even if work order fields are
configured here, they will appear only for work order-related events.

Click Save to save the changes made.

Click Reset to discard your changes and continue stay on the same page to make fur-
ther changes.

Click Back to Setup Home to return to the ServiceMax setup home page.

Note: Rich text, Rollup, and Lookup text fields are not supported.

Configuring Work Order Custom Views
Click Home > ServiceMax Setup > Dispatch Management > Work Order Views to
launch the screen as shown below:

Figure 24: Manage Views Screen
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In this screen you can view standard Work Order Views or create customWork Order
Views. The View definition includes prefilter conditions, filter by owner and options for dis-
play result.

To create a new Custom View:

1. Click the New button. The Configure View screen displays.

2. Enter the View Name, View Id, and Description in the appropriate text fields.
See figure below.

The View Object field defaults to Work Order.

3. Select the filter (User's Records or All Records) from the Filter By Owner picklist.

4. Use the expression builder, and if necessary, the Advanced Expression builder to
define filter criteria for Work Order records.

5. Select one or more fields that will be displayed in the Work Order results.

Figure 25: Configure View Screen

See Also:

Troubleshooting Configuration Issues

Standard Configuration Settings
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ServiceMax Territories

Service Teams and Technician
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DISPATCH CONSOLE VIEWS

Overview
Use the Dispatch Console Views option to view standard or customWork Order, Location,
and Account views. View definition includes the filter criteria including advanced expres-
sion if any, and the fields to be displayed in the result. You can also assign these views for
Service Teams and Territories. These views can be filtered by ownership, preconditions,
and display results.

Access and Permissions

Actions User Permissions Needed

To view Dispatch Console Views: "Read" on ServiceMax Processes, ServiceMax Config
Data and Work Order.

To create or edit Dispatch Console
Views:

"Create" and "Update" on ServiceMax Processes and Ser-
viceMax Config Data.

To delete Dispatch Console Views: "Delete" on ServiceMax Processes and ServiceMax Con-
fig Data.

To view Dispatch Console Views
Permissions:

"Read" on ServiceMax Processes, ServiceMax Config
Data, Service Team and Territory.

To create or edit Dispatch Console
Views Permissions:

"Create" and "Update" on ServiceMax Config Data.

To delete Dispatch Console Views
Permissions:

"Delete" on ServiceMax Config Data.
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Click Home > ServiceMax Setup > Dispatch Management > Dispatch Console
Views > Go to launch the screen as shown below.

Figure 1: Manage Views Screen

In the Manage Views screen:

You can view and clone standard Work Order, Location, and Account views.

Create a new custom view (Work Order, Location, Account).

Edit an existing custom view (Work Order, Location, Account).

Clone a view.

Delete a view.

Manage view permissions.

Return to Setup Home. 

Creating a New View

To create a new view:

1. Click the New button.

2. In the Configure View screen, select a View Object (Account, Location, orWork
Order). See figure below. (The View Object defaults to None).

3. Enter the View Name, View Id, and Description in the appropriate text boxes.

4. In the View For text box, select one of the following: Grid,Map, or Grid And Map.

5. Select the ownership (User's Records, All Records) in the Filter By Owner pick-
list.
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6. Use the expression builder, and if necessary, the Advanced Expression builder, to
define filter criteria for the Object (Account, Location, orWork Order) records.

7. To add or delete an expression, click the Add or Delete buttons.

8. Select one or more fields that will be displayed in the Object (Account, Location, or
Work Order) results.

Figure 2: Configure View Screen

9. Click the Save & Assign button to assign the view to a Service Team or Territory.

a. In the Manage View Permissions screen, select a view from the Select View pick-
list. See figure below.

b. Assign the selected view to a Service Team or Territory.

10. To assign a view to a Service Team:

a. Click the Service Team tab in the Manage View Permissions screen.

b. Add a team by clicking the Add Team button. See figure below.

c. In the Service Team text box, enter the name of team or search for a team using
the Lookup icon.

d. Assign the view to either a Dispatcher, Technician, or All.
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e. If you want to conduct a keyword search for a service team, enter a keyword and
click the Go button in the Search for Territories by entering a keyword text
box.

f. Click the Add Selected button to add the team to the Service Team tab area.
Click Cancel to remove the service team from the search area.

g. To delete a team, check a team from the Service Team checkbox, and click the
Delete button. A popup window displays and asks you, "Are you sure?". Click OK
to delete the view. Click Cancel to cancel the deletion.

Figure 3: Manage View Permissions (Service Team)

11. To assign a view to a Territory:

a. Click the Territory tab in the Manage View Permissions screen. See figure below.

b. Add a territory by clicking the Add Territory button.

c. In the Territory text box, enter the name of territory or search for one using the
Lookup icon.

d. Assign the view to either a Dispatcher, Technician, or All.

e. If you want to conduct a keyword search for a territory, enter a keyword and click
the Go button in the Search for Service Teams by entering a keyword text
box.

f. Click the Add Selected button to add the team to the Territory tab area. Click
Cancel to remove the territory from the search area.

g. To delete a territory, check one from the Territory checkbox, and click the
Delete button. A popup window displays and asks you, "Are you sure?". Click OK
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to delete the view. Click Cancel to cancel the deletion.

Figure 4: Manage View Permissions (Territory)

12. Click the Quick Save button to save the view and remain in the Custom View screen.

13. Click the Save & Close button to save the view and close the Manage View Per-
missions Screen.

14. Click the Cancel button if you want to cancel the permission.

Editing a View

To edit a view:

1. Check the Select checkbox of the view you would like to edit.

2. Click the Edit button.

3. In the Configure View screen, update the View Name, View Id, and Description in
the appropriate text boxes if necessary. (The View Object defaults toWork Order).
See figure below.

4. Make changes to the Field Name,Operator, and Value in the expression builder if
necessary. Add or delete expressions as necessary.

5. Use the Advanced Expression builder to define filter criteria for Work Order records.

6. Select one or more fields that will be displayed in the Work Order results.

7. If you need to update the view permissions, click the Save & Assign button. See
Manage View Permissions for steps on how to update this section.

8. Click the Quick Save button to save the view and remain in the Custom View screen.
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9. Click the Save & Close button to save the view and close the Custom View Screen.

10. Click the Cancel button if you want to cancel the view.

Cloning a View

To clone a view:

1. Check the Select checkbox of the view you would like to clone.

2. Click the Clone button.

3. In the Configure View screen, select a new View Name, View Id, and Description.

4. If necessary, update the view permissions, click the Save & Assign button. For more
information about updating view permissions, see Managing View Permissions.

5. Click the Quick Save button to save the view and remain in the Custom View screen.

6. Click the Save & Close button to save the view and close the Custom View Screen.

7. Click the Cancel button if you want to cancel the view.

Deleting a View

To delete a view:

1. Check the Select checkbox of the view you would like to delete.

2. Click the Delete button.

3. A popup window displays and asks you, "Are you sure?".

a. Click OK to delete the view.

b. Click Cancel to cancel the deletion.

Managing View Permissions

To assign a view permissions:

1. Check the Select checkbox of the view you would like to assign permissions.

2. Click the Manage Permissions button.
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3. In the Manage View Permissions screen, select a view from the Select View picklist.

4. Assign the selected view to a Service Team or a Territory.

5. To assign a view to a Service Team:

a. Click the Service Team tab in the Manage View Permissions screen.

b. Add a team by clicking the Add Team button.

c. In the Service Team text box, enter the name of team or search for a team using
the Lookup icon.

d. Assign the view to either a Dispatcher, Technician, or All. If you assign the view
to a technician, see figure below.

Figure 5: Manage View Permissions - Assign the View to a Technician

e. If you want to conduct a keyword search for a service team, enter a keyword and
click the Go button in the Search for Service Teams by entering a keyword
text box.

f. Click the Add Selected button to add the team to the Service Team tab area.
Click Cancel to remove the service team from the search area.

g. To delete a team, check a team from the Service Team checkbox, and click the
Delete button. A popup window displays and asks you, "Are you sure?". Click OK
to delete the view. Click Cancel to cancel the deletion.

2. To assign a view to a Territory:

a. Click the Territory tab in the Manage View Permissions screen. See figure below.

b. Add a territory by clicking the Add Territory button.

Managing View Permissions 259



c. In the Territory text box, enter the name of territory or search for one using the
Lookup icon.

d. Assign the view to either a Dispatcher, Technician, or All.

e. If you want to conduct a keyword search for a territory, enter a keyword and click
the Go button in the Search for Territories by entering a keyword text box.

f. Click the Add Selected button to add the team to the Territory tab area. Click
Cancel to remove the territory from the search area.

Figure 6: Manage View Permissions (Territory)
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TECHNICIAN ELIGIBILITY RULES

Overview
This feature enables your organization to define criteria for finding eligible technicians for
work orders. The list of technicians found using Technician Eligibility Rules is used while
OptiMax assigns a technician to a work order.

Access and Permissions

Actions User Permissions Needed

To view Technician Eli-
gibility Rule

'Read' permission on Objects: ServiceMax Processes, ServiceMax
Config Data, Technician, Work Order

To create Technician
Eligibility Rule

'Create' permission on Objects: ServiceMax Processes, ServiceMax

Config Data

'Read' permission on Objects: ServiceMax Processes, ServiceMax

Config Data, Technician, Work Order

To edit Technician Eli-
gibility Rule

'Edit' permission on Objects: ServiceMax Processes, ServiceMax Con-

fig Data

'Read' permission on Objects: ServiceMax Processes, ServiceMax

Config Data, Technician, Work Order

To delete Technician Eli-
gibility Rule

'Delete' permission on Objects: ServiceMax Processes, ServiceMax

Config Data

'Read' permission on Objects: ServiceMax Processes, ServiceMax

Config Data, Technician, Work Order

Click Home > ServiceMax Setup > Dispatch Management > Technician Eligibility
Rules  to view the Technician Eligibility Rules screen.
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Creating a Technician Eligibility Rule
You create rules that determine how to find eligible technicians for a Work Order.

To create a technician eligibility rule:

1. Click Home > ServiceMax Setup > Dispatch Management > Technician Eli-
gibility Rules.

2. In the Technician Eligibility Rules screen, click the New Rule button at the top of the
screen (see figure below).

Figure 1: Technician Eligibility Rules Screen

The following Technician Eligibility Rules screen displays (see figure below).

Figure 2: Creating a New Technician Eligibility Rule
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3. In the Rule Name text box, enter the name of the rule you want to create (see figure
below).

4. If necessary, enter a description for your rule in the Description text box.

5. Check the Active checkbox to make the rule active.

Figure 3: Rule Name and Description

6. In the Work Order criteria section, select a field from theWork Order Field picklist
(see figure below).

7. From the Operator picklist, select an operator.

8. Enter the value in the Value text box.

9. To delete a Work Order criteria, click the button.

10. To add an additional Work Order criteria, click the button.

11. If necessary, enter an advanced expression in the Advanced Expression text box.

Figure 4:Work Order Criteria for Eligibility Rule

12. In the Map the technician attributes section, select a technician from the Technician
picklist (see figure below for all steps).

13. From the Operator picklist, select an operator.

14. Enter the value in the Value text box. Click the Edit icon to select an item from
the Value picklist. The Work Order fields are available from the picklist.

15. If necessary, enter an advanced expression in the Advanced Expression text box.
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16. To delete a technician attribute, click the icon.

17. To add an additional technician attribute, click the icon.

Figure 5: Technician Attributes

18. Click the Save button to save the Technician Eligibility Rule.

19. Click the Delete button to delete the Technician Eligibility Rule.

20. Now that you have created your technician eligibility rule, you can edit it by clicking
the Edit Rule button. Make sure the rule is checked in the Select checkbox.

Editing a Technician Eligibility Rule

To edit a technician eligibility rule:

1. Click Home > ServiceMax Setup > Dispatch Management > Technician Eli-
gibility Rules.

2. Select the rule name you want to edit (see figure below).

Figure 6: Select Eligibility Rule

The Technician Eligibility Rules screen displays.

3. If necessary, update the description for your rule in the Description text box.

4. Check or uncheck the Active checkbox to make the rule active or inactive.

5. In the Work Order criteria section, select a field from theWork Order Field picklist
(see figure below).

6. From the Operator picklist, select an operator.
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7. If necessary, enter a different value in the Value text box.

8. To delete a Work Order criterion, click the button.

9. To add an additional Work Order criterion, click the button.

10. If necessary, update the advanced expression in the Advanced Expression text
box.

Figure 7: Select Eligibility Rule

11. Click the Save button to save the changes you made to your Technician Eligibility
Rule.

Deleting a Technician Eligibility Rule

To delete a technician eligibility rule:

1. Select the rule name you want to delete by checking the rule via the Select check-
box.

2. Click the Delete Rule button. Click OK when prompted to confirm deletion, or click
Cancel to cancel deletion. The selected rules are deleted and the rule list is
refreshed.
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SKILL MATCH RULES

Overview
This feature enables your organization to define mandatory and optional skills required to
complete work orders. The list of technicians with the most appropriate skills found using
Skill Match Rules is used while OptiMax assigns a technician to a work order.

Access and Permissions

Actions User Permissions Needed

To view Skill
Match Rule

'Read' permission on Objects: ServiceMax Processes, ServiceMax Config
Data, Technician, Work Order, Skills.

To create Skill
Match Rule

'Create' permission on Objects: ServiceMax Processes, ServiceMax Config

Data

'Read' permission on Objects: ServiceMax Processes, ServiceMax Config

Data, Technician, Work Order, Skills

To edit Skill
Match Rule

'Edit' permission on Objects: ServiceMax Processes, ServiceMax Config

Data

'Read' permission on Objects: ServiceMax Processes, ServiceMax Config

Data, Technician, Work Order, Skills

To delete Skill
Match Rule

'Delete' permission on Objects: ServiceMax Processes, ServiceMax Config

Data

'Read' permission on Objects: ServiceMax Processes, ServiceMax Config

Data, Technician, Work Order, Skills

Click Home > ServiceMax Setup > Dispatch Management > Skill Match Rules  to
view the Skill Match Rules screen.
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Creating a Skill Match Rule
You can create rules that determine how to find technicians with matching skills for a Work
Order.

To define a skill match rule:

1. Click Home > ServiceMax Setup > Dispatch Management > Technician Eli-
gibility Rules.

2. In the Skill Match Rules screen, click the New Rule button at the top of the screen
(see figure below).

Figure 1: Skill Match Screen: New Rule Button

The Skill Match Rules screen displays.

3. In the Work Order criteria area, enter the name of the rule you want to create in the
Rule Name text box (see figure below).

4. If necessary, enter a description for your rule in the Description text box.

5. In the Work Order Field area, select an order type from theWork Order Field pick-
list. (See figure below).

6. From the Operator picklist, select an operator.

7. Enter the value in the Value text box.

8. To delete a Work Order criteria, click the button.

9. To add an additional Work Order criteria, click the button.
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10. If necessary, enter an advanced expression in the Advanced Expression text box.

Figure 2:Work Order Criteria for Skill Match Rule

11. In the Skill Category picklist, select a Skill Category (for example, Installation,
Upgrade, Configuration, and so on), and then click the Search button

12. The available skills for the selected category display in the Available Skills text box
area.

13. Select a skill in the Available Skills area, and click the icon to move skills from
the Available Skills text box area to the Applicable Skills area.

14. If you want to move an applicable skill to the Available Skills area, check the skill

using the checkbox next to the Skill Name, and click the arrow.

15. Check the Required? checkbox to indicate whether or not the skill should be required
when matching a skill with a technician.
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16. In the Applicable Skills area, indicate the Minimum skill level the technician should
have.

Figure 3: Select Filter for Skills

Editing a Match Skill Rule

To edit a match skill rule:

1. Click Home > ServiceMax Setup > Dispatch Management > Technician Eli-
gibility Rules.

2. Select the rule name you want to edit (see figure below).

Figure 4: Select Match Skill Rule

The Skill Match Rules screen displays. Update following the steps below.

3. In the Work Order criteria area, update the description for your rule in the Descrip-
tion text box.

Skill Match Rules
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4. In the Work Order Field area, change the order type from theWork Order Field pick-
list (see figure below).

5. From the Operator picklist, select a different operator if necessary.

6. Enter a different value in the Value text box if necessary.

7. To delete a Work Order criteria, click the button.

8. To add an additional Work Order criteria, click the button.

9. If necessary, update the advanced expression in the Advanced Expression text
box.

10. In the Skill Category picklist, select a Skill Category (for example, Installation,
Upgrade, Configuration, and so on), and then click the Search button.

The available skills for the selected category display in the Available Skills text box
area (see figure below).

Figure 5: Select Filter for Skills

11. Select a skill in the Available Skills area, and click the icon to move skills from
the Available Skills text box area to the Applicable Skills area.

12. If you want to move an applicable skill to the Available Skills area, check the skill

using the checkbox next to the Skill Name, and click the arrow.
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13. Check the Required? checkbox to indicate whether or not the skill should be required
when matching a skill with a technician.

14. In the Applicable Skills area, indicate the Minimum skill level the technician should
have.

Deleting a Match Skill Rule

To delete a matching skill rule:

1. Select the rule name you want to delete.

2. Click the Delete Rule button. Click OK when prompted to confirm deletion, or click
Cancel to cancel deletion. The selected rules are deleted and the rule list is
refreshed.
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272 Deleting a Match Skill Rule



DC MAP HOVER

Overview
Use the DC Map Hover option to configure what field criteria will hover over the map view
in the Dispatch Console. You can select Work Order, Location, and Account field criteria to
display as Map Hover in the Dispatch Console Map view.

Access and Permissions

Object Read Create Edit Delete

ServiceMax Process Yes Yes Yes Yes

ServiceMax Config Data Yes Yes Yes Yes

Click Home > ServiceMax Setup > Dispatch Management > DC MAP Hover > Go
to launch the screen as shown below.
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Figure 1: Configure Map Hover Screen

In the Configure Map Hover screen:

You can select Work Order field criteria (up to ten) to display as Map Hover on Dis-
patch Console.

You can select Location field criteria (up to ten) display as Map Hover on Dispatch
Console.

You can select Account field criteria (up to ten) to display as Map Hover on Dispatch
Console.

Return to Setup Home.  

Configuring Map Hover Field Criteria

To configure map hover field criteria:

1. In the Map Hover Field 1 picklist forWork Orders, select an item to display on the
map in Dispatch Console. You can select up to ten fields (Map Hover Field1 to Map
Hover Field 10).

2. In the Map Hover Field 1 picklist for Locations, select an item to display on the map
in Dispatch Console. You can select to ten fields (Map Hover Field 1 to Map Hover Field
10).

3. In the Map Hover Field 1 picklist for Accounts, select an item to display on the map in
Dispatch Console. You can select to ten fields (Map Hover Field 1 to Map Hover Field
10).

4. Click the Save button.

DC Map Hover
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SFM CUSTOM ACTIONS

Overview
Using this feature, ServiceMax administrators can configure URL-based actions that can
be launched from SFM wizard on a record. The URL can be configured to pass data from
one or more fields in the record.

Access and Permissions

Actions User Permissions Needed

To view SFM Custom Actions: "Read" on ServiceMax Processes, ServiceMax Config Data

To create or edit SFM Custom
Actions:

"Create" and "Update" on ServiceMax Processes and Ser-
viceMax Config Data

To delete SFM Custom
Actions:

"Delete" on ServiceMax Processes and ServiceMax Config
Data

SFM Custom Action Fields

Fields Description

Object Name of the Object. For example: Installed product, Case.

Action Title Name of the Action.

Action ID Unique identification of the Action.

Description Detailed description of the SFM Custom Action. Details entered here are displayed
in the manage actions screen, when the action is selected.

Open URL in Launch the Action in New Window or Existing window.

Open URL to
Launch

The URL to launch the Action.
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Fields Description

Window
Height

The Height of new window to be launched for the Action.

Window
Width

The Width of new window to be launched for the Action.

Open As Full
Window

Checkbox that indicates action will be launched in full window.

Is Active Checkbox that indicates if the Action is currently active and available for use.

Show Scroll-
bars

Checkbox that indicates scrollbars enabled when launch new window

Parameter
Name

Name of the parameter for the Action.

Parameter
Value Type

Select Field Name or Value as the Parameter Value type for the Action.

Parameter
Value

If Value Type is Field Name, then the Parameter value will be a map of fields in
object else the default value to be used for that field.
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Steps In Creating a Custom Action
1. Click Home > ServiceMax Setup > Service Flow Manager > SFM Custom
Actions to view the SFM Custom Actions screen. Select the object that you want to
create/edit an action. The following screen will display.

Figure 1: SFM Custom Actions - Standard Actions & Custom Actions Screen

2. The list under Pre-configured Actions displays the predefined Actions of ServiceMax
for the particular object selected.

3. Any custom actions appear under the User-defined Custom Actions section.

4. Pre-configured actions cannot be modified. However, you can clone them to create
User-defined actions.

5. In the SFM Custom Actions screen:

To create an action from an existing action, select the action from the list and click
Clone .

To create a new action, click New.

To delete an existing action, select the action from the list and click Delete .
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Caution: Use Extreme Caution when deleting custom actions since the effect is
immediate and irreversible. You will not be warned if the custom action is used
in an SFM wizard.

Creating/Editing Actions
In the User-defined Actions section, click New to create a new custom action or select an
existing action from the list and click Edit. You can create custom actions for the following
Action Types: URL, andWeb Service. See figure below.

Figure 2: SFM Action Types

If you select URL, the following SFM Custom Action screen appears.

Figure 3: SFM Custom Actions - Create New Action for URL
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Follow the steps below to create a custom action for a URL.

To Create a Custom Action for a URL:

1. Enter a user-friendly Title for the Action. This will be used as the default title when
this action is placed in a wizard.

2. Enter a unique ID and description for the SFM custom action. The description entered
here will be used as the default when this action is used in a wizard.

3. Indicate if the URL should be launched in the same window or in a new window.

4. Enter the URL to be launched.

5. If the URL should be launched in a new window, check Open In Full Window if the
new window should be opened in full mode. Leaving this checkbox unchecked will
open the URL as a popup window. You must then specify the height and width of the
popup window.

6. If you check the Show Scrollbars checkbox, the new window will display horizontal
and vertical scrollbars when launched.

7. In the Parameters section at the bottom, create one or more URL parameters. The
parameter name cannot contain spaces. A parameter value can either be a constant
or data from any field in the record. To configure a static parameter value, select
Value in the Parameter Value Type picklist and enter any static text in the Para-
meter Value field. To configure a dynamic parameter value, select Field Name in
the Parameter Value Type picklist and select a field name in the Parameter
Value picklist.

8. At anytime during the SFM custom action creation process, you can click Quick Save
button to save the SFM custom action even if it is incomplete, and continue to edit/cre-
ate the action.

9. To save the SFM custom action and return to the ServiceMax Setup Home page, click
the Save & Close button at the top.

10. To cancel any changes made to the action and return to ServiceMax Setup Home,
click the Cancel button at the top. Any changes saved while building the SFM custom
action will not be rolled back.

Creating/Editing Actions 279



If you selectWeb Service, the following SFM Custom Action screen appears.

Figure 4: SFM Custom Actions - Create New Action for Web Service

Follow the steps below to create a custom action for Web Service.

To Create a Custom Action for Web Service:

1. Enter a user-friendly Action Title for the custom action. This will be used as the
default title when this action is placed in a wizard.

2. Enter a unique Action ID and Description for the SFM custom action. The descrip-
tion entered here will be used as the default when this action is used in a wizard.

3. Enter the Namespace Prefix in the appropriate text box.

4. Enter the Class Name in the appropriate text box.

5. Enter the method name in the Method Name text box.

6. In the Processing Message text box, enter a custommessage that will display to
end users during processing.

7. In the parameters section at the bottom, create one or more Web Service para-
meters. The parameter name cannot contain spaces. The parameter value can either
be a constant or data from any field in the record. To configure a static parameter
value, select Value in the Parameter Value Type picklist and enter any static text
in the Parameter Value field. To configure a dynamic parameter value, select Field
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Name in the Parameter Value Type picklist and select a field name in the Para-
meter Value picklist.

8. At anytime during the SFM custom action creation process, you can click the Quick
Save button to save the SFM custom action even if it is incomplete, and continue to
edit/create the action.

9. To save the SFM custom action and return to the ServiceMax Setup Home page, click
the Save & Close button at the top.

10. To cancel any changes made to the action and return to ServiceMax Setup Home,
click the Cancel button at the top. Any changes saved while building the SFM custom
action will not be rolled back.

Sample SFW Action (Web Service)
Follow the instructions below to setup a SFW Action to invoke the Apex Web Service.

To Setup a SFW Action to Invoke the Apex Web Service:

1. Create Apex Web Service.

// This is sample service to update ownership of given Work order record

global class SVMX_SampleSFWEvent {

webservice static SVMXC.INTF_WebServicesDef.INTF_Response takeWOOwnership(SVMXC.INTF_

WebServicesDef.INTF_Response request)

{

SVMXC.INTF_WebServicesDef.INTF_Response obj = new SVMXC.INTF_WebServicesDef.INTF_Response

(); // Response object declaration

try

{

String recordId; //Declare variable to hold Work Order record id

// Iterate request's valueMap member to get Key-Value pairs

for(SVMXC.INTF_WebServicesDef.SVMXMap objSVXMMap : request.valueMap)

{
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// Default Key  : SVMX_RECORDID is always available in request it contains source record

Id from where SFW Action is initiated

// Other Keys : <Custom keys as configured in Custom Action>

// Add your logic here to get values for custom keys...

// ...... In this example we take Work Order id from Default key and assign it to a local

variable

if(objSVXMMap.key == 'SVMX_RecordId'){

recordId = objSVXMMap.value; 

}

}

// Custom Logic for the Service Goes here....

// ...... In this example we retrieve Work Order record and update it's ownership

SVMXC__Service_Order__c objWO = [Select Id, OwnerId from SVMXC__Service_Order__c where

Id=:recordId];

objWO.OwnerId = UserInfo.getUserId();

Update objWO;

// Construct Success response, Update response object members 

obj.message = 'Work Order update successfully';

obj.success = true;

obj.messageType = 'INFO';

return obj; // Return should be of INTF_Response type and

}

catch(Exception ex)

{

// Construct Failure response, Update response object members

obj.message = ex.getMessage();

obj.success = false;

obj.messageType = 'ERROR';
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return obj;

}

}

}

2. Create Custom Action of typeWeb Service as shown in the figure below.

Figure 5: SFM Custom Action Details for Work Order (Sample)

3. Go to any Work Order and click the SFW Button: Take Ownership button.

Deleting Actions

To delete an SFM Custom Action:

1. Select the name of the custom action under the User-defined Actions section.

2. Click Delete.

Note: Pre-configured Actions of ServiceMax cannot be deleted.
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SFM TRANSACTION DESIGNER

Overview
Service Flow Manager (SFM) is the central engine in ServiceMax that facilitates flow of
information between all service and related processes. The end-to-end service delivery
normally requires flow of information through various stages such as support call, enti-
tlement verification, dispatch, estimation, forward & reverse logistics, parts consumption,
call resolution, and so on. Service Flow manager helps maintain the accuracy of such
information throughout the service delivery cycle but also helps reduce the time spent in
each step. Examples of ServiceMax standard flows deployed using SFM are Create
RMA/Shipment from Case, Create Work Order from Installed Product, and Work Order T&M
Lines. The following picture demonstrates the typical use-case and flow of SFM.

Figure 1: SFM Transaction Manager Overview
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SFM Transaction Engine has two major components as explained below:

SFM Transaction Designer provides an interactive wizard-like interface to define SFM
transaction, rules and end-user interface.

SFM Transaction Delivery delivers the configured SFM transaction to end users using
a rich and advanced user interface.

Note: SFM Transactions are sometimes interchangeably referred to as Pro-
cesses or Service Processes in this document.

Access and Permissions

Actions User Permissions Needed

To view SFM
Transactions:

"Read" on ServiceMax Processes, ServiceMax Config Data, Page Layout, Page
Layout Detail, SFM Event, Code Snippet Manifest, Code Snippet, Doc Template,
Doc Template Details, Function Definition

To create or
edit SFM
Transactions:

"Create" and "Update" on ServiceMax Processes and ServiceMax Config Data,
Page Layout, Page Layout Detail, SFM Event, Code Snippet Manifest, Code Snip-
pet, Doc Template, Doc Template Details

To delete
SFM Trans-
actions:

"Delete" on ServiceMax Processes and ServiceMax Config Data, Page Layout,
Page Layout Detail, SFM Event

SFM Transaction Designer Fields

Fields Description

Name Name of the SFM Transaction. Example: Create RMA from Case.

ID Unique ID of the SFM Transaction. Used in deployment of the process. Spaces
and special characters are not allowed in this. Examples of valid SFM transaction
ID are CASETORMA001 and WO_TO_SHIP_001.

Description A detailed description of this SFM Transaction.

Status Configuration status of the SFM Transaction. Determined automatically based on
the completeness of flow definition. Incomplete flows cannot be deployed.
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Fields Description

Purpose of
Transaction

Indicates if the transaction is used to create a new target record from the source
record, add new child records to an existing target record, or to edit the source
record & its lines in a stand-alone mode.

Use Data
From

Name of the source object and its child objects.

To Create
Records For

Name of the target object and its child objects.

Create Tar-
get As

A user-friendly label for the target object. Useful if the target object is used for
multiple business purposes. For example, the same Parts Order object can be
used for Sales Orders, Spare Parts Shipments, or Defect Return flows.

Filter Name Name of the predefined filter to be used as filter/qualification criteria on the
source object.

Save filter
as

User-friendly name for the filter criteria. Used when creating new filters.

Filter ID Unique ID for the filter criteria. Used when creating new filters.

Filter Cri-
teria

An expression based on source object field values that defines the qual-
ification/entry criteria. For source header records, this is considered as the qual-
ification criteria, that is, the SFM Transaction will be allowed only if the source
record matches the criteria. For source child records, it is considered as filter cri-
teria, that is, the SFM Transaction will proceed even if the filter criteria does not
yield any matching child records.

Error Mes-
sage

Error message to be displayed to end user when the source record does not
match the filter criteria.

Field Map A map of fields in source and target objects. Not applicable for stand-alone SFM
Transactions.

Value Map List of default values to be used for target object fields. Applicable when new
records are created without a source record. Also used when existing records are
being updated.

Map Name Name of the pre-defined field or value map to be used between source and target
objects.

Save Map As User-friendly name for the map. Used when creating new maps.

Map ID Unique ID for the map. Used when creating new maps.

Target Field Name of the field from the target object.

SFM Transaction Designer Fields 287



Fields Description

Value Name of the field from the source object or a valid value.

Additional
Mapping

Two alternate mapping field names to be considered if the source field is
blank/null.

Update Field
Name

Name of the field in the source object to be updated.

Update Oper-
ation

Type of update operation to be performed on the source object field. Allowed val-
ues are Increase, Decrease and Set.

Update From Name of the target object whose field value to use in the update operation.

Update
Value

Name of the field from the selected target object or a valid value to be assigned
to the source object field.

Page Layout
Name

Name of the pre-defined page layout to be used for delivering the SFM Trans-
action.

Save Page
Layout As

User-friendly name for the page layout. Used when creating new layouts.

Page Layout
ID

Unique ID for the page layout. Used when creating new layouts.

On Load Name of the web service to be called just before the page is displayed to the end
user but after data is retrieved from Salesforce.

Before
Save/Insert
Event Type

Type of method to be called Before Insert/Save. Applicable values are Web ser-
vice or JavaScript.

Before
Save/Insert
Method

Name of the web service or JavaScript method to be called before inserting the
target header record. Applies to source-to-target processes only.

After
Save/Insert
Event Type

Type of method to be called After Insert/Save. Applicable values are Web service
or JavaScript.

After
Save/Insert
Method

Name of the web service or JavaScript method to be called after inserting the tar-
get header and child records. Applies to source-to-target processes only.

Before
Save/Update
Event Type

Type of method to be called before updating the record. Applicable values are
Web service or JavaScript.
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Fields Description

Before
Save/Update
Method

Name of the web service or JavaScript method to be called before updating the
header record. Applies to standalone edit processes only.

After
Update/Save

Name of the web service or JavaScript method to be called after updating the
header and child records. Applies to standalone edit processes only.

Help URL Name of the URL to be launched when user clicks on the Help icon.

Help text A brief help on how to use the page. Displayed as a bubble when user clicks on
the process name.

Title Title of the custom button or section.

On Click Name of the web service or JavaScript method to be called when the end user
clicks on the custom button.

On Click
Event Type

Type of method to be called on clicking the button. Applicable values are Web Ser-
vice or JavaScript.

Number of
Columns

Number of display columns in the section. Maximum of 2 is allowed in this
release.

Required Indicates if the field is Required or optional.

Read Only Indicates if the field is editable or read only.

On Exit
Event Type

Type of method to be called when end user exits the field after entering data.
Applicable values are Web Service or JavaScript.

On Exit Name of the web service to be called when the end user exits the field after enter-
ing data.

On Change
Event Type

Type of method to be called when an end user changes the field value. Applicable
values are Web Service or JavaScript.

On Change Name of the web service to be called when the end user changes the field value.

Lookup Con-
text

Controlling lookup for the current field. Applies to only lookup fields. For
example, if the page layout has two lookups, Account and Contact, Account
lookup can be defined as the Context for Contact lookup so the end user can only
select contacts that belong to the account.

Override
Context

Indicates if the end user can override the pre-defined context for this lookup. If
unchecked, the lookup will always apply the context.
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Fields Description

Matching
Field

Name of the field that should be used for matching the current lookup and the con-
text lookup records. In the above example where Account is the controlling
lookup for Contact lookup, Contact, Account Id will be the matching field.

No of rows Number of rows of display. Applies to long text fields only.

Allow New Indicates if the end user can create new records in this child section.

Allow Delete Indicates if the end user can delete existing records in this child section.

Action on
Zero Lines

Action to be taken when the user tries to save with no records in this child sec-
tion. Valid actions are Allow, Disallow or Warn.

Allow Multi-
add Using

Name of the lookup in the Child section to be used for facilitating multi-add fea-
ture.

Lookup
Name

Name of the pre-defined lookup to be used for the lookup field.

Save Lookup
As

User-friendly name for the lookup. Used when creating new lookups.

Lookup ID Unique ID for the lookup. Used when creating new lookups.

Fields to use
in search

One or more fields to be searched when querying the lookup object.

Fields to use
in results

One or more fields to be displayed in the lookup result set.

Fields to use
in bubble

One or more fields to be displayed in the lookup bubble for the selected record.

Display Field Name of the field whose value will be displayed in the lookup field. Default is the
Name field of the object.

No of
records

Number of records to display in the result set. Allowed values are 10, 20, 30, 40
and 50.

Make this
default
lookup

Indicates if this lookup configuration must be used as the default wherever this
object is used in a page layout and when no other lookup configuration is avail-
able.

Steps In Creating an SFM Transaction
Click Home > ServiceMax Setup > Service Flow Manager > SFM Transaction
Designer to view the SFM Transaction Designer screen.
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In the SFM Transaction Designer screen, the tabs across the top left of the screen are the
steps to define an SFM transaction:

Create/Edit SFM Transaction Tab

Qualifying Criteria and Mapping Tab

Source Object Update Tab

Screen Designer Tab

Data Validation Rules Tab

Advanced Options Tab

On the Create/Edit SFM Transaction tab, the Standard SFM Transactions tab lists
all the standard transactions available. Standard SFM transactions cannot be modified.
However, you can clone standard transactions to create custom SFM transactions, then
use the Your Custom SFM Transaction tab to create your own transactions.

Figure 2: SFM Transaction Designer Screen

In the Create/Edit SFM Transaction tab on the SFM Transaction Designer screen:
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To create a custom SFM transaction from a standard SFM transaction, click a stand-
ard SFM transaction from the Standard SFM Transaction tab, and click the Clone
button.

To create a new custom SFM transaction, click the Your Custom SFM Transaction
tab, and click the New button.

To create a custom SFM transaction from another custom SFM transaction, click the
Your Custom SFM Transaction tab, click a custom SFM transaction to select it,
and click the Clone button.

To delete a custom SFM transaction, click a custom SFM transaction name and click
the Delete icon on the bottom right-side of the custom SFM panel.

Caution: Use Extreme Caution when deleting SFM transactions since the effect
is immediate and irreversible.

Creating/Editing SFM Transactions
Follow the sections and steps below to create/edit an SFM Transaction.

Create/Edit SFM Transaction Tab

1. On the Create/Edit SFM Transaction tab of the SFM Transaction Designer screen,
click an SFM Transaction from Standard SFM Transactions list (for example,
"Create Usage Lines from Estimates").

Note: Standard SFM transactions cannot be modified. However, you can
clone standard transactions to create custom SFM transactions, then use
the Your Custom SFM Transactions tab to create your own trans-
actions.
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Note: If you have created custom SFM Transactions, you can select a
transaction from the list in the Your Custom SFM Transactions tab. For
existing custom or standard SFM Transactions, you can enter a name in
the Quick Find text box to automatically locate the transaction.

Figure 3: Creating/Editing SFM Transactions

2. Enter a user-friendly name for the SFM transaction. For example: Create Shipment
from Case.

3. Enter a unique ID for the SFM transaction. (Special characters are not allowed; under-
scores are allowed).

Note: For previous releases, if any Custom SFM transaction IDs contained
any special characters (for example, (/,<>?”!@$%^&*()+{}[]), they
will get converted to an underscore.

4. Enter the SFM transaction description in the Description text box.
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5. Select how SFM transactions will be used by choosing an option from the Create an
SFM Transaction picklist. For example, they can be used for:

Creating new target header and child record(s) from a source record.

Creating only new child records in an existing target record.

Editing an existing source record with/without child records.

Creating a new target record with/without child records.

Viewing a target header record with/without child records.

Figure 4: SFM Transaction Designer 

6. Specify Source and Target Objects from the Use data from and to create these
records area picklists. For example, you can specify to "use data from" a Case to
create a Parts Order record, as shown in the figure below.
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If applicable, select the source header object from which target records will be cre-
ated.

Figure 5: Specify Source and Target Objects

Any child objects available for the selected header appear. Check the relevant source
child objects

7. Select the target header object. Optionally, you can enter a more user-friendly name
for the header object. If the purpose of the SFM Transaction is to create new child
records only, the target object will be automatically set to the source object and will
be disabled.

Any child objects available for the selected target header appear. Check the relevant
target child objects. If it is a view transaction, all the objects which have a reference
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to the object appear.

Figure 6: Creating/Editing SFM Transactions

8. To use the same child object more than once as a target, click the Add button. To
remove an existing child object, click the Delete icon adjacent to the record. When
using the same child object more than once, you must specify a unique alias for each
instance. Once the SFM transaction is saved after choosing the source and target
objects, the object selection cannot be modified.

9. When specifying Source and Target Objects, you might see the message
below indicating that any changes you make in the Use data from picklist will reset
the data in the other tabs. Click OK to acknowledge the message.

Figure 7: Source and Target Object Message
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Note: The SFM Transaction options listed below are available only for iPad and
ServiceMax Mobile for Laptops:

– "As a standalone for the purpose of creating a new record."
– "View as a header record with/without its child records."

Qualifying Criteria and Mapping Tab

10. Click Next or click the Qualifying Criteria and Field Mappings tab.

The Qualifying Criteria and Mapping screen displays as shown below.

Figure 8: Specify Qualifying Criteria and Field Mappings

11. If the SFM transaction is for source-to-target record creation (both header & child and
child-only modes):

a. All the target objects (header and child) are listed on the top-left.

b. The target header is automatically associated with the source header.

c. Select the source object to be used for each target child object.
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d. For each source-to-target association, use the expression builder on the top-right
to specify the filter criteria. See Using the Expression Builder below.

e. For each source-to-target association, use the Map Builder on the bottom-right to
specify the mapping between source and target records. See Using the Map
Builder below.

12. If the SFM transaction is meant for standalone editing of a record and to manage its
lines (child records):

a. All the target objects (header and child) are listed on the top-left.

b. For each target object, use the Expression Builder on the top-right to specify the fil-
ter criteria. See Using the Expression Builder below.

c. For each target child object, use the Map Builder on the bottom-right to specify
value maps. See Using the Map Builder below.

13. If the SFM transaction is meant for standalone creation of new target object, the tar-
get objects (header and child) are listed on the top-left.

14. If the SFM transaction is for viewing the target header record with/without child
records, the Page Layout designer appears with/without child records.

15. Click Next.

16. If the transaction is a standalone edit/create, the Page Layout designer appears. For
source-to-target flows, the Source Object Update screen appears.

Using the Expression Builder

Figure 9: Expression Builder

The Expression Builder has a row of icons at the top. From left to right they are Save,
Save As,New, Refresh, Delete, and Advanced.
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To view/edit an existing expression, select its name from the picklist. The expression
details appear below. ServiceMax standard expressions cannot be modified.

To remove an existing expression, select the expression from the picklist and click
Delete. ServiceMax standard expressions cannot be deleted.

To create a new expression, click the New icon.

Any unsaved changes in the expression area will be lost when you switch between
New and Edit modes.

To insert a new expression record, click the Add icon at the end of the row. To
remove an existing record, click the Delete icon at the end of the row.

Select a Field name from the list and a relevant Operator.

Depending upon the type of field, the operand (value) can be specified either as free
text or from a list of allowed values. Use the toggle button to switch between the
Text and List modes.

Click the Advanced icon to specify an advanced expression such as 1 AND (2 OR
3).

Click the Save icon to save the expression.

To save the expression as new, enter a user-friendly expression name and a unique
expression ID, and click the Save As button.

To undo any changes you have made to an existing expression, click the Refresh but-
ton.

The filter is considered as the qualification criteria for Header objects. Click the
Advanced button to enter the error message that will be displayed to the end user if
the Header record does not match the criteria.

Using the Map Builder

The Map Builder supports the definition of three types of maps:
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Field Map for Existing Records is used when target records are created from
Source records. This can be defined for both header and detail records.

Value Map for New Records is used when target records are created from Source
records. This can be defined for detail records only.

Value Map for Existing Records is used when header and detail records are being
edited. This can be defined for header records only.

Note: Value for Existing Records is only available for Spring 12 SP2
onwards.

Based on the type of SFM transaction, the Map Builder displays one or two of the appro-
priate mapping tabs. The Map Builder has a row of icons at the top. From left to right they
are Save, Save As,New, Refresh and Delete.

To view/edit an existing map, select its name from the picklist. Map details appear
below. Standard maps cannot be modified.

To remove an existing map, select the map from the picklist and click Delete. Stand-
ard maps cannot be deleted.

To create a new map, click the New icon.

Click Save to save the map.

To save the map as new, enter a user-friendly map name and a unique map ID, and
click Save As.

To undo any changes you have made to an existing map, click the Refresh button.

Note: Any unsaved changes in the map area will be lost when you switch
between new and edit modes.

When specifying value for a target field, the screen automatically shows a list of values
based on the field data type where applicable:
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Picklist: List of values defined in Salesforce.

Date: Today, Tomorrow, Yesterday.

Checkbox: True, False.

Defining a Field Map for Existing Records:This is applicable when defining a trans-
action to create new header and child records from source object and mapping is defined
for either the header or detail object.

Figure 10: Map Builder - Field Map for Existing Records

For each target field, all compatible fields from the source object appear. If only one field
suggestion is available, it is selected automatically. If more than one compatible field is lis-
ted, you can select one of the listed fields. In addition, you can select two alternate fields if
the primary source field value is blank.

You can also specify a default value for a target field instead ofmapping it to a source
field. This is useful when certain fields cannot be mapped to the source or when fields must
be defaulted irrespective of the source value.

Defining a Value Map for New Records:This is applicable when defining a transaction to
create new header and child records from source object and mapping is defined for detail
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objects.

Figure 11: Map Builder - Apply Filter Criteria

Defining a Value Map for Existing Records: This is applicable when defining a trans-
action to edit records and mapping is defined for header object.

To define a new Value Map for Existing Header:

1. In the Value Map for Existing Records tab, click the New button. See figure
below.

Figure 12: Specify Value Maps

2. Enter the name you would like to save the Value Map as in the Save this map as
text box.

3. Enter the input ID in the Input ID Here text box.

4. In the Value Map for Existing Records tab for each target field, you can select
from a list of allowed values or enter free text depending upon the field data type.

5. When specifying value for a target field, the screen automatically shows a list of val-
ues based on the field data type where applicable.
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6. Click Save to save the map. After the value maps are defined, they are applied as
soon as a user opens a transaction.

Using the Lookup Configuration

If you are using Spring 12 SP2 onwards, skip this step and see the next section titled:
Using the Lookup Configuration (Spring 12 SP2 Onwards Only).

In the Properties for Field: Component area of the Lookup section, click the Con-
figure Lookup icon.

Figure 13: Lookup Configuration Designer (Pre-Spring 12 SP2 Release)

The Lookup Configuration screen has a row of icons at the top. From left to right, they are:
Save, Save As,New, Refresh, and Delete.
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To view/edit an existing lookup, select its name from the picklist. The lookup details
appear below. Standard lookups of ServiceMax cannot be modified.

To remove an existing lookup, select the lookup from the picklist and click Delete.
Standard lookups of ServiceMax cannot be deleted.

To create a new lookup, click the New button.

Any unsaved changes in the lookup area will be lost when you switch between New
and Edit modes.

Icons in the field list on the left indicate where each field can be used: In search, in
result set and in bubble. These are determined based on the field’s query ability and
whether the field will fit in the results/bubble.

Drag and drop the fields from the list to the appropriate sections on the right.

To remove a field from the selection, click the Delete icon adjacent to the field
name.

Select a display field for the lookup. At run time, the value from this field appears on
the screen. In most cases, the Name field of the object can be used. For example
Account Name, Work Order Number, and so on.

Note: The field selected as the Display Fieldmust be included to the list
of Fields to show in lookup results.
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Select the number of records to be displayed in the result set.

Indicate if you want the lookup to be considered as the default lookup for this object.
At run time, if no lookup configuration is available for a lookup field, the default
lookup will be used.

Click Save to save the lookup.

To save the lookup as new, enter a user-friendly lookup name and a unique Lookup
ID, and click Save As.

To undo any changes you have made to an existing lookup, click the Refresh icon.

To return to the page layout designer, click Done.

The page layout designer shows a green indicator adjacent to the Configure button
after a lookup configuration is successfully associated with a lookup field.

Note: The SFM transaction is not saved when you save a map, expression,
lookup configuration, or page layout using the Save icon in their bands. The
SFM transaction must be explicitly saved using the Quick Save or Save &
Close icons at the top of all tabs.

Using the Lookup Configuration (Spring 12 SP2 Onwards Only)

The following information are new features for Lookup Configuration for Spring 12 SP2
onward.
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In the Properties for Field: Component area of the Lookup section, click the Configure
Lookup icon (see figure below).

Figure 14: Lookup Configuration Designer (SP2 Only)

The Lookup Configuration screen has a band of buttons at the top of the screen: Save,
Save As,New, Refresh, and Delete. See figure above.
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To view/edit an existing lookup, select its name from the list. The lookup details
appear below. Standard lookups of ServiceMax cannot be modified.

To remove an existing lookup, select the lookup from the list and click Delete. Stand-
ard lookups of ServiceMax cannot be deleted.

To create a new lookup, click the New button.

Any unsaved changes in the lookup area will be lost when you switch between New
and Edit modes.

Icons in the field list on the left indicate where each field can be used: In search, in
result set and in bubble. These are determined based on the field’s query ability and
whether the field will fit in the results/bubble.

Drag and drop fields from the list to the appropriate tabs (Search, Display, Bubble) to
the right.

To remove a field from the selection, click the Delete icon adjacent to the field
name.

Using the expression builder, define the filter criteria.

Click the Add a row button if you want to add additional filter criteria.

Click the Delete button to delete a row.

Use the Advanced Expression text box to enter an advanced expression (for
example, 1 or 2).

Select a display field for the lookup. At run time, the value from this field appears on
the screen. In most cases, the Name field of the object can be used. For example
Account Name, Work Order Number, and so on.

Note: The field selected as Display Fieldmust be included to the list of
Fields to show in lookup results.
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Select the number of records to be displayed in the result set.

Indicate if you want the lookup to be considered as the default lookup for this object.
At run time, if no lookup configuration is available for a lookup field, the default
lookup will be used.

Click Save to save the lookup.

To save the lookup as new, enter a user-friendly lookup name and a unique Lookup
ID, and click Save As.

To undo any changes you have made to an existing lookup, click Refresh button.

To return to the page layout designer, click the Select button.

Source Object Update Tab

Click Next or click the Source Object Update tab.

The Source Object Update screen displays as shown below.

Figure 15: Source Object Update Tab

All source objects (header and child) in the SFM transaction are listed on the left.
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Click an object name to manage updates. All existing field updates for the selected
object appear on the right or a blank row is inserted.

To insert a new source update record, click the Add button at the end of the row. To
remove an existing record, click the Delete button at the end of the row.

Click the field name area and select the field name to be updated.

Select the operation to be performed on the selected field. Increase and Decrease
are available on numeric fields only.

Select the target object. It is preselected if there are no target child objects.

All compatible fields in the target object are displayed in the field list. Select the rel-
evant target field. This field’s value will be used to update the source field. Altern-
atively, you can enter a value instead of choosing from the list of compatible fields.

Repeat the above for each source object to be updated.

Note: The Source Object update configuration is limited to the following SFM
transaction types: "from Source Object to create new header and child
records" and "from Source Object to create new child records only."

Note: This is not currently available in the iPad application.

Screen Designer Tab

Click Next or click the Screen Designer tab. The Screen Designer screen displays as
shown below.
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Figure 16: Screen Designer Tab

From the Screen Designer tab, you can:

Design a page layout

Create a custom Get Price button

Configure the Advanced Filter

Configure the Lookup Form Fill

The Screen Designer screen is described in the bullet points and sections below.

The page layout designer includes the following icons from left to right: Save, Save As,
New, Refresh and Delete.
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The page layout list shows all existing layouts whose objects are an exact match of
the SFM transactions target objects.

To view/edit an existing page layout, select its name from the picklist. The page lay-
out is displayed below. Standard page layouts cannot be modified.

To remove an existing page layout, select the layout from the list and click the
Delete icon. Standard page layouts cannot be deleted.

To create a new page layout, click the New icon.

Click the Save button to save the page layout.

To save the page layout as new, enter a user-friendly page layout name and a unique
page layout ID, and click Save As.

To undo any changes you have made to an existing page layout, click the Refresh
button.

Any unsaved changes in the page layout area will be lost when you switch between
new and edit modes.

The organization of the Screen Designer is described below.

It contains the header design area at the top, detail design areas at the bottom, and
a context-sensitive configuration panel on the right.

Header design area can contain one or more sections that can be used to logically
group fields. Each section can contain one or more fields.

There will be as many detail design areas as there are target dependent objects in
the SFM transaction. Each detail design area can contain one or more fields from the
dependent object.

If you click a field (for example, Create Shipment from Case, Record Type ID) or sec-
tion (for example, Shipment, Location), data for that field displays and populates in
the Properties for Page area on the far right side of the window. If you click a button
(for example, Get Price), data for that button displays and populates in the Prop-
erties for Page area. The Save and Cancel buttons are default buttons and do not
display or populate data in the Properties for Page area.

The Screen Designer Page level design options are described below.
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The Save and Cancel buttons appear by default; they cannot be removed.

To add a custom button, click the Add button in the buttons section.

To remove a custom button, click the Xmark that appears when your cursor hovers
over the button.

Once a custom button is added, create a button title and select the type of action you
want to perform. See the ServiceMax User Guide to learn more about integrating web
services with button click events.

To create a custom Get Price button for work order price cal-

culations:

1. Click the Add button to create a custom button.

2. In the Properties for Button: Get Price area, enter a title for the button.

3. In the Event Type picklist, select JavaScript.

4. In the Code Snippet picklist, select Code001: Standard Get Price.

5. Check the checkbox Show in web.

6. Check the checkbox Show in iPad.

Figure 17: Properties for Button: Get Price.

At run time, the standard and custom buttons are displayed at the top and bottom of
the page.
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7. Click the page layout band at the top of the designer to manage page-level attributes.
See the ServiceMax User Guide to learn more about integrating web services with
page events.

8. You can specify a help URL and help text to guide end users of the screen. The URL
will be launched in a new window in run time.

9. You can use the iPad Options area to configure how this transaction is deployed in
ServiceMax iPad Client. If Show all sections by default is checked, the iPad dis-
plays all header sections from this page. If the screen contains many sections with
numerous fields, it is recommended to leave this checkbox unchecked. You also can
hide the Quick Save button and the Save button in the ServiceMax iPad Client by
checking their respective checkboxes in the iPad Options area. By default, the Quick
Save button and the Save button are enabled when viewing transactions.

To design a header layout:

1. To insert a new section, click the Add button at the bottom right of the last section. A
new section with blank fields will be inserted below.

2. To remove a section, click the Remove button at the bottom of the section. All fields
placed in the section will be removed as well.

3. To move a section, hold the section title area and drag and drop it to the required loc-
ation.

4. To change the properties of a section such as Title and so on, click the section title.

5. Click any blank field area to view a popup list of fields. You can search the field list by
typing part of the field name. To hide the popup, click anywhere outside of the popup
window, or press the Escape button.

6. To add a field from the popup, double-click the field name or select the field and click
the Add Field to Page button.

7. To move a field’s placement on the screen, click the field label and drag and drop it to
any empty field area.

A new empty field row displays automatically when you fill the last field row of a sec-
tion.
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8. To remove a field, click the Delete button in the field area. A field can be added to the
page layout only once.

9. Once a field is placed on the page layout, examine the field’s attributes on the right
side carefully and set them as required. See the ServiceMax User Guide to learn more
about integrating web services with field events.

To design a child layout:

1. Click the blank field area to view a popup list of fields. You can search the field list by
entering part of the field name. To hide the popup, click anywhere outside or press the
Escape button.

2. To add a field from the popup, either double-click the field name or select the field and
click the Add Field to Page button.

3. To move a field’s placement within the child section, click the field label, drag and
drop it where required.

4. To remove a field, click the Delete button in the field area. A field can be added to the
child layout only once.

5. Once a field is placed on the child layout, examine the field’s attributes on the right
side carefully and set them as required. See the ServiceMax User Guide to learn more
about integrating web services with field events.

6. Because the iPad does not support horizontal scrolling, there is limited space avail-
able to display all the child columns. In order to make the child section more readable
to iPad users, you can select the first "n" number of columns to be displayed in the
child list.

7. To move a child layout within a page, hold the child layout title area, and drag and
drop it to the required location. All child layouts must be placed below the header lay-
out.

8. Even though all child sections are listed below one another in the designer, the sec-
tions will be painted as tabs for the end user.

Data Validation Rules Tab

Click Next or click the Data Validation Rules tab. The Data Validation Rules screen dis-
plays as shown below.
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Configuring Data Validation Rules is available in the Data Validation Rules screen. This
screen includes the following areas: Data Validation Rules available for the target
objects of the SFM transaction and Data Validation Rules added to the target
objects of the SFM transaction.

Figure 18: Data Validation Rules Screen

Click the New icon to create, edit, or view a new Data Validation Rule.
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The Configure Data Validation Rules dialog box displays as shown below.

Figure 19: Configure Data Validation Rule Dialog Box

In the Data Validation Rules dialog box:

1. Select a Target Object from the Target Object picklist (see figure below for an illus-
trated example of the steps below).

2. Enter a name for your rule in the Rule Name text field. The Rule ID automatically pop-
ulates in the Rule ID text field. However, you can also enter a different name for your
Rule ID if desired.

3. Enter a description for your rule in the Description text box.

4. In the Expressions area, select an expression for your rule using the available pick-
lists. (Note: Data Validation Rule expressions support the following operands: Field,
Value, and Functions).

5. In the Expression Name field, enter an expression name.

6. Use the +/- icons to add or delete expressions.
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7. If applicable to your process, enter an Advanced Expression in the Advanced Expres-
sion text box.

8. In the Message Type picklist, select either Error or Confirmation.

Note: In the Default Message area, enter the Error or Confirmation mes-
sage your users will see when they click the Save or Quick Save button.

Note: The Error or Confirmation Default Message is the message that dis-
plays when a user violates the Data Validation Rule that you have con-
figured.

9. Click the Save button to save the Data Validation Rule. Click the Add to Process
button to add your rule to the SFM process.

10. If you click the Add to Process button, the Select Target Children dialog box dis-
plays for SFM Transactions that have more than one child section. Check the target
children (for example, Parts, Labor, Expense) checkboxes that you want to add to the
rule and then click OK.

Figure 20: Select Target Children Dialog Box
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Note: If you clicked the Add to Process button (see Figure 13), your
rule is automatically added to the SFM Transaction and displays in the
Business Rules added to the target object of this SFM Trans-
action area.

Figure 21: Configure Data Validation Dialog Box

The Data Validation Rules configured display in the Business Rules available for
the target objects of this SFM Transaction area. If you clicked the Add To Pro-
cess button from the Configure Data Validation Rules dialog box, your rules will
also display in the area titled, Data Validation Rules added to the target objects
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of this SFM Transaction.

Figure 22: Data Validation Rules Available and Business Rules Added

The Data Validation Rules available for the target objects of this SFM Trans-
action area (as shown in the figure below) lists all of the rules that you have con-
figured for your SFM Transaction. This area includes the Object, Rule Name,
Description,Message Type, and Actions for your Business Rules. You can also
search for specific rules using the Quick Find feature.

Figure 23: Data Validation Rules Available for the SFM Traction Target Objects

11. Add a rule to the SFM transaction by clicking the Add Rule to the Process icon, or
you can select a rule from available rules for the target object and drag and drop
the rule into the Business Rules added to the target objects of this SFM Trans-
action area.
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Note: If you use the drag and drop method to add a rule to a process, the
Select Target Children dialog box displays for SFM Transactions that
have more than one child section as shown in the figure below. Check the
target children (for example, Parts, Labor, Expense) checkboxes that you
want to add to the rule and click OK.

12. To save your rule under a different name, click the Save As icon.

13. To edit your existing rule, click the Edit icon.

14. To delete a rule, click the Delete icon.

The Data Validation Rules added to the target objects of this SFM Trans-
action area lists all of the rules that you have added to your SFM Transaction. This
section includes the Target Name, Rule Name, Description, Message Type, Rule Mes-
sage, and Actions (see figure below).

Figure 24: Data Validation Rules Added to the SFM Transaction Target Objects
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15. When there are multiple rules, use the up/down arrows to define the sequence in
which rules are applied.

16. To remove a Business Rule from the SFM Transaction, click the Remove Rule From
Process icon in the Actions area.

Advanced Options Tab

Click Next or click the Advanced Options tab. The Advanced Options screen displays as
shown below.

Figure 25: Advanced Options Screen

In the Advanced Options tab you can:

Enable attachments on mobile devices

Configure field sets

Linked processes

Configure multi source process

Configure fields for sorting
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Configuring iPad Attachments to Records

iPad users can upload photos and videos to a source object (for example, Work Order).
Technicians can capture real-time pictures and videos in the ServiceMax 14 for iPad app
and attach them to an SFM transaction.

Administrators must configure this feature for each specific SFM before it is available to
end users. Attachments are enabled for a target object in the Advanced Options tab of the
SFM Transaction Designer.

To configure iPad attachments to records:

1. In the SFM screen, click the Advanced Options tab.

2. In the Enable Attachment for a Target Object area, check the Target Object
checkbox as shown in the figure below.

3. Click Save & Close to save the transaction and close the screen. Click Quick Save
to save the transaction and remain on the current screen.

Figure 26: Enabling Attachment for a Target Object

Note: For attachments on mobile devices, there is a Salesforce upload (from
end user to server) size limitation of 5 MB per file.
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Field Set and Configure Fields for Sorting

Field set and configure fields for sorting are available in the Advanced Options screen as
shown in the figure above. This screen includes the following areas: Field Sets, Select
Target Object, Available Field Sets, and Selected Field Sets.

To configure field sets for sorting:

1. Select a target object from the list of objects in the Select Target Object area.

2. In the Available fields area, select an available field. Use the arrow to move the
available field into the Selected fields area.

3. Move all desired available fields into the Selected fields area.

4. Use the up/down arrows next to the Selected fields area to determine the order of the
selected fields.

5. To return a selected field to the Available fields area, select a selected field and click

the arrow.

At anytime during the SFM transaction creation process, you can click the Quick Save but-
ton to save the SFM transaction (even if it is incomplete) and continue to edit the flow.

To save the SFM transaction and return to the ServiceMax Setup home page, click the
Save & Close button at the top of the screen.

To cancel any changes you have made to the transaction and return to ServiceMax Setup
Home, click the Cancel button at the top of the screen. If you cancel, any expressions,
maps, page layouts, and lookup configurations saved while building the SFM transaction
will not be rolled back.

To undo any changes you made to the flow and start from the first step, click the Start
Over button at the top of the screen. If you start over, any expressions, maps, page lay-
outs and lookup configurations saved while building the SFM transaction will not be rolled
back.

Configuring Multi-Source Processes

You can configure multi-source processes from the Advanced Options tab of the SFM Trans-
action Designer. The multi-source process feature is useful when information from the
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source and dependent records need to be updated in the target record(s). This con-
figuration is applicable for only transactions of the type, "from Source Object to create
new header and child records." You must create the SFM Transaction that will be used as
the secondary source before configuring the Multi-Source feature.

To configure multi-source processes:

1. In the primary SFM transaction, click the Advanced Options tab, as shown in the fig-
ure below.

Figure 27: Advanced Options Tab: Multi-Source Configuration

2. Click Multi-Source Configuration located on the left pane of the screen.

A list of possible Lookup fields from the target object appear in the Select source
field for sub-process picklist.

3. Select a field from the Select source field for sub-process picklist, representing
the source object of your secondary dataset. A list of SFM Transactions that can be
used as a source for the secondary data appear in the Available SFM Processes area.

4. Click the radio button next to an SFM Process to select it.

5. Click Save and Close or Quick Save.
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Advanced Filter
You can use the Advanced Lookup tab to create advanced filters based on a related object
(for example, Product Stock). You must first select the transaction (standard or custom)
you want enabled by the advanced filters. The figure below displays an example of the
Advanced Filter tab dialog box. The table below provides a description of the text fields
and icons in the Advanced Filter tab dialog box.

Figure 28: Advanced Filter tab Dialog Box
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Advanced Filter Fields and Icons Table

The table below provides a description of text fields and icons of the Advanced Filter tab
dialog box as shown in the figure above.

Fields and

Icons
Description

Object Name of an object you want to configure (for example, Product Stock).

Filter Name Name of a filter.

Description A description of a filter.

Default On Checkbox to enable the Advanced Filter as a default. All end user searches per-
formed for that lookup will be on by default.

Allow Over-
ride

Checkbox to enable an override of a filter. Use this if you want to allow end
users to turn a filter off when they perform the search.

Advanced
Expression

Advanced criteria for your rule.

Edit Clicking this icon enables you to edit your filter Object, Description, and Filter
Name in the Define filter and its expressions area.

Create/Reset
Filter

If you have made any changes to the filter, clicking reset will change it back to
the saved advanced filter configuration.

Save Saves your filter.

Save As Saves your filter under a new name that you designate.

New/Add a
row

Adds a new row for you to create a new filter.

Reset If you have made any changes to the filter, Reset will delete your current filter
configuration and restore your saved advanced filter configuration.

Trash Discards your filter.

Add Filter but-
ton

Adds filter to the Lookup configuration after you have defined the filter and its
expressions.
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Fields and

Icons
Description

Select button Applies the filter to the Lookup configuration.

Cancel button Cancels your filter.

Advanced Filter Configuration

Advanced Filter is used for creating advanced filters based on a related object. A use case
scenario for using Advanced Filter is Product Stock. In this example, the administrator cre-
ates an advanced filter that limits the parts a technician can record to only those parts
that are available in his or her trunk. Creating this type of advanced filter will reduce tech-
nician errors. This example is illustrated in the instructions below.

To configure an Advanced Filter:

1. In the Screen Designer tab, click an object's text area and then click the Configure
Lookup button to open the Configuration Lookup field dialog box. See figure below
for a procedural illustration.

Note: You can also click an object's Lookup icon to open the Con-
figuration Lookup field dialog box.
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Figure 29: Screen Designer Tab
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2. In the Configuration Lookup field dialog box, click the Advanced Filter tab.

Figure 30: Advanced Filter Tab Dialog Box

3. In the area titled, Define filter and its expressions:

a. Select a related object to configure an advanced filter from the Object picklist.

b. Enter a description of the filter in the Description text box.

c. Enter a name for your filter in the Filter Name text box.

d. Check the Default On checkbox if you want to enable this feature by default. (All
searches end users perform for the lookup search will be on by default).

e. Check the Allow Override checkbox if you want to allow end users to turn this fil-
ter off when they perform the search.
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4. Determine your filter expressions (criteria): See figure below.

a. Select an option from the Select expressions picklist.

b. Select an operator (for example, Equals, Not Equal, Greater Than) from the appro-
priate picklist.

c. Select Value or Function from the appropriate picklist. See figure below for an
example of a value and function.

d. Enter the Value or the Function in the corresponding picklist.

e. To add additional expressions, click the Add a row icon.

f. To delete an expression, click the Delete icon.

Figure 31: Define Filter and its Expressions Dialog Box

5. In the Advanced Expression text box, enter an advanced expression (for example,
1 and 2) if this applies to your filter.

6. Click the Add Filter button to add your filter to the Lookup configuration.

Note: The only function supported is User Trunk.
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Figure 32: Advanced Filter Tab Dialog Box

7. If you have multiple filters displayed, click the Select button to apply the filter con-
figuration to the Lookup filter.

8. If you need to cancel your filter, click Cancel.

Lookup Form Fill
The Lookup Form Fill feature enables you to configure mapping that copies information
from a looked up record to the current record being edited.
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To Configure the Lookup Form Fill feature:

1. Edit an SFM Transaction and click the Screen Designer tab. See figure below.

2. Click an object's Lookup icon.

3. In the Object Mapping picklist, select the defined mapping.

For an illustration of the above procedures, see the figure below.

Figure 33: Configure SFM MappingWindow (Form Fill Example)

4. Save the page layout and the transaction. The feature is ready to use in the SFM trans-
action.
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Note: If you do not see your defined map in the Object Mapping picklist, you
can define a map in the SFM Mapping module. For instructions on how to
define an SFM Map, see Advanced Configuration: SFM Mapping.

See also (for Lookup Form Fill):

For more information about the Screen Designer tab, see: Screen Designer Tab.

For information on how to define a map, see: Advanced Configuration: SFM Map-
ping.

For a use case example of Lookup Form Fill, see: Lookup Form Fill Use Case.

For more information about Lookup Form Fill, see Using the SFM Transaction
Screen > Lookup Form Fill section.

Cloning SFM Transactions
You can make any modification to a cloned SFM transaction. Instructions are described
below.

To clone an SFM transaction:

1. Click Home > ServiceMax Setup > Service Flow Manager > SFM Transaction
Designer to view the SFM Transaction Designer screen.

2. From the Create/Edit SFM Transaction tab, click the Standard SFM Trans-
actions or Custom SFM Transactions tab.

3. Select a standard or custom SFM transaction. For existing custom or standard SFM
transactions, you can enter the name in the Quick Find text box to automatically loc-
ate the transaction.

4. Click the Clone button.

5. Specify Source and Target Objects.
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Select the source header object from which target records will be created.

You can only edit the source and target objects when you create a new transaction
for the first time or when you clone a transaction that you have not yet saved.

All available child and related objects for the selected header are displayed. Select
the relevant source child objects.

Select the target header object. Optionally, you can enter a more user-friendly
name for the header object. If the purpose of the SFM Transaction is to create new
child records only, the target object will be automatically set to the source object
and will be disabled.

Any child objects available for the selected target header are displayed. Check the
relevant target child objects. If it is a view transaction, all the objects which have a
reference to the object are displayed.

Figure 34: Specify Source and Target Objects

6. To use the same child object more than once as a target, click the Add button. To
remove an existing child object, click the Delete icon adjacent to the record. When
using the same child object more than once, you must specify a unique alias for each
instance.

7. Once SFM transaction is saved after choosing the source and target objects, the
object selection cannot be modified.

8. Click Next to access the Qualifying Criteria and Field Mappings tab (see Creat-
ing/Editing SFM Transactions for complete instructions for Qualifying Criteria
and Field Mappings tab, Source Object Update tab, and the Screen Designer
tab.)

SFM Transaction Designer

334 Cloning SFM Transactions



SFM Transaction Designer

Note: For complete step-by-step instructions, follow the instructions provided
in the above section titled "Creating/Editing SFM Transactions."

Note: You can only edit the source and target objects when you create a new
transaction for the first time or when you clone a transaction that you have not
yet saved.

Deleting an SFM Transaction

To delete an SFM transaction:

1. Click the name of the custom SFM transaction at the bottom left.

2. Click the Delete button.

3. If the transaction has been configured to run from a button or link, you must remove
such buttons/links from the page layout and delete the buttons manually.

Note: ServiceMax Standard SFM transactions cannot be deleted.

Deploying an SFM Transaction
Once an SFM transaction is configured, you must explicitly deploy it for use by your end
users.

Standalone Edit, Source-to-target Create, and Source-to-target Child Only transactions
can be deployed using the SFMWizard. For more information about SFMWizards, see
Advanced Configuration: SFMWizards.

Standalone Create and View Record transactions are supported by the ServiceMax iPad cli-
ent only. To grant access to these transactions, see Setting Up SFM Permissions for
iPad.

It is a recommended practice to create/update your SFM transactions on a Sandbox
instance and verify them before deploying them to production. Once you have successfully
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verified the SFM transactions on the Sandbox, you can migrate them to the production
instance using the SFM Migrator tool. See the SFM Migrator for more information.

Note: Picklist values should be restricted by Record types when the Record
types are known. Also, dependent picklists are supported in SFM Delivery if all
the fields are present. All dependent fields should be present in the Page Lay-
out to support dependent picklists.

Output Documents Overview
Output Documents, also known as Smart Business Documents or Smart Documents, are
service reports and business documents that require ServiceMax and Salesforce data (for
example, company name, company logo, Work Order details, work performed, billing
details, and so on).

You can create templates for your Output Documents in HTML instead of VF pages, which
significantly reduces the complexity of creating business document templates. The table
below lists all the supported functions for creating Output Documents.

For information on how to create an Output Document/Smart Document, see Creating an
SFM Output/Smart Document below.

SFM Template Designer Functions for Output Documents

The functions in the table below are supported in the Output Documents.

Type
Function

Name
Description Syntax Example

Conditional BOOL Returns True if all
the arguments are
non-null, false oth-
erwise.

$F.BOOL(<value>) $F.BOOL
($D.WorkOrder.Id)

Conditional
IF Returns truthy if the

provided condition is
true, false oth-
erwise.

$F.IF(condition,
truthy, falsey)

$F.IF
($D.WorkOrder.Id,
'True', 'False')
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Type
Function

Name
Description Syntax Example

Conditional ISNULL Shortcut $BOOL() to
check for null val-
ues. Returns True if
the value is null,
false otherwise.

$F.ISNULL(<value>) $F.ISNULL
($D.WorkOrder.Id)

Date NOW Returns the current
date time.

$F.NOW() $F.NOW()

Date TODAY Returns a "today"
date.

$F.TODAY() $F.TODAY()

Date TOMORROW Returns a "tomor-
row" date.

$F.TOMORROW() $F.TOMORROW()

Date YESTERDAY Returns a "yes-
terday" date.

$F.YESTERDAY() $F.YESTERDAY()

LNumber LNUMBER Formats a number
using the user locale
settings.

Syntax :
$F.LNUMBER
(<value>)

Example:
$F.LNUMBER(23.45)

Math ADD Adds up all the val-
ues that are passed
as arguments to this
function. It is expec-
ted that the type of
all the values be
same. Otherwise,
the behavior is
undefined.

$F.ADD(<value1>,
[<value2>,...])

$F.ADD(2,3)

Math INT Converts the value
to an integer.
Returns 0 for invalid
values.

$F.INT(<value>) $F.INT('23')

Math SUMOF Adds the values for a
given column name
from the record col-
lection.

$F.SUMOF
(<recordCollection>,
'<columnname>')

$F.SUMOF
($D.WorkOrderLines,
'SVMXC__Estim-
ated_Quantity2__c')
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Type
Function

Name
Description Syntax Example

Number ROUND Limits the decimal
places to specified
number of digits.

$F.ROUND
(<value>,<no. of
digits>)

$F.ROUND(23.45,1)

Organization ADDRESS Returns the address
of the Organization.

$F.ADDRESS() $F.ADDRESS()

Organization LOGO Shows the document
with name LOGO as
an image. Note: You
must use key word
SFM_OUTPUT_
DOCUMENT and doc-
ument unique name
LOGO when upload-
ing a new image.

$F.LOGO() $F.LOGO()

String FORMAT Function that allows
you to pass in a tem-
plate string (a string
that contains place-
holders) and some
parameters, and it
replaces the place-
holders from the tem-
plate string with the
parameter values.

$F.FORMAT
(<String>,
[<value1>,...]

$F.FORMAT("Wel-
come {0}
",$F.USERNAME())

String TOUPPER Converts the argu-
ments that have
passed to uppercase.

$F.TOUPPER
(<value>)

$F.TOUPPER
($D.WorkOrder.Id)

User USERNAME Returns the logged in
user name.

$F.USERNAME() $F.USERNAME()

Creating an SFM Output/Smart Document

To create an SFM Output Document:

1. Click Home > ServiceMax Setup > Service Flow Manager > SFM Transaction
Designer to view the SFM Transaction Designer screen.

2. Click the Create/Edit SFM Transaction tab.
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Create/Edit SFM Transaction Tab

3. Click the Your Custom SFM Transactions tab.

Note: You cannot edit an Standard SFM Transaction, but you can clone an SFM
Transaction, and then edit it. For more information, see Cloning SFM Trans-
actions.

4. Click the New SFM Transaction icon located at the bottom right corner of the Your
Custom SFM Transaction tab (see figure below).

Figure 35: Your Custom SFM Transactions

5. Enter a user-friendly name for the SFM transaction. For example, ServiceMax Work
Order Service Report.

6. Enter the SFM transaction description.

7. Select to generate an Output Document with/without its child records from
the Create an SFM Transaction picklist. See figure below.
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Figure 36: Output Document Description

8. Select the target header object for any object (for example, Work Order) from the
area titled ...to create these records.

9. Select one or more Work Order line items (for example, Labor, Expense, Travel,
Parts, and so on) by checking their checkbox. Any child objects available for the selec-
ted target header appear. If the As text box does not automatically populate, enter a
descriptive name in the text box.

Figure 37: Select Relevant Target Child Objects

10. To use the same child object more than once as a target, click the Add button. To
remove an existing child object, click the Delete icon adjacent to the record. When
using the same child object more than once, you must specify a unique alias for each
instance.

When specifying Source and Target Objects, you might see the message
below indicating that any changes you make in the Use data from picklist will reset
the data in the other tabs. Click OK to acknowledge the message.

Figure 38: Source and Target Object Message

11. Click the Next button located at the bottom right corner of the screen, or click the
Qualifying Criteria and Field Mappings tab.
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Qualifying Criteria and Field Mappings Tab

12. In the Create map for target fields section, select an object by clicking it. See fig-
ure below.

Figure 39: Qualifying Criteria for Output Documents

13. In the Apply the filter criteria below on the source child object section.

a. Select an existing filter from the Use an existing filter picklist. See above fig-
ure.

b. Use the expression builder for each filter criteria you create. (Follow the instruc-
tions below if you are creating more than one filter criteria).

i. The expression builder has a band of buttons at the top: Save, Save As,New,
Refresh, Delete, and Advanced.

ii. To view/edit an existing expression, select its name from the list. The expres-
sion details appear below. Standard expressions of ServiceMax cannot be mod-
ified.

iii. To remove an existing expression, select the expression from the list and click
Delete. Standard expressions of ServiceMax cannot be deleted.

iv. To create a new expression, click the New button. Any unsaved changes in the
expression area will be lost when you switch between new and edit modes.

v. To insert a new expression record, click the Add button at the end of the row.
To remove an existing expression record, click the Delete button at the end of
the row.
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Note: Field Mapping is not a relevant feature when creating Output Docu-
ments.

14. Using the Target Object tab: (Target objects are used only Smart Documents).

15. Click the Next button or click the Template Designer tab. 

Template Designer Tab

The Template Designer screen contains three areas (see figure below):

Template Builder (located on the top of the screen). From the Template Builder,
you can use an existing template or create a new template.

Content tree (located on the left side of the screen). The content tree includes the
target fields you selected in the Qualifying Criteria and Field Mappings screen and
functions. For a description of functions, see SFM Output Document Guidelines.
The Content Tree area includes two text fields above the tree: Field Value and
Field Label.

HTML editor (located on the right side of the screen). You can click the Source but-
ton to view the HTML code (see figure below).
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Figure 40: Template Designer

16. From the Template Builder area, select a template from the Use an existing tem-
plate picklist. (The Save template as field and the input ID fields are auto-
matically populated, but you can update these fields by clicking inside the field area
and entering new names).

17. If necessary, in the Save template as field, enter the name you want to use to save
your template.

18. If necessary, update the input ID for your template in the Input ID Here field.

19. Click the Save button to save the template.

Note: If you try to save the template using an existing ID, an error mes-
sage displays indicating that you must save the template under a new
name (see figure below).

Figure 41: Template Unique ID Message

Note: If you have cloned your template, your template is already pop-
ulated, but you can still update this content by clicking anywhere in the
content template area.

20. Use data and functions to create your template (see steps below).

21. Add data to your template.

a. Open data from the Content Tree. (Click the + sign to open data options).

b. Select one of the data options. (The Field Value text box and the Field Label
text box automatically populates).

c. Select the merge field content from the Field Label text box and copy and paste
it into your template (see Figure 24 above).

d. Select the content from the merge field/Field Value text box and copy and paste
it into your template (see Figure 24 above).
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22. Add functions to your template.

a. Open a function from the Content Tree. (Click the + sign to open the options for a
function).

b. Click one of the options for a given function. The Field Value and the Field Label
populates.

c. Select the function value content from the Field Value text box and copy and
paste the function value content into your template.

d. Select the function value content from the Field Label text box and copy and
paste the function value content into your template.

Note: For a list of functions and their definitions, see SFM Output Docu-
ment Guidelines.

Note: To apply style based formatting like italics, bold, and so on, you
must set up a font family explicitly (see example below). Otherwise the
default font "Unicode MS" will be applied, which does not support format-
ting.

Example:<p style="font-family:times new roman,times,serif;">
<u><em><strong>welcome</strong></em></u></p>
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Figure 42: Template Designer

23. Click the Save button to save the template.

24. Before you can view your Output Document, you must first create a custom wizard
step for the Output Document (see SFM Wizard Designer for information about how
to create a wizard).

A sample Output Document is shown below.
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Figure 43: Sample Output Document

SFM Output Document Guidelines
The SFM Output Document Guidelines provide a detailed guideline for using expressions
within SFM Output Document Templates. This section includes details on various imple-
mentation considerations, including naming conventions and best practices. These
guidelines also serve as a rulebook, which MUST be followed throughout the imple-
mentation cycle.

See the following tables below.

Note: These guidelines are primarily for the developers of the template.
However, it can also be used by the template reviewers to validate the tem-
plates against the guidelines.

Note: Output Documents are also referred to as Smart Business Documents.

Guideline

ID
Guideline Description

OD-DEL-

GEN-

EXP001

An output document expression MUST always be enclosed between a starting pair of

braces and ending pair of braces.

Ex.{{$D.WO.Id}}

OD-DEL-

GEN-

EXP002

To show a form UI, use a table with required number of columns and rows. Each cell

can than hold one or more values.

OD-DEL-

GEN-

EXP003

All of the standard function are available and MUST be accessed on the namespace

$F.

Ex:<div svmx-data=’{{$F.IF($D.WO.val > 10, true, false)}}’>WorkOrder Id</div>
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Guideline

ID
Guideline Description

OD-DEL-

GEN-

EXP004

All arithmetic operations are valid to be executed and do not necessarily require any

special functions.

Ex:<div svmx-data=’{{$D.WO.num1 + $D.WO.num1}}’>{{$D.WO.num1 +

$D.WO.num1}}</div>

OD-DEL-

GEN-

EXP005

Avoid using HTML constructs to provide styles. Instead use CSS styles.

Example:

HTML style:<b>{{$D.WO.Id }}</b>

CSS style:<div svmx-data=’{{$D.WO.Id}}’ style=’font-weight:bold’>WorkOrder

Id</div>

OD-DEL-

GEN-

EXP006

For images, only JPEG, PNG, and GIF images are supported. No other formats will be

supported.

OD-DEL-

GEN-

EXP007

Label expressions should follow the format {{$M.<Alias Name>.<Field Name>.la-

bel}}

OD-DEL-

GEN-

EXP008

In order to access label of one or more fields of an object, it is required that at least

one field from the corresponding object is accessed in the template.
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Guideline

ID
Guideline Description

OD-DEL-

GEN-

EXP009

All images that need to be used in the template MUST be uploaded to Documents

within SFDC. Further, following information MUST be added for that document:

a. Document Unique Name: A unique name for this document.

b. Keywords: SFM_OUTPUT_DOCUMENT

OD-DEL-

GEN-

EXP010

To include custom styles OR media queries (typically for header and footer), include

a single HTML STYLE tag at the beginning and define all the relevant attributes.

Example:

<style type="text/css">

@page{

size:A4 landscape;

@top-left {

color: rgb(255,0,0); content:'{{$D.Work_Order.Name}}';

font-size:18px;font-color:red;font-weight:bold;text-align:left;

}

}

.table {

color: #fff;

}

</style>
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Guideline

ID
Guideline Description

OD-DEL-

GEN-

EXP011

In order to apply style based formatting like italics, bold, and so on, one has to also

setup a font family explicitly. Otherwise the default font "Unicode MS" will be applied

which will not support formatting.

OD-DEL-

GEN-

EXP012

In order to apply locale formatting for number one has use the function LNUMBER for

the field.

Example: {{$F.LNUMBER($D.Work_Order.SVMXC__Latitude__c)}}

OD-DEL-

GEN-

EXP013

In Style mode, the IMAGE function cannot be nested. The parameter to the function

should be a legitimate image name.

Example:

<style type="text/css">

@page{

size:A4 landscape;

@top-left {

color: rgb(255,0,0); content:'{{$D.Work_Order.Name}}';

font-size:18px;font-color:red;font-weight:bold;text-align:left;

background-image: url({{$F.IMAGE(‘ServiceMaxLogo’)}})

}

}

.table {

color: #fff;

}

</style>
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Guideline

ID
Guideline Description

OD-DEL-

ATT-

EXPR001

All the attribute driven data bindings MUST be done against a custom ServiceMax

attribute svmx-data.

Ex:<div svmx-data=’{{$D.WO.Id}}’>WorkOrder Id</div>

OD-DEL-

ATT-

EXPR002

Whenever a div is used to do attribute based data binding, it is a good practice to

keep the div’s contents same as the data binding value.

Ex:<div svmx-data=’{{$D.WO.Id}}’>{{$D.WO.Id}}</div>

OD-DEL-

ATT-

EXPR003

When it is required to use string literals as part of the expression, use double-

quotes to contain the expression and single-quotes to represent the string literal.

Ex:<div svmx-data=”’WorkOrder Id:’ + {{$D.WO.Id}}”>$D.WO.Id </div>

OD-DEL-

ATT-

EXPR004

Only following HTML elements are supported for attribute based data binding:

01.  DIV

02.  IMG

03.  TABLE

04. TD
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Guideline

ID
Guideline Description

OD-DEL-

ATT-

EXPR005

Child lines should follow the below table structure in order to display data:

<table svmx-data=”{{<child object name alias>}}”>

<thead>

<tr>

<th svmx-data=”{{<field name>}}”><Column Label></th>

…….

……

</tr>

</thead>

</table>

Ex:

<table svmx-data=”{{$D.Work_Details__Work_Order_}}”>

<thead>

<tr>

<th svmx-data=”{{SVMXC__Line_Type__c}}”>Line Type</th>

<th svmx-data=”{{SVMXC__Billable_Quantity__c}}”>Quantity</th>

<th svmx-data=”{{SVMXC__Billable_Line_Price__c}}”>Price</th>

</tr>

</thead>

</table>

SFM Output Document Guidelines 351



Guideline ID Guideline Description

OD-DEL-IL-

EXPR001

It is possible to use data binding as part of the content of an HTML element.

Ex:<p> Current date is {{$F.TODAY()}}</p>

OD-DEL-IL-

EXPR002

Rest of the rules that apply to bindings for the attribute based binding hold

good for inline data binding.

OD-DEL-IL-

EXPR003

Only the following HTML elements are supported for inline based data binding:

01.  DIV

02.  P

03.  PRE

04.  B

05.  U

06.  I

07.  H1, H2, H3, H4, H5, H6

08.  SPAN

09.  STYLE (for Header and Footer)

10.  EM

11.  STRIKE

12.  SUB

13.  SUP

14.  OL

15.  LI

16.  UL

17. B
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Guideline ID Guideline Description

OD-DEL-IL-

EXPR004

One cascade the supported elements while creating an inline data binding

expression.

Ex:<p> Current date is <b>{{$F.TODAY()}}</b></p>

OD-DEL-IL-

EXPR005

It is possible to have more than one data binding in an inline expression.

Ex:<p> Current date is <b>{{$F.TODAY()}}</b>. User: <i>

{{$F.CURRENT_USER()}}</i></p>

OD-DEL-IL-

EXPR006

For labels, all the rules are the same as data bindings.

Guideline ID Guideline Description

OD-DEL-PM-EXPR001 Object Permissions for designing Output Documents:

Name Create Read Update Delete

ServiceMax Process X X X X

ServiceMax Config Data X X X X

Doc Template X X X X

Doc Template Details X X X X

ServiceMax List X X X X
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Guideline ID Guideline Description

OD-DEL-PM-EXPR002 Object Permissions for viewing Output Documents:

Name Create Read Update Delete

ServiceMax Process X

ServiceMax Config Data X

Doc Template X

Doc Template Details X

ServiceMax List X X X

OD-DEL-PM-EXPR003 Page Permissions:

OPDOC_Delivery

OPDOC_DocumentViewer

Note: Server Cache: Any changes made to the Salesforce object model must
be explicitly made available to SFM by refreshing server cache. This process is
not automatic or optional. The following changes require server cache refresh:
picklist field dependencies with other picklists are changed and picklist field
dependencies with associated record types are changed. The auto-con-
figurator will build a server cache automatically if it is empty.

For more information about Server Cache, see Server Cache.

SFM Availability Matrix
There are some SFM features that are only available on the ServiceMax Suite and not the
ServiceMax Mobile iPad. See the table below for a list of these features.

SFM Transaction Designer

354 SFM Availability Matrix



SFM Transaction Designer

SFM Feature
Available on ServiceMax

Suite

Available on iPad

Mobile

Advanced Lookup Con-

figuration

Yes No

Value Maps for Existing

Records

Yes No

Warning Messages Yes No

See Also:

SFM Literals/Constants/Field Attributes
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SFM LITERALS/CONSTANTS/FIELD ATTRIBUTES

Overview
Literals provide a way to set specific information when defining a mapping or expression.
For mappings, use literals when you do not have Source to Target mapping capability, or
when applying a static or value mapping instance. Literals are also used in defining Expres-
sions, Source Object updates, and Advanced Data Validation.

Literals are used by typing or copying/pasting them into the mapping/expression result
field.  In some cases, available literals may be selected from a picklist. This is usually
reserved for Date Fields.

A description of supported literals are displayed in the table below.

Literal Description Note

Today or SVMX.TODAY: This option is selec-
ted from a picklist.
If no picklist is avail-
able, use
SVMX.TODAY

Tomorrow: This option is selec-
ted from a picklist. 

Yesterday: This option is selec-
ted from a picklist.

Now or SVMX.NOW: This option is selec-
ted from a picklist.
If no picklist is avail-
able, use
SVMX.NOW
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Literal Description Note

SVMX.USERTRUNK: This populates the
Location or Site
field. This literal
should be available
as a pick-list option
in advanced lookup
filter expressions. At
this time, advanced
lookup filter expres-
sions are the only
supported area for
this literal.

SVMX.CURRENTRECORD.<FieldAPIName>:   This is not a picklist
literal.  This literal is
only available in for
Lookup Pre-filter Cri-
teria, Value Map-
pings, and Field
Mappings. This can-
not be used to apply
Mapping for “Create
New Record” type
SFMs.

This literal is
not supported
for Advanced
Lookup Filters,
Advanced Data
Validation,
SFM Expres-
sions, or
Source Object
Updates.

SVMX.CURRENTRECORDHEADER.<FieldAPIName>:  This is not a picklist
literal. This literal is
only available in for
Lookup Pre-filter Cri-
teria, Value Map-
pings, and Field
Mappings. This can-
not be used to apply
Mapping for “Create
New Record” type
SFMs.

This literal is
not supported
for Advanced
Lookup Filters,
Advanced Data
Validation,
SFM Expres-
sions, or
Source Object
Updates.

This is the one
often used
when defining
Linked Process
value map-
pings.

SFM Literals/Constants/Field Attributes
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Literal Description Note

SVMX.OWNER:   This literal is only
available for use in
VF Page Expressions
or
Updates. Examples
include Inventory or
Dispatch processes.

SVMX.CURRENTUSER:  This literal should be
generally available
but is not presented
as a picklist nor will
it display OnLoad or
before saving the
transaction.

It is important
to be aware
that this literal
returns the Full
Name of the
User, not the
User Id. This
may result in
discrepancies
if there are
multiple users
with the same
name.

The table below shows the supported SFM literals, constants, and field attributes.

Dat-

a

Typ-

e

Literal Name

SFM

Map-

ping

SFM

Expres-

sion

SF-

M

Biz

Rul-

e

Output

Docu-

ments

OptiMax

(Skill

Match-

ing

Rules)

Sup-

ported

by SOQL

Query

Date Yesterday Yes Yes Yes Yes Yes

Date Tomorrow Yes Yes Yes Yes Yes

Date Today Yes Yes Yes Yes Yes

Date SVMX.TODAY - - -
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Dat-

a

Typ-

e

Literal Name

SFM

Map-

ping

SFM

Expres-

sion

SF-

M

Biz

Rul-

e

Output

Docu-

ments

OptiMax

(Skill

Match-

ing

Rules)

Sup-

ported

by SOQL

Query

Date
Time

Now Yes Yes (It
works like
today
only).

Yes Yes No (At run
time Now
is
replaced
by Today).

Date
Time

SVMX.NOW - - -

Date THIS_WEEK No No No Yes Yes

Date NEXT_WEEK No No No Yes Yes

Date LAST_WEEK No No No Yes Yes

Date THIS_MONTH No No No Yes Yes

Date NEXT_MONTH No No No Yes Yes

Date LAST_MONTH No No No Yes Yes

Date NEXT_90_DAYS No No No Yes Yes

Date LAST_90_DAYS No No No Yes Yes

User SVMX.CURRENT_USER No No No

User SVMX.CURRENTRECO-
RD

Yes No No

User SVMX.CURRENTHEAD-
ER

Yes No No

Linked Processes
A Linked Process provides a method for connecting SFMs to allow the invoking of the
linked SFM from within another SFM.  

The linked process allows secondary related actions to be carried out.  For example, linked
process allow Usage/Consumption lines to be added to a Product Service work

SFM Literals/Constants/Field Attributes
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details.  The Product Serviced work details provides support for one work order to doc-
ument service of many Installed Products.

Adhere to the following with regard to Linked Processes:

Make sure you understand the architecture of your processes. The standard Linked
Process adding Usage/Consumption lines to a Product Serviced work detail includes
a WO (Source) to WD (Target) SFM that invokes a WD (Source) to WD (Target)
SFM. 

The SFM type used for a linked process must be  “as Standalone for the purpose of
editing an existing record.”

If Linked Process SFM adds a child record, the Parent source record must be
mapped.  (In Product Serviced SFMs, the literal that links the Usage/Consumption to
the work order would be SVMX.CURRENTRECORDHEADER.SVMXC__Service_Order__
c).

To Map the IP that the T&M is coming from in the Standard SFM, you will have to
Clone and add the Literal for the Serial Number field on WD.
(SVMX.CURRENTRECORDHEADER.SVMXC__Serial_Number__c)

The Linked SFM for the T&M Portion of the standard Product Serviced SFM is “Manage
Work Details for Product Serviced” (this is not obvious as they renamed it in the
Linked process section of the Add/Edit Product Serviced SFM).

When Adding Literal Mappings for linked Process, the fields have to be on the Page
Layout. With it being an Onload action, it is added on the screen designer.
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SCHEDULED SFM

Overview
Some businesses have SFM Transactions that need to be executed automatically for qual-
ifying records without any manual intervention. This feature is useful when automatic exe-
cution is required for large volume of records.

Following are the salient aspects of this feature:

A new configuration option named Scheduled SFM enables definition of schedules

The SCON Scheduler executes the defined schedules at hourly intervals

A Scheduled SFM Process is a combination of one or more schedules for one or more
SFM Transactions; multiple Scheduled SFM Processes can be defined

An option is provided to invoke a process interactively to test configurations

Only Source to Target (child only and header & child) and Standalone Edit type of
SFM Transactions, which are Complete, are supported for scheduled execution

Business Context
There are many transactions that are repetitive and do not need manual intervention.
Examples could be Service Contract Renewals, creating work orders when RMA’s are
received, creating shipments when a depot repair work order is completed, creating work
orders for qualifying installed products, and so on. When these transactions need to be
executed for a large volume of records, customers must either manually perform them or
write custom code. This feature helps achieve the requirements related to bulk SFM exe-
cution, without custom code or manual intervention.

Detailed Feature Description
The Scheduled SFM feature consists of a configuration screen to define Scheduled SFM Pro-
cesses and SCON Scheduler that executes the defined schedules.
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Scheduled SFM Processes Configuration Screen
Enables the user to create/edit/clone/delete a Scheduled SFM Process

Enables the user to manually run a scheduled SFM Process

The General Info tab enables users to:

Define the Process Name, Id, and description for the scheduled SFM process

Make the process Active

Select one or more SFM Transactions to schedule from the list of available SFM
Transactions

Only Source to Target (child only and header & child) and Standalone Edit type
of SFM Transactions, which are Complete, are supported for scheduled exe-
cution

Only SFM Transactions that have Qualifying Criteria for the header object are eli-
gible to be scheduled

The Schedule & Notifications tab enables users to:

Select the days and times the process will run in terms of days of the week or
dates of the month

Schedule processes for multiple days and times

Set a time zone for the process

Enable status logging in Salesforce in a ServiceMax Job record

Select the configured Salesforce user that will receive the email notification mes-
sage of the scheduled process status

Scheduled SFM
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SCON Scheduler
The SCON Scheduler executes the defined schedules at hourly intervals

When the scheduler executes an SFM Transaction, it applies the configured SFM Map-
pings and Source Object Updates

There is no specific order in which Scheduled SFM Processes, SFM Transactions con-
figured in these processes, and the records that qualify for these processes are
picked up by the scheduler

If the execution fails for any record, an error is captured for that record and exe-
cution continues with the next record

After every execution of a Scheduled SFM Process, the scheduler sends an email noti-
fication to the configured Salesforce User with the following details:

Scheduled SFM Process Name & Id

A count of parent records, successes, and failures per SFM Transaction processed

Execution start and end time

Name field value and execution status of individual records are included in a text
file attached to the email

If Enable Logging is configured, all the details of the notification along with the
attachment are recorded in the ServiceMax Job record of Type Scheduled SFM

Data Model – Key Details

Object

Name

Field

Name
Remarks

ServiceMax
Job

Type Set to the value Scheduled SFM

ServiceMax
Job

Message Status log messages, including the number of SFM Transactions pro-
cessed, number of records per transaction, and execution status

ServiceMax
Job

Start
Time

Time at which scheduler started the execution of scheduled SFM Process
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Object

Name

Field

Name
Remarks

ServiceMax
Job

End
Time

Time at which scheduler completed the execution of scheduled SFM Pro-
cess

ServiceMax
Job

SVMX
Process

Lookup to the Scheduled SFM Process

Object
Name

Field
Name

Remarks

Access and Permissions

Actions User Permissions Needed

To create a pro-
cess:

“Create” on ServiceMax Processes and ServiceMax Config Data

To edit a pro-
cess:

“Update” on ServiceMax Processes, and “Create” and “Delete” on Ser-
viceMax Config Data

To delete a pro-
cess:

“Delete” on ServiceMax Processes and ServiceMax Config Data

Configuration
This feature can be fully configured using the Scheduled SFM configuration screen. There
are no other configuration options specific to this feature.

How to Configure a Scheduled SFM Process

Prerequisites

Ensure that the required SFM Transactions have qualifying criteria for the header
object

Ensure that the SCON Scheduler is available and running

Using the Scheduled SFM Configuration Screen

Follow the instructions below to create a new Scheduled SFM Process.

Scheduled SFM
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1. Launch the SeviceMax Setup Home screen.

2. Select Service Flow Manager > Scheduled SFM > Go.

3. In the Custom Scheduled SFM Processes screen, click the New button.

4. In the General Info tab, enter a unique Process Name, Process Id, and process
Description in the appropriate text boxes (see figure below).

Figure 1: General Info Tab

5. Check the Active checkbox to make the Scheduled SFM Process active. SCON Sched-
uler executes Active processes only.

6. Select one or more SFM Transactions to schedule from the Available SFM Trans-
actions multi-picklist, by clicking the required transactions. (You can use the Quick
Find feature to search for an SFM Transaction).

7. Click the right arrow to move the selected SFM Transactions to the Selected SFM
Transactions multi-picklist.
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8. Click the Schedule & Notifications tab (see figure below).

Figure 2: Schedule & Notifications Tab

9. Select the days and times to run the process in terms of days of the week or dates of
the month.

10. From the Time zone picklist, select the time zone applicable to the times selected.

11. Check the Enable logging checkbox to record details of the notification in the Ser-
viceMax Job record.

12. Specify which Salesforce user will receive the email notification message of the sched-
uled process execution status.

Manually Running a Scheduled SFM Process
Scheduled SFM Processes should automatically run on the scheduled days and times. You
can also run the processes manually by selecting a process, and then clicking the Run
Now button in the Custom Scheduled SFM Processes screen (see figure below). Only

Scheduled SFM
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processes marked Active can be run.

Figure 3: Custom Scheduled SFM Processes

Verifying the Scheduled SFM Execution Status
An email notification of the Scheduled SFM Process execution status will be sent to the con-
figured Salesforce user’s email Id. This email is sent after both automatic and manual exe-
cution. A sample screenshot of this system generated email is shown in the figure below.

Figure 4: Email Notification

The attachment to the email captures the execution status of individual records. If Enable
logging is configured, all these details are also recorded in ServiceMax Job record of Type
Scheduled SFM.

Performance Considerations
The time it takes to process a large volume of records using the Scheduled SFM Process
feature has been benchmarked with a standard SFM Transaction. The average processing
times for Scheduled SFM Processes are published below. These are based on tests
executed for up to 1000 work orders, with 5 work details for each work order. The standard
SFM Transaction Create Shipment FromWork Order (TDM007) was used for running the
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benchmarks. These benchmarks are for guidance only and actual times may vary depend-
ing on service availability.

Up to about 250 work orders, time taken to process one record is 4 to 5 seconds:

Average time taken to process 100 work orders with 500 work detail lines: 8
minutes

Average time taken to process 200 work orders with 1000 work detail lines: 15
minutes

Above 500 work orders, time taken to process one record is 3+ seconds

Average time taken to process 500 work orders with 2500 work detail lines: 24
minutes

Average time taken to process 1000 work orders with 5000 work detail lines: 54
minutes

Known Issues/Limitations
The Scheduled SFM feature does not support the following:

All UI-based features such as SFM Data Validation Rules, Lookup Form-Fill, Required-
Field check, and so on are not supported

Apex and JS web service calls are not supported

Multi-source processes and Linked SFM processes are not supported

Tips for Troubleshooting

Scenario / Issue Solution

Scheduled SFM Process is not executed auto-
matically at the scheduled time.

Ensure that the SCON Scheduler is
available and is running.

Scheduled SFM
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Scenario / Issue Solution

Some SFM Transactions are not listed for selec-
tion when configuring Scheduled SFM Process.

Check if the SFM Transactions are of

the supported type (source to target

and standalone edit).

Ensure that the SFM Transactions have

qualifying criteria for the header

object.

No email notification is received, though the
Scheduled SFM Process is executed.

Ensure that the email Id of the Sales-
force user configured to receive noti-
fications is valid and active.

ServiceMax Job record is not created capturing
the execution status of Scheduled SFM Process,
though the process is executed.

Check if Enable logging is checked in
the Scheduled SFM Process definition.

Tips for Troubleshooting 371



372



SFM DATA VALIDATION RULES

Overview
SFM Data Validation Rules is an administrative module in the ServiceMax application that
enables you to view standard SFM Data Validation Rules or to create custom SFM Data Val-
idation Rules. You can design SFM Data Validation Rules to display an error or confirmation
message when defined criteria are met. You create the defined criteria using expressions
and optional advanced expressions for target object records.

Accessing the Data Validation Rules Module

To access the Data Validation Rules module:

1. Click the Home tab.

2. Under the ServiceMax Administration area, click the ServiceMax Setup link. See fig-
ure below.

Figure 1: Home Tab and ServiceMax Setup Link 

3. Click the Service Flow Manager button, and then click the SFM Data Validation
Rules button. See figure below.
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Figure 2: Service Flow Manager and SFM Data Validation Rules Button

4. Click the Go button as shown in the image below.

SFM Data Validation Rules
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Figure 3: Go Button

Access and Permissions

Actions User Permissions Needed

To view SFM Data Val-
idation Rules:

"Read" on ServiceMax Processes, ServiceMax Config Data, Page Lay-
out, Page Layout Detail, SFM Event

To create or edit SFM
Data Validation
Rules:

"Create" and "Update" on ServiceMax Processes and ServiceMax Con-
fig Data, Read on Page Layout, Read on Page Layout Detail, SFM Event

To delete SFM Data
Validation Rules:

"Delete" on ServiceMax Processes and ServiceMax Config Data, Page
Layout, Page Layout Detail, SFM Event

SFM Data Validation Rules Window Fields
The table below provides descriptions of icons, text boxes, and text fields for the Configure
SFM Data Validation Rules Window.

Fields Description

Select
Object

Picklist menu listing available objects for you to select.

Quick Find Text box for search term.

Clear Fil-
ter icon

Removes your quick search term.

New icon Opens the Configure Data Validation Rule dialog box.

Rule Name Name of the data validation rule.

Description A detailed description of the data validation rule.

Message
Type

Displays the type of message, either Confirmation or Error.

Actions Displays the following available icons: Edit (to edit a rule), Save As (to save
your rule under a new name, and Delete (to delete a rule).

Name Text box for the rule name.
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Fields Description

SFM Trans-
action ID

The ID for the SFM Process.

Status Indicates if a transaction is completely or partially defined. The transaction status
options are either Complete or Incomplete.

Configuring an SFM Data Validation Rule
Instructions on how to configure an SFM data validation rule are listed below. For a use
case example of an SFM data validation rule, see next section titled, SFM Data Val-
idation Rule Use Case Example.

To Configure an SFM Data Validation rule:

1. In the Configure SFM Data Validation Rules window, select an object from the Select
Object picklist. Use the Quick Find text box to search for an existing rule.

2. Click New to open the Configure Data Validation Rule dialog box. See figure below.

Figure 4: Configure SFM Data Validation Rules Window

3. In the Configure Data Validation Rule dialog box, enter a name, ID, and description for
your rule in the respective text boxes (see figure below).

SFM Data Validation Rules
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Figure 5: Configure Data Validation Rule Dialog Box

4. Create defined criteria for your rule using expressions (Expressions and, if neces-
sary, Advanced Expressions). Expressions are the filtering criteria for your rule.

a. In the Expressions area, select an object from the Expressions picklist (see Fig-
ure below).Select

b. an Operator (for example, Equals, Not Equal, Greater Than, Greater or Equal).

c. From the relevant picklist, select one of the following: Field, Value, or Function.

d. Enter a value in the available text box. Depending upon the type of field, the oper-
and (value) can be specified either as free text or from a list of allowed values.

Figure 6: Expressions and Advanced Expressions Area

e. To create a new expression, click the Add a row icon (see image below). To
remove an existing expression, select the expression from the list and click
Delete. ServiceMax standard expressions cannot be deleted.

Figure 7: Add a New Expression

f. In the Advanced Expression text box, enter an advanced expression, if neces-
sary, such as 1 AND (2 OR 3). See figure below for an example of an advanced
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expression.

Figure 8: Advanced Expression Example

5. In the Message picklist, select a message type (Error or Confirmation). See figure
below.

6. In the Default Message area, enter the message that will be associated with the
rule. This is the message end users will see when the rule expression criteria are met.
See figure below for a sample message.

Figure 9: Message Type Picklist and Default Message Text Area

7. Click Save to save the expression.

The data validation rule displays in the Configure SFM Data Validation Rules window

as shown in the figure below. A icon displays in the Message Type area to rep-

resent Error messages, and a Confirmation icon displays in the Message Type
area to represent Confirmation messages.

Figure 10: Data Validation Rule Example

In the Actions column in the Data Validation Rules area you can:

SFM Data Validation Rules
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Click the Edit icon to edit your rule.

Click the Save As icon to save your rule under a new name. (Replace the name in
the Rule Name text box and click the Save button).

Click the Delete icon to delete your rule.

SFM Data Validation Rule Use Case Example
Administrators can set up data validation rules so that Confirmation and Error messages
display to the end user when defined criteria are met. An example of a data validation rule
is an error message that displays when an end user selects a Start date that is incon-
sistent with an End date.

In this scenario, the administrator selects an object (such as Work Detail), defines criteria
via expressions and advanced expressions, selects Error as a message type, and creates
a default message. The default message for this example could be: "Start Date/Time must
be before End Date/Time." If an end user enters a start date or time that is after an end
date or time, the default message would display. This example is visually illustrated in the
above section, Configuring an SFM Data Validation Rule.
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SERVER CACHE

Overview
Use this option to manage the ServiceMax Server Cache. The cache contains complete
definitions of Salesforce objects and fields used in SFM processes. The cache must be
manually refreshed using this screen whenever Salesforce object model is changed impact-
ing SFM processes.

Any changes made to the Salesforce object model must be explicitly made available to
SFM by refreshing server cache. This process is not automatic or optional. The following
changes require server cache refresh: picklist field dependencies with other picklists are
changed and picklist field dependencies with associated record types are changed. The
auto-configurator will build a server cache automatically if it is empty.

Access and Permissions

Object
Permission

Create Read Update Delete

ServiceMax Processes X

Page Layout Detail X

Object Cache X X X X

Field Cache X X X X

Picklist Cache X X X X

VF Page:

COMM_CreateServerCache

Apex Classes:

COMM_CreateServerCache

COMM_ServerCacheUtils

381



COMM_Webservices

SVMXDescribeObjectUtils

Refreshing the Server Cache
1. Click Home > Service Setup > Service Flow Manager > Server Cache to view
the Manage Server Cache screen.

Figure 1: Manage Server Cache Screen

2. Select the object you want to refresh.

3. Click the Refresh Server Cache button to refresh the objects.

A server cache message displays indicating that you must remain on the Manage
Server Cache screen until the refresh process completes.

4. Click OK to continue the server refresh process.

Server Cache
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5. Click Cancel to cancel the process.

Figure 2: Server Cache Message
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SFM WIZARD DESIGNER

Overview
Using this feature, ServiceMax administrators can assemble various Service Flow steps to
enable wizard-based guided execution of business processes. SFM wizards can be con-
figured to become available on any Salesforce record based on the business process con-
text of each record. For example, all the steps related to Preventive Maintenance business
process can be represented as a wizard on Work Order object and can be made available
only for PMWork Orders. Multiple wizards can be configured for each object. In addition to
enabling/disabling a wizard, specific steps within the wizard can be allowed or disallowed
based on the state of the record. For example, users can be allowed to perform the Close
Work Order step only if the Work Order is open.

Access and Permissions

Actions User Permissions Needed

To view SFM Wizard : "Read" on ServiceMax Processes, ServiceMax Config Data

To create or edit SFM Wiz-
ard :

"Create" and "Update" on ServiceMax Processes and ServiceMax
Config Data

To delete SFM Wizard : "Delete" on ServiceMax Processes and ServiceMax Config Data

SFM Wizard Designer Fields

Fields Description

Object Name of the object. For Example: Installed product, Case.

Wizard Title Name of the Wizard.

Wizard ID Unique identification of the Wizard.

Description Detailed description of the SFM Wizard.
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Fields Description

Criteria To show
Wizard

The qualification criteria i.e. the SFM Wizard will be shown only if it qual-
ifies the criteria defined.

Is Active Checkbox indicates the wizard is active and available for use.

Sequence The sequence number is auto populated, however it can be changed using
sequence button.

Wizard Step The Service Flow Wizard Step.

Title Name of the Wizard Step.

Description for
step

Detailed description of the Wizard Step.

Criteria To
Enable SFW
Action

The qualification criteria i.e. the SFM custom action defined for the wizard
will be enabled only if it qualifies the criteria defined.

Steps In Creating a Wizard
1. Click Home > Service Setup > Service Flow Manager > SFM Wizards to view
the SFMWizard screen. The list under the Standard SFMWizards shows the standard
preconfigured wizards of ServiceMax. Any Custom SFM wizards are displayed under

SFM Wizard Designer

386 Steps In Creating a Wizard



SFM Wizard Designer

the Custom SFM wizards section.

Figure 1: Manage Service Flow Wizards

2. In the SFMWizard Screen:

To create a custom wizard from a standard wizard, select the standard service wiz-
ard and click the Clone button.

To create a custom wizard, click the New button at the top of the custom SFM wiz-
ards section.

To create a custom wizard from another custom wizard, select the custom wizard
and click the Clone button.

To delete a custom wizard, select the custom wizard and click the Delete button.

Steps In Creating a Wizard 387



Caution: Use Extreme Caution when deleting wizards since the effect is
immediate and irreversible.

Creating/Editing Wizards

To Create or Edit Wizards:

1. In the SFMWizard screen, click the New button or select an existing custom wizard,
and click the Edit button at the top. The Edit SFMWizard dialog box displays as shown
in the figure below.

Figure 2: SFMWizard - General Information Screen

2.  In the above screen, the SFMWizard has three tabs. Click the General Information
tab.

SFM Wizard Designer
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3. Select the object you want to use to create a Wizard. The list shows only those
objects for which SFM Transactions, SFM Custom Action, or Inventory processes are
available.

4. Enter a user-friendly title for the wizard. Generally, the wizard title represents the
business process (for example, Paid Repair orWarranty Service).

5. Enter a unique and user-friendly Expression Name. For example,Open Work
Orders.

6. Enter a service wizard description.

7. From the list of available criteria, select the applicable criteria. The wizard will be dis-
played only if the record meets the selected criteria. You can modify the criteria by
clicking Edit Criteria. Since criteria can also be re-used by other wizards, use
extreme caution when modifying existing criteria.

8. Check Is Active to make the wizard available to use.

9. Enter unique Expression Name and ID. Using the combination of Field Name,
Operator, and Operand enter the criteria for each rule. Ensure the criteria is exclus-
ive between each rule.

10. Use the buttons marked with x and + to remove and add conditions respectively.

11. If required use the Advanced Expression to enter conditions such as (1 AND 2) OR
3.

12. Click the Manage Wizard Steps tab (see figure below). The screen below is used to
define one or more steps for the wizard.
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Figure 3: SFMWizard - ManageWizard Steps

13. Click New to add a new wizard step. The new step is added at the end of the wizard.
You can rearrange the wizard steps by using the Sequence button.

14. For each wizard step, select the applicable action from the list. This list shows all the
SFM transactions, Inventory processes, and SFM Custom actions defined for this
object. The Action Title and Description is automatically populated. You can overwrite
the same if required. The title and description entered here is displayed in the SFM
Wizard on the record.

15. From the list of available criteria, select the applicable criteria for the step. The wizard
step will be enabled only if the record meets the selected criteria. You can modify the
criteria by clicking Edit Criteria. Since criteria can be reused by other wizards or wiz-
ard steps, use extreme caution when modifying existing criteria. 

16. Enable the Mode Of Execution by selecting an SFM from theWizard Step picklist.

17. The Mode of Execution is only enabled if you select an SFM from theWizard Step
Type picklist.

18. The following SFM transactions are available for Mode of Execution: from Source
Object to create new header and child records and as Standalone for the pur-
pose of creating a new record.

SFM Wizard Designer
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19. Select a Mode Of Execution. Two options are available, Interactive and Back-
ground. The default option is Interactive.

20. Background mode performs SFM transactions without displaying the intermediate
SFM page. Interactive mode displays the SFM page allowing users to make changes to
the record.

In this release, only SFM transactions that create new target Objects from a source
Object can run in Background mode.

Handover is available for SFM transactions. When Handover is enabled, the defined
SFM process step in the SFMWizard begins execution. Upon successful completion of
the process step, the next process step in the sequence will be seamlessly initiated.
See figure above.

21. If applicable, check the Handover checkbox.

You can create a custom confirmation message that prompts users to confirm an SFM
action step before it is executed. Select this feature by checking the Confirm on
Launch checkbox, and enter a custommessage in the Confirmation Message text
box.

The default question, "Are you sure?" displays after you check the Confirm on
Launch checkbox. However, you can customize the message to any custommes-
sage of your choosing.

 If you check the Confirm on Launch checkbox, you must create a custom con-
firmation message or use the default question, "Are you sure?"

The custommessage you create will display each time an end user performs an
SFM action step.

22.  Click Quick Save. 
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23. Click Sequence to define the sequence in which the steps appear on the SFMWizard.

Figure 4: SFMWizard - Sequence Screen

24. Click Save Sequence to save the new sequence.

25. Click Cancel to discard the changes made and return back to the Manage Wizard
Steps screen.

Note: In this release, only SFM transactions can initiate Handover.

26. Click the Manage Permissions tab, the screen as shown below appears. Use this
screen to select the ServiceMax user profiles that need access to this wizard. If no pro-
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files are selected, all user profiles will have access to the wizard by default.

Figure 5: SFMWizard - Manage Permissions

27. To give permissions to one or more profiles, you can move the applicable profiles from
left to right.

28. Alternatively, you can copy permissions from other wizards by choosing the wizard
name from the list at the bottom.

29. Anytime during the wizard creation process, you can click the Quick Save button at
the top to save the service wizard even if it is incomplete and continue to edit the wiz-
ard.

30. To save the SFM transaction and return to the ServiceMax Setup home page, click the
Save & Close button at the top.

31. To cancel any changes made to wizard and return to SFMWizard screen, click the
Cancelbutton at the top.

Deleting Wizards

To delete an SFM Wizard:

1. Select the name of the custom SFM wizard at the bottom.

2. Click Delete.
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Note: Standard SFMWizards and Criteria of ServiceMax cannot be modified
or deleted. However, standard wizards can be deactivated. You can also adjust
profile permissions of standard wizards.

Setting Up Wizard Layout

To configure how all SFM wizards of an object appear on the record

layout in relation to each other:

1. Click the Layout Configuration button.

Figure 6: SFMWizard - Layout Configuration Screen

2. Select the object for which you want to configure the wizard layout. All the available
wizards are displayed in a two-column format.

3. Select the display size of the wizard. To avoid scrolling, decrease the display size if
the number of wizards and steps are more.

4. You can configure the wizard layout by choosing the applicable wizard in each row and
column. You can select any wizard only once in a layout. To leave a cell blank, select
None. Click the + button to insert a new row. Blank rows will be ignored when saving
the wizard layout.

SFM Wizard Designer
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5. Once you have configured the layout, you can preview the layout by clicking the Pre-
view button at the top. A sample preview screen is shown below.

Figure 7: SFMWizard : Preview Layout Configuration

6. At anytime during the layout configuration process, you can click the Quick Save but-
ton at the top to save the layout, even if it is incomplete and continue to edit the lay-
out.

7. To save the layout and return back to the SFM wizard screen click the Save & Close
button at the top.

8. To cancel any changes made to the layout and return to SFM wizard screen, click the
Cancel button.

9. Click Back to Setup Home to return back to the ServiceMax Setup home.
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SFM MAPPING

Overview
SFM Mapping is a ServiceMax Suite configuration module for administrators. SFMmap-
pings include field mappings between source and target object records and value map-
pings for target object records. You can use SFM Mapping to view standard SFMmappings
or to create custom SFMmappings.

Note: Use the SFM Mapping module to create your maps (source objects).
Use the Screen Designer from the SFM Transaction Designer and Docs
Designer module to define the page layout.

Access and Permissions

Actions User Permissions Needed

To view SFM
Mapping:

"Read" on ServiceMax Processes, ServiceMax Config Data, Page Layout,
Page Layout Detail, SFM Event

To create or edit
SFM Mapping:

"Create" and "Update" on ServiceMax Processes and ServiceMax Config
Data, Read on Page Layout, Read on Page Layout Detail, SFM Event

To delete SFM
Mapping:

"Delete" on ServiceMax Processes and ServiceMax Config Data, Page Layout,
Page Layout Detail, SFM Event

SFM Mapping Screen Fields and Icons
The table below provides a description of text fields and icons associated with the SFM
Mapping Screen/Window.
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SFM Mapping Fields and Icons

Fields and Icons Description

Select Source Object Picklist of available source objects.

Select Target Object Picklist of available target objects.

Back To Setup Home Clicking this icon returns you to the Setup Home screen.

Save Saves a map.

Save As Saves a map under a new name.

New Creates a new map.

Delete Deletes a map.

Quick Find A text field for conducting a search of an existing map.

Value An area.

Using an Existing Map A picklist of available existing maps.

Save this map as A text field to type the name you would like to save your map as.

Input ID Here A text field for your map's ID.

SFM Mapping Module
Use this module to view standard SFMmappings or to create custom SFMmappings. In
addition, to use the Lookup Form Fill feature you can define your maps in this module and
access them from the Lookup Form Fill Object Mapping picklist from the SFM Trans-
action Designer. Instructions on how to access the SFM Mapping module are listed below.

To access the SFM Mapping module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Service Flow Manager button.

3. Click the SFM Mapping button.

4. Click the Go button.

SFM Mapping
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The Configure SFM Mappings screen displays as shown in the figure below.

Figure 1: Configure SFM Mappings Screen

Managing Field Maps
Follow the steps below to configure SFM Mapping for field maps.

To configure a new field map:

1. In the Source Object picklist, select an available source object (for example, Case)
as shown in the figure below.

Figure 2: Source Object Picklist

2. In the Target Object picklist, select an available target object. The Configure SFM
Mapping screen displays the Field Map for Existing Records tab.
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Figure 3:  Field Map For Existing Records Tab

3. In the Field Map for Existing Records area, click New to create a new map. The
Field Map for Existing Records area populates with available fields.

SFM Mapping
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Figure 4: Field Map For Existing Records Tab (populated)

4. Select a value for a map field. (For example, Case is a map field and Case ID is its
value). There are two options for choosing values:

a. Option 1: Click if not already visible and select an option from the Value pick-
list.
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b. Option 2: Click if not already visible and enter a value in the Value text field.

Figure 5: Configure SFM MappingWindow

Note: Some values will have an additional mapping feature associated

with it. Those values have a next to it.

5. If you want to select additional mapping for a value, click to open the Alternate
Mapping dialog box. Select an item from the Option 1 or Option 2 picklist as show in
the figure below. Click Done after you have made your selection. Note: If you assign

SFM Mapping
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a value as null, you can use the alternate mapping.

Figure 6: Alternate Mapping Dialog Box

6. In the Save this map as text box, enter a name for your map (for example,
SVMXSTD: Case To Work Order).

7. In the Input ID Here text box, enter an ID for your map (for example, MAP015).
Note: The Map ID should be 8 characters long.

8. Click Save to save the map.

Note: If you have an existing map, you can select one from the Use an
existing map picklist as shown in the figure below. Click Save As to
save the map under a new name.

Figure 7: Use An Existing Map Picklist

9. If you need to reset or delete a map, click the Reset or Delete icons.
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Managing Value Maps
Follow the steps below to configure a new value map.

To configure a new value map:

1. In the Source Object picklist, select None as shown in the figure below.

2. In the Target Object picklist, select an available target object.

Figure 8: Configure SFM Mapping (Target Object)

3. Click the New icon.

The Configure SFM Mapping screen updates with the Value Map for New Records tab
area.

4. In the Value Map for New Records area, click New to create a new map. The Field
Map for Existing Records area populates as shown in the figure below.

SFM Mapping
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Figure 9: Value Map For New Records Tab (Populated)

5. Select an object from the available list that you want to map from.

6. Enter a value in the Value text field. There are three options for populating the Value
text field.

Option 1: Select an option from the Value picklist. See figure below. (If neces-

sary, click and then select an option from the picklist).

Figure 10: Value Picklist
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Option 2: Click and enter a value in the Value text field.

Option 3: Click to open the search dialog box. Enter a value, click , and then
click Select. You can also use the scroll bar to search for a value. See figure below.

Figure 11: Search Dialog Box

See Figure 5 below for an example of the Value Map For New Records tab area pop-
ulated with a value.

Figure 12: Value Map For New Records Tab (Example)

7. In the Save this map as text field, enter the name you want to use to save the map.

8. In the Input ID Here text field, enter an ID for the map.
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Note: If you have an existing map, you can select one from the Use an exist-
ing map picklist. Click Save As to save the map under a new name.

9. Click Save to save the map.

10. To reset or delete the map, click Reset or Delete .

11. Click Save As to save an existing map under a new name.

See Also:

SFM Transaction Designer (Lookup Form Fill section)

Lookup Form Fill Use Case
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SFM EXPRESSIONS

Overview
Use this option to view standard SFM expressions or to create custom SFM expressions.
SFM expressions include the criteria for filtering and advanced expression for the filter cri-
teria.

Access and Permissions

Actions User Permissions Needed

To view SFM
Expressions:

"Read" on ServiceMax Processes, ServiceMax Config Data, Page Layout,
Page Layout Detail, SFM Event

To create or edit
SFM Expressions:

"Create" and "Update" on ServiceMax Processes and ServiceMax Config
Data, Read on Page Layout, Read on Page Layout Detail, SFM Event

To delete SFM
Expressions:

"Delete" on ServiceMax Processes and ServiceMax Config Data, Page Lay-
out, Page Layout Detail, SFM Event

Click Home > ServiceMax Setup > Service Flow Manager > SFM Expressions to
view the Configure Expressions screen as shown in the figure below.

Figure 1: Configure Expressions Screen
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Configuring a new SFM Expression

To configure a new SFM Expression (see figure below):

1. In the Select Object picklist, select an object.

2. In the Manage Expressions area, select and option from the Select expression pick-
list.

3. Enter a expression name in the Save expression as text box.

4. Enter the Input ID in the Input ID Here text box.

5. Create and expression:

a. Click the New icon to create a new row.

b. In the Select picklist, select an object.

c. Select an operator in the Operator picklist.

d. Select a value in the value picklist. (You can also click the icon located next to the
picklist to select a field from the list).

e. If necessary, click the New button to create another row.

f. In the Advanced Expression text box, enter an advanced expression (fore
example, 1 and 2).

6. Click the Save icon to the save the expression.

7. Click the Save as icon to save new expressions with new Input IDs. (Use the Save
icon to save existing expressions. Use the Save as icon for new expressions).

8. To reset the expression, click the Reset icon.

9. If you need to delete the expression, click the Delete icon.

SFM Expressions
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10. Click the Back to Setup Home button to return to the Setup Home page.

Figure 2: Configure Expressions (Expression Builder) Screen

Configuring a new SFM Expression 411



412



SFM MIGRATOR

Overview
This feature allows ServiceMax administrators to migrate new or modified SFM trans-
actions from the current instance (production or sandbox org) to any target (production)
instance. All dependent setup within an SFM transaction such as Object mappings, page
layouts and expressions are also automatically migrated.

Access and Permissions

Actions User Permissions Needed

To migrate SFM
Transactions:

"Create" and "Update" on ServiceMax Processes and ServiceMax Config
Data, Page Layout, Page Layout Detail, SFM Event

SFM Migrator fields

Fields Description

Username Name of target org

Password Password for the target org, with security token if applicable

SFM transaction ID Unique ID of the SFM transaction

Name Name of an SFM transaction

Last Modified date Last modified date of the transaction

Deployment Status  Status of migration of a transaction

Steps for Deploying
Click Home > ServiceMax Setup > Service Flow Manager > SFM Migrator. The
screen as shown below appears.
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Figure 1:  SFM Migrator - Home Screen

In the SFM Migrator home screen:

1. Enter the user name of the target org. The target cannot be a Sandbox instance.

2. Enter the password, with security token if applicable.

3. To clear and reenter the user name and password, click Reset.

4. Click Next to login to the target org and proceed with migration.

5. To return to the setup home page, click Back To Setup Home.

6. In order for the migration to be successful, ServiceMax versions in the source and tar-
get orgs must be compatible. If the target instance runs an earlier version of Ser-
viceMax than the source (current) instance, an error is displayed as shown below. The
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target instance must be upgraded to avoid this error.

Figure 2: SFM Migrator - Validation Screen

After a successful login and compatibility check, the following is screen appears. This
screen shows the list of all available SFM transactions in the source instance.

Figure 3: SFM Migrator - Available Service Flows Screen

7. The list is sorted by SFM transaction ID by default. Click any column title to apply a
new sorting. To switch the sorting order of the currently sorted column, click the
column title again.
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8. To select or unselect all SFM transactions, check/uncheck the checkbox at the top-
left of the list. You can also select specific SFM transactions by checking the checkbox
in each row.

9. Once you have selected the SFM transactions to be migrated, click Deploy to start
the migration.

10. Each SFM transaction will be validated for suitability of migration. This is to ensure
that the migrated transactions can run successfully in the target instance. The pro-
gress of migration is indicated in each row as shown below.

Figure 4: SFM Migrator - Deployment Status Screen

11. If the migration resulted in any errors, the affected transactions will be highlighted in
red. Click the log button in the row to see the error details. Once you have resolved
the errors, you can attempt to migrate the transactions again.

12. You can also view the log of all the migrations, successful or otherwise, by clicking the
log button at the top right.

13. The Log appears in a popup screen. See the Deployment Log section below for more
details.

14. To return to the login screen, click Start Over.

SFM Migrator
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15. To return to ServiceMax setup page, click Back to Setup Home.

Figure 5:  SFM Migrator - Deployment Status Screen

Deployment Log
1. The log screen (shown below) displays status and errors encountered when migrating

SFM transactions.

Figure 6: SFM Migrator - Debug Console

2. To locate log information for a specific SFM transaction, select the transaction name
from the SFM Transaction picklist.

3. Select the level of details you want to see by using the Log Level picklist.
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All: Displays all log messages.

Error: Displays errors only.

Info: Displays errors and progress of each major step in migration.

Fine: Displays errors and fine-grained messages most helpful in debugging.

SFM Migrator
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SFM SEARCH

Overview
Use this option to view standard SFM search configurations or to create custom SFM
search configurations. SFM Search configurations include the objects in scope, the fields to
be searched upon, prefilter conditions and how the results are displayed.

SFM Search Module

To access the SFM Search module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Service Flow Manager button.

3. Click the SFM Search button.

4. Click the Go button.

The Standard and Custom Searches screen displays as shown in the figure below.

Figure 1: Standard and Custom Searches Screen

Standard Searches
As shown in Figure 1, in the Standard Searches area, you can:
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View a standard search.

Clone a standard search.

Manage profile access permissions.

Return to the Setup Home screen.

Custom Searches
As shown in Figure 1, in the Custom Searches area, you can:

Create a new custom search.

Edit a custom search.

Clone a custom search.

Manage profile access permissions.

Delete a custom search.

Return to the Setup Home screen.

Creating a New Custom Search

To create a new custom search:

1. In the Custom Searches area, click the New button.

Figure 2: Configure Search

2. Enter the Search Title and Search ID in their respective text boxes.

SFM Search
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3. Add a description in the Description text box if necessary.

4. Click either the Search Configuration tab or the Search Configuration button loc-
ated at the bottom right corner of the screen.

5. Click the New button to add one or more objects to be included in the search.

6. In the Search Object picklist, select an object to be included in the search.

7. Enter a description for the object in the Description text box.

8. As an optional step, use the expression builder to define filter criteria, which will be
applied to the object's records (see figure below0.

a. In the Field picklist, select a field.

b. Select an operator from the Operator picklist.

c. Enter a value in the Value text box.

d. Use the and buttons to add or delete filter criteria.

e. Use the Advanced Expression text box if necessary.

Figure 3: Optional Expression Builder

9. Select one or more fields to display in the search result using the Expression Builder.

10. Select an object from the Search Object picklist and a field name from the Field
Name picklist (see figure below).

Figure 4: Select one or more objects and fields for search
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11. Select fields for sorting (see figure below).

Figure 5: Select fields for sorting

In the Search Object area, select an object.

In the Field Name area, select a field from the Field Name picklist.

Indicate the search order (Descending or Ascending).

Click the Save button to save the search.

Editing a Custom Search

To edit a custom search:

1. Select a custom search by checking the Select checkbox for the appropriate search
name.

2. In the Custom Searches area, click the Edit button.

3. In the General Info area, update the following if necessary, Search Title, Search ID,
and Description.

4. Click either the Search Configuration tab or the Search Configuration button loc-
ated at the bottom right corner of the screen.

5. In the Search Configuration area, use the Expression Builder to include one or more
objects to be included in the scope of this search.

a. In the Search Object pick list, select an object.

b. Enter a title in the Results Section Title text box.

c. If required, enter a description in the Description text box.

6. Click the Field Display Sequence button to change the sequence of the of the fields.
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7. Use the up and down arrows to change the sequence of the fields.

8. Click the Save button to save your updates.

Clone a Custom Search

To clone a custom search:

1. Select a custom search by checking the Select checkbox for the appropriate search
name.

2. In the Custom Searches area, click the Clone button.

3. In the General Info area, change the following: Search Title, Search ID, and
Description.

4. Click either the Search Configuration tab or the Search Configuration button loc-
ated at the bottom right corner of the screen.

5. In the Search Configuration area, use the Expression Builder to make changes to the
Search Object, Results Section Title, and Description.

a. In the Search Object picklist, select an object.

b. Select a title in the Results Section Title text box.

c. If required, enter a description in the Description text box.

6. Click the Field Display Sequence button to change the sequence of the fields.

7. Use the up and down arrows to change the sequence of the fields.

8. Click the Save button to save your updates.

Manage Profile Access Permissions

To manage profile access permissions:

1. In the Custom Searches area, click the Manage Permissions button.

2. From the Select Service Max Profile picklist, select a profile.

3. Use the left and right arrows to move objects from the Available Searches area to
the Selected Searches area.
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4. Click the Quick Save button to save the profile permission and remain in the Profile
Access To Search Configuration screen.

5. Click the Save & Close button to save the profile permission and return to the Stand-
ard and Custom Searches screen.
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SERVICE CONTRACT PROFORMA PROCESS

Overview
Use this option to configure proforma invoice processes for Service Contracts. You can
indicate how Service Contracts are consolidated into an invoice, the type of lines to
include, and more. You can also setup the process to run automatically on a schedule.

Access and Permissions

Actions User Permissions Needed

To view Service Contract Proforma
Invoice Process:

"Read" on ServiceMax Processes, ServiceMax Config
Data, Service/Maintenance Contract

To create or edit Service Contract
Proforma Invoice Process:

"Create" and "Update" on ServiceMax Processes and
ServiceMax Config Data

To delete Service Contract Proforma
Invoice Process:

"Delete" on ServiceMax Processes and ServiceMax
Config Data

Value Map for Proforma Invoice

Service Contract Performa Invoice

CurrencyIsoCode CurrencyIsoCode

Account Account

Account - Billing address Billing Address

Field Map for Proforma Invoice Detail

Service Contract Performa Invoice Detail

ID  Service Contract

CurrencyIsoCode CurrencyIsoCode
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Proforma Invoice Lines (Covered Products)

Covered Products
Proforma Invoice Line (Line Type =

Covered Products)

ID Covered Product

Service Contract Service Contract

CurrencyIsoCode CurrencyIsoCode

Product Product

Installed Product Installed Product

Line Price (If Is Billable field of Covered
Product is true)

 Price (If Is Billable field of Covered Product is
true then)

Line Price (If Is Billable field of Covered
Product is true)

Total Line Price (If Is Billable field of Covered
Product is true)

Note: Else Price and Total Line Price of Proforma Invoice Line is set to 0
(zero).

Proforma Invoice Lines (Service Contract Sites)

Covered Products
Proforma Invoice Line (Line Type =

Covered Products)

ID Covered Locations

Service Contract Service Contract

CurrencyIsoCode CurrencyIsoCode

Location Location

Notes Line Notes

Line Price (If Is Billable field of Covered
Location is true)

 Price (If Is Billable field of Covered Location is
true then)

Line Price (If Is Billable field of Covered
Location is true)

Total Line Price (If Is Billable field of Covered
Location is true)

Service Contract Proforma Process
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Note: Else Price and Total Line Price of Proforma Invoice Line is set to 0
(zero).

Proforma Invoice Lines (Line Type= Included Services)

Covered Products
Proforma Invoice Line (Line Type =

Covered Products)

ID Included Services

Service Contract Service Contract

CurrencyIsoCode CurrencyIsoCode

Notes Line Notes

Line Price (If Is Billable field of Included Ser-
vices is true)

 Price (If Is Billable field of Included Services is
true then)

Line Price (If Is Billable field of Included Ser-
vices is true)

Total Line Price (If Is Billable field of Included
Services is true)

Note: Else Price and Total Line Price of Proforma Invoice Line is set to 0
(zero).

Proforma Invoice Line (PM Offering)

Covered Products
Proforma Invoice Line (Line Type =

Covered Products)

Service Contract Service Contract

Line Price (If Is Billable field of Included Ser-
vices is true)

 Price (If Is Billable field of Included Services is
true then)

Line Price (If Is Billable field of Included Ser-
vices is true)

Total Line Price (If Is Billable field of Included
Services is true)
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Note: Else Price and Total Line Price of Proforma Invoice Line is set to 0
(zero).

Service Contract Proforma Processes Screen
Click Home > ServiceMax Setup > Service Contracts > Service Contract Pro-
forma Process. The Standard and Custom Service Contract Proforma Processes Screen
displays. See figure below.

Note: Scheduler has limitations when creating invoices (fromWork Order-
/Service Contract) for dates between the 28th to the 1st of a month.

Figure 1:  Standard and Custom Service Contract Performa Invoice Processes Screen

In the Standard Service Contract Proforma Processes screen:

To view a standard service contract Proforma invoice process, select a process and
click the View button.

To clone a standard process, select a process and click the Clone button. Edit the
available fields, text boxes, and picklists in the Setup Service Contract Proforma Pro-
cess screen.

To return to the Setup Home page, click the Back To Setup Home button.

In the Custom Service Contract Proforma Invoice Processes screen:

Service Contract Proforma Process
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Click the New button to create a new custom process.

Click the Edit button to edit a custom process.

Click the Clone button to clone a process.

To delete a process, click the Delete button.

Creating/Editing a Custom Service Contract Proforma
Invoice Process

To create a custom service contract Proforma invoice process:

1. Click the New button in the Custom Service Contract Proforma Invoice Processes
screen to create a new process, or select a process and click the Edit button to edit
an existing process. See figure below.

Figure 2: Setup Service Contract Proforma Invoice Process

2. In the General Info Tab:

a. Enter the Process Name.

b. Enter the Process ID.

c. Enter the Description.

d. Check the Active checkbox to make the process active.

Creating/Editing a Custom Service Contract Proforma Invoice Process 429



Note: If you do not check the Active checkbox, the process will not be
activated. Therefore, when the end user clicks the Generate Invoice but-
ton in the SFW, an error message displays indicating that the Proforma
Invoice Process is inactive.

3. If necessary, use the expression builder to indicate how the Service Contracts qualify
for the process. See figure below. Select one of the following options:

a. Select existing criteria from the picklist.

i. Click the View/Edit link to view or edit the existing criteria.

ii. Make any necessary changes.

b. Click the Create New link to create new criteria for the process.

Figure 3: Service Contract Expression Builder

4. Click the Invoice Rules tab.

5. In the Invoice Rules tab in the Service Contracts Consolidation rules area, define
the following Service Contracts Consolidation Rules by making a selection from the fol-
lowing picklists (see figure below):

a. Determine what the consolidation is based on (for example, Service Main-
tenance/Contract, Account).

b. Determine what to use for the primary grouping of proforma invoice.

Service Contract Proforma Process
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c. Determine what to use for the secondary grouping of proforma invoice.

Figure 4: Service Contract Consolidation Rules

6. In the Mapping & Rules to Create Proforma Invoice area:

a. If applicable, check the non-billable Service Contracts lines checkbox.

b. Select an option from the Use this value-map to create Proforma Invoice
picklist.

c. Select an option from the Use the field-map to create Proforma Invoice
Details from Service Contract picklist.

Figure 5: Mapping & Rules to Create Proforma Invoice

7. Click the Source Updates tab.

8. In the Automatic field updates to Service Contract when proforma invoice is created
area:

a. Select the field name in the Field Name picklist.

b. Select an operator from the Operator picklist.

c. Enter a value in the Value text box.

d. Click the +/- buttons to add or delete rows.

Figure 6: Automatic field updates
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9. Click the Schedule & Notification tab (see figure below).

10. In the Select the times and days to run this process area:

a. Select the time in the Run At (GMT) picklist.

b. Select the day in the On These Days picklist.

c. In the Available panel, select an available day and using the appropriate arrow,
move the day to the Select panel. (Use the arrows to move the days from left and
right between the Available and Chosen panels.

d. Use the +/- buttons to add or delete.

11. In the Specify recipients of notification and alerts area:

a. Enter the email address for receiving success notifications.

b. Enter the email address for receiving error notifications.

c. If applicable, check the Enable Logging checkbox.

Figure 7:  Schedule & Notification Tab

12. Click the Quick Save button to save the process and remain in the current tab.

13. Click the Save & Close button to save the process and return to the Stand-
ard/Custom Service Contract Invoice Process screen.

14. Click the Cancel button to cancel the process.
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Cloning a Custom Service Contract Proforma Invoice Pro-
cess

To clone a custom Service Contract proforma invoice process:

1. Select a process to clone, and click the Clone button.

2. In the General Info screen, update any of the text boxes.

Note: When cloning a custom service contract Proforma invoice process, you
must change the name of the Process ID. The Process ID must be unique.

3. Click the Invoice Rules Tab.

4. In the Service Contract Consolidation Rules area, select an option from the Con-
solidate based on picklist.

5. In the Mapping & Rules to Create Proforma Invoice area, update the picklists and/or
checkbox if necessary.

6. Click the Source Update tab.

7. If necessary, update the Automatic field updates to Service Contract when pro-
forma invoice is created area.

8. Click the Schedule & Notification tab.

9. Make any changes to the times and days to run the process in the Run At (GMT) and
On These Days areas.

10. If necessary edit the recipients for the notifications and alerts in the Specify recip-
ients of notification and alerts area.

11. Click the Quick Save button to save the process.

12. Click the Save & Close button to save the process and return to the Standard and
Custom Service Contract Proforma Invoice Processes screen.

13. Click the Cancel button to cancel the process.
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Deleting a Custom Service Contract Proforma Invoice Pro-
cess

To delete a custom Service Contract process:

1. Select a process to delete from the Select Process area.

2. Click the Delete button.

3. In the Message from webpage dialog box, click OK to answer the question Are you
sure?

Service Contract Proforma Process
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WORK ORDER PROFORMA INVOICE PROCESS

Overview
Use this option to configure proforma invoice processes for Work Orders. You can indicate
how Work Orders are consolidated into an invoice, the type of Work Order lines to include,
and more. You can also setup the process to run automatically on a schedule.

Access and Permissions

Actions User Permissions Needed

To view Work Order Proforma
Invoice Process:

"Read" on ServiceMax Processes, ServiceMax Config
Data, Work Order

To create or edit Work Order Pro-
forma Invoice Process:

"Create" and "Update" on ServiceMax Processes and
ServiceMax Config Data

To delete Work Order Proforma
Invoice Process:

"Delete" on ServiceMax Processes and ServiceMax
Config Data

Value Map for Proforma Invoice

Work Order Proforma Invoice

CurrencyIsoCode CurrencyIsoCode

Account Account

Account - Billing address Billing Address

Field Map for Proforma Invoice Detail

Work Order Proforma Invoice Detail

ID Work Order
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Work Order Proforma Invoice Detail

CurrencyIsoCode CurrencyIsoCode

Proforma Invoice Amount Total Amount

Proforma Invoice Lines

Work Detail Proforma Invoice Lines

Work Order Proforma Invoice Detail

ID Work Order

CurrencyIsoCode CurrencyIsoCode

Proforma Invoice Amount Total Amount

Work Order Proforma Invoice Detail

ID Work Order

CurrencyIsoCode CurrencyIsoCode

Proforma Invoice Amount Total Amount

Work Order Proforma Invoice Detail

ID Work Order

CurrencyIsoCode CurrencyIsoCode

Proforma Invoice Amount Total Amount

Work Order Proforma Invoice Detail

ID Work Order

Work Order Proforma Invoice Processes Screen
Click Home > ServiceMax Setup > Service Contracts > Work Order Billing Pro-
cess to use this option to configure proforma invoice processes for Work Orders. You can
indicate how service contracts are consolidated into an invoice, the type of Work Order
lines to include and more. You can also setup the process to run automatically on a sched-
ule.

Work Order Proforma Invoice Process
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Work Order Proforma Invoice Process

Note: Scheduler has limitations when creating invoices (fromWork Order-
/Service Contract) for dates between the 28th to the 1st of a month.

The steps to create Work Order billing invoice processes in this section represent the
BatchpProcess. For the Work Order Interactive billing process, select Generate Invoice
from the SFW tool bar. For more information about the Interactive billing process, see the
Creating/Editing Wizards section in the Advanced Configuration: SFM Wizard
Designer.

Figure 1: Standard/Custom Work Order Performa Invoice

In the standard Work Order Proforma Invoice Processes screen:

To view a standard Work Order Proforma invoice process, select a process and click
the View button.

To clone a standard Work Order process, select a process and click the Clone but-
ton. Edit the available fields, text boxes, and picklists in the Setup Work Order Pro-
forma Process screen.

To return to the Setup Home page, click the Back To Setup Home button.

In the customWork Order Proforma Invoices processes screen:

Click the New button to create a new custom Proforma invoice process. Click the Edit but-
ton to edit a Proforma Invoice Process. Click the Clone button to clone a Proforma Invoice
Process. Click the Delete button to delete a Proforma Invoice Process.
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Creating/Editing a Custom Work Order Proforma Invoice
Process

To create a custom service contract Proforma invoice process:

1. Click the New button in the CustomWork Order Proforma Invoice Processes screen,
or select a process and click the Edit button to edit an existing process. See figure
below.

Figure 2: SetupWork Order Proforma Invoice Process

2. In the General Info Tab:

a. Enter the Process Name.

b. Enter the Process ID.

c. Enter the Description.

d. Check the Active checkbox to make the process active.

Note: If you do not check the Active checkbox, the process will not be
activated. Therefore, when the end user clicks the Generate Invoice but-
ton in the SFW, an error message displays indicating that the Proforma
Invoice Process is inactive.

Work Order Proforma Invoice Process
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Work Order Proforma Invoice Process

3. If necessary, use the expression builder to indicate how Work Orders qualify for the
process. See figure above. Select one of the following options:

a. Select existing criteria from the picklist.

b. If applicable, click the View/Edit link to view or edit the existing criteria. Make
any necessary changes.

c. If applicable, click the Create New link to create new criteria for the process.

4. Click the Invoice Rules tab.

5. In theWork Order Consolidation Rules area (see figure below):

a. Determine what the consolidation is based on (for example, Work Order,
Account).

b. Determine what to use for the primary grouping of proforma invoice.

c. Determine what to use for the secondary grouping of proforma invoice.

Figure 3:Work Order Consolidation Rules area

6. In the Mapping & Rules to Create Proforma Invoice area (see figure below):

a. Check the Include non-billable Work Detail lines checkbox.

b. Select a value map from the Use this value-map to create Proforma Invoice
picklist.

c. Select a field map from the Use the field-map to create Proforma Invoice
Details from Work Order picklist.

Figure 4: Mapping & Rules to Create Proforma Invoice
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7. Click the Source Updates tab (see figure below).

8. In the Automatic field updates to Work Order when proforma invoice is cre-
ated area:

a. Select the field name in the Field Name picklist.

b. Select an operator from the Operator picklist.

c. Select a value in the Value text box.

d. Click the +/- buttons to add or delete rows.

Figure 5: Automatic Field Updates toWork Order

9. Click the Schedule & Notification tab (see figure below).

10. In the Select the times and days to run this process area:

a. Select the time in the Run At (GMT) picklist.

b. Select the day in the On These Days picklist.

c. In the Available panel, select an available day and using the appropriate arrow,
move the day to the Select panel. (Use the arrows to move the days from left and
right between the Available and Chosen panels.

d. Use the +/- buttons to add or delete

11. In the Specify recipients of notification and alerts area:

a. Enter the email address for receiving success notifications.

b. Enter the email address for receiving error notifications.

Work Order Proforma Invoice Process
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Work Order Proforma Invoice Process

c. If applicable, check the Enable Logging checkbox.

Figure 6: Schedule & Notification Tab

Cloning a Custom Work Order Proforma Invoice Process

To clone a custom Work Order proforma invoice process:

1. Select a process to clone, and click the Clone button.

2. In the General Info screen, update any of the text boxes.

Note: When cloning a customWork Order Proforma invoice process, you
must change the name of the Process ID. The Process ID must be unique.

3. Click the Invoice Rules Tab.

4. In theWork Order Consolidation Rules area, select an option from the Con-
solidate based on picklist.

5. In the Mapping & Rules to Create Proforma Invoice area, update the picklists
and/or checkbox if necessary.

6. Click the Source Update tab.

7. If necessary, update the Automatic field updates to Work Order when proforma
invoice is created area.

8. Click the Schedule & Notification tab.
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9. Make any changes to the times and days to run the process in the Run At (GMT) and
On These Days areas.

10. If necessary edit the recipients for the notifications and alerts in the Specify recip-
ients of notification and alerts area.

11. Click the Quick Save button to save the process.

12. Click the Save & Close button to save the process and return to the Standard and
CustomWork Order Proforma Invoice Processes screen.

13. Click the Cancel button to cancel the process.

Deleting a Custom Work Order Proforma Invoice Process

To delete a custom Work Order process:

1. Select a process to delete from the Select Process area.

2. Click the Delete button.

3. In the Message from webpage dialog box, click OK to answer the question Are you
sure?

Work Order Proforma Invoice Process
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DISPATCH OPTIMIZATION USING OPTIMAX

Overview
OptiMax is the collection of various functions and features in ServiceMax that delivers
optimized dispatch of Work Orders to technicians. OptiMax provides the ability to con-
figure various factors influencing dispatch and also the scope of impact each factor has on
the dispatch results. With the scalable architecture and the light footprint of OptiMax, ser-
vice organizations of all sizes can effectively implement OptiMax to reduce operational
costs, increase margins and enhance productivity levels.

OptiMax Architecture
The picture below depicts the high-level functional architecture of OptiMax.
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Figure 1: OptiMax – Architecture

Highlights of the above architecture are:

OptiMax consists of various tools to cater to varying degrees of sophistication
needed in dispatch management. The capabilities include:

A rules-based assignment engine for direct and immediate assignment of Work
Orders to technicians, queues or dispatches.

A rich, intuitive and interactive dispatch console to queue, assign or schedule
Work Orders to teams or technicians.

An advanced optimization engine that delivers automatic scheduling of Work
Orders to technicians considering various constraints and preferences.

Depending upon their readiness and suitability, organizations can deploy any com-
bination of the above tools to meet their dispatching requirements. For example, an
organization can select to use simple assignment rules for Work Orders in North
America, a combination of simple assignment and interactive dispatch for Work
Orders in Europe, and advanced optimization for Work Orders in Australia.

The most fundamental setup required for OptiMax is a thorough and accurate defin-
ition of your service organization. Specifically, the service organization must be rep-
resented as service territories and service teams. Dispatch process definition relies
upon completeness of service organization setup.

OptiMax Process Flow
OptiMax processes Work Orders in two stages:

1. Immediate Actions

2. Batch Actions

Stage 1: Immediate Actions

Dispatch Optimization Using OptiMax
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Dispatch Optimization Using OptiMax

Figure 2: OptiMax Processing – Stage 1

In Stage 1, when a Work Order is created or updated, OptiMax finds the appropriate dis-
patch process for the Work Order. The dispatch process determines if the Work Order
must be dispatched immediately or through the nightly process. If it is configured as
simple dispatch, the assignment rules are applied immediately and a suitable recipient is
identified. The assignee can be a technician, queue or a dispatcher. If it is configured as an
advanced dispatch process, several factors required for dispatch optimization are pre-
computed on the Work Order. The factors include:

OptiMax Process Flow 445



Primary territory (using territory match rules)

Preferred start and end time (using booking window, SLA commitment, access hours
or default business hours in that order)

Preferred technician (configured in Installed Product, service contract or Account in
that order)

Service duration (from MTTS rules)

Expertise

Product specialization from Component installed product

Dispatch priority as defined by the dispatch process

Once all the dispatch factors are calculated successfully, the Work Order is placed in the
advanced dispatch queue for the nightly job to pick up.

Stage 2: Batch Actions

Figure 3: OptiMax Processing – Stage 2

Dispatch Optimization Using OptiMax
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Dispatch Optimization Using OptiMax

In Stage 2, a batch job wakes up every day at the time designated in the dispatch process.
One job runs for each territory in the dispatch process. In each optimization run, the fol-
lowing key steps are involved:

All unassigned Work Orders are identified. A Work Order can be either new (freshly
submitted to the queue) or old (failure from a previous run).

The preferred time window is set to the next business day for Work Orders that do
not have a preferred time window or if the Work Order failed in the previous optim-
ization run.

Work Order list is sorted as per the prioritization criteria.

Optimization settings are configured as the territory, technician, dispatch process
and organization level are applied.

Technicians for the given territory and adjacent territories are retrieved.

Technician availability for the next business day is calculated including break hours.

A matrix of distances between various Work Orders and technicians is prepared. Cur-
rently distance is calculated using the haversine method (aka ‘as the crow flies’
method). Real-time distance calculations using a mapping service will be imple-
mented in the future.

Now the process performs several iterations of schedule and route optimization, con-
sidering various constraints and preferences (see below to learn more about factors
influencing results), and identifies the most suitable route plan for each technician.

All successful events are saved in ServiceMax. Work Orders are assigned as per the
schedule.

Any failures (unassigned Work Orders) are sent back to the queue for the next
nightly run to consider. Currently, the routing of unassigned Work Orders to another
dispatch process or to a dispatcher is not supported.

Factors Influencing Optimization Results
Considering the very complex nature of dispatch optimization, several configuration
factors as well as quality of transactional data can potentially influence the overall results
of optimization. Given below are various factors that could impact the quality of results pro-
duced by OptiMax:
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Where Con-

figured
Factor Potential Impact

Global/Org-
wide

Distance Type OptiMax core engine will perform necessary distance con-
versions between miles and kilometers based on this setting.

MTTS Rule The amount of time scheduled for a Work Order on a tech-
nician’s calendar is calculated based on these rules.

Territory match
rule

This rule influences how the primary territory is calculated for
a Work Order. It dictates the mandatory coverage attributes to
be used to calculate territory.

Technician Address Address with valid geographical codes impacts the accuracy of
distance calculations.

Home Base Home base with valid geographical codes impacts the accur-
acy of distance calculations, if configured as Current.

Working hours &
break hours

Availability of the technician on any given day is driven by
this.

Average Speed Used to identify if the technician will be able to reach a Work
Order location on time.

Max Distance Limits the distance a technician travels on a route.

Product spe-
cialization

Will result in higher probability of finding the relevant tech-
nician for a Work Order.

Expertise Will result in higher probability of finding the relevant tech-
nician for a Work Order

Territory Coverage Proper and complete definition helps in identifying the primary
territory of a Work Order without iterations.

Average Speed Territory-wide average speed applied if not setup for a tech-
nicians.

Max Distance Territory-wide maximum distance applied if not setup for a
technician.

Account Access hours Impacts the preferred scheduling window of a Work Order if
not defined at the installed product level.

Preferred tech-
nician

Increases the relative ranking for a technician.

Dispatch Optimization Using OptiMax
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Where Con-

figured
Factor Potential Impact

Installed
Product

Access hours Impacts the preferred scheduling window of a Work Order.

Preferred tech-
nician

Increases the relative ranking for a technician.

Service Con-
tract

Preferred Tech-
nician

Increases the relative ranking for a technician.

Work Order Service Location Location with valid geographical codes impacts the accuracy of
distance calculations.

Booking Window If available, impacts the preferred scheduling window of the
Work Order.

SLA commitment If available, impacts the preferred scheduling window of the
Work Order.

Product Increases the probability of finding a suitable technician for
the Work Order.

Skill Increases the probability of finding a suitable technician for
the Work Order.
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Where Con-

figured
Factor Potential Impact

Dispatch
process

Entry criteria Highly granular definition of entry criteria ensures that there
are no conflicts between processes, and that the Work Order is
picked up by the right process.

Prioritization Rule Determines the Work Order’s relative priority in a given batch
of Work Orders. Proper definition will ensure that critical and
high priority Work Orders are considered first with high
resource availability.

Time Window
Weight

Has the highest importance. If specified, it ensures the Work
Order is scheduled within the given time window.

Total Distance
Weight

Has the second highest importance. If this factor is specified,
the optimization engine will compare various ‘route plans’ and
select the plan whose total distance (of all technicians com-
bined) is a relative minimum.

Route Distance
Weight

Has the third highest importance. If this factor is specified, the
route distance for each technician is kept within the specified
limits.

Route Time
Weight

Has the fourth highest importance. If this factor is specified,
the route time for each technician is kept within the specified
limits. Idle/break time is not included in this factor.

Product/Expertise
Weight

This is the last in the order of weights. If this factor is spe-
cified, Work Orders will be matched to technicians that have
the required product specialization or expertise.

See Also:

Advanced Configuration: Modules

Advanced Configuration: Submodules

Advanced Configuration: Display Tags

Advanced Configuration: Configuration Profile

Advanced Configuration: Auto-Entitlement Rules

Advanced Configuration: Counter Rules

Advanced Configuration: Inventory Process

Advanced Configuration: Dispatch Process

Dispatch Optimization Using OptiMax
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Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings
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SAMPLE INVENTORY PROCESS

Overview
This section demonstrates how to translate requirements for two sample inventory pro-
cesses into a Salesforce object model and custom inventory processes, and deploy it to
end users.

Requirements: Misc Receipts
Ability to receive and stock parts from suppliers without a source document such as a
Parts Request. While most supplier deliveries are handled using parts requests,
some parts are delivered ad-hoc or are received on behalf of departments that are
not online

The above receipts are called Miscellaneous Receipts.

There can be one or more products received in a miscellaneous receipt.

Some of the products may be serialized.

Serial numbers must be unique.

Ability to track the history of all miscellaneous receipt transactions only at the quant-
ity level. History tracking at serial number level is not required.

Only some users should be allowed to post Miscellaneous receipts.
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Requirements: Misc Issues
Ability to issue parts from a location without a stockable target location and without
a source document. This is to manage issuance of parts to departments that are not
online

The above parts are called Miscellaneous Issues.

There can be one or more products issued in a miscellaneous issue.

Some of the products may be serialized.

Serial numbers must be unique.

Ability to track the history of all miscellaneous issue transactions only at the quantity
level. History tracking at serial number level is not required.

Only some users should be allowed to post Miscellaneous Issues.

Data Model: Misc Receipts

Field Name Data Type Description

Field Name Data Type Description

Misc Receipt Num-
ber

Auto-num-
ber

Name field is setup as an auto-number field

Receiving Location Lookup
(Location)

Location where the parts are received

Department Text (100) Name of the department on whose behalf the parts are
received

Supplier Lookup
(Account)

Name of the supplier who sent the parts

Supplier Reference
Number

Text (100) Reference document number, typically invoice or delivery
note from the supplier

Posted To Invent-
ory

Checkbox Flag indicates if this miscellaneous receipt has been posted
to inventory or not

Sample Inventory Process
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Sample Inventory Process

Data Model: Misc Receipt Lines

Field Name Data Type Description

Line Number Auto-number Name field is setup as an auto-number field

Misc Receipt Lookup (Misc
Receipt)

Reference to miscellaneous receipt. Master-Detail rela-
tionship

Product Lookup
(Product)

Name of the product received

Received Quant-
ity

Number (14,4) Quantity received

Posted To
Inventory

Checkbox Flag indicates if this miscellaneous receipt has been posted
to inventory or not

Data Model: Misc Issue

Field Name Data Type Description

Misc Issue Num-
ber

Auto-number Name field is setup as an auto-number field

Issued From
Location

Lookup (Loca-
tion)

Location from where the parts are issued

Department Text (100) Name of the department to whom the parts are issued

Posted To
Inventory

Checkbox Flag indicates if this miscellaneous receipt has been posted to
inventory or not

Data Model: Misc Issue Line

Field Name Data Type Description

Line Number Auto-number Name field is setup as an auto-number field

Misc Issue Lookup (Misc.
Issue)

Reference to the miscellaneous issue. Master-Detail rela-
tionship
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Field Name Data Type Description

Product Lookup
(Product)

Name of the product issued

Issue Quantity Number (14,4) Quantity Issued

Posted To
Inventory

Checkbox Flag indicates that if this miscellaneous issue has been pos-
ted to inventory or not

Setup Considerations
To avoid posting the same transaction more than once, we will maintain a flag to
indicate if it has already been posted to inventory.

Use the flag as entry criteria.

Update the flag upon successful completion of transaction.

Setup Steps: Misc Receipts
1. Create custom objects Misc Receipt andMisc Receipt Line as described above.
Grant object permissions to profiles that are allowed to use the feature.

2. Create a tabMisc Receipts. Give access to this tab to profiles that are allowed to
use the feature.

3. Add custom lookup fields in the Stock History object for Misc Receipt and Misc Receipt
Line objects.

4. Click Home > ServiceMax Setup > Modules and then click New in the Custom
Modules section.

5. Create a new custommodule as shown in the figure below and then click Save.

Figure 1: Custom Modules Screen

6. Click Home > ServiceMax Setup > Service Flow Manager > Inventory Pro-
cess to view the Manage Inventory Process screen and then click New in the Custom

Sample Inventory Process
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Inventory Process section.

7. In the Process Information tab, enter the information as shown below:

Figure 2: Process Information Tab

8. In the Entry Criteria tab, enter the information as shown below:

Figure 3: Entry Criteria Tab
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Note: No entry criterion is specified for miscellaneous receipt lines. We
want to consider all lines as long as the receipt has not been posted to
inventory.

9. In the User Inputs tab, enter the information as shown below:

Figure 4: User Inputs Tab

Note: Since this is a multi-line transaction, Product is displayed from Misc
Receipt Line. Since the Received Quantity is entered when creating the
lines, no data entry is required (except serial numbers) when users post
the receipts to inventory. We have also selected Strict enforcement of
uniqueness of serial numbers.

Sample Inventory Process
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10. In the Stock Updates tab, enter the information as shown below:

Figure 5: Stock Updates Tab

Note: The expected outcome of miscellaneous receipt is to increase the
Available Stock at the Receiving Location. We have also enabled Stock
History tracking for this process.

11. Since Miscellaneous Receipts is an independent transaction, we will skip the Related
Transactions tab.
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12. In the Closure Actions tab, enter the information as shown below:

Figure 6: Closure Actions Tab

Note: Upon successful completion, we will update the Posted To Invent-
ory flag to true. As a result, the receipt cannot be posted to inventory
more than once.

13. Click Save.

14. Navigate to Misc. Receipt Object to create a new custom button.

15. Create a button as shown below and then click Save.

Figure 7: Custom Button Screen

Sample Inventory Process
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16. Edit the page layout named Misc Receipt Layout and add the Post To Inventory but-
ton to the page layout.

17. After creating a Misc receipt record and adding receipt lines, when users click the
Post To Inventory button from a Misc Receipt record, the inventory processing
screen appears similar to this:

Figure 8: Inventory Processing Screen

Setup Steps: Misc Issues
1. Create custom objects Misc Issue andMisc Issue Line as described above. Grant
object permissions to profiles that are allowed to use the feature.

2. Create a tabMisc Issues. Give access to this tab to profiles that are allowed to use
the feature.

3. Add custom lookup fields in Stock History object for Misc Issue and Misc Issue Line
objects.

4. Click Home > ServiceMax Setup > Modules to view the Manage Modules screen.
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5. Click New in the Custom Modules section. Create a new custommodule as shown
below and then click Save.

Figure 9: Custom Modules Screen

6. Click Home > ServiceMax Setup Home > Inventory Processes and then click
New in the Custom Inventory Processes section.

7. In the Process Information tab, enter information as shown below:

Figure 10: Process Information Tab

Sample Inventory Process
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8. In the Entry Criteria tab, enter the information as shown below:

Figure 11: Entry Criteria Tab

Note: No entry criterion is specified for miscellaneous issue lines. We
want to consider all lines as long as the issue has not been posted to
inventory.

9.  In the User Inputs tab, enter the information as shown below:
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Figure 12: User Inputs Tab

Note: Since this is a multi-line transaction, Product is displayed from Misc
Issue Line. Since the Issued Quantity is entered when creating the lines,
no data entry is required (except serial numbers) when users post the
issues to inventory. We have also selected Strict enforcement of unique-
ness of serial numbers.

10. In the Stock Updates tab, enter the information as shown below:

Figure 13: Stock Updates Tab

Note: The expected outcome of miscellaneous issue is to decrease the
Available Stock and increase the Consumed stock at the Issuing Location.
We have also enabled Stock History tracking for this process.

11. Since Miscellaneous Issues is an independent transaction, we will skip the Related
Transactions tab.

Sample Inventory Process
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12. In the Closure Actions tab, enter the information as shown below:

Figure 14: Closure Actions Tab

Note: Upon successful completion, we will update the Posted To Invent-
ory flag to true. As a result, the issue cannot be posted to inventory more
than once.

13. Click Save.

14. Navigate to Misc Issue object to create a new custom button.

15. Create a custom button as shown below and then click Save.

Figure 15: Custom Button Screen
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16. Edit the page layout namedMisc Issue Layout and add the Post To Inventory but-
ton to the page layout.

17. After creating a misc issue record and adding issue lines, when users click Post To
Inventory from a Misc Issue record, the inventory processing screen will appear sim-
ilar to this:

Figure 16: Inventory Processing Screen

See Also:

Advanced Configuration: Modules

Advanced Configuration: Submodules

Advanced Configuration: Setting

Advanced Configuration: Display Tags

Advanced Configuration: Configuration Profile

Advanced Configuration: Auto-Entitlement Rules

Advanced Configuration: Counter Rules

Advanced Configuration: Inventory Process

Advanced Configuration: Dispatch Process

Sample Inventory Process
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Basic Configuration

Troubleshooting Configuration Issues

Standard Configuration Settings
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APPENDIX A: TROUBLESHOOTING CONFIGURATION
ISSUES

Overview
This section outlines some of the typical problems you may encounter while using the Ser-
viceMax Configuration features.

Problem Solution

I do not see any standard mod-
ules or submodules.

You may not have loaded the default configuration data.
This process is described in detail in the ServiceMax Install-
ation Guide.

I am trying to create a custom
module ID PM for preventive
maintenance, but it throws an
error.

All custom IDs such as module, submodule, and so on, must
be at least 8 characters long. This is enforced to maintain
the integrity of the default ServiceMax settings between
upgrades.

I created modules, submodules
and settings. How do I use
them?

See Customizing ServiceMax. It provides guidelines and
tools to effectively utilize these constructs in custom func-
tionality.

How do I activate multiple org-
wide profiles?

Only one org-wide profile can be active at any time.
However, you can have any number of group-wide profiles.

I am unable to remove a set-
ting from a profile.

All settings are automatically linked to all profiles, and can-
not be deleted. To alter behavior of a submodule, simply
select the appropriate setting value.

I am unable to deactivate an
org-wide profile I created.

At least one org-wide profile must be active at any time. To
deactivate the currently active org-wide profile, simply
activate another profile.

I do not see all the settings in
a group-wide profile I created.
Why?

Only settings with setting type Group or User are displayed
in group-wide profiles. Global settings are displayed in org-
wide profiles only.

I get an OptiMax engine error
when trying to save a dispatch
process.

This could be because the OptiMax user credentials have
changed or OptiMax has been disabled for your organ-
ization. Please contact ServiceMax support to resolve
this.
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APPENDIX B: STANDARD SETTINGS

Overview
This section lists all the standard settings for each module in a vanilla installation of Ser-
viceMax.

Note: Modules like Case, Booking Window and their related modules are avail-
able for your installation only if allowed by your ServiceMax license. Contact
your ServiceMax administrator to know the type of license used by your organ-
ization.

Booking Window

Setting Name Default Value

Default Booking Window Start TODAY

Default Booking Window Duration 5

Yellow Color Starts From 4

Yellow Color Ends At 15

Maximum Booking Window Duration 10

SLA Timestamp To Use In Booking Window Onsite
Response

Allow Overbooking False

Use Default Booking Window In Addition To Referenced Booking Win-
dows

False
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Dispatch Console

Setting Name Default Value

Number of days for which events
are displayed in calendar

7

Default duration for new events in
minutes

60

Initiate search automatically when
a Work Order is selected

None

Default tree view (service team or
territory)

Team

Default radius on map to find
teams or technicians (in Miles)

50

Default dispatch status to be used
as a Work Order filter (New,
Queued, Assigned, All)

All

Select Work Order automatically if
only one Work Order is in a view

True

Change Work Order owner when
queued to a team or assigned to a
technician

True

Refresh Work Order list when
assignment status is changed

False

When Work Order is dropped on
calendar, number of minutes to
round off the event start time

15

What to do if an event starts out-
side a technician’s working hours

Warn

Whether to retain the lock on a
Work Order when it is unassigned

False

Enforce integrity of Work Order
start/end times and service dur-
ation

True
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Setting Name Default Value

Remove past events on Work
Order reassignment

False

Refresh calendar when refreshing
work order list

False

Custom fields in Event Edit (1-10)

Image URL to be used for plotting
Work Orders on map

 http://maps.google.com/mapfiles/kml/pal4/icon55.png

Image URL to be used for plotting
Service Teams on map

 http://maps.google.com/mapfiles/kml/pal4/icon53.png

Image URL to be used for plotting
Technicians on map

 http://maps.google.com/mapfiles/kml/pal2/icon5.png

Auto-Refresh Work Order List on
deleting of Work Order Event

True

Auto-Refresh Work Order List on
saving of Work Order Event

False

Default event start time for Multi
Assign of Work Order

08:00

Allow deploying of settings to
other Super Dispatchers

True

Unit of measure for Service Dur-
ation and Travel Time

Minutes

Unit of measure to plot Map Miles

Auto-Refresh Work Order List on
deleting of Work Order Event

True

Apply Event Subject Rule for Multi
Assign?

False

Dispatch Console Work Order Queues
Scenarios supported for Dispatch Console Work Order Queues:

Dispatch Console Work Order Queues 473



Work Order Queue created with Role.

Work Order Queue created with Public Group and only User associated with Public
Group.

Work Order Queue created with Partner Users.

Work Order Queue created with Partner Role.

Scenarios NOT supported for Dispatch Console Work Order Queues:

Work Order Queue created Roles and Subordinates.

Work Order Queue created Role and Internal Subordinates.

Work Order Queue created Role, Internal and Portal Subordinates.

Work Order Queue created Public Group and Public Group associated with Role, Role
and Subordinate, Partner Users, Portal Roles, Portal Role and Subordinates, and
Public Groups.

Entitlement Verification on Case

Setting Name Default Value

Show Future Entitlements True

Show Expired Entitlements True

Default Entitlement Type Product

Match Account in Entitlement Check True

Match Contact in Entitlement Check True

Applicable SLA Coverage Level Contract

Check Coverage on Parent Product True

Check Coverage on Top-Level Product True

Check Coverage on Child Product True

Check Coverage on Part Number True

Check Coverage on Product Family True
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474 Entitlement Verification on Case



Appendix B: Standard Settings

Setting Name Default Value

Check Coverage on Product Line True

Number of Child Level Iterations 1

Allow Entitlement Filters True

Go back to Case on Save Entitlement True

Auto Calculate Billing Type True

Automatic Entitlement On Case

Setting Name Default Value

Enable Auto Entitlement False

Global Settings

Setting Name Default Value

Setting Name Default Value

Allow inventory
transactions even if
sufficient quantity
is not available

True

Consider only stock-
able products for
inventory pro-
cessing

False

Stock Status values
to be considered for
serial number
uniqueness

Available, In Transit

Enable Google Map
based features

True
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Setting Name Default Value

Unit of measure for
distance. This
impacts how vari-
ous distances are
interpreted by
OptiMax engine

Mile

Enable Dispatch
Optimization. This
is to enable or dis-
able any automatic
calculations related
to OptiMax

True

Enable ServiceMax
Partner Portal fea-
tures

True

Enable ServiceMax
Partner Portal
inventory features

True

OptiMax Endpoint
URL

http://optimaxdev.servicemax.com:8443/optimax/optimization

Size of Attachment
in ServiceMax Off-
line

2048

Populate product
from IB

True

Enable APL Cap-
abilities

False

Email ID To Notify
ServiceMax Back-
ground Errors

Default search oper-
ator

Contains

SET002 Maximum length allowed for SOQL queries made from ServiceMax Off-

line. Before increasing the value of this setting, contact Salesforce to get

the limit increased for your Org.
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Installed Product

Setting Name
Default

Value

Map ID for creating Child IB MAP001

Required product for Child IB True

Required Serial Number for Child IB True

Create Warranty on New Installed Product True

Create Warranty on Update Installed Product True

Derive Product from Installed Product on Case True

Use Today's Date If Warranty Start Date Not Present False

Map ID for Creating Warranty from Warranty Terms MAP021

Inherit Parent Warranty False

Create Warranty From Templates Even After Warranty Inheritance False

Map ID for creating Case from Installed Product MAP020

Default Case Record Type to Consider When Creating Case From
Installed Product

Map ID for creating Work Order from Installed Product MAP023

Perform Auto-Entitlement When Creating Case From Installed Product False

Derive Product from Installed Product on Work Order True

Default Record Type to consider when creating work order from
Installed Product

iPad ServiceMax Enterprise

Setting Name Default Value

Frequency of location tracking (minutes) 30

Enable Location Tracking False
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OptiMax

Setting Name Default Value

OptiMax.Assisted True

OptiMax.AssistedMode MULTIDEPOT

OptiMax.OptimizationRule WEEKLY

OptiMaxExitCondition.Type OptiMaxCovergencyCount

OptiMaxExitCondition.Count 1000

OptiMaxExitCondition.OptiMaxCovergencyCount 500

OptiMaxExitCondition.OptiMaxGenerationCount 20000

OptiMaxWeight.Capacity 1

OptiMaxWeight.resourceLoadBalance 1

OptiMax.debug False

OptiMax.debugMail

Optimax.CompactingFactor 1000

Zombie Job Minutes 1440

Number of days to maintain job history 7

Default Hourly Labor Cost for Technicians 60

Default Drive Cost Per Unit of Distance (Mile or Kilometer) 1

Default Fixed Overhead Cost per Technician 0

Average Traveling Speed Per Unit of Distance (Mile or Kilo-
meter)

40

Maximum Daily Drive Distance 1000

Maximum Threshold For Calculating Capacity (In Days) 30

Change Owner on Assignment True

Always calculate Dispatch Process False

Default Dispatch Priority 1
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Setting Name Default Value

Default Service Duration 60

SLA Timestamp for Work Order scheduling Onsite Response Cus-
tomer

Change owner on Assignment True

Email Address: To send error notifications

Number of Days To Find Slots In for Immediate Dispatch 5

Average Drive Time For Technicians In Minutes 60

Consider Same Day For Immediate Dispatch True

Lead Time In Minutes For Immediate Dispatch 60

Default start day for Full run Time Horizon 0

Default Number of days for Capacity Calculation 3

Default start hour for Incremental run Time Horizon 1

Importance of retaining the existing schedule for res-
cheduled work orders

100

Event time window priority 100

Event owner priority 1000

Default priority for work orders that meet the incremental
run filter criteria

100

Event importance 100

Priority for retaining the existing technician assignment for
rescheduled work orders

1000

Importance for retaining the existing schedule for externally
scheduled work orders

100

Priority for retaining the existing technician assignment for
externally scheduled work orders

1000

Attach OptiMax input data to ServiceMax Job record False

P1 Priority 5

P2 Priority 4
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Setting Name Default Value

P3 Priority 3

P4 Priority 2

Normalization factor for Node Type 1

Normalization factor for Route Distance 100

Normalization factor for Route Time 600

Normalization factor for Time Window 10

Normalization factor for Total Distance 1000

Enable runtime calculation of dispatch process and priority False

Abort on error during runtime calculation of dispatch process
and priority

False

Pre-calc Batch Size 100

Enable runtime calculation of dispatch process and priority False

Abort on error during runtime calculation of dispatch process
and priority.

False

Pre-calc Batch size (number of work orders sent in each
batch)

100

Parts Order (RMA and Shipment)

Setting Name Default Value

Map ID for Create RMA from Case MAP007

Map ID for Create RMA from Work Order MAP008

Default RMA Source Address Type Account Shipping
Address

Setting for Default To Location

Action on Create RMA without Lines Warn

Action on RMA without Source Location Warn

Action on RMA without Target Location Warn
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Setting Name Default Value

Use Product Unit Price from Price Book for Line True

RMA Line Price Book Standard Price Book

Map ID to Create RMA Line from Work Order Line MAP012

Populate Product/Serial Number from Case True

Populate Product/Serial Number from Work Order True

Map ID for Create Shipment from Case MAP009

Map ID for Create Shipment from Work Order MAP010

Map ID for Create Shipment from RMA MAP011

Default Shipment Destination Address Type Account Shipping
Address

Setting for Default From Location

Action on Create Shipment without Lines Warn

Action on Shipment without Source Location Warn

Action on Shipment without Target Location Warn

Use Product Unit Price from Price Book for Line True

Shipment Line Price Book Standard Price Book

Map ID to Create Shipment Line from Work Order Line MAP018

Map ID to Create Shipment Line from RMA Line MAP019

Record Type for Shipment Order Header Shipment

Record Type for Shipment Order Line Shipment

Use Product Unit Price from Price Book for Line True

Enable Auto price calculation for RMA lines True

Enable Auto price calculation for Shipment lines True

Allow adding new shipment lines when creating Shipment from
Work Order

True
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Parts Request

Setting Name Default Value

Enable Auto price calculation for Parts Request lines True

Use Product Unit Price from Price Book for Line True

Default Price Book for creating Parts Request Line Standard Price Book

Preventive Maintenance

Setting Name Default Value

Reset PM Cycle When Frequency Changes True

Default Task Priority Normal

Create Task on Work Order True

Service Contract

Setting Name Default Value

Activation of Contract without Product coverage Allow

Activation of Contract without Site coverage Allow

Activation of Contract without Contact coverage Allow

Activation of Contract without Services coverage Allow

Map ID to Map header fields of selected Service Contract MAP002

Covered Products Map ID MAP003

Included Services Map ID MAP004

Covered Locations Map ID MAP005

Entitled Contacts Map ID MAP006

Check Entitlement History on Cancellation Warn

Check Open Transactions on Cancellation Warn
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Service Level Agreement

Setting Name Default Value

Commitment Type on Case SLA Clock Customer Commitment

Allow Pause or Restart of SLA Clock on Case True

SLA Tracking Enabled on Case True

Change Countdown clock color in case to Yellow at 25

Commitment Type on Work Order SLA Clock Customer Commitment

Allow Pause or Restart of SLA Clock on Work Order True

SLA Tracking Enabled on Work Order True

Change Countdown clock color in Work Order to Yellow at 25

Service Org Setup

Setting Name Default Value

Enforce Uniqueness of Salesforce User in Technician False

Stock Transfer

Setting Name Default Value

Use Product Unit Price from Price Book for Line True

Default Price Book for creating Stock Transfer Line Standard Price Book

Work Order

Setting Name Default Value

Work Order Close Status Closed

Map ID for create quotes from Estimates MAP013
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Setting Name Default Value

Map ID for Create Estimate Lines to Quotation Lines MAP017

Checkbox to Select or Deselect Estimate Records True

Map ID for Create Usage from Estimates MAP014

Map ID for Create Work Order from Case MAP015

Select Default Record Type True

Estimate/Usage Lines VF Page Name SVMXP__WORD_CreateWOEstUs-
gLines

Parts Request Lines VF Page Name SVMXP__WORD_
CreateWOReqRecLines

Use Price From Price Book for Usage Lines True

Work Order Usage Price Book Standard Price Book

Use Price From Price Book for Estimate Lines True

Work Order Estimate Price Book Standard Price Book

Use Price From Price Book for Parts Request Lines True

Work Order Parts Request Price Book Standard Price Book

Enable Auto price calculation for Usage lines True

Enable Auto price calculation for Estimate lines True

Enable Auto price calculation for Parts Request lines True

Allow Quote Save Without Lines Allow

Show Work Details Screen After Work Order Is Created
From Case

False

Are line items billable always? True

Billing Types that determine if line items are billable Warranty, Contract
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Entitlement Verification on Work Order

Setting Name Default Value

Show Future Entitlements True

Show Expired Entitlements True

Default Entitlement Type Product

Match Account in Entitlement Check True

Match Contact in Entitlement Check True

Applicable SLA Coverage Level Contract

Check Coverage on Parent Product True

Check Coverage on Top-Level Product True

Check Coverage on Child Product True

Check Coverage on Part Number True

Check Coverage on Product Family True

Check Coverage on Product Line True

Number of Child Level Iterations 1

Allow Entitlement Filters True

Go back to Work Order on Save Entitlement True

Auto Calculate Billing Type True
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QUICKBOOKS EXPORT

Overview
The ServiceMax QuickBooks Export feature enables export of work orders and work
details that are ready to be billed, in IIF format, which is a proprietary QuickBooks™
format. The exported data can be directly imported into QuickBooks for billing.

Business Context
QuickBooks is the accounting system of choice for many mid-market customers of Ser-
viceMax. These customers need a quick and easy way to extract completed work orders or
other ServiceMax data and import it into QuickBooks to eliminate duplicate data entry,
without having to use a full-fledged middleware tool.

Detailed Feature Description
The following are the salient aspects of this feature:
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Provision to define the default org-wide export configuration in a JSON formatted
string

Sample default configuration provided out-of-the-box for cloning and customization

The following options can be configured in the JSON string:

Header and child objects to be exported, default being Work Order and Work
Detail

Header and child object fields to export

Filter condition for qualifying header and child records

Date field to filter header records on

Header fields to display in the Export screen

Sort field (ascending order) for records displayed in the Export screen

Header object fields to update after export; for example, to flag exported records

The Export screen enables the user to achieve these capabilities:

Specify a date range on the configured header date field

View the qualifying header records in the above date range

Select all or any of these records for export

Export the selected records and their qualifying child records in IIF format file

Download the export file or email it to the logged in user

Data Model – Key Details

Object

Name
Field Name Remarks

ServiceMax
Processes

Export Con-
figuration

The JSON formatted string containing the configuration details
for exporting ServiceMax data to QuickBooks.

ServiceMax
Processes

Is Default? This checkbox, when checked, identifies the particular Export
Configuration as the default configuration for the org.

ServiceMax
Processes

Name A descriptive name for the export configuration.

QuickBooks Export
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QuickBooks Export

Object

Name
Field Name Remarks

ServiceMax
Processes

Process Id A unique Id for the export configuration, defined using alphabets,
numbers, and underscores.

Work
Order

Is Exported This checkbox, when checked identifies that the particular work
order has already been exported for QuickBooks. This is checked
automatically when the work order is exported using the Export
for QuickBooks screen. To re-export a work order that has
already been exported, uncheck this checkbox.

Access and Permissions

Actions User Permissions Needed

To view QuickBooks Export Con-
figuration:

“Read” on ServiceMax Processes

To define QuickBooks Export Con-
figuration:

“Create” on ServiceMax Processes

To edit QuickBooks Export Con-
figuration:

“Update” on ServiceMax Processes

To delete QuickBooks Export Con-
figuration:

“Delete” on ServiceMax Processes

To export work orders based on the
sample default configuration:

“Update” on Work Order field Is Exported “Read”
on Work Order and Work Detail

Configuration
Configuration for export to QuickBooks includes configuring the various aspects of the
Export for QuickBooks screen and the data to be exported. This is done in a JSON format-
ted string in the Export Configuration field in the ServiceMax Processes object record
of Record Type Export Configuration.

The Export Configuration record with the Is Default? checkbox checked is the one con-
sidered as the default export configuration used by the Export for QuickBooks screen. An
org can have only one Export Configuration record with Is Default? checked.
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ServiceMax provides a sample default configuration for cloning and customization. A par-
tial default Export Configuration field is shown below.

Figure 1: Export Configuration Field (Partial list of sample default configuration)

Clone the sample Export Configuration record for editing the default configuration. Check
Is Default? in the cloned record and uncheck it in the sample record.

Export Configuration Field

The table below describes the configuration parameters of the Export Configuration field.

Configuration Parameters Description

"headerObjectAPIName":
"SVMXC__Service_Order__c”

The API name of the header object from which data is expor-
ted. By default, this is the Work Order object.

"childObjectAPIName":
"SVMXC__Service_Order_Line__c"

The API name of the child object for which data is exported.
By default, this is the Work Detail object.

"headerEligibilityCriteriaID":
"EXPR076"

This is the filter applied on the header object and is used to
qualify records for export. This is specified as an SFM
Expression ID. The default expression filters Closed work
orders which have not yet been exported (Expression is
Order Status = Closed and Is Exported = False).

QuickBooks Export
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Configuration Parameters Description

"childEligibilityCriteriaID":
"EXPR077"

This is the filter applied on the child object. This is specified
as an SFM Expression ID. The default expression filters
Usage/Consumption work details which have Is Billable =
True.

"filterDateField":
"SVMXC__Closed_On__c"

The header object date field used for the filter on the Export
for QuickBooks screen. By default, Export Configuration is
set to filter work order records on the Closed On date.

"defaultSortingField":
"SVMXC__Closed_On__c"

The sorting field used for the record list on the Export for
QuickBooks screen. By default, it is the Closed On date.
The sort order is not configurable, and is always ascending.

"sourceUpdate": [
"field": "SVMXC__Is_Exported__
c",
"operator": "Set",
"value": true"
]

This configuration is used to update fields in the header
object after each record has been exported. By default, Is
Exported = True, indicating they are not available for
export again.
If source updates are required to be made to any date or
date time fields in the header object, one of the following lit-
erals have to be used:
Date: Today, Tomorrow, Yesterday Date Time: Now,
Today, Tomorrow, Yesterday

"displayFields": [
"Name",
"SVMXC__Company__c",
"SVMXC__Contact__c",
"SVMXC__Closed_On__c",
"SVMXC__Total_Billable_Amount_
_c"
]

The header object fields set here appear as the columns on
the Export for QuickBooks screen (see Figure 2).

Fields in the TRNS section labeled
TRNSID, TRNSTYPE, DATE, ACCNT,
NAME, CLASS, AMOUNT, DOCNUM,
TOPRINT

These fields come from the header object and are the
header fields in the exported file.
The configuration for fields TRNSID, TRNSTYPE, ACCNT,
CLASS, DOCNUM, and TOPRINT should not be changed.
The date values are exported in MM/dd/yy format.
TRNSID and DOCNUM fields are set to the numeric part of
the Work Order Name field value.
DATE, NAME, and AMOUNT are set to Closed On, Account
Name, and Total Billable Amount field values respectively.
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Configuration Parameters Description

Fields in the SPL section labeled
SPLID, TRNSTYPE, DATE, ACCNT,
NAME, AMOUNT, DOCNUM

These fields come from the child object and are the child
fields in the exported file.
The configuration for fields SPLID, TRNSTYPE, ACCNT,
NAME, and DOCNUM should not be changed.
The date values are exported in MM/dd/yy format.
SPLID and DOCNUM fields are set to the numeric part of the
Work Detail Name field value.
DATE and AMOUNT are set to Closed On and Total Line Price
field values respectively.

How to Export to QuickBooks

To show the Export for QuickBooks link in Home page:

1. Create/edit a custom component of type Links from Salesforce Setup > App Setup
> Customize > Home > Home Page Components.

2. Add the custom link Data_Extract_Console to the above custom component.

3. Edit the required home page layouts and add the above custom component.

To export Work Order records to QuickBooks:

1. Click the Export for QuickBooks link on your home page.

QuickBooks Export
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The Export for QuickBooks screen appears, as shown below with the sample default
configuration. The work orders meeting the header filter criteria are displayed.

Figure 2: Export for QuickBooks Screen (Sample default configuration)

2. (Optional) To filter records by a date range, click the arrow icon next to Filter
records by applying this date range (optional) on the configured date field:
Closed On.

a. Enter dates in the From: and To: fields by clicking in the fields to open a popup
Calendar where you can select a date. Click today’s date to the right of each field
to enter today’s date.

b. Click the Go! button to the right of the date fields.

The records filtered by the date range appear below.

3. In the Choose records from the list below and click one of the buttons to
export section, select records for export by checking their checkboxes in the left
column.
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To select all records, check the top left checkbox in the header row.

Use the vertical scroll bar on the right to scroll the record list displayed in the cur-
rent page.

To set the number of records per page, select a number (100, 200, or 500) from
the picklist on the bottom left. 100 is the default value.

To move between pages, click the First, Prev,Next, and Last icons on the bot-
tom center.

4. Click the Email As Attachment button to email the export file as an attachment in
an email. The extract will be emailed to the logged in Salesforce user’s email account.
If successful, a “Data exported successfully” message appears.

5. Click the Export To File button to save the export file to your browser’s download loc-
ation on your computer. If successful, a “Data exported successfully” message
appears.

Note: The export file is named with the date of export (for example, QB_
Export_03_18_2014.iif). If more than one export is done per day, the files are
generated with unique names by appending a running number to the name
above. Files are not overwritten.

Performance Considerations
With the default Export Configuration, average time taken to export 500 work orders with
1500 work details (3 work details per work order) is 30 seconds. This is for guidance only
and actual times may vary depending on service availability.

Known Limitations
Only one active Export Configuration, as identified by Is Default? checked in the
configuration record, is supported per org.

The Export Configuration has to be specified manually in JSON format; there is no
configuration screen for this.

No data validations are done before creating the IIF format file.
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Tips for Troubleshooting

Scenario/Issue Solution

The Home page does not have the Export for QuickBooks
link.

See To show the Export for
QuickBooks link in Home page:.

The Export for QuickBooks screen displays this error mes-
sage on launch: “Unable to display data. Default Con-
figuration for export is not available. Please contact your
ServiceMax Administrator.”

Ensure there is one ServiceMax Pro-
cesses record of Record Type
Export Configuration, with Is
Default? checked.

The Export for QuickBooks screen displays this error mes-
sage on launch: “Unable to display data. More than one act-
ive configuration detected. Please contact your ServiceMax
Administrator.”

Ensure there is one ServiceMax Pro-
cesses record of Record Type
Export Configuration, with Is
Default? checked.
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SERVICEMAX TRANSLATIONWORKBENCH

Overview
ServiceMax Translation Workbench enables administrators to define and manage trans-
lations for labels and messages configured in SFM Transactions, SFMWizards, SFM Search,
and Inventory Processes. The benefit of this feature is that it enables administrators to
define one SFMWizard (or SFM Transaction, SFM Search, or Inventory Process) for all sup-
ported languages to deliver the wizard (or transaction, search, or inventory process) in
any supported language, based on the language of the logged in user.

Detailed Feature Description
ServiceMax Translation Workbench provides the platform to define translations in any sup-
ported language for strings configured in the following features:

SFM Transactions

SFMWizard

SFM Search

Inventory Processes

The translations are configured using the Manage Translations screen, and these trans-
lations are displayed by delivery engines of above features in the online application,
depending on the language of the logged in user.

Mobile applications such as the iPad application, which support the ServiceMax Translation
Workbench feature, can get the configured translations after doing a configuration sync.

Initial and Incremental Loading of Master Text List

When the Manage Translations screen is launched for the first time in an org by any user,
the master list of all the existing translatable strings associated with the above features is
loaded into the ServiceMax Tag object. The list of keys associated with these translatable
strings is updated in the related ServiceMax Processes object record(s).

497



Whenever any translatable strings are added/modified, this screen needs to be
relaunched to load the newly added /modified strings into the ServiceMax Tag object, and
to update the related ServiceMax Processes record. Examples of additions/modifications
include creation of a new SFM Transaction, updating of an existing SFMWizard, and adding
objects to an existing SFM Search.

Note: Any master text stored in a field of length up to 255 characters can
have only one translation per language, as the master text is used as the key
for the translation record (ServiceMax Tag record). For example, if 'Renew And
Activate Contract’ is used as an SFM Process Name and SFMWizard Step
Name, there is only one translation record per language for these two con-
texts, with the key being ‘Renew_And_Activate_Contract.’ There can be only
one translation for this label, which displays in both SFM and SFMWizard deliv-
ery screens.

Master text stored in a field of length above 255 characters can technically
have more than one translation per language if it is used in two or more con-
texts. This is because the key used in these cases is the relevant pro-
cess/page layout ID concatenated with ‘_DESC’ / ‘_PAGELAYOUT.’ For
example, if 'Renew And Activate Contract renews an existing contract and
activates it’ is used as the Page Help Text in an SFM Transaction and also as
the SFMWizard Step Description, there are two translation records per lan-
guage, one for each occurrence. Therefore, the translation will have to be
defined for each of these occurrences.

Search Criteria Section in Manage Translations Screen

The Language picklist lists all the fully supported languages of Salesforce.

After choosing a language, translations can be defined for all available strings in all the sup-
ported features listed above, or for specific strings. Specific strings can be retrieved by
choosing the appropriate Process Type, and optionally with a specific Process Name.
Specific strings can also be retrieved by entering all or part of the translatable string in the
Search For Master Text field. This search condition can be applied in combination with
Process Type and Process Name.

ServiceMax Translation Workbench
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Clicking the Get Translations button loads the matching strings for the defined search cri-
teria. The search for master text is a contains search.

Search Results Section in Manage Translations Screen

By default, 50 search results are shown per page. After the search results are displayed,
this page size can be changed to 10, 25, or 100, for that search.

Search results can be filtered further on the data displayed in any of the columns,
Context,Master Text, and Text, by entering keyword(s) in the text box at the top right
of this section. This is an inline filter, that does a contains search, and is applied as the
keywords are entered. Each space-separated keyword is applied individually on the data
displayed in each of the columns. All records containing any keyword in any one of the
three columns will be displayed.

The count of search results returned and the page count details appear below the search
results table, with provision to navigate to First, Previous,Next, or Last page.

Clicking the Save button saves the newly entered/updated translated Text in all search
result pages displayed.

If the translation is blanked out in the Text column for any Master Text, the existing
translation entry is deleted in the ServiceMax Tag object. In this case, as well as in the
case of strings for which no translations are defined, the delivery modules of the supported
features display the Master Text, which is the text defined in the associated process.

Copy Master Text copies the Master Text value to the Text column. The user is promp-
ted to select if this should be done for all the strings displayed, or only for the strings that
do not have a translation, that is, for strings for which the Text column is blank. As per the
user’s choice, the Master Text value is copied to the Text column in all pages, not just
the page being displayed.

Reset rolls back all the unsaved translations entered in the Text column for all pages.

Search Results Columns in Manage Translations Screen

The Master Text column displays the actual string to be translated. By default, the
search results are displayed sorted on this column in ascending order. Clicking this column
header toggles the sort order.

The Text column displays the translations already defined for the selected language.
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The Context column indicates the feature area in which a particular translatable string,
that is, Master Text, is defined. There can be more than one context for some Master Text
values. The following table lists all the possible values for the Context column, and
provides a brief description about each.

Feature Context Master Text

Inventory Detail Error
Message

Inventory Process Configuration screen, Entry Criteria tab, Error mes-
sage to display if no child records meet the above criteria field

Inventory Header Error
Message

Inventory Process Configuration screen, Entry Criteria tab, Error mes-
sage to display if a record does not meet the above criteria
field

Inventory Inventory
Process
Description

Inventory Process Configuration screen, Process Information tab,
Description field

Inventory Inventory
Process Title

Inventory Process Configuration screen, Process Information tab, Pro-
cess Name field

SFM Data Val-
idation Rule
Message

SFM Designer screen, Data Validation Rules tab, value displayed in the
Rule Message column.

SFM Header Error
Message

SFM Designer screen, Qualifying Criteria & Field Mappings tab, value
displayed in the Error Message field in the Expression Options dialog
box displayed by clicking the Expression Options… for the header
object expression

SFM SFM Button
Title

SFM Designer screen, Screen Designer tab, value displayed in the Title
field (General section) of the Properties pane displayed for an SFM But-
ton

SFM SFM Link
Title

SFM Designer screen, Advanced Options tab, Linked Process vertical
tab, value displayed in the Link Title column in the Selected SFM Pro-
cesses section

SFM SFM Page
Help

SFM Designer screen, Screen Designer tab, value displayed in the Help
Text field (Help section) of the Properties pane displayed for an SFM
Page Layout

SFM SFM Process
Description

SFM Designer screen, Create/Edit SFM Transaction tab, value displayed
in the Description field

SFM SFM Process
Name

SFM Designer screen, Create/Edit SFM Transaction tab, value displayed
in the Name field
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Feature Context Master Text

SFM SFM Section
Title

SFM Designer screen, Screen Designer tab, value displayed in the Title
field of the Properties pane displayed for each header and child section
in SFM Page Layout (Properties for Section & Properties for Details sec-
tions)

SFM
Search

Search Res-
ult Section
Description

SFM Search configuration screen, Search Configuration section,
Description column

SFM
Search

Search Res-
ult Section
Title

SFM Search configuration screen, Search Configuration section, Result
Section Title column

SFM
Search

SFM Search
Description

SFM Search configuration screen, General Info tab, Description field

SFM
Search

SFM Search
Name

SFM Search configuration screen, General Info tab, Search Title field

SFM Wiz-
ard

Wizard
Description

SFM Wizard configuration screen, General Information tab, Descrip-
tion field

SFM Wiz-
ard

Wizard
Name

SFM Wizard configuration screen, General Information tab,Wizard
Title field

SFM Wiz-
ard

Wizard Step
Confirmation
Message

SFM Wizard configuration screen, Manage Wizard Steps tab, Con-
firmation Message field

SFM Wiz-
ard

Wizard Step
Description

SFM Wizard configuration screen, Manage Wizard Steps tab, Descrip-
tion field

SFM Wiz-
ard

Wizard Step
Name

SFM Wizard configuration screen, Manage Wizard Steps tab, Title field

Data Model – Key Details

Object

Name

Field

Name
Remarks

ServiceMax
Tag

Language The language identifier for the translation. It is the same as in Sales-
force, and is associated with the Language picklist displayed in the Man-
age Translations screen. More details about this can be found in a later
section of this help document.
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Object

Name

Field

Name
Remarks

ServiceMax
Tag

Tag Con-
text

Feature area in which a particular string is defined. This is displayed in
the Context column of the Manage Translations screen. More details
about this can be found in a later section of this help document.

ServiceMax
Tag

Tag Text Automatically set to the first 255 characters of the Tag Value. Used for
internal purpose.

ServiceMax
Tag

Tag
Value

The translation of the string. This is displayed in the Text column of the
Manage Translations screen.

ServiceMax
Tag

Tag
Value

The unique internal identifier for a translatable string. For labels and
messages stored in fields of length up to 255 characters (for example,
SFM Transaction Name and Inventory Process Name), the label/mes-
sage itself is used as the key, after replacing the spaces in the message
with underscores.

For labels and messages stored in fields of length above 255 characters
(for example, SFM Transaction Description, SFM Wizard Description, and
SFM Page Help Text), the ID of the specific process/page layout is con-
catenated with ‘_DESC’ / ‘_PAGEHELP’ and the concatenated string is
used as the key.

ServiceMax
Processes

Tag Keys List of Tag Keys associated with an SFM Transaction, SFM Wizard, SFM
Search, or Inventory Process. The list entries are separated by a semi-
colon. This field is updated when the Manage Translations screen is
launched.

Access and Permissions

Actions User Permissions Needed

To view trans-
lations:

"Read" on ServiceMax Tag, ServiceMax Processes, ServiceMax Config Data,
Page Layout, Page Layout Details

To create trans-
lations:

"Create" on ServiceMax Tag and “Update” on ServiceMax Processes

To edit trans-
lations:

"Update" on ServiceMax Tag

To delete trans-
lations:

"Delete" on ServiceMax Tag
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Managing Translations Using Manage Translations Screen
Use the Manage Translations screen to define, update, and delete translations for the
required strings interactively.

Sample steps to do these are as follows:

1. Click Home > ServiceMax Setup > App Administration > Translations > Go.

The Manage Translations screen displays as shown below.

Figure 1: Manage Translations Screen

2. From the Language picklist, select the language for which you want to define trans-
lations (for example, French).

3. (Optional) From the Process Type picklist, select the required type (for example,
SFM Transaction).

4. (Optional) From the Process Name picklist, select a process name (for example,
Manage Work Order Lines - Usage).

5. (Optional) Enter any required keyword in the Search For Master Text field.

6. Click the Get Translations button.
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The labels and messages matching the search criteria display as shown below.

Figure 2: SFM Transaction Labels & Messages

Note: When you launch this screen after translations have been defined,
the Text column will show the existing translations.

7. (Optional) Enter any keyword(s) to filter the search results on the data displayed in
any of the columns.

8. (Optional) Select the required page size to display fewer or more records per page.

9. In the Text field, enter the translation in the selected language, and then click Save.

10. If you want to remove any existing translation(s), blank out the Text field, and then
click Save.

11. If you have updated some translations but not yet saved them, and want to roll back
your changes, click Reset.

Managing Translations Using Salesforce Dataloader
To define or update in bulk the translations of strings supported by the ServiceMax Trans-
lation Workbench for any language, use the Salesforce Dataloader (
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https://dataloader.io). The following sections describe the procedure for defining and
updating translations. The language codes for the languages supported by the ServiceMax
application are given in the table below. Use these when defining or updating translations.

Language Language Code

English en

German de

Spanish es

French fr

Italian it

Japanese ja

Korean ko

Chinese (Traditional) zh_TW

Chinese (Simplified) zh_CN

Portuguese (Brazilian) pt_BR

Dutch nl_NL

To define new translations:

1. Export the master list of translatable strings from the ServiceMax Tag object by
retrieving Language, Tag Key, Tag Text, and Tag Value fields of all records which
meet the condition Language = ‘Master’. Do this by creating a NEW TASK of type
EXPORT.

The SOQL Query for this is given below:

SELECT SVMXC__Language__c, SVMXC__Tag_Key__c, SVMXC__Tag_Text__c, SVMXC__Tag_Value__c

FROM SVMXC__ServiceMax_Tags__c WHERE SVMXC__Language__c = ‘Master’
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Note: If you select the fields and the filter condition from the Salesforce
Dataloader UI to generate the SOQL Query automatically, select English
as the Language field value in filter condition and then edit the SOQL
Query to replace English with Master.

If you copy the SOQL Query given above and paste it into the SOQL
Query text box in the Salesforce Dataloader UI, delete and retype the
single quote surrounding the Language field value Master before pro-
ceeding. This is to avoid query error.

The Tag Text field is included in the query for the review of the translation
with the master text. This is because the translation needs to be entered
in the Tag Value column which stores the master text, and the Tag Text
field stores the first 255 characters of the master text.

2. In the exported .csv file, replace the value of all the records in the Language column
with the language code of the required language, as per the table above. For example,
to define new translations for the French language, replace Master with fr.

3. In the above .csv file, enter the translations in the Tag Value column, and then save
the updated file.

4. Import the saved file, by choosing Insert as the Operation. Do this by creating a
NEW TASK of type IMPORT.

To update existing translations:

1. Export the existing translations from the ServiceMax Tag object by retrieving Id, Tag
Key, and Tag Value fields of all records which meet the condition Language =
‘<language code of the required language>’. Do this by creating a NEW TASK
of type EXPORT.

A sample SOQL Query for retrieving the existing French translations is given below:

SELECT Id, SVMXC__Tag_Key__c, SVMXC__Tag_Value__c FROM SVMXC__ServiceMax_Tags__c WHERE

SVMXC__Language__c = ‘fr’
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Note: If you select the fields and the filter condition from the Salesforce
Dataloader UI to generate the SOQL Query automatically, select the
required language as the Language field value in the filter condition, and
then edit the SOQL Query to replace the language with the language
code.

If you copy the SOQL Query given above and paste it into the SOQL
Query text box in the Salesforce Dataloader UI, delete and re-enter the
single quotes surrounding the Language field value fr before proceeding.
This is to avoid a query error.

2. In the exported .csv file, update the translations in the Tag Value column as
required, and then save the updated file.

3. Import the saved file, by choosing Update as the Operation. Do this by creating a
NEW TASK of type IMPORT.

Known Limitations
1. When search returns more than 1000 translatable strings, only 1000 strings are dis-
played. So, if the number of strings displayed is 1000 as indicated by the count dis-
played in the search results section, the search has to be refined to keep the search
results returned to less than 1000 strings.

2. When a translatable string, that is, Master Text, stored in a field of length 255 char-
acters or less is updated, the existing translation(s), if any, for the previous string
value are not associated with the new string value.
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IPAD CONFIGURATION

Overview
ServiceMax has two applications for iPad, ServiceMax Enterprise App and ServiceMax
Mobile App. The ServiceMax Enterprise App works only in connected mode. The Ser-
viceMax Mobile App works in both connected and disconnected modes. Both of these iPad
Apps are specialized applications that provide targeted features to technicians on the field.

For both these iPad Apps, you can configure the user permissions for SFM View and Stan-
dalone Create transactions, the appearance of the Service Report, and configuration set-
tings. For the ServiceMax Mobile app, you can configure download criteria, frequency of
synchronization, and limits that may apply to the size of offline data. These configurations
are applicable for iPad users only. Apart from these, you can also configure permissions for
SFM Searches.

SFM Search Configuration applies to both ServiceMax Suite and ServiceMax Mobile App
and can be found in the section Setup > Configuration > Advanced Configuration >
SFM Search > Custom Searches > Manage Profile Access Permissions.

Access and Permissions

Actions User Permissions Needed

Actions User Permissions
Needed:

"Read" on ServiceMax Processes and ServiceMax Config Data

To edit iPad Settings: "Create" and "Update" on ServiceMax Processes and Ser-
viceMax Config Data

Setting Up SFM Permissions for iPad
This feature is currently applicable only for iPad deployments. Use this feature to define
which ServiceMax Group Profiles have access to View and Standalone Create SFM pro-
cesses.
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To set up SFM permissions for iPad:

1. Click Home > ServiceMax Setup > Mobile & Offline > SFM iPad Permissions.
The screen as shown below appears.

Figure 1: Configure SFM Permission for View & Standalone Processes

2. Select the ServiceMax Group Profile for assigning access to SFM transactions. If
required, select an object to list SFM transactions for that object. The default selec-
tion—ALL— lists the Standalone Create and View processes of all the objects. Select-
ing any particular object lists the transactions related only to that object.

3. In the above screen, all the available processes for the selected object appear on the
left. The assigned processes are in the right. You can move the applicable trans-
actions from left to right.

4. Click Save.

5. Click Back To Setup Home to return to the ServiceMax setup home page.
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Note: If an SFM View or Standalone Create transaction is not assigned to any
ServiceMax Group Profile, all profiles will have access to that SFM transaction.

Setting up iPad Client (Service Report Configuration)

To set up the iPad Client:

1. Click Home > ServiceMax Setup > iPad Settings link to launch the Setup iPad Cli-
ent screen as shown below.

Figure 2: Set Up iPad Client Screen

Under the Report Header section:

2. In the Report Title field, enter a suitable title for the report.

3. In the Address Type field, select the desired address type of the Account to be prin-
ted on the report.

4. Checking the Show Contact Phone checkbox adds the Contacts business phone
number to the report.

5. Checking the Show Problem Description and Show Work Performed checkboxes
adds the respective fields to the report.

Under the Report Lines section:
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6. Checking the Show Parts checkbox adds the details of the parts consumed to ser-
vice the Work order to the report.

7. The Show Discount % checkbox controls if the details of the discount given on the
parts consumed should be displayed in the report. This setting works in conjunction
with the Show Parts setting and the discount details will be shown on the report only
if the former’s checkbox is also checked.

8. Checking the Show Labor checkbox adds the details of the various labor activities
undertaken for servicing the Work Order to the report.

9. The Show Unit Price checkbox controls if the price information for each unit of parts
consumed and the per hour rate for labor are to be displayed on the report. This set-
ting also works in conjunction with the Show Parts and Show Labor checkboxes
and will be effective only if either one of them is checked.

Under the Select Additional Fields To Be Displayed in the Report section:

10. You can add up to a maximum of 10 additional fields to be displayed on the report.

Note: Rich text fields are not supported in the Service Report.

11. Click Save to save the changes made.

12. Click Reset to discard your unsaved changes and to continue to stay on the same tab
to make further changes.

13. Click Back To Setup Home to discard your changes and return to the Setup Home
page.

Mobile Configuration
Click Home > ServiceMax Setup > Mobile & Offline > Mobile Configuration. The
ServiceMax Mobile Configuration screen displays (see figure below). Use this feature to
configure how your end users will use ServiceMax Mobile Client on iPad.
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You can configure data download criteria, frequency of synchronization, limits that may
apply to the size of offline data, and more.

Figure 3: ServiceMax Mobile Configuration

To configure the options for ServiceMax Mobile:

1. In the ServiceMax Mobile Configuration screen, select a profile from the Select Pro-
file picklist.

2. If you want to clone a mobile configuration from a profile, select a profile from the
Clone Mobile Configuration From picklist.

3. In the SFM Transactions tab, select either an Object from the Filter List By
Object picklist or a Type from the Filter List By Type picklist.

4. Click the Process ID to display all the objects used in that SFM process (see figure
below). 

Figure 4: Filter List by Object

Mobile Configuration 515



5. Click the Download Criteria tab.

6. In the Download Criteria tab area, check the Select checkbox and select an Object
from the Object Name picklist as shown in the figure below.

Figure 5: Download Criteria

7. Select criteria from the Download Criteria picklist.

8. Select the ownership type from the Ownership Type picklist.

9. To add criteria, click the Add link in the Download Criteria area.

a. Using the Expression Builder, enter the Expression Name and Expression ID.

b. Select the Field Name and Operator from the appropriate picklists.

c. Enter a value in the Value text box.

d. Add or Delete rows using the appropriate icons.

e. If necessary, enter an expression in the Advanced Expression text box.

f. Click Save in the expression section.

g. Click Save at the top of the page.

10. If necessary, click the Add button to add additional objects, and click the Delete but-
ton to delete objects.

11. To configure synchronization settings, click the Synchronization Settings tab (see
figure below).

Note: You can configure scheduled sync for Data synchronization in Ser-
viceMax Mobile for Laptops.
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Figure 6: Synchronization Settings Tab

Note: You can configure scheduled sync for Data synchronization in Ser-
viceMax Mobile for Laptops.

12. In the Synchronization settings for Calendar events and tasks section:

a. Select when synchronization occurs for events, tasks, and related data for the
iPad in the picklist: Automatically When Online or At Regular Intervals. If
you select At Regular Intervals, enter the number of interval minutes you want
the scheduled synchronization to occur. The default is Automatically When
Online.

b. Enter the number of days to retrieve events and tasks for the next number of
days. The default is 10 days.

c. Enter the number of days to delete events and tasks older than the number of
days. The default is 10 days.

13. In the Other Settings section:

a. Enter the time interval in minutes to synchronize application data (includes
events, tasks, and related data). Set the minutes to 0 to avoid synchronization at
regular intervals. If this is done, synchronization has to be manually initiated from
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the Sync screen in the iPad whenever needed. The default is 600 minutes or 10
hours.

b. Enter the time interval in minutes to synchronize configuration data for the iPad.
The default is 1200 minutes or 20 hours.

c. Select what happens when there are data synchronization conflicts (Ask User,
Online Takes Precedence,Mobile Takes Precedence) from the picklist. The
default is Online Takes Precedence.

d. Enter the time interval in hours for the purge data prompt on the iPad in the Purge
data once every text box. The default is 168 hours or 7 days. If it is set to 0, the
user will not be prompted to purge data.

e. Enter the purge criteria for the purge function in non-event window based data
older than a number of days. The default is 10 days. If it is set to 0, it is taken as 1
day.

Note: All events and event related records are purged automatically if
they are outside of the event window.

14. Click the Other Settings tab to select Chatter Download, Knowledge Base, Loca-
tion Tracking, and API Access for Laptops settings (see figure below).

Figure 7: Other Settings
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Note: Accounts and Products cannot be configured as advanced download cri-
teria.

15. Click the Advanced Download Criteria tab to define download criteria for an object.
(You can configure which type of attachments are available on a mobile device based
on attachment attributes (such as File Name and Content Type)).

16. Define download criteria for each object. See figure below.

17. In the Object Name area:

a. Select download criteria from the Advanced Download Criteria picklist (File-
name_contains).

b. Select the ownership type (My Records, All Records).

c. Use the Edit/Add links to edit existing criteria or add a row to create additional cri-
teria.

Figure 8: ServiceMax Mobile Configuration

Note: Advanced download criteria only works on records related to
events in the event window.
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18. Select a field name from the Field Name picklist.

19. Select anOperator (for example, Equals, Contains).

20. Enter a value (for example, PDF or PNG) in the Value text box.

21. Enter an Advanced Expression if necessary. For example, (1 AND (2 or 3)).

22. Click Save.

Note: The criteria described in the instructions above and shown in the
example figure below will download only file extensions that contain “PDF &
PNG."

Figure 9: ServiceMax Mobile Configuration Screen

These attachments get downloaded only for those records of the configured object which
are associated with an Event. For example, if the Advanced Download Criteria condition
defined for an Attachment is “Parent Id Equals Work Order Id,” attachments will be down-
loaded for Work Orders which are associated with Events.
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File Names are designated by file extensions. This feature is useful when it is necessary to
filter which attachments are available to an end user. Administrators can configure this fea-
ture in the Advanced Download Criteria tab in the Mobile Configurationmodule.
Examples of file extensions are listed in the table below.

File Names and File Extensions

Example File Types Example File Extensions

Images jpg, jpeg, bmp, png, tiff, gif, dib, ico, cur, xbm

Video mov, m4v, mp4, 3gp

Presentations ppt

PDF pdf

Documentation doc, docx

Spreadsheet xls, xlsx

ServiceMax Enterprise Configuration Settings
Click Home > ServiceMax Setup > App Administration > Configuration Profiles to
launch the screen below.

Figure 10: Org-wide Configuration Settings

To configure iPad Client settings for GPS location tracking and fre-

quency:

1. In the Select Module picklist, select ServiceMax iPad Client.

2. In the Select Submodule picklist, select General.

3. Select the active org-wide custom profile, and then click Edit.
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The settings for ServiceMax Enterprise appear as shown in the figure below.

Figure 11: Enter Values For Settings (ServiceMax Enterprise)

Note: Do NOT edit the values of the settings for submodule Service Report
using this Edit Configuration Profile–Enter Values For Settings page. The Ser-
vice Report options need to be configured through the Setup iPad Client page
only.

ServiceMax Mobile Configuration Settings
Click Home > ServiceMax Setup > App Administration > Configuration Profiles to
launch the screen below.

Figure 12: Org-wide Configuration Settings

Select an active profile and click the Edit button (see figure below).

Figure 13: Edit Configuration Profile
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Configuring Calendar Settings
Events shown in the Timeline Calendar for Mobile for Laptops, and in the Schedule of the
Calendar for Mobile for iPad, are color-coded. Events with a Work Order or Case attached
are color-coded based on their priority (High, Medium, or Low).

To configure iPad Client or ServiceMax Mobile for Laptops settings

for Calendar:

1. In the Select Module picklist, select ServiceMax iPad Client.

2. In the Select Submodule picklist, select Calendar. The Calendar settings for Ser-
viceMax Mobile are shown in the figure below.

Figure 14: Enter Values for Settings (ServiceMax Mobile Calendar)

To configure iPad Client settings for Synchronization:

1. In the Select Module picklist, select ServiceMax iPad Client.

2. In the Select Submodule picklist, select Synchronization.
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The Synchronization settings for ServiceMax Mobile are shown in the figure below.

Figure 15: Enter Values For Settings (ServiceMax Mobile Synchronization)

Note: Do NOT edit the values of the settings for submodule Service Report
using this Edit Configuration Profile-Enter Values For Settings page. The Ser-
vice Report options need to be configured through the Setup iPad Client page
only.

Service Report Logo Change on the Home Page

To change the logo on a Service Report in Salesforce.com:

1. Create an image file with the following logo.
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Name = ServiceMax_iPad_CompanyLogo.

Format = PNG only.

Maximum dimensions allowed = 600 (width) x 250 (height).

Minimum resolution required = 72 dpi.

2. Upload the file to the ServiceMax for iPad folder under Documents. Create the
folder if it does not already exist.

Setting Up Chatter Feeds
There are three main configuration areas for setting up Chatter feeds on Products in the
iPad application as described below: Salesforce settings, Troubleshooting setting, and iPad
Chatter settings.

To configure Salesforce settings:

1. Access Salesforce online through a browser.

2. Go to Salesforce Settings.

3. Go to App Setup > Customize > Chatter >Feed Tracking.

4. From the list of objects, select Product.

5. Check the Enable Feed Tracking checkbox.

6. Check the checkbox next to any field that you want automatically reported on in the
Chatter field when a change occurs in that field.

To configure Troubleshooting settings:

1. Access Salesforce online through a browser.

2. Go to ServiceMax Setup.

3. Go to Service Flow Manager > SFM Transaction & Docs Designer.

4. Click Go.

5. Select work order view transaction under Custom SFM Transactions that is used in
your implementation.

6. Go to the Screen Designer tab.
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7. Click anywhere in the white space around the Save,Quick Save,New, Reset, and
Delete icons (this brings up the Properties for Page settings).

8. Check the checkbox next to Enable Troubleshooting.

To configure iPad Chatter settings:

1. Access Salesforce online through a browser.

2. Go to ServiceMax Setup.

3. Go toMobile & Offline > Mobile Configuration.

4. Click Go.

5. Select the Profile that is used for your mobile user.

6. Click the Settings tab.

7. Update the Chatter download settings to meet your needs.

To add your photo to the product chatter feed:

1. In Salesforce, create a new folder under Documents called ServiceMax for iPad.
Select the This folder is accessible by all users setting.

2. Create a new document with name as your fully qualified user name (for example,
yourlogin@yourcompany.com).

3. Upload your photo in PNG format. Note that only PNG format is supported.

4. Save it in the folder created in Step 1.
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MANAGE SERVICEMAX OFFLINE PROFILES

Overview
ServiceMax Offline profile represents a collection of datasets and their attributes, and can
be associated with one or more Salesforce profiles. An offline profile not only drives the
end user experience in ServiceMax Offline Client, but also the type and collection of data
that is available to the user in Offline mode. An unlimited number of Offline profiles can be
created for an organization.

Note: The default offline profile is configured to only include work orders.

Offline Configuration Model
A clear understanding of various configuration aspects of ServiceMax helps you configure
the offline application more efficiently. The picture below illustrates the relationship
between various logical entities involved in ServiceMax configuration and how they drive
end user experience. Note that these are logical, not physical entities.
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Figure 1: ServiceMax Offline Configuration Model

Access and Permissions

Actions User Permissions needed

To view offline pro-
files:

"Read" on ServiceMax Processes and ServiceMax Config. Data

To create or edit
offline profiles:

"Create" and "Edit" on ServiceMax Processes and ServiceMax Config.
Data

To delete offline
profiles:

"Delete" on ServiceMax Processes, ServiceMax Config. Data, Offline
Object, Offline Dataset Expression, and Offline View
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Offline Client Configuration Settings

Set-

ting

Name

Default Value

SET002 Maximum length allowed for SOQL queries made from ServiceMax Offline. Before
increasing the value of this setting, contact Salesforce to get the limit increased for your
Org.

Click Home > ServiceMax Setup > Mobile & Offline in the Manage Offline Profiles
area, click the Go button to view Offline Profile home page as shown below:

Figure 2: Offline Profiles Home Page

In the Offline Profiles screen:
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All the available Offline Profiles are listed.

Click New to create a new offline profile from scratch.

Click Edit to edit datasets in an existing offline profile.

Click Clone to create a copy of an existing offline profile with all its datasets.

Click Delete to delete an offline profile and its datasets.

Click Activate to make an offline profile available for use. You can associate Sales-
force profiles with Active offline profiles only.

Click Deactivate to remove an offline profile from use but still keep it for the admin-
istrator's reference.

Click Back to Setup Home to return to the ServiceMax home page.

Offline Profile Fields

Field Description

Profile Name Name of the offline profile.

Description Detailed description of the offline profile.

Active Indicates if this profile is Active or not. Users with inactive profiles will
not be allowed to login to Salesforce or synchronize data from ServiceMax
offline client.

Enable Task Indicates if users of this profile require the task feature to be enabled in
Offline client. If unchecked, task functionality is disabled.

Enable Calendar Indicates if users of this profile require the calendar feature to be enabled
in offline client. If unchecked, calendar functionality is disabled.

Enable Activity
Tracking On

List of offline activities that should be tracked automatically for users of
this profile.

Access Permission Salesforce profile linked to the offline profile.

Remove Events and
Tasks Older Than

Number of days for removing events and tasks. (Default is 10 days).

Remove Unused
Related Records
Older Than

Number of days for removing unused related records (other than events
and tasks). Default is 30 days.
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Field Description

Validate User Cre-
dential Every

Number of days for user credential validation.

Allow API Access Indicates if users have access to API.

Authentication Key
For

Designates an Authentication key for a user.

Creating/Editing Offline Profiles

To create or edit an offline profile:

1. Click Home > ServiceMax Setup > Mobile & Offline in the Manage Offline Profiles
area, click the Go button. The Offline Profile screen displays.

Figure 3: Offline Profiles

2. Click New or select an existing profile by checking the Select checkbox in the list and
then clicking Clone. Alternatively, to edit an existing profile, select the profile and
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then click Edit. New and Clone modes display the same screen as shown below.

Figure 4: Manage Offline Profiles Screen

3. Enter a unique profile name. Remember that the profile name must be alphanumeric
and can contain spaces.

4. Enter a Profile Description.

5. Enter the number of days for removing events and tasks in the Remove Events And
Tasks Older Than text box. If you do not specify the number of days, the default is
10 days.

6. Enter the number of days for removing unused related records (other than events and
tasks) in the Remove Unused Related Records Older Than text box. If you do
not specify the number of days, the default is 30 days.
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7. In the Validate User Credential Every text box, enter the number of days a user
must validate his or her credential.

Note: You must define the number of days a user will have access to Off-
line Client application via the Validate User Credential Every check-
box. This login validity is required for a user to access the Offline Client
after his or her login validity has expired. If you have not set up Validate
User Credential for a certain number of days, the default is 9999 days.

8. To activate the profile, check the Active checkbox.

9. To activate tasks, check the Enable Task checkbox.

10. To enable the calendar, check the Enable Calendar checkbox.

11. Check the Allow API Access checkbox to enable users to generate an API token.
This token allows external applications to use ServiceMax Offline data access API.

12. Obtain an Authentication Key for a user. This is step not needed for setting up an off-
line profile. This step is required if a user is locked out of the Offline Client application.
If such a scenario occurs, he or she must request an Authentication Key from you to
login to the Offline Client application. Follow the substeps below to generate an
Authentication Key.

a. Select a user from the appropriate picklist.

b. Click the Generate Key button.

c. A unique Authentication Key displays in the pop-up window. Click OK.

13. In the Offline Activities section, select the activities you want to track for users of this
profile.

14. In the Offline Auto-Sync Options area, select an option from the Sync Duration pick-
list (minutes, hours, days) to define the upload and download frequency of syn-
chronization.
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Note: The maximum duration is 24 days. If you exceed the maximum
number of days, synchronization will still occur, but you will see an error
message in the Offline Client application prompting you to change the dur-
ation in the ServiceMax Suite application and to download configuration.

15. In the Sync Duration text box, enter the number of corresponding minutes, hours, or
days you would like the Offline Client to prompt synchronization. The default setting
for Sync Duration is one day.

16. Check the Sync Data On Login checkbox if you would like the Offline Client to per-
form synchronization upon launching ServiceMax Offline. If you do not check this
checkbox, the ServiceMax Offline Client will not perform an automatic syn-
chronization upon launch. By default, the Sync Data On Login checkbox is checked.

17. In the Access Permission section, select the Salesforce profiles whose users will need
offline access. A Salesforce profile can be linked to one Offline Profile only. If the selec-
ted Salesforce Profile is already linked to a different offline profile, you will get a warn-
ing message. Upon saving, the selected Salesforce profile is automatically unlinked
from any other offline profiles it is linked to.

18. To save and continue with creation of datasets for the offline profile, click Quick
Save.

19. To save the offline profile and return to the previous screen, click Save. The dataset
is displayed in the Edit mode as shown below:

Figure 5: Manage Offline DataSets Screen

20. To create a new dataset, click Add Dataset.

21. To edit an existing dataset, click Edit.

22. To delete one or more datasets from a profile, check the required records using the
checkbox and then click Delete.

23. To specify the default tab order for users of this profile, click Tab Order. In the screen
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that follows, use the button to arrange the tab order for the datasets and then click
Done.

Figure 6: Edit Tab Order Screen

See Manage Datasets for more information about datasets and their attributes.

Deleting Offline Profiles  

Note: Active offline profiles cannot be deleted. Also, offline profiles that are
linked to Salesforce profiles cannot be deleted.

To delete one or more profiles:

1. Select the profiles in the profiles list to be deleted by checking their Select checkbox.

2. Click Delete. The selected rows are deleted and the profiles list is refreshed.

See Also:

Manage Datasets

Manage Document Templates

Sample Offline Configuration
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MANAGE DATASET

Overview
A dataset defines the criteria used to download object data for ServiceMax offline users. A
dataset typically represents high-level Salesforce objects such as Account, Contact, Work
Order, and so on. Datasets can be defined for standard and custom objects.

Access and Permissions

Action User Permissions needed

To view datasets: "Read" on ServiceMax Config Data, Offline Object, Offline Dataset Expres-
sion, and Offline View

To create or edit
datasets:

"Create" and "Edit" on ServiceMax Config Data, Offline Object, Offline Data
Expression, and Offline View

To delete data-
sets:

"Delete" on ServiceMax Config Data, Offline Object, Offline Data Expres-
sion, and Offline View

From the Manage Offline Datasets section of an Offline Profile record, click Add Dataset
or Edit by choosing the existing data set. The Define Dataset screen appears with four sec-
tions as described below.

General Information
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Figure 1: Define Dataset - General Information Section

The General Information section is used to identify the object for which you intend to
define the dataset. All Salesforce object names available for use are displayed including
custom objects created for your ServiceMax implementation.

Download Criteria

Figure 2: Define Dataset - Download Criteria Section

In this section, you can enter basic and advanced criteria for selecting data from the
object. The criteria can be applied on any field in the object selected above. For date fields,
you can also use special date literals such as THIS WEEK or TODAY that are supported by
Salesforce query language. In addition, you can use advanced criteria to group the con-
ditions.

Manage Dataset
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Lookup to Related Objects

Figure 3: Define Dataset - Related Objects Section

This section lists all the objects referenced by the selected object. When downloading data
for this dataset, you can select to include the related records even if the related object
does not have a dataset definition or if the related record does not match the dataset
download criteria.

Default View in Offline

Figure 4: Define Dataset - Default Offline View Section

In this section, if the object has a tab enabled, you can select the columns displayed by
default in the offline tab.
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Configuration Settings
Configuration settings are managed by your ServiceMax administrator using the Ser-
viceMax Setup screens.

Signature Capture Settings

These settings provide options for managing PDF attachments for signature capture
reports as listed below. These settings are located under the module, ServiceMax Offline
and the sub module, Attachment. See figure below.

Figure 5: Signature Capture Settings

Setting ID SET001: The option to save or not save reports with signatures as PDF
attachments.

Set this option to True if you want the report with the signature saved in PDF
format and attached to the parent record.

Set this option to False if you want the signature integrated into the report, but
not saved as an attachment.

Setting ID SET002: The option to delete unsynched duplicate attachments.

Set this option to True to delete any existing unsynched attachments (with the
same name) when a new attachment is created.

Set this option to False if you do not want duplicated attachments deleted.

Attachment Size Setting

This setting provides an option to set the maximum size of attachments allowed in the Ser-
viceMax Offline Client. This setting is located under the module, Common and the sub mod-
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ule, Global Settings.

Figure 6: Attachment Size Settings

Setting ID GBL012: The option to set the size limit for attachments in kilo bytes.
See figure below.

The default size limit for attachments is 2048 KB.

Manage Offline Profiles Settings

This setting indicates the maximum size of the Offline database. See figure below.

Figure 7: Manage Offline Profile Settings

SET001: The option to set the maximum size of the Offline Database in MB per your
volume of data.

The minimum default value is 256 MB.

The maximum default value is 4000 MB.

Dataset Fields

Field Description

Object Name Name of the Salesforce object this dataset represents.

Ownership
Limit

Scope of records to download to ServiceMax offline. My Records will download
only records owned by the offline user. All Records will download all the records
accessible to the offline user.
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Field Description

Allow Upload
Data from Off-
line

Indicates if data can be modified for this dataset in Offline client and can be
uploaded to ServiceMax online. If unchecked, offline users can only view data
from this dataset.

Allow Tab in
Offline

Indicates if this dataset requires a tab in Offline.

Set as Home
Tab

Indicates if this dataset’s tab will be the home tab or not. This can be enabled
for only one dataset in an Offline profile.

Include Child
Objects

Indicates if the objects child objects, if applicable, need to be included in the
dataset. Child objects can be included through their parent objects only.

Field Field from the object to be used in download criteria.

Operator An expression operator to be applied on the field value. For example, Equals
will perform an exact match, Contains will perform a wild card match, and so
on.

Value A specific value to which the field data is matched. For date values, you can use
Salesforce special literals such as TODAY, THIS WEEK, NEXT WEEK,and so on.

Advanced Fil-
ter Criteria

A logical expression that represents the combination of download criteria. For
example, if there are 4 criteria entered, you can use (1 AND 2) OR (3 AND 4)
here

Salesforce
Object Name

Name of the Salesforce object that is referenced in the selected dataset.

Download
Related
Record

Indicates if data for this related lookup field must be downloaded into offline
along with this dataset.

Retain Old
Unused
Related
Records

Check box for the option of retaining old, unused related records.

Creating/Editing Datasets

To create a new dataset:

1. Click Add Dataset from the Manage Datasets section of an offline profile. Altern-
atively, to edit an existing dataset, check the dataset using the checkbox in the
record and then click Edit.

Manage Dataset
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2. Select the Object Name and Ownership Limit. If an object has child objects, you
can optionally include the child objects in the dataset by checking the Include Child
Objects checkbox. Child objects can be included through their parent objects only.

3. Based on the dataset requirements, indicate if this dataset requires a tab in Offline cli-
ent, if the tab should be set as the Home tab, and if data can be uploaded for this
dataset from offline.

4. If you want to Allow API access at the object level, check the Allow API Access
checkbox.

5. If additional download criteria are applicable, enter the criteria in the Download Cri-
teria section. For example, you may want users of this profile to download only
Accounts in a certain state or city.

6. To add more criteria rows, click Add Row. A new empty row will be appended to the
bottom of the criteria list.

7. To delete one of the existing criteria rows, click Delete Row corresponding to the
row.

8. Use Advanced Filter Criteria to build an advanced expression of download criteria.

9. To retain old, unused related records, check the Retain Old Unused Related
Records checkbox.

10. In the Related Objects section, select the lookup (reference) records that you wish to
download with this dataset. For example, if you are defining a dataset for Work
Orders, you may want to include Case, Account, Contact and Installed Product as
related records. It is recommended to include any lookup fields that are mandatory in
the user’s page layout. If Case is a mandatory field on the Work Order page layout,
make sure to include Case in the Work Order dataset.

11. If you have enabled an offline tab for this dataset, in the Default Offline View section,
select object columns that form the default tab view. If no columns are selected here,
the default view in offline will show Name, Created Date, Created By, Last Modified
Date, and Last Modified By.

12. To save and continue modifications to the same dataset, click Quick Save.

13. To save the dataset and return to the offline profile screen, click Save.
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Note: Some standard objects such as Cases and Opportunities are available
for use in Dataset definition only if allowed by your ServiceMax license. Please
contact your ServiceMax administrator to know the type of license used by
your organization.

Deleting Datasets

To delete one or more datasets:

1. Select the records to be deleted by checking their checkbox.

2. Click Delete and then click OK when prompted for confirmation. The selected data-
sets will be deleted and the dataset list will be refreshed.

See Also:

Manage Datasets

Manage Document Templates

Sample Offline Configuration

Report Builder
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546 Deleting Datasets



MANAGE DOCUMENT TEMPLATES

Overview
ServiceMax client supports the generation of output documents. For example, offline users
can generate a Service Report from the Work Order screen or a Customer Parts Order
Report from Parts Order screen. The generated documents can be printed, saved in many
formats, or emailed. These reports are generated using predefined document templates
uploaded to Salesforce by ServiceMax administrators, and distributed to offline users
through configuration download.

Building Document Templates
The ServiceMax offline package contains sample templates for Service Report and Cus-
tomer Report. This can be launched from the Work Order screen and Parts Order Screen in
Offline. To customize these template to suit your organization’s needs or to build new tem-
plates, you need one of the following tools:

Microsoft Visual Studio 2008 – an Integrated Development Environment (IDE) from
Microsoft

Crystal Report Designer – application used to design and generate reports

In addition, you also require a good understanding of ServiceMax object model and rela-
tionships and a working knowledge of MySql database and SQL (Structured Query Lan-
guage).

For a quick overview of building the report templates using Visual Studio 2008 or Crystal
Report Designer, click here. If you need further assistance or need more information,
please contact ServiceMax Professional Services.

Deploying Document Templates
Once you have built a document template and tested it on your offline database, follow
these steps to package and deploy it to your users.
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1. Create a zip that contains the .rpt file and any other files such as images that the
report needs. The name of the zip file should match the display name of the template.
For example, if the template name is Germany Service Report, the zip file would be
"Germany Service Report.zip".

2. Login to Salesforce online and then click the Documents tab.

3. Under the Folder ServiceMax documents, select the folder into which you want to
upload your template. If the template will only be used by a subset of your offline
users, create a new folder and grant permission to the folder based on Salesforce Role
or Public Groups.

4. Click New Document. The following screen appears.

Figure 1: Upload New Document Screen

Manage Document Templates
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5. Enter the Document Name. When users view a record in Offline client, this name
appears in the list of available templates.

6. Enter a detailed description.

7. In Keywords, enter the Salesforce API name of the object this template is associated
with. For example, if this template generates a service report fromWork Order
object, enter "SVMXP__Service_Order__c."

8. Click Browse and then select the ZIP file you created in Step 1.

9. Click Save.

10. To download and use this template, instruct your offline users to check the Down-
load Configuration checkbox in the Offline login screen. The template will be down-
loaded to their desktop. When the users view any record from the object associated
with this template, the list of templates appear as shown below.

Figure 2: List of Templates

See Also:

Manage Offline Profiles

Manage Datasets

Sample Offline Configuration

Report Builder
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SAMPLE OFFLINE CONFIGURATION

Overview
This section shows an example of how ServiceMax Offline can be configured to meet data-
set and access requirements of a sample company ABC, Inc.

Requirements
ABC has two geographical divisions, Northwest and Northeast

Within each division, there are teams specializing in laptop and desktop services

The service management wants Offline access only to the field service technicians

Team Leads and service managers do not require offline access

Northwest service manager does not want Laptop technicians to have access to
Desktop products

Northwest service manager wants to know how frequently the technicians login and
logout of offline client

Northeast service manager wants technicians to see all products within the North-
east territory

Northeast service manager wants to know how frequently the technicians syn-
chronize data from offline client to ServiceMax online

Offline Profile Setup
To meet the above requirements, three ServiceMax offline profiles will be required as
shown below. Each profile dictates the scope of data visible to the technicians in the offline
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application.

Figure 1: Sample Profile Hierarchy

Offline Datasets

Offline Profile Datasets Download Criteria

NW Laptop Technicians Account All Records
Billing State Equals CA, OR, WA

Contact All Records
Mailing State Equals CA, OR, WA

Installed Product State Equals CA, OR, WA
Product Family Equals Laptop

Work Order My Records

Sample Offline Configuration
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Offline Profile Datasets Download Criteria

NW Desktop Technicians Account All Records
Billing State Equals CA, OR, WA

Contact All Records
Mailing State Equals CA, OR, WA

Installed Product State Equals CA, OR, WA
Product Family Equals Desktop

Work Order My Records

NE Northeast Technicians Account All Records
Billing state equals PA, NY, MA, NJ, NH

Contact All Records
Contact state equals PA, NY, MA, NJ, NH

Installed Product All Records
State equals PA, NY, MA, NJ, NH

Work Order My Records

Offline Activity Tracking

Offline Profile Activity Tracking

NW Laptop Technicians Login
Logout

NW Desktop Technicians Login
Logout

NE Northeast Technicians Start Synch
Cancel Synch

Offline Profile Access

Offline Profile Salesforce Profile

NW Laptop Technicians NW Laptop Technicians

NW Desktop Technicians NW Desktop Technicians

NE Northeast Technicians NE Northeast Technicians
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Note: All other ServiceMax users such as service manager, team lead, and dir-
ector will not have access to ServiceMax offline client.

See Also:

Manage Offline Profiles

Manage Datasets

Manage Document Templates

Report Builder
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REPORT BUILDER

Creating Report Template using Microsoft Visual Studio
2008
This section outlines the high-level steps involved in creating report templates using
Microsoft Visual Studio 2008.

To create report templates using Microsoft Visual Studio 2008:

1. Launch Microsoft Visual Studio 2008.

2. Click File > New Project to open the New Project window as shown below.

Figure 1: New Project Screen
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3. In the Templates section, clickWindows Forms Application, enter the name of the
project and the location of the project in the respective fields, and then click OK. This
opens the created project.

4. In the Solution Explorer section, right-click the project name, point to Add and then
click New Item. The Add New Item window appears as shown below.

Figure 2: Add New Item Screen

5. If you do not see the Solution Explorer section, on the View menu, click Solution
Explorer to view it.
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6. In the Categories section, click Reporting and then click Crystal Report in the Tem-
plates section. The Crystal Report Gallery window appears.

Figure 3: Crystal Reports Gallery Screen

7. Click As a Blank Project to go back to the project window.
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8. In the Field Explorer section, right-click Database Fields and then click Database
Expert. The Database Expert window appears as shown below.

Figure 4: Database Expert Screen

9. If you do not see the Field Explorer section, click the work area to view the Crystal
Report menu. In the Crystal Report menu, click Database Fields and then click Data-
base Expert.

10. Expand the Create New Connection folder by double-clicking it. A list of available con-
nection folders appear.
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11. Expand ODBC (RDO) folder by double-clicking it and then double-click Make New
Connection. The ODBC (RDO) window appears as shown in the figure below.

Figure 5: ODBC (RDO) Screen

12. In the ODBC (RDO) window:

a. Click Enter Connection String to enable the Connection String field.

b. In the Connection String field, enter Driver=MySQL ODBC 5.1 Driver-
;Server=localhost

c. Click Next to proceed. The following window appears, with Server and User ID
fields pre-populated with the correct values as applicable to your installation of
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MySql.

Figure 6: Connection information Screen

d. Enter the password (this will bemysql if MySql was installed by the ServiceMax
Offline application installer, with default values for User ID and password), select
svmx as the Database, and then click Finish.

13. Double-click Add Command to view the Add Command To Report window.

Figure 7: Add Command To Report Screen

Report Builder
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14. Write an SQL query to include the fields you want to appear in the report and then
click Create to open the Command Parameter window. Syntax for querying is given
below:

Select <field_names> from <object_name> where <object_name>_Pid={?<Parameter_Name >};

Figure 8: Command Parameter Screen

15. Enter the Parameter Name, select the Value Type as Number from the picklist,
enter a Default Value and then click OK. An Enter Values window appears.

16. Enter the Default Value and then click OK to test the created database connection.
If there is any error, the Crystal Report screen appears with error information.

17. Click OK.
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18. Double-click to open the Database Fields folder under Field Explorer in the right nav-
igation pane as shown in the figure below.

Figure 9: Field Explorer Screen

19. Double-click Command to expand it.

20. Drag and drop the fields from Command to the locations like Page Header, Details in
the Design mode, where you want the fields to appear in the report.

21. Click the Main Report Preview tab to view the created report’s preview. Altern-
atively, you can right-click the report file and then click Report Preview to preview
the report.

22. Click File > Save to save the template in the project folder. Alternatively, you can
click File > Save <report_name> Save As to save the report in the desired loc-
ation.

Creating Report Templates Using Crystal Report Designer
This section outlines the high-level steps involved in creating report templates using Crys-
tal Report Designer.

To create report templates using Crystal Report Designer:

1. Start the Crystal Report application and then click File > New > Blank Report…. A
Database Expert window appears as shown in the figure below.

Report Builder
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Figure 10: Database Expert Screen

2. Expand the Create New Connection folder by double-clicking it. A list of available
connection folders appear.

Creating Report Templates Using Crystal Report Designer 563



3. Expand the ODBC (RDO) folder by double-clicking it and then double-click Make
New Connection. The ODBC (RDO) window appears as shown in the figure below.

Figure 11: ODBC (RDO) Screen

4. In the ODBC (RDO) window:

a. Click Enter Connection String to enable the Connection String field.

b. In the Connection String field, enter, Driver=MySQL ODBC 5.1 Driver-
;Server=localhost

c. Click Next to proceed. The following window appears, with Server and User ID
fields pre-populated with the correct values as applicable to your installation of
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564 Creating Report Templates Using Crystal Report Designer



Report Builder

MySql.

Figure 12: Connection Information Screen

d. Enter the password (this will bemysql if MySql was installed by the ServiceMax
Offline application installer, with default values for User ID and password), select
svmx as the Database, and then click Finish.

e. Double-click Add Command to view the Add Command To Report window.

Figure 13: Add Command To Report Screen
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5. Write an SQL query to include the fields you want to appear in the report and then
click Create to open the Command Parameter window. Syntax for querying is given
below:

Select <field_names> from <object_name> where <object_name>_Pid={?<Parameter_Name >};

6. Enter the Parameter Name, select the Value Type as Number from the picklist
and then click OK. An Enter Values window appears as shown below.

Figure 14: Enter Values Dialog Box

7. Enter a value, say 1, and then click OK to test the created database connection. If
there is any error, the Crystal Report screen appears with error information.

8. Click OK.

9. Double-click to open the Database Fields folder under Field Explorer in the right nav-
igation pane as shown in the figure below.
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Figure 15: Field Explorer

10. Double-click Command to expand it.

11. Drag and drop the fields from Command to the locations like Page Header, Details in
the Design mode, where you want the fields to appear in the report.

12. Click File > Save to save the report template created.

Note: Change the font of the fields on the Crystal report designer while design-
ing the template to Arial Unicode MS. Arial Unicode MS supports the display
of characters in all languages.

Adding Signature Capture Fields to the Report Template
Follow the steps below to add Signature and Date Time fields to the Report Template. Use
these templates to create offline reports for accepting signatures with the signature cap-
ture device in the ServiceMax Offline Client application. Currently, only the Topaz SigLite
SL electronic capture device is supported.

To add a signature capture field to the report template:

1. Open the Crystal Report Template in Designer, and select the menu option Insert,
and then click OLEObject (figure 16).
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Figure 16: Select OLE Object

2. In the resulting dialog box, select the Object Type as Bitmap Image or Paint-
brush Picture and click OK. See figure below.

Figure 17: Insert Object Dialog Box

Report Builder

568 Adding Signature Capture Fields to the Report Template



Report Builder

3. In the Field Explorer right navigation pane, right-click Parameter Fields and select
the New menu option as shown in the figure below.

Figure 18: Select Menu Option New

4. Create a new parameter with Type: String and Name: SVMX_Signature as shown
in the figure below.

Figure 19: Create New Parameter Dialog Box

5. Select the OLE Object you added in Step 2, right-click and select the Format
Graphic menu as shown below.
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Figure 20: Format Graphic Menu Option

6. In the Format Editor dialog box, enter SVMX_Signature in the Object Name field
as shown below.
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Figure 21: Format Editor Dialog Box

7. In the Format Editor dialog box, click the Picture tab, and then click the Graphic
Location icon. See figure below.
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Figure 22: Format Editor Picture Tab

8. In the resulting new dialog box, locate the parameter field SVMX_Signature in the
first tree in the right pane, drag and drop it to the white box below. It will get dropped
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as (?SVMX_Signature). Save and Close it.

Figure 23: Graphic Location Window

9. To include a date time field in the report that will get auto-populated with the current
date time in the Windows system time zone when clicking the Confirm button in the
Signature Capture section of report, do the following:

a. Create a new parameter of type Date Time and name SVMX_DateTime.

b. From the Field Explorer in right navigation pane, drag and drop the above para-
meter to the place in the report template where you need to capture the date
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time. It will get dropped as ?SVMX_DateTime. See figure below.

Figure 24: Report Template

10.  If record id (for example, Work Order Number field) is to be included in the report,
add it as a string parameter named SVMX_RecId.

11. Save the report template.

Adding Multiple Signature Capture Fields to the Report
Template
Follow the steps below to add multiple Signature and Date Time fields to the Report Tem-
plate. Use these templates to create offline reports for accepting signatures with the sig-
nature capture device in the ServiceMax Offline Client application. Currently, only the
Topaz SigLite SL electronic capture device is supported.
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1. Open the Crystal Report Template in Designer, and select the menu option Insert,
and then click OLEObject (see figure below).

Figure 25: Select OLE Object

Note: You must create an OLE Object for EACH signature you want in the
report.

2. Right-click and select Format Object (see figure below).
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Figure 26: Format Object

3. In the Format Editor dialog box, enter the object name in the Object Name text box.
The Object name for each OLE Object must start with the prefix “SVMX_Signature”
(For example, for a Technician Signature the name should be "SVMX_Signature_Tech-
nician_Signature," and for Customer Signature the Object name should be "SVMX_Sig-
nature_Customer_Signature." See figure below.

Figure 27: Format Editor

4. Create a new parameter for each OLE object:

a. Enter the name in the Name text box. The name must be the same as that of the
OLE Object (for example, SVMX_Signature_Customer_Signature) as shown in the
figure below.
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b. From the Type picklist, select String.

Figure 28: Create New Parameter Window

5. Link the Parameter Fields to each OLE Objects by dragging and dropping them using
the Graphic Location icon in the Picture Tab as shown in the two figures below.

Adding Multiple Signature Capture Fields to the Report Template 577



6. In the Format Editor dialog box, click the Picture tab, and then click the Graphic
Location icon.

Figure 29: Format Editor

7. From the Field Explorer in the right navigation pane, drag and drop the parameters to
the appropriate place in the report template.
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Figure 30: Format Formula Editor -- Graphic Location

8. Save the report template.

Making the Document Template Available to the Users
To make the uploaded report template available to your ServiceMax Offline user, follow
the steps below:

1. Enter your login credentials.

2. Check the Download Configuration checkbox in the login screen.

3. Click Login. The ServiceMax Offline will synchronize the data from Salesforce and
download the template to the user’s desktop.
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4. When the users view any record from the object associated with this template from
ServiceMax Offline, the list of templates appear as shown below.

Figure 31: List of Templates

5. Click Generate Report to generate the report based on the downloaded template.

See Also:

Manage Offline Profiles

Manage Datasets

Manage Document Templates

Sample Offline Configuration
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CUSTOMIZING SERVICEMAX

Overview
Customizations are customer-specific features that are not available in the out-of-the-box
ServiceMax application. If any functionality built on the Force.com platform that is not read-
ily available in ServiceMax meets the criteria listed below, it will be considered as a Ser-
viceMax customization.

The functionality uses one or more objects from the ServiceMax package

The functionality requires some coding involving one or more development tools such
as Apex, Visual Force, JavaScript or Flex

For example, a customer requires the tracking of Work Orders closed every week. Since
this feature is not covered by the standard ServiceMax application, this may be built as a
customization using an Apex Trigger that creates a record in a custom object called Work
Order Closure History. Note that this is only an imaginary scenario. Your requirements
may vary in complexity and may require ServiceMax implementation professionals to jus-
tify the customization needs.

Any changes made to the standard mail-merge templates provided by ServiceMax are
also considered customizations. Mail-merge templates include Visual Force pages and
their Apex controllers. These can be customized to meet your specific formatting or con-
tent requirements.

Due to the nature of customizations, they are not supported by ServiceMax Technical Sup-
port, nor are they automatically replaced if/when they become standard features in Ser-
viceMax.

Salesforce administration activities such as adding custom fields to ServiceMax objects,
modifying picklist values, changing translations, adjusting page layouts are not considered
customizations. See Configuring ServiceMax for any limitations surrounding these
administrative tasks.
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Customization Considerations
Since any customizations built specific to customer requirements are not supported by Ser-
viceMax Technical Support, consider the following before you start building custom func-
tionality.

How critical is the requirement? Is it a must-have or nice-to-have?

Can a process workaround be found so that you can continue to use standard func-
tionality?

Can it be built using standard Salesforce point-and-click constructs such as workflow
rules, approval processes?

Is similar functionality already in ServiceMax product road map? If yes, can your
requirement wait until it is rolled out?

How many users will be using this custom functionality? The more the number of
users, the more you must consider supportability.

Do you have enough qualified resources (external or internal) to maintain the func-
tionality through Salesforce platform upgrades?

Building Custom Functionality in ServiceMax
The picture below outlines the flow of building custom functionality in a Sandbox instance
and deploying it to the production instance:

Customizing ServiceMax
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Figure 1: Building Custom Functionality

In order to implement your customizations in a scalable way, it is strongly recommended
to adhere to the following guidelines:
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Identify the closest standard module in ServiceMax where this requirement would fit.
Create new modules only if none of the standard modules match with your require-
ment. For example, if the requirement is about capturing billing schedule of a service
contract, attach the functionality to the Service Contract module in ServiceMax.

Identify the standard submodule in ServiceMax where this requirement would fit. If
your functionality is similar to one of the existing submodules but slightly different,
simply use the existing Submodule ID. Each submodule has its own set of standard
settings and tags that you may be able to take advantage of. If the functionality is
not supported in any submodule, you can create a new custom submodule.

Identify all the configurable parameters you like to have. While this is a subjective
exercise, a good rule of thumb is to avoid any hard-coding in your code. If you need
to provide flexibility either during development or you anticipate end users might
change their requirements, it is a good opportunity to make the behavior driven by
configurable parameters. Any future coding effort can be avoided by this.

For each configurable parameter, determine the scope of its impact—org-wide or not.
Org-wide (Global) settings impact functionality for all users regardless of their login
or profile.

If your functionality requires new records to be created from existing records, make
it configurable using the Object maps in ServiceMax configuration. This provides com-
plete scalability and flexibility for the customer administrator to configure the field
mapping between the source and target objects.

Build the functionality using ServiceMax settings and object maps. See sample
code in ServiceMax API.

If the code is written in Apex, create unit test cases. While Force.com accepts 75%
code coverage, target at least 90% to 95% coverage of your code. This ensures suc-
cessful migration to production. Avoid hard-coding references data in unit test cases.
Since the test cases will fail if data is missing, create any/all data dynamically in unit
test cases.

Before you can deploy the functionality in production, you must create the custom
modules, submodules, settings, object maps, and so on, in production first. This is an
important step and must be done manually in production using ServiceMax Con-
figuration screens. See Configuring ServiceMax for details.

After creating your meta-data in production, adjust the setting values appropriately
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in all existing ServiceMax Configuration profiles. Note that when a new setting is cre-
ated, it is automatically linked to appropriate profiles with its default value.

Create an unmanaged package of your customizations and deploy to production.
While packaging is not mandatory in Force.com, it is a recommended best practice.

Using Product from Opportunity Line in SFM Transactions
Additional customization is required to use the Product field in SFM Transactions. Follow
the instructions below.

To use Product from Opportunity Line in an SFM Transaction:

1. In Opportunity Product object, create a field of type Lookup to Product as Oppor-
tunity_Product__c (field label: Opportunity Product).

2. Create a trigger as follows for Opportunity Product object:

// When a new line item is added to an opportunity,

// this trigger copies the value of the associated product's ID to the record.

trigger PopulateProductLookup on OpportunityLineItem (before insert) {

// For every OpportunityLineItem record, add its associated pricebook

entry

// to a set so there are no duplicates.

Set<Id> pbeIds = new Set<Id>();

for (OpportunityLineItem oli : Trigger.new)

pbeIds.add(oli.pricebookentryid);
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// Query the PricebookEntries for their associated product and place

the results

// in a map.

Map<Id, PricebookEntry> entries = new Map<Id, PricebookEntry>([select

product2.id from pricebookentry where id in :pbeIds]);

// Now use the map to set the appropriate product on every OpportunityLineItem

processed

// by the trigger.

for (OpportunityLineItem oli : Trigger.new)

oli.Opportunity_Product__c = entries.get(oli.pricebookEntryId).product2.id;

}

3. If there is a need to populate the Opportunity Product custom field for the existing
Opportunity Product records, change the definition of the trigger to (before insert,
before update), and update all the existing Opportunity Product records.

4. In the SFM transaction for Opportunity to any target object, map the target object's
Product Lookup field to Opportunity Product’s Opportunity Product field.

'Consumed From Location’ Field Sample Code
Sample code for the 'Consumed From Location’ field is displayed below.

Customizing ServiceMax
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trigger WORD_Line_UpdateConsumedLocationTrigger on SVMXC__Service_Order_Line__c (before

insert, before update)

{

List<SVMXC__Service_Group_Members__c> lstTechnician = new List<SVMXC__Service_Group_Members__

c>();

lstTechnician = [Select SVMXC__Salesforce_User__c, SVMXC__Inventory_Location__c From SVMXC__

Service_Group_Members__c  where SVMXC__Inventory_Location__c != null and SVMXC__Salesforce_

User__c=:UserInfo.getUserId() Limit 1];

if (lstTechnician != null && lstTechnician.size() == 1 && lstTechnician[0].SVMXC__Inventory_

Location__c != null)

{

for(SVMXC__Service_Order_Line__c R : Trigger.new)

{

if(R.SVMXC__Consumed_From_Location__c == null )

R.SVMXC__Consumed_From_Location__c = lstTechnician[0].SVMXC__Inventory_Location__c;

}

}

}

Building Custom Service Flow Events

Overview

SFM provides the ability to plug-in custom logic during various stages of user interaction
on any SFM screen. Since all custom logic is written as Apex web services, a strong under-
standing of ServiceMax object model and working knowledge of Apex programming lan-
guage are essential to create custom logic for SFM screens.
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Web Service Syntax

All SFM web services must adhere to a standard syntax so they can be integrated
with SFM screen events

As required by Apex and Flash toolkit, the web service class must be declared as
global so it can be accessed from the SFM screen

The web service method must accept an input parameter of type SVMXC.SFM_Wrap-
perDef.SFM_TargetRecord

The web service must be declared with the return data type SVMXC.SFM_Wrap-
perDef.SFM_PageData

After updating the incoming record, it must be converted to the return data type
using a special utility method provided by ServiceMax as shown below

With the above considerations, the structure of an SFM web service would be like this:

global class AnyClass {

webservice static SVMXC.SFM_WrapperDef.SFM_PageData AnyMethod (SVMXC.SFM_WrapperDef.SFM_Tar-

getRecord AnyTarget)

{

...

...

// Your logic goes here...

...

...

SVMXC.SFM_buildPageData PageUtil = new SVMXC.SFM_buildPageData();

return PageUtil.SFM_buildPageData(AnyTarget);

Apex Exception Handling Block

}

}
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You must also build Apex unit test classes for each SFM web service

The input and return data types are highly generic and hierarchical in nature to
ensure scalability. Hence using and updating the incoming data is a fairly complex
process. Refer to the methods in the class SFM_Sample for implementation tem-
plates of custom web services

Calling Web Service On Event
The table below lists various events on SFM screens to which web services can be integ-
rated. To call a web service on any of these events, simply use the syntax
ClassName.MethodName.

Area Event When invoked

Page On Load Before the screen is displayed to the end user but after filling relevant
data in the fields

Page Before Inser-
t/Save

Before any of the target records are created. Applies only to source-to-
target flows

Page Before
Update/Save

Before any of the existing records are updated. Applies only to stan-
dalone edit flows

Page After Inser-
t/Save

After the entire target header and child records are created. Applies only
to source-to-target flows

Page Before
Update/Save

After all the existing records are updated. Applies only to standalone edit
flows

Button On Click When the user clicks on the button

Field On Exit When the user leaves a field either by tabbing out or clicking elsewhere

Field On Change When the user changes the data in a field and leaves the field either by
tabbing out or clicking elsewhere

Note: The web services that are integrated with SFM screen events requires
Internet connectivity. The iPad mobile application WILL NOT invoke these web
services when there is no Internet connectivity.
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Web Service Response Example
Input Parameter:SFM_TargetRecord

Output Parameters:SFM_PageData

Global Class ClassName

{

webservice static SVMXC.SFM_WrapperDef.SFM_PageData WSName(SVMXC.SFM_WrapperDef.SFM_Tar-

getRecord sfmtargetrec)

{

                                //Describe all objects

SVMXC.SFM_WrapperDef.SFM_PageData pagedata = new SVMXC.SFM_WrapperDef.SFM_PageData();

map<String,Schema.SObjectType> Allobj = new map<String,Schema.SObjectType>();

map<String, Schema.SObjectType> gd = new Map<String, Schema.SObjectType>();

                                gd = Schema.getGlobalDescribe();

                                if(gd.size() > 0)

{

                                                For(Schema.SObjectType s : gd.values())

{

                                                                Schema.DescribeSObjectResult

result = s.getDescribe();

                                                Allobj.put(result.getName(),s);

                                                }

                                }

                                SVMXC.SFM_ServicesDef def = new SVMXC.SFM_ServicesDef();

                                //Below method will return Header Sobject.

Sobject headerSobj =def.SFM_Page_GetHeaderRecord(sfmtargetrec,Allobj);

                //After getting Header Sobject process it if required.

//Below method will return detail Sobjects in map  (Key --> Tab Id Value --> List of Sobjects)

map<String,List<Sobject>> detailSobjectMap = new map<String,List<Sobject>>();
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                 detailSobjectMap = def.SFM_Page_GetDetailRecords(sfmtargetrec,Allobj);

                // Loop through the map,get the list of Sobjects and process it

//Call below method with processes Header Sobject and Detail Sobjects Map.

pagedata = def.SFM_Page_BuildResponse(sfmtargetrec,headerSobj,detailSobjectMap);

return pagedata;

    }

}

Note: Never modify/update input parameter.

Best Practice

Never modified existing map always update values of the map and create new map
with same key and update values. (See example of detail records update).

Never modified/add values as key-value pair in internal types (for example, SFM_
Records). Always use Sobject or list of Sobject to perform operation.

SFM Pagedata  is overloaded with SFM_Response. Use SFM_Response to com-
municate if operation is successful or not. Always send success member true/false
based on operation is successful or not with message member.

Find the full SFM_Response structure at the end of the document for more information.

Examples of Custom Web Service

Example 1: Sample web service example for header record. After save, if Work Order’s
Order Status is closed, update Closed On and Closed By fields of the Work Order.

Global Class WorkOrderClosure

{

  webservice static SVMXC.SFM_WrapperDef.SFM_PageData closeWorkOrder(SVMXC.SFM_WrapperDef.SFM_

TargetRecord sfmtargetrec)

{

        //Describe all objects

SVMXC.SFM_WrapperDef.SFM_PageData pagedata = new SVMXC.SFM_WrapperDef.SFM_PageData();
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        map<String,Schema.SObjectType> Allobj = new map<String,Schema.SObjectType>();

        map<String, Schema.SObjectType> gd = new Map<String, Schema.SObjectType>();

        gd = Schema.getGlobalDescribe();

        if(gd.size() > 0)

{

            For(Schema.SObjectType s : gd.values())

{

                Schema.DescribeSObjectResult result = s.getDescribe();

                Allobj.put(result.getName(),s);

            }

        }

        SVMXC.SFM_ServicesDef def = new SVMXC.SFM_ServicesDef();

        //Below method will return Header Sobject.

        Sobject headerSobj =def.SFM_Page_GetHeaderRecord(sfmtargetrec,Allobj);

        SVMXC__Service_Order__c  objWO = new SVMXC__Service_Order__c();

        objWO  = (SVMXC__Service_Order__C  ) headerSobj;

        if(objWO.SVMXC__Order_Status__c  == 'Closed')

{

            objWO.SVMXC__Closed_On__c = system.now();

            objWO.SVMXC__Closed_By__c = userinfo.getuserid();

            try

{

update objWO;

pagedata.response.message = ‘Saved Successfully’;

pagedata.response.success = true;

 pagedata.response.messageType = ‘SVMX_SUCCESS’;

}

catch(exception ex)
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{

Pagedata .response.message = ex.getmessage();

pagedata.response.success = false;

 pagedata.response.messageType = 'SVMX_ERROR';

return Pagedata;

}

        }

        //below method will return detail Sobjects in map  (Key --> Tab Id Value --> List of

Sobjects)

        map<String,List<Sobject>> detailSobjectMap = new map<String,List<Sobject>>();

        detailSobjectMap = def.SFM_Page_GetDetailRecords(sfmtargetrec,Allobj);

         //Call below method with processes Header Sobject and Detail Sobjects Map.

        pagedata = def.SFM_Page_BuildResponse(sfmtargetrec, objWO ,detailSobjectMap);

        return pagedata;

    }

}

Example 2: Sample web service example for detail records on load if activity type’s value
is service value then it will set discount = 10.

Global Class DiscountOnService

{

    webservice static SVMXC.SFM_WrapperDef.SFM_PageData giveDiscount(SVMXC.SFM_WrapperDef.SFM_

TargetRecord sfmtargetrec)

{

        SVMXC.SFM_WrapperDef.SFM_PageData pagedata = new SVMXC.SFM_WrapperDef.SFM_PageData();

        //Describe all objects

        map<String,Schema.SObjectType> Allobj = new map<String,Schema.SObjectType>();

        map<String, Schema.SObjectType> gd = new Map<String, Schema.SObjectType>();

        gd = Schema.getGlobalDescribe();

        if(gd.size() > 0)
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{

            For(Schema.SObjectType s : gd.values())

{

                Schema.DescribeSObjectResult result = s.getDescribe();

                Allobj.put(result.getName(),s);

            }

        }

        SVMXC.SFM_ServicesDef def = new SVMXC.SFM_ServicesDef();

        //Bellow method will return Header Sobject.

        Sobject headerSobj =def.SFM_Page_GetHeaderRecord(sfmtargetrec,Allobj);

        //below method will return detail Sobjects in map  (Key --> Tab Id Value --> List of

Sobjects)

        map<String,List<Sobject>> detailSobjectMap = new map<String,List<Sobject>>();

        map<String,List<Sobject>> newDetailSobjectMap = new map<String,List<Sobject>>();

        detailSobjectMap = def.SFM_Page_GetDetailRecords(sfmtargetrec,Allobj);

        if(detailSobjectMap.size() > 0)

{

            for(String str : detailSobjectMap.keyset())

{

                list<SVMXC__Service_Order_Line__c> lstWoLines = new list<SVMXC__Service_Order_

Line__c>();

                lstWoLines = detailSobjectMap.get(str);

                if(lstWoLines.size() > 0)

{

                    for(Integer i = 0;i<lstWoLines.size();i++)

{

                        if(lstWoLines[i].SVMXC__Activity_Type__c == 'Service')

{
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                            lstWoLines[i].SVMXC__Discount__c = 10;

                        }

                    }

                    newDetailSobjectMap.put(str,lstWoLines);

                }

            }

        }

        // Loop through the map,get the list of Sobjects and process it

        //Call below method with processes Header Sobject and Detail Sobjects Map.

        pagedata = def.SFM_Page_BuildResponse(sfmtargetrec, headerSobj ,newDetailSobjectMap);

return pagedata;

    }

}

global class SFM_Response

{

                webservice Boolean success {get;set;}

                webservice String message {get;set;}

                webservice String messageType {get;set;}

                webservice String tagId {get;set;}

                webservice String eventType {get;set;}

                webservice List<SFM_StringMap> stringMap = new List<SFM_StringMap>();

                webservice List<SFM_StringFieldMap> stringFieldMap = new List<SFM_

StringFieldMap>();

                webservice List<SVMX_Debug.SMAX_Debug> logMsg;

                webservice List<String> resultIds = new List<String>();

                webservice List<SFM_StringListMap> StringLstMap = new List<SFM_StringListMap>

();
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                webservice List<SFM_MapStringMap> MapStringMap = new List<SFM_MapStringMap>();

                global SFM_Response(Boolean success,String message,String tagId,List<SFM_

StringMap> stringMap,List<SVMX_Debug.SMAX_Debug> logMsg,List<String> resultIds)//List<SFM_

StringFieldMap> stringFieldMap commented by amar

{

                                this.success = success;

                                this.message = message;

                                this.tagId = tagId;

                                this.stringMap = stringMap;

                                this.logMsg = logMsg;

                                this.resultIds=resultIds;

                                //this.stringFieldMap=stringFieldMap;

                }

                global SFM_Response(){}

                global List<SFM_StringMap> getstringMap(){return stringMap;}

                global void setstringMap(List<SFM_StringMap> s){stringMap = s ;}

                global List<SFM_StringFieldMap> getstringFieldMap(){return stringFieldMap;}

                global void setstringFieldMap(List<SFM_StringFieldMap> s){stringFieldMap = s

;}

                global List<SFM_StringListMap> getStringLstMap(){return StringLstMap;}

                global void setStringLstMap(List<SFM_StringListMap> s){StringLstMap = s ;}

                global List<SFM_MapStringMap> getMapStringMap(){return MapStringMap;}

global void setMapStringMap(List<SFM_MapStringMap> s){MapStringMap = s ;}

}

See Also:

Configuring ServiceMax
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ServiceMax Mail Merge

ServiceMax API
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SERVICEMAX MAIL MERGE

Overview
Depending upon the modules to which you have subscribed, ServiceMax installation may
include several Mail-merge templates for:

RMA

Shipment note

Service Report

Service Contract

Quotation

These are templates built using Visual Force and Apex. Create a copy of the template to
customize them for your organization’s use.

In addition, ServiceMax provides a simple process to publish your custom templates to
end users, and a standard screen that allows users to select templates from a list and print
them in multiple formats.

Customization
Working knowledge of Visual Force, Apex programming and a thorough understanding of
the ServiceMax object model are absolutely necessary to customize/build Visual Force
templates.

Based on user requirements, identify the standard ServiceMax template you wish to cus-
tomize. For example, if the users require a custom Service Contract template, use the Ser-
viceMax Service Contract Template as a starting point.

Each ServiceMax template has three components:
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a Visual Force page

an Apex controller

The Apex Unit Test class.

Create a copy of all the three for your customization.

Once you have completed the changes in your Sandbox instance, you must publish the
templates in order to use them on an object page. See Publishing Templates for more
information.

After testing the template from an end user experience standpoint, you can package and
migrate the template (Visual Force and Apex) to production. You can do this on Eclipse
using Force.com IDE.

Publishing Templates
Once a template is created, publishing is a 2-step process:

Step 1: Create a Document Record

1. Click the Documents tab and select any folder where you want to save the tem-
plates. The default templates of ServiceMax are available in the ServiceMax Docu-
ments folder.

2. Click New Document to view the Document Edit screen.

3. Enter a user-friendly name for the document. This is the name that will be listed for
users to select from.

4. Check the Internal Use Only checkbox.

5. Select the appropriate folder.

6. In Description, enter the object name using the format "NamespacePre-
fix.ObjectName.RecordType." For example, if the template you built corresponds to
Shipments, enter "SVMXP.RMA_Shipment_Order.Shipment". This is to make sure that
you have the flexibility to define templates for various record types in an object. If
your object does not have a record type, use only the Namespace prefix and Object
name. For example, to identify a template built on the Stock Transfer object, use
"SVMXI.Stock_Transfer".

ServiceMax Mail Merge
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7. In Keywords, enter the name of the Visual Force page you created.

8. Click Save.

Repeat the above steps for as many templates as your organization needs. If you are build-
ing templates in more than one language, create separate document folders for each lan-
guage, and grant folder access to only the appropriate users. A sample document record
entry is shown below:

Figure 1: Document Entry Screen

Step 2: Create a custom button or link to launch ServiceMax Mail

Merge Page

This must be done for each object, if not already present. To do this:

1. Navigate to Setup > App Setup > Create > Objects and then click the object for
which you created templates.

2. Create New Custom button/link by following Steps 3 - 10 below.

3. Enter a suitable name for the label. Recommended practice is “Object Name Report
(s)”. For example, for RMA-related templates, the button/link label could be RMA
Report(s.)

4. In the Behavior picklist, click Display in existing window without sidebar or
header.

5. Select URL for Content Source.
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6. For the button content, use the syntax given below. The area highlighted must be
used exactly as shown here: /apex/SVMX_Select_VF_Tem-
plate?id=YourObjectId&ObjName=NameSpace.ObjectName.RecordType

7. Specify the Salesforce merge variable name for the id parameter.

8. Specify the Document description for the ObjName parameter.

9.  For example, the URL for RMA reports will be: /apex/SVMX_Select_VF_Template?id=
{!SVMXP__RMA_Shipment_Order__c.Id}&ObjName=SVMXP.RMA_Shipment_Order-
.RMA

10. Click Save.

11. Add the custom button/link to the page layout. A sample custom link is shown here:

Figure 2: Custom Button or Link Edit Screen

Testing Created Templates

To test a template:

1. Go to the detail page of any record.
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2. Click the custom button/link you created. You will see the Templates Selection screen
that lists all the templates you created for the given object.

Figure 3: ServiceMax Template Selection Screen

3. If you do not see your template listed in this screen, verify that:

a. The Document description has the exact same data as specified in the ObjName
parameter of the button.

b. You have access to the documents folder in which the document record was cre-
ated.
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SERVICEMAX API

Overview
This section lists the syntax and usage of various Apex utilities made available in Ser-
viceMax for public use.

Class: SVMXC. COMM_Utils_ManageSettings

1. SVMX_getSettingList(String SubmoduleId)

Returns the values of all settings in the given submodule ID as a Map<String,String>.

Example: To retrieve all setting values for Case Entitlement submodule (Submodule ID
EVER001):

YourClass(...)

{

Your code...

// Initialize the constructor

SVMXC.COMM_Utils_ManageSettings commUtilSettings = new SVMXC.COMM_Utils_ManageSettings();

Map<String, String> mySettings = settings.SVMX_getSettingList('EVER001');

// Your code to use the settings

String valSet001 = mySettings.get('SET001');

}

2. SVMX_getSettingList(String SubmoduleId, String SettingId)

Returns the values of the given setting in the given submodule ID as a
Map<String,String>.

Example: To retrieve the value of the setting Show Future Entitlements in Case Enti-
tlement submodule:
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YourClass(...)

{

Your code...

// Initialize the constructor

SVMXC.COMM_Utils_ManageSettings commUtilSettings = new SVMXC.COMM_Utils_ManageSettings();

Map<String, String> mySettings = settings.SVMX_getSettingList('EVER001', 'SET001');

// Your code to use the settings

String valSet001 = mySettings.get('SET001');

}

3. SVMX_getSettingList(String SubmoduleId, List<String> Set-

tingList)

Returns the values of the given setting in the given submodule ID as a
Map<String,String>.

Example: To retrieve the value of multiple settings for Case Entitlement submodule:

YourClass(...)

{

Your code...

// Initialize the constructor

SVMXC.COMM_Utils_ManageSettings commUtilSettings = new SVMXC.COMM_Utils_ManageSettings();

// Create a list of setting IDs

List<String> listOfSettings = new List<String>();

listOfSettings .add('SET001');

listOfSettings .add('SET002');

listOfSettings .add('SET003');

Map<String, String> mySettings = settings.SVMX_getSettingList('EVER001', listOfSettings);

// Your code to use the settings

String valSet001 = mySettings.get('SET001');
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}

4. SVMX_getFieldMapping(String MapId)

Returns the source to target field mapping configured for the given object Map ID as an
array of records from SVMXC__ServiceMax_Config_Data__c object.

Example: This retrieves field mapping between two sample objects, Source_Object__c
and Target_Object__c, and copies field values between the two objects using the map-
pings.

YourClass(...)

{

// Initialize the constructor

SVMXC.COMM_Utils_ManageSettings commUtilSettings = new SVMXC.COMM_Utils_ManageSettings();

// Get the field mapping for a given map ID

SVMXC__ServiceMax_Config_Data__c[] FieldMap = commUtilSettings.SVMX_getFieldMapping('MAP001');

Target_Object__c TObj = new Target_Object__c();

// Use your code to select data from Source_Object__c

// Assuming you have the source record in SObj

//Populate fields and corresponding values using fieldMap

             for (SVMXC__ServiceMax_Config_Data__c fld : FieldMap)

{

                 String targetFieldName = fld.SVMXC__Target_Field_Name__c;

                 String sourceFieldName = fld.SVMXC__Source_Field_Name__c;

                 Object sourceFldVal = SObj.get(sourceFieldName);

                 if(sourceFldVal != null)

{

                    TObj.put(targetFieldName, sourceFldVal);

                 }

}
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Class: SVMXC. COMM_Utils_ManageTags

1. SVMX_getTagList(String SubmoduleId)

Returns all the display tags for the given submodule as a Map<String,String>. It considers
the login user’s language settings in Salesforce.

Example: To retrieve all display tags for Case Entitlement page:

YourClass(...)

{

Your code...

// Initialize the constructor

SVMXC.COMM_Utils_ManageTags commUtilTags = new SVMXC.COMM_Utils_ManageTags();

Map<String, String> myTags = settings.SVMX_getTagList ('EVER001');

}

In the above example, once the tags are available in myTags, you can apply the tag text in a

VisualForce page on buttons, labels etc. The following example uses 3 tags, one each for page

title, label of the Help URL and Cancel button label.

VisualForce page snippet:

<apex:pageBlock id="mainBlock" title="{!TAG001}" helpTitle="{!TAG002}" helpUrl-

l="http://www.servicemax.com" />

<apex:commandButton action="{!Cancel}" value="{!TAG003}" id="theCancelButton"/>

... other page elements

</apex:pageBlock>

Getter methods for the display tags in Controller class:

public String getTAG001()

{

return myTags.containsKey('TAG001') ? myTags.get('TAG001') : '';

}
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public String getTAG002()

{

return myTags.containsKey('TAG002') ? myTags.get('TAG002') : '';

}

public String getTAG003()

{

return myTags.containsKey('TAG003') ? myTags.get('TAG003') : '';

}
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SERVICEMAX OFFLINE DATA ACCESS API

Overview
The ServiceMax Offline Data Access API is an overview of the ServiceMax Data Access API
for the Offline application and its implementation details. This content will allow third party
applications access to the ServiceMax Offline dataset through a well defined interface
respecting all security requirements.

Implementation Details
The SVMXDataAccess DLL component will be deployed and registered as part of the offline
installation and will be made available for third party integration/access. Through this com-
ponent, third party applications can perform CRUD operations against the local offline data-
base. During offline synchronization, data manipulated through this API is synchronized
and made available in online SFDC.

Access to database objects (tables) and fields depends on the configuration and per-
missions assigned to the offline logged in user. The user profile should have the following
configuration defined/assigned for successful CRUD operation through the API in Manage
Offline Profiles (SFDC).

Allow API access property set to True for generating an API access key in Offline cli-
ent.

Allow API access property set to True for the objects that are part of Offline data set
definition.

API access is allowed only for a predefined duration without data synchronization
through Offline application.

The database can be accessed only from the machine where Offline client is installed.

CRUD operations via SVMXDataAccess DLL is achieved via the following function/method
calls. See table below.
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Method/Function

Name
Parameters Description

executeInsert DARequest Allows inserting new records into offline local database.

executeUpdate DARequest Allows updating of existing records in offline local database.

executeDelete DARequest Allows deleting of existing records in offline local database.

executeQuery DARequest Allows querying data from the existing offline local database.

getDbObjects DARequest Provides the list of objects the logged in user has access to
for CRUD operations.

getDBObjectFields DARequest Provides the list of fields for a given object with its per-
missions, data type, and so on.

All the functions/methods takes one parameter, an object of DARequest type, which may
consume other custom objects as its properties. The following objects are used during
method invocation for CRUD operation.

DARequest

FieldData

CriteriaData

DAResponse

DARequest
All the exposed functions/methods in SVMXDataAccess API take DARequest as its input
parameter, which contain all the required information for a successful execution of the
exposed function/method. The following table provides the properties that are available
and its usage.

Property Name Data Type
Data

Flow
Description

UserName String Input The Offline application login user name (SFDC
login).

APIKey String Input Unique API key generated via offline application.
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Property Name Data Type
Data

Flow
Description

ObjectName String Input Object name against which the CRUD operation will
be executed.

FieldNames ArrayList of
FieldData
object

Input ArrayList with FieldData objects as its items.
FieldData object holds the field information
required for CRUD operation.

Criteria ArrayList of
CriteriaData
object

Input ArrayList of CriteriaData objects as it items. Cri-
teriaData object holds the information required for
CRUD operation.

AdvancedExpression String Input Order and condition criteria (SQL Operators).

OrderBy String Input Order by field names for query execution.

DAResponse DAResponse
object

Output Object holding the response returned by the
executed API function/method.

Source Location String Input Location of file to be attached when object is Attach-
ment and operation is Insert.

Destination Location String Input Location where file to be copied when object is
Attachment and operation is executequery.

Reference Object
Name

String Input Reference object name against which the object
Attachment is called.

Response String Output It contains all the response in JSON format.

FieldData
The object is used within the DARequest object, and the FieldNames array list values in
the DARequest object should be of this type. This object is responsible for holding field
information during CRUD operation. The field information includes the field name, type,
and its value. The following table provides the properties that are available and its usage.

Property Name Data Type Data Flow Description

FieldName String Input Name of the database object field.

FieldValue String Input Value used for insertion or updates.

FieldType String Input Data type of the field value.
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CriteriaData
This object represents SQL where the condition for the executing query and Criteria array
list values in DARequest object should be of this type. The criteria information includes the
field name, value, and the expression (=, <, >, <>, NOT IN, IN, and so on). The following
table provides the properties that are available and its usage.

Property

Name

Data

Type

Data

Flow
Description

FieldName String Input Name of the database object field.

FieldValue String Input Value used in the criteria for this field.

Operator String Input Supported SQL operators.

ParentId String Input Contains ParentId. This is used when object is Attach-
ment only.

DAResponse
This object represents the response returned by the executed function/method. All the
functions/methods supported by the API can access this object for response information.
The properties of this object and its usage are provided in the following table.

Property

Name

Data

Type

Data

Flow
Description

ObjectName String Output Name of the object against which the CRUD operation is
performed.

ResponseCode Integer Output Response code can be 0 or 1. 1-representing success, 0-
representing error.

ResponseMsg String Output Response message. This is an information message.

ObjectData String Output Holds query results in JSON format.

ErrorId String Output Holds the error code. Used for debugging.

ErrorMsg String Output Custom Error Message.

ErrorDescription String Output Actual error description retrieved from the exception.

exStackStrace String Output Complete exception stack trace.
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API Function/Method and its Parameter Matrix
The following matrix provides the mandatory, optional parameters and its applicability.
Use this matrix during implementation.

Property

Name

executeI-

nsert

executeUp-

date

executeD-

elete

executeQ-

uery

getDbOb-

jects

getDbOb-

jectFields

UserName Mandatory Mandatory Mandatory Mandatory Mandatory Mandatory

APIKey Mandatory Mandatory Mandatory Mandatory Mandatory Mandatory

ObjectName Mandatory Mandatory Mandatory Mandatory NA Mandatory

FieldNames Mandatory Mandatory NA Optional Mandatory Mandatory

Criteria Optional Optional Optional Optional Optional Optional

SourceLoca-
tion

Mandatory
(For Attach-
ment only)

NA NA NA NA NA

Destin-
ationLocation

NA NA Mandatory
(For
Attach-
ment only)

NA NA

AdvancedEx-
pression

Optional Optional Optional Optional Optional Optional

OrderBy NA NA NA Optional Optional Optional

DAResponse Output Output Output Output Output Output

Response Output Output Output Output Output Output

Function/Method Signature With Example
Consider the following before executing any of the function/method exposed via
SVMXDataAccess API.
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Make sure the required parameter values are provided in the DARequest object as
per the function parameter matrix specification.

Use getDbObjects and getDbObjectFields to know more about the object and its
fields.

Attachments cannot be updated. To update attachments, delete the existing attach-
ment that you intent to update and insert again by calling executeDelete and
executeInsert function calls.

executeInsert (DARequest daRequest)

This function will insert new records to the local offline database including attachments.

Function Signature: executeInsert(DARequest daRequest)

Function Name: executeInsert

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

                objDAReq.UserName = “techuser@acme.com”;

                objDAReq.APIKey = “95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk”;

                objDAReq.ObjectName = “Account”;

                objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation=””;

                objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = ("Name");

objFD.setValue = ("Burlington");

objFD.setType= ("nvarchar") ;

arrFD.Add(objFD);

objFD = new FieldData();

objFD.setName = ("Type");

objFD.setValue = ("Other");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

ServiceMax Offline Data Access API

618 Function/Method Signature With Example



ServiceMax Offline Data Access API

objFD = new FieldData();

objFD.setName = ("BillingStreet");

objFD.setValue = ("Main Street");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

objDAReq.Criteria = null;

                objDAReq.AdvanceExpression = "";

                objDAReq.OrderBy = “”;

                objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation = “”;

                objDAReq.ReferenceObjectName = “”;

if (SVMXDataAccessAPI.SVMXDataAccessAPI.executeInsert(objDAReq) = = 1 )

                txt1.Text = objDAReq.Response;

else

txt1.Text = objDAReq.Response;

Sample code in case of Attachment Record insertion:

  DARequest objDAReq = new DARequest();

  objDAReq.UserName = “techuser@acme.com”;

         objDAReq.APIKey = “95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk”;

  objDAReq.ObjectName = “Attachment”;

  objDAReq.SourceLocation = “d:/test.doc”;

  objDAReq.DestinationLocation=””;

  objDAReq.ReferenceObjectName=”SVMXC__Service__Order__c”;

          ArrayList arrFD = new ArrayList();
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          FieldData objFD = new FieldData();

          objFD.setName = ("Body");

          objFD.setValue = ("test.doc");

          objFD.setType = ("File") ;

           arrFD.Add(objFD);

          FieldData objFD = new FieldData();

          objFD.setName = ("ParentId");

          objFD.setValue = ("a0vZ0000000eM4bIAE");

          objFD.setType = ("=") ;

            arrFD.Add(objFD);

            objDAReq.FieldNames = arrFD;

                CriteriaData objCD = null;

                objDAReq.AdvanceExpression = "";

                objDAReq.OrderBy = “”;

                 if (SVMXDataAccessAPI.SVMXDataAccessAPI.executeInsert(objDAReq) == 1 )

                txt1.Text = objDAReq.Response;

 else

 txt1.Text = objDAReq.Response;

executeUpdate (DARequest daRequest)

This function will update existing records to the local offline database excluding attach-
ments.

Function Signature: executeUpdate(DARequest daRequest)

Function Name: executeUpdate

Parameter: DARequest

Sample Code:
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DARequest objDAReq = new DARequest();

                objDAReq.UserName = “techuser@acme.com”;

                objDAReq.APIKey = “95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk”;

                objDAReq.ObjectName = “Account”;

                objDAReq.SourceLocation = “”;

      objDAReq.DestinationLocation=””;

      objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = ("Name");

objFD.setValue = ("Burlington");

objFD.setType = ("nvarchar") ;

arrFD.Add(objFD);

objFD = new FieldData();

objFD.setName = ("Type");

objFD.setValue = ("Other");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

objFD = new FieldData();

objFD.setName = ("BillingStreet");

objFD.setValue = ("Main Street");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

ArrayList arrCD = new ArrayList();

CriteriaData objCD = new CriteriaData();
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objCD.setName = "Account_PID";

objCD.setValue = "1";

objCD.setOperator = "=" ;

arrCD.Add(objCD);

objCD = new CriteriaData();

objCD.setName = "OwnerId";

objCD.setValue = "3";

objCD.setOperator = "=" ;

arrCD.Add(objCD);

objDAReq.Criteria = arrCD;

                objDAReq.AdvanceExpression = "1 AND 2";

                objDAReq.OrderBy = “”;

                objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation = “”;

                objDAReq.ReferenceObjectName = “”;

if (SVMXDataAccessAPI.SVMXDataAccessAPI.executeUpdate(objDAReq) == 1 )

                txt1.Text = objDAReq.Response;

else

txt1.Text = objDAReq.Response;

executeDelete (DARequest daRequest)

This function is used to delete existing records from the local offline database including
attachments.
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Function Signature: executeDelete(DARequest daRequest)

Function Name: executeDelete

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "SVMXC__Service_Order_Line__c";

objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation=””;

                objDAReq.ReferenceObjectName=””;

objDAReq.FieldNames = null;

ArrayList arrCD = new ArrayList();

CriteriaData objCD = new CriteriaData();

objCD.setName = "SVMXC__Service_Order_Line__c_PID";

objCD.setValue = "1";

objCD.setOperator = "=" ;

arrCD.Add(objCD);

objDAReq.Criteria = arrCD;

objDAReq.AdvanceExpression = "";

objDAReq.OrderBy = "";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";
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if (SVMXDataAccessAPI.SVMXDataAccessAPI.executeDelete(objDAReq) == 1 )

{

                txt1.Text = objDAReq.Response;

}

Else

{

txt1.Text = objDAReq.Response;

                }

executeQuery (DARequest daRequest)

This function is used to query existing records from the local offline database including
attachments.

Function Signature: executeQuery(DARequest daRequest)

Function Name: executeQuery

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "SVMXC__Installed_Product__c";

objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation=””;

                objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = "SVMXC__Installed_Product__c_PID";

arrFD.Add(objFD);
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objFD.setName = "Id";

arrFD.Add(objFD);

objFD.setName = "OwnerId";

arrFD.Add(objFD);

objFD.setName = "Name";

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

ArrayList arrCD = new ArrayList();

CriteriaData objCD = new CriteriaData();

objCD.setName = "SVMXC__Product_Name__c";

objCD.setValue = "'RASINHS'";

objCD.setOperator = "LIKE" ;

arrCD.Add(objCD);

objCD = new CriteriaData();

objCD.setName = "SVMXC__Serial_Lot_Number__c";

objCD.setValue = "NULL";

objCD.setOperator = "<>" ;

arrCD.Add(objCD);

objDAReq.Criteria = arrCD;

objDAReq.AdvanceExpression = "1 OR 2";

objDAReq.OrderBy = "Name DESC";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";

if (SVMXDataAccessAPI.SVMXDataAccessAPI.executeQuery(objDAReq) == 1 )
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{

txt1.Text = objDAReq.Response;

}

Else

{

                txt1.Text = objDAReq.Response;

}

getDbObjects (DARequest daRequest)

This function is used to get the list of objects the user is allowed for CRUD operation from
the local offline database.

Function Signature: getDbObjects(DARequest daRequest)

Function Name: getDbObjects

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "";

objDAReq.SourceLocation = “”;

objDAReq.DestinationLocation=””;

objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = "*";

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;
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objDAReq.Criteria = null;

objDAReq.AdvanceExpression = "";

objDAReq.OrderBy = "Name DESC";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";

if (SVMXDataAccessAPI.SVMXDataAccessAPI.getDbObjects(objDAReq) == 1 )

{

             txt1.Text = objDAReq.Response;

}

Else

{

                txt1.Text = objDAReq.Response;

}

getDBObjectFields (DARequest daRequest)

This function is used to get the list of fields for a given object from the local offline data-
base with its permissions and data type.

Function Signature: getDBObjectFields (DARequest daRequest)

Function Name: getDBObjectFields

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "Account";
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objDAReq.SourceLocation = “”;

objDAReq.DestinationLocation=””;

objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = "*";

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

objDAReq.Criteria = null;

objDAReq.AdvanceExpression = "";

objDAReq.OrderBy = "Name DESC";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";

if (SVMXDataAccessAPI.SVMXDataAccessAPI.getDBObjectFields(objDAReq) == 1 )

{

                txt1.Text = objDAReq.Response;

}

Else

{

                txt1.Text = objDAReq.Response;

ServiceMax Offline Data Access API

628 Function/Method Signature With Example



SERVICEMAX LAPTOP DATA ACCESS API

Overview
The ServiceMax Laptop Data Access API enables offline data to be directly accessed by
third party applications. This content provides an integration detail that helps third party
applications access the ServiceMax Laptop Offline dataset through a well-defined inter-
face, respecting all security requirements.

Implementation Details
The LaptopMobile.DataAccessAPIDLL is deployed in GAC as part of the offline Laptop
Mobile installation and is made available for third party integration/access. Additionally,
third party applications need to add a reference to System.Data.SQLite.dll, SQLite.In-
terop.dll, which is available in the DataAccessAPI folder in the Laptop Mobile installed dir-
ectory.

Third party applications can perform CRUD operations against the local offline database.
During synchronization, data manipulated through this API is synchronized and made avail-
able in online SFDC.

Access to perform CRUD operation on database objects (tables) and fields depends on the
configuration and permissions assigned to the logged in user.  The user profile should have
the following configuration defined/assigned for successful CRUD operation through the
API.

Allow API Access property should be checked in the Other Settings tab under Mobile
Configuration.

Necessary permissions for transactional objects, on which API operations are per-
formed, should be provided in SFDC.

The database can be accessed only from the machine where the Laptop Client is
installed.

CRUD operations via LaptopMobile.DataAccessAPIDLL are achieved through the following
function/method calls listed in the table below.
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Method/Function

Name
Parameters Description

executeInsert DARequest Allows inserting new records into the local database.

executeUpdate   DARequest Allows updating of existing records in the local database.

executeDelete DARequest Allows deleting of existing records in the local database.

executeQuery DARequest Allows querying data from the existing local database.

getDbObjects DARequest Provides the list of objects available in the local database
along with the permissions.

getDBObjectFields DARequest Provides the list of fields for a given object with its per-
missions, data type, and so on.

All the functions/methods accept one parameter, an object of DARequest type, as input.

DARequest
All the exposed functions/methods in Data Access API take DARequest as input, which con-
tains all the required information for a successful execution. The following table provides
the properties that are available and its usage.

Property Name Data Type
Data

Flow
Description

UserName String Input The Laptop application login user name
(SFDC login).

APIKey String Input Unique API key generated via offline applic-
ation.

ObjectName String Input Object name from which the CRUD oper-
ation will be executed.

FieldNames ArrayList of
FieldData
object

Input ArrayList with FieldData objects as its
items. FieldData object holds the field
information required for CRUD operation.

Criteria ArrayList of
CriteriaData
object

Input ArrayList of CriteriaData objects as its
items. CriteriaData object holds the inform-
ation required for CRUD operation.
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Property Name Data Type
Data

Flow
Description

AdvancedExpression String Input Order and condition criteria (SQL Oper-
ators).

OrderBy String Input Order by field names for query execution.

DAResponse DAResponse
object

Output Object holding the response returned by the
executed API function/method.

Source Location String Input Location of file to be attached when object is
Attachment and operation is Insert.

Destination Location String Input Location where file to be copied when the
object is Attachment and operation is
executequery.

Reference Object Name String Input Reference object name from which the
object Attachment is called.

Response String Output It contains all the responses in JSON
format.

mandatoryCheckDisabled Bool Input Disables mandatory check for Insert /
Update Operation if set to ‘true.’

FieldData
This object is responsible for holding field information during CRUD operation.The object is
used within the DARequest object, and the FieldNames array list values in the DARequest
object should be of this type. The following table provides the properties that are available
and its usage.

Property Name Data Type Data Flow Description

FieldName String Input Name of the database object field.

FieldValue String Input Value used for insertion or updates.

FieldType String Input Data type of the field value.

FieldData 631



CriteriaData
This object represents SQL where the condition for the executing query and Criteria array
list values in DARequest object should be of this type. The criteria information includes the
field name, value, and the expression (=, <, >, <>, NOT IN, IN, and so on) The following
table provides the properties that are available and its usage.

Property

Name

Data

Type

Data

Flow
Description

FieldName String Input Name of the database object field.

FieldValue String Input Value used in the criteria for this field.

Operator String Input Supported SQL operators like =, <, >, <>, NOT IN, IN.

ParentId String Input Contains ParentId. This is used when the object is 'Attach-
ment Only.'

DAResponse
This object represents the response returned by the executed function/method. This is
available as an attribute in the DARequest object and the client methods can access this
for retrieving response information. The properties of this object and its usage are
provided in the following table.

Property Name
Data

Type

Data

Flow
Description

ObjectName String Output Name of the object against which the CRUD operation is
performed.

ResponseCode Integer Output Response code can be 0 or 1. 1-representing success, 0-
representing error.

ResponseMsg String Output Response message. This is an information message.

ObjectData String Output Holds query results in JSON format.

ErrorId String Output Holds the error code. Used for debugging.

ErrorMsg String Output Custom Error Message.
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Property Name
Data

Type

Data

Flow
Description

ErrorDescription String Output Actual error description retrieved from the exception.

exStackStrace String Output Complete exception stack trace.

API Function/Method and its Parameter Matrix
The following matrix provides the mandatory, optional parameters and its applicability.
Use this matrix during implementation.

Property Name
executeI-

nsert

executeU-

pdate

executeD-

elete

execute-

Query

getDbOb-

jects

getDbOb-

jectFields

UserName Man-
datory

Mandatory Mandatory Man-
datory

Man-
datory

Mandatory

APIKey Man-
datory

Mandatory Mandatory Man-
datory

Man-
datory

Mandatory

ObjectName Man-
datory

Mandatory Mandatory Man-
datory

NA Mandatory

FieldNames Man-
datory

Mandatory NA Optional Man-
datory

Mandatory

Criteria Optional Optional Optional Optional Optional Optional

SourceLocation Man-
datory
(For
Attach-
ment
only)

NA NA NA NA NA

Destin-
ationLocation

NA NA Man-
datory
(For
Attach-
ment
only)

NA NA

AdvancedEx-
pression

Optional Optional Optional Optional Optional Optional
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Property Name
executeI-

nsert

executeU-

pdate

executeD-

elete

execute-

Query

getDbOb-

jects

getDbOb-

jectFields

OrderBy NA NA NA Optional Optional Optional

man-
dat-
oryCheckDisabled

Optional Optional NA NA NA NA

DAResponse Output Output Output Output Output Output

Response Output Output Output Output Output Output

Function/Method Signature with Example
Consider the following before executing any of the function/method exposed via Laptop
Data Access API.

Make sure the required parameter values are provided in the DARequest object as
per the function parameter matrix specification.

Use getDbObjects and getDbObjectFields to know more about the object and its
fields.

Attachments cannot be updated. To update attachments, delete the existing attach-
ment that you intend to update and insert again by calling executeDelete and
executeInsert function calls.

executeInsert(DARequestdaRequest)

This function will insert new records to the local offline database including attachments.

Function Signature: executeInsert(DARequestdaRequest)

Function Name: executeInsert

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

                objDAReq.UserName = “techuser@acme.com”;

                objDAReq.APIKey = “95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk”;

                objDAReq.ObjectName = “Account”;
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                objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation=””;

                objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = ("Name");

objFD.setValue = ("Burlingame");

objFD.setType= ("nvarchar") ;

arrFD.Add(objFD);

objFD = new FieldData();

objFD.setName = ("Type");

objFD.setValue = ("Other");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

objFD = new FieldData();

objFD.setName = ("BillingStreet");

objFD.setValue = ("Main Street");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

objDAReq.Criteria = null;

                objDAReq.AdvanceExpression = "";

                objDAReq.OrderBy = “”;

                objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation = “”;

                objDAReq.ReferenceObjectName = “”;

LaptopMobile.DataAccessAPI.DataAccessAPI objDAAPI = new LaptopMobile.DataAc-

cessAPI.DataAccessAPI();

if (objDAAPI.executeInsert(objDAReq) = = 1 )

                txt1.Text = objDAReq.Response;

else
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txt1.Text = objDAReq.Response;

Sample code in case of Attachment Record insertion:

  DARequest objDAReq = new DARequest();

  objDAReq.UserName = “techuser@acme.com”;

         objDAReq.APIKey = “95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk”;

  objDAReq.ObjectName = “Attachment”;

  objDAReq.SourceLocation = “d:/test.doc”;

  objDAReq.DestinationLocation=””;

  objDAReq.ReferenceObjectName=”SVMXC__Service__Order__c”;

          ArrayList arrFD = new ArrayList();

          FieldData objFD = new FieldData();

          objFD.setName = ("Body");

          objFD.setValue = ("test.doc");

          objFD.setType = ("File") ;

           arrFD.Add(objFD);

          FieldData objFD = new FieldData();

          objFD.setName = ("ParentId");

          objFD.setValue = ("a0vZ0000000eM4bIAE");

          objFD.setType = ("=") ;

            arrFD.Add(objFD);

            objDAReq.FieldNames = arrFD;

                CriteriaData objCD = null;

                objDAReq.AdvanceExpression = "";

                objDAReq.OrderBy = “”;
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LaptopMobile.DataAccessAPI.DataAccessAPI objDAAPI = new LaptopMobile.DataAc-

cessAPI.DataAccessAPI();

                 if (objDAAPI.executeInsert(objDAReq) == 1 )

                txt1.Text = objDAReq.Response;

 else

 txt1.Text = objDAReq.Response;

executeUpdate(DARequestdaRequest)

This function will update existing records to the local offline database excluding attach-
ments.

Function Signature: executeUpdate(DARequestdaRequest)

Function Name: executeUpdate

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

                objDAReq.UserName = “techuser@acme.com”;

                objDAReq.APIKey = “95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk”;

                objDAReq.ObjectName = “Account”;

                objDAReq.SourceLocation = “”;

objDAReq.DestinationLocation=””;

      objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = ("Name");

objFD.setValue = ("Burlington");

objFD.setType = ("nvarchar") ;

arrFD.Add(objFD);
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objFD = new FieldData();

objFD.setName = ("Type");

objFD.setValue = ("Other");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

objFD = new FieldData();

objFD.setName = ("BillingStreet");

objFD.setValue = ("Main Street");

objFD.setType= ("nvarchar");

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

ArrayList arrCD = new ArrayList();

CriteriaData objCD = new CriteriaData();

objCD.setName = "Account_PID";

objCD.setValue = "1";

objCD.setOperator = "=" ;

arrCD.Add(objCD);

objCD = new CriteriaData();

objCD.setName = "OwnerId";

objCD.setValue = "3";

objCD.setOperator = "=" ;

arrCD.Add(objCD);

objDAReq.Criteria = arrCD;

                objDAReq.AdvanceExpression = "1 AND 2";

                objDAReq.OrderBy = “”;
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                objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation = “”;

                objDAReq.ReferenceObjectName = “”;

LaptopMobile.DataAccessAPI.DataAccessAPI objDAAPI = new LaptopMobile.DataAc-

cessAPI.DataAccessAPI();

if (objDAAPI.executeUpdate(objDAReq) == 1 )

                txt1.Text = objDAReq.Response;

else

txt1.Text = objDAReq.Response;

executeDelete(DARequest daRequest)

This function is used to delete existing records from the local offline database including
attachments.

Function Signature: executeDelete(DARequest daRequest)

Function Name: executeDelete

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "SVMXC__Service_Order_Line__c";

objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation=””;

                objDAReq.ReferenceObjectName=””;

objDAReq.FieldNames = null;
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ArrayList arrCD = new ArrayList();

CriteriaData objCD = new CriteriaData();

objCD.setName = "SVMXC__Service_Order_Line__c_PID";

objCD.setValue = "1";

objCD.setOperator = "=" ;

arrCD.Add(objCD);

objDAReq.Criteria = arrCD;

objDAReq.AdvanceExpression = "";

objDAReq.OrderBy = "";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";

LaptopMobile.DataAccessAPI.DataAccessAPI objDAAPI = new LaptopMobile.DataAc-

cessAPI.DataAccessAPI();

if (objDAAPI.executeDelete(objDAReq) == 1 )

{

                txt1.Text = objDAReq.Response;

}

Else

{

txt1.Text = objDAReq.Response;

                }

executeQuery(DARequest daRequest)

This function is used to query existing records from the local offline database including
attachments.
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Function Signature: executeQuery(DARequest daRequest)

Function Name: executeQuery

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "SVMXC__Installed_Product__c";

objDAReq.SourceLocation = “”;

                objDAReq.DestinationLocation=””;

                objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = "SVMXC__Installed_Product__c_PID";

arrFD.Add(objFD);

objFD.setName = "Id";

arrFD.Add(objFD);

objFD.setName = "OwnerId";

arrFD.Add(objFD);

objFD.setName = "Name";

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

ArrayList arrCD = new ArrayList();

CriteriaData objCD = new CriteriaData();

objCD.setName = "SVMXC__Product_Name__c";

objCD.setValue = "'RASINHS'";
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objCD.setOperator = "LIKE" ;

arrCD.Add(objCD);

objCD = new CriteriaData();

objCD.setName = "SVMXC__Serial_Lot_Number__c";

objCD.setValue = "NULL";

objCD.setOperator = "<>" ;

arrCD.Add(objCD);

objDAReq.Criteria = arrCD;

objDAReq.AdvanceExpression = "1 OR 2";

objDAReq.OrderBy = "Name DESC";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";

LaptopMobile.DataAccessAPI.DataAccessAPI objDAAPI = new LaptopMobile.DataAc-

cessAPI.DataAccessAPI();

if (objDAAPI.executeQuery(objDAReq) == 1 )

{

txt1.Text = objDAReq.Response;

}

Else

{

                txt1.Text = objDAReq.Response;

}

getDbObjects(DARequest daRequest)

This function is used to get the list of objects the user is allowed for the CRUD operation
from the local offline database.
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Function Signature: getDbObjects(DARequest daRequest)

Function Name: getDbObjects

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "";

objDAReq.SourceLocation = “”;

objDAReq.DestinationLocation=””;

objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = "*";

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;

objDAReq.Criteria = null;

objDAReq.AdvanceExpression = "";

objDAReq.OrderBy = "Name DESC";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";

LaptopMobile.DataAccessAPI.DataAccessAPI objDAAPI = new LaptopMobile.DataAc-

cessAPI.DataAccessAPI();

if (objDAAPI.getDbObjects(objDAReq) == 1 )
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{

             txt1.Text = objDAReq.Response;

}

Else

{

                txt1.Text = objDAReq.Response;

}

getDBObjectFields (DARequest daRequest)

This function is used to get the list of fields for a given object from the local offline data-
base with its permissions and data type.

Function Signature: getDBObjectFields(DARequest daRequest)

Function Name: getDBObjectFields

Parameter: DARequest

Sample Code:

DARequest objDAReq = new DARequest();

objDAReq.UserName = "techuser@acme.com";

objDAReq.APIKey = "95757CQrHzBhvIfI1ZtX47HNL+nxUMscZY8sk";

objDAReq.ObjectName = "Account";

objDAReq.SourceLocation = “”;

objDAReq.DestinationLocation=””;

objDAReq.ReferenceObjectName=””;

ArrayList arrFD = new ArrayList();

FieldData objFD = new FieldData();

objFD.setName = "*";

arrFD.Add(objFD);

objDAReq.FieldNames = arrFD;
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objDAReq.Criteria = null;

objDAReq.AdvanceExpression = "";

objDAReq.OrderBy = "Name DESC";

objDAReq.SourceLocation ="";

objDAReq.DestinationLocation = "";

objDAReq.ReferenceObjectName = "";

LaptopMobile.DataAccessAPI.DataAccessAPI objDAAPI = new LaptopMobile.DataAc-

cessAPI.DataAccessAPI();

if (objDAAPI.getDBObjectFields(objDAReq) == 1 )

{

                txt1.Text = objDAReq.Response;

}

Else

{

                txt1.Text = objDAReq.Response;

}

'>
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API MESSAGES

Overview
The following tables describe the information and error messages used in the ServiceMax
Offline Client for API.

Information Messages

Message Number Description

MSG-001 Field information for the given object retrieved successfully.

MSG-002 Object information for the given object retrieved successfully.

MSG-003 Record(s) updated successfully. Number of rows updated.

MSG-004 Record(s) deleted successfully. Number of rows deleted.

MSG-005 Record(s) inserted successfully. Number of rows inserted.

MSG-006 Record(s) retrieved successfully. Number of rows queried.

MSG-007 No records found.

Error Messages

Error Num-

ber
Description

ERR-001 Invalid Request: API key not found or invalid.

ERR-002 Object name cannot be null.

ERR-003 Invalid database credentials.

ERR-004 Error inserting records. Permission denied. Verify object and field level per-
missions.
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Error Num-

ber
Description

ERR-005 Error updating records. Permission denied. Verify object and field level per-
missions.

ERR-006 Error deleting records. Permission denied. Verify object and field level per-
missions.

ERR-007 User's credentials have expired. Login to SVMX Offline application and validate
the user.

ERR-008 Error inserting records. File not found. Verify file exists at source location.

ERR-009 Error inserting records. Parent ID is null. Verify Parent ID exists if object is
Attachment.

ERR-010 Error inserting records. Data type mismatch.

ERR-011 Error inserting records. Reference column value is not present in parent table.

ERR-012 Error inserting records. Permission denied. Verify object level permissions.

ERR-013 Error updating records. Permission denied. Verify object level permissions.

ERR-014 Error deleting records. Permission denied. Verify object level permissions.

ERR-015 Error accessing API. Permission denied. Verify user level permissions.

ERR-016 Error inserting records. File size is greater than maximum size limit.

API Messages
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ACCOUNTS/COMPANIES

Overview
Account is a standard feature in Salesforce. In ServiceMax, an account is interchangeably
referred to as a Company. Accounts are organization's customers, partners, suppliers, and
service providers. Each account stores information such as name, address, and phone num-
bers for which you can store related information such as opportunities, cases, ser-
vice/maintenance contracts, installed products and Work Orders.

To learn about how to create, edit and manage account information in Salesforce, see the
online help from the Accounts tab on Salesforce.com.

See Also:

Case

Installed Product

Service/Maintenance Contract

Work Order
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CONTACT

Overview
Contacts are individuals associated with business accounts that you need to track in Sales-
force. You can store information for a contact such as phone numbers, addresses, titles,
and roles in a deal. The Contacts tab displays a home page that enables you to create and
locate contacts quickly. You can also sort and filter contacts using standard and custom
list views. For each contact, you can store and track related information such as cases
reported, installed products, service/maintenance contracts, Work Orders and other ser-
vice activities.

To learn about how to create, edit and manage contact information in Salesforce, see the
online help from the Contacts tab on Salesforce.com.

See Also:

Case

Installed Product

Service/Maintenance Contract

Work Order
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PRODUCT

Overview
Product is a standard feature in Salesforce. Products are the individual items that you sell
on your opportunities and any item that you need to keep track of from a service delivery
standpoint. You can create a product and create multiple instances of Installed Products
for each product in ServiceMax.

You can also associate products with Service/Maintenance Contracts and Warranty Terms,
and use them in various service transactions such as Customer Entitlement on Case, RMA,
Shipment, and Work Orders. To learn about how to create, edit, and manage product
information in Salesforce, see the online help from the Products tab on Salesforce.com.

Custom Product Fields

Fields Description

Product
Line

Product line to which the product belongs. This list will be specific to your business.
For example, a computer manufacturer may have Laptop, Desktop,and Server as
available values.

Inherit
Parent
Warranty

This checkbox indicates if this part number will automatically inherit its parent
product’s warranty when used in an Installed Product configuration. If this checkbox
is selected, the parent product’s warranty is copied automatically to the child
product.

Tracking Indicates how this product is tracked when shipped to customers. Serialized
products will have serial numbers, Lot/Batch Tracked products will have a batch
number and Non-Tracked products will not have either of the above.

Unit of
Measure

The unit of measure used to determine the product quantity. There is no functionality
associated with this field. This field can be included in reports that show product
quantities for better readability.

Stockable This checkbox indicates if this product is stockable. ServiceMax does not maintain
inventory of non-stockable products.
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Fields Description

Enable
Serialized
Tracking
of Stock

This checkbox indicates if stock information for this product is tracked at the serial
number level. If this flag is selected and if serialized tracking of inventory is enabled
for your organization, serial number information will be captured in all ServiceMax
inventory transactions.

Product
Cost

Product cost in the default currency for your organization. Used for computing invent-
ory value in ServiceMax.

See Also:

Case

Returned Material Authorization (RMA)

Service/Maintenance Contract

Shipment Order

Work Order

Product
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LOCATION

Overview
Location is unique information that is identified by a name and address. It is especially
beneficial in service scenarios when accurate information about the physical location of a
product is crucial to the timely delivery of service. ServiceMax uses location to track ware-
house and field inventory locations.

Access and Permissions

Actions User Permissions Needed

Actions User Permissions Needed

To view the Location tab: "Read" on Location

To view locations: "Read" on Location

To create or clone locations: "Create" on Location

To change locations: "Edit" on Location

To delete locations: "Delete" on Location

To validate locations address: "Read" and "Edit" on Location

Click the Locations tab to display the Locations home page.

Caution: Remember that when deleting a Location record, you will not be
warned if the location is used in a related record. Since locations are related to
numerous ServiceMax records such as installed product, RMA, Shipment, Work
Order, inventory, and so on, review and make sure the location record is not
used in any related records.
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Location Fields

Field

Name
Description

Location

Name

Name of the location. It is not required to be unique.

Street "Street" part of the location's address.

City "City" part of the location's address.

State "State/Province" part of the location's address.

Zip "Zip/Postal code" part of the location's address.

Country "Country" part of the location's address.

Location
Type

Indicates the type of location, such as Manufacturing unit, headquarters, warehouse,
field location, or branch office.

Account The company to which this location belongs. Note that you can maintain your own
organization’s locations in which case you will create an Account record for your com-
pany.

Phone Main phone number of the location (if available).

Fax Main fax number of the location (if available).

Web site Website URL for the location (if available).

Service
Engineer

Service Engineer (ServiceMax user) associated with this location. Applicable to loc-
ations of type Field Location only.

Costed At
Value

Flag indicates if inventory in this location is priced using price book value or priced at
zero. Clear this flag for scrap locations.

Inventory
Account

Inventory account number for this location. Used for costing/accounting purposes.

Stocking
Location

Flag indicates if this is a stocking location or not. ServiceMax does not perform
inventory updates on non-stocking locations.

Latitude Geographical code for this location. This is calculated automatically using the Val-
idate Address feature.

Longitude Geographical code for this location. This is calculated automatically using the Val-
idate Address feature.

Email Email address of the location (if available).

Location
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Validating Location Address

To validate a created location:

1. Navigate to the location record from the Locations tab.

2. Click Validate Address. A dialog appears indicating the validation process.

If the address is valid, a message indicating the same appears and the location
record will be refreshed. The latitude and longitude fields are populated on the
screen.

If the address is invalid, an error message appears and you will be returned to the
location record.  

Note: An address could become invalid because of spelling mistakes or if the
address contains PO Box or Suite numbers. Since this functionality uses the
Google Maps engine, ability to validate an address depends upon the level of
coverage for countries provided by Google.

See Also:

Case

Parts Request

Returned Material Authorization (RMA)

Service/Maintenance Contract

Shipment Order

Stock Adjustment

Stock Transfer

Work Order

Validating Location Address 659
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AVAILABLE SERVICES

Overview
Service is an activity which is performed during service delivery. For example, a service
provider for modems may list installation, configuration, troubleshooting, and on site
repair as various services. Service definition is used in Service Contracts to define the cov-
erage for a customer.

Access and Permissions

Actions User Permissions Needed

To view the Available Services: "Read" on Available Services

To create or clone Available Services: "Create" on Available Services

To change Available Services: "Edit" on Available Services

To delete Available Services: "Delete" on Available Services

Click Home > ServiceMax Setup > Services to view the Available Services home
page.

Caution: Remember that when you are deleting Available Services record(s),
you will not be warned if the service is used in a related record. Since services
are related to other ServiceMax records such as service/maintenance contract
and service team, review and make sure the service record is not used in any
related records.
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Available Services Fields

Fields Description

Service
Name

Name of the service. When naming the service be as specific and granular as pos-
sible. For example, instead of Windows OS Installation, you can enter Windows Vista
Installation for Intel Laptops.

Effective
Date

Date from which this service is available to your customers. This is an optional field.

Data
Type

Type of data to be captured as Commitment when using a service in an SLA Terms
record. Options are: Text, Number, Frequency,and Boolean.

Service
Type

Indicates the type of service. This helps in grouping similar types of services for
reporting purposes. Your system administrator is responsible for configuring this list
for your organization’s requirements.

Active Checkbox that indicates if this service is currently active and available for use.

Available Services Screen
Click the Available Services tab to display the Available Services page. See figure
below.

Figure 1: Recent Available Services Screen

Creating a New Available Service

To create a new Available Service:

1. Click the New button in the Recent Available Services screen. See figure above.

2. In the Manage Service area:

a. Enter or search for the Qualifying Criteria.

Available Services
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Available Services

b. Enter the Service Name.

c. In the Tracked On picklist, selectWork Order or Case.

3. In Service Pricebook Entry Lines area, select an Activity Master by entering the
name in the text field, using the Quick Find search feature, or clicking the bubble
icon to search for the Activity Master. See figure below.

Figure 2: Create Services Screen

4. Click Save to save the Available Service.

5. Click Save & New to save the Available Service and create a new Available Service.

6. Click Cancel to cancel the Available Service.

See Also:

Service/Maintenance Contracts

SLA Terms

Creating a New Available Service 663
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SLA TERMS

Overview
Service Level Agreement (SLA) Terms indicate the details of coverage a customer is
entitled to receive in a service/maintenance contract or a service-level agreement. For
example, a Bronze level coverage might be used to provide a response within a maximum
of 24 hours whereas a Platinum level coverage can be used for response within 4 hours.
Service level can also be used to indicate exceptions, and coverage based on time-of-the-
day (8 or 24) and day-of-the-week (5 or 7) support eligibility of a customer.

SLA Terms consists of the following blocks of information:

General Information: Name, description, and so on.

Initial Response: Rules based on Case/Work Order Type and Priority to indicate
how to calculate initial response time when entitled by an SLA Term.

Onsite Response: Rules based on Case/Work Order Type and Priority to indicate
how to calculate onsite response time when entitled by an SLA Term

Restoration: Rules based on Case/Work Order Type and Priority to indicate how to
calculate restoration time when entitled by an SLA Term.

Resolution: Rules based on Case/Work Order Type and Priority to indicate how to
calculate resolution time when entitled by an SLA Term.

Services: List of services and commitments provided as part of the SLA Terms.

Once SLA Terms are defined and when advanced SLA management is enabled for your
organization, the ServiceMax SLA engine calculates commitment times automatically on
Case and Work Order. Based on the calculated timestamps, the Case and the Work Order
screens will display a countdown clock on various time commitments.
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Access and Permissions

Actions User Permissions Needed

To view SLA Term: "Read" on SLA Terms and SLA Detail

To create SLA Term: "Create" on SLA Terms and SLA Detail

"Read" on Case and Work Order

To change SLA Term: "Update" on SLA Terms and SLA Detail

"Read" on Case and Work Order

To delete SLA Term: "Delete" on SLA Terms and SLA Detail

 Click Home > ServiceMax Setup > SLA Terms to view the SLA Terms home page.

Figure 1: SLA Terms Home Page

Caution: Starting from ServiceMax 3.0 release, ServiceMax SLA Terms
provides the ability to define advanced commitments such as initial response,
onsite response, restoration, resolution and services. Considering the data integ-
rity requirements to maintain such advanced rules, the above specialized
screen has been introduced in ServiceMax. Hence, SLA Terms should not be cre-
ated or updated using the standard screens of Salesforce.

SLA Terms
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SLA Terms Fields

Fields Description

SLA Terms
Name

Name of the service level. Example Gold, Silver, Basic, and Premier.

Description Detailed description of the service level. Details entered here are displayed in the
Case / Work Order Entitlement Screens when a service/maintenance contract is
selected.

Active Checkbox that indicates if the service level is currently active and available for
use.

Effective
Date

Date from which this service level is available for offering to customers through
service contracts.

Default Busi-
ness Hours

Business hours to be used when applying the SLA Terms on Case or Work Orders.
This is a lookup to an existing Salesforce business hours record.

Initial
Response
Tracked On

Indicates if initial response is tracked on Case or Work Order if a Case/Work
Order is entitled using these SLA Terms.

Onsite
Response
Tracked On

Indicates if onsite response is tracked on Case or Work Order if a Case/Work
Order is entitled using these SLA Terms.

Restoration
Tracked On

Indicates if restoration time is tracked on Case or Work Order if a Case/Work
Order is entitled using these SLA Terms.

Resolution
Tracked On

Indicates if resolution time is tracked on Case or Work Order if a Case/Work
Order is entitled using these SLA Terms.

Type Case/Work Order type.

Priority Case/Work Order priority.

Clock Starts
From

Case or Work Order timestamp from which the SLA clock starts for the type of
commitment.

Internal
Goal

Internal goal in minutes for meeting the type of commitment, if different from
customer commitment.

Customer
Commitment

Commitment made to customer in minutes for response, restoration, or res-
olution.
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Fields Description

Business
Hours Type

Indicates which business hours to be used to calculate the SLA commitment on
Case/Work Order when entitled by these SLA Terms. Options are Account,
Product (Installed Product), Service Contract, SLA, or Custom.

Business
Hours

Business hours to be used to calculate SLA commitments on Case or Work Order
when entitled by these SLA Terms. Used only if Business Hour Type is Custom.

Creating SLA Terms

To create a new SLA Term:

1. Click New SLA Terms in the SLA Terms home page. A new SLA Term record appears
below the existing records as shown below:

Figure 2: New SLA Term Record Screen

2. Enter a unique SLA Term name in the SLA Terms Name field.

3. Enter a detailed description of the SLA Term in the Description field.

4. Check the Active checkbox, if this service level is available for use.

5. Enter the default business hour or select the default business hours applicable by click-
ing the Lookup icon in the Default Business Hours field. This could be used to cal-
culate response, restoration and resolution times for Cases and Work Orders that are
entitled by this SLA Terms.

Note: The SLA commitments can be tracked on Case only if allowed by your
ServiceMax license. Please contact your ServiceMax administrator to know the
type of license used by your organization.

SLA Terms
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Creating Initial Response Commitment

To provide initial response commitment to your customers:

1. Click Initial Response tab to view the Initial Response screen as shown below:

Figure 3: SLA Terms - Initial Response Screen

2. Click Case orWork Order from the Initial Response Tracked On picklist. Depend-
ing on the selected value, the Type, Priority, and Clock Starts From fields will dis-
play the applicable values from the Case or Work Order.

3. Click Add Record to add a new initial response commitment record. If Initial
Response Tracked On is selected as None, then clicking Add Record will not
include any values under any fields for selecting.

4. Select a valid value for Type, Priority, and Clock Starts From in the appropriate
fields.

5. Enter the Internal Goals in minutes, if your internal SLA goals are different from cus-
tomer commitment.

6. Select the appropriate value from the Business Hours From picklist. If you want to
use created business hours, click Custom and then locate the record using the
Lookup icon.

7. Click Save on the top section of the SLA Terms screen to save your changes.

8. Click Next to view the Onsite Response tab.
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Creating Onsite Response Commitment

To provide onsite response commitment to your customers:

1. Click the Onsite Response tab to view the Onsite Response screen as shown below:

Figure 4: SLA Terms - Onsite Response Screen

2. Click Case orWork Order from the Onsite Response Tracked On picklist. Depend-
ing on the selected value, the Type, Priority, and Clock Starts From fields will dis-
play the applicable values from the Case or Work Order.

3. Click Add Record to add a new onsite response commitment record. If Onsite
Response Tracked On is selected as None, then clicking the Add Record will not
include any values under any fields for selecting.

4. Select a valid value for Type, Priority, and Clock Starts From.

5. Enter the Internal Goals field in minutes, if your internal SLA goals are different from
customer commitment.

6. Select the appropriate value from the Business Hours From picklist. If you want to
use created business hours, click Custom and then locate the record using the
Lookup icon.

7. Click Save on the top section of the SLA Terms screen to save your changes.

8. Click Next to view the Restoration tab.
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Creating Restoration Commitment

To provide restoration commitment to your customers:

1. Click the Restoration tab to display the Restoration screen as shown below:

Figure 5: SLA Terms - Restoration Screen

2. Click Case orWork Order from the Restoration Tracked On picklist. Depending
on the selected value, the Type, Priority, and Clock Starts From fields will display
the applicable values from the Case or Work Order.

3. Click Add Record to add a new restoration commitment record. If Restoration
Tracked On is selected as None, then clicking Add Record will not include any val-
ues under any fields for selecting.

4. Select the valid value for Type, Priority, and Clock Starts From.

5. Enter the Internal Goals field in minutes, if your internal SLA goals are different from
customer commitment.

6. Select the appropriate value from the Business Hours From list. If you want to use
created business hours, click Custom and then locate the record using the Lookup
icon.

7. Click Save on the top section of the SLA Terms screen to save your changes.

8. Click Next to view the Resolution tab.
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Creating Resolution Commitment

To provide resolution commitment:

1. Click the Resolution tab to view the resolution screen as shown below:

Figure 6: SLA Terms - Resolution Screen

2. Click Case orWork Order from the Resolution Tracked On picklist. Depending on
the selected value, the Type, Priority, and Clock Starts From fields will display the
applicable values from the Case or Work Order.

3. Click Add Record to add a new resolution commitment record. If Resolution
Tracked On is selected as None, then clicking Add Record will not include any val-
ues under any fields for selecting.

4. Select the valid value for Type, Priority, and Clock Starts From.

5. Enter the Internal Goals field in minutes, if your internal SLA goals are different from
customer commitment.

6. Select the appropriate value from the Business Hours From picklist. If you want to
use created business hours, click Custom and then locate the record using the
Lookup icon.

7. Click Save on the top section of the SLA Terms screen to save your changes.

8. Click Next to view the Services tab.
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Creating Services

To define the services and commitment level on each service

covered by this SLA Terms:

1. Click the Services tab to view the Services screen as shown below:

Figure 7: SLA Terms - Services Screen

2. Click Add Service. A new service commitment record appears.

3. Enter a service name or select a valid service using the Lookup in the Service Name
field. When a valid service name is selected, the Edit Commitment link is enabled.

4. Click the Edit Commitment link to enter a commitment for the service. The screen
will show appropriate fields based on the Data Type of the service. See Available Ser-
vices to learn more about the supported data types for service.

Figure 8: Edit Commitment Screen

5. Click Save on the top section of the SLA Terms screen to save your changes.
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To add multiple services, follow the steps below:

1. Enter a keyword in the Search services field and then click Go!. A list of available ser-
vices which are not added to the left section appears.

2. Select one or more services using the checkbox available before the service name.

3. Click Add Selected to add the selected services.

Editing SLA Terms

To edit an existing SLA Terms record:

Note: Creating a new SLA Terms record or editing an existing record displays
the same screen.

1. Check the checkbox against the record to be edited and then click Edit in the SLA
Terms home page. The SLA Terms record screen appears for editing with all the exist-
ing values.

2. Edit the fields such as name and description to suit your needs.

3. Edit the appropriate commitments available to your customers by clicking the appro-
priate commitment tabs.

4. Click Save to save the changes.

Deleting SLA Terms

Note: When deleting an SLA Term, you will not be warned if the SLA Term is
referenced in Cases, Work Orders, or Entitlement History.

To delete existing SLA Terms record(s):

1. Check one or more checkboxes against the SLA Terms record(s) you want to delete in
the SLA Terms home page.

2. Click Delete and then click OK to confirm the deletion.
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See Also:

Cases

Service Level Agreement Settings

Work Order
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WARRANTY TERMS

Overview
Warranty Terms is a template that allows organizations to define and standardize their
warranty offering and apply it to a range of products automatically. The template can be
used to define the type and scope of coverage in a warranty such as parts, labor and
expenses, and can then be associated with one or more products. When installed product
records are created in ServiceMax, warranty will be calculated automatically based on the
pre-defined warranty template associated with the product.

Access and Permissions

Actions User Permissions Needed

To view the Warranty
Terms tab:

"Read" on Warranty Terms

To view the Warranty
Terms:

"Read" on Warranty Terms

To create or clone War-
ranty Terms:

"Create" on Warranty Terms

To change Warranty
Terms:

"Edit" on Warranty Terms

To delete Warranty
Terms:

"Delete" on Warranty Terms

To view applicable
products:

"Read" on Applicable Products and Warranty Terms

To create applicable
products:

"Create" on Applicable Products

To edit applicable
products:

"Edit" on Applicable Products
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Actions User Permissions Needed

To delete applicable
products:

"Delete" on Applicable Products

To define coverage by
Counters:

"Read" on Applicable Products, Warranty Terms, ServiceMax Pro-
cess, and ServiceMax Config Data

"Read", "Create", and "Update" on Counter Details

Click theWarranty Terms tab to display the Warranty Terms home page.

Caution: Remember that when deleting a warranty terms record, you will not
be warned if the warranty terms are used in a related record. Since warranty
terms are strongly tied to installed products and entitlements, review and make
sure the warranty terms record is not used in any related records.

Warranty Terms Fields

Fields Description

Template
Name

Name of the warranty terms template.

Template
Type

Indicates if this template is used for warranty calculation or referred to in ser-
vice/maintenance contracts. When creating warranty for installed products, only
templates with type Warranty are considered.

Material %
Covered

A number between 1 and 100 indicating the percentage of coverage on parts. If
Material coverage % is specified, duration and unit of time should be specified
too.

Duration of
Material
Coverage

A number indicating the duration of coverage for parts.

Unit of Time
for Material
Coverage

A value that qualifies the material coverage duration in days, weeks, months or
years.

Labor %
Covered

A number between 1 and 100 indicating the percentage of coverage on labor. If
Labor coverage % is specified, duration and unit of time should be specified too.

Warranty Terms
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Fields Description

Duration of
Labor Cover-
age

A number indicating the duration of coverage for labor.

Unit of Time
for Labor
Coverage

A value that qualifies the labor coverage duration in days, weeks, months or
years.

Expenses %
Covered

A number between 1 and 100 indicating the percentage of coverage on expenses.
If Expenses coverage % is specified, duration and unit of time should be spe-
cified too.

Duration of
Expenses
Coverage

A number indicating the duration of coverage for expenses.

Unit of Time
for Expenses
Coverage

A value that qualifies the expenses coverage duration in days, weeks, months or
years.

RMA Required Flag indicates if an RMA is always required or an RMA is implied when this war-
ranty is used to entitle a customer. This flag does not drive any functionality in
ServiceMax and is for informational purposes only.

Shipment
Allowed

Flag indicates if customer shipments are covered by the warranty. This flag does
not drive any functionality in ServiceMax and is for informational purposes only.

Transferable Flag indicates if this warranty is transferable to other products under special cir-
cumstances. This flag does not drive any functionality in ServiceMax and is for
informational purposes only.

Walk-in
Allowed

Flag indicates if the customer is authorized to walk into a service center for ser-
vice. This flag does not drive any functionality in ServiceMax and is for inform-
ational purposes only.

Onsite
Repair

Flag indicates if customer is eligible for onsite repair when entitled by this war-
ranty. This flag does not drive any functionality in ServiceMax and is for inform-
ational purposes only.

Loaner
Provided

Flag indicates if customer is given a temporary replacement product when the
covered product is under repair. This flag does not drive any functionality in Ser-
viceMax and is for informational purposes only

Invoice
Required

Flag indicates if an invoice is always raised at the end of service delivery. This
flag does not drive any functionality in ServiceMax and is for informational pur-
poses only.
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Fields Description

Exclusions A free format text to define any exceptions not covered by the standard cov-
erage of the template.

Coverage
Effective
From

Identifies how to calculate the warranty start date for installed products. It can
be any Date field on the installed product record. See Configuring Coverage
Start Date for more information.

All Products
Covered

Flag indicates if all products involved in the repair will be covered by this war-
ranty. This flag does not drive any functionality in ServiceMax and is for inform-
ational purposes only.

All Services
Covered

Flag indicates if all services performed will be covered by this warranty. This
flag does not drive any functionality in ServiceMax and is for informational pur-
poses only.

Configuring Coverage Start Date
Warranty can be configured to start from any event (date) on an installed product. This
includes standard ServiceMax fields such as Ship Date, Install Date, Order Date or any cus-
tom date field created in Installed Product for your implementation of ServiceMax.

To configure the applicable start date for a warranty terms record:

1. Locate the warranty terms record from the Warranty Terms tab and then click the war-
ranty terms record. The warranty term record information screen appears.

2. Click Configure Start Date. The Define Warranty Coverage Start Date screen as
shown below appears:

Figure 1: Define Warranty Coverage Start Date Screen
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Note: The Coverage Effective From picklist shows the name of all the
Date fields available in installed product such as Date Installed, Date
Ordered, Date Shipped, Last Activity Date, and Last Date Shipped.

3. Select an applicable date from the Coverage Effective From picklist, and then click
Save. A success message appears.

4. Click Close to close the Configure Start Date screen.

Including Applicable Products
You can add a product(s), product line, or product family to a warranty term record by
using the Applicable Product section.

Applicable Products Fields

Field-

s
Description

Warranty
Terms

Name of the warranty terms. This is a lookup to the existing warranty terms record
in ServiceMax.

Product
Family

Product family covered by this template. Your system administrator is responsible
for configuring this list for your organization's requirement.

Product Product covered by the template. This is a lookup to an existing Product in Sales-
force.

Product
Line

Product Line covered by the template. Your system administrator is responsible for
configuring this list for your organization's requirement.

Adding Product(s) to Warranty Terms

To add a product or products to an existing warranty template:

1. Locate the warranty terms record by searching in the sidebar or from a list view in the
Warranty Terms tab and then click the warranty term to display the selected record
information.

2. Click the New Applicable Product in the Applicable Products section. The Applicable
Products Edit screen appears with the warranty term's name auto-populated.
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a. Enter the product in the Product field, if the template covers a specific part num-
ber. You can also search for the product by clicking the Lookup icon.

b. Select the appropriate value from the Product Family or the Product Line pick-
list, if the template covers all the products in a product family or product line.

3. Click Save.

Note: Each warranty terms record can cover an unlimited number of products,
families or lines. Repeat the above steps for each product you want to asso-
ciate with the terms. You can also click Save & New after creating a new
Applicable product record.

Defining Counters-based Coverage
If your products have ongoing readings that are measured using embedded or external
devices, and if those readings impact customer entitlements, you can define such cov-
erage in warranty terms. Coverage defined using counters can be applied in auto-enti-
tlement in Cases. Interactive entitlement does not support counter-based coverage in this
release. Counters applicable to various products in your organization must be defined
before using this feature. Talk to your ServiceMax administrator if you are unable to view
all the relevant counters while defining coverage.

When warranty is created for an installed product, Counters-based coverage is not copied
fromWarranty Terms into Product Warranty. The warranty always refers to the counters-
based coverage in warranty terms. Any change made in counters-based coverage in a war-
ranty terms record will impact all product warranties created from it.

To define Counters-based Coverage:

1. Locate the warranty terms record by searching in the sidebar or from a list view in the
Warranty Terms tab and then click the warranty term to display the selected record's
information.
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2. Click Coverage By Counters. The Enter Coverage Limit screen appears with all
applicable counters covered by the warranty terms.

Figure 2: Enter Coverage Limit Screen

3. For products that require counters-based coverage:

a. Enter the starting reading in the Coverage Starts At field, from which the cov-
erage starts. For example, if the product is a car with 100 miles on the odometer
at the time of sale, enter 100.

b. Enter the number of counters supported by this warranty term in Counters
Covered field. For example, to indicate 3000-mile service, enter 2900.

4. Skip the products that do not require counter-based coverage by leaving the Cover-
age Start At and the Counters Covered fields as zero.

5. Click Save. You will be redirected to the warranty terms record. Alternatively, click
Cancel to return to the warranty terms without saving.

See Also:

Product

RMA

Shipment Order

ServiceMax Processes
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INSTALLED PRODUCT

Overview
Installed Product represents one or a collection of product units delivered to a customer
and installed at the customer’s location(s). Depending upon the tracking needs of an organ-
ization, Installed Products are tracked using a serial number, a lot/batch number, or
simply by the product number. In ServiceMax, Installed Product record drives entitlement,
material movement, and service delivery activities.

Access and Permissions

Actions User Permissions Needed

To view the Installed Products
tab:

"Read" on Installed Products

To view the Installed Products: "Read" on Installed Products, Account, Contact, Loca-
tion, and Product

To create or clone Installed
Products:

"Create" on Installed Products

"Read" on Account, Contact, Location, and Product

To change Installed Products: "Edit" on Installed Products

"Read" on Account, Contact, Location, and Product.

To delete Installed Products: "Delete" on Installed Products

To create child Installed Products: "Create" on Installed Product

"Read" on Account, Contact, Location and Product

To validate Installed Products
address:

"Read" and "Edit" on Installed Products
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Actions User Permissions Needed

To capture Counter Reading: "Read" on Installed Product, ServiceMax Process, and

ServiceMax Config data

"Read", "Create", and "Update" on Counter Details

To view warranties: "Read" on Installed Product and Product Warranty

To create warranties: "Create" on Installed Product and Product Warranty

To change product warranties: "Edit" on Product Warranty

To delete product warranties: "Delete" on Product Warranty

To create a case from Installed
Products:

"Read" on Account, Contact, Installed Product, and

Product

"Create" on Case

To create a Work Order from
Installed Products:

"Read" on Account, Contact, Installed Product, and

Product

"Create" on Work Order

Click the Installed Products tab to view the Installed Products home page.

Caution: Since installed products are strongly connected to most ServiceMax
transactions, review and make sure the installed product record is not used in
any related records. When you are deleting an Installed Product, you will not be
warned if the installed product is used in a related record. Instead of deleting an
installed product, it is always recommended to change the status to Scrap.

Installed Products Fields

Fields Description

Product Name of the product. This is a lookup to an existing Salesforce Product
record.

Serial/Lot Num-
ber

Unique identification of the product. This information is required if the
product's tracking is Serialized or Lot/Batch tracked in the product record.

Installed Product
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Fields Description

Parent Serial/Lot number of the parent product in the Installed Product hierarchy.
This is a lookup to an existing Installed Product record.

Parent Product This appears automatically when a parent serial/lot number is selected and is
read-only.

Top-level Serial/Lot number of the top-most product in the Installed Product hierarchy.

Top-level
Product

This appears automatically when the top-level serial/lot number is selected
and is read-only.

Asset Tag Another way to identify the Installed Product. Typically asset tags are
assigned by your customers. This will be a time saver when your customer
calls for support and identifies the product by their asset tag instead of trying
to locate your serial number on the product.

Account/Company Name of the customer for the Installed Product. This is a lookup to an existing
Salesforce Account record.

Contact Name of the primary contact for this Installed Product at the customer’s loc-
ation. This is a lookup to an existing Salesforce Contact record.

Alternate
Account

Free text to indicate if another contact is involved with this product but is not
an existing customer record.

Distributor
Account

Name of the distributor account (if applicable).

Distributor
Contact

Name of the distributor contact (if applicable).

Sales Order Num-
ber

Sales order reference (typically from the ERP application).

Status Current status of the Installed Product.

Date Ordered Date on which the product is ordered by the customer.

Date Shipped Date on which the product was shipped to the customer originally.

Last Date
Shipped

If this product was shipped multiple times, date of the most recent shipment.
Multiple shipments are possible if the product is returned for depot repair or
service.

Date Installed Date on which the product was installed at the customer location.

Location Current physical location of the product. This is a lookup to an existing Loca-
tion record.
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Fields Description

Street "Street" part of the physical location address.

City "City" part of the physical location address.

State "State" part of the physical location address.

Zip "Zip or Postal Code" part of the physical location address.

Country "Country" part of the physical location address.

Installation
Notes

Any technical information relevant for the service organization. This is nor-
mally supplied by field service engineers upon completion of installation.

Latitude Geographical code for this Installed Product’s address. This is calculated auto-
matically using the Validate Address feature.

Longitude Geographical code for this Installed Product’s address. This is calculated auto-
matically using the Validate Address feature.

Preferred Tech-
nician

Name of the technician. This is a lookup to an existing ServiceMax Tech-
nician/Equipment record.

Access Hours Time period during which this installed product can be accessed for service.
Reference to an existing Business Hours record in Salesforce.

Building Installed Product Hierarchy
The illustration below is a sample product configuration with four levels in the hierarchy.
The table illustrates how you can represent that configuration in ServiceMax. There is no
limit to the number of levels in the ServiceMax Installed Product hierarchy.

Figure 1: Installed Product Hierarchy
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Level Product Serial Number Parent Serial Number Top-level Serial Number

1 (Top) PRODUCT-001 <Blank> <Blank>

2 (Middle) ASSEMBLY-001

ASSEMBLY-002

PRODUCT-001

PRODUCT-001

PRODUCT-001

PRODUCT-001

3 (Middle) ASSEMBLY-003

ASSEMBLY-004

COMPONENT-001

ASSEMBLY-001

ASSEMBLY-002

ASSEMBLY-002

PRODUCT-001

PRODUCT-001

PRODUCT-001

4 (Bottom) COMPONENT-002

COMPONENT-003

ASSEMBLY-003

ASSEMBLY-004

PRODUCT-001

PRODUCT-001

Creating a Child Installed Product from a Parent

To create a child product:

1. Navigate to an existing Installed Product record and then click Create Child. The
Create Child screen appears for the selected record.

Figure 2: Installed Products - Create Child Screen

2. Enter the following details:

Product – Select a valid product using the Lookup icon.

Serial Number – Enter the serial number.

3. Click Save to create a child product record. You will now be directed to the newly cre-
ated record.
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Most of the information from the parent record is copied to the child record automatically.
The fields to be copied between the records are configured by your ServiceMax admin-
istrator. This configuration may include your organization’s custom fields on Installed
Product as well.

Note: Product warranty is not cloned, but calculated based on the warranty
terms of the newly cloned product.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Validating Installed Product Address

To validate the address on an installed product record:

1. Navigate to the Installed Product record.

2. Click Validate Address. A dialog appears indicating the validation process.

If the address is valid, a message indicating the same is displayed and the
installed product record will be refreshed. The latitude and longitude fields are pop-
ulated on the screen.

If the address is invalid, an error message will be displayed and you will be
returned to the installed product record.An address could become invalid because
of spelling mistakes or if the address contains PO Box or Suite numbers. Since this
functionality uses the Google Maps engine, ability to validate an address depends
upon the level of coverage for countries provided by Google.

Capture Counter Reading
If your products have ongoing readings that are measured using embedded or external
devices, and if those readings impact customer entitlements, you must define such
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Installed Product

coverage in a service contracts and/or warranty terms, and also capture the current read-
ings at regular intervals. Coverage defined using counters can be applied in auto-enti-
tlement in Cases. Interactive entitlement does not support counter-based coverage in this
release.

Counters applicable to various products in your organization must be defined before using
this feature. Please contact your ServiceMax administrator if you are unable to view all the
relevant counters while entering current readings.

To capture counter reading:

1. Locate to the Installed Product by searching in the sidebar or from a list view in the
Installed Products tab. Click the Installed Product name for which you want to cap-
ture current readings.

2. Click Update Counters. The Enter counter readings screen with the current reading
for each counter appears as shown below.

Figure 3: Enter Counter Reading Screen

3. Enter the latest reading for each counter.

4. Click Save. You will be directed to the Installed Product record. Alternatively, you can
click Cancel to return to the Installed Product without saving.

The above feature to capture Counter readings can also be launched from Case and Work
Order screens.
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Creating a Case from Installed Product

To create a case from the Installed Product:

1. Navigate to an existing Installed Product record and then click Create Case. A
Create Case screen appears for the selected record as shown below.

Figure 4: Installed Products - Create Case Screen

Relevant information from the Installed Product record will be automatically copied
and displayed.

2. Enter Subject, Description, and other required fields.

3. Click Save to create a new Case record. You will now be redirected to the newly cre-
ated record.

Most of the information from the Installed Product record is copied to the Case record auto-
matically. The fields to be copied between the records are configured by your ServiceMax
administrator. This configuration may include your organization’s custom fields on
Installed Product and Case as well.
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Note: Cases can be created from Installed Products only if allowed by your
ServiceMax license. Please contact your ServiceMax administrator to know the
type of license used by your organization.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Creating a Work Order from Installed Product

To create a Work Order from the Installed Product:

1. Navigate to an existing Installed Product record and then click Create Work Order.
A Create Work Order screen appears for the selected record as shown below.

Figure 5: Installed Products - Create Work Order Screen

Relevant information from the Installed Product record will be automatically copied
and displayed.
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2. Enter Subject, Description, and other required fields.

3. Click Save to create a new Work Order record. You will now be redirected to the
newly created record.

Most of the information from the Installed Product record is copied to the Work Order
record automatically. The fields to be copied between the records are configured by your
ServiceMax administrator. This configuration may include your organization’s custom
fields on Installed Product and Work Order as well.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Installed Product: Configuration
The Installed Product configuration shows the tree view of all Installed Products in a hier-
archy from the top-most product. Your administrator may have enabled this view either in
the embedded mode or popup mode or both. In the embedded mode, the tree view is dis-
played from all Installed Product records as shown below:

Figure 6: Installed Product Configuration Screen

To view Installed Product configuration as a popup window:

1. Click Configuration in the Installed Product screen. You can also click any node in
the tree to open the Installed Product in a new window. Shown below is a sample
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Installed Product configuration tree in popup mode.

Figure 7: Configuration Tree Popup Screen

2. You can configure the columns displayed in the Installed Product tree by clicking
Select Columns. A popup screen appears as follows.

Figure 8: Select Fields Screen

3. In the above screen, the list of all available fields in Installed Product appears on the
left. Fields currently in the view appear on the right. The table below lists various oper-
ations you can perform on this popup screen:
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Actions Result

Click field name Field name is selected.

CTRL - Click field name Multiple fields are selected.

Click Fields selected from the left-side are moved to the right-side.

Click Fields selected from the right-side are moved to the left-side.

Click The selected fields are moved to the top of the list.

Click The selected fields are moved to the bottom of the list.

Click The selected fields are moved one position above.

Click The selected fields are moved one position below.

4. Click Save. The Installed Product tree view will be refreshed with the columns you
have selected. Alternatively, click Cancel to discard your changes.

Note: The columns you have selected are saved locally on your browser using
cookies. Clearing your browser’s cache will reset the installed product tree to
use default columns.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.
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Installed Product - Warranty

Product Warranty Fields

Fields Description

Installed
Product

Product name of the current Installed Product. This is a read-only field.

Warranty
Terms

Name of the service/warranty template used to create a warranty. This is a
lookup field to an existing warranty terms record.

Warranty
Records

A table that shows the list of warranties for this Installed Product.

Start Date Warranty start date.

End Date Warranty end date.

Time %
Covered

Percentage of the labor cost covered by the warranty.

Material %
Covered

Percentage of the material cost covered by the warranty.

Expenses %
Covered

Percentage of other expenses covered by the warranty.

End Date
Time Covered

Date on which the labor coverage ends.

End Date
Material
Covered

Date on which the parts coverage ends.

End Date
Expense
Covered

Date on which the expenses coverage ends.

All Products
Covered

Flag indicates if all products involved in the repair will be covered by this war-
ranty. This flag does not drive any functionality in ServiceMax and is for inform-
ational purposes only.

All Services
Covered

Flag indicates if all services performed will be covered by this warranty. This flag
does not drive any functionality in ServiceMax and is for informational purposes
only.
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Fields Description

RMA Required Flag indicates if an RMA is always required or an RMA is implied when this war-
ranty is used to entitle a customer. This flag does not drive any functionality in
ServiceMax and is for informational purposes only.

Shipment
Allowed

Flag indicates if customer shipments are covered by the warranty. This flag does
not drive any functionality in ServiceMax and is for informational purposes only.

Invoice
Required

Flag indicates if an invoice is always raised at the end of service delivery. This
flag does not drive any functionality in ServiceMax and is for informational pur-
poses only.

Loaner
Provided

Flag indicates if customer is given a temporary replacement product when the
covered product is under repair. This flag does not drive any functionality in Ser-
viceMax and is for informational purposes only.

Walk-in
Allowed

Flag indicates if the customer is authorized to walk into a service center for ser-
vice. This flag does not drive any functionality in ServiceMax and is for inform-
ational purposes only.

Transferable Flag indicates if this warranty is transferable to other products under special cir-
cumstances. This flag does not drive any functionality in ServiceMax and is for
informational purposes only.

Onsite
Repair

Flag indicates if customer is eligible for onsite repair when entitled by this war-
ranty. This flag does not drive any functionality in ServiceMax and is for inform-
ational purposes only.

Exclusions A free format text to define any exceptions specifically applicable to this Installed
Product.

Creating Warranty on Installed Product – Automatically

When an Installed Product record is saved, a warranty is created automatically based on
all warranty terms that:

Cover the specific product number specified in the Installed Product, or

Cover the product family of the product specified in the Installed Product, or

Cover the product line of the product specified in the Installed Product.
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Note: Your ServiceMax administrator can configure the event upon which war-
ranty is created. Warranty can be created when new installed products are cre-
ated, or when existing installed product records are updated or both.

Warranty start date is calculated based on the Warranty Starts From setting in the war-
ranty terms. See Configuring Coverage Start Date for more information. Warranty can
be configured to start from any date on Installed product. For example, if this setting is
Ship Date, the warranty start date will be set to Date Shipped on Installed Product
record; If the setting is Install Date, the warranty start date will be set to Date
Installed on Installed Product record and so on.

If the date field configured as warranty start date is not filled (blank) in the Installed
Product record, your administrator can configure ServiceMax either not to create warranty
or to create warranty using today’s date as the warranty start date.

Warranty components such as parts, labor and expenses can have different end dates
based on the duration of their respective coverage. The overall warranty end date is set to
the highest of the end dates of parts, labor and expenses coverage end dates.

For child Installed Products (that are linked to a parent Installed Product), warranty is cre-
ated if all of the following conditions are met:

The parent has a valid warranty.

The Inherit Parent Warranty checkbox is checked in the child’s product record.

Your administrator has enabled warranty inheritance for your organization.

When inheriting parent warranty, if the child product is also linked to one or more warranty
terms, ServiceMax can be configured to create additional warranties using warranty
terms. If enabled by your administrator, warranty for child products will be created by
inheriting from parent and by using the applicable warranty terms.

When inheriting a parent record’s warranty, the start date of the child’s warranty is always
set to current date. Expired warranties are not inherited.
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Creating Warranty on Installed Product – Manually

To create a warranty manually:

1. Locate the Installed Product by searching in the sidebar or from a list view in Installed
Products tab and click the Installed Product ID to which you want to add war-
ranties.

2. Click New Product Warranty from the Product Warranty related list section of the
Installed Product screen. The list of warranty terms applicable to the product and all
other warranty terms is displayed in two separate lists. A sample warranty terms
screen is shown here.

Figure 9: Create Product Warranty Screen

3. Select the appropriate warranty terms from the list. ServiceMax does not validate if
the template covers the current Installed Product. You can select to use any available
warranty terms to apply to an Installed Product. Manual creation of warranty also
overrides the Inherit Parent Warranty setting of the product.

4. Click Create Warranty. Product warranty will be created based on the terms. The
newly created product warranty record appears.

There is no limit to the number of warranty records an Installed Product can have. Repeat
the above steps as many times as required.
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Note: When creating warranty manually or automatically, the mapping of
fields between Warranty Terms and Product Warranty is configurable by your
ServiceMax administrator. This also includes your organization’s custom fields.

Editing Warranty on Installed Product

To edit a warranty on an Installed Product:

1. Locate the Installed Product by searching in the sidebar or from a list view in the
Installed Products tab. Click the Installed Product ID in which you want to make
warranty changes.

2. Click the Edit link next to the warranty record from the Product Warranty related list.

3. Make the necessary changes to the warranty record. You cannot change the warranty
terms of an existing warranty record. In order to effect new warranty terms, simply
delete the old warranty record and create a new warranty record using the appro-
priate warranty terms.

4. Click Save. The warranty information will be updated.

Deleting Warranty from Installed Product

Caution: Since warranty information is used in entitlement, it is strongly recom-
mended not to delete warranty records. An alternative is to "expire" the war-
ranty by changing the warranty End Date. Before proceeding to delete
warranty, make sure the warranty record is not used in any existing enti-
tlements.

To delete a warranty record:

1. Locate the Installed Product by searching in the sidebar or from a list view in the
Installed Products tab. Click the Installed Product ID from which you want to
delete warranties.

2. Click the Del link next to the warranty record you want to delete in the Product War-
ranty related list, and then click OK when prompted for confirmation.
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See Also:

Account

Contacts

Installed Product Settings

Location

Product

ServiceMax Processes
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SERVICE/MAINTENANCE CONTRACT

Overview
The Service/Maintenance Contract documents the details of entitlement provided to a cus-
tomer for the products bought. Usually shipped/delivered products are covered for a pre-
defined period through a basic warranty. If customers wish to get coverage for repairs
beyond the normal warranty period, they normally purchase extended Ser-
vice/Maintenance Contracts. Service contract is interchangeably referred to as a service
agreement as well. Service/Maintenance Contract is also referred to as Service Contract in
ServiceMax.

Access and Permissions

Action User Permissions Needed

To view the Ser-
vice/Maintenance Contract tab:

"Read" on Service/Maintenance Contract

To view Service/Maintenance
Contracts:

“Read” on Service/Maintenance Contract, Account,
Contact, and SLA Terms

To create or clone Ser-
vice/Maintenance Contracts:

"Create" on Service/Maintenance Contract

"Read" on Account, Contact and SLA Terms

To change Service/Maintenance
Contracts:

"Edit" on Service/Maintenance Contract

"Read" on Account, Contract and SLA Terms

To delete Service/Maintenance
Contracts:

"Delete" on Service/Maintenance Contract

To view covered products: "Read" on Covered Products, Service/Maintenance Con-
tract, Installed Product, and Product

To create covered products: "Create" on Covered Products

"Read" on Installed Products, and Product
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Action User Permissions Needed

To change covered products: "Edit" on Covered Products

"Read" on Installed Products, and Product

To delete covered products: "Delete" on Covered Products

To define coverage by counters: "Update" on Covered Products

"Read" on ServiceMax Process, and ServiceMax config
data

"Read", "Create", "Update" on Counter Details

To view entitled contacts: "Read" on Entitled Contacts, and Service/Maintenance Con-
tract

To create entitled contacts: "Create" on Entitled Contacts

"Read" on Contacts

To change entitled contacts: "Edit" on Entitled Contacts

"Read" on Contacts

To delete entitled contacts: "Delete" on Entitled Contacts

To view covered locations: "Read" on Covered Locations, and Service/Maintenance
Contract

To create covered locations: "Create" on Covered Locations

"Read" on Location

To change covered locations: "Edit" on Covered Locations

"Read" on Location

To delete covered locations: "Delete" on Covered Locations

To view included services: "Read" on Included Service, and Service/Maintenance Con-
tracts

To create included services: "Create" on Included Services

"Read" on Available Services

To change included services: "Edit" on Included Services

"Read" on Available Services

Service/Maintenance Contract
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Action User Permissions Needed

To delete included services: "Delete" on Included Services

To activate Ser-
vice/Maintenance Contracts:

"Edit" on Service/Maintenance Contract

To renew Service/Maintenance
Contracts:

"Edit" on Service/Maintenance Contract

To cancel Service/Maintenance
Contracts:

"Edit" on Service/Maintenance Contract

Click the Service/Maintenance Contracts tab to view the Service/Maintenance Con-
tracts home page.

Caution: Since parts requests are strongly tied to the inventory module you
are not allowed to delete a Parts Requests. Instead you can cancel a Parts
Request.

Service/Maintenance Contract Fields

Fields Description

Contract Name/Num-
ber

Name of the Service/Maintenance Contract. This is the document number
that is shared with the customer as well.

Account Customer to whom this Service/Maintenance Contract is sold. This is a
lookup to an existing Salesforce account record.

Renewal Number Renewal number for this contract. Incremented automatically when a
contract is renewed.

Renewal Date Date on which the contract was renewed.

Renewal From The original Service/Maintenance Contract from which this contract was
renewed. This is populated automatically when a Service/Maintenance
Contract is renewed.

Sales Rep Name of the internal sales representative responsible for or involved in
selling this contract. This is a lookup to a valid Salesforce user.
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Fields Description

Contact Name of the contact person from the customer account associated with
this contract. This is a lookup to an existing Salesforce Contact record.

Active Flag indicating if this contract is currently active or not. This flag is
checked automatically when you activate a contract.

Billing Schedule Indicates the frequency of how the customer prefers to be invoiced for
the contract amount.

Business Hours This is a lookup to an existing Salesforce business hours record.

Start Date Start date of the Service/Maintenance Contract. Service Contract should
have a valid start date.

End Date End date of the Service/Maintenance Contract. Service Contract should
have a valid end date. End date should be greater or equal to Start date.

SLA Terms Service level the customer is entitled to by this contract. This is a lookup
to an existing SLA Terms record.

Service/Maintenance
Contract Notes

Free text that shows any exceptions or conditions that apply when
entitling the customer based on this contract.

Contract Price Total price of the Service/Maintenance Contract before discount.

Discount % Percentage discount to be applied on the contract price.

Discounted Price Contract Price minus discount. Calculated automatically.

All Products
Covered

Flag that indicates if this contract covers all products purchased by this
customer. See Checking Entitlement in Case and Work Order.

All Contacts
Covered

Flag that indicates if all contacts from this customer are entitled to sup-
port. This flag does not drive any functionality in ServiceMax and is for
informational purposes only.

All Sites Covered Flag that indicates if all customer locations are covered by this contract.
This flag does not drive any functionality in ServiceMax and is for inform-
ational purposes only.

All Services
Covered

Flag that indicates if the customer is entitled to all types of services
offered. This flag does not drive any functionality in ServiceMax and is
for informational purposes only.

Default Service
Groups

Name of the service group to whom the Work Orders can be assigned by
default when a case is entitled using this contract.
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Fields Description

Default Group Mem-
ber

Name of the service group member to whom the Work Orders can be
assigned by default when a case is entitled using this contract.

Canceled by Name of the Salesforce user that canceled this Service/Maintenance Con-
tract.

Canceled on Date/time on which this Service/Maintenance Contract was canceled.

Primary Technician Primary technician for this service contract. Reference to an existing.
Technician record in ServiceMax.

Activation Notes Service/Maintenance Contract Activation Notes.

Cancellation Notes Service/Maintenance Contract Cancellation Notes.

Renewal Notes Service/Maintenance Contract Renewal Notes.

Weeks to Renewal Number of weeks before the contract expires. This is calculated auto-
matically.

Activating Service/Maintenance Contract
Activating a Service/Maintenance Contract makes it available for use in entitlements. In
order for a Service/Maintenance Contract to be available for entitlement, the contract
dates must also be current.

To activate a Service/Maintenance Contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and then click the contract name that you
want to activate. When a Service/Maintenance Contract is activated, all previous
instances of the contract will be automatically deactivated and will not be available
for entitlement in the future.

2. In the Service Flow Wizard (SFW) Manage Contract Tool bar, click Activate
Contract. Depending on how your administrator has configured this feature, some
validations may be performed to see if the contract qualifies for activation. The val-
idations include:
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Product coverage is entered

Services coverage is entered

Entitled contacts are entered

Location coverage is specified

If the contract qualifies for activation, the Activate Contract screen appears as shown
below.

Figure 1: Activate Contract Screen

5. Enter Activation Notes and then click Activate. The contract will be activated and
you will be returned to the Service Contract screen.

Renewing Service/Maintenance Contract
When a Service/Maintenance Contract is renewed, all coverage details will be auto-
matically copied to the renewed contract: the renewal number and date will be set in the
new contract. Depending upon your organization’s settings, the renewed contract may not
be activated automatically. In such instances, you must explicitly activate the renewed
contract.

To renew a Service/Maintenance Contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and then click the contract name to
renew.
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2. Click Renew Contract. If the contract qualifies for renewal, the Contact Renewal
screen appears as shown below:

Figure 2: Contract Renewal Screen

3. In the Renewal Information section, enter contract number, start and end dates for
the new contract. Though not required in ServiceMax, it is a recommended practice
that contract numbers are unique and indicate the number of renewals.

4. Click Renew Contract. A new contract will be created. All the selected information
such as products and services will be copied to the new contract. Depending upon the
activation settings, the renewed contract will be automatically activated. You will be
returned to the newly created contract.

Note: Renewal instructions, default renewal options and activation settings
are configurable by your administrator.

Note: A new contract is created upon renewal. The fields to be copied
between the original and new contracts are configurable by your ServiceMax
administrator. This configuration may also include your organization’s custom
fields on Service Contract.

Canceling Service/Maintenance Contract
When a Service/Maintenance Contract is canceled, the contract becomes inactive imme-
diately. The Service/Maintenance Contract will not be available for future entitlements.
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To cancel a Service/Maintenance Contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and then click the contract name to can-
cel.

2. Click Cancel Contract. Depending upon how your administrator has configured this
feature, some validations may be performed to see if the contract qualifies for can-
cellation. The validations include:

No cases or Work Orders have been entitled using this contract.

Any cases or Work Orders entitled using this contract are not currently open.

If the contract qualifies, the cancellation screen appears as shown below.

Figure 3: Cancel Contract Screen

3. Click Cancel Contract. The contract becomes inactive and you are returned to the
contract screen.

Note: Cancellation instructions and validations to be applied are configurable
by your administrator.

Adding Covered Products

Covered Product Fields

Fields Description

Service/Maintenance
Contract

Name of the Service/Maintenance Contract. This is a lookup to an exist-
ing Service/Maintenance Contract in ServiceMax.
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Fields Description

Installed Product ID of the installed product covered by the Service/Maintenance Contract.
This is a lookup to an existing installed product record in ServiceMax.

Product Name of the product covered by Service/Maintenance Contract. This is a
lookup to an existing Salesforce product record.

Product Family Product Family covered by this Service/Maintenance Contract. Your sys-
tem administrator is responsible for configuring this list for your organ-
ization’s requirements.

Product Line Product Line covered by this Service/Maintenance Contract. Your system
administrator is responsible for configuring this list for your organ-
ization’s requirements.

Start Date Coverage start date for this product in the Service/Maintenance Contract.

End Date Coverage end date for this product in the Service/Maintenance Contract.

SLA Terms Service level the customer is entitled to by this contract for this product.
This is a lookup to an existing SLA Terms record.

Adding Products to a Service/Maintenance Contract

To add products to an existing Service/Maintenance Contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and then click the contract name to which
you want to add products.

2. Click New in the Covered Products Related List section. The Service/Maintenance Con-
tract name is automatically populated in the screen.

3. Enter the Installed Product ID or Product Name, if the contract covers a specific
installed product or a part number. You can also use the Lookup icon to locate the
installed product or product.

4. Select the appropriate value from the Product Family or Product Line, if the con-
tract covers all the products in a Product Family or Product Line.

5. Click Save. A new product record is added to this Service/Maintenance Contract.
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Note: A Service/Maintenance Contract can have an unlimited number of
products. Repeat the above steps for each product (or family or line) you want
to associate with the service/maintenance contract. You can also click Save &
New after creating a new service/maintenance contract product record.

Editing Products from a Service/Maintenance Contract

To edit a product information:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and then click the contract name in which
you want to make product changes.

2. In the related list Covered Products, click Edit next to the product record you want to
edit.

3. Make necessary changes to the Service/Maintenance Contract product record.

4. Click Save to save the changes done. Alternatively, click Cancel to discard the
changes.

Deleting Products from a Service/Maintenance Contract

To delete a product from Service/Maintenance Contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and then click the contract name from
which you want to delete products.

2. In the Covered Products Related List section, click Del next to the product record you
want to delete and then click OK when prompted for confirmation.

Defining Counter-based Coverage

If your products have ongoing readings that are measured using embedded or external
devices, and if those readings impact customer entitlements, you can define such cov-
erage in warranty terms. Coverage defined using counters can be applied in auto-enti-
tlement in Cases. Interactive entitlement does not support counter-based coverage in this
release. Counters applicable to various products in your organization must be defined
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before using this feature. Please talk to your ServiceMax administrator if you are unable to
view all the relevant counters while defining coverage. View Defining Counter-based
Coverage to define the counters for the products.

Adding Entitled Contacts

Entitled Contact Fields

Fields Description

Service/Maintenance
Contract

Name of the Service/Maintenance Contract. This is a lookup to an exist-
ing Service/Maintenance Contract in ServiceMax.

Contact Name of the contact. This is a lookup to an existing contact record in
ServiceMax.

Number of Work
Orders

Maximum number of Work Orders this customer contact is allowed
when entitled by this Service/Maintenance Contract.

Notes Any additional information about entitlement on this contact.

Adding Contacts to a Service/Maintenance Contract

To add contacts:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab. Click the contract name to which you
want to add contacts.

2. In the Entitled Contacts Related List section, click New. The Service/Maintenance
Contract name is automatically populated in the screen.

3. Enter the contact name. You can also use the Lookup icon to find the contact record.

4. Enter Number of Work Orders (if applicable).

5. Enter any additional Notes (if applicable).

6. Click Save to add the contact information.
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Note: A Service/Maintenance Contract can support an unlimited number of
contact records. Repeat the above steps for each contact you want to asso-
ciate with the service/maintenance contract. You can also click Save & New
after creating a new service/maintenance contract contact record.

Editing Contacts from a Service/Maintenance Contract

To edit contact information:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab. Click the relevant contract name.

2. In the Entitled Contacts Related List section, click Edit next to the contact record you
want to edit.

3. Make the necessary changes to the Service/Maintenance Contract contact record.

4. Click Save to save the changes.

Deleting Contacts from a Service/Maintenance Contract

To delete a contact from the contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and click the relevant contract name.

2. In the Entitled Contacts Related List section, click Del next to the contact record you
want to delete and then click OK when prompted for confirmation.

Adding Covered Locations

Covered Locations Fields

Fields Description

Service/Maintenance
Contract

Name of the Service/Maintenance Contract. This is a lookup to an exist-
ing Service/Maintenance Contract in ServiceMax.
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Fields Description

Location Name of the location. This is a lookup to an existing location record in
ServiceMax.

Number of Work
Orders

Maximum number of Work Orders this customer location is allowed when
entitled by this Service/Maintenance Contract.

Notes Any additional information about entitlement on this location.

Adding Locations to Service/Maintenance Contract

To add a location to the contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and click the relevant contract name.

2. In the Covered Location Related List section, click New. The Service/Maintenance
Contract name is automatically populated in the screen.

3. Enter the location name. You can also use the Lookup icon to find the location record.

4. Enter Number of Work Orders (if applicable).

5. Enter any additional Notes (if applicable).

6. Click Save to add the location information.

Note: A Service/Maintenance Contract can support an unlimited number of loc-
ation records. Repeat the above steps for each location you want to associate
with the service/maintenance contract. You can also click Save & New after
creating a new service/maintenance contract location record.

Editing Locations from a Service/Maintenance Contract

To edit a location information:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and click the relevant contract name.

2. In the Covered Locations Related List section, click Edit next to the location record.
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3. Make the necessary changes to the Service/Maintenance Contract location record
and then click Save.

Deleting Locations from a Service/Maintenance Contract

To delete a location:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and click the relevant contract name.

2. In the Covered Locations Related List section, click Del next to the location record
you want to delete and then click OK when prompted for confirmation.

Adding Included Services

Included Services Fields

Fields Description

Service/Maintenance
Contract

Name of the Service/Maintenance Contract. This is a lookup to an exist-
ing Service/Maintenance Contract in ServiceMax.

Service Name of the service. This is a lookup to an existing service record in
ServiceMax.

Service Type Type of service covered by the Service/Maintenance Contract. Your sys-
tem administrator is responsible for configuring this list for your organ-
ization’s requirements.

Notes Any additional information about entitlement on this service.

Adding Services to a Service/Maintenance Contract

To add services to a contract:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and click the relevant contract name.

2. In the Included Services Related List section, click New. The Service/Maintenance
Contract name is automatically populated in the screen.

3. If the customer is entitled for specific services only, enter the service name. You can
also use the Lookup icon to find the service record.
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4. If the customer is entitled for all services of a service type, simply select the service
type.

5. Enter Additional Notes if applicable and then click Save.

Note: A Service/Maintenance Contract can support an unlimited number of ser-
vice records. Repeat the above steps for each service you want to associate
with the service/maintenance contract. You can also click Save & New after
creating a new service/maintenance contract service record.

Editing Services from a Service/Maintenance Contract

To edit services:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and click the relevant contract name.

2. In the Included Services Related List section, click Edit next to the service record you
want to edit.

3. Make the necessary changes to the Service/Maintenance Contract service record and
then click Save.

Deleting Services a from Service/Maintenance Contract

To delete services:

1. Locate the Service/Maintenance Contract by searching in the sidebar or from a list
view in Service/Maintenance Contracts tab and click the relevant contract name.

2. In the Included Services Related List section, click Del next to the service record and
then click OK when prompted for confirmation.

See Also:

Creating a New Service Plan

Creating a Service Contract from a Service Plan

Account
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Location

Product
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ServiceMax Processes

Service Contracts - Standard Settings
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ACTIVITY MASTERS

Overview
Activity Master is used to define the different labor activities performed by your tech-
nicians as a part of service. You can also associate applicable products with these activ-
ities.

From the Home page, click the Activity Masters tab to display the Activity Masters page.
See figure below.

Figure 1: Recent Activity Master Screen

Creating an Activity Master

To create a new Activity Master:

1. Click the New button in the Recent Activity Master screen. See figure above.

2. In the Create Activity Master screen:

a. Select the Action Type.

b. Enter the minimum number of labor hours.

c. Enter a description of the activity.

3. In Activity Product Lines area, select a product by entering the product name in the
text field, using the Quick Find search feature, or clicking the bubble icon to search
for the product. See figure below.

4. Click Save to save the Activity Master.
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5. Click Save & New to save the Activity Master and create a new Activity Master.

6. Click Cancel to cancel the activity.

Figure 2: Create Activity Master Screen

The Service Flow Wizard (SFM) Activity Master Detail updates.

7. Click the Edit Activity Master button to edit your activity master. See figure below.

Figure 3: Activity Master Detail

Activity Masters
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See Also:

Service Pricebook

Service Plans
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SERVICE PRICEBOOK

Overview
Click the Service Pricebook tab to display the Service Pricebook page. See figure below.

Figure 1: Recent Service Pricebooks Screen

Creating a New Service Pricebook

To create a new Service Pricebook:

1. Click the New button in the Recent Service Pricebooks screen. See figure above.

2. In the Create Activity Master screen, enter the name of the Pricebook.

3. In Service Pricebook Entry Lines area, select an Activity Master by entering the
name in the text field, using the Quick Find search feature, or clicking the bubble
icon to search for an Activity Master. See figure below.

4. Click Save to save the Service Pricebook.

5. Click Save & New to save the Service Pricebook and create a new Service Price-
book.
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6. Click Cancel to cancel the Service Pricebook.

Figure 2: Create Price Book Screen

The Service Flow Wizard (SFM) Service Pricebook Detail updates.

7. Click the Edit Service Pricebook button to edit your Service Pricebook.

Figure 3: Service Pricebook Detail

Service Pricebook
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SERVICE PLANS

Overview
Service Plans are templates that you can use when you create service maintenance con-
tracts. When you create a Service Plan, you can set criteria for: Pricing Rules, Parts Pri-
cing, Labor Pricing, Expense Pricing, and Travel Pricing.

Click the Service Plans tab to display the Service Plans Home page. See figure below.

Figure 1: Recent Service Plans Screen

Creating a New Service Plan

To create a new Service Plan:

1. In the Recent Service Plans screen, click the New button.

2. In the Information area of the New Service Plan screen:

a. Enter the Service Plan Name.

b. Enter the Default Parts Price Book in the appropriate text box.

c. Select the price type from the Price Type picklist.

d. Enter the SLA terms in the SLA Terms text box or use the Lookup feature to find
it.

e. Enter a List Price in the appropriate text box.

f. Click the Save button.
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Figure 2: New Service Plan Screen

3. In the Service Plan Detail area, click the appropriate tabs in the Service Plan Pricing
SFW (Service Flow Wizard) area for your new service plan (Pricing Rule, Parts Pri-
cing, Labor Pricing, Expense Pricing, Travel Policy, Service Offering). See
steps below for an example.

4. In the Service Plan area, enter a Parts Price Book or use the Lookup feature button
to find it (for example, Standard Pricebook). 

5. Click the Pricing Rule tab in the Service Plan Pricing SFW area:

a. In the Pricing Rule area, click the Add a row button and enter the Service Type
or use the Lookup feature button to find the Service Type.

b. You can also use the Quick find feature text box to quickly find a Service Type.
Enter the text and click the Filter button. Click the Reset Filter button to reset
the filter.

c. You can also click the Search and Add button to search for the Service Type.

i. In the Pricing Rule dialog box, select a search filter (Contains, Starts With,
Ends With, Exact Match). See figure below.

ii. Enter the Service Type in the appropriate text field.

iii. Click the Lookup feature button.

iv. The Service Name area updates to include your filtered search criteria.

v. Select the Service Name you want to add.

vi. Click the Add Selected button.

Service Plans
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Figure 3: Pricing Rule Dialog Box

6. In the Rate Type field, select a rate type (Fixed,NTE,Minimum, Surcharge).

7. Enter a rate in the Rate field.

8. Click the Save button.

The Pricing Rule area updates with your data in the Service Plan Detail screen. See fig-
ure below.

9. Click the Parts Pricing tab in the SFW area.

a. In the Parts Pricing area, click the Add a row button and enter the Product or use
the Lookup feature button to find the Product.

b. You can also use the Quick find feature text box to quickly find a Product. Enter
the text and click the Filter button. Click the Reset Filter button to reset the fil-
ter.

c. You can also click the Search and Add button to search for the Product.

10. In the Product search dialog box, select a search filter (Contains, Starts With, Ends
With, Exact Match). See figure below.

a. Enter a Product in the appropriate text field or click the Lookup feature button to
search for it.

b. The Product area updates to include your filtered search criteria.

c. Select the Product you want to add.

d. Click the Add Selected button.
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Figure 4: Product Search

11. In the Price Per Unit area, enter the price for the product. See figure below.

12. Check the Active checkbox to activate the parts pricing.

Figure 5: Parts Pricing Tab

13. Click the Quick Save button to save the parts pricing and remain in the Parts Pricing
area.

14. Click the Parts Discount tab to apply discounts to Products, Product Families, and
Product Lines (see figure below).

a. Assign individual discounts to Products, Product Families, and Product Lines on
one line each for each part (see figure below for example).

b. For Product discounts:

i. Enter the Product in the appropriate text field or use the Lookup feature but-
ton to search for it.

Service Plans
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ii. Enter a discount percentage in the Discount % area.

iii. Check the Active checkbox to activate the discount.

c. For Product Family discounts:

i. In the Product Family field, select a product family from the picklist.

ii. Enter a discount percentage in the Discount % area.

iii. Check the Active checkbox to activate the discount.

d. For Product Line discounts:

i. Select a product line from the Product Line field picklist.

ii. Enter a discount percentage in the Discount % area.

iii. Check the Active checkbox to activate the discount.

e. Click the Save button to save the Parts Discount and return to the Service Plan
Detail area.

Figure 6: Parts Discount Tab

Note: If you assign more than one item in the discount (Product, Product Fam-
ily, Product Line), you will receive an error message indicating that you can
only apply one discount to one item at a time. See above figure.

15. Click the Labor Pricing button in the SFW Service Plan Pricing Toolbar.

16. In the Labor/Overtime Rounding Rules area (see figure below):

a. In the Round Labor to the Nearest (Mins) text box, enter the number in
minutes only.

b. In the Minimum Labor (Mins) text box, enter the number in minutes only.
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c. In the Rounding Type (Labor) picklist, select a type (Round Up, Round Down,
Actuals).

17. In the Labor Pricing tab (see figure below):

a. Click the Add a row button to add a row.

b. In the Activity text field, enter the labor activity or use the Lookup feature but-
ton to find it.

c. In the Activity Product area, enter the product for the activity or use Lookup
feature button to find it.

d. In the Unit area, select Flat Rate or Per Hour from the picklist.

e. Enter the minimum number of labor minutes in the Minimum Labor area.

f. In the Regular Rate area, enter the rate.

Figure 7: Labor Pricing Tab

18. Click the Save button to save the parts pricing and return to the Service Plan Detail
area.

19. Click the Expense Pricing tab in the SFW Service Plan Pricing Toolbar.

20. In the Expense Pricing tab (see figure below):

a. Click the Add a row button to add a row.

b. In the Expense Type area, select an Expense Type from the picklist.

c. Select a Rate Type from the picklist.

d. Enter the rate amount in the Rate area.

Service Plans
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Figure 8: Expense Pricing Tab

21. Click the Travel Policy button from the SFW Service Plan Pricing Toolbar.

a. In the Service Plan area:

i. In the Default Travel Unit picklist, select a travel unit.

ii. Enter a price in the Default Travel Price text box.

Figure 9: Travel Policy

b. In the Time Based Billing Rules area:

i. Enter the number of minutes in the Round Travel to Nearest (Mins) text
box.

ii. Enter the minimum travel minutes in the Minimum Travel (Mins) text box.

iii. Select a rounding type from the Rounding Type (Travel) picklist.

Figure 10: Time Based Billing Rules Area

c. In the Travel Policy tab:

i. Click the Add a row button or the Search and Add button.

ii. In the Service Type area, enter a service or use the Lookup feature button.

iii. In the Unit area, select a type from the picklist.

iv. Enter a rate in the Rate area.

v. Click the Quick Save button.
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Figure 11: Travel Policy Tab

d. Click the Mileage Tier tab (see figure below).

i. Click the Add a row button or double-click in a one of the grid lines.

ii. In the Tier Name area, enter a name for the mileage tier.

iii. In the Minimum area, enter the minimum number of miles.

iv. In the Maximum area, enter the maximum number of miles.

v. From the Unit picklist, select a unit type.

vi. Enter the rate per mile or the flat rate in the Rate area.

Figure 12: Mileage Tier Tab

e. Click the Add a row button or double-click in a one of the grid lines.

i. In the Zone area, select a zone from the picklist.

ii. In the Rate area, enter a flat rate for the zone.

Figure 13: Zone Pricing Tab

22. Click the Service Offering button in the SFW Service Plan Pricing Toolbar.

In the Service Offering tab:

Service Plans
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a. Click the Add a row button or the Search and Add button.

b. In the Service Type area, enter a service or use the Lookup feature button to
search for it.

c. Enter the number of allowed units in the Allowed Units text box.

d. Enter the discount for the Parts Discount Covered in the appropriate area.

e. Enter a discount for labor in the Labor Discount Covered text box.

f. For expense discounts, enter the amount in the Expense Discount Covered text
box.

g. Enter discounts for travel in the Travel Discount Covered text box.

Figure 14: Service Offering Tab

Creating a Service Contract from a Service Plan
After creating a Service Plan, you can create a service contract from a service plan.

To create a service contract from a service plan (see figure below):

1. In the Service Plan Detail area, click the Create a Contract button SFW (Service
Flow Wizard) in the Other Actions toolbar.

In the Service/Maintenance Contract area:

a. Enter the contract name in the Contract Name/Number text box.

b. In the Account text box, enter the account name or use the Lookup feature but-
ton to search for it.

c. Enter the Start Date or use the Calendar icon button to select a date.

d. In the SLA Terms text box, enter the SLA terms (Gold, Silver, Bronze) or use
the Lookup feature button to find it.
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e. Enter the name of the service plan you want to use in the Service Plan text box.
Use the Lookup feature button to find it if necessary.

f. Enter the contact name in the Contact text box or find it using the Lookup fea-
ture button.

g. Enter an End Date or use the Calendar icon button to select a date.

h. If there are any notes, enter them in the Service Contract Notes section.

Figure 15: Service/Maintenance Contract Screen

2. Click the Save button to save the service contract.

Note: Many of the terms and coverages listed in the Terms & Coverages tool
bar in the SFW area of the Service/Maintenance Contract Detail screen have
already been updated via the Service Plan.

3. Activate the contract by clicking the Active button in the SFW (Generates the PM
Schedules).

Note: You can a activate service contract from the account as well.

Service Contract Reports

To generate a Service Contract report:

1. From the Service Contract Detail screen, in the SFW Manage Contract tool bar, click
the Activate Contract button.

a. In the Generate Report screen, select a template from the Select Template
area.

Service Plans
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b. Select a format for the report in the Generate Report As picklist.

c. If applicable, check the Attach Report To checkbox.

d. Click the Generate button to generate the report. The service report generates.

Figure 16: Generate Report Screen

2. From the Service Contract Detail screen, in the SFW Manage Contract tool bar, click
the Activate Contract button.

3. In the Service/Maintenance Contract area, enter any Activation Notes in the appro-
priate area.

4. Click the Activate Contract button.

Creating a Service Contract from an Account

To renew a Service Contract:

1. From the Service Contract Detail screen, in the SFW Manage Contract tool bar, click
the Renew Contract button.

2. In the Renewal Information area, enter the Start Date in the appropriate text box or
use the Calendar icon button to select the start date.

3. Enter the end date in the End Date text box or use the Calendar icon button to
select the end date.

4. Enter any notes in the Renewal Notes area.

To cancel a Service Contract:

1. From the Service Contract Detail screen, in the SFW Manage Contract tool bar, click
the Cancel Contract button.
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2. Enter any notes in the Cancellation Notes area.

3. Click the Cancel Contract button.

Note: Clicking the Cancel button will cancel any changes you have made
to the service contract.

Service Plans
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BOOKING WINDOWS

Overview
A booking window is a named time period of any day. Some examples of booking windows
are, Peak Hours (10am to 12pm), Late Afternoon (3pm to 5pm), and After Hours
(7pm to 9pm). Customer commitments for field service are made based on technician
availability during a booking window. Once booking windows are defined, ServiceMax
allows your call center users to select an appropriate booking window on a Case. The book-
ing window is subsequently propagated to the Work Order. If your organization uses
OptiMax for dispatch optimization, booking window commitments can be honored when
scheduling Work Orders to Technicians.

Booking windows carries two sets of information organized by record type:

Definition: Contains basic information about a booking window such as the name,
time period, and display order.

Access: Lists the call center users who have access to a booking window. Since an
organization can have multiple booking windows across geographies, access
enables display of only those booking windows that are applicable for a local region.

Access and Permissions

Actions User Permissions Needed

To view the Booking Windows: "Read" on Booking Window

To create or clone Booking Windows: "Create" on Booking Window

To change Booking Windows: "Edit" on Booking Window

To delete Booking Windows: "Delete" on Booking Window

Click Home > ServiceMax Setup > Booking Windows to view the Booking Windows
home page.

737



Caution: Remember that when deleting a booking window you will not be
warned if the booking window is used in a related record. Since booking win-
dows are related to other ServiceMax records such as Cases, Work Orders and
booking window access, review and make sure the booking window record is not
used in any related records.

Booking Windows Fields

Fields Description

Booking
Window
Name

A user-friendly name for the booking window. For example: Peak Hour Slot or After
Hours.

Booking
Definition

Name of the booking window to which the user has access. Reference to an existing
booking window record in ServiceMax.

Start Time Time when the booking window starts on any day. Represented in increments of 30
minutes.

End Time Time when the booking window ends on any day. Represented in increments of 30
minutes.

Display
Order

Order in which this booking window should be relative to other booking windows in
the Case Booking Window selection screen.

Average
Slots

Number of service slots per technician that can be committed in this time period.
This information is used to show the number of available slots on the Booking Win-
dow selection screen.

IsDefault Indicates if this booking window can be displayed in the Booking Window selection
screen for all users if the current user is not explicitly given access to any booking
window records.

User Name of the Salesforce user who has access to a booking window. Applicable only if
the record type is Access.

See Also:

Case

Booking Windows Settings

Booking Windows
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WORK TEMPLATES

Overview
A Work Template, also known as a Task Template, is a reusable collection of predefined
tasks. Work templates are primarily used in the Preventive Maintenance (PM) module of
ServiceMax. When a task template is associated with a preventive maintenance plan,
tasks listed in the template are automatically created and assigned to technicians in the
PMWork Orders. See Preventive Maintenance for more details.

A task template contains two sets of information:

Template: High level information about the template itself such as name and
description.

Work: List of tasks that are linked to a template.

Access and Permissions

Actions User Permissions Needed

To view the Work Templates tab: "Read" on Task Templates

To view Work Templates: "Read" on Task Templates

To create or clone Work Templates: "Create" on Task Templates

To change Work Templates: "Edit" on Task Templates

To delete Work Templates: "Delete" on Task Templates

Click Home > ServiceMax Setup > Task Templates to view the home page.

Alternatively, you can also click the Task Templates tab to view the Task Template
home page.
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Templates Fields

Fields Description

Template
Name

Name of the template. For example, Installation Checklist for HP9000 Series Serv-
ers.

Description Detailed description of the template.

Template
Type

Type of the template. Currently only one value is applicable: Preventive Main-
tenance.

Task Fields

Fields Description

Priority Priority of the task. Uses the same priority values of Salesforce tasks.

Task Title A brief summary of the task to be performed.

Description Detailed description of the task to be performed.

Task Template The template to which the task is linked.

Creating a New Work Template

To create a new work template (also known as task template):

1. Navigate to the Task Templates Home page by clicking the Task Templates in the
ServiceMax Home page. (You can also access Work Tasks Templates from the fol-
lowing path: Home > ServiceMax Setup > Service Organization > Task Tem-
plates

2. Click the New Task Template button in the Tasks related list.

3. Select the record type Templates and click Continue (see figure below).

Work Templates
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Figure 1: Select Task Template Record Type

4. In the Create Work Template screen, enter a name for your template in the Work
Order Purpose area.

5. Include a description for the template in the Description area.

6. To add tasks: click the Tasks tab to add work tasks to the template (see figure
below).

a. Enter the sequence number in the Sequence text field.

b. Enter the title name in the Task Title text field.

c. Provide a description of the tab in the Description text field.

d. From the Priority picklist, select a task priority (High,Medium, Low).

7. To add tasks to the Task grid, click the Add a row icon. (Enter the Sequence, Task
Title, and Description) fields and select a priority.

8. To delete a task, click the Delete icon for the appropriate task.

Figure 2: Tasks Tab

Note: You can use the Quick Find/Lookup feature to search for tasks or
required parts.

9. To add required parts: click the Required Parts tab to add required parts to the task.
See figure below.

a. Enter the product name in the Product field.

b. Enter the quantity in the Quantity field.
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Figure 3: Required Parts Tab

10. Click the Save button to save the template and remain in the Create Work Template
screen.

11. Click the Save & New button to save the template and create a new one.

12. Click the Cancel button to cancel the work template.

The Task Template Detail screen displays your newly created template in the Task Tem-
plates area (see figure below).

Figure 4: Task Templates Area

Editing/Cloning a Work Template

To edit a work template (also known as task template):

1. Navigate to the Task Templates Home page by clicking Task Templates in the Ser-
viceMax Home page. (You can also access Work Tasks Templates from the following
path: Home > ServiceMax Setup > Service Organization > Task Templates

2. A recent list of Work Orders display. Click the record number link of the template you
want to edit (see figure below).

Work Templates
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Figure 5: All Work Templates List

Note: By default, the "All Work Templates" view displays. Click the
Create New View link to create a new view (based on number, type,
name, and so on) for your work templates.

3. The Task Template Detail screen displays your template in the Task Templates area.
Click the appropriate template record number in the Task Templates area. (See figure
below).

Figure 6: Task Templates List

4. Your template displays in the Task Template Detail area. Click the Edit button to edit
the template. Click the Clone button to clone the template.

5. In the Task Template Edit screen, edit theWork Order Purpose, Task Title, Pri-
ority, or Description.

Figure 7: Task Template Edit Screen

Note: For cloning templates, you must edit the "Work Order Purpose" and
"Task Title" in order to save the template successfully.

6. Click the Save button to save the template and remain in the Task Template Detail
area.

7. Click the Save & New button to save the template and create a new one.

8. Click the Cancel button to cancel the template.
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Caution: Remember that when deleting a task template, you will not be warned
if the template is used in a related record. Since task templates are used in pre-
ventive maintenance, review and make sure the task template is not used in
any related records.

See Also:

Preventive Maintenance

Work Templates
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PREVENTIVE MAINTENANCE

Overview
The Preventive Maintenance(PM) feature in ServiceMax enables your organization to
define and execute preventive maintenance plans for your installed products based on a
service contract. PM Plans can be used to create Work Orders and cases, and assign tasks
to the Work Order owners automatically. To address various maintenance needs of
products, a service contract can have unlimited number of preventive maintenance plans
with varying frequencies and coverage. In order to successfully utilize this powerful fea-
ture, your ServiceMax administrator must have installed and configured ServiceMax PM
Scheduler.
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How does ServiceMax PM Work?
The following picture depicts the flow of ServiceMax PM Module:

Figure 1:Work Flow of ServiceMax PM

Once the PM feature is installed and configured for your organization, your ServiceMax
administrator will define the field mapping required for automatic creation of PMWork
Orders and cases. The type of field mappings defined depends on your organization’s
requirements. If your organization requires one PMWork Order for all products covered in
a PM Plan, you would require a field mapping between Service Contract andWork Order
fields. Similarly, you would need a mapping between Installed Product andWork Order
fields, if your organization needs one PMWork Order for each installed product. If you
prefer to create PM Cases for PMWork Orders, appropriate field mappings must be defined
for Cases as well. Field mappings could include standard ServiceMax fields as well as any
custom fields your organization may have created. Please work with your ServiceMax
administrator to setup these maps. Note that you will not be able to create and execute
PM plans without any field maps.

Preventive Maintenance
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If execution of your PMWork Orders is aided by a predefined checklist of tasks, you can
take advantage of the Task Template feature in ServiceMax. See Task Templates for
more information. Once task templates are created, contract administrators can attach
the templates to PM Plans. When a technician is assigned to a Work Order, tasks listed in
the template are created and assigned to the technician automatically.

The PM Scheduler runs at regular intervals based on the frequency configured by your Ser-
viceMax administrator. For plans that are due as per the schedule, PM Scheduler creates
Work Orders and cases as defined in the PM Plan. The Work Orders and cases are assigned
to users or queues as configured in the plan.

When a PMWork Order is assigned to a technician and if a task template is associated
with its PM Plan, tasks from the template are automatically created and assigned to the
technician. The technician can then close out the tasks using the standard Salesforce task
screen. Upon successful completion of the Work Order, when the Work Order is closed,
statistical information is automatically posted to the PM Plan.

Access and Permissions

Actions User Permissions Needed

To manage Preventive
Maintenance Plans:

"Read" on Service/Maintenance Contract, Installed Product,
Product, Work Order, Case, and Task Template.

"Edit" and "Delete" on Preventive Maintenance Plan, and Pre-
ventive Maintenance Coverage.

To create or edit PM Plans, click the Define PM Plans wizard on any service contract
record. A screen with all existing PM Plans for the service contract appears as shown
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below.

Figure 2: PM Plans Screen

Preventive Maintenance Fields

Fields Description

PM Plan Name Name of the PM Plan.

Description Detailed description about the PM Plan.

Status Current status of the PM Plan.

Start Date Date on which the Plan will go into effect.

End Date Date on which the Plan will end.

Schedule Type Type of the schedule. Always set to Time Based.

SLA Terms SLA Terms. Defaulted from the service contract.

Last PM Date Date on which this Plan was executed last. Automatically set by
the PM Scheduler.

Next PM Date Date on which this Plan will be executed next as per the fre-
quency.

Frequency Frequency by which the Plan is executed. Number of days/-
months/years.

Frequency Unit Unit of measure for the frequency.

Preventive Maintenance
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Fields Description

Create Work Order 'n'
days before scheduled
date

Number of days in advance the PM Work Orders should be created
for this Plan.

Number of Work Orders Indicates how many Work Orders should be created for this plan:
One Per Plan or One Per Product included in the Plan.

Field map to use Name of the Field Map to be used to create Work Orders.

Task Template Name of the Task Template. Line items listed under this template
will be used to create Work Order tasks.

Assign To Indicates who the Work Order should be assigned to: User,
Queue, or the Primary Technician listed in the service con-
tract.

Create Case Flag to indicate if Cases should be created for this PM Plan.

Field map to use Name of the Field Map to be used to create Cases.

Number of cases Indicates how many Cases should be created for this Plan: One
Per Plan or One Per Work Order.

Assign To Indicates who the Case should be assigned to: User or Queue.

Email ID for success
notifications

Email ID to which PM Scheduler should send notifications upon suc-
cessful execution of the Plan.

Email ID for error noti-
fications

Email ID to which PM scheduler should send notifications about
errors encountered during execution of the Plan.

Create Activity upon Suc-
cessful execution

Flag to indicate if an Activity record should be created auto-
matically upon successful execution of the Plan.

Create Activity for
Errors

Flag to indicate if an Activity record should be created auto-
matically if errors occur during execution of the Plan.

Product Name Name of the product covered by the Plan. This is a lookup to an
existing product record.

Installed Product Installed product covered by the Plan. This is a lookup to an exist-
ing installed product record.
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Creating a PM Plan

To create a new PM Plan:

1. Click Preventive Maintenance on any service contract. A PM Plan screen with all
the existing PM Plans for the service contract appears as shown above.

2. Click New PM Plan. The new PM Plan screen appears with the appropriate service
contract information as shown below.

Figure 3: New/Edit PM Plan Screen

3. In the New/Edit PM Plan screen:

a. Enter a unique name for the PM Plan. For example, "Annual Maintenance of
Desktops."

b. Enter a detailed description of the Plan.

c. Select the appropriate status of the Plan.

To temporarily suspend an active Plan, select Suspended in Status.

To cancel an active PM Plan, select Canceled in Status.

Status value Expired is used for internal purposes only.

For all the active Plans, select Active in Status.

d. Enter the Start Date and End Date for the Plan. This must be a future date for
new plans.
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e. Enter Frequency as a number and select the Frequency Unit. For example, if
you are creating a quarterly Plan, select 3 and Months for the fields respectively.

f. If you are creating a PM Plan that is already in effect, enter the Last PM Date.
This can be used to calculate the Next PM Date based on the frequency.

g. If you are creating a PM Plan that is already in effect, enter the Next PM Date. If
you like this date to be calculated automatically, click Recalculate Next PM
Date.

4. Click theWork Order Settings tab to display the following screen:

Figure 4:Work Order Settings Screen

5. In theWork Order Settings screen:

a. Enter the number of days in advance PMWork Orders should be created. This
should be at least 1.

b. Select the appropriate value for Number of Work Orders. If the PM plan requires
one Work Order for each product covered, select One Per Product or One Per
Plan.

c. Select the Field map to use for creating Work Orders. The available options in
this list are determined by Number of Work Orders. If you selected to create one
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Work Order per product, the field map will show all available field maps from ser-
vice contracts and installed products to Work Orders. If you selected to create one
Work Order per Plan, the field map will show field maps from service contracts to
Work Orders only.

d. If you want tasks to be created automatically, select the applicable Task Tem-
plate.

e. Select Assign To for the Work Order. If you select User from this list, select a
user using the Lookup icon. If you select Queue from the list, select from the list
of available queues for Work Order. If the Work Orders should be assigned to the
primary technician defined in the service contract, select Primary Technician.

f. If you want Cases to be created for this PM Plan, check the checkbox Create
Case.

g. Select the appropriate value for Number of Cases. If you would like all the PM
Work Orders from this Plan to be tracked on one Case, select One Per Plan or
One Per Work Order.

h. Select the Field map to use for creating Cases. This list shows all available field
maps from service contracts and Work Orders to Cases.

i. Select Assign To for the Case. If you select User from this list, select a user using
the Lookup icon. If you select Queue from the list, select from the list of available
queues for the Case.

Note: Cases can be created from PM Plans only if allowed by your Ser-
viceMax license. Please contact your ServiceMax administrator to know
the type of license used by your organization.
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6. Click the Alerts and Logging tab. The Alerts and Logging screen appears:

Figure 5: Alerts and Logging Details Screen

7. In the Alerts and Logging screen:

a. Enter an e-mail ID to receive success notifications. To avoid dependency on indi-
viduals, it is strongly recommended to create e-mail aliases or distribution lists for
PM Plan notifications.

b. Enter an e-mail ID to receive error notifications.

c. At the end of every successful execution of this PM Plan, if you want the Ser-
viceMax PM Scheduler to automatically create a historical record, check the
Create activity upon successful execution checkbox.

d. If the execution of this PM Plan encounters errors and if you want ServiceMax PM
scheduler to automatically create a historical record of the errors, check the
Create activity if errors occur in execution checkbox.
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8. Click the Product Coverage tab. All covered products from the service contract are
automatically displayed in the list as shown in the following screen.

Figure 6: Product Coverage Details Screen

9. In the Product Coverage screen:

a. To delete any products not covered by this PM Plan, select the products from the
list and then click Delete.

b. To find and add more covered products from the service contract, click Find
Covered Products. The following popup screen appears.

Figure 7: Products Covered Search Screen

c. In the above screen, enter a keyword and then click Go.
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If Filter by Product Family is selected, the keyword is matched with the
product family of installed products covered by the service contract.

If Filter by Product Line is selected, the keyword is matched with the
product line of installed products covered by the service contract.

If Filter by Product Family and Filter by Product Line are both cleared,
the keyword is matched with the installed product name or product name
linked to the installed product. Only installed products that are covered in the
service contract are displayed.

Select one or more records from the result set and then click Add Selected.
The selected records will be added to the Product Coverage list in the PM Plan
and the popup window closes.

10. Click Save And Close to save the PM Plan and return to the PM Plans list. Altern-
atively, click Cancel to discard your changes and return to the PM Plans list.

Editing a PM Plan

To edit an existing PM Plan:

1. Check the checkbox against PM Plan record in the PM Plan list and then click Edit. The
New/Edit PM Plan screen appears.

2. Click the PM Plan tab to edit the Plan details.

3. Click theWork Order Settings tab to edit the Work Order settings information.

4. Click the Alerts and Logging tab to edit any alert or notification details.

5. Click the Product Coverage tab to edit the product details for this PM Plan.

6. Click Save And Close in the Product Coverage screen to save the changes.

Deleting a PM Plan

To delete an existing PM Plan record or records:

1. Check the checkbox against the PM Plan record or records that you want to delete.

2. Click Delete and then click OK when prompted for confirmation.
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See Also:

Scheduling PM Jobs

Cases

Installed Products

Service/Maintenance Contracts

Task Templates

Work Order
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SKILLS

Overview
Skill record defines the expertise required during service delivery. For example, a Com-
puter Telephone Integration (CTI) product company may define Network Assessment,
CISCO router setup as various skills. Skill definition is used in service team definition and
can be used when assigning a Work Order to a service team or technician considering their
skill levels.

Access and Permissions

Actions User Permissions Needed

To view the Skills tab: "Read" on Skills

To view Skills: "Read" on Skills

To create or clone Skills: "Create" on Skills

To change Skills: "Edit" on Skills

To delete Skills: "Delete" on Skills

Click Home > ServiceMax Setup > Skills to view the skills home page.

Caution: Remember that when you are deleting a skill, you will not be warned if
the skill is used in a related record. Since skills are related to other ServiceMax
records such as service team, review and make sure the skill record is not used
in any related records.
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Skills Fields

Fields Description

Skill Name Name of the Skill. Be specific and granular when naming a Skill. For example,
instead of DSL Installation, you can enter DSL <Model> Installation.

Description Detailed description of the Skill.

Active Checkbox to indicate if this Skill is currently active and available for use.

Skill Cat-
egory

Indicates the type of Skill. This helps in grouping similar types of Skills for report-
ing purposes. Your system administrator is responsible for configuring this list for
your organization’s requirements.

Skill Area Indicates where this Skill is applicable, in the field or depot or both.

Skill Level
- Low

Benchmark for the minimum level of proficiency for this Skill.

Skill Level
- Medium

Benchmark for the average level of proficiency for this Skill.

Skill Level
- High

Benchmark for the maximum level of proficiency for this Skill.

See Also:

Dispatch Optimization using OptiMax

Dispatch Process

Service Teams

Work Order

Skills
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SERVICE TEAM

Overview
Service Team enables definition of your entire service organization. Service Team defin-
ition includes details of technicians, equipment, products in which the team specializes,
the expertise of the team, typical service delivery costs as well as geographies covered by
the team. Work orders are queued to a service team and assigned to technicians. At the
time of assignment, all the above parameters can be considered by the support center
engineer(s) to select the most suitable team that can address the customer problem.

There are two ways to manage Service Team information in ServiceMax:

Using the standard user Salesforce interface of tabs and screens.

Using Service Team Management Console, which is a more streamlined way to
manage your service teams and technicians in a tree view.

Access and Permissions

Actions User Permissions Needed

To view the Service Teams tab: "Read" on Service Team

To view Service Teams: "Read" on Service Team

To create or clone Service Teams: "Create" on Service Team

To change Service Teams: "Edit" on Service Team

To delete Service Teams: "Delete" on Service Team

To validate Service Teams address: "Read" and "Edit" on Service Team

To view technicians/equipment: "Read" on Technician/Equipment and Service Team

To create technicians/equipment: "Create" on Technician/Equipment

To change technicians/equipment: "Edit" on Technician/Equipment
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Actions User Permissions Needed

To delete technicians/equipment: "Delete" on Technician/Equipment

To validate technicians address: "Read" and "Edit" on Technician/Equipment

To view products serviced: "Read" on Products Serviced, Service Team and
Product

To create products serviced: "Create" on Products Serviced

"Read" on Product

To change products serviced: "Edit" on Products Serviced

"Read" on Product

To delete products serviced: "Delete" on Products Serviced

To view the team labor costs: "Read" on Team Labor Costs and Service Team

To create team labor costs: "Create" on Team Labor Costs

To change team labor costs: "Edit" on Team Labor Costs

To delete team labor costs: "Delete" on Team Labor Costs

To view expertise: "Read" on Expertise and Service Team

To create expertise: "Create" on Expertise

"Read" on Skills

To change expertise: "Edit" on Expertise

"Read" on Skills

To delete expertise: "Delete" on Expertise

To view locations covered: "Read" on Locations Covered and Service Team

To create locations covered: "Create" on Location Covered

"Read" on Location

To change locations covered: "Edit" on Locations Covered

"Read" on Location

To delete service team locations: "Delete" on Locations Covered

Service Team
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Click the Service Teams tab to display the Service Team home page.

Caution: When you are deleting a Service Team, you will not be warned if the
Service Team is used in a related record. Since Service Teams are strongly tied
to service contracts and Work Orders, review and make sure the Service Team
record is not used in any related records.

Service Team Fields

Fields Description

Service
Team
Name

Name of the Service Team.

Group Type Indicates if this is a group Internal to your organization, a partner company provid-
ing the services on your behalf, or a combination of Both.

Description Description of the group.

Group
Code

Any internal (typically, financials) code your organization uses to refer the group.

Email Email ID of the Service Team. This email ID is used to notify the team when Work
Orders are queued to the team.

Active Flag indicates if this group is active and available for Work Order assignments.
This flag does not drive any functionality in ServiceMax and is for informational pur-
poses only.

Phone Primary telephone number for the Service Team.

Street "Street" part of the Service Team's address.

City "City" part of the Service Team's address.

State "State" part of the Service Team's address.

Zip "Zip or Postal Code" part of the Service Team's address.

Country "Country" part of the Service Team's address.

Latitude Geographical code for this Service Team address. This is calculated automatically
using the Validate Address feature.

Longitude Geographical code for this Service Team address. This is calculated automatically
using the Validate Address feature.
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Validating Service Team Address

To validate the address:

1. Navigate to the Service Team record.

2. Click Validate Address. A popup window appears indicating the validation process.

If the address is valid, a message indicating the same appears and the location
record refreshes. The latitude and longitude fields are populated on the screen.

If the address is invalid, an error message appears and you will be returned to the
location record.

Note: An address could become invalid because of spelling mistakes or if the
address contains PO Box or Suite numbers. Since this functionality uses the
Google Maps engine, ability to validate an address depends upon the level of
coverage for countries provided by Google.

Managing Technician/Equipment

Technician/Equipment Fields

Fields Description

Member Name Full name of the technician/equipment.

Service
Team

Name of the Service Team. This is a lookup to an existing Service Team in Ser-
viceMax.

Active Flag indicates that if this member is active and available for Work Order assign-
ments. This flag drives the functionality in both Dispatch Console and OptiMax.

Member
Information

Additional information about the member relevant to service delivery.

Role Role of the member in the group. Your system administrator is responsible for con-
figuring this list for your organization's requirements.
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Fields Description

Salesforce
User

Name of the Salesforce user associated with the technician. Applicable only for
Technicians. This is a link to an existing Salesforce user.

Street "Street" part of the technician or equipment address.

City "City" part of the technician or equipment address.

State "State" part of the technician or equipment address.

Zip "Zip or Postal Code" part of the technician or equipment address.

Country "Country" part of the technician or equipment address.

Phone Telephone number of the technician.

Email Email ID of the technician. This is used to notify the technician when Work Orders
are assigned.

Third Party Flag indicates whether this technician is an employee or a third-party service pro-
vider.

Latitude Geographical code for this technician address. This is calculated automatically
using the Validate Address feature.

Longitude Geographical code for this technician address. This is calculated automatically
using the Validate Address feature.

Average
Speed

Average speed in which the technician travels on the road. Used in dispatch optim-
ization.

Max
Distance

Distance in miles if the technician cannot travel beyond this limit on a given route.
Used in dispatch optimization.

Per Mile
Cost

Average travel cost per mile for the technician. Used in dispatch optimization.

Per Hour
Cost

Average cost of technician time. Used in dispatch optimization.

Fixed Cost Any fixed costs associated with the technician for each day of Work Order activity.
Used in dispatch optimization.

Enable
Scheduling

Indicates if the technician's calendar must be managed by ServiceMax. Applies to
third-party technicians and equipment that are not linked to a Salesforce user.

Inventory
Location

Technician's inventory location.
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Fields Description

Service Ter-
ritory

Service territory to which this technician belongs. Reference to an existing Ter-
ritory record in ServiceMax.

Working
Hours

Working Hours applicable to the technician. Reference to an existing Business
Hours record in Salesforce.

Overtime
Hours

Overtime hours applicable to the technician. Reference to an existing Business
Hours record in Salesforce.

Break Hours Break hours applicable to the technician. Reference to an existing Business Hours
record in Salesforce.

Break Dur-
ation

Duration of technician's break in minutes.

Break Type Type of break: Fixed or Time Window.

Adding Technician/Equipment to Service Team

To add a technician/equipment:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the team name to which you want to add members.

2. In the Technician/Equipment related list, click New. The Service Team name appears.

3. Enter the technician or equipment's full name.

4. Enter the relevant details. See Technician/Equipment Fields for more information
about the available fields.

5. Click Save to add the technician/equipment.

Note: A Service Team can have an unlimited number of members. Repeat the
above steps for each member you want to associate with the group. You can
also click Save & New after creating a new Service Teammember record.
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Editing Technician/Equipment in a Service Team

To edit a technician/equipment information:

1. Locate the Service Team by searching in the sidebar or from a list view in the Service
Teams tab and click the relevant group name.

2. In the Technician/Equipment related list, click Edit next to the member record.

3. Make necessary changes to the record.

4. Click Save to save the changes.

Deleting Technician/Equipment in Service Team

Since technicians/equipment are referenced in other ServiceMax records such as Work
Orders, it is strongly recommended to deactivate the member instead of deleting him or
her. If you must delete a technician/equipment record, make sure the record is not
referred to in any ServiceMax record.

To delete a technician/equipment record:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the relevant group name.

2. In the Technical/Equipment related list, Click Del next to the record and then click OK
to confirm the deletion.

Validating a Technician Address

To validate the address:

1. Navigate to the record for which you want to validate the address.

2. Click Validate Address. A popup window appears indicating the validation process.

If the address is valid, a message indicating the same is displayed and the location
record will be refreshed. The latitude and longitude fields are populated on the
screen.

If the address is invalid, an error message will be displayed and you will be
returned to the location record.
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Managing Products Serviced

Products Serviced Fields

Fields Description

Service
Team

Name of the Service Team. This is a lookup to an existing Service Team in Ser-
viceMax.

Product
Family

Product family supported by this group. Your system administrator is responsible for
configuring this list for your organization's requirements.

Product Product supported by the group. This is a lookup to an existing product in Salesforce.

Product
Line

Product Line supported by this group. Your system administrator is responsible for con-
figuring this list for your organization's requirements.

Adding Products Serviced to a Service Team

To add a product to the Service Team:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab. Click the relevant team name.

2. In the Products Serviced related list, click New. The Service Team name appears.

3. If the team supports the specific part number, enter the product. You can also lookup
the product using the Lookup icon.

4. If the team supports all products in a Product Family or Product Line, select the appro-
priate value from the Product Family or Product Line list.

5. Click Save to add the product.

Note: Service team can support an unlimited number of products, families or
lines. Repeat the above steps for each product you want to associate with the
group. You can also click Save & New after creating a new Service Team
product record.
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Editing Products in a Service Team

To edit a product information:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the team name in which you want to make the product
changes.

2. In the Products Serviced related list, click Edit next to the product record.

3. Make necessary changes to the record.

4. Click Save to save the changes.

Deleting Products Serviced from a Service Team

To delete a product record:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the relevant team name.

2. In the Products Serviced related list, click Del next to the product record and then
click OK to confirm the deletion.

Managing Team Labor Costs

Team Labor Costs Fields

Fields Description

Service Team Name of the Service Team. This is a lookup to an existing Service Team
in ServiceMax.

Technician/Equipment Name of the technician/equipment. This is a lookup to an existing tech-
nician/equipment record in ServiceMax.

Cost Category Type of cost defined by this record. Your system administrator is
responsible for configuring this list for your organization's require-
ments.

Hourly Cost Average internal cost of service for this group or member.

Billable Cost Average billable cost of service for this group or member.

Managing Team Labor Costs 769



Adding Labor Cost to a Service Team

To add labor costs to a Service Team:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the relevant team name.

2. In the Labor Costs related list, click New. The Service Team name appears.

3. If the cost is applicable to the entire team, leave the Technician/Equipment field
blank.

4. If the cost is specific to a teammember, enter the technician/equipment name. You
can also use the Lookup icon to find the member record.

5. Select the applicable Cost Category.

6. Enter Hourly and Billable Cost.

7. Click Save to add the labor cost.

Note: A Service Team can support an unlimited number of cost records.
Repeat the above steps for each cost factor you want to associate with the
team. You can also click Save & New after creating a new Service Team cost
record.

Editing Labor Costs in a Service Team

To edit a labor cost:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the relevant team name.

2. In the Labor Costs related list, click Edit next to the cost record.

3. Make the necessary changes to the record and then click Save to save the changes.
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770 Managing Team Labor Costs



Service Team

Deleting Labor Costs from a Service Team

To delete a labor cost:

1. Locate the Service Team by searching in the sidebar or from a list view section in Ser-
vice Teams tab and then click the team name.

2. In the Labor Costs related list, click Del next to the cost record and then click OK to
confirm the deletion.

Managing Expertise

Expertise Fields

Fields Description

Service Team Name of the Service Team. This is a lookup to an existing Service Team
in ServiceMax.

Skill Name of the Skill. This is a lookup to an existing Skill record in Ser-
viceMax.

Availability Start
Date

Date from which the Skill is available in this group.

Technician/Equipment Name of the Service Team member. This is a lookup to an existing tech-
nician/equipment in ServiceMax.

Skill Level Proficiency level at which the Skill is available.

Availability End
Date

Date up to which this Skill is available to this group.

Adding Expertise to a Service Team

To add expertise:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the relevant team name.

2. In the Expertise related list, click New. The Service Team name appears.

3. Enter the Skill name. You can also use the Lookup icon to find the Skill record.
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4. If the Skill is applicable to the entire team, leave the Technician/Equipment field
blank.

5. If the Skill is specific to a technician, enter the technician's name. You can also use
the Lookup icon to find the member record.

6. Enter the Availability Start Date and Availability End Date.

7. Enter the Skill Level. If a technician is not available, you can enter an average Skill
level available in the group.

8. Click Save to add the expertise.

Note: A Service team can support an unlimited number of expertise records.
Repeat the above steps for each expertise you want to associate with the
group. You can also click Save & New after creating a new expertise record.

Editing Expertise from a Service Team

To edit expertise:

1. Locate the Service Team by searching in the sidebar or from a list view in the Services
Teams tab and then click the relevant team name.

2. In the Expertise related list, click Edit next to the record.

3. Make necessary changes to the record and then click Save to save the changes.

Deleting Expertise from a Service Team

To delete an expertise record:

1. Locate the Service Team by searching in the sidebar or from a list view in Service
Teams tab and then click the relevant team name.

2. In the Expertise related list, click Del next to the record and then click OK to confirm
the deletion.
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Managing Locations Covered

Locations Covered Fields

Fields Description

Service
Team

Name of the Service Team. This is a lookup to an existing Service Team in Ser-
viceMax.

Location Name of the Location. This is a lookup to an existing location record in Ser-
viceMax.

Adding Locations to Service Team

To add a Location to a Service Team:

1. Locate the Service Team by searching in the sidebar or from a list view in the Services
Team tab and then click the relevant team name.

2. In the Locations Covered related list, click New. The service team name appears.

3. Enter the location name. You can also use the Lookup icon to find the location record.

4. Click Save to add the location.

Note: A Service Team can support an unlimited number of location records.
Repeat the above steps for each location you want to associate with the
group. You can also click Save & New after creating a new Service Team loc-
ation record.

Editing Locations Covered in a Service Team

To edit locations covered information:

1. Locate the Service Team by searching in the sidebar or from a list view in the Services
Team tab and then click the relevant team name.

2. In the Locations Covered related list, click Edit next to the record.

3. Make the necessary changes and then click Save to save the changes.
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Deleting Locations Covered from a Service Team

To delete a location covered record:

1. Locate the Service Team by searching in the sidebar or from a list view in the Services
Team tab and then click the relevant team name.

2. In the Locations Covered related list, Click Del next to the record and then click OK to
confirm the deletion.

Managing Team Dispatchers

Team Dispatchers Fields

Fields Description

Service Team Name of the Service Team. This is a lookup to an existing Service Team in Ser-
viceMax.

Dispatcher
Name

Name of the dispatcher user. This is a reference to an existing Salesforce user
record.

Adding Dispatchers to a Service Team

To add a dispatcher:

1. Locate the Service Team by searching in the sidebar or from the list view in Service
Teams tab and then click the relevant team name.

2. In the Dispatchers related list, click New. The Service Team name appears.

3. Enter the dispatcher user name. You can also use the Lookup icon to find the Sales-
force user record.

4. Click Save to add the dispatcher.

Note: A Service Team can support an unlimited number of dispatcher records.
Repeat the above steps for each dispatcher you want to associate with the
team. You can also click Save & New after creating a new dispatcher record.
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Editing Dispatchers from a Service Team

To edit a dispatcher information:

1. Locate the Service Team by searching in the sidebar or from the list view in Service
Teams tab and then click the relevant team name.

2. In the Dispatchers related list, click Edit next to the record.

3. Make necessary changes to the record and then click Save to save the changes.

Deleting Dispatchers from a Service Team

To delete a dispatcher:

1. Locate the Service Team by searching in the sidebar or from the list view in Service
Teams tab and then click the relevant team name.

2. In the Dispatcher related list, click Del next to the record and then click OK to confirm
the deletion.

Managing Home Base

Home Base Fields

Fields Description

Technician/Equipment Name of the Technician/Equipment. This is a lookup to an existing Tech-
nician/Equipment record in ServiceMax.

Street "Street" part of the home base address.

City "City" part of the home base address.

State "State" part of the home base address.

Zip "Zip" part of the home base address.

Country "Country" part of the home base address.

Current Home Base Indicates if this address is the current home base for this technician.
Only one home base can be designated as the current home base.
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Adding Home Base to a Technician

To add home base to a technician:

1. Locate the technician by searching in the sidebar or from the list view in the Tech-
nician tab and then click the relevant technician name.

2. In the Home Bases related lists, click New. The technician name appears.

3. Enter all the address fields as applicable.

4. Check the Current Home Base checkbox, if this address is the current home base
for the technician.

5. Click Save.

When setting the current home base for a home base record, you must explicitly uncheck
the checkbox on any other home base address associated with the technician. This is not
done automatically.

Note: Technician can support an unlimited number of home base records.
Repeat the above steps for each home base address you want to associate
with the technician. Remember to leave only his current home based checked.
You can also click Save & New after creating a new technician home base
address record.

Editing Home Base in a Technician

To edit a home base:

1. Locate the technician by searching in the sidebar or from the list view in the Tech-
nicians tab and then click the relevant technician name.

2. In the Home Bases related lists, click Edit next to the home base record.

3. Make the necessary changes to the record and then click Save.
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Deleting Home Base from a Technician

To delete home base:

1. Locate the technician by searching in the sidebar or from the list view in the Tech-
nicians tab and then click the relevant technician name.

2. In the Home Bases related list, click Del next to the home base record you want to
delete and then click OK when prompted for confirmation.

Service Team Management Console
This feature provides a streamlined way to manage your service organization. Using this
screen, you can create or edit Service Teams and manage technicians, expertise, product
specializations, labor cost, home base and team dispatchers. While all this information can
also be entered using the standard Salesforce screens, it is strongly recommended to use
this console to manage service team and technician information. This screen enforces sev-
eral data integrity rules and performs automatic calculations of data which are not done
when you enter information using the standard Salesforce page layout.

Click Home > ServiceMax Setup > Manage Service Org, and the Team Technician
Management Console screen appears with all existing service teams and technician
records in a tree view as shown below. Alternatively, you can also reach this screen by nav-

Service Team Management Console 777



igating to a technician record and then clickingManage Technicians.

Figure 1: Team Technician Management Console Screen

To filter the team/technician tree view to locate specific teams or

technicians:

1. Enter a keyword and then click Go!.

If Filter By Expertise and Filter By Product are cleared, the teams and tech-
nicians whose names match the keyword display.

If Filter By Expertise is selected, all teams and technician with the skill name
that matches the keyword display.

If Filter By Product is selected, all teams and technicians with the product name
that matches the keyword display.

An error appears if no teams or technicians are found that match the keyword.
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Creating a Service Team

1. To create a new team, click New Service Team. The following screen appears.

Figure 2: New/Edit Team Screen

2. Select Technician in the Record Type if you want to define a group of technicians.
To define a group of equipment, select Equipment in the Record Type.

3. Enter a unique name for the Service Team. For example, "NA East Laptop Field Ser-
vice."

4. Select the Group Type.

5. Enter a detailed description about the team.

6. Enter any internal code your organization might use to refer the team.

7. Check the Active checkbox, if this group is active and available for Work Order
assignments.

8. Enter valid address information in the appropriate fields.

9. Enter the team telephone number and email ID.

10. Click Save. If you entered an invalid address, an error appears. An address could
become invalid because of spelling mistakes or if the address contains PO Box or
Suite numbers. Since this functionality uses the Google Maps engine,the ability to val-
idate an address depends upon the level of coverage for countries provided by
Google.
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Editing a Service Team

To edit an existing service team information:

1. Click the radio button adjacent to the service team and then click Edit.

2. Make the necessary changes and then click Save to save the changes.

Deleting a Service Team

To delete an existing Service Team:

1. Click the radio button to select the Service Team and then click Delete.

2. Click OK when prompted for confirmation. The selected team and all the associated
technicians, expertise, product, and cost records will be deleted permanently.

Adding a Technician/Equipment to a Service Team

To create a new technician or equipment in a team:

1. Click the radio button to select the service team and then click New Technician to
display the following screen:

Service Team
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Figure 3: Add/Edit Technician Screen

2. Enter the technician name.

3. Select the technician’s role in the team.

4. Select the Salesforce User associated with the technician. If this is a third party
technician without a login or if it is equipment, leave the Salesforce User field blank.
If you prefer to track calendar assignments for this resource, select Enable Schedul-
ing.

5. Select the Service Territory this resource belongs to.

6. Enter a valid street address for the resource.

7. Enter the email and telephone number.

8. If this resource is linked to an inventory location in which ServiceMax stock is man-
aged, select the location using the Lookup icon. For new records, if you prefer to cre-
ate an inventory location automatically using the resource name, check the Create
Automatically checkbox.
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9. Select the business hours forWorking Hours, Break Hours, and Overtime Hours.

10. Enter Break duration in minutes.

11. Select the break type. Select Time Window if the break hours indicates a wider
range of time, or select Fixed if the resource is not available for the entire duration of
the break hours.

12. Enter any additional information regarding the resource.

13. In the Dispatch Factors section, enter any constraints the technician may have. These
factors will be used by OptiMax, the dispatch optimization engine in ServiceMax when
dispatching Work Orders to this technician. If no information is provided for the tech-
nician, any such information defined for the technician’s territory will be considered.

14. Click Save. If you entered an invalid address, an error appears. An address could
become invalid because of spelling mistakes or if the address contains PO Box or
Suite numbers. Since this functionality uses the Google Maps engine, the ability to val-
idate an address depends on the level of coverage for countries provided by Google.

Editing Technician/Equipment in a Service Team

To edit an existing technician/equipment record:

1. Select the record by checking the checkbox adjacent to it and then click Edit. The
Add/Edit Technician screen appears.

2. Make the necessary changes and then click Save to save the changes.

Deleting Technician/Equipment from a Service Team

To delete an existing technician:

1. Click the radio button adjacent to the technician's record which you want to delete
and then click Delete.

2. Click OK when prompted for confirmation. The selected technician and all the asso-
ciated expertise, product and cost records will be deleted permanently.
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Managing Expertise of Service Team or Technician

To manage expertise of a service team or technician:

1. Click the radio button adjacent to the service team or technician record. Any existing
expertise records associated with the selected record appear at the bottom in the
Expertise tab as shown below:

Figure 4: Expertise tab in Service Team Console

2. To add one expertise record, click Add Expertise. Select the Skill using the Lookup
icon.

3. Enter Skill Level.

4. To add more than one expertise record, enter a keyword to search for Skills and click
Go. All Skill records matching the keyword appear. Select one or more records from
the resulting set and then click Add Selected. The selected records will be added to
the list on the left, if not already added .

5. Click Save. Alternatively, to delete one or more records check the checkbox against
the records, click Delete and thenOK when prompted for confirmation.

6. To return to the setup home page, click Back To Setup Home on the Top section.

Managing Product Specialization of a Service Team or Technician

To manage Product Specialization of a Service Team or technician:

1. Click the radio button adjacent to the Service Team or technician record. Any existing
Product records associated with the selected record appear at the bottom in the
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Product tab as shown below:

Figure 5: Product tab in Service Team Console

2. To add one product record, click Add Product. Select the product using the Lookup
icon.

3. To add more than one product record, enter a keyword to search for products and
click Go. All product records matching the keyword appear. Select one or more
records from the resulting set and then click Add Selected. The selected records are
added to the list on the left, if not already added.

4. Click Save. Alternatively, to delete one or more product records from the team/-
technician, check the checkbox against the records, click Delete and thenOK when
prompted for confirmation.

5. To return to the setup home page, click Back To Setup Home on the Top section.

Managing Labor Costs of a Service Team or Technician

To manage Labor Cost of a Service Team or technician:

1. Click the radio button adjacent to the Service Team or technician record. Any existing
cost records associated with the selected record appear at the bottom in the Cost tab
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as shown below:

Figure 6: Cost tab in Service Team Console

2. To add a cost record, click Add Cost Record. A blank record is added to the bottom
of the list.

3. Select Cost Category.

4. Enter Hourly Cost and Billable Cost.

5. Select Currency.

6. Click Save. Alternatively, to delete one or more cost records from the team/-
technician, check the checkbox against the records, click Delete and thenOK when
prompted for confirmation.

7. To return to the setup home page, click Back To Setup Home on the Top section.

Managing Dispatchers for a Service Team

To manage dispatchers for a service team:

1. Click the radio button adjacent to the service team record. The Dispatcher tab will be
visible. Note that this tab will be hidden automatically when you select a technician
record. Any existing dispatcher records associated with the selected Service Team
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appear at the bottom in the Dispatcher tab as shown below:

Figure 7: Dispatcher tab in Service Team Console

2. To add one dispatcher record, click Add Dispatcher. Select the Salesforce user using
the Lookup icon.

3. To add more than one dispatcher record, enter a keyword to search for Salesforce
users and click Go. All Salesforce user records matching the keyword appear. Select
one or more records from the resulting set and then click Add Selected. The selected
records are added to the list on the left, if not already added.

4. Click Save. Alternatively, to delete one or more dispatcher records from the team,
check the checkbox against the records, click Delete and thenOK when prompted for
confirmation.

5. To return to the setup home page, click Back To Setup Home on the Top section.

Managing Home Bases for Technician

To manage Home Bases for a technician:

1. Click on the radio button adjacent to the technician record. The Home Base tab will be
visible. Note that this tab will be hidden automatically when you select a service team
record. Any existing home base records associated with the selected technician
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appear at the bottom in the Home Base tab as shown below:

Figure 8: Home Base Tab

2. To add a home base record, click Add Home Base. A blank record is added to the bot-
tom of the list.

3. Enter all the address fields.

4. If the record is the current home base for the technician, check the Current Home
Base checkbox. Only one record can be the current home base for a technician.

5. Click Save. Alternatively, to delete one or more home base records from the tech-
nician, check the checkbox on the records, click Delete and thenOK when prompted
for confirmation.

6. To return to the setup home page, click Back To Setup Home on the Top section.

See Also:

Locations

Product

Service Team Management Console

Skills

Territory
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TERRITORY

Overview
Territory, also referred to as Service Territory, is used in ServiceMax to align one or more
Service Teams and technicians to a logical grouping based on geographical dimensions
such as postal code, city, country and/or virtual dimensions such as product and industry.
Territory management is crucial to achieve work load balancing, and to reach optimum
levels of service resource utilization. ServiceMax provides an interactive tree-based hier-
archical system to manage service territories along with the scope of coverage for each
territory. Once territory hierarchy is defined, technicians can be associated with the appro-
priate territories.

Access and Permissions

Actions User Permissions Needed

To view Territories: "Read" on Territory and Territory Coverage

To create or clone Territories: "Create" on Territory and Territory Coverage

To change Territories: "Edit" on Territory and Territory Coverage

To delete Territories: "Delete" on Territory and Territory Coverage

To view Territory Coverage: "Read" on Territory and Territory Coverage

To create Territory Coverage: "Create" on Territory and Territory Coverage

To change Territory Coverage: "Edit" on Territory and Territory Coverage

To delete Territory Coverage: "Delete" on Territory Coverage

Click Home > ServiceMax Setup > Manage Territories to view the Territory home
page. Alternatively, you can search and navigate to a Territory record and then click Man-
age Territories to view the Territory home page.

789



Territory Fields

Fields Description

Territory
Name

Name of the Territory.

Description Description of the Territory.

Territory
Code

Any internal (typically financials) code your organization uses to refer to this Ter-
ritory.

Active Flag indicates if this group is active and available for Work Order assignments.
This flag does not drive any functionality in ServiceMax and is for informational
purposes only.

Parent Ter-
ritory

Parent Territory a Territory rolls up to. This is a lookup to an existing Territory
in ServiceMax.

Average Driv-
ing Speed
(Miles/Hours)

Average speed in which the technicians of this Territory travel on road. Used in
dispatch optimization.

Max Round
Trip Distance
Daily (Miles)

Distance in miles if the technicians in this Territory cannot travel beyond this
limit on a given route. Used in dispatch optimization.

Max Daily
Hours

Limits on number of hours of Work Order activity per day. Though this option is
available, it is recommended to use technician business hours and break hours
to indicate technician’s availability. Used in dispatch optimization.

Max Hours Limits on number of hours of Work Order activity.

Cost Per Mile Average travel cost per mile for this Territory. Used in dispatch optimization.

Per Hour Cost Average cost of technician’s time for this Territory. Used in dispatch optim-
ization.

Fixed Cost Any fixed costs associated with the technicians in this Territory for each day of
Work Order activity. Used in dispatch optimization.

Break Hours Indicates the duration of time a technician can take during his daily working
hours as breaks. This is a lookup to Salesforce Business Hours.

Territory's
Business
Hours

Indicate the general operating time of a Territory. This is a lookup to Salesforce
Business Hours.

Territory
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Territory Coverage Fields

Fields Description

Territory
Name

Name of the Territory. This is a lookup to an existing Territory in ServiceMax.

Attribute Type of coverage. Standard values include Zip, City, State, and Country.

Value Value for the coverage depending upon the coverage type. For example, if coverage
type is Zip, Value will contain a zip/postal code.

Territory Dispatcher Fields

Fields Description

Territory
Name

Name of the Territory. This is a lookup to an existing Territory in ServiceMax.

Dispatcher
Name

Name of the dispatcher user. This is a reference to an existing Salesforce user
record.

Territory Management Console
This feature provides a streamlined way to manage your service territories. Using this
screen, you can create or edit Territories, Territory coverage, and territory dispatchers.
While all this information can also be entered using the standard Salesforce page layouts,
it is strongly recommended to use this console to manage Territory information. This
screen enforces several data integrity rules and performs automatic calculations of data
which are not done when you enter information using the standard Salesforce page layout.

Click Home > ServiceMax Setup > Manage Territories to view the following screen
with all the existing Territory displayed in tree view. Alternatively, you can search and nav-
igate to a Territory record and then click Manage Territories to view the Territory Man-
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agement Console.

Figure 1: Territory Management Console

Creating a New Territory

To create a territory:

1. Click Add Territory. The following screen appears:

Figure 2: Add Territory Screen

Territory
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2. Enter the details of the new Territory:

a. Enter a unique name for the Territory. For example “Western United States”.

b. Enter any internal code your organization might use to refer to the Territory, if
applicable.

c. Select the parent Territory if this is a child Territory. This will be automatically pop-
ulated if you clicked Add Territory after choosing an existing Territory record.

d. Check the Active checkbox if this Territory is active.

e. Enter a description for the Territory.

f. In the Dispatch Factors section, enter any constraints the technicians in this Ter-
ritory may have. These factors will be used by OptiMax, the dispatch optimization
engine in ServiceMax when dispatching Work Orders for this Territory. If these val-
ues vary by each technician, you can enter the same on the technician screen as
well. See Service Team Management Console for more information. Inform-
ation entered on technician screen will override the dispatch factors entered at the
Territory level.

3. Click Save to save the Territory.

Editing a Territory

To edit an existing Territory:

1. Click the radio button adjacent to the Territory name and then click Edit. The Add Ter-
ritory screen appears with selected Territory information.

2. Make the necessary changes to the Territory record.

3. Click Save to save the changes.

Deleting a Territory

To delete an existing Territory:

1. Click the radio button adjacent to the Territory to select it and then click Delete.

2. Click OK when prompted for confirmation. The selected Territory and all the child Ter-
ritories as well as coverage records will be deleted permanently.
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Managing Coverage for a Territory

To manage coverage for a Territory:

1. Click the radio button adjacent to the Territory record. Any existing coverage records
associated with the selected Territory appear at the bottom in the Territory Coverage
tab as shown below:

Figure 3: Territory Coverage Tab

2. Click Add Coverage to add a new coverage record.

3. Select attribute and the corresponding coverage value.

4. Click Quick Add Zip Coverage, to add coverage based on a range of zip codes. A
popup window appears as shown below:

Figure 4: Coverage Based on Zip Codes Screen

5. Enter the Start Zip Code and End Zip Code and then click Submit. All zip codes
between the start and end zip codes will be added as individual coverage records.
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794 Territory Management Console



Territory

6. Click Quick Add Country Coverage to add coverage based on countries. A popup
window appears as shown below:

Figure 5: Coverage based on Country Screen

7. In the above window, select the countries from the list on the left, move them to the
right and then click Submit. All selected countries are added as individual coverage
records.

8. Click Save. Alternatively, to delete one or more records, check the checkbox against
the record, click Delete and thenOK when prompted for confirmation.

9. To return to the setup home page from the Territory Management Console, click Back
To Setup Home.

Managing Dispatchers for a Territory

To manage dispatchers for a Territory:

1. Click the radio button adjacent to the Territory record. Any existing dispatcher
records associated with the selected Territory appear at the bottom in the Dispatcher
tab as shown below:
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Figure 6: Dispatcher Tab

2. Click Add Dispatcher to add a new dispatcher record. Select the Salesforce user
using the Lookup icon.

3. Click Save. Alternatively, to delete one or more coverage records from the Territory,
check the checkbox against the records, click Delete and thenOK when prompted for
confirmation.

4. To return to the setup home page from the Territory Management Console, click Back
To Setup Home.

To add more than one dispatcher record:

1. Enter a keyword to search for Salesforce users and then click Go!. All Salesforce user
records matching the keyword appear.

2. Select one or more records from the resulting set and then click Add Selected. The
selected records are added to the list on the left, if not already added.

See Also:

Case

Dispatch Optimization using OptiMax

Dispatch Process

Service Team Management Console

Work Order

Territory
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CASE

Overview
A Case is a detailed description of a customer’s feedback, problem, or question. Your
organization can use Cases to track and solve your customer issues. You can enter Cases
manually in the Cases tab, or your administrator can set up Web-to-Case and Email-to-
Case to gather customer feedback from your company’s website and customer emails.
Your customers can also create and submit new Cases on your Self-Service portal.

The Cases tab displays a home page that lets you quickly create and locate Cases. You
can also sort and filter Cases using standard and custom list views. In addition, the Cases
tab lets you view and edit detailed information on all Cases. Optionally, Salesforce Pro-
fessional, Enterprise, Unlimited, and Developer Edition organizations can enable the con-
sole to find, view, and edit Cases and their associated records quickly on one screen.

ServiceMax extends the standard capabilities of the Salesforce Case screen to capture
product information and perform entitlement checks using warranty and service contracts.
In addition, other service transactions such as Returned Material Authorization (RMA),
Shipment, or Work Order can be launched from the Case screen.

Note: The Case module is available only if allowed by your ServiceMax
license. Please contact your ServiceMax administrator to know the type of
license used by your organization.

Access and Permissions

Actions User Permissions Needed

To create RMA
from Case:

"Read" on Cases, Account, Contact, Location, Installed Product, and
Product

"Create" on Parts Order and Parts Order Line
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Actions User Permissions Needed

To create Ship-
ment from Case:

"Read" on Cases, Contact, Account, Location, and Product

"Create" on Parts Order and Parts Order Line

To create Work
Order from Case:

"Read" on Cases, Account, Contact, Installed Product, and Product

"Create" on Work Order and Work Details

To perform Case
Entitlement:

"Edit" on Case

"Read" on Account, Contact, Installed Product, Service Contract, Covered
Products, Entitled Contacts, Warranty Terms, Product Warranty, and
Product

"Create" on Entitlement History

To select Booking
Window for a
Case:

"Edit" on Case

"Read" on Territory, Expertise, Product, Product Serviced, Technician, Ser-
vice Team, and Booking Window

Click the Cases tab to view the Cases home page.

Custom Case Fields

Fields Description

Product The component's product number for which the customer is seeking sup-
port. This is a lookup to an existing Salesforce Product record.

Component Serial
Number

Serial number of the component for which the customer is seeking sup-
port. This is a lookup to an existing installed product record in Ser-
viceMax.

Top-level Serial
Number

Serial number of the top-level installed product to which the component
belongs. This is a lookup to an existing installed product record in Ser-
viceMax. This is a read-only field.

RMA Requested Flag indicates if the customer has requested an RMA. This field does not
drive any functionality in ServiceMax and is for informational purposes
only.

Case
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Fields Description

Replacement Reques-
ted

Flag indicates if the customer has requested a replacement. This field
does not drive any functionality in ServiceMax and is for informational
purposes only.

Entitlement Notes Information entered by the support center engineer at the time of
entitling the customer for the requested services

Entitlement Records List of available entitlement records: warranties and ser-
vice/maintenance contract.

SLA Terms Read-only field that displays the service level description from the ser-
vice/maintenance contract.

Service/Maintenance
Contract Notes

This is a read-only field that displays notes from service/maintenance
contract.

Billing Type Whether the billing is covered by an agreement or this is a paid ship-
ment.

Note: When a Component serial number is entered on the Case, the Com-
ponent’s Product can be automatically derived. However, in the interest of
effective troubleshooting of the problem, some organizations do not opt for
automatic derivation but prefer to capture product and serial number as sep-
arate fields. Your ServiceMax administrator can enable or disable the auto-
matic derivation of product from the serial number record.

Create RMA from Case

To create an RMA from a Case:

1. Locate the Case by searching in the sidebar or from a list view in the Cases tab. Click
the Case number from which you want to initiate an RMA.
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2. Click Create RMA. The Create RMA screen appears as shown below:

Figure 1: Create RMA Screen

3. Select the appropriate Header Record Type and Line Record Type. The default
record type is RMA. If your administrator has set up custom record types for header
and lines, they appear at the top.

4. Select the owner of the RMA in the Owner ID field by using Lookup. Owner ID is usu-
ally the ServiceMax user who will be processing this RMA upon receipt. By default, it is
set to your user name.

5. Select Order Type as applicable.

6. In the From Location section:

Select an address type from Address Type. This automatically populates the
selected address and disables the address field.

If you select a location using Lookup, the address fields are populated auto-
matically. Alternatively you can also enter the address information manually by
entering appropriate values in their respective fields.

Case
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7. Select an existing location using Lookup or enter the address in the To Location sec-
tion.

8. In the RMA Lines section:

The product and serial number entered on the Case automatically appear in the
first RMA line.

Enter a product and/or serial number using Lookup. Note that when the installed
product is selected, the product is not automatically calculated.

Enter Expected Qty, Expected Condition, and Disposition.

Click the Add button to add more product returns. To delete one or more products
entered, click Delete beside each record.

9. Click Save to save the created RMA for a Case.

Below are the configurable options available for this screen. These settings can be adjus-
ted by your ServiceMax administrator.

Default address type.

Whether the Case product and serial number should be automatically included as an
RMA line.

Use Pricebook should be checked by default or not.

Mapping of fields between Case and RMA. This includes your organization’s custom
fields too.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.
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Create Shipment from Case

To create a Shipment from a Case:

1. Locate the Case by searching in the sidebar or from a list view in the Cases tab. Click
the Case number from which you want to initiate a shipment order.

2. Click Create Shipment Order. The Create Shipment screen appears as shown
below:

Figure 2: Create Shipment Order Screen

3. Select the owner of the Shipment in the Owner ID field by using Lookup. Owner ID is
usually the ServiceMax user who will be processing this shipment in logistics. By
default, it will be set to your user name.

4. Select Order Type as applicable.

5. In the From Location section:

Case
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Select an address type from Address Type. This will automatically populate the
selected address and disables the address field.

If you select a location using Lookup, the address fields are populated auto-
matically. Alternatively you can also enter the address information manually by
entering appropriate values in their respective fields.

6. Select an existing location using Lookup or enter the address in the To Location sec-
tion.

7. In the Order Lines section:

Click Add Lines to add more product returns. Alternatively, to delete one or more
products entered, check the records using the checkbox and then click Delete
Lines.

Enter a product using Lookup.

Enter Expected Quantity.

Click Add button to add more product shipments. To delete one or more products
entered, click Delete beside each record.

Check the Use Price Book checkbox and then click Get Price to automatically
calculate the price of a product. Note that the price is calculated only if a valid
price book is configured for shipments. To enter a price manually, uncheck the Use
Price Book checkbox.

8. Click Save to save the created shipment order.

Given below are the configurable options available for this screen. These settings can be
adjusted by your ServiceMax administrator.

Default address type.

Use Pricebook should be checked by default or not.

Mapping of fields between Case and Shipment. This includes your organization’s cus-
tom fields too.
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Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Create Work Order from Case

To create a Work Order from a Case:

1. Locate the Case by searching in the sidebar or from a list view in the Cases tab. Click
the Case number from which you want to initiate a new Work Order.

2. Click Create Work Order. The Create Work Order screen appears as shown below:

Figure 3: Create Work Order Screen

3. Select the Record Type of the Work Order to be created. The Record Type field
appears if the Work Order types are defined and available to you.

4. Enter the Order Type, Billing Type and Problem Description. These are defaulted
and/or copied from the Case.

5. Click Save. A new Work Order is created by copying the relevant information from the
case.

6. Once the work order is created, you will be redirected to the newly created work order
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record. You can then use the appropriate links on the work order screen to create
estimates, parts requests or usage lines.

Note: The mapping of fields between Case and Work Order is configurable by
your ServiceMax administrator. This includes your organization’s custom
fields.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Case Entitlements: Interactive
The entitlement feature utilizes advanced user interface capabilities to deliver a rich inter-
active experience to users.

To initiate an entitlement check on a Case, click Entitlement. The Entitlement section has
three tabs:

Settings: The default entitlement options are as shown below. See various Enti-
tlement options for more information.

Figure 4: Entitlement Options Screen
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Entitlement: To perform entitlement verification on the Case. In the Product Inform-
ation section at the top-left, information from the Case record displays. If the Case is
already entitled using a warranty or service contract, it appears at the bottom sec-
tion.

Figure 5: Case Entitlement Screen

Warranties/Service Contract: To view the details for warranty or service contract
records as shown below:

Figure 6:Warranty or Service Contract Screen

If the Service Based Entitlement setting is enabled (set as True), you can include avail-
able services for service contracts.

Case
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Entitlement Options

Option Purpose

Show Future
Entitlements

Include any warranties and service contracts that are yet to be effective.

Show
Expired Enti-
tlements

Include warranties and service contracts that have expired.

Match
Account

Enforce matching of Account on service contracts with Account on the Case. This
is relevant when a service contract is purchased by your customer but the end cus-
tomer of the product is different.

Match
Contact

Enforce matching of Contact given in the Case to the list of entitled contacts in the
service contract. This is useful when some contact person from your customer
organizations are authorized to contact your support centers.

Match Loca-
tion

Enforce matching of Location in the Case to the list of covered locations in the ser-
vice contract.

Entitle
Using

This indicates if the product or the installed product is considered in entitlement
at all. If Account-based entitlement is selected, all the valid service contracts
for the given account appear, irrespective of the product. If Product-based enti-
tlement is selected, only those warranties and service contracts that provide the
coverage appear.

Parent Consider the entitlement coverage of the product's immediate parent (in the
installed product tree) also. This is useful when your organization implements the
installed product hierarchy.

Top-Level Consider the entitlement coverage of the product's top most product (in the
installed product tree) also. This is useful when your organization implements the
installed product hierarchy.

Child Consider the entitlement coverage of the child installed products of the given
product. Your administrator can also configure the number of levels to traverse in
the product hierarchy.

Part Num-
ber

Consider the entitlement coverage of the part number associated with the given
installed product.

Line Consider the entitlement coverage of the product line of the part number asso-
ciated with the given installed product.

Family Consider the entitlement coverage of the product family of the part number asso-
ciated with the given installed product.

Case Entitlements: Interactive 807



Note: Entitlement Criteria such as Parent, Top-Level, Child, Part Number,
Family and Line are applicable only for Product-based entitlements.

Note: Depending upon your organization’s requirements, the default values
for the above options can be set up by your administrator. If you find the enti-
tlement options disabled, your administrator may have prevented overriding
of the settings by end users.

Case Entitlement Process
In order to entitle the customer to the requested support/services, the Case must be cre-
ated first with the account information. Once you create the Case, locate the Case by
searching the sidebar or from a list view in the Cases tab and then click the Case number
for which you want to perform entitlement verification.

1. Enter the part or full serial number in the component serial/lot number field and then
click the Lookup icon to find if the serial number exists. Select the applicable serial
number for the product.

2. Click Check Entitlement to view the coverage available for the product. ServiceMax
will find all the matching warranties and service contracts based on the entitlement
option selected. The matching warranties and service contracts appear at the bottom
of the screen as shown below:

Case
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Figure 7: MatchingWarranties and Service Contracts Screen

3. Click theWarranty, Service Contract, or SLA Terms link to see more details about
a warranty, a service contract or an SLA Term, respectively. This displays the cor-
responding records in the Warranties/Service Contracts tab.

4. Check the checkbox against the relevant entitlement record and then click Save Enti-
tlement. This action means you have selected to entitle the customer based on the
conditions outlined in the selected warranty or service/maintenance contract. Only
one record can be selected from the entitlement list. The case screen is refreshed
with the details.

If you are not sure about choosing the proper entitlement or if you wish to account for
data corrections and not to lose the product information, enter entitlement notes and
then click Save Entitlement. This saves only the product information and allows you
to return to the Case later to complete the entitlement check.

Case Included Services
To select available contract services to entitle, the Service Based Entitlement setting
(SET022) must be enabled.

1. Click the Service Contract tab.

2. Click the Check Entitlement button.

3. Click the Select a Service link for a contract that has services available. See figure
below.

Figure 8: Select Available Services

4. Select an available service for the contract. In the Included Services dialog box,
select the services you want to include for the contract, or click None if you do not
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want to include any services. See figure below.

Figure 9: Included Services

Case
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If you exceed the available units for a service, you will see a warning message asking
you to confirm your selection. Click Yes to confirm. See figure below.

Figure 10: Included Services WarningMessage

5. Click the Apply button.

6. Click the Save Entitlement button.

Case Entitlement: Automatic
If applicable, you can enable automatic entitlement for all or some of your Cases. This is
achieved by configuring auto entitlement rules based on Case attributes. When the Cases
meet the predefined qualification criteria, ServiceMax automatically verifies existing enti-
tlements and selects the appropriate entitlement (service contract or warranty) for the
Case. Auto entitlement saves significant time during call center interactions with cus-
tomers and avoids end user errors in entitlement.
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In addition, one of the most significant benefits of enabling automatic entitlement on
Cases is that the customers are entitled automatically when they log Cases from the Ser-
viceMax customer portal. This enables your organization to take the corrective action dir-
ectly on the Cases without having to spend time in customer interaction cycles.

If auto entitlement is enabled and configured for your organization, the Case screen will
display a checkbox called Perform Auto Entitlement. Depending on your Salesforce pro-
file, you may or may not be able to edit this checkbox on the Case screen. Please contact
your ServiceMax administrator or subject matter expert to understand if and how auto enti-
tlement is used by your organization.

To perform auto entitlement:

1. Locate the Case by searching in the side bar or from the view list of the Case tab.
Click the Case number and then click Edit to perform the automatic entitlement.

2. Check the Perform Auto Entitlement checkbox as shown in the figure below:

Figure 11: Perform Auto Entitlement - Selected

3. Click Save to perform auto entitlement. Alternatively, click Cancel to return to the
Case record without performing auto entitlement.

When you perform the auto entitlement:

Case
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If information on the Case matches any Active auto entitlement rule set up by your
ServiceMax administrator, the entitlement engine of ServiceMax will perform the
necessary validations and conflict resolutions, and apply the most applicable enti-
tlement on the Case.

Any errors encountered during the entitlement process will appear on the screen.

The service contract, warranty and SLA Terms fields on the Case screen will be
refreshed with the results of the entitlement process.

Depending upon your profile setup, the Case screen will display Auto Entitlement
Status. If this field shows Failed, indicating a problem, try performing auto enti-
tlement status again. If the problem persists, report it to your ServiceMax admin-
istrator.

Note: If the auto entitlement feature does not produce results due to setup
issues, as an interim workaround you can use the interactive entitlement fea-
ture if enabled by your administrator.

Select Booking Windows Slots
This feature allows you to find available slots in various booking windows in a territory and
select an appropriate slot for the Case. In order to use this feature effectively, the fol-
lowing information should be set up effectively in ServiceMax:

Your service organization’s Territory structure

Technicians linked to Territories

Expertise for technicians

Product specialization for technicians

SLA Terms

Booking window definitions

Booking window access, if your organization has exclusive regional booking windows
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In addition, if you like to restrict booking window commitments within the SLA com-
mitment, you must also perform an entitlement check automatically or manually before
using this feature.

To initiate booking window selection on a Case, click Book Appointment. The following
screen appears:

Figure 12: BookingWindows Screen in Case

The Booking window screen has two tabs:

Territory Selection: Enables you to identify the technicians whose availability must
be considered for booking window selection. See below for more information.

Booking Windows: Enables you to find the number of available slots in the given
territory for a range of dates, and select a suitable slot for the Case. See To Select
Booking Windows for more information.

To select a Territory:

1. Click the Territory Selection tab to view the territory tree on the left as shown
below:

Case
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Figure 13: Territory Tree Screen

2. Click the radio button against the Territory where you want to find the technician avail-
ability.

3. Click Expertise if you want to limit the technician availability based on expertise. All
the available expertise of technicians in the Territory appear as shown below. Select
as many expertise records from the list by checking their checkboxes.

Figure 14: Expertise Options Screen

4. Click Product if you want to limit the technician availability based on product spe-
cialization. All the products specialized by technicians in the territory appear as
shown below. Select as many product specialization records from the list by checking
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their checkboxes.

Figure 15: Product Specialization Options

To select Booking Windows:

1. Click the Booking Windows tab to display the number of available slots in the given
Territory for a range of dates, and select a suitable slot for the Case.

2. Enter the Start Date and End Date. The date range is automatically populated
based on your ServiceMax configuration. In addition, the number of days allowed in
the range is also based on ServiceMax configuration settings. If you would like to
change the default date range or the allowed limit, please contact your ServiceMax
administrator.

3. Check the Apply SLA checkbox if you would like to see the booking windows within
the SLA commitment on the Case.

4. The time zone is automatically filled with your time zone. If you would like to view the
results in a different time zone, select the applicable name from the list.

5. Configure how the results should be color-coded at the bottom tab. The booking win-
dow results appear in three colors:

Red: If the number of available slots are below a threshold, indicating a densely
committed slot.

Green: If the number of available slots are above a limit, indicating a highly avail-
able slot.

Yellow: For all the available slots between Red and Green. These are moderately
booked slots.

Case
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6. Click Show Booking Windows. The results appear as shown below:

Figure 16: BookingWindows Slots

7. Select the applicable slot. Talk to your Subject Matter Experts or ServiceMax admin-
istrator for guidance on how to select an appropriate slot.

8. Click Confirm Booking Windows. The selected booking window will be saved on the
Case and you will be redirected to the Case record. Alternatively, click Back To Case
to return to the Case record without choosing a booking window.

View/Manage SLA Clocks on Case
When advanced SLA management is enabled for your organization, the ServiceMax SLA
engine calculates commitment times automatically on a Case where applicable. Depending
on the SLA definition, none, some, or all of the following commitments are tracked on a
Case:

Initial Response Time

Onsite Response Time

Restoration Time

Resolution Time
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If any of the above timestamps are tracked on a Case, a countdown of the remaining time
on each clock displays embedded in the Case screen as shown below:

Figure 17: Clock in the Case Screen

In the above screen, the remaining time is displayed in the format "Days : Hours :
Minutes : Seconds".

The clock appears in various color-codes depending on the time left:

Red: If no time is left on the clock, the clock appears in Red.

Yellow: If less than 25% of time is left, the clock appears in Yellow.

Green: If more than 25% of time is left, the clock appears in Green.

Pausing the SLA Clock

The Pause feature allows you to suspend the SLA clock for as long as you select. This can
be used when the SLA commitment cannot be met due to unforeseen circumstances not
caused by internal factors, and when the customer is in agreement with the delay.

Note: If your ServiceMax administrator has disabled the ability for you to
pause the clock, the Pause and Resume buttons will be disabled.

Case
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To pause the SLA clock, click Pause. A popup screen appears as shown below:

Figure 18: Pause Clock Screen

In the above screen:

Select a reason for pausing the clock. The reasons listed are fully configurable.
Please contact your ServiceMax administrator if the relevant reasons are not listed.

Click Pause to pause the SLA Clock. The popup screen closes and the Case screen
refreshes to show the paused clock. Note that all active SLA clocks on the Case are
paused.

To cancel without pausing the clock, click Cancel.

Resuming the SLA Clock

To resume a paused SLA clock, click Resume. A message appears indicating the amount
of time elapsed since the clock was paused.

Click Yes if you would like to extend the SLA commitment with the elapsed time.

Click No if you would like to keep the SLA commitment as is.

Click Cancel if you do not want to resume the clock.

Note: When you answer Yes or No to the above question, all paused SLA
clocks on the Case will be resumed.

Setting SLA Time Commitments

To set the different SLA time commitments on Case(s), scroll down to the Custom Links
section:

View/Manage SLA Clocks on Case 819



Click the Initial Response Completed link to update the actual response time to
the current date and time.

Click the Onsite Response Completed link to update the actual onsite response
time to the current date and time.

Click the Service Restored link to update the actual restoration time to the current
date and time.

Click the Issue Resolved link to update the actual resolution time to the current
date and time.

See Also:

Account

Booking Windows

Contacts

Installed Product

Location

Product

Service Team

Service/Maintenance Contract

Warranty Terms

Case
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RETURNED MATERIAL AUTHORIZATION (RMA)

Overview
Returned Material Authorization (RMA) is a document that authorizes products or parts to
be returned to the manufacturer/repair center/warehouse.

There are two steps in the RMA process:

1. The RMA is initiated by a support center engineer or field engineer, along with instruc-
tions for handling the returned products. A copy of the RMA document is given to the
customer to be used as a reference in their shipment.

2. The RMA is processed or closed at the receiving location when the products actually
arrive.

ServiceMax uses Parts Orders as a home for RMA and Shipment Orders. See Shipment
Order for more information.

Access and Permissions

Actions User Permissions Needed

To view the Parts
Order tab:

"Read" on Parts Order

To view RMAs: "Read" on Parts Order, Parts Order Line, Account, Contact, Location,
Installed Product, and Product

To create or clone
RMAs:

"Create" on Parts Order, Parts Order Line

"Read" on Account, Contact, Location, Installed Product, and Product

To change RMAs: "Edit" on Parts Order and Parts Order Line

"Read" on Account, Contact, Location, Installed Product, and Product

To delete RMAs: "Delete" on Parts Order and Parts Order Line
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Actions User Permissions Needed

To create RMA
products:

"Create" on Parts Order Line

"Read" on Installed Products and Product

To change RMA
products:

"Edit" on Parts Order Line

"Read" on Installed Product and Product

To delete RMA
products:

"Delete" on Parts Order Line

To process/complete
an RMA:

"Edit" on Parts Order and Parts Order Line

To process receipts
for an RMA:

"Edit" on Parts Order and Parts Order Line

"Read" on Product and Location

"Create", "Edit", "Delete" on Product Stock, Stocked Serial, and Stock
History

Click the Parts Order tab to display the Parts Order home page and then click New in the
Recent Parts Order section. Select the Record Type for a new record as RMA and then
click Continue. The New Parts Order screen appears with the Record Type as RMA.

Caution: Remember that when you are deleting an RMA record, you will not be
warned if the RMA is used in a related record. Since RMAs are strongly tied to
Cases, installed products and Work Orders, review and make sure the RMA
record is not used in any related records.

Note: Fields related to some standard objects such as Cases and Oppor-
tunities are available for use in RMA only if allowed by your ServiceMax
license. Please contact your ServiceMax administrator to know the type of
license used by your organization.

Returned Material Authorization (RMA)
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RMA Fields

Fields Description

Record Type Indicates whether this is an RMA or Shipment.

Case Support Case from which the RMA is originated. This is a lookup to the existing
Salesforce Case record.

Work Order Work Order related to this RMA. This is a lookup to the existing Work Order
record in ServiceMax.

Account Company initiating this RMA. This is a lookup to an existing Salesforce account
record.

Contact Name of the contact person for the customer account for this RMA. This is a
lookup to the existing Salesforce contact record.

Parts Order
Reference

Reference to another parts order number within ServiceMax.

Order Status Current status of the RMA.

Priority Priority of the RMA.

Expected
Receipt Date

Date when the products are expected at the receiving dock. Useful for plan-
ning and allocating resources.

Receiving Cour-
ier

Name of the courier company the customer used to ship the product. This is a
lookup to the existing Salesforce account record.

Tracking Num-
ber

Tracking number given by the courier company.

Service Engin-
eer

Name of the service engineer who initiated the RMA from the field. This is a
lookup to the existing Salesforce user record.

From Location Name of the customer location from where the products are shipped. This is a
lookup to the existing location record in ServiceMax.

From Street "Street" part of the source address.

From City "City" part of the source address.

From State "State/Province" part of the source address.

From Zip "Zip/Postal Code" part of the source address.

From Country "Country" part of the source address.
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Fields Description

To Location Name of the destination address to where the products are shipped. This is a
lookup to an existing location record in ServiceMax.

To Street "Street" part of the destination address.

To City "City" part of the destination address.

To State "State/Province" part of the destination address.

To Zip "Zip/Postal Code" part of the destination address.

To Country "Country" part of the destination address.

Warehouse Name/Number of the warehouse where the products will be received.

Shipping/
Receiving
Notes

Instruction for receiving department. Free text entry.

Returned Material Authorization (RMA)
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RMA Line Fields

Fields Description

Record Type Always set to RMA.

Parts Order RMA number. This is a lookup to an existing Salesforce product record.

Product Name of the product returned by the customer in the RMA. This is a lookup to
the existing Salesforce product record.

Serial Number ID of the installed product returned by the customer in this RMA. This is a
lookup to an existing Installed Products record in ServiceMax.

Expected
Receipt Date

Date on which the product is expected to be received at the depot/-
factory/warehouse.

Expected
Condition

Condition of the product returned.

Expected Qty Number of products returned. Usually 1 for serialized products.

Disposition Type of action to be taken by receiving department when the product arrives.

Disposition
Instructions

Any special handling notes for product disposition.

Actual
Receipt Date

Date on which the product was actually received.

Returned
Condition

Condition of the product when received (As expected or otherwise).

Actual Qty Actual number of unit returned against expected quantity.

Return/Ship
Location

The actual location/location where the product was received. This is a lookup to
an existing location record.

Service Engin-
eer

Name of the service engineer involved in the RMA receipt. This is a lookup to
the existing Salesforce record.

Warehouse Name/identification of the warehouse, where the product was received.

Adding Products to RMA
Locate the RMA by searching in the side bar or from a list view in the Parts Order tab and
then click the RMA number to which you want to add products.
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There are two methods to add products to an RMA:

Method 1: Single-line Entry

1. Click New from the related list Parts Order Lines.

2. Select RMA for Record Type. The RMA number appears.

3. Select Open for Line Status.

4. Enter the name of the product that is returned. You can also use the Lookup icon to
search and select the product.

5. Enter the ID of the Installed Product that is returned. You can also use the Lookup
icon to search and select the installed product.

6. Enter the Expected Receipt Date.

7. Enter the Expected Qty. For Serialized Products, this will normally be 1.

8. Select the Expected Condition.

9. Select the Disposition and enter additional disposition instructions if necessary.

10. Leave the Receipt Details section blank.

11. Click Save to add the product.

Note: An RMA can have an unlimited number of products. Repeat the above
steps for each product to be returned using the RMA. You can also click Save
& New after creating a new RMA product record.

Method 2: Multi-line Entry

1. Click Create Lines from the RMA screen. An RMA Lines screen appears as shown
below:

Returned Material Authorization (RMA)
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Figure 1: RMA Lines Screen

The top section shows the From (Source) and To (Destination) locations from the
RMA. All the products already entered in the RMA appear at the bottom section.

2. Select Order Type as applicable.

3. Select an existing location using the Lookup or enter the address details in the appro-
priate fields in the From Location section.

4. Select an existing location using the Lookup or enter the address details in the appro-
priate fields in the To Location section.

5. Modify the existing product records as needed.

6. Click Add button to add a new product to the RMA. An empty record is added to the
bottom of the list.

a. Enter the name of the product or use the Lookup icon to search and select a
product.

b. Enter the ID of the installed product or use the Lookup icon to search and select
the installed product. Note that when an installed product is selected, the product
is not automatically calculated.
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c. Enter the Expected Quantity.

d. Select the Expected Condition.

e. Select the Disposition.

7. To delete product records entered, click Delete beside each record.

8. Click Save to save your changes.

Processing/Completing an RMA
This step is typically performed when the material is received. Locate the RMA by search-
ing in the side bar or from a list view in the Parts Order tab and then click the RMA number
which you want to process.

There are two ways to process/receive RMA lines:

Method 1: Processing an Individual RMA Item

You can edit each RMA line record and enter receipt information. This is done when there
are any differences between the expected quantity and date, and the actual (received)
quantity and date.

To process each RMA item individually:

1. In the Parts Order lines Related List section, click Edit next to the RMA item you want
to receive and process.

2. Enter the actual receipt date. You can enter today's date by clicking on the date link
next to the date field.

3. Enter the actual quantity.

4. Enter the name of the service engineer, who should be notified upon the receipt of this
material. This could be a depot repair technician who awaits this product to
troubleshoot.

5. Select the returned condition.

6. Enter the name of your location or the location where the product was received. You
can also use the Lookup icon to search and select the location.

7. Enter the warehouse name/number.
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8. Change the Line Status to Completed.

9. Click Save.

10. When all the items are completed, edit the RMA, change the Order Status to Closed
and then click Save.

Method 2: Processing All of an RMA's Items at Once

You can process all line items at once if the received product information matches the
expected product for all RMA lines.

To process an entire RMA in one click:

1. Click Complete Receipt.

2. Click OK when prompted. This will change the RMA Status to Closed, set the RMA
Line Item Status to Completed, and set the RMA receipt information to match the
expected information for all line items.

Processing Receipts for RMA
When parts returned are received in the location specified in an RMA, you should process
the receipts in ServiceMax for inventory accountability and also to complete the RMA
cycle.

To process receipts for an RMA:

1. Locate the RMA by searching in sidebar or from a list view in Parts Orders tab and
then click the RMA record for which you want to process receipts.

2. Make sure the RMA is open and the destination location is not blank. Also ensure the
RMA has at least one product to be received.

3. Click Process Receipts. A screen appears (sample shown below) in which you can
enter the actual receipt information. The screen lists all products in the RMA that are
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not yet received. The Actual Qty is defaulted to the pending quantity expected.

Figure 2: Sample Process Receipts Screen

4. When entering received quantities, one or more of the following scenarios may be
applicable:

Receipt Scenario How to process it

All products in the RMA have
been received as expected.

Click Submit. All the open lines and the RMA will be
closed automatically.

A product has not been
received now but it is expec-
ted to be received at a later
date.

Enter Zero in Actual Qty. Make sure that the Close Line
checkbox is not selected. This leaves the Line open for a
future receipt.

A product has not been
received and will not be
received in the future at all.

This amounts to cancellation of an open RMA line. Enter
Zero in Actual Qty. Make sure that the Close Line
checkbox is selected. If your organization does not permit
short-closing line, this checkbox may be disabled.

A product has been received
partially now. The remain-
ing quantity is expected to
be received at a later date.

Enter the quantity received. Make sure that the Close
Line checkbox is not checked. This leaves the line open
for a future receipt.

A product has been received
partially now. The remain-
ing quantity will not be
received in future at all.

This indicates the short-closure of an RMA line. Enter the
quantity received. Make sure that the Close Line check-
box is checked. If your organization does not permit
short-closing line, this checkbox may be disabled.

5. Click Submit to confirm the entries made. Alternately, click Cancel to return to the
RMA screen.

6. If your organization tracks inventory at the serial number level, the bottom section of
the screen allows you to enter/select serial numbers for serialized products. To enter
serial numbers for a product, check the checkbox against the product in the list. See
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Serial Number Selection to learn about how serialized tracking of inventory works
in ServiceMax.

7. The RMA screen refreshes. The RMA Line and RMA Status are updated.

Create Linked Shipment from RMA
This feature allows you to create a shipment order to send the processed RMA’ed material
back.

To create a linked shipment order:

1. Locate the RMA by searching in the sidebar or from a list view in the Parts Order tab.
Click the order number from which you want to initiate a linked shipment order. The
Create Shipment screen appears as shown below.

Figure 3: RMA Linked Shipment

2. Select the owner of the Shipment in the Owner ID field by using Lookup. Owner ID is
usually the ServiceMax user who will be processing this shipment in logistics. By
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default, it will be set to your user name.

3. Select Order Type as applicable.

4. The From Location and To Location sections will be populated automatically with
the addresses from the RMA record. Edit them as required or you can also enter a new
address either manually or select an existing location using Lookup.

5. The Order Lines section will also be populated automatically with the information of
the product(s) that were RMA’ed. Enter the Expected Quantity.

6. Click Add Lines to add more products. Alternatively, to delete one or more products
listed, select the records by checking their checkbox and then click Delete Lines.

7. Check the Use Price Book checkbox and then click Get Price to automatically cal-
culate the price of a product. Note that the price is calculated only if a valid price book
is configured for shipments. To enter a price manually, check the Use Price Book
checkbox.

8. Enter Expected Ship Date.

9. Click Save to save the created shipment order.

Below are the configurable options available for this screen. These settings can be adjus-
ted by your ServiceMax administrator.

Default address type.

Use Pricebook should be checked by default or not.

Default Shipment Line Pricebook.

Mapping of fields between RMA and Shipment. This includes your organization’s cus-
tom fields too.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.
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See Also:

Account

Contacts

Location

Product

Parts Order - Standard Settings

Serial Number Selection

Shipment Order
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SHIPMENT ORDER

Overview
Shipment Order is an internal document that authorizes products or parts to be shipped to
a customer or field inventory location.

There are two steps in a shipment process:

1. The shipment order is initiated by a support center engineer or inventory planner. A
copy of the shipment note is sent to the receiving entity (customer or service engin-
eer).

2. The shipment is processed and closed at the shipping location when the products are
actually shipped to the specified destination.

ServiceMax uses the Parts Orders tab for Returned Material Authorization (RMA) and Ship-
ment Orders. See RMA for more information about the RMA module.

Access and Permissions

Actions User Permissions Needed

To view the Parts Order
tab:

"Read" on Parts Order

To view Shipment Orders: "Read" on Parts Order, Parts Order Line, Account, Contact, Loca-
tion, Installed Product, and Product

To create or clone Shipment
Orders:

"Create" on Parts Order and Parts Order Line

"Read" on Account, Contact, Location, Installed Product and
Product

To change Shipment Orders: "Edit" on Parts Order and Parts Order Line

"Read" on Account, Contact, Location, Installed Product and
Product
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Actions User Permissions Needed

To delete Shipment Orders: "Delete" on Parts Order and Parts Order Line

To create Shipment Order
products:

"Create" on Parts Order Line

"Read" on Product

To change Shipment Order
products:

"Edit" on Parts Order Line

"Read" on Product

To delete Shipment Order
Products:

"Delete" on Parts Order Line

To process/complete a Ship-
ment Order:

"Edit" on Parts Order and Parts Order Line

To process shipments for a
Shipment Order:

"Edit" on Parts Order and Parts Order Line

"Read" on Product and Location

"Create", "Edit", "Delete" on Product Stock, Stocked Serial, and
Stock History

To cancel a Shipment Order: "Edit" on Parts Order and Parts Order Line

Click the Parts Order tab to display the Parts Order home page and then click New in the
Recent Parts Order section. Select the Record Type for the new record as Shipment and
then click Continue. The New Parts Order screen appears with the Record Type as Ship-
ment.

Caution: Remember that when you are deleting a shipment order you will not
be warned if the shipment order is used in a related record. Since shipment
orders are strongly tied to Cases, Installed Products, and Work Orders, review
and make sure the shipment order record is not used in any related records.

Note: Fields related to some standard objects such as Cases and Oppor-
tunities are available for use in Shipment Order only if allowed by your Ser-
viceMax license. Please contact your ServiceMax administrator to know the
type of license used by your organization.

Shipment Order
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Shipment Order Fields

Fields Description

Record Type Indicates if this is a shipment order or Shipment.

Case Support case from which this shipment order is originated. This is a
lookup to an existing Salesforce case record.

Work Order Work Order related to this Shipment Order. This is a lookup to an existing
Work Order record in ServiceMax.

Account Company initiating this Shipment Order. This is a lookup to an existing
Salesforce account record.

Contact Name of the contact person from the customer account for this shipment
order. This is a lookup to an existing Salesforce contact record.

Parts Order Refer-
ence

Reference to another Parts Order number within ServiceMax.

Order Status Current status of the shipment order.

Priority Priority of the shipment order.

Expected Ship Date Date when the products are expected to be shipped to the customer. Use-
ful for planning and allocating resources.

Service Engineer Name of the service engineer associated with the shipment order. This is
a lookup to the existing Saleforce user record.

Sales Order Number Sales order number reference from a back-office Enterprise Resource
Planning (ERP) application.

From Location Name of your organization's location from where the products will be
shipped. This is a lookup to an existing location record in ServiceMax.

From Street "Street" part of the source address.

From City "City" part of the source address.

From State "State" part of the source address.

From Zip "Zip" part of the source address.

From Country "Country" part of the source address.

Warehouse Name/number of the warehouse from where the product will be shipped.
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Fields Description

To Location Name of the customer's location to which the products are shipped. This is
a lookup to an existing location record in ServiceMax.

To Street "Street" part of the destination address.

To City "City" part of the destination address.

To State "State/Province" part of the destination address.

To Zip "Zip/postal code" part of the destination address.

To Country "Country" part of the destination address.

Shipping/Receiving
Notes

Instruction for the shipping department. This is a free text entry field.

Shipping Terms List indicates the standard shipping terms such as FOB, EXW, DDP.

Delivery Option Special delivery requirements such as Saturday Delivery.

Bill To Indicates who should be billed for shipping charges.

Billing Type Indicates whether the billing is covered by an agreement or this is a paid
shipment.

Shipping Courier Name of the courier company used to ship the product. This is a lookup to
an existing Salesforce Account record.

Tracking Number Tracking number given by courier company.

Canceled By The Salesforce user who canceled this Parts order.

Canceled On Date/time when this Parts order was canceled.

Closed By Salesforce user who closed this Parts order.

Closed On Date/time when this Parts order was closed.

Parts Request The ServiceMax Parts Request for which this shipment order is created.

Shipment Order Line Fields

Record Type Always set to Shipment

Parts Order Shipment Order number. This is a lookup to an existing Shipment Order in Ser-
viceMax.

Shipment Order
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Record Type Always set to Shipment

Product Name of the product to be shipped in this Shipment Order. This is a lookup to an
existing Salesforce Product record.

Serial Num-
ber

ID of the installed product shipped in this shipment order. This is a lookup to an
existing Installed Product record in ServiceMax.

Expected
Ship Date

Date on which the product is shipped to the customer/field location.

Expected Qty Number of products shipped. Usually 1 for a serialized product.

Packing
Instructions

Any special handling notes for shipping department.

Actual Ship
Date

Date on which the product was actually shipped.

Actual Qty Actual number of units shipped against expected quantity.

Return/Ship
Location

The actual location/location where the product was shipped. This is a lookup to an
existing location record.

Service
Engineer

Name of the service engineer. This is a lookup to an existing Salesforce user
record.

Sales Order
Number

Sales order reference from back-office ERP application.

Canceled By The Salesforce user that canceled the shipment line. This is set automatically
when a user cancels the shipment line.

Canceled On Date/time when this shipment was canceled. This is set automatically when a
user cancels the shipment line.

Closed By The Salesforce user who closed this Parts order.

Closed On Date/time when this Parts order was closed.

Parts
Request Line

The ServiceMax Parts Request for which this shipment order was created.

Posted To
Inventory

Flag indicates if this Parts order line has been posted to inventory or not.

Work Details The ServiceMax Work Order parts request line for which this shipment line was
created.
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Adding Products to a Shipment Order
Locate the shipment order by searching in the side bar or from a list view in the Parts
Orders tab and then click the Shipment Order number to which you want to add products.

There are two methods available to add products to a shipment order.

Method 1: Single-line Entry

1. Click New from the Parts Order Lines related list.

2. Select Shipment for the Record Type. The Shipment Order number appears.

3. Select Open for Line Status.

4. Enter the name of the product to be shipped or use the Lookup icon to search and
select the product.

5. Enter the ID of the installed product to be shipped or use the Lookup icon to search
and select the installed product.

6. Enter the expected ship date.

7. Enter the expected quantity. For serialized products, this will normally be 1.

8. Enter special packing instructions if necessary.

9. Leave the actual shipment details section blank.

10. Click Save.

Note: A Shipment Order can have an unlimited number of products. Repeat
the above steps for each product to be shipped using the Shipment Order. You
can also click Save & New after creating a new Shipment Order product
record.
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Method 2: Multi-line Entry

1. Click Create Lines from the Shipment screen.

Figure 1: Shipment Lines Screen

The top section shows the From (Source) and To (Destination) locations from the
shipment. All products that were already entered in the shipment appear at the bot-
tom section.

2. Select Order Type as applicable.

3. Select an existing location using the Lookup or enter the address in the From Loca-
tion section.

4. Select an existing location using the Lookup or enter the address in the To Location
section.

5. Modify the existing product records, if needed.

6. Click the Add button to add a new product to the Shipment Order. An empty record is
added at the bottom of the list.

a. Enter the name of the product or use the Lookup to search and select the
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product.

b. To delete product records entered, click Delete beside each record.

c. Enter the expected quantity.

d. Check the Use Price Book checkbox and then click Get Price to calculate the
price of a product automatically. Note that the price is calculated only if a valid
price book is configured for shipments. To enter a price manually, check the Use
Price Book checkbox.

e. Click Add Line to add as many products as required. Alternatively, check the
record using the checkbox and then click Delete Lines to delete one or more
products.

7. Click Save to save your changes.

Processing a Shipment Order with no Inventory Updates
This step is typically performed when the material is shipped. Locate the shipment order
by searching in the sidebar or from a list view in Parts Orders tab. Click the Shipment
Order number which you want to process. There are three ways to process/ship shipment
order lines:

Processing Individual Shipment Order Items

Processing an Entire Shipment Order with One Click

Processing an Entire Shipment Order with Ship Quantity

Method 1: Processing Individual Shipment Order Items

You can edit each shipment order line record and enter shipment information. This is done
when there are any discrepancies between expected quantity and date, and actual
(shipped) quantity and date.

1. In the related list section of the Parts Order Lines, click Edit next to the shipment
order item you want to receive and process.

2. Enter the actual ship date. You can enter today’s date by just clicking the date link
next to the date field.

3. Enter actual quantity shipped.
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4. Enter the name of the service engineer who should be notified upon shipment. This
could be a field service engineer awaiting the shipment to complete a Work Order.

5. Enter the name of customer/field location where the product is shipped or use the
Lookup icon to search and select the location.

6. Change the Line Status to Completed and then click Save.

7. When you have completed all the line items in the Shipment Order, edit the Shipment
Order, change the Order Status to Closed and then click Save.

Method 2: Processing an Entire Shipment Order with One Click

You can process all line items at once if the shipped product information matches expected
product for all shipment order lines.

To process an entire shipment order in a single click:

1. Click Complete Shipment to complete the shipment order.

2. Click OK when prompted.

This will change the shipment Order Status to Closed, set the shipment order Line Item
Status to Completed, and set the shipment order shipping information to match the
expected information for all line items.

Method 3: Processing an entire Shipment Order with Ship Quantity

You can process multiple shipment lines by entering ship quantity only.

1. Click Process Shipment.

2. In the screen that appears, enter the actual shipped quantity for applicable products.
Enter zero if a product is not shipped. If you make a partial shipment, you can either
select to leave the shipment request open for future shipments or close the remaining
by checking the Close Request checkbox.

3. Click Submit after entering ship quantity for all the items. The shipment order screen
will be refreshed and the shipment order line and shipment order status is updated
and displayed.
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Processing a Shipment with Inventory Updates
When parts are ready to ship to the location specified in a Shipment Order, you should pro-
cess the shipment in ServiceMax for inventory accountability and to complete the Ship-
ment Order.

To process shipments for a Shipment Order:

1. Locate the Shipment Order by searching in the sidebar or from a list view in Parts
Order tab and then click the Shipment Order number associated with the shipment
you want to process. Make sure the Shipment Order is Open and the destination loc-
ation is not blank. Also ensure the Shipment Order has at least one product to be
shipped.

2. Click Process Shipments (Inv). A screen appears (sample shown below) where
you can enter the actual shipment information. The screen lists all products in the
Shipment Order that are not yet shipped. The Quantity Shipped is defaulted to the
pending quantity requested.

Figure 2: Process Shipments (Advanced) Screen

3. When entering shipped quantities, one or more of the following scenarios may be
applicable:

Shipment Scenario How to process it

All the products in the
Shipment Order have
been shipped as reques-
ted.

Click Submit. All the open lines and the Shipment Order will
be closed automatically.

Shipment Order
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Shipment Scenario How to process it

A product has not been
shipped now but may be
later.

Enter Zero in Actual Qty. Make sure the Close Line check-
box is unchecked. This leaves the line open for future ship-
ment.

A product has not been
shipped and it will not be
shipped at all.

This amounts to the cancellation of an open Shipment Order
Line. Enter Zero in Actual Qty. Make sure the Close Line
checkbox is selected. If your organization does not permit
short-closing lines, this check box may be disabled.

A product has been
shipped partially now.
The remaining quantity is
expected to be shipped
later.

Enter the quantity shipped. Make sure the Close Line check-
box is unchecked. This leaves the line open for future ship-
ment.

A product has been
shipped partially now.
The remaining quantity
will not be shipped at all.

This indicates the short-closure of a Shipment Order Line.
Enter the quantity shipped. Make sure the Close Line check-
box is checked. If your organization does not permit short-
closing line, this checkbox may be disabled.

4. Click Submit to confirm the entries. Alternatively, click Cancel to return to the Ship-
ment Order screen.

5. If your organization tracks inventory at the serial number level, the bottom section of
the screen allows you to enter/select serial numbers for serialized products. To enter
serial numbers for a product, check the checkbox against the product in the list. See
Serial Number Selection to learn about how serialized tracking of inventory works
in ServiceMax.

6. The Shipment Order screen will be refreshed and the Shipment Order Line and Ship-
ment Order Status are updated.

Note: A serialized product is shipped to a non-stocking location. The Available
stock the source location is reduced by the shipped quantity, and DECREASED
stock at the source location is increased by the shipped quantity. The shipped
serials are associated with the DECREASED stock record.
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Canceling a Shipment Order
When you don't have any processed shipments for a Shipment Order, you can cancel the
order. Once a Shipment Order is canceled, it will not be available for processing shipments
anymore.

To cancel a Shipment Order:

1. Locate the Shipment Order by searching in the side bar or from a list view in the Parts
Order tab and then click the Shipment Order you want to cancel. Make sure the Ship-
ment Order is Open. Also ensure none of the product in the Shipment Order is
shipped.

2. Click Cancel Shipment and then click OK when prompted.

See Also:

Account

Contacts

Location

Product

Parts Order - Standard Settings

Returned Material Authorization (RMA)

Serial Number Selection
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846 Canceling a Shipment Order



WORK ORDER

Overview
Work Order is used to plan, execute and manage Service events for Field and Depot Ser-
vice activities. Depending on the service scenario, the Order creation can be triggered by
many events:

When creating a Support Case.

When one or more installed products require periodic service or calibration.

When troubleshooting a customer problem in the field.

If the field service engineer learns that the product requires specialized conditions of
a factory/depot to resolve the problem.

When a new/repair shipment to the customer requires specialized installation activ-
ity.

In ServiceMax, Work Orders can be used to manage the entire service delivery process,
from creating estimates and quotations, to requesting and receiving parts, to recording
usage/consumption, to closure and analysis.

Note: Work Order is also interchangeably referred to as Service Order in Ser-
viceMax.

Access and Permissions

Action Users Permissions Needed

To view the Work
Orders tab:

"Read" on Work Order

To view Work Orders: "Read" on Work Order and Work Details
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Action Users Permissions Needed

To create or clone
Work Orders:

"Create" on Work Order, Account, Contact, Installed Product, Case,
Service Team, Technician, and Work Details

To change Work
Orders:

"Edit" on Work Order, Account, Contact, Installed Product, Case, Ser-
vice Team, Technician, and Work Details

To delete Work Orders: "Delete" on Work Order

To perform Work
Order Entitlement:

"Edit" on Work Order

"Read" on Account, Contact, Installed Product, Service Contract,
Covered Products, Entitled Contacts, Warranty Terms, Product War-
ranty, and Product

"Create" on Entitlement History

To find and assign a
Service Team to a
Work Order:

"Edit" on Work Order

"Read" on Service Team

To find and assign a
Work Order:

"Edit" on Work Order

"Read" on Technician/Equipment

To perform Advanced
Dispatch:

"Edit" on Work Order

"Read"  on Service Team, Technician/Equipment

"Modify All Data" enabled in login user's profile

To create an RMA from
a Work Order:

"Read" on Work Order, Account, Contact, Installed Product, Product,
Location, and Work Order Details

"Create" on Parts Order and Parts Order Line

To create Work Order
Lines:

"Create" on Work Details

"Read" on Installed Product, Location, and Product

To edit Work Order
Lines:

"Edit" on Work Details

"Read" on Installed Product, Location, and Product

To delete Work Order
Lines:

"Delete" on Work Details

Work Order
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Action Users Permissions Needed

To create Usage Lines
from Estimates:

"Create" on Work Details

"Read" on Installed Product, Location, and Product

To create quotations: "Read" on Work Order, Product, Account, Contact, and Work Details

"Create" on Service Quotes, and Quote Item.

To cancel all parts
request:

"Edit" on Work Order and Work Details

To perform a stock
lookup:

"Read" on Location, Product and Product Stock

"Edit" on Work Details.

To create a Shipment
Order:

"Read" on Work Order, Account, Contact, Product, and Work Details

"Create" on Parts and Parts Order Line.

To process receipts on
Work Order:

"Read" on Location.

"Edit" on Work Order and Work Details

"Create" and "Edit" on Product Stock, Stocked Serial, and Stock His-
tory

To view process bot-
tlenecks:

“Read” on Process Bottlenecks, Case, Contact and Work Order

To create process bot-
tlenecks:

"Create" on Process Bottlenecks

"Read" on Case, Work Order, and Contact

To change process bot-
tlenecks:

"Edit" on Process Bottlenecks

"Read" on Case, Work Order, and Contact

To delete process bot-
tlenecks:

"Delete" on Process Bottlenecks

To close a Work Order: "Edit" on Work Order and Work Details

To post usage to invent-
ory:

"Edit" on Work Order, Product, Location, and Work Details

"Create" and "Edit" on Product Stock, Stocked Serial, and Stock His-
tory
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Click theWork Orders tab to display the Work Order home page.

Caution: When deleting Work Orders, you will not be warned if the Work Order
is used in a related record. Since Work Orders are strongly tied to Cases,
installed products, and Parts orders, review and make sure the Work Order
record is not used in any related records.

Work Order Fields

Fields Description

Case Support Case from which this Work Order is originated. This is a lookup to an
existing Salesforce Case record.

Account/Company Company initiating this Work Order. This is a lookup to an existing Salesforce
Account record.

Contact Name of the contact person from the customer account for this Work Order.
This is a lookup to an existing Salesforce Contact record.

Component The component installed product which is at the center of the issue reported
by the customer.

Entitlement
Notes

Information entered by the support center engineer at the time of entitling the
customer for the requested services.

Entitlement
Records

List of available entitlement records: warranties and service/maintenance con-
tract.

Top-level The top-level installed product to which the component installed product
belongs.

Parts Order Reference to a Parts Order number in ServiceMax.

Problem Descrip-
tion

Detailed description of the problem as reported by the customer.

Order Status Current status of the Work Order.

Priority Priority of the Work Order.

Customer Down If the customer situation is critical affecting the uptime due to the problem
reported.

Work Order
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Fields Description

Order Type Type of Work Order. Options include: Field Service, Depot Repair, and so on.

Purpose of
Visit

If the Order Type is Field Service, specific reasons for the field service.

Billing Type How the Work Order expenses will be accounted for. Options include: Agree-
ment, Paid, and so on.

Service Team Name of the Service Team that is working on the Work Order. If your organ-
ization uses ServiceMax dispatch console to manage Work Order assign-
ments, this field will be read-only in the Work Order screen.

Technician Name of the Technician working on the Work Order. This does not imply that
this member has ownership of the Work Order record. If your organization
uses ServiceMax dispatch console to manage Work Order assignments, this
field will be read-only on the Work Order screen.

Work Performed Details of work performed to address or resolve the Work Order.

Special Instruc-
tions

Relevant instruction for future service events for the same product/customer.

Customer Fail-
ure Feedback

Feedback given by the customer about the overall failure event and how your
organization responded.

Corrective
Action

Any corrective action taken by your engineer(s) to address the customer feed-
back.

Configuration -
Before

Snapshot of the product's technical details before the engineer(s) started
addressing it.

Configuration -
After

Snapshot of the product's technical details after the engineer(s) resolved/ad-
dressed the issue.

Failure Loca-
tion

Location where the product failed such as Field or Depot.

Failed Assembly The assembly of the product that failed. Your system administrator is respons-
ible for configuring this list for your organization's requirements.

Symptom Symptom that was noted before the failure. Your system administrator is
responsible for configuring this list for your organization’s requirements.

Root Cause Root cause of the failure. Your system administrator is responsible for con-
figuring this list for your organization’s requirements.
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Fields Description

How Fixed Type of fix that was applied to resolve the problem. Your system admin-
istrator is responsible for configuring this list for your organization’s require-
ments.

Street "Street" part of the service location's address.

City "City" part of the service location's address.

State "State" part of the service location's address.

Zip "Zip" part of the service location's address.

Country "Country" part of the service location's address.

Dispatch Pro-
cess

Dispatch process to be used to schedule which this Work Order. This is a
lookup to ServiceMax Process.

Dispatch Pri-
ority

Work Order priority bucket as defined in the dispatch process. This will be cal-
culated automatically.

Preferred Tech-
nician

Name of the preferred Technician for the Work Order. Calculated from the ser-
vice contract, installed product or account wherever available.

Primary Ter-
ritory

Primary Territory for the Work Order. This is calculated automatically by the
OptiMax precalculation engine.

Scheduled Date
Time

Schedule date and time to dispatch the Work Order.

OptiMax Status OptiMax dispatch status for the Work Order.

OptiMax Error
Text

Details of error occurred when performing precalculations for OptiMax.

Preferred Start
Time

Start time for the Work Order to be scheduled. Calculated automatically
based on booking window, SLA and access hours.

Preferred End
Time

End time before which the Work Order must be scheduled. Calculated auto-
matically based on booking window, SLA and access hours.

SLA Terms SLA Terms used for dispatch process.

Service Dur-
ation (in
Seconds)

Duration in minutes required for the Work Order. Calculated from rules by
OptiMax precalculation engine.

Is PM Work
Order

Indicates if this is a preventive maintenance Work Order or not. Set auto-
matically by PM scheduler.

Work Order
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Fields Description

Scheduled Date Scheduled date for the Preventive maintenance Work Order.

Preventive Main-
tenance Plan

The source PM Plan that resulted in this preventive maintenance Work Order.
Set by PM scheduler.

PM Tasks
Created

Indicates if PM tasks have been created.

Work Order Entitlements
The entitlement feature utilizes advanced user interface capabilities to deliver a rich inter-
active experience to users.

To initiate entitlement check a Work Order and click Entitlement. The following screen
appears:

Figure 1:Work Order Entitlement Screen

The Entitlement screen has three tabs:

Settings: To show the default entitlement options as shown below. See various Enti-
tlement options for more information.

Figure 2: Entitlement Options Screen

Work Order Entitlements 853



Entitlement: To perform entitlement verification on the Work Order. In the Product
Information section at the top-left, information fromWork Order record appears. If
the Work Order is already entitled using a warranty or service contract, it appears at
the bottom section.

Warranties/Service Contract: To view the details for warranty or service contract
records as shown below:

Figure 3:Warranty or Service Contract Screen

Entitlement Options

Option Purpose

Show Future
Entitlements

Include any warranties and service contracts that are yet to be effective.

Show
Expired Enti-
tlements

Include warranties and service contracts that have expired.

Match
Account

Enforce matching of Account on service contracts with Account on the Work
Order. This is relevant when a service contract is purchased by your customer but
the end customer of the product is different.

Work Order
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Option Purpose

Match
Contact

Enforce matching of Contact given in the Work Order to the list of entitled con-
tacts in the service contract. This is useful when some contact person from your
customer organizations are authorized to contact your support centers.

Match Loca-
tion

Enforce matching of Location in the Work Order to the list of covered locations in
the service contract.

Entitle
Using

This indicates if the product or the installed product is considered in entitlement
at all. If Account-based entitlement is selected, all the valid service contracts
for the given account appear, irrespective of the product. If Product-based enti-
tlement is selected, only those warranties and service contracts that provide the
coverage appear.

Parent Consider the entitlement coverage of the product's immediate parent (in the
installed product tree) also. This is useful when your organization implements the
installed product hierarchy.

Top-Level Consider the entitlement coverage of the product's top most product (in the
installed product tree) also. This is useful when your organization implements the
installed product hierarchy.

Child Consider the entitlement coverage of the child installed products of the given
product. Your administrator can also configure the number of levels to traverse
in the product hierarchy.

Part Num-
ber

Consider the entitlement coverage of the part number associated with the given
installed product.

Line Consider the entitlement coverage of the product line of the part number asso-
ciated with the given installed product.

Family Consider the entitlement coverage of the product family of the part number asso-
ciated with the given installed product.

Note: Entitlement Criteria such as Parent, Top-Level, Child, Part Number, Fam-
ily and Line are applicable only for Product-based entitlements.
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Note: Depending upon your organization’s requirements, the default values
for the above options can be set up by your administrator. If you find the enti-
tlement options disabled, your administrator may have prevented overriding
of the settings by end users.

Work Order Entitlement Process
In order to entitle the customer for requested support/services, the Work Order must be
created first with the account information. Once you create the Work Order, locate the
Work Order by searching the sidebar or from a list view in the Work Orders tab and then
click the Work Order number for which you want to perform entitlement verification.

1. Enter the part or full serial number in the component serial/lot number field and then
click the Lookup icon to find if the serial number exists. Select the applicable serial
number for the product.

2. Click Check Entitlement to view the coverage available for the product. ServiceMax
will find all the matching warranties and service contracts based on the entitlement
option selected. The matching warranties and service contracts appear at the bottom
of the screen as shown below.

Figure 4: MatchingWarranties and Service Contracts Screen

3. Click theWarranty, Service Contract, or SLA Terms link to see more details about
a warranty, a service contract, or an SLA Term, respectively. This will display the cor-
responding records in the Warranties/Service Contracts tab.

4. Check the checkbox against the relevant entitlement record and then click Save Enti-
tlement. This action means you have selected to entitle the customer based on the
conditions outlines in the selected warranty or service/maintenance contract. Only
one record can be selected from the entitlement list. The Work Order screen
refreshes with the details.
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If you are not sure about choosing the proper entitlement or if you wish to account for
data corrections and not to lose the product information, enter entitlement notes and
then click Save Entitlement. This saves only the product information and allows you
to return to the Work Order later to complete the entitlement check.

Work Order Included Services
To select available contract services to entitle, the Service Based Entitlement setting
(SET022) must be enabled.

1. Click the Service Contract tab.

Figure 5: Service Contracts Screen (Entitlement Tab)

2. Click the Check Entitlement button.

3. Click the Select a Service link for a contract that has services available (see figure
below).

Figure 6: Select Available Services
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4. Select an available service for the contract. In the Included Services dialog box,
select the services you want to include for the contract, or click None if you do not
want to include any services. See figure below.

Figure 7: Included Services

Note: The Allowed Units column displays how many units are available
for the service. The Consumed Units column displays the number of units
consumed.
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If you exceed the available units for a service, you will see a warning message asking
you to confirm your selection. See figure below.

Figure 8: Included Services WarningMessage

5. Click Yes to confirm.

6. Click the Apply button.

7. Click the Save Entitlement button.

View/Manage SLA Clocks on a Work Order
When advanced SLA management is enabled for your organization, ServiceMax SLA
engine calculates commitment times automatically on a Work Order where applicable.

Depending upon the SLA definition, none, some, or all of the following commitments are
tracked on a Work Order:
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Initial Response Time

Onsite Response Time

Restoration Time

Resolution Time

If any of the above timestamps are tracked on a Work Order, a countdown of the remain-
ing time on each clock is displayed embedded in the Work Order screen as shown below:

Figure 9: Clock in the Work Order Screen

In the above screen, the remaining time is displayed in the format "Days : Hours : Minutes
: Seconds".

The clock will be displayed in various color-codes depending on the time left:

Red: If no time is left on the clock, the clock appears Red.

Yellow: If less than 25% of time is left, the clock appears Yellow.

Green: If more than 25% of time is left, the clock appears Green.

Pausing the SLA Clock

The Pause feature allows you to suspend the SLA clock for as long as you select. This can
be used when the SLA commitment cannot be met due to unforeseen circumstances not
caused by internal factors, and when the customer is in agreement with the delay. If your
ServiceMax administrator has disabled the ability for you to pause the clock, the Pause but-
ton will be disabled.

To pause the SLA clock, click Pause. A popup screen appears as shown below:
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Figure 10: Pause Clock Screen

In the above screen:

Select a reason for pausing the clock. The reasons listed are fully configurable.
Please contact your ServiceMax administrator if the relevant reasons are not listed.

Click Pause to pause the SLA Clock. The popup screen closes and the Work Order
screen refreshes to show the paused clock. Note that all active SLA clocks on the
Work Order will be paused.

To cancel without pausing the clock, click Cancel.

Resuming the SLA Clock

To resume a paused SLA clock, click Resume. A message appears indicating the amount
of time elapsed since the clock was paused.

Click Yes if you would like to extend the SLA commitment with the elapsed time.

Click No if you would like to keep the SLA commitment as is.

Click Cancel if you do not want to resume the clock.

When you answer Yes or No to the above question, all paused SLA clocks on the Work
Order will be resumed.

Setting the SLA Time Commitments

To set the different SLA time commitments on Work Order(s), scroll down to the Custom
Links section:
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Click the Initial Response Completed link to update the actual response time to
current date and time.

Click the Onsite Response Completed link to update the actual onsite response
time to current date and time.

Click the Service Restored link to update the actual restoration time to current
date and time.

Click the Issue Resolved link to update the actual resolution time to current date
and time.

Dispatching a Work Order
ServiceMax provides multiple methods to dispatch Work Orders. These features allow
your organization to deploy varying levels of sophistication depending upon your organ-
ization’s readiness and automation needs.

Simple Assignment: In this method, dispatch processes can be defined to assign
Work Orders to Technicians when the Work Orders match certain entry criteria.

Dispatch Console: The simple assignment can be extended to assign Work Orders
to dispatchers, who in turn can use the interactive full functional Dispatch Console to
queue, assign, and schedule Work Orders on Technician calendars.

Advanced Assignment: This is meant for organizations that want to use OptiMax,
the advanced dispatching and scheduling engine of ServiceMax. Using this method,
you can define dispatching rules, qualify Technicians by their availability and skills,
define various scheduling constraints such as booking windows, SLA commitments,
and ultimately assign and schedule Work Orders by optimizing Technician travel time
and distance. Please contact your ServiceMax administrator to determine whether
OptiMax has been enabled for your organization.

ServiceMax provides the flexibility to deploy all the above methods in various parts of an
organization.

Dispatch Console

The ServiceMax Dispatch Console displays a list of Work Orders pending dispatch, and
allows dispatchers to find suitable Service Teams and/or Technicians by matching Work
Order criteria with team/Technician attributes. It also shows the Technician's calendar of
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events and allows dispatchers to reorganize or reassign existing events. In addition, dis-
patch console provides the ability to view matching teams and Technicians on an inter-
active map, and a Technician’s daily route on the map. For more information on how to
dispatch a Work Order, see Dispatch Console.

Create an RMA from a Work Order
1. Locate the Case by searching in the sidebar or from a list view in the Work Order tab.
Click the Work Order number from which you want to initiate an RMA.

2. Click Create RMA. The Create RMA screen appears as shown below:

Figure 11: Create RMA Screen

3. Select the owner of the RMA in the Owner ID field by using Lookup. Owner ID is usu-
ally the ServiceMax user who will be processing this RMA upon receipt. By default, it
will be set to your user name.
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4. Select Order Type as applicable.

5. In the From Location section:

Select an address type from Address Type. This automatically populates the
selected address and disables the address field.

If you select a location using Lookup, the address fields are populated auto-
matically. Alternatively, you can enter the address information manually by enter-
ing appropriate values in their respective fields.

6. Select an existing location using Lookup or enter the address in the To Location sec-
tion.

7. In the RMA Lines section:

The product and serial number entered on the Work Order are automatically dis-
played in the first RMA line.

Enter a product and/or serial number using Lookup. When the installed product is
selected, the product is not automatically calculated.

Enter Expected Qty, Expected Condition, and Disposition.

Click the Add button to add more product returns. To delete one or more products
entered, click Delete beside each record.

8. Click Save to save the created RMA for a Work Order.

Given below are the configurable options available for this screen. These settings can be
adjusted by your ServiceMax administrator.

Default address type.

Mapping of fields between Work Order and RMA. This includes your organization’s cus-
tom fields too.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator
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Work Order Estimate Fields

Fields Description

Record Type Always set to Estimate.

Work Order Work Order number. This is a lookup to an existing Work Order in ServiceMax.

Line Type Indicates if this estimate is for Parts, Time, or Expenses.

Product Name of the product estimated to be used in the Work Order. This is a lookup to an
existing Salesforce product record.

Serial Num-
ber

ID of the installed product estimated to be used in the Work Order. This is a lookup
to an existing installed product record in ServiceMax.

Expense
Type

Type of expenses likely to be incurred, if the line type is Expenses.

Estimated
Qty

Quantity of part, time, or expenses to be used. This is context-sensitive. For
example: Quantity for Travel expense might be 500 (miles).

Estimated
Price

The unit price for this estimate item. Total estimate price for the line is calculated
by multiplying estimated price and estimated quantity.

Work
Description

An assessment of work to be performed or additional details about the line type.

Include in
Quote

Indicates if this expense is covered by a warranty/contract, or should be quoted to
customer for approval.

Work Order Request/Receipt Fields

Fields Description

Record Type Always set to Request/Receipt.

Work Order Work Order number. This is a lookup to an existing Work Order in ServiceMax.

Product Name of the product requested. This is a lookup to an existing Salesforce product
record.

Serial Num-
ber

ID of the installed product requested. This is a lookup to an existing installed
product record in ServiceMax.
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Fields Description

Requested
Qty

Number of units of this product required.

Date Reques-
ted

Date when this product is required.

Destination
Location

Location where this product is required. This is a lookup to an existing Salesforce
location record.

Requested
Street

"Street" part of the Destination Location.

Requested
City

"City" part of the Destination Location.

Requested
State

"State/Province" part of the Destination Location.

Requested
Zip

"Zip/Postal code" part of the Destination Location.

Requested
Country

"Country" part of the Destination Location.

Received
Qty

Number of units of this product received so far.

Date
Received

Date when this product was actually received (Last receipt date if multiple receipts
are made).

Received
Location

Location where the product was actually received. This is a lookup to an existing
Salesforce location record.

Received
Street

"Street" part of the received location.

Received
City

"City" part of the received location.

Received
State

"State/Province" part of the received location.

Received
Zip

"Zip/Postal code" part of the received location.

Received
Country

"Country part of the received location.
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Fields Description

Canceled By The Salesforce user who canceled this part request. This is set automatically when
a user cancels a part request.

Canceled On Date/time when this Work Order parts request was canceled. This is set auto-
matically when a user cancels a part request.

Closed By The Salesforce user who closed the Work Order line. This is set automatically
when parts are received.

Closed On Date/time when this Work Order line was closed. This is set automatically when
parts are received.

Line Status Work Order line status.

Posted To
Inventory

Indicates if quantity from this Work Order line has been posted to inventory or not.
This is applicable for Part Requests and Usage/Consumption records in a Work
Order.

Qty Ship-
ment Ini-
tiated

For part requests, quantity for which shipment has been initiated so far.

Qty Shipped For parts requests, actual quantity shipped for the request.

Requested
From

Stock requested from location. Link to an existing location record in ServiceMax.

Work Order Usage/Consumption Fields

Fields Description

Record Type Always set to Usage/Consumption.

Work Order Work Order number. This is a lookup to an existing Work Order in Ser-
viceMax.

Line Type Indicates the type of usage: Parts, Labor, or Expenses.

Activity Type Indicates the type of activity performed. Usually applicable for labor
line types. Your administrator is responsible for configuring this list for
your organization's requirements.

Log Against For internal accounting purposes, indicates if this expense/activity is
tracked at the Service Team level or at the Technician/equipment level.
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Fields Description

Service Team Name of the Service Team if the Log Against is set to Service Team.
This is a lookup to an existing Service Team record in ServiceMax.

Technician/Equipment Name of the Technician or equipment if the Log Against is set to Tech-
nician/Equipment. This is a lookup to an existing Tech-
nician/Equipment record in ServiceMax.

Start Date and Time Start date and time if the Line Type is Labor.

End Date and Time End date and time if the Line Type is Labor.

Expense Type Type of expense incurred if the Line Type is Expenses.

Product Name of the product used/consumed if the Line Type is Parts. This is a
lookup to an existing Salesforce Product record.

Serial Number ID of the installed product used/consumed if the Line Type is Parts.
This is a lookup to an Installed Product record in ServiceMax.

Reference Inform-
ation

Additional information about the work performed, or expense incurred
(mileage for example).

Line Qty Number of units consumed. This is context-sensitive based on Line
Type.

Line Price The unit price for this line item. Total price is calculated by multiplying
line price and line quantity.

Cost Category Type of costing applied to calculate the actual price.

Is Billable Indicates if this usage/consumption is billable to the customer.

Closed By The Salesforce user who closed this Work Order line. This is set auto-
matically when the parts are received.

Closed On Date/time when this Work Order line was closed. This is set auto-
matically when the parts are received.

Consumed From Loca-
tion

Location from where the inventory was consumed. Link to an existing
Location record in ServiceMax. This must be a stockable location.

Line Status Work Order line status.

Posted To Inventory Indicates if quantity from this Work Order line has been posted to
inventory or not. This is applicable for Parts Requests and Usage/Con-
sumption records in ServiceMax.
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Adding Work Details to a Work Order
There are two methods to add work details to a Work Order:

Method 1: Single-Line Entry
1. Locate the Work Order by searching in the sidebar or from a list view in the Work
Orders tab and then click the Work Order number to which you want to add the work
details.

2. Click New from the Work Details related list section.

3. Select the record type.

If you select the record type as Estimate:

Select Line Type. If the Line Type is Parts, enter the name of the product or use the
Lookup icon to search and select the product. Optionally, enter the ID of the
installed product to be shipped or use the Lookup icon to search and select the
installed product.

If you select the record type as Expenses:

Enter the estimated quantity and price. The quantity will have different meaning
based on the line type and expense type selected.

Enter work description or additional information about the estimate line.

For Parts line type, the estimated price is automatically assigned from the price
book in the background after the estimate record is saved. This happens only if
your ServiceMax administrator has enabled automatic calculation of estimated line
prices and also configured a price book for Work Order estimates. If the feature is
not activated or if no price book is configured for Work Order estimates, the price
you entered on the screen is saved.

If you select the record type as Request/Receipt:
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Enter the name of the product or use the lookup to search and select the product.
Optionally, enter the ID of the installed product or use the Lookup icon to search
and select the installed product.

Enter the requested quantity. The quantity will be 1 if you are requesting a specific
serial number.

Enter the date on which the product is requested.

Enter the name of your location, where you want the product to be delivered or use
the lookup to search and select an existing location record. If a location record is
not available, you can create a new location (recommended) or enter the address.

Leave the receipt details section blank. See Creating Shipment Order from
Work Order and Processing Parts Receipt on Work Order below.

If you select the record type as Usage/Consumption:

Select Line Type.

Depending upon the accountability requirements, select the Service Team or
Technician/Equipment in Log Against.

If the usage/consumption is logged against a Service Team, enter the name of the
Service Team or use Lookup to search and select the Service Team.

If the usage/consumption is logged against Technician/equipment, enter the name
of the Service Teammember or use Lookup to search and select the Tech-
nician/equipment.

If the Line Type is Parts, enter the name of the product or use Lookup to search
and select the product. Optionally, you can enter the ID of the installed product
used or use Lookup to search and select the installed product.

If the Line Type is Time, enter the start date/time and end date/time.

If the Line Type is Expenses, select the expense type.

Enter Actual Quantity and price. Quantity is context-sensitive depending upon the
line type you have selected. For example, when you record Time usage, the quant-
ity may be the number of hours.

Enter the work description or additional information about the consumption in the
Reference information field.

4. Click Save.
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Note: A Work Order can have an unlimited number of work details. Repeat the
above steps for each record to be added to the Work Order. You can also click
Save & New after creating a new work detail record.

Method 2: Multi-Line Entry

1. Locate the Work Order by searching in the sidebar or from a list view in the Work
Orders tab and then click the Work Order number to which you want to add the work
details.

2. Depending upon the type of lines you want to create in the work order, click one of the
appropriate wizards:

Estimate Lines to create estimate lines.

Parts Request Lines to create parts request lines.

T&M Lines to enter Usage/Consumption lines.

3. Follow the instructions below to create/edit work order lines:

If you select Estimate Lines, the following screen appears with three tabs: Parts,
Labor, and Expenses.

Figure 12: Estimate Lines
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Modify information in the header section as required.

Click the Parts tab to add/modify/delete parts estimates.

Click the Labor tab to add/modify/delete labor estimates.

Click the Expenses tab to add/modify/delete expense estimates.

To automatically calculate the price of a product, check the Use Price Book
checkbox and click Get Price. Note that the price is calculated only if a valid price-
book is configured for Work Order Estimate Lines. To enter a price manually,
uncheck the Use Price Book checkbox.

Click Save when you have completed all the work detail entries.

If you select Parts Request Lines, the following screen appears with the Parts
Request Lines tab.

Figure 13: Parts Request Lines

Modify information in the header section as required.

Use the detail section to add/modify/delete parts required.

To automatically calculate the price of a product, check the Use Price Book
checkbox and click Get Price. Note that the price is calculated only if a valid price-
book is configured for Work Order Request/Receipt Lines. To enter a price manu-
ally, uncheck the Use Price Book checkbox.

Click Save when you have completed all the work detail entries.
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If you select T&M Lines, the following screen appears with three tabs: Parts, Labor
and Expenses.

Figure 14: T&M Lines

Modify information in the header section as required.

Click the Parts tab to add/modify/delete parts used.

Click the Labor tab to add/modify/delete labor used.

Click the Expenses tab to add/modify/delete expenses incurred.

To automatically calculate the price of a product, check the Use Price Book
checkbox and click Get Price. Note that the price is calculated only if a valid price-
book is configured for Work Order Usage Lines. To enter a price manually, uncheck
the Use Price Book checkbox.

Click Save when you have completed all the work detail entries.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.
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Creating Usage Lines From Estimates

To create Usage Lines:

1. Locate the Work Order by searching in the sidebar or from a list view in Work Orders
tab and click the Work Order number to which you want to add work details.

2. Click Create Usage From Estimate. All estimate lines in the Work Order are copied
as usage lines, and displayed in Edit mode. For more details about this screen, see
Method-2 Multi-line Entry.

Figure 15: Usage Lines From Estimates

Creating Quotations from a Work Order
Once you have entered estimate lines in a Work Order, you can generate a quotation auto-
matically based on the estimates.

To create quotations from a Work Order:

1. Locate the Work Order by searching in the sidebar or from a list view in Work Orders
tab. Click the Work Order number from which you want to generate a quotation.

2. Click Create Advanced Quote. The following screen appears with Account, Contact,
and Work Order information automatically populated from the Work Order. The
screen also has three separate tabs to enter Parts, Labor, and Expense lines in the
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quote.

Figure 16: Service Quote Screen

Change any information on the Service Quote section as needed.

All estimate lines from the Work Details are listed in the Service Quotes Lines sec-
tion in the appropriate tab—Parts, Labor, and Expense.

Click the Parts tab to add/modify/delete parts lines.

Click the Labor tab to add/modify/delete labor lines.

Click the Expenses tab to add/modify/delete expense lines.

Enter the Line Quantity and Unit Price for each line as applicable.

If a discount is applicable for a line, select the discount type—Percent or
Amount. Select Percent if the discount is a percentage of (Quantity * Unit
Price). Select Amount if the discount is a specific amount.

In any of the three tabs, when you enter quantity, price, discount type, or dis-
count, the Line Price and Quote Amount are calculated automatically.

Click Save. The newly created quote appears.
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Note: The mapping of fields between Work Order and Quote, and Work Details
and Quote Line are configurable by your ServiceMax administrator. This
includes your organization’s custom fields too.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Canceling All Parts Requests in a Work Order
When you have neither initiated shipment nor processed receipts for any of the
Request/Receipt lines in a Work Order, you can cancel the Work Order by clicking on
Cancel All Parts Request wizard. When you cancel Work Order Request/Receipt lines,
these lines will not be available for creating a shipment order or for processing receipts
going forward.

To cancel all Work Order request/receipt lines for a Work Order:

1. Locate the Work Order by searching in the sidebar or from a list view in the Work
Order tab and click the Work Order number to which you want to cancel all parts
requests.

2. Make sure the Work Order is Open. Also ensure none of the product in the Work
Order Request/receipt line is initiated for shipment and that no parts have been
received against it.

3. Click the Cancel All Parts Requests wizard at the top.

4. Click OK when prompted. The Work Order screen is refreshed and Work Details and
Work Order Status display.
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Stock Lookup in Work Order
After you create a parts request, you can use the Stock Lookup tool to check availability
of stock in other locations. Once you identify the right location, you can request stock from
the location by copying the location from stock lookup into the Work Order parts request
line.

To Stock Lookup and Request Stock:

1. Locate the Work Order by searching in the sidebar or from a list view in Work Orders
tab. Click the Work Order number in which you want to do Stock Lookup.

2. Click the Line Number in the related list Work Details for the line you want to do
Stock Lookup, Make sure line’s record type is Request/receipt.

3. Click Stock Lookup. A screen appears as shown below:

Figure 17: Stock Location Screen

4. Enter the radius from your location to limit the search to. The Radius is defaulted to
50.

5. Using the Show Results As picklist, you can select to display the results as a grid
(table), in an interactive Google map, or both.
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6. Click Find Stock. Depending on your criteria, the results appear in a grid, map, or
both. Clicking a green/red location will show driving directions on the right side.

Note: The Map shows only valid addresses. Locations with required stock
are indicated in Green, and locations with less than the required stock are
indicated in Red. The grid displays all matching records regardless of
whether it is a valid address or not.

7. To request stock from a location:

On Grid: Click/select the option button in the far right column (titled Request) in
each row in the grid, and then click Request Stock.

On Map: Double-click the highlighted flag icon in the Map.

Click OK if prompted. The Requested From location in the Work Order parts
request screen will now automatically show the location you selected.

Create Shipment Orders from a Work Order

To create a Shipment Order:

1. Locate the Work Order by searching in the sidebar or from a list view in the Work
Order tab. Click the Work Order number from which you want to initiate a shipment
order.
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2. Click Create Shipment Order. The Create Shipment FromWork Order screen
appears as shown in the figure below.

Figure 18: Create Shipment Order Screen

3. Select the owner of the Shipment in the Owner ID field by using Lookup. Owner ID is
usually the ServiceMax user who will be processing this shipment in logistics. By
default, it will be set to your user name.

4. Select Order Type as applicable.

5. In the From Location section, select an address type from Select Address Type.
This automatically populates the selected address and disables the address field. If
you select a location using Lookup, the address fields are populated automatically.
Alternatively, you can enter the address information manually by entering appro-
priate values in their respective fields.

6. Select an existing location using Lookup or enter the address in the To Location sec-
tion.
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7. In the Order Lines section, click Add to add more shipment lines. To delete one or
more products entered, click Delete beside each record.

8. Click Save to save the created shipment order.

Below are the configurable options available for this screen. These settings can be adjus-
ted by your ServiceMax administrator.

Default address type.

Mapping of fields between Work Order and Shipment. This also includes your organ-
ization’s custom fields.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Processing Receipts in a Work Order
When parts are received in the location specified in a Work Order Request/Receipt line,
you should process the receipts to account for the inventory in the receiving location.

Note: In previous releases of ServiceMax, the processing of receipts was
allowed in two modes: Basic and Advanced. Basic mode allowed processing
of part receipts without making inventory updates, whereas Advancedmode
performed stock updates on both shipping and receiving locations. From the
Summer 09' release onwards, only Advancedmode is supported.

To process the receipts for Work Order:

1. Locate the service order by searching in the sidebar or from a list view in the Work
Order tab and then click the Work Order number to which you want to process the
receipts.

2. Make sure the Work Order Status is Open and the destination location is not blank.
Also ensure that the Work Order has at least one product to be received.
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3. Click Process Receipts in theWork Order Actions section, if you want to process
multiple parts at a time. You can also click the parts request line and then click
Receive Parts if you want to receive a specific part. A screen appears as shown
below in which you can enter the actual receipt information. The screen lists all
products in the Work Order that are not yet received. The Received Qty is defaulted
to the pending quantity expected.

Figure 19: Receive Parts Screen

4. When entering the received quantities, one or more of the following scenarios are
applicable:

Receipt Scenario How to Process It

All the products in the Work
Order have been received as
expected.

Click Submit. All the open lines and the Work Order will
be closed automatically.

A product has not been
received now but is expec-
ted to be received at a later
date.

Enter Zero in Received Qty. Make sure the Close Line
checkbox is unchecked. This leaves the line open for a
future receipt.

A product has not been
received and it will not be
received in future at all.

This amounts to the cancellation of an open service Order
Line. Enter Zero in the Received Qty. Make sure the
Close Line checkbox is selected

A product has been received
partially now. The remaining
quantity is expected to be
received at a later date.

Enter the Received Qty. Make sure the Close Line
checkbox is unchecked. This leaves the line open for the
future receipt. If your organization does not permit short-
closing line, this checkbox may be disabled.

A product has been received
partially now. The remaining
quantity will not be received
in future at all.

This indicates short-closure of a Work Order line. Enter
the quantity received. Make sure the Close Line check-
box is checked. If your organization does not permit
short-closing lines, this checkbox may be disabled.
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5. Click Submit to confirm the entries. Alternatively, click Cancel to return to the Work
Order screen.

6. If your organization tracks inventory at the serial number level, the bottom section of
the screen allows you to enter/select serial numbers for serialized products. To enter
serial numbers for a product, check the checkbox against the product in the list. See
Serial Number Selection to learn how serialized tracking of inventory works in Ser-
viceMax.

The Work Order screen refreshes, and the Work Details and Work Order Status dis-
play.

Process Bottlenecks

Process Bottlenecks Fields

Fields Description

Case Number Case number is a lookup to an existing Case record in Salesforce.

Work Order Work Order number. This is a lookup to an existing Work Order in ServiceMax.

Issue area The main area where the bottleneck has arisen. Your system administrator is
responsible for configuring this list for your organization's requirements.

Issue sub-
category

Specific type of bottleneck within the issue area. Your system administrator is
responsible for configuring this list for your organization's requirements.

Start date
and time

Date and time when the waiting/bottleneck started.

End date
and time

Date and time when the waiting/bottleneck ended.

Assigned To Internal ServiceMax user who is the owner of this issue.

Waiting on
Contact

External customer contact for whom this issue is waiting for a resolution.

Parts Order
Reference

Parts Order connected to this issue. This is a lookup to an existing Parts Order in
ServiceMax.

Issue
Description

Detailed description about the issue.
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Adding Process Bottlenecks to a Work Order

To add process bottlenecks:

1. Locate the Work Order by searching in the side bar or from a list view in Work Orders
tab. Click the Work Order number to which you want to add issues affecting timely
completion.

2. In the Process Bottlenecks related list, click New. Work Order number are populated
automatically in the screen.

3. Enter the Case number or use Lookup to search and select the Case record.

4. Select the appropriate issue area and subcategory.

5. Enter start date and time. As a best practice and to enable visibility to management,
it is recommended to log an issue as soon as it is discovered.

6. Leave the end date and time blank until the issue is resolved.

7. If the issue has an internal owner, enter the name of the owner or use Lookup to
search and select the Salesforce user.

8. If the issue is waiting on a customer contact, enter the name of the contact or use
Lookup to search and select the contact record.

9. Enter the Parts Order reference or use Lookup to search and select the Parts Order
record.

10. Enter the detailed issue description.

11. Click Save.

Note: A Work Order can have an unlimited number of process bottlenecks.
Repeat the above steps for each process bottlenecks record to be added to the
Work Order. You can also click Save & New after creating a new process bot-
tlenecks record.
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Editing Process Bottlenecks in a Work Order

To edit an existing process bottleneck:

1. Locate the Work Order by searching in the sidebar or from a list view in the Work
Orders tab and then click the Work Order number in which you want to make the Pro-
cess Bottleneck changes.

2. In the Process Bottleneck related list, click Edit next to the Process Bottleneck record
which you want to edit.

3. Make the necessary changes to the process bottleneck record and then click Save to
save the changes.

Deleting a Process Bottleneck from a Work Order

Unless the Process Bottleneck logged in a Work Order is a test record, it is strongly recom-
mended not to delete existing Process Bottleneck records. These provide valuable insight
on typical process challenges and enable your organization to optimize your business pro-
cesses proactively.

To delete an existing Process Bottleneck record:

1. Locate the Work Order by searching in the sidebar or from a list view in Work Orders
tab and then click the Work Order number in which you want to delete consumption.

2. In the Process Bottlenecks related list, click Del next to the record which you want to
delete and then click OK when prompted for confirmation.

Closing a Work Order
When the service event tracked by a Work Order is complete, you can close the Work
Order. Note that there may be multiple Work Orders originating from the same support
Case for driving parallel service events. Even if you close one or all Work Orders of a Case,
your support organization is responsible for closing the original Case manually. Before clos-
ing a Work Order, make sure you have entered information in the Closure section of a
Work Order Detail page. The information entered here is used in generating a service
report as well as analytics on service organization performance.
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To close a Work Order:

1. Locate the Work Order by searching in the sidebar or from a list view in the Work
Orders tab and then click the Work Order number which you want to close.

2. Click Close Work Order. The Work Order closure screen appears as shown below:

Figure 20:Work Order Closure Screen

3. Enter diagnostics and other analytical information that will be useful for building a
sound troubleshooting knowledge-base for your organization.

4. Click Close Work Order. The Work Order is closed automatically.

Printing a Service Report from Closure Information

To print a service report from closure information using a formal

document template:

1. Click the Service Reports wizard on the Work Order page.

2. In the screen that appears, select a template from the list. These templates are
defined and managed by your ServiceMax administrator.

3. Select the output format. PDF, Excel, andWord formats are supported. This gen-
erates the Service Report in the selected format.
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Posting Usage/Consumption to Inventory
After you have created consumption lines associated with a Work Order, you should post
the consumption to inventory to maintain the stock accountability in the inventory.

To post all Work Order Usage/Consumption lines for a Work Order

to Inventory:

1. Locate the Work Order by searching in the sidebar or from a list view in Work Orders
tab and then click the Work Order number in which you want to post consumption to
inventory.

2. Make sure the Work Order Status is Open.

3. Click the Post Usage To Inventory wizard in the Work Order section. A screen sim-
ilar to the following appears:

Figure 21: Post to Inventory Screen

4. Click Submit to confirm the entries. Alternatively, click Cancel to return to the Work
Order screen.

5. If your organization tracks inventory at the serial number level, the bottom section of
the screen allows you to enter/select serial numbers for serialized products. To enter
serial numbers for a product, check the checkbox against the product in the list. See
Serial Number Selection to learn how serialized tracking of inventory works in Ser-
viceMax.

The Work Order screen refreshes and Work Order Usage/Consumption Line Status dis-
plays.

Work Order
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Creating a Proforma Invoice

To generate a Proforma invoice:

In the Work Order Detail area, click the Generate Invoice WO button in the Wizard tool-
bar.

Figure 22: Generate Proforma Invoice

The Proforma Invoice Details and Invoice Lines display in the appropriate areas (see figure
below).

Figure 23: Proforma Invoice Details and Lines

If you click the Generate Proforma Invoice button and the invoice is not generated, an
inactive error message appears (see figure below). Notify your administrator to activate
the Proforma Invoice process.

Figure 24: Proforma Invoice Process is Inactive Message
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Canceling a Proforma Invoice

To cancel a Proforma invoice:

In the Work Order Detail area, click the Cancel Proforma Invoice button in the Wizard
toolbar (see figure below).

Figure 25: Cancel Proforma Invoice

When you cancel a Proforma invoice, this updates the source document(s) (work order or
service contract) and releases them for re-invoicing.

See Also:

Account

Contact

Location

Product

Installed Product

Service Team

Service/Maintenance Contract

Service Quotes

Booking Windows

Warranty Terms

Work Order - Standard Settings

Work Order
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SERVICE QUOTE

Overview
In ServiceMax, Service Quote contains the estimated cost of a service event to be presen-
ted to a customer to get approval. A Service Quote can either be created manually or gen-
erated automatically from the estimate lines of a Work Order.

Access and Permissions

Actions User Permissions Needed

To view the Service Quotes
tab:

"Read" on Service Quote and Quote Item

To view Service Quotes: "Read" on Service Quote, Work Order, Account, Contact, Product
and Quote Item

To create or clone Service
Quotes:

"Create" on Service Quote and Quote Item

"Read" on Work Order, Account, Contact and Product

To change Service Quotes: "Edit" on Service Quotes and Quote Item

"Read" on Work Order, Account, Contact, and Product

To delete Service Quotes: "Delete" on Service Quotes and Quote Item

To create Quote Items: "Create" on Quote Item

"Read" on Product

To change Quote Items: "Edit" on Quote Item

"Read" on Product

To delete Quote Items: "Delete" on Quote Item

Click the Service Quotes tab to view the service quotes home page.
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Caution: Remember that when deleting service quotes you will not be warned,
if the service quote is used in a related record. Since service quotes are con-
nected to Work Orders, review and make sure the service quote record is not
used in any related records.

Service Quotes Fields

Fields Description

Quote Num-
ber

Number of the Service Quote - Generated automatically.

Work
Order

Work Order number for which this Service Quote is created. This is a lookup to an
existing Work Order record in ServiceMax.

Account Customer account for whom the Service Quote is prepared. This is a lookup to an
existing Salesforce Account record.

Contact Customer contact for which the Service Quote is prepared. This is a lookup to an
existing Salesforce Contact record.

Status Current status of the Service Quote.

Valid
Until

Date until which the Service Quote is valid.

Revised
From

The original Service Quote number from which this Service Quote was revised. This
is a lookup to an existing Service Quote in ServiceMax.

Quote
Amount

Total amount of the Service Quote after discount.

Total
Line
Price

Sum of Line Price for all the lines.

Discount
Type

Indicates if the discount is entered as an amount or percentage of total price.

Discount To capture discount percentage or amount based on selected Discount Type.

Service Quote

890 Service Quotes Fields



Service Quote

Quote Item Fields

Fields Description

Service
Quote

Name of the Service Quote. This is a lookup to an existing Service Quote in Ser-
viceMax.

Line Type Indicates if the line refers to a Part, Labor or Expense estimate.

Line Descrip-
tion

Detailed description of the quote item.

Product Name of the product if line type is Parts.

Qty Number of units. This depends upon the line type.

Unit Price Price per unit of the line. Product cost if it is a Parts line, hourly charges if it is
Labor, and so on.

Discount Discount (amount or percentage) for the line.

Line Price Final line price after applying discount.

Discount Discount (amount or percentage) for the line.

Discount
Type

Select the Discount Type.

Work Details Service Order estimates line record from which this quote line was derived. Not
displayed on the screen.

Adding Items to a Quote
Locate the Service Quote by searching in the sidebar or from a list view in Service Quotes
tab and then click the Service Quote number to which you want to add lines.

There are two methods available to add lines to a Quote:

Method 1: Single-line Entry

1. To create a new line, in the related list Quote Lines, click New. Alternatively, to edit
an existing line, in the related list Quote Items, click Edit next to the Quote item
record.

2. Select Line Type. If the line type is Parts, enter the name of the product or use the
Lookup icon to search and select the product.
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3. Enter the quantity, unit price, discount, and line price. The quantity will have a dif-
ferent meaning based on the line type and expense type selected.

4. Enter a detailed description of the line in Line Description.

5. Click Save.

Method 2: Multi-line Entry

1. Click Create/Edit Quote Lines to display the following screen:

Figure 1: Service Quotes Edit Screen

2. Change any information in the Service Quote section as needed.

3. Click the Parts tab to add/modify/delete parts lines.

4. Click the Labor tab to add/modify/delete labor lines.

5. Click the Expenses tab to add/modify/delete expense lines.

6. Enter the Line Quantity and Unit Price for each line as applicable.

7. If a discount is applicable for a line, select the discount type—Percent or Amount.
Select Percent if the discount is a percentage of (Quantity * Unit Price). Select
Amount if the discount is a specific amount.

Service Quote
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8. In any of the three tabs, when you enter quantity, price, discount type, or discount,
the Line Price and Quote Amount are calculated automatically.

9. Click Save & Close to save the changes and return to the quote view screen. To
save the quote and continue editing, click Quick Save.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator

See Also:

Account

Contacts

Product

Work Order
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DISPATCH CONSOLE

Overview
The Dispatch Console is a powerful tool in the ServiceMax application that helps Service
Teams and dispatchers identify open Work Orders, locate the most suitable Technicians
and equipment, interactively analyze their availability and work load, and schedule Work
Orders on their calendars.

Dispatch Console is used by call center/dispatch organizations responsible for routing
Work Orders to various Service Teams. In some organizations, dispatchers are respons-
ible for identifying a Service Team only. In such cases, the Service Teamman-
agers/leaders will use the Dispatch Console to view the Work Orders queued to their team
and assign/schedule it to their teammembers.

Service management can measure, analyze, and optimize the performance of service
scheduling using the powerful dashboard and reports in-built with the Dispatch Console
module. See Dashboards and Reports for a complete list of reports available with the
Dispatch Console module.

Prerequisites

Prerequisite to Launch the Dispatch Console

In order for end users to launch the Dispatch Console window, the administrator must
check the API Enabled checkbox at the Profile level. If the API Enabled checkbox is not
checked, then upon launch of the Dispatch Console window, the following error message
displays, and then Dispatch Console window closes.

Error Message: Salesforce session is invalid. Dispatch Console will close now.

Prerequisite for Dispatchers to Edit/Delete Events for a Technician

To Edit/Delete Events for the Technician, Dispatchers must have full access to calendars
of Salesforce users associated with the Technician. To grant full access to a Dispatcher,
Salesforce users must share their calendar using the Sharing option Full Access.
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To grant full access to a Dispatcher:

1. Navigate to Your Name > Setup > My Personal Information > Calendar Shar-
ing.

2. Click Add to share your calendar with others.

3. Use the arrows to add or remove users, roles, or groups to your calendar.

4. Select the Dispatcher users.

5. In Calendar Access, specify the share option Full Access.

If a Salesforce user's calendar is not shared with a Dispatcher, the following error message
is generated for Edit/Delete Events for the respective Technician:

An error occurred while saving the event. Click on the icon for more details.

SVMXC.DCON_Event_WS.SVMXException: insufficient access rights on object id

(SVMXC)

External entry point

Note: If the Dispatcher is a System Administrator, calendar sharing by other
Salesforce users is not required for Editing/Deleting Events for the respective
technicians.

Access and Permissions

Object Name User Permissions Needed

Work Order Read, Write

Event Read, Write

ServiceMax Event Read, Write

Service Team Read

Technician/Equipment Read

Territory Read

Dispatch Console
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Object Name User Permissions Needed

Product Read

Installed Product Read

ServiceMax Processes Read

ServiceMax Config Data Read

Click the Dispatch Console link in the left navigational pane of the Home page to display
the Dispatch Console home page as shown in the figure below. Contact your administrator,
if you are unable to find this link on your home page.

Figure 1: Dispatch Console Link

Configuration Settings
The functionality and user experience of the Dispatch Console is driven by two types of
configuration settings that are managed in different ways:
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Functionality Settings: These are settings that influence the behavior of Dispatch
Console as listed below. These settings are managed by your ServiceMax admin-
istrator using the ServiceMax Setup screens.

Default number of days to show in calendar.

Default duration for a new event.

Default radius in the map.

Whether to perform a keyword search automatically when a Work Order is selec-
ted in the list.

Whether a Work Order should be selected automatically when there is only one
Work Order in a view.

Default type of tree view (Service Team or Territory).

Default dispatch status to be used to filter Work Order list (All,New, Assigned,
Queued).

Whether the Work Order list should be refreshed automatically when the assign-
ment status of a Work Order changes.

Number of minutes to round-off the start time of a new event. For example, if set
to 10, when you drop a Work Order at 8:07am, the start time will be 8:10am.

Whether a Work Order’s owner should be changed when queuing or assigning.

Whether past events should be deleted during reassignment of Work Orders.

Whether to enforce the integrity of event duration and Work Order times (service
time, idle time, and drive time).

How to treat events that start outside a Technician’s working hours. Show a warn-
ing, disallow or allow.

Whether the unassignment of a Work Order should release the dispatch lock on
the Work Order.

API name of up to 10 Work order/Event fields to be displayed in Dispatch Console
Screen.

URL to the image displayed as icon for Work Order in Dispatch Console Map.

URL to the image displayed as icon for Service Team in Dispatch Console Map.

Dispatch Console
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URL to the image displayed as icon for Technician in Dispatch Console Map.

Allowing the deployment of settings to other dispatchers.

Auto-refresh of Work Order List on saving Work Order Events.

Default event start time for Multi Assign of Work Order.

Auto-refresh Work Order List on deleting Work Order Events.

The option to apply Event Subject Rule to Multi Assign.

User Interface Settings: These user-based configurations, listed below, are saved
for and by the Dispatch Console users. These settings can be saved from within the
Dispatch Console itself.

List of columns displayed on the Work Order list.

List of columns displayed on the Technician calendar.

Auto-refresh of the Work Order list and calendar.

Color coding rules for the Work Order list.

Color coding rules for events.

Default Zoom level in map.

Default latitude/longitude to display on map.

Keyword search preferences (Work Order, Service Team and Technician fields
used for search).

Auto-refresh of calendar.

Default range of dates in calendar.

Unit of measure for Service Duration Travel Time.

Unit of measure to plot Maps.

Service Teams and Members
In order to use the Dispatch Console effectively, it is extremely important to define your
entire service organization in ServiceMax as Service Teams and members. Since Dispatch
Console supports scheduling Work Orders to equipment, you can also define groups of
equipment (tools and machinery) that have scheduling requirements in your service
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delivery. The more granular and thorough your team definitions are the more efficient and
effective your dispatchers can be.

When defining a team of Technicians, identify all the teammembers (your employees and
third party), areas of expertise, products they specialize in servicing, as well as Tech-
nicians’ current home bases. Make sure the contact information such as telephone number
and email, as well as the default address is entered for every Technician and equipment.
Technicians that are direct service providers (not third party Technicians) must have a
valid Salesforce User associated with them.

Setting Up Equipment
To enable scheduling of equipment through Dispatch Console, create one or more Service
Teams with Record Type as Equipment. Add all equipment as Service Teammembers.
Make sure the name of the equipment identifies the machinery/tool uniquely. A recom-
mended practice is to use an asset tag or serial number along with the name/type of the
equipment. To track the equipment calendar, make sure the record is not linked to a Sales-
force user and the Enable Scheduling checkbox is checked.

Setting Up Third-Party Technicians
Dispatch Console can be used to assign and schedule Work Orders to third-party Tech-
nicians as well. You can create one or more Service Teams with record type Technician
and add teammembers. Besides entering all the member information such as telephone
number, address, email, expertise, and so on, the Enable Scheduling checkbox should
be checked on the Technician/equipment page layout. Also make sure the third-party Tech-
nicians are not linked to a Salesforce user.

Note: Starting with ServiceMax 3 release, ServiceMax does not use Sales-
force public calendars to manage calendars of third-party Technicians and
equipment. Existing events from public calendars are not automatically trans-
ferred to the new model when upgrading to ServiceMax 3 release. Please con-
tact your ServiceMax administrator for more information regarding this.
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Technician/Equipment Availability
Dispatch Console provides valuable information to users by calculating a Tech-
nician/equipment’s availability in any given period. To do this, it relies on the gen-
eral/specific availability defined for each Technician/equipment. Availability can be defined
specifically for every day of the week, or generally for weekdays and weekends. To max-
imize your benefits from Dispatch Console, it is strongly recommended that availability of
your Service Teammembers is thoroughly configured in ServiceMax. See the Service
Team section for details about how to define Service Teammembers.

Terminology
The translation capabilities of Salesforce combined with the flexible design of Dispatch Con-
sole allow your organization to fully customize the terminology used on the application.
This document uses the standard out-of-the-box ServiceMax terms such as Work Orders,
Service Teams, and Technicians, and so on. Please contact your ServiceMax administrator
if you find that the terminology used in this document does not match the Dispatch Con-
sole in your organization.

Launching Dispatch Console
The Dispatch Console can be launched from two locations in ServiceMax as given below.
The initial behavior and display of Dispatch Console varies slightly based on where it was
launched from. See Search Work Orders to learn about the differences.

Home Page Link

If enabled by your ServiceMax administrator for your profile, Dispatch Console can be
launched from the home page link Dispatch Console. Please contact your admin-
istrator if you are unable to find this link on your home page.

Work Order Page Layout

Your administrator can also enable Dispatch Console to be launched from the Work
Order page layout. If your organization has multiple Work Order page layouts based
on various responsibilities, Dispatch Console may or may not be enabled for some of
the profiles. Please contact your administrator if you do not see the wizard on your
Work Order page layout.
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Dispatch Console Screen

The Dispatch Console consists of three sections:

Work Orders: In this section, you can view the Work Orders assigned to you or any
Salesforce Queue to which you have access. You can easily configure the columns
you wish to view in the Work Order list. You can select one of the resulting Work
Orders for dispatch.

Tree view and Calendar: This section displays the list of Service Teams and Ter-
ritories to which you have been designated as dispatcher. This information is presen-
ted in a hierarchical tree view. You can switch between Territory tree view and
Service Team tree view. For each Technician in a Service Team or Territory, this sec-
tion shows the detailed calendar view of events for a given period. You can use this
section to pick one or more resources to schedule the Work Order.

Map: Using this section, Service Teams or Technicians returned by a search are plot-
ted on the map as long as they are within the given radius. In addition, this section
can be used to find a Technician’s daily route on any given day.

Dispatch Console
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A sample Dispatch Console screen is shown below.

Figure 2: Dispatch Console Screen

Note: Some of the functionality described in this section may have been dis-
abled for your organization or your specific ServiceMax user profile. It could be
because the feature is either not available in your geography or it has been dis-
abled by your administrator. Please contact your ServiceMax administrator if
you are unable to locate/use any feature described below.
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Dispatch Process

The following picture depicts the dispatch process in ServiceMax Dispatch Console.

Figure 3: Dispatch Process

As shown in Figure 3, after a Work Order is created, there are up to three stages in reach-
ing it to a Technician.

1. Initially the Work Order is in a general queue or yet-to-be-dispatched state. At this
stage, the Work Order can be queued to a Service Team.

2. The Work Order can be assigned to a Technician.

3. The Work Order is scheduled on the Technician’s (and optionally equipment) cal-
endar.

However, the three stages are not mandatory. If a Work Order is assigned to a Technician
directly, it implies that the Work Order belongs to the Technician’s Service Team queue.
Similarly, if the Work Order is scheduled to a Technician, it implies queuing and assign-
ment.

The dotted lines in the above diagram indicate the reversal of scheduling, assignment and
queuing of the Work Order. Whenever a Work Order is unassigned, it is moved back to the
general queue.

Dispatch Console
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How Dispatch Console Works

Work Order List

Activity in Dispatch Console starts with the selection of Work Orders from the list dis-
played in the top section. The default display of Dispatch Console is driven by a com-
bination of your Salesforce user profile and whether you are linked to an existing Service
Team as a Technician. The Work Order section shows:

Work Orders assigned to the end user indicated by the view name My Work Orders.

Work Orders assigned to Salesforce queues to which the end user has access. The
queue names are displayed in the list of views.

If the Dispatch Console is launched from an existing Work Order, the Work Order
number is added to the list of views.

You can switch between various views simply by selecting the view name from the list.
You can filter the Work Order list by the current dispatch status of Work Orders. To do so,
click Status and then:

Select New to view Work Orders that are not queued or assigned to any Service
Team or Technician yet.

Select Queued to view Work Orders that are assigned to a Service Team but not to a
Technician.

Select Assigned to view Work Orders that are assigned to a Technician.

Select All to view all Work Orders in the selected view.

You can filter the Work Order list based on data displayed in the list. To do this, select the
field name in the Filter By picklist and then enter any text in the adjacent text box. The
Work Order list will be filtered as you type. To undo the filter, clear the text you entered.

Configuring the Work Order List

The work order list has many configuration options.
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To configure the columns to be displayed and the orders of their

display:

1. Click Configure on the top-right of the Work Order section. The popup window shows
all fields in the Work Order including standard ServiceMax fields and any custom fields
created in your implementation of ServiceMax.

2. Select one or more columns from left and then move to right. You can also use the up
or down arrows to set the order of display.

To refresh the Work Order list automatically:

1. Click Configure on the top-right of the Work Order section.

2. In the Configure Work Order View dialog box, check the Automatically Refresh
List checkbox. The frequency field is enabled and displayed.

3. Enter the desired frequency in minutes. A sample configuration screen is shown in the
figure below.

Figure 4: Configure Work Order Screen

To apply conditional colors on the work order list and also con-

figure the colors when work order rows are selected:

1. Click Configure Colors adjacent to the Filter text box. In the Rules tab of the Con-
figure Coloring of Work Order Grid dialog box, all the existing coloring rules are

Dispatch Console

906 How Dispatch Console Works



Dispatch Console

displayed as a list.

Figure 5: Configure Coloring Screen

2. Click New to create a new coloring rule. Alternatively, click Edit to edit the existing
coloring rule.

3. In the New coloring or Edit coloring mode:

a. Enter a valid rule name. For example, "Critical Work Orders."

b. Define the criteria by using the Advanced Expression builder. For example, "Pri-
ority Equals Critical."

c. Use the + or - buttons to add or delete conditions in the Advanced Expression
builder. All conditions must be met to apply a coloring rule.

d. If required, use the Advanced Expression field to enter conditions such as (1 AND
2) OR 3.

e. Click the Paint it with color box to display the color palette, and then select a
color.

f. Ensure the Active checkbox is checked.

g. Click Apply. Your color coding rules are applied immediately on your Work Order
list. You can also delete a coloring rule by clicking the rule record and then clicking
Delete.
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4. To set up work order row selection colors, select the Highlight tab of the Configure
Coloring of Work Order Grid dialog box as shown in the figure below.

Figure 6: Configure Highlight Work Order Screen

5. Select the Hover color. When you mouse-over a work order record, the row will be
highlighted in a box of the Hover Color.

6. Select the Selection color. When you select a work order record, the row will be high-
lighted in a box of the Selection Color.

Search Criteria

After you select a Work Order, you can search Service Team or Technician to
assign the Work Order.

You can configure one or more Work Order fields as the source of keyword search.

When finding teams or technicians based on the keywords, you can configure which
team or technician fields the search should be applied against.

To configure the keyword search:

1. Click the Configure Search icon located at the top right corner of the Work
Order section. The Search Configuration dialog box appears. See figure below.
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Figure 7: Search Configuration Dialog Box (Service Team)

The Search Configuration dialog box has three tabs for search configuration:
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TheWork Order tab shows all the Work Order fields. This includes standard Ser-
viceMax fields and any custom fields added to Work Order screen for your Ser-
viceMax implementation. Select the applicable fields from the left and move to the
right. Subsequent to this configuration, when you click a Work Order from the list,
information from the selected fields is automatically displayed as keywords for
search.

The Service Team tab shows all the Service Team fields. This includes standard
ServiceMax fields and any custom fields added to the Service Team screen for your
ServiceMax implementation. Select the fields against which you wish to apply the
keyword search. In addition, indicate if a match should be found for all the
keywords or any keyword. Fields selected here will be used when you click Find Ser-
vice Teams for a Work Order.

The Technician tab shows all the Technician fields. This includes standard Ser-
viceMax fields and any custom fields added to the Technician screen for your Ser-
viceMax implementation. Select the fields against which you wish to apply the
keyword search. In addition, indicate if a match should be found for all the
keywords or any keyword. Fields selected here will be used when you click Find
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Technicians for a Work Order.

Figure 8: Search Configuration (Technician Team)

2. Click Save to save your settings for the duration of the session.

3. Save your user interface settings permanently by clicking the Save button in the Set-
tings area located below the Map view located at the bottom right corner of the Dis-
patch Console. You can also click the Default button to restore the default settings.

Logging

To configure log settings:

1. Click the ServiceMax logo located at the bottom left corner of the Dispatch Console to
display the log settings menu. See figure below.
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Figure 9: Log Settings Menu

2. Select Configure Logging from the log settings menu to configure the level of log-
ging required. The Configure Logging dialog box appears. Enabling logging helps your
administrator to troubleshooting potential issues.

Figure 10: Configure Logging Dialog Box

3. Select the level of logging required. The default recommended level of logging is
FATAL. This ensures that critical errors are automatically logged for troubleshooting
later.

4. Close the Configure Logging dialog box. A message appears indicating that your log-
ging preferences are saved only for the duration of your sessions. See image below.

Figure 11: Message Area

5. As shown in the figure below, you can save the logging settings permanently by click-
ing the Save button in the Settings area located below the Map view at the bottom
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right corner of the Dispatch Console. You can also click the Reset button to restore
the default settings.

Figure 12: Settings Area

6. To view log information for a session, click the ServiceMax icon located at the bottom
left corner on the Dispatch Console screen and select either View current log or
View previous log (see Figure 9). The Log Information dialog box appears. Sample
log information is shown in the figure below. To facilitate troubleshooting, you can
copy the log information to your clipboard and send it to your ServiceMax admin-
istrator.

Figure 13: Log Information Dialog Box

Work Order Actions

You can sort the Work Order results by clicking on the column headers. Clicking the same
column again will sort it in the reverse order. For example, to sort the result set based on
dispatch status, click the highlighted column name Dispatch Status.
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When you click a Work Order record, the keyword field is automatically populated on your
search configuration. You can overwrite the keywords by entering a list of keywords sep-
arated by commas manually, as well.

Figure 14: Keywords Separated by Commas

To find Service Teams for the Work Order, click Find Service Teams adjacent to the
keywords list.

To find Technicians for the Work Order, click Find Technicians adjacent to the keywords
list.

When you move the mouse over the Work Order number of any record, an arrow is dis-
played as shown below. Click the arrow and select one of the options from the Work Order
actions menu.

Figure 15:Work Order Actions Menu

Click Show Record to see the Work Order record in Salesforce. Note that each Show
Record click opens the record in a new browser window. These windows are not closed
when you close the Dispatch Console.

Click Unassign to remove the current assignment (Service Team or Technician) for the
Work Order. When prompted, click Yes to confirm.
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Click Assign to Multiple to schedule the Work Order to multiple Technicians sim-
ultaneously. A popup window appears as shown below:

Figure 16: Multiple Assignment Dialog Box

In the above screen:

Click any Technician from the tree view in the above screen to add the Technician to
the assignment list. Alternatively, click the remove button to remove the Technician
from the list.

At least one and only one of the Technicians can be a primary assignee for the Work
Order. Use the Owner radio button to designate the Technician as the primary Tech-
nician.

Click Assign to assign the Work Order. An event will be added to the calendar for all
the selected Technicians. The primary Technician will be marked as Owner.

Tree and Calendar View

When Dispatch Console is launched, a list of Technicians is displayed in a hierarchical tree
view. There are two options for the tree view: Service Team tree or Territory tree.
Only Service Teams and Territories for which you are designated as a Dispatcher appear.
For more information regarding designating dispatchers, see Service Team Management
Console and Territory Management Console.
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Figure 17: Technician Screen

In addition to the Territory/team hierarchy, the calendar of events for each Technician for
the default date range is displayed in the calendar section.

You can also type dates directly into the Gantt Chart Date field. For example,
10/25/2011 to 10/29/2011 as shown in the figure above. You must click Refresh for the
dates to display. (No set up is required for this feature).

Overlapping events display with the shortest event on top as shown in the figure below.

Figure 18: Overlapping Events
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You can switch between the Territory tree or Service Team tree by selecting the view
type.

Use the Collapse or Expand buttons to collapse or expand the tree view
respectively. The tree is in Expandedmode by default.

Use the Zoom Out or Zoom In buttons to increase or decrease the zoom level
of the calendar respectively.

To refresh the events view, clickRefresh.

When a filter is currently applied on the technician view, the Reset button is high-
lighted in yellow   indicating that you must reset the view to see the entire list of
technicians. Clicking on the Reset button will show all technicians that were dis-
played when Dispatch Console was launched. It will also restore the reset button to

its original state .

To set your time zones in which you want the events to be displayed, click Select
Time Zone button. In the popup window (as shown below), click the applicable
country and then click OK.

Figure 19: Select Time Zone Screen

Note: The time zone selected here is not connected to your Salesforce
time zone. All events displayed or created in dispatch console are con-
sidered to be in the time zone selected using this window.
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To delete an existing event in the calendar, click the event and then click the Delete

Event button. When prompted, click Yes to confirm.

To create a new event, click the Add Event button. Events created this way are
not related to a Work Order.

To edit an existing event, double-click the event in the calendar. The following dialog
box appears in Create and Edit modes for events that are not linked to a Work Order.

Figure 20: New Event Screen

In the above screen:

Enter Subject, Description, Start Date, End Date, and Location.

Click Save. The event is saved and the calendar is refreshed.

Note: You can also type dates directly in the Gantt Chart Date fields.
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Click the   at the top, the right side of the Create/Edit event screen shows cus-
tom fields fromWork Order and Event. Up to 10 fields fromWork Order and/or
Event can be configured by your administrator for this screen. For more details,
see Configure DC Field Updates.

Figure 21: Edit Events Screen

How Dispatch Console Works 919



To keep the window in expanded mode, click the pin button available at the top.

 To hide the customWork Order/Event fields, click .

If the event is linked to a Work Order, the following popup window is displayed.

In the New Event screen:

Click any Technician from the tree view for the Assigned To field.

If event subject rules are configured for the Work Order, the Subject field is auto-
matically populated from the relevant fields on Work Order. Please contact your
ServiceMax administrator to learn more about how to utilize the Event Subject
rules.

Enter Subject, Description, Start Date, End Date, and Location.

Enter Drive time, Idle time, and Service time as applicable.

To automatically calculate end time, click the (Auto-populate) button adjacent
to End Date field. The end date is calculated as (Start Date) + (Service time +
Drive time + Idle time).

To automatically calculate service time based on start date and end date, click the
(Auto-populate) button in the Duration section.

To set the 3 duration fields to zero, click the (Reset) button.

To restore the 3 duration fields to their original values from the Work Order, click

the (Restore) button.

To remove all existing assignments of the Work Order, if any, before assigning the
Work Order to the new Technician, check the checkbox.

If the event start time is outside the Technician’s working hours, an error message
will be displayed and a Save button will be disabled. This happens only if your
administrator has enabled this enforcement.

The service duration and drive time can also be displayed in hours and minutes.
See figure below. This feature is controlled by Group-wide Configuration Set-
tings.
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Click Save. The event is saved and the calendar is refreshed.

Figure 22: Edit Events Screen (duration time in hours andminutes)

Extended Event Edit Window

You can view and edit events that overlap on the Gantt chart in the Dispatch Console. To
access this feature, hover over the block of events in the Gantt chart to display the pop up
window for the event. From the popup window, click the arrow on the right corner of the
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window. See figure below.

Figure 23: Hover Over Events on Gantt Chart
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The Extended Edit Event Window displays all events, including the overlapping events for
a technician for a given day.

Figure 24: Extended Event Edit Window - Technician Day View

From the above dialog box, you can:

Hover over an event to display event details.

Double-click an event to edit the event.

Zoom in or zoom out using the icons located on the upper left corner of the dialog
box.

Events that span across multiple days appear in the top area of the Extended Event win-
dow. A black arrow icon displays in the corner of the event area indicating that the event
continues.
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For example, in the figure below, the Training event begins at 9:00 A.M. on January 2nd
and ends at 5:30 P.M. on January 3rd.

Figure 25: Extended Event Edit Window -Multi Day Events

Configure Technician View

You can configure fields displayed against each Technician and also how the events are
colored in the calendar. To configure this, click Configure at the top-right of the Tech-
nicians section. The Configure technician View appears.
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To configure columns displayed in the Technician list:

1. Click the Columns tab.

Figure 26: Columns Tab

2. Select the applicable fields from the left and then move it to the right. Member Name
must always remain selected and cannot be unselected.

3. Use the Up or Down arrows to manage the display order fields.
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To configure colors and other attributes of calendar events:

1. Click the Calendar tab.

Figure 27: Calendar Color Tab

2. You can designate a color for calendar events based on the subject type. You can
select a color for the five standard subject titles supported by Salesforce as well as
Work Orders. The Default color is used for any subject that does not match the stand-
ard subject names.

3. To view the events details for certain days before or after the current date, enter the
number of days in Default start date to field and then select before or after appro-
priately in the picklist next to the field.

4. To refresh the calendar automatically when start date or end date is selected, check
the checkbox Refresh calendar automatically when dates are changed.
Though this feature provides increased flexibility, it may impact the performance.

5. When viewing daily routes of Technicians, to retain the current date on the map even
while switching between Technicians, check the checkbox Leave the date
unchanged on map when Technician selection changes. If this is cleared, date
on the map will be reset to start date when you switch between Technicians.

6. When you change the start date or time in an event, the end date can also be auto-
matically updated with a similar change. For example, if the start time is 3:00 and the
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end time is 4:00,and you change start time to 3:30 using the spin buttons,the end
time can automatically adjust itself to 4:30. To achieve this effect, check the check-
box Automatically change end time when start time is changed.

7. During work order assignment, you can configure the color used to highlight the selec-
ted technician record. Use the color palette in Color To Highlight Technician
Record.

8. There are two configuration options to control when event hover is displayed. To dis-
play the hover on mouse-over, select the time delay in milliseconds (1 second is 1000
milliseconds). To display the hover on mouse-click, select the setting Show the
hover information only on clicking the event.

9. In the hover information, click at the top right to view the work order record. The
standard Salesforce record view as configured by your administrator appears. To

close the hover information, click .

10. Click Apply to save and apply your changes.

You can rearrange any existing event on the calendar horizontally (for the same Tech-
nician) or vertically (across Technicians) by simply dragging the event and dropping it at a
desired location. When you drag and drop an event, click Yes when prompted for con-
firmation to finalize the change.

To schedule a Work Order to a Technician on the tree, drag the Work Order from the Work
Order list and drop it at any desired location on the calendar. When the dragged record is
hovered over the Technician’s calendar, date and time for the new event will be shown as
pop-up text. The New Event window appears as shown above. Note that nothing happens
when you drop a Work Order on a Territory or Service Team. You can drop the Work Order
only on Technicians.

When you move the mouse over the Technician name on any record in the tree, an arrow
is displayed as shown below. Click the arrow and select one of the options from the Tech-
nician Actions menu, either Show Route or View Record.

Figure 28: Technician Action Menu
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In the Technician Actions menu:

Click Show Record to see the Technician record in Salesforce. Each record view
opens a new browser window. These windows are not automatically closed when you
close Dispatch Console.

Click Show Route to view the Technician’s route on the start date entered in the
events view.

All Work Orders assigned to the Technician on each day, if available, are displayed.

The map also shows the driving route starting from the Technician’s address to
each Work Order in the order of assignment and back to the Technician’s address.

To view Technician’s route on the next or previous day, click the corresponding but-
tons in the map section.

Configure Colors and Other Attributes for Events

You can click the Events tab to configure coloring rules and other attributes. See figure
below.

For event coloring coding rules, an Event field will be listed only if it exists with the same
API name and is of the exact same type in both SVMXC__SVMX_Event__c object and Sales-
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force Event object.

Figure 29: Configure Technician View Dialog Box

The Event tab in the Configure Technician View dialog box includes three sections: the
Rule list (which includes Rule Name, Status, and buttons to manage the rules), the Rule
Expression builder area, and default event colors (Driving,Work Order, Default).

All the defined rules are listed under Rule Name. You can create a new rule, edit an exist-
ing rule, or delete a rule by selecting one of the defined rules and clicking the appropriate
button located below the Rule list.

The Rule Expression builder area includes the Rule Name text box, Rule Expression(s),
and the Paint it with color box. The Rule Expression builder area contains three parts:
the Field Name picklist, the Operator picklist, and the Value text box. The Field
Name picklist lists all work order and event fields. The Event fields (located in the Field
Name picklist) are prefixed with the word “Event.”

The default colors for Driving,Work Orders, and Default do not match any rules.
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To create an event coloring rule:

1. In the Configure Technician View dialog box, click the Events tab. See figure
below.

2. Click the New button located below the Rule Name list.

3. Enter a valid rule name in the Rule Name text box. “Accepted Work Orders” is an
example of a valid rule name.

4. Define your Rule Expression:

a. In the Field Name picklist, select a field name.

b. In the Operator picklist, select an operation.

c. In the Value text box, enter a value. “Dispatch Response Equals Accepted” is an
example of a rule expression.

d. Use the + or – buttons to add or delete expressions in the Rule Expression builder
area. See figure below.

e. If required, use Advanced Expression to enter conditions such as (1 AND 2) OR
3.

f. Check the Active check box.

g. Click the Paint it with color box to display the color palette and select a color.
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h. Click Apply. Your Event Coloring rule displays in the Rule Name list. All conditions
must be satisfied before a coloring rule can be applied.

Figure 30: Configure Technician View Dialog Box (multiple expressions)

To edit an event coloring rule:

1. Select a rule from the Rule Name picklist.

2. In the Configure Technician View dialog box, click the Edit button.
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The rule populates in the Rule Expression builder area. See figure below.

Figure 31: Configure Technician View Dialog Box (Rule Expression)

3. Make changes to the existing rule by changing the color, the fields (Name and Oper-
ator), or the Value text box.

4. Add a new expression by clicking the + button. You can delete an expression by click-
ing the - button.

5. Check the Active checkbox.

6. Click Apply.

Configure Display Sequence

You can configure the display sequence for teams and territories. The Display Sequence
configuration feature is useful when you need to rearrange the sequence from its original
alphabetical order. For example, you could rearrange the order of the Service Team View
area with your business process rules. The person who would be most likely to use this fea-
ture is a Dispatch Console Dispatcher or Manager.
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See figure below for an example of a default display sequence (alphabetical order by first
name).

Figure 32: Display Sequence Example

To configure the display sequence:

1. Click the Gear icon located on the top right corner of the screen.

2. In the Configure Technician View dialog box, click the Service Team/Territory tab.
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3. Use the up/down arrows to move teammembers or territories in the sequence you
desire.

Figure 33: Configure Display Sequence

4. Click Save.
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The Display Sequence updates based on your arrangement.

Figure 34: Display Sequence Rearranged

Note: If you change the display sequence, there is no Reset button to return
to the default (alphabetical) sequence).

Gantt Chart Current Time Marker
The Current Time Marker visually displays the current time and day as a vertical bar in the
Gantt Chart as shown in the figure below. Dispatch Console Dispatchers can configure the
color and turn the current time marker on or off. This feature is most useful to Dispatch
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Console Dispatchers who need a quick visual of activities in progress on the Gantt Chart.

Figure 35: Current Time Marker Example

Follow the instructions below to configure the display option and vertical bar color for the
Current Time Marker.

To configure the Current Time Marker on the Gantt Chart:

1. Click the Gear icon located at the top, right corner of the Gantt Chart area as shown
in the figure below.
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2. Click the Calendar tab.

3. Find and click option titled, Show current time marker with this color, to display
the marker on the Gantt Chart.

4. Click the color box of the Show current time marker with this color option to
open the array of available colors.

5. Select your desired color.

6. Click Save.

Check Validity for Expertise Search
The Check Validity for Expertise Search is a feature that enables Dispatchers to configure
technician expertise searches to display only valid technician skills and expertise. Any
technician whose expertise dates have expired will not display in search results.

For example, if a Dispatcher searches for technicians with the expertise "Certificate in Elec-
tronics,” only those technicians with a valid "Certificate in Electronics" expertise record
will display.

Figure 36: Check Validity for Expertise Search Example
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Map View
The Map section at the bottom right of the Dispatch Console can be used for two purposes:

To view matching teams or Technicians for a Work Order within a given radius.

To know the Technician's route on a given day.

A sample map view is shown below:

Figure 37: Map View
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The map can toggled by clicking ON or OFF at the top-right of the map section.

A floating panel appears on the map when you keep the mouse pointer anywhere on
the map, and then disappears when the mouse pointer is moved away from the map.
To keep the floating panel permanent on the map, click the Pin button available on
the panel itself.

If the map is ON (displayed), when you search for Service Teams and Technicians,
the matching teams/Technicians are plotted on the map automatically. Only team-
s/Technicians within the radius entered in the map section are displayed.

Click the Maximize button next to the OFF button to view the map in the new
browser window. This will provide more room for the calendar section. Closing the
map in the new browser window will show the map in its original position next to the
calendar.

If the map is ON (displayed), when you select a work order and then click Find Tech-
nician adjacent to the keywords list, the map will open in radius mode and the match-
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ing Technician(s) within the radius is plotted automatically as shown below.

Figure 38: Map View in Radius Mode

To locate Technicians within a certain radius, you can enter a radius value in miles or
use the spin button to increase/decrease the value. If Radius Mode checked, a
circle appears around the work order to visually indicate the coverage of your radius
on the map. The circle changes as you increase or decrease the radius. Uncheck the
Radius Mode checkbox to view the map in normal mode.

To make the floating panel permanent, click the Pin button adjacent to the Radius
Mode checkbox.
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Note: Icons used to representWork Order,Technician, and Team on the
map are configurable. For more details contact your Service Administrator.

JavaScript Map View
The existing Flash-based Map in Dispatch Console is being replaced with JavaScript-based
Map. This is to switch from the deprecated Google Maps API for Flash to Google Maps
JavaScript API v3. In this release, JavaScript-based Map supports all the features of Flash-
based Map except the following:

Plotting Dispatch Console Views for Work Order, Location, and Account

The functionality related to Radius

JavaScript-based Map includes the following enhancements:

Default map size is now set to 25% of the width and 100% of the height of the Dis-
patch Console window, with the map still positioned on the right side (see image
below for an example)

Figure 39: Default Map for JavaScript Map View
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User can personalize the map width by resizing the map and saving it by clicking the
Save button in the Settings area

Disable map component:

This can be achieved by closing the map component and clicking the Save button
in the Settings area

Once saved, map component will not be displayed when Dispatch Console is
launched

When required, map can be switched on again for the session or permanently

Show Route enhancements:

Plot the route for the selected technician for the first day visible in Gantt

Route starts at and ends at the home location

Home location is represented by a new icon

Each stop (work order) on the route is displayed with a sequential numbered icon
starting from 1, for better visualization of technician's route

Route displayed for current day is for the rest of the day, starting from the most
recent work order and ending at the home location

Show route for one technician in a single color, with up to 15 distinct colors used
to show routes for different technicians in different colors

Map Hover enhancements:

Ability to configure hover fields for Service Team and Technician in the Dispatch
Console Hovers configuration screen

Display the configured hover field values on hovering over the relevant icons on
the map, for both routes and search results

If no hover fields are configured, display Name and Address details for Work
Order, Team, and Technician, and Name for Account and Location

Option in the hover window to open the record in Salesforce

Ability to view Dispatch Console on two monitors, with Work Order grid and Gantt dis-
played on one monitor and the map displayed on another monitor

Maintain the map view state when switching between inline and pop-out maps

Dispatch Console

942 JavaScript Map View



Dispatch Console

Option to select traffic as an overlay option on the map, to enable viewing of current
traffic conditions (see example below)

Figure 40: Traffic Overlay Option

Use of icons for teams and technicians to represent the search results on the map

DC Custom Views
Your administrator can create customWork Order, Account, and Location views and
assign them to technicians, teams, and territories. These views can be filtered by own-
ership and pre-conditions. The display results columns can be specified. All available cus-
tomWork Order, Account, and Location views can be accessed from the DC View List
picklist. A black line separates the custom views from the standard views. See figure
below.

To display your custom DC view:

1. Select a custom view from the DC View List picklist.

2. The DC View List will be refreshed with results.

3. Check the Is Default View checkbox to save the view as a default (see figure
below).
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4. Save the setting by clicking the Save button in the Settings area (located in the bot-
tom right corner underneath the Map view).

Figure 41: Dispatch Console Screen (Work Order Custom Views)

5. Click the icon located at the top of left corner of the Map to display the Work
Order, Account, and Location tabs for the DC map views to plot nearby work orders,
account addresses, and locations in the map area. See figure below. A floating panel
appears on the map when you keep the mouse pointer anywhere on the map, and
then disappears when the mouse pointer is moved away from the map. To keep the
floating panel permanent on the map, click the Pin button available on the panel
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itself.

Figure 42: Configure Map Button

6. Click one of the tabs:Work Order, Account, and Location. See figure below.

Figure 43:Work Order, Account, and Location Tabs
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7. Select a View Name from theWork Order, Account, or Location tabs.

Figure 44: View Name Selection

8. In the Radius text box, select the radius (in miles) using the up and down arrows.

9. In the Number of Records text box, indicate the number of records to display on the
map.
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10. Click the Plot Map button to plot the view on the map.

Figure 45: Account View Plotted on Map

The selected view is plotted on the map.

11. Hover over the plotted points on the map to display information about the view. See
figure below.
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Figure 46: DCMap Hover

Note: Your administrator configures the field criteria for the Work Order,
Account, and Location views that are displayed when you hover over the plot-
ted points on the map.

Super Dispatcher
Super Dispatcher is a feature that enables you to deploy Dispatch Console configurations
to multiple dispatchers.

Administrators must activate this feature for the desired dispatchers by checking the
checkbox titled, Is Super Dispatcher? located in the User Detail page. For more inform-
ation about adding Super Dispatcher to the page layout, see Salesforce Help and Training.

After the administrator activates the Super Dispatcher feature, relaunch the Dispatch Con-
sole.

When Super Dispatcher is activated, a Deploy button appears in the Settings area of the
Dispatch Console as shown in the figure below. The Settings area is located below the Map
view.

Figure 47: Settings Area

To deploy Dispatch Console configurations:

1. Click the Deploy button in the Settings area located below the Map view.
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The Deploy UI Settings dialog box displays as shown in figure below.

Figure 48: Deploy UI Settings Dialog Box 

2. Select a service team or territory from the Service Team/Territory picklist. See fig-
ure below.
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Figure 49: Select a Service Team or Territory

Available dispatchers display in the Available Dispatchers list.

3. Find the dispatcher you want to deploy in the Available Dispatchers list and move it
to the Selected Dispatchers list using the appropriate arrow. See figure below.

Figure 50: Selected Dispatchers List

4. Click the Deploy button.

 A message indicating that your deployment was successful displays in the Message
area. See figure below.

Figure 51: Successful Deployment

Note: If your deployment was not successful, read the message in the Mes-
sage area for information to help you troubleshoot the issue.
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Work Flow and Notifications
Since most actions in Dispatch Console directly impact the activities of individuals and
team leaders, email notifications are sent to Service Teams and Technicians based as a
result of actions in Dispatch Console. The table below lists all the workflow rules available.

Note: Workflow rules can be deactivated if they are not applicable for your ser-
vice organization.

In addition, the email templates used by the workflow rules can also be fully customized
as per your requirements. Contact your ServiceMax administrator to know your organ-
ization’s active rules as well as the email templates used.

Event Recipient(s)

Work Order is queued Email ID of the Service Team

Work Order is assigned Email ID of the Technician or equipment

Work Order is scheduled Email ID of the Technician or equipment

Work Order is unassigned Work Order Owner

Work Order is removed from the queue Work Order Owner

See Also:

Dispatch Console - Standard Settings

Installed Product

Product

ServiceMax Processes

Territory

Work Order
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PARTS REQUEST

Overview
Parts Request allows field engineers and other repair locations to request for parts from
other locations (mainly a warehouse). The requirement for parts is usually driven by
reorder levels. The Parts Request does not have the context of a service event; the parts
are not requested for a specific Work Order.

Access and Permissions

Actions User Permissions Needed

To view the Parts Request tab: "Read" on Parts Request

To view Parts Requests: "Read" on Parts Request and Parts Request Line

To create or clone Parts Requests: "Create" on Parts Request and Parts Request Line

"Read" on Location and Product

To change Parts Requests: "Edit" on Parts Request and Parts Request Line

"Read" on Location and Product

To delete Parts Requests: "Delete" on Parts Request and Parts Request Line

To create Parts Requests Line: "Create" on Parts Request Line

"Read" on Product

To edit Parts Requests Line: "Edit" on Parts Request Line

"Read" on Product

To find the stocks in Parts Request
Lines:

"Read" on ServiceMax Settings, Product, Location, and
Product Stock

"Edit" on Parts Request Line
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Actions User Permissions Needed

To create Shipment Order from
Parts Request:

"Read" on Parts Request, Product, and Location

"Edit on Parts Request Line

"Create on Parts Order and Parts Order Line

To process receipt in Parts
Request:

"Read" on ServiceMax Settings, Product and Location

"Edit" on Parts Request Line and Parts Requests

"Create" and "Edit" on Stock History, Product Stock,
and Stocked Serial

To cancel Parts Request: "Edit" on Parts Requests and Parts Request Line

Click the Parts Requests tab to view the Parts Requests home page.

Parts Requests Fields

Fields Description

Additional
Information

Any additional information relevant to this Parts Request.

Age Age of the Parts Request in number of days.

Canceled By Name of the Salesforce user who canceled this Parts Request.

Canceled On Date/time when this Parts Request was canceled.

Closed By Name of the Salesforce user who closed this Parts Requests.

Closed On Date/time when this request was completed.

Requested
From

Location from where the stock is requested. This is a lookup to an existing loc-
ation record.

Required At
Location

Location where the stock is required. This is a lookup to an existing location
record.

Status Current status of the Parts Request.

Supplier Name of the supplier company. Applicable for replenishing stock at warehouse loc-
ations. This is a lookup to an existing Salesforce account record.
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Parts Request Line

Parts Request Line Fields

Fields Description

Additional
Information

Any additional information relevant to this Parts Request line.

Canceled By The Salesforce user who canceled this Parts Request. This is set automatically
when the user cancels the Parts Request.

Canceled On Date/time when this part request was canceled. This is set automatically when the
user cancels the Parts Request.

Closed By The Salesforce user that closed this Parts Request line. This is set automatically
when the receipt is processed.

Closed On Date/time when this Parts Request line was closed. This is set automatically when
the receipt is processed.

Date
Received

Date when the requested part was received at the requested location.

Date
Required

Date when this part is required at the requesting location.

Date
Shipped

Date when the requested part was shipped using a Shipment Order.

Line Status Status of the Parts Request line.

Parts
Request

Link to the Parts Request header. This is a lookup to an existing ServiceMax Parts
Request.

Posted To
Inventory

Flag indicating if this receipt has been posted to product inventory.

Product Name of the product. This is a lookup to an existing Salesforce product record.

Qty
Received

Received quantity of product.

Qty
Required

Required quantity of product.
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Fields Description

Qty Ship-
ment Ini-
tiated

Quantity of product for which shipment has been initiated.

Qty Shipped Actual shipped quantity of product.

Use Price
From Price
Book

Leave this box checked if you want the price to be filled automatically from the
default Price Book. If you would like to enter a price manually for this part, simply
uncheck this box.

Unit Price Unit Price for Line Item.

Adding Lines to Parts Request

Locate the Parts Request by searching in the sidebar or from a list view in Parts Request
tab and click the Parts Request name to which you want to add lines (products).

There are two methods available to add products to a Parts Request as described below.

Method 1: Single-Line Entry

1. Click New from the related list Parts Request Lines. A new Parts Request Lines
record appears below the existing records.

2. Enter the name of the product or use the Lookup icon to search and select the
product.

3. Enter the Qty Required. This should be greater than zero.

4. Enter the date on which the product is required. This should not be a past date.

5. Leave the Shipment/receipt information section blank. See Creating Shipment
Order from Parts Request and Processing Part Receipts in Parts Request for more
information.

6. Click Save.

Note: A Parts Request can have an unlimited number of products. Repeat the
above steps for each part required. You can also click Save & New after cre-
ating a new Parts request line record.
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Method 2: Multi-Line Entry

1. Click Create Lines from the Parts Request screen. The Parts Request Lines screen
appears as shown below:

Figure 1: Parts Request Screen

2. Click the Add button to add a new product to the Parts Request. An empty record is
added to the bottom of the list.

3. Enter the name of the product or use the Lookup icon to search and select the
product.

4. Enter the Qty Required.

5. Enter Date Required.

6. To delete product records entered, click Delete beside each record.

7. Click the Add button to add as many products as required. Alternatively, to delete
one or more products, check the records using the checkbox and click Delete Lines.

8. Check the Use Price Book checkbox and then click Get Price, to automatically cal-
culate the price of a product. Note that the price is calculated only if a valid Price Book
is configured for Parts Requests. To enter a price manually, uncheck the Use Price
Book checkbox.

9. Click Save.
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Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Editing Lines in a Parts Request

To edit lines in a Parts Request:

1. Locate the Parts Request by searching in the sidebar or from a list view in Parts
Request tab and click the Parts Request name in which you want to make part request
changes.

2. In the related list Parts Request Lines, click Edit next to the part request line record

3. Make necessary changes to the parts request line record. You cannot change Quant-
ity Required if shipment activity has been initiated for the line.

4. Click Save to save your changes.

You can also edit multiple Parts Request Lines records. See Multi-Line Entry for more
information.

Finding Stock in a Parts Request Line

After you create a Parts Request line, you can check stock availability in various locations
by using the Stock Lookup tool.

To use the Stock Lookup and Request Stock:

1. Locate the Parts Request by searching in the sidebar or from a list view in Parts
Request tab. Click the Parts Request name in which you want to find stock.

2. Click the Name in the related list Parts Request Lines for any line.

Parts Request
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3. Click Find Stock. A screen appears (sample shown below).

Figure 2: Find Stock For Screen

4. Enter the radius from your location to limit the search to. The Default Radius is set at
50.

5. Using the Show Results As picklist, select to display the results as a grid (table), in
an interactive Google map, or both.

6. Click Find Stock. Depending on your criteria, the results appear as a grid, in a map,
or both.

Note: The Map will show only valid addresses. Locations with required stock
are indicated in Green; locations with less than the required stock are indic-
ated in Red. The grid displays all matching records whether it is a valid address
or not.

When you rest the mouse pointer over a location on the map, it shows location and
stock details as a display list.

7. Click a green/red location to display driving directions on the right side.

8. To request stock from a location:
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a. On Grid: Click the option button in the far right column (titled Request) of each
row in the grid, and click Request Stock.

b. OnMap: Double-click the highlighted flag icon in the Map.

c. Click OK once prompted.

The Requested From location in the Parts Request screen displays the location you
selected.

Create a Shipment Order from a Parts Request
Once you have entered parts request lines in a Parts Request, you can generate a Ship-
ment Order automatically based on the parts requests lines. Typically this step is done by
planners responsible for procurement of the requested products.

To create a Shipment Order for a Parts Request:

1. Locate the Parts Request by searching in the sidebar or from a list view in the Parts
Request tab.

2. Click the Parts Request name from which you want to generate a Shipment Order,
making sure the Parts Request is Open. Also, ensure the Parts Request has at least
one line (product) pending for initiating shipment.

Parts Request
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3. Click Create Shipment Order. A screen appears (sample shown below).

Figure 3: Create Shipment Order Screen

4. Select Order Type as applicable.

5. Enter Quantity to be shipped for each product. The screen lists all products from the
Parts Request for which Shipment Order is not yet created. The Quantity to be cre-
ated in Shipment Order is defaulted to the remaining quantity for Shipment Order cre-
ation. When entering the quantity to be shipped, one or more of the following
scenarios may be applicable:

Create Shipment Order Scenario How to process it

Shipment initiated for all
products in the Parts Request.

Click Submit. Shipment Order will be created for
all open Parts Request lines.

Shipment for a part to be ini-
tiated on a future date.

Enter Zero in the Quantity to be shipped. Make
sure the Close Line checkbox is cleared. This
leaves the line open for creation of a Shipment
Order in the future.
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Create Shipment Order Scenario How to process it

A Parts Request line is not valid
anymore and no shipment will be
initiated for this part in the
future.

This amounts to cancellation of an open Parts
Request line. Enter Zero in Quantity to be
Shipped. Make sure the Close Line checkbox is
checked.

Partial shipment to be initiated
for a part. Shipment for the
remaining quantity will be ini-
tiated in the future.

Enter the quantity to be shipped. Make sure the
Close Line checkbox remains unchecked. This
leaves the line open for creation of a Shipment
Order in the future.

Partial shipment to be initiated
for a part. The remaining quantity
will not be shipped in the future.

This indicates short-closure of a Parts Request
Line. Enter the quantity to be shipped. Make sure
the Close Line checkbox is checked.

6. Click Save to confirm the entries you have made. Alternatively, click Cancel to
return to the Parts Request screen.

7. The newly created Shipment Order displays.

To learn how shipments are processed, see Process Shipment in Shipment Order.

Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

Process Receipts in a Parts Request
When parts are received in the receiving location specified in a Parts Request, you should
process the receipts in ServiceMax for inventory accountability and also to complete the
Parts Request.

To process parts receipts for a Parts Request:

1. Locate the Parts Request by searching in the sidebar or from a list view in Parts
Request tab, click the Parts Request number for which you want to process receipts.
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2. Make sure the Parts Request is Open. Also ensure the Work Order has at least one
Parts Request line (product) to be received.

3. If you are receiving parts from an internal stockable location, such as a warehouse,
click Process Receipts (Internal). If you are receiving parts from an external/non-
stockable entity, such as a supplier, click Process Receipts (Supplier). A screen
appears (sample shown below) in which you can enter the actual receipt information.
The screen lists all products in the Work Order that are not yet received. The Quant-
ity Received is defaulted to the pending quantity expected.

Figure 4: Process Receipts Supplier Screen

4. When entering received quantities, one or more of the following scenarios may be
applicable:

Receipt Scenario How to process it

All products in Parts
Request have been received
as expected.

Click Submit. All the open lines and the Parts Request will
be closed automatically.

A product has not been
received now but is expec-
ted to be received at a
later date.

Enter Zero in Quantity Received. Make sure the Close
Line checkbox is unchecked. This leaves the line open for
a future receipt.

A product has not been
received and it will not
be received in the future
at all.

This amounts to cancellation of an open Parts Request
line. Enter Zero in Quantity Received. Make sure the
Close Line checkbox is checked. If your organization
does not permit short-closing lines, this checkbox may be
disabled.
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Receipt Scenario How to process it

A product has been
received partially now.
The remaining quantity is
expected to be received at
a later date.

Enter the quantity received. Make sure the Close Line
checkbox is unchecked. This leaves the line open for a
future receipt.

A product has been
received partially now.
The remaining quantity
will not be received in
the future at all.

This indicates short-closure of a Parts Request line. Enter
the quantity received. Make sure the Close Line check-
box is checked. If your organization does not permit
short-closing lines, this checkbox may be disabled.

5. Click Submit to confirm the entries you have made. Alternatively, click Cancel to
return to the Parts Request screen.

6. If your organization tracks inventory at the serial number level, the bottom section of
the screen allows you to enter/select serial numbers for serialized products. To enter
serial numbers for a product, check the checkbox against the product in the list. See
Serial Number Selection to learn about how serialized tracking of inventory works
in ServiceMax.

The Parts Request screen is refreshed and you will see the Parts Request Line and
Parts Request Status updated accordingly.

Cancel a Parts Request
When you have neither initiated shipment nor processed receipts for any of the part
request line in Parts Request, you can cancel a Parts Request. When you cancel Parts
Request, this will not be available for creating a Shipment Order or for processing receipts
going forward.

To cancel parts request for a Parts Request:

1. Locate the Parts Request by searching in sidebar or from a list view in Parts Request
tab and then click the relevant Parts Request name.

2. Make sure the Parts Request Status is Open. Also ensure that shipment is not ini-
tiated for any of the Parts Request line (product).

Parts Request
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3. Click Cancel Parts Requests.

4. Click OK when prompted.

The Parts Request screen will be refreshed and you will see the Parts Request Line
and Parts Request Status updated accordingly.

Note: Since parts requests are strongly tied to the inventory module you are
not allowed to delete a Parts Requests. Instead you can cancel a Parts
Request.

See Also:

Account

Location

Parts Request - Standard Settings

Product

Serial Number Selection
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STOCK TRANSFER

Overview
Stock Transfer is used when there is no shipping involved between two locations but the
transfer is a hand-pick/delivery. This is applicable when field engineers drop by at a ware-
house for picking up inventory or when parts are moved between a warehouse and a repair
facility that are both located in the same building.

Access and Permissions

Actions User Permissions Needed

To view the Stock Transfer
tab:

"Read" on Stock Transfer

To view Stock Transfer: "Read" on Stock Transfer and Stock Transfer Line

To create or clone Stock Trans-
fer:

"Create" on Stock Transfer and Stock Transfer Line

"Read" on Location and Product

To change Stock Transfer: "Edit" on Stock Transfer and Stock Transfer Line

"Read" on Location and Product

To delete Stock Transfer: "Delete" on Stock Transfer and Stock Transfer Line

To create Stock Transfer Line: "Create" on Stock Transfer Line

"Read" on Product

To edit Stock Transfer Line: "Edit" on Stock Transfer Line

"Read" on Product

To post Stock Transfer to
inventory:

"Read" on ServiceMax Settings, Product, and Location

"Edit" on Stock Transfer Line and Stock Transfer

"Create" and "Edit" on Stock History, Product Stock, and
Stocked Serial
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Note: Since stock transfers are strongly tied to the inventory module you are
not allowed to delete a stock transfer record.

Stock Transfer Fields

Fields Description

Additional
Information

Any additional information relevant to this Stock Transfer.

Destination Loca-
tion

Physical location where the stock is transferred to. This is a lookup to an
existing Location record.

Source Location Physical location from where the stock is transferred. This is a lookup to an
existing Location record.

Stock Transfer Lines

Stock Transfer Line Fields

Fields Description

Additional
Information

Any additional information relevant to this Stock Transfer line.

Posted To
Inventory

Indicates if this Stock Transfer record has been posted to inventory or not. This is
set automatically.

Product Name of the product. This is a lookup to an existing Salesforce Product record.

Qty Trans-
ferred

Quantity transferred from source to destination location.

Stock Trans-
fer

Reference to Stock Transfer.

Unit Price Unit Price for Line Item.

Use Price
From Price
Book

Leave this box checked if you want the price to be filled automatically from the
default price book. If you would like to enter a price manually for this part, simply
uncheck this box.

Stock Transfer
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Adding Lines to a Stock Transfer
Locate the Stock Transfer by searching in the sidebar or from a list view in the Stock Trans-
fer tab and then click the Stock Transfer name to which you want to add lines.

There are two methods available to add products to a Stock Transfer as described below.

Method 1: Single-Line Entry

1. Click New from the related list Stock Transfer Lines. The Stock Transfer screen
appears.

2. Enter the name of the product or use the Lookup icon to search and select the
product.

3. Enter the Quantity to Transfer. This should be greater than zero and once saved you
cannot modify the quantity.

4. Enter the additional information.

5. Click Save.

Note: Stock Transfer can have an unlimited number of products. Repeat the
above steps for each part required. You can also click Save & New after cre-
ating a new Stock Transfer line record.
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Method 2: Multi-Line Entry

1. Click Create Lines from the Stock Transfer screen. The following screen appears:

Figure 1: Stock Transfer Screen

2. Click Add to add a new product to the Stock Transfer. An empty record is added to the
bottom of the list.

3. Enter the name of the product or use the Lookup icon to search and select the
product.

4. Enter the quantity transferred.

5. Click Add to add as many products as required. To delete one or more products,
check the records using the checkbox and then click Delete Lines.

6. Check the Use Price Book checkbox and then click Get Price, to automatically cal-
culate the price of a product. Note that the price is calculated only if a valid price book
is configured for Stock Transfer. To enter a price manually, uncheck the Use Price
Book checkbox.

7. Click Save.

Stock Transfer
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Note: This screen is presented by the Service Flow delivery engine of Ser-
viceMax based on the service flow configuration. To learn more about how to
use this screen’s features, see Using The Application > Service Flow
Screen. In addition, you can click the screen title or the help button to view
additional help for this screen, if configured by your administrator.

To edit Lines in a Stock Transfer:

1. Locate the Stock Transfer by searching in the sidebar or from a list view in the Stock
Transfer tab and then click the Stock Transfer name in which you want to make Stock
Transfer changes.

2. In the related list Stock Transfer Lines, click Edit next to the Stock Transfer line
record. The Stock Transfer screen appears in the edit mode for the selected record.

3. Make the necessary changes to the Stock Transfer line record.

4. Click Save.

Posting Stock Transfer to Inventory
After you have created Stock Transfer lines to a Stock Transfer, you should post Stock
Transfer information to inventory to maintain the stock accountability in inventory.

To post Stock Transfer to inventory:

1. Locate the Stock Transfer by searching in the sidebar or from a list view in the Stock
Transfer tab.

2. Click the Stock Transfer which you want to post to inventory. Make sure the Stock
Transfer is not already posted to inventory. Also ensure the Stock Transfer has at
least one product for posting to inventory
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3. Click Post To Inventory. A screen as shown below appears:

Figure 2: Post to Inventory Screen

4. Click Submit to confirm the entries. Alternatively, click Cancel to return to the Stock
Transfer screen.

5. If your organization tracks inventory at the serial number level, the bottom section of
the screen allows you to enter/select serial numbers for serialized products. To enter
serial numbers for a product, check the checkbox against the product in the list. See
Serial Number Selection to learn how serialized tracking of inventory works in Ser-
viceMax.

The Stock Transfer screen refreshes and you will see the updated flag of Posted to
Inventory in Stock Transfer.

See Also:

Account

Location

Product

Serial Number Selection

Stock Transfer - Standard Settings

Stock Transfer
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STOCK ADJUSTMENT

Overview
Stock Adjustment is used to perform a hard-reset of stock information in ServiceMax when
mismatches are found between actual stock and information in ServiceMax. Only admin-
istrators can perform this task.

Access and Permissions

Actions User Permissions Needed

To view the Stock Adjustment
tab:

"Read" on Stock Adjustment

To view Stock Adjustments: "Read" on Stock Adjustment

To create or clone Stock Adjust-
ments:

"Create" on Stock Adjustment

"Read" on Location and Product

To change Stock Adjustments: "Edit" on Stock Adjustment

"Read" on Location and Product

To delete Stock Adjustments: "Delete" on Stock Adjustment

To post Stock Adjustments to
inventory:

"Read" on ServiceMax Settings, Product and Location

"Edit" on Stock Adjustment

"Create" and "Edit" on Stock History, Product Stock, and
Stocked Serial

Click the Stock Adjustment tab to display the Stock Adjustment home page.

Caution: Since Stock Adjustments are strongly tied to inventory module you
are not allowed to delete a stock adjustment.
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Stock Adjustment Fields

Fields Description

Additional
Information

Any additional information relevant to this Stock Adjustment.

Adjustment
Account Num-
ber

The source/target inventory account against which this increase/decrease is
accounted for.

Adjustment
Type

Type of adjustment. Indicates the purpose for Stock Adjustment.

Change Qty Positive number indicating the change in quantity (Higher quantity - lower quant-
ity).

Change Type Indicates if the change was an increase or decrease.

Location Physical location of the product where the stock is adjusted. This is a lookup for
an existing Location record. The adjustment location should be a stocking loc-
ation.

New Qty Product quantity after Stock Adjustment.

Old Qty Product quantity before Stock Adjustment.

Partner
Account

This is a lookup to Partner Account.

Partner
Contact

This is a lookup to Partner Contact.

Posted To
Inventory

Indicates if this Stock Adjustment has been posted to inventory or not. This is set
automatically.

Product Name of the product. This is a lookup to an existing Salesforce Product record.

Figure 1: Posting Stock Adjustment to Inventory

After you have created Stock Adjustment, you should Post Stock Adjustment information
to inventory to maintain the stock accountability in inventory.

To post Stock Adjustment to inventory:

1. Locate the Stock Adjustment by searching in the sidebar or from a list view in the
Stock Adjustment tab.

Stock Adjustment
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2. Click the Stock Adjustment which you want to post to inventory. Make sure the Stock
Adjustment is not already posted to inventory.

3. Click Post To Inventory. A screen appears as shown below:

Figure 2: Post to Inventory Screen

4. Click Submit to confirm the entries. Alternatively, you can click Cancel to return to
the Stock Adjustment screen.

5. If your organization tracks inventory at the serial number level, the bottom section of
the screen allows you to enter/select serial numbers for serialized products. To enter
serial numbers for a product, check the checkbox against the product in the list. See
Serial Number Selection to learn how serialized tracking of inventory works in Ser-
viceMax.

Note: The Stock Adjustment screen will be refreshed and you will see the
updated flag of Posted to Inventory in Stock Adjustment. Product Stock quant-
ity for a serialized product at a given location is found to be less than the cur-
rent stock, and Stock Adjustment operation is performed to record this
correction. The ADJUSTED stock at the source location is increased by the
excess quantity. The excess serials are associated with the ADJUSTED stock
record.

See Also:

Account

Location

Product

Serial Number Selection
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SERIAL NUMBER SELECTION

Overview
ServiceMax provides increased granularity of inventory management by tracking the
stock of products and spare parts using serial numbers. This is an optional feature that is
enabled upon request. When this feature is enabled, users will be prompted to select or
enter serial numbers whenever inventory transactions such as RMA, Shipment, or Stock
Transfer are carried out. In addition, since all products in your organization may not be
tracked by serial numbers, you can enable serialized tracking of inventory for specific
products only.

Based on your organizational requirements, you can configure ServiceMax to allow or
block duplicate serial numbers for a product/part. You can also define the level of strict-
ness with which serial number uniqueness is enforced. Please contact your ServiceMax
administrator to learn if serialization is enabled and configured for your organization.

Entering/Selecting a Serial Number
For all inventory transactions, a standard screen will be displayed to enter/select serial
numbers for each product in the transaction. A sample serial number selection screen is
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shown below.

Figure 1: Serial Number Selection Screen

The top of the section shows the product currently selected from the list. This is the
product for which serial numbers are required to be selected.

The From List 1 shows the serial numbers available in the From Location for choos-
ing. Depending on the type of inventory transaction, sometimes this list may be
empty.

The From List 2 is a free text area where you can enter serial numbers and move to
the To Location. This is especially useful when processing supplier receipts with a
large volume of serial numbers.

The To List is the list of serial numbers selected into the To Location. This list
always starts as an empty list.

In some cases, the From Location and To Locationmay be the same but the
Status will be different. For example, when you receive parts on a Parts Request or
Work Order, the From Location status will be In Transit (indicating the part has
been shipped), and the To Location status will be Available (indicating it is the final
receiving location).

Serial Number Selection
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When the above screen is displayed, you can add serial numbers to the To Location in
many ways:

Move serial numbers from the From List 1 to the To List. You can select multiple
entries from the From List 1 by holding the CTRL key and then clicking the list.
Then click Add (>>) to move the selected serial numbers to the To List. To undo
the selection made, select the entries from the To List and then click Remove
(<<).

If you are processing supplier receipts and need to enter a large volume of distinct
serial numbers, paste the serial numbers in From List 2 and click Add (>>) to
move the serial numbers to the To List. To undo the selection made, select the
entries from the To List and then click Remove (<<).

You can also manually enter serial numbers by using the Serial Number field one at a
time. Click Add (>>) after entering each serial number.

If the serial numbers you wish to add are in a sequence, you can enter the starting
serial number in the Serial Number field and enter the number of serial numbers you
wish to add in the Quick Add field. For example, if you wish to add 10 serial numbers
starting from “SN-0001”, enter SN-0001 in the serial number field, enter 10 in the
Quick Add field, and click the Quick Add button. This will add 10 serial numbers
from SN-0001 to SN-0010 to the To List. You cannot use Quick Add for serial num-
bers with only alphabetical digits.

When adding serial numbers, ServiceMax validates to make sure you have not selected or
entered more serial numbers than required by the transaction. For example, if you are pro-
cessing an RMA for 5 numbers of a product, you will be allowed to add only 5 numbers to
the To List.

Once you have finished entering serial numbers for a product, navigate to the next product
using the Next button. Use the Prev button to navigate to the previous product in the list.
Alternatively, you can select any product from the list at the top to process serial numbers
for that product.

After completing serial selection for all products, click Submit.

If you have omitted any product, or selected fewer serial numbers than required, or if you
have entered duplicate serial numbers, error messages appear at the bottom of the screen
in the Error Messages section. Rectify the errors and then click Submit again.
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DASHBOARDS AND REPORTS

Overview
Several operational and management reports are preloaded in ServiceMax. These reports
and dashboards are fully customizable. In addition, you can create your own custom
reports using the ServiceMax object model and custom report types. To learn about how to
create your own reports or customize existing reports, see the online help on the topic
Reports on Salesforce.com.

ServiceMax Finance Reports

Dashboard Name Description

Service Contract Billing
Report

Service Contract Billing Report by week in a given period.

Work Order Amounts
per Technician

Shows the billable and total work order amounts per technician for
the current and prior fiscal year.

Work Order Billing
Information

Lists all closed work order details for last month, for billing.

ServiceMax Parts & Inventory Reports

Dashboard Name Description

Consumption Trend
by Location (Quant-
ity)

Stock consumption trend (quantity) by location

Consumption Trend
by Location
(Value)

Consumption Trend (Value) by location
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Dashboard Name Description

Consumption Trend
by Partner (Quant-
ity)

Stock consumption Trend (quantity) by Partner location

Consumption Trend
by Partner (Value)

Consumption Trend (Value) by Partner location

Delayed RMAs Open RMAs past the scheduled release date

Parts Below
Reorder Level

Shows the inventory levels of each stocking location and displays a chart
of how many of each product family need to be ordered to get back to
desired levels.

Parts Below
Reorder Level by
Partner

Parts Below Reorder Level by Partner

Pending RMAs Lists RMAs that are due today and in the future.

RMA/Shipment
Backlog for Part-
ners

RMA/Shipment orders past the scheduled return/shipment dates for Part-
ners.

Shipment Backlog Shipment orders past the scheduled shipment dates.

Stock Quantity By
Location

Stock quantity by location

Stock Quantity by
Partner Location

Stock quantity by Partner location

Stock Value By
Location

Stock value by location and family

Stock Value by
Partner Location

Stock value by Partner location

This Week's
RMA/Shipments
for Partners

List of Material expected to be returned and Shipments expected to be
sent this Week for Partners

This Week's RMAs Material expected to be returned this week

This Week's Ship-
ments

Shipments expected to be sent this week

Dashboards and Reports
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Dashboards and Reports

Dashboard Name Description

Today's RMA/Ship-
ments for Partners

List of Material expected to be returned and Shipments expected to be
sent today for Partners

Today's RMAs Material expected to returned today.

Today's Shipments Shipments expected to be sent today.

ServiceMax Productivity Reports

Dashboard Name Description

Efficiency in Assignment
To Scheduling

Time taken between assignment and scheduling of work orders

Efficiency in Queuing To
Assignment

Time taken between queuing and assignment of work orders

Efficiency in Scheduling To
Closure

Time taken between scheduling and closure of work orders

Service Turnaround Time Turnaround time to close work orders

Service Turnaround Time
by Partner

Turnaround time to close work orders by Partner

Work Order Throughput Open and Closed work orders in the current FQ

Work Order Throughput by
Partner

Partner's Open and Closed work orders in the current FQ

Work Order Time to Assign Time it takes for initial assignment of work orders to technicians

Work Order Time To
Queue

Time it takes for initial queuing of work orders to service teams

Work Order Time to Sched-
ule

Time it takes for initial scheduling of work orders

Work Orders Assigned Mul-
tiple Times

Incidences of work orders assigned more than once

Work Orders by Technician
This Qtr

Shows all work orders for the current quarter by technician,
based on the work order creation date.

Work Orders Closed Per
Tech Last 7 Days

Shows the number of work orders closed per day by each tech-
nician for the last 7 days.
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Dashboard Name Description

Work Orders Created Per
Month

Shows the trend of the number of work orders created per
month, by order type.

Work Orders Queued Mul-
tiple Times

Incidences of work orders queued more than once

Work Orders Scheduled
Multiple Times

Incidences of work orders scheduled more than once

ServiceMax Warranty/Svc Reports

Dashboard Name Description

Active Service Con-
tracts by Country

Shows active service contracts grouped by country.

Active Service Con-
tracts by SLA

Active Service Contracts by SLA terms

Active Service Con-
tracts by State

Lists all active service contracts by state, and shows relative value
and number coming from each state.

Incidents in warranty* Incidents in warranty

Installed Product
Status

Installed Product Status

Installed Products By
Country

Installed Products by Country

Installed Products By
State

Compares the number of installed products by state.

New Service Contracts
by Month

Shows the value of new service contracts started each month for the
last year.

New Warranties by
Month

Shows the number of new warranties per month over the last year.

Service Contract Expir-
ation by Month

Value and number of contracts expiring in the next 12 months, by
month.

Service Contract Expir-
ation Report

A list of all service contracts expiring in the last 3 weeks or the next
3 months, sorted by contract end date.

Dashboards and Reports
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Dashboards and Reports

Dashboard Name Description

Warranties by Country Shows the number of current warranty terms by country.

Warranties by State Shows the number of current warranty terms by state.

Warranty Expiration by
Month

Lists warranties expiring per month for the next 12 months.

Warranty Expiration
Report

Lists all product warranties that have expired in the last 4 weeks or
are expiring in the next 8 weeks and have no service contract asso-
ciated with them.

* Reports available only in some editions of ServiceMax. Please contact your ServiceMax administrator to know the type of
license used by your organization.

ServiceMax Work Order Management Reports

Report Name Description

Canceled Work Orders
Per Month

Shows the number of work orders canceled per month over the last 12
months. If this is a significant number, or rising fast, it may be worth
further investigation.

Critical Work Orders
By Type

Lists work orders open for more than 7 days.

Critical Work Orders
for Partners

Lists work orders open for more than 7 days assigned to partners.

Down Customers Lists work orders that are in Customer-down situations.

Down Customers by
Partner

Lists service orders that are in Customer-down situations.

Open Work Order Mat-
rix

Shows the number of work orders by work order type.

Open Work Orders by
Status & Type

Lists all open work orders and shows them in a chart of how many are
in each status and type.

Open Work Orders by
Technician

Shows the number of work orders of each order type by technician.

Open Work Orders By
Type

Lists open work orders grouped by order type.
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Report Name Description

Open Work Orders By
Type for Partners

Lists open partner work orders grouped by order type.

Service Bottlenecks* Cases/Service issues preventing completion of service delivery

Unscheduled PM Work
Orders

Shows unscheduled planned maintenance work orders by created date
to show possible overlooked PMs.

Upcoming PM Work
Orders

Shows the number of scheduled PM work orders over the next 12
months.

Work Order Aging Open work orders in various time buckets

Work Order Aging by
Partner

Open partner work orders in various time buckets

* Reports available only in some editions of ServiceMax. Please contact your ServiceMax administrator to know the type of
license used by your organization.

ServiceMax Dashboards

Dashboard Name Description

IB, Warranty & Service
contracts dashboard

Has charts showing installed product distribution, warranty and
service/maintenance contracts performance

Service Operations dash-
board

Contains reports and charts useful for daily operations in service

RMA dashboard Charts and reports pertaining to RMA activities

Shipment dashboard Charts and reports pertaining to shipment activities

Service management dash-
board

Charts and reports for service administration and executive man-
agement

Failure analysis dash-
board

Charts highlighting performance of products in customer locations
from a service standpoint

Dispatch Console dash-
board

Contains reports and charts useful for dispatch and service man-
agement

Inventory dashboard Contains reports and charts useful for daily operations in service

Dashboards and Reports
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USING THE SFM TRANSACTION SCREEN

Overview
The SFM Transaction delivery engine provides a rich user interface to deliver the user
experience for all SFM Transactions—standard and custom. Irrespective of whether an
SFM transaction is used to create target records from source records or to edit target
record lines in standalone mode, certain user interface aspects remain the same. The over-
all experience of entering data would be similar to entering data in a Salesforce web
screen. However, the SFM transaction delivery engine supports some advanced data-
entry capabilities to enhance the productivity of end users. The capabilities include:

Ability to enter header and child records at the same time.

Adding multiple child records from a lookup at once.

Extended edit for child records.

Advanced context-based lookup.
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Screen Sections
A sample SFM transaction designer screen with header and details is shown below.

Figure 1: A Sample SFM Screen Designer

The transaction contains the following areas:

Header with sections

Child record tabs

Standard and custom buttons.

Entering Data
Entering data in SFM transaction screens is much like entering data in any web page or in
the standard Salesforce application. Required fields are marked in Red. All other fields are
optional and may be left blank. Listed below are key features to know while using SFM
transaction screens:

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

When creating target records, some of the fields may be automatically filled with
data from the source records if available.

Any data you entered/edited will be lost and default values will be restored for all
fields if you refresh the browser screen.

In the header section, the tab order is always top-to-bottom within a section. In the
child tabs, the tab order is always left-to-right.

Text fields include all fields with text data type, email, URL, and phone numbers. No
special handling or formatting is done for phone numbers and URLs. Email entries are
validated for adherence to a valid email format.

Long text fields show multiple lines to enter data as configured in the page layout
designer.

Multi-select picklists are displayed in a list box. Use CTRL+Click to select or deselect
one or more values from the list.

Date and Date/Time fields provide a date picker as shown in the figure below.

Figure 2: Date Picker in SFM Transaction
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Lookup Attributes Tab

Lookup fields have a locator button adjacent to them. Click the Locator button to
open the Configure Lookup dialog box as shown below.

Figure 3:  Lookup Field Screen

Note: You can also enter a field name or a partial field name, and then
click the Locator button to conduct a search based on the field name or
partial field name.

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

You cannot use other parts of the SFM transaction screen when a lookup window is
displayed.

If your administrator has configured a custom lookup for this field, the custom lookup
screen appears. If not, the default generic lookup is shown.

The lookup object is automatically searched if any text is already entered.

The search is performed based on the fields configured for the custom lookup. Stand-
ard lookup uses only the Name field in search.

The result set shows the fields configured for the custom lookup. Standard lookup
only shows the Name field in the result set.

The number of records displayed in the result set is also configurable by the admin-
istrator. Standard lookups show up to 50 matching records.

If a context (controlling) lookup has been configured for the lookup, the search res-
ults are limited to the values matching the controlling field. For example, if Account is
set up as a controlling/context for Contact lookup and you have selected ABC Inc. in
the account field, the contact result set will display only those contacts that are
linked to the account ABC Inc. Depending upon the setup, you may be allowed to
override this behavior and select to search all contacts irrespective of the account.

There are four search options in the search operator picklist (Contains, Starts With,
Ends With, and Exact Match). See figure below.
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The Contains option will include your search term(s) in the search results.

The Starts With option searches for terms that start with your search term.

The Ends With option searches for terms that end with your search term.

The Exact Match option searches for terms that are an exact match with your
search term.

The default search operator is determined by the value global setting GBL017 (Mod-
ule, Common, Sub Module, and Global Settings).

Figure 4: Search Operator Picklist

Once a valid record is selected in a lookup, clicking the bubble icon beside the field
shows additional information from the selected record. The fields to be used in the
bubble can be configured by the administrator. If no configuration is available, the
Name field appears. The bubble goes away when you click anywhere outside its box.

Advanced Filter
Your administrator can set up an advanced filter to create filter criteria based on a related
object. For example, your administrator can set up an advanced filter for Product Stock to
limit the parts you can record to only those parts that are available in your trunk stock.

Advanced Lookup Filter Example

An advanced filter Product Stock example is illustrated below.

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

To conduct a search based only on those items in your product

stock:

1. Open a work order.

2. In the Service Flow Wizard area, click the Record T&M button.

3. In the Manage Work Order Lines window, click Add a row to add a row to the Parts
tab area (if necessary). See figure below.

4. Click inside the Part text box area to display the Part text box and Parts Lookup
icon. See figure below.

5. Click the Parts Lookup icon as shown in the above figure.

6. In the Product search dialog box, select a search string (Contains, Starts With,
Ends With, or Exact Match) and enter the product you want to search for.

7. In the Product search dialog box, click Search . The products from the search cri-
teria display in the Product search dialog box.
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8. In the Product search dialog box, click the Advanced Filter icon as shown in the fig-
ure below.

Figure 5: Product Search

9. Check the Limit Items to Truck Stock checkbox to limit the search to only the
products that are available in your trunk as shown in the figure below.

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

Figure 6: Product Search

10. Click Search . The product list now includes only items from your truck stock.

11. Click a product from the available product list to select it.

12. Click Select to select the selected product.

13. If you need to cancel your search, click Cancel.

Lookup Form Fill
Lookup form fill is an administrator setting that enables information to be copied over from
a record you have looked up to the current record you are editing. For example, your
administrator can configure a form fill attribute for warranty information. In this example,
the warranty information automatically populates with the form fill attribute your admin-
istrator has configured. An illustrated example of this feature is described below.

Lookup Form Fill Feature Example

In this warranty example, the administrator created a Lookup form fill for warranty start
date and end date. Therefore, the warranty information will automatically populate into
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the record.

To use the Lookup Form Fill feature:

1. Open a Work Order.

2. Launch a transaction from the Service Flow Wizard (SFW).

3. Add a Products Serviced detail line and select a serial number. See figure below.

Figure 7: Add/Edit Products Serviced

4. Click the Lookup icon next to the Product Warranty field.

5. In the Recent Items: Product Warranty dialog box, click the Search icon. Applic-
able warranty records appear in the dialog box as shown in the figure below.

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

Figure 8: Add/Edit Products Serviced

6. In the Recent Items: Product Warranty dialog box, select a product warranty
item from the available list by clicking it.

7. Click Select. The Warranty Start Date and End Date are updated in the source record.

Figure 9: Add/Edit Products Serviced

Note: This functionality is available only when you are using ServiceMax
SFM—not on custom VF pages or Salesforce page edits.

Child Records
Child records are displayed as tabs below the header as shown below. (Parts, Labor,
Expenses, and Travel are examples of Child records).
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Figure 10: Tabbed Display of Child Records

To add a new record, click the Add button. This button will not be available if your
administrator has disabled it based on your organization’s requirements.

If your child section contains one or more lookups, your administrator may have con-
figured one of those lookups to facilitate adding of multiple records quickly. For
example, when creating Parts consumed for a work order, you can add multiple part
records from the lookup.

To add multiple child records in one go, click the Multi-Add button. A popup appears
as shown below. The multi-add lookup works the same as the regular lookup screen
(described above), except it allows you to select more than one record from the res-
ult set.

To select all the products at once, check the checkbox next to the Product Name
field. See figure below.

Figure 11: AddingMultiple Child Records using the Multi-Add Feature

There are four search options in the search operator picklist (Contains, Starts With,
Ends With, and Exact Match). See figure below.

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

The Contains option will include your search term(s) in the search results.

The Starts With option searches for terms that start with your search term.

The Ends With option searches for terms that end with your search term.

The Exact Match option searches for terms that are an exact match with your
search term.

Figure 12: Search Operator Picklist
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To remove a child record, click the Delete button in the row itself. Though the record
is deleted from the screen, you must click Save to make the deletion final.

If the child section contains too many fields, it may be difficult to scroll back and forth
to fill all the fields. You can avoid the horizontal scrolling by using the Extended Edit
feature. A popup screen as shown below appears when you click the Extended Edit
button.

Figure 13: Editing the Child Record using Extended Edit Feature

In this transaction you can enter data for each child record and also navigate through
other child records in the tab without closing the popup. Extended Edit works for existing
records only—you cannot create new records using this screen.

Note: Rich Text fields are not supported by the SFM transaction manager in
this release. Standalone Create and View processes are not supported.

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

Auto Resolve Lookup
Auto Resolve Lookup is a feature that enables end users to enter values on SFM Trans-
action lookup fields directly, rather than opening the Lookup dialog box and choosing a
value.

To use the Auto Resolve Lookup feature:

1. Enter text in an Object field (for example, Part, Account). See figure below.

Figure 14: Auto Resolve Lookup Feature

2. Click Save. The Auto Resolve Lookup feature automatically processes.
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If the Auto Resolve Lookup feature finds multiple matches, the Error Details dialog
box displays an error message as shown in the figure below.

Figure 15: Error Details Dialog Box

If your value has multiple matches, click the Object's arrow to open the Object's pick-
list as shown in the figure above.

Using the SFM Transaction Screen
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Using the SFM Transaction Screen

Screen Buttons
Standard and custom buttons are displayed at the top and bottom of all SFM trans-
action screens. Standard buttons such as Save and Cancel are always displayed at
the left.

Click the Save button to create/update header and child records as applicable. Upon
successful saving of data, you will be redirected to the created/updated record in
Salesforce in view mode.

To discard your changes, click Cancel. You will be redirected to the record from
which you launched the SFM transaction screen.

If the SFM transaction is for standalone editing of a record with child records, an addi-
tional buttonQuick Save is available. This button allows you to work on the same
SFM transaction after saving.

Some of the standard ServiceMax transactions have special standard buttons in addi-
tion to Save and Cancel. See the appropriate section in this document where the
SFM transaction functionality is described in detail.

Clicking custom buttons will result in one of the following:

Execute any custom logic associated with them. The header and child sections will be
refreshed with the results of the custom logic. Contact your ServiceMax admin-
istrator if you need more information regarding how to use the custom buttons in the
context of your SFM transactions.

Launch the URL associated with the button in a new window.

SFM Delivery Lines Area Enhancement Grid
The delivery lines area has been enhanced to support a universal, grid based format that
includes sort, filter, and other capabilities (see Figure below).
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Figure 16: Delivery Lines Area Grid

In the delivery lines grid area:

Click the record once to select it.

Click the record twice to access the Product Lookup feature and (if applicable) edit
any content in the text box (see Figure above).

Once a record is selected, you can use the Tab key to move to the next column.

Resize columns by moving the lines between columns with your cursor (left to right).

You can Delete a row or use the Extended Edit feature by clicking the appropriate
buttons on the left side of the grid.

The Add a row and Search and Add buttons are featured on the left side of the grid.

To use the filter option, enter a name in the Search text area and click the Refresh
button.

Click the Bubble icon to get information about the record. See figure below.

Figure 17: Delivery Lines Area Grid (Bubble icon)

Using the SFM Transaction Screen
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SFM SEARCH

Overview
SFM Search is a search feature for your business-related processes (Accounts, Installed
Products, Work Orders, and so on).

Your administrator configures and manages the profile access permissions for the SFM
Search feature. For information about your settings, contact your administrator.

ServiceMax Search
The ServiceMax Search box is located in the top left corner of the Home screen.

To use the ServiceMax Search:

1. Select your search options from the Select Search picklist (Figure 1).

Figure 1: ServiceMax Search

2. Enter your keyword(s) in the search text box.

3. Click the Go button.
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The SFM Search Results Page appears (Figure 2).

Figure 2: SFM Search Results Page

From this screen you can:

Select a predefined search (Contains, Exact Match, Ends With, Starts With) in
the picklist.

Enter a search keyword in the text box and click the Go button.

Click the Account Search area to see account related information.

Get Customer Details by clicking the Customer 360 area.

Click the Locate IB area to find the process stage IB is in.

Click Serial Number Search to search by serial number.

SFM Search
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SERVICE PARTS & REVERSE LOGISTICS
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SERVICE PARTS & REVERSE LOGISTICS

Overview
Service Parts & Reverse Logistics enables organizations to seamlessly manage end-to-
end repair and logistics operations involving high volumes of data including initiating
returns, receiving, shipping, exchange fulfillment, and depot repair.

To activate Service Parts & Reverse Logistics:

1. Go to Home > ServiceMax Setup > App Administrations > Configuration Pro-
files.

2. Select an active Org-wide Profile and click the Edit button.

3. Select Common from the Select Module picklist.

4. Select Global Settings from the Select SubModule picklist.

5. Check the checkbox for GBL014.

For configuring Service Parts & Reverse Logistics see:

Depot & Stocking Locations

Routes & Stops

Repair Shipment Preparation

Forwarding Engine

Product Substitution Matrix

Returns Process

Receiving Process

Delivery Rules

Shipping Process

Sourcing Rules
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For using Service Parts & Reverse Logistics see:

Case

Return Material Authorization (RMA)

Shipment

Fulfillment

Service Parts & Reverse Logistics
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ADVANCED CONFIGURATION: SERVICE PARTS &
REVERSE LOGISTICS

Overview
Service Parts & Reverse Logistics enables organizations to seamlessly manage end-to-
end repair and logistics operations involving high volumes of data from initiating returns,
receiving, shipping, exchange fulfillment, and depot repair. 

In order to use Service Parts & Reverse Logistics in your organization, your administrator
must set up configurations for each Service Parts & Reverse Logistics module listed below.

Service Parts & Reverse Logistics consists of the following modules:

Depot & Stocking Locations

Returns Process

Routes & Stops

Receiving Process

Delivery Rules

Repair Shipment Preparation

Forwarding Engine

Shipping Process

Product Substitution Matrix

Sourcing Rules

See the Glossary for a list of terms associated with Service Parts & Reverse Logistics.

1011



1012



DEPOT & STOCKING LOCATIONS

Overview
The Depot & Stocking Locations module enables administrators to manage Service Parts
Depots (Warehouses) and their Stocking Locations. You can define multilevel hierarchical
structures to represent regional depots, field stocking locations, central warehouses, and
so on. You can also define stocking locations (receiving, holding, delivery, and staging)
within a depot.

Access and Permissions

Actions User Permissions Needed

To view Depot & Stocking Locations "Read" on Location

To create or edit Depot & Stocking Locations "Create" and "Update" on Location

To delete Depot & Stocking Locations "Delete" on Location

Manage Depot & Stocking Locations Screen

To access the Reverse Logistics module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area in the top left of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Depot & Stocking Locations button.
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4. Click the Go button. The Manage Depot & Stocking Locations screen appears as
shown in the figure below.

Figure 1: Manage Depot & Stocking Locations

In the Manage Depot & Stocking Locations screen (Figure 1 above)

you can:

You can add new a top level location by clicking the Add Top Level button.

Quick Save locations.

Save locations and close the window.

Return to ServiceMax Setup Home.

To add a top level location:

1. Click the Add Top Level button.

Depot & Stocking Locations
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Depot & Stocking Locations

2. In the Level/Depot Name text box, enter the name you want to assign to the
level/depot. See Figure below.

Figure 2: Level/Depot Name

3. Click the Quick Save button to save the location.

4. Click the Save and Close button to save the location and close the Manage Depot &
Stocking Locations screen.

The Level/Depot Name is saved. See figure below.

Figure 3: Level/Depot Name Saved Successfully
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Editing Level/Depots

In the Edit Level/Depot area of the Manage Depot & Stocking Locations screen, you can
add levels, add depots, and delete locations.

To add a level:

1. Click the Level/Depot Name.

2. Click the Add the Level button.

3. In the Adding a Level area, enter a level/depot name in the Level/Depot Name text
box.

Figure 4: Adding a Level

4. Click the Quick Save button to save the location.

5. Click the Save and Close button to save the location and close the Manage Depot &
Stocking Locations screen.

6. Click the Cancel button to cancel the level.

Depot & Stocking Locations

1016 Manage Depot & Stocking Locations Screen



Depot & Stocking Locations

The level is added to the location. See figure below.

Figure 5: Added Level Saved

To add a level/depot:

1. Click a top level to select it. The level/depot displays in the Level/Depot Name text
box.

2. Click the Add Depot button in the Edit/Level Depot area.

3. Enter the Level/Depot Name in the first text box.

4. Enter appropriate information in the Street, City, State, Zip, and Country text
fields.

5. Select a Location Type (Internal, Customer, Supplier, Field).

6. Enter the Latitude and Longitude in the appropriate text boxes.

7. Enter Locations for the top level.

a. Enter the name in the Name text box.

b. Select a function (Default Delivery, Delivery Location, Receiving Location,
Staging Location) from the Function picklist.

c. Check the appropriate checkbox to answer the question Has Good Stock?.
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8. Click the Validate Address button to validate the Level/Depot address.

Figure 6: Adding a Level/Depot

Setting Up Service Parts & Reverse Logistics Locations

To set up a Service Parts & Reverse Logistics Location:

1. In the Manage Depot & Stocking Locations screen, select a Depot and a Depot Par-
ent.

2. In the Edit Level/Depot area, enter the address information in the appropriate fields.

3. For further location details, enter the Latitude and Longitude for the depot. Use the
Validate Address button to populate values in the Latitude and Longitude fields.

4. Select the Location Type (Internal, Customer, Supplier).

Figure 7: Edit Level/Depot

5. If you select Customer or Supplier as the Location Type, enter the account inform-
ation in the Account field.

6. Assign locations for the depot (Receiving, Delivering, and/or Staging). See Figure
8 below.

Depot & Stocking Locations
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Depot & Stocking Locations

7. If the location has good stock, check the checkbox,Has Good Stock?

8. Click the icon to add additional locations; click the icon to delete locations. If
you delete a location, you will receive a warning message. Click OK to proceed with
the deletion.

Figure 8: Locations in Depot

9. Click the Validate Address button to verify the Depot address.

10. Click Quick Save to save the location.

11. You can click the Outbound Routing button to configure Outbound Routing or you
can click the Delivery Rules button to set up Delivery Rules for the selected Depot.

12. If you select to configure Outbound Routing and set up Delivery Rules at a later time,
click Save and Close to save the location and return to the ServiceMax Setup Home.
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ROUTES & STOPS

Overview
Use the Routes & Stops module to define your service delivery network. Routes & Stops
for returned products can be defined as inbound routes terminating in repair/disposition
centers. Similarly, you can setup Routes & Stops for outbound parts & repaired products
which are shipped to customers.

Access and Permissions

Actions User Permissions Needed

To view Routes & Stops: "Read" on ServiceMax Processes, ServiceMax Config Data and
Location.

To create or edit Routes &
Stops:

"Create" and "Update" on ServiceMax Processes and ServiceMax

Config Data.

"Read" on Location.

To delete Routes & Stops: "Delete" on ServiceMax Processes and ServiceMax Config Data.

Manage Routes & Stops Screen

To access the Routes & Stops Module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top-left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistic button.

3. Click the Routes & Stops button.

4. Click the Go button.
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The Manage Routes & Stops screen displays as shown in the figure below.

Figure 1: Routing Rules Screen

Manage Routes & Stops
In the Manage Routes & Stops screen you can:

Select an existing Route & Stop and edit it.

Select an existing Route & Stop and clone it.

Create a new Route & Stop.

Delete a Route & Stop.

Place rules in a specific order.

Return to ServiceMax Setup Home.

Creating a New Route & Stop

To create a new Route & Stop:

1. Click the New button in the Manage Routes & Stops screen (see Figure 1).

2. Select the Route Direction (Inbound,Outbound) in the Setup Routes & Stops
screen. (See Figure 2 below). Select Inbound if you are configuring an inbound route.
Select Outbound to configure an outbound route. For Inbound routes, you have the
option to select the additional objects (Case, Case Line).

Figure 2: Setup Routing Rules Screen

3. In the General Information area, enter a Route Name and a Description.

Routes & Stops
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Routes & Stops

4. Check the Active checkbox if you want activate the route.

Figure 3: General Information Area

5. Click the Quick Save button to save your information.

6. In the Route Stops area, select a depot from the Depot picklist (Figure 4).

Figure 4: Route Stops

7. Add another depot by clicking the icon. If you need to delete a depot, click the
icon.

8. Use the Expression Builder to indicate when this route should be considered. Enter the
Object, Field Name,Operator, and Value. (See Figure 5).

9. Use the and icons to add or delete expressions.

10. Use the Advanced Expression if necessary. For Inbound routing only, you can select
between the following objects (Account, Case, Case Line, and Product).
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Figure 5: Expression Builder

11. Click the Save and Close button to save and return to the Mange Routes & Stops
screen.

Editing a Route & Stop

To edit a Route & Stop:

1. Select a Route & Stop to edit by checking the Select checkbox for the selected rule.

2. Click the Edit button in the Manage Routes & Stops screen.

3. From the Setup Routing Rules screen, you can edit the General Information area,
Route Stops, and the Expression Builder.

4. Click the Save and Close button to save the rule and return to the Manage Routes &
Stops screen.

Cloning a Route & Stop
Cloning a Route & Stop creates a duplicate rule of the original.

To clone a Route & Stop:

1. Select a Route & Stop to clone by checking the checkbox for the appropriate rule.

2. Click the Clone button in the Manage Routes & Stops screen.

3. Update the General Information, Route Stops, and Expression Builder.

If you want to change the Rule Direction, you must create a new Route & Stop.

Deleting a Route & Stop

To delete a Route & Stop:

1. Check the Select checkbox for the appropriate rule.

2. Click the Delete button.

A warning dialog box displays asking the question, "Are you sure you want to delete
the selected rule(s)?"

Routes & Stops
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Routes & Stops

3. Click OK to delete the rule.

Changing the Rule Sequence
You can change the order of the rules. To dictate the sequence in which rules are pro-
cessed, click Rule Sequence. The first matching rule is considered for calculating the
route.

To change the order:

1. In the Mange Routes & Stops screen, click the Rule Sequence button.

2. In the Rules Sequence dialog box, click a rule to select it (Figure 6).

Figure 6: Rule Sequence Screen

3. Using the Up, Down, Top, Bottom arrows move the rule to the desired order.

4. Click the Save button to save the order.

5. Click the Cancel button to cancel the order.
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REPAIR SHIPMENT PREPARATION

Overview
Use this option to configure when Outbound routes must be calculated from work orders
and external (reverse) RMAs from suppliers. Use relevant attributes in work orders and
RMAs that indicate the repair cycle is complete and the product is ready to make its return
journey to the customer.

Access and Permissions

Actions User Permissions Needed

To view Repair Shipment Pre-
paration:

"Read" on ServiceMax Processes, ServiceMax Config
Data and Location.

To create or edit Repair Shipment
Preparation:

"Create" and "Update" on ServiceMax Processes and Ser-

viceMax Config Data

"Read" on Location.

To delete Repair Shipment Pre-
paration:

"Delete" on ServiceMax Processes and ServiceMax Con-
fig Data

Manage Repair Shipment Preparation Rules

To access the Repair Shipment Preparation module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Repair Shipment Preparation button.

4. Click the Go button.
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The Manage Repair Shipment Preparation Rules screen appears. See Figure 1.

Figure 1: Manage Repair Shipment Preparation Rules Screen

From the Manage Repair Shipment Preparation Rules screen you

can:

Create a new rule by clicking the New button.

View or edit a rule by clicking the View/Edit button.

Delete a rule by clicking the Delete button.

Return to ServiceMax Setup Home by clicking the Back to Setup Home button.

Creating a New Rule

To create a new rule:

1. Click the New button in the Manage Repair Shipment Preparation Rules screen.

2. In the Rule Information dialog box, enter the Depot name,Name of the rule, and the
Description. See Figure 2.

3. Check the Active checkbox to activate the rule.

4. Click the Save button to save the rule, or click the Cancel button to cancel the rule.

Figure 2: Rule Information Area

5. Use the Expression Builder to select criteria to indicate how Work Orders qualify for
Outbound Route calculation (Figure 3).

a. Select an existing criteria from the Use An Existing Criteria picklist, or
view/edit existing criteria from the View/Edit link.

Repair Shipment Preparation
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Repair Shipment Preparation

b. You can also create new criteria by clicking the Or Create New Criteria link.

Figure 3: Use Existing Criteria Expression Builder

6. Use the Expression Builder in Figure 4 to indicate how the supplier returns for Out-
bound Route Calculations.

a. Select the Object, Field,Operator, and Value from their respective picklists.

b. Use the Advanced Expression if necessary.

c. Use the and icons to add or delete expressions.

d. Click the Save button to save the rule.

Figure 4: Expression Builder-Outbound Route Calculation

Deleting a Rule

To delete a rule:

1. Check the checkbook for the appropriate rule.

2. Click the Delete button.

A warning dialog box displays asking the question, "Are you sure?"

3. Click OK to delete the rule.
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FORWARDING ENGINE

Overview
The Forwarding Engine automatically creates shipment orders to the next stop in the route
based on route cards. In this area, you can define which RMAs will be processed by the
engine. The configuration should be setup for each Depot exclusively, and you can also spe-
cify a schedule for the depot.

Access and Permissions

Actions User Permissions Needed

To view Forwarding Engine: "Read" on ServiceMax Processes and ServiceMax Config Data.

To create or edit Forwarding
Engine:

"Create" and "Update" on ServiceMax Processes and Ser-
viceMax Config Data.

To delete Forwarding Engine: "Delete" on ServiceMax Processes and ServiceMax Config
Data.

Forwarding Engine Screen

To access the Forwarding Engine module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Forwarding Engine button.

4. Click the Go button.

The Manage Auto Shipment Engines screen displays as shown in the figure below.
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Figure 1: Manage Auto Shipment Engines Screen

In the Manage Auto Shipment Engines screen you can:

Setup a new Auto Shipment Engine process.

Edit or clone an existing Auto Shipment Engine process.

Delete an existing Auto Shipment Engine process.

Return to the ServiceMax Setup Home Page.

Creating a New Forwarding Engine Process

To create a new Shipment Engine process:

1. Click the New button in the Manage Auto Shipment Engine screen.

2. In the Setup Forward Shipment Processes screen, select a Depot from the Depot pick-
list (see Figure 2).

3. In the Name field, enter the name of the forward shipment process.

4. In the Description field, enter a description.

5. Click Quick Save to save your General Info & Criteria and remain in the Setup Auto
Shipment Engine screen.

Figure 2: General Info & Criteria Area

6. Use the expression-builder to qualify RMAs and RMA lines for forward shipments.

a. For each picklist (Object, Field, and Operator) select the appropriate item for
your expression.

b. In the Value field, enter the value that represents the expression.

c. Use the and icons to add or delete expressions.

Forwarding Engine
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d. If necessary, use an advanced expression to qualify RMAs and RMA lines for for-
ward shipments.

Figure 3: Expression Builder- Forward Shipments

7. Select field maps to create shipment orders and lines from originating customer RMA
and lines by selecting items from two picklists: Field map to create forwarding
shipment from originating customer RMA and Field map to create for-
warding shipment lines from originating customer RMA lines (see Figure 4).

8. Click the Quick Save button to save your information and remain in the current
screen.

Figure 4: Select Field Maps to Create Shipment Orders area

9. Click the Schedule button located on the bottom right corner of the screen area, or
click the Schedule tab located at the top left corner of the screen.

10. In the Schedule tab, select the time you want the forward shipment engine to run
from the Run At picklist (see Figure 5).

Figure 5: Schedule tab (Select Days and Times)

11. Select the days you want the forward shipment engine to run using the and
arrows between the Available and Chosen areas by moving the appropriate day
from left to right.

12. Use the and icons to add or delete schedules.
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13. In the Specify recipients of notification and alerts area, enter an e-mail address
to notify recipients of successful notifications and an e-mail address to notify recip-
ients of error notifications (see Figure 6).

14. Click the Save and Closebutton to save your information and close the screen.

15. To return to the General Info & Criteria tab, click the General Info & Criteria button
located at the bottom left corner of the screen.

Figure 6: Specify recipients of notifications and alerts area

Editing a Forwarding Engine Process

To edit a shipment engine process:

1. In the Manage Auto Shipment Engines screen, select a process from the list of pro-
cess names (Figure 7).

Figure 7: Select a Shipment Engine Process

2. Click the Edit button.

3. Change the Depot, by choosing a new one in the Depot picklist (see Figure 2).

4. In the General Info & Criteria tab, update the Name and Description fields, if neces-
sary.

5. Use the expression-builder to update the RMAs and RMA lines for forward shipments
(see Figure 3).

a. For each picklist (Object, Field, and Operator) select the appropriate item for
your expression.

b. In the Value field, enter the value that represents the expression.

Forwarding Engine
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c. Use the and icons to add or delete expressions.

d. If necessary, use an advanced expression to qualify RMAs and RMA lines for for-
ward shipments.

6. Select field maps to create shipment orders and lines from originating customer RMA
and lines by selecting items from two picklists: Field map to create forwarding
shipment from originating customer RMA and Field map to create for-
warding shipment lines from originating customer RMA lines (see Figure 4).

7. Click the Quick Save button to save your information and remain in the current
screen.

8. Click the Schedule button located on the bottom right corner of the screen.

9. In the Schedule tab, select the time you want the forward shipment engine to run
from the Run At picklist (see Figure 5).

10. Select the days you want the forward shipment engine to run using the and
arrows between the Available and Chosen areas by moving the appropriate day
from left to right.

11. Use the and icons to add or delete schedules.

12. In the Specify recipients of notification and alerts area, enter an e-mail address
to notify recipients of successful notifications and an e-mail address to notify recip-
ients of error notifications (see Figure 6).

Cloning a Forwarding Engine Process

To clone a forwarding engine process:

1. In the Manage Auto Shipment Engines screen, select a process from the list of pro-
cess names (Figure 7).

2. Click the Clone button.

3. Enter a unique process name in the Name field of the General Info & Criteria tab.

4. Click the Quick Save button.
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Deleting a Forwarding Engine Process

To delete a forwarding engine process:

1. Check the checkbox for the appropriate rule.

2. Click the Delete button.

3. Click OK in the dialog box that asks the question, "Are you sure?"

Forwarding Engine
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PRODUCT SUBSTITUTION MATRIX

Overview
Use this option to setup one or more products as alternatives for a given product and
establish the order of preference. Substitutions defined here are used in the Fulfillment
Console to drive exchange product fulfillment.

Access and Permissions

Actions User Permissions Needed

To view Product Substitution Matrix: "Read" on Product and Product Replacement.

To create or edit Product Substitution
Matrix:

"Create" and "Update" on Product Replacement.
"Update" on Product.

To delete Product Substitution Matrix: "Delete" on Product Replacement."Update" on
Product.

Manage Product Replacements Screen

To access the Product Substitution Matrix module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Product Substitution Matrix button.

4. Click the Go button.

The Manage Product Substitutions screen displays as shown in the figure below.

Figure 1: Manage Product Replacements
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In the Manage Product Substitutions screen you can:

Look up and edit product substitutions.

Return to ServiceMax Setup Home.

Indicate the number of products to display on the Manage Product Substitutions
screen.

Substituting a Product

To substitute a product:

1. Enter the full or partial product name in the text box next to the Go button. Click Go
to view all the products.

2. Click the icon to edit the product (Figure 2).

Figure 2: Manage Product Substitutions Display Area

3. In the Define Replacements For Product area, enter a different product name or click
Go for a list of available products. See Figure 3.

Figure 3: Define Substitutions for Product Area

4. Check the appropriate checkbox for the product.

5. In the Available Product(s) area, click the arrow to move the selected product to the
Substitutions Product(s) area (Figure 4).

6. Continue to select products and use the and arrows to move products from
the Available Product(s) area to the Replacement Product(s) area using the applic-
able arrow keys.

Product Substitution Matrix
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Product Substitution Matrix

7. Use the and arrows to move products up and down in the Define Sub-
stitutions Product(s) area.

8. Click the Save button to save your product information.

Figure 4: Define Substitutions for Product Area
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RETURNS PROCESS

Overview
Use this option to configure returns process (RMA) for returns originating from customers.
A typical customer returns process involves performing entitlement checks & route cal-
culation. One or more RMAs will be created based on destination depots as a result of this
process.

Access and Permissions

Actions User Permissions Needed

To view Returns Process: "Read" on ServiceMax Processes, ServiceMax Config Data and SFM
Event.

To create or edit Returns
Process:

"Create" and "Update" on ServiceMax Processes, ServiceMax Con-
fig Data and SFM Event.

To delete Returns Pro-
cess:

"Delete" on ServiceMax Processes, ServiceMax Config Data and
SFM Event.

Standard and Custom Returns Process Screen

To access the Returns Process module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located in the top left of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Returns Process button.

4. Click the Go button.
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The Standard Returns Process and Custom Returns Process screens display as shown
in the figure below.

Figure 1: Standard/Custom Returns Process

Custom Returns Process
As shown in Figure 1 above, in the Custom Returns Process area, you can:

Create a new custom returns process.

Edit an existing custom returns process.

Clone a custom returns process.

Delete a custom returns process.

Creating a New Custom Returns Process

To create a new custom returns process:

1. In the Custom Returns Process area, click the New button.

The Setup Returns Process screen displays.

General Info Tab Screen

2. Click the General Info tab, enter a Process Name, Process ID, and a Descrip-
tion for your process.

Figure 2: General Info Tab- Returns Process

Returns Process
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Returns Process

3. Using the Expression Builder, indicate how the Case qualifies for the return process
(Figure 3). Select between the following two options in the Expression Builder area.

a. Select an existing criteria from the Use an existing criteria from the list pick-
list.

b. Or create new criteria by clicking the Or Create a new criteria link.

Figure 3: Expression Builder-Case

4. Using the Expression Builder, indicate how the Case Line records qualify for the return
process (Figure 4). Select between the following two options in the Expression Builder
area.

a. Select an existing criteria from the Use an existing criteria from the list pick-
list.

b. Or create a new criteria by clicking the Or Create a new criteria link.

Figure 4: Expression Builder - Case Line Records

Entitlement Tab Screen

5. Click either the Entitlement tab or the Entitlement button located at the bottom
right corner of the screen (Figure 5).

6. Check the Perform Entitlement checkbox.

Figure 5: Perform Entitlement Checkbox

7. Using the Expression Builder, indicate how the Case qualifies for entitlement check.

a. Select an existing criteria from the Use an existing criteria from the list pick-
list.
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b. Or create a new criteria by clicking the Or Create a new criteria link.

Figure 6: Expression Builder- Case

8. Using the Expression Builder, indicate how the CaseLine Records qualifies for enti-
tlement check.

a. Select an existing criteria from the Use an existing criteria from the list pick-
list.

b. Or create a new criteria by clicking the Or Create a new criteria link.

Figure 7: Expression Builder- Case Lines

9. In the Configure Custom Events area, enter the Namespace Prefix,Web service
class name, andMethod name in the appropriate text boxes (Figure 8).

Figure 8: Configure Custom Events

Routing Tab Screen

10. Click either the Routing tab or the Routing button located at the bottom right corner
of the screen.

11. The Perform Route Calculation checkbox is checked automatically.

12. In the Consider Location From picklist, select where the location will be considered
(Figure 9).

Figure 9: Route Calculations- Consider Location

Returns Process
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13. Using the Expression Builder, indicate how the Case qualifies for Route Calculation.

a. Select an existing criteria from the Use an existing criteria from the list pick-
list.

b. Or create a new criteria by clicking the Or Create a new criteria link.

Figure 10: Expression Builder Case- Route Calculation

14.  Using the Expression Builder, indicate how the Case Line Records qualify for Enti-
tlement Check.

a. Select an existing criteria from the Use an existing criteria from the list pick-
list.

b. Or create a new criteria by clicking the Or Create a new criteria link.

Figure 11: Expression Builder Case Line Records

15. In the Configure Custom Events area, enter the Namespace Prefix,Web service
class name,Method Name in the appropriate text boxes (Figure 12).

Figure 12: Configure Custom Events

RMA Creation Tab Screen

16. Click either the RMA Creation tab or the RMA Creation button located at the bot-
tom right corner of the screen.

17. In the Object Mapping to Create RMA(s) area, select a field-map in the appropriate
picklist to create an RMA from the Case.
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18. In the Object Mapping to Create RMA(s) area, select a field-map in the appropriate
picklist to create RMA Lines from Case Lines.

Figure 13: Object Mapping to Create RMA(s)

19. In the Configure Custom Events area, enter the Namespace Prefix,Web service
class name, andMethod name in the appropriate text boxes for Before RMA
Creation and After RMA Creation.

Figure 14: Configure Custom Events- RMA Creation

20. In the Other Details area, enter the VisualForce page name to use for printing
RMAs in the appropriate text box (Figure 15).

Source Updates Tab Screen

21. Click the Source Updates tab or the Source Updates button located on the bottom
right corner of the screen.

Figure 15: Other Details

22. Configure automatic field updates to the Case after the route calculation is performed.

a. Select the field from the Field picklist.

b. The default for the Operator is Set.

c. Enter the Value.

d. Indicate when the update will occur in theWhen picklist.

Returns Process
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e. Click the and buttons to add or delete.

Figure 16: Configure Automatic Field Updates to Case

23. Configure automatic field updates to the Case Lines after the route calculation is per-
formed.

a. Select the field from the Field picklist.

b. The default for the Operator is Set.

c. Enter the Value.

d. Indicate when the update will occur in theWhen picklist.

23. Click the Quick Save button to save your information and remain in the Setup Return
Process screen or click the Save and Close button to save your information and
close the screen.

24. To return to the previous screen, click the RMA Creation button located on the bot-
tom left corner of the screen.

Figure 17: Configure Automatic Field Updates to Case Lines

Editing a Custom Returns Process
The steps for editing a Custom Returns Process are very similar to creating a new Custom
Return Process. For more information and detailed screen shots for each step, see Creat-
ing a New Custom Returns Process.

To edit a Custom Returns Process:

1. Select a custom return process from the Process ID picklist by checking the Select
checkbox for the appropriate process name.

2. In the Custom Returns Process area, click the Edit button.
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The Setup Returns Process screen displays.

General Info Tab Screen

3. Click the General Info tab, and update the Process Name, Process ID, and
Description, if necessary.

4. In the Expression Builder, update how the Case qualifies for the return process, either
by choosing criteria from the picklist or creating new criteria (Figure 3).

5. In the next Expression Builder, indicate how the Case Line records qualify for the
return process (Figure 4). Select criteria from the picklist or create new criteria.

Entitlement Tab Screen

6. Click either the Entitlement tab or the Entitlement button located at the bottom
right corner of the screen (Figure 5).

7. Check the Perform Entitlement checkbox.

8. In the Expression Builder, indicate how the Case qualifies for entitlement check by
choosing an existing criteria from the Use an existing criteria from the list pick-
list, or creating a new criteria by clicking the Or Create a new criteria link.

9. In the Expression Builder, indicate how the Case Line Records qualify for entitlement
check by choosing an existing criteria from the Use an existing criteria from the
list picklist, or creating a new criteria by clicking the Or Create a new criteria link.

10. In the Configure Custom Events area, enter the Namespace Prefix,Web service
class name, andMethod name (Figure 8).

Routing Tab Screen

11. Click either the Routing tab or the Routing button located at the bottom right corner
of the screen.

12. The Perform Route Calculation checkbox is checked automatically.

13. In the Consider Location From picklist, select where the location will be considered
(Figure 9).

14. In the Expression Builder, indicate how the Case qualifies for Route Calculation, by
choosing an existing criteria from the Use an existing criteria from the list pick-
list, or creating a new criteria by clicking the Or Create a new criteria link.

Returns Process
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15. Using the Expression Builder, indicate how the Case Line Records qualify for Route Cal-
culation by choosing an existing criteria from the Use an existing criteria from the
list picklist, or creating a new criteria by clicking the Or Create a new criteria link.

16. In the Configure Custom Events area, enter the Namespace prefix,Web service
class name, andMethod Name in the appropriate text boxes (Figure 12).

RMA Creation Tab Screen

17. Click either the RMA Creation tab or the RMA Creation button located at the bot-
tom right corner of the screen.

18. In the Object Mapping to Create RMA(s) area, select a field-map in the appropriate
picklist to create an RMA from the Case.

19. In the Object Mapping to Create RMA(s) area, select a field-map in the appropriate
picklist to create RMA Lines from Case Lines.

20. In the Configure Custom Events area, enter the Namespace Prefix,Web service
class name, and the Method name in the appropriate text boxes for Before RMA
Creation and After RMA Creation.

21. In the Other Details area, enter the VisualForce page name to use for printing
RMAs in the appropriate text box (Figure 15).

Source Updates Tab Screen

22. Click the Source Updates tab or the Source Updates button located on the bottom
right corner of the screen.

23. Configure automatic field updates to the Case after the route calculation is performed.

a. Select the field from the Field picklist.

b. The default for the Operator is Set.

c. Enter the Value.

d. Indicate when the update will occur in theWhen picklist.

e. Click the and buttons to add or delete.

24. Configure automatic field updates to the Case Lines after the route calculation is per-
formed.

a. Select the field from the Field picklist.
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b. The default for the Operator is Set.

c. Enter the Value.

d. Indicate when the update will occur in theWhen picklist.

25. Click the Quick Save button to save your information and remain in the Setup Return
Process screen. Click the Save and Close button to save your information and close
the screen.

26. To return to the previous screen, click the RMA Creation button located on the bot-
tom left corner of the screen

Cloning a Returns Process

To clone a Return Process:

1. Select a custom return process from the Process ID list by checking the Select
checkbox for the appropriate process name.

2. In the Custom Returns Process area, click the Edit button.

The Setup Returns Process screen displays.

3. Click the General Info tab, and enter a unique Process Name and Process ID.

 You must enter a unique Process Name and Process ID to clone a return process.

4. Update other sections in Returns Process as appropriate: Qualification for Pick and
Move, Updates and Pick and Move, Qualification for Pack and Ship, Updates on Pack
and Ship, Custom Events and Links, and RMA Rules.

Note: For detailed, step-by-step instructions for the above mentioned
sections, see Creating a New Custom Returns Process or Editing a
Custom Returns Process.

5. Click the Save button to save the process and remain in the Setup Return Process
screen. Click the Save and Close button to save the process and return to the Stand-
ard Process and Custom Returns Process screen.

Returns Process
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Deleting a Returns Process

To delete a Returns Process:

1. Check the Select checkbox for the appropriate rule.

2. Click the Delete button.

A warning dialog box displays asking the question, "Are you sure you want to delete
the selected process(es)?"

3. Click OK to delete the rule.
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RECEIVING PROCESS

Overview
The Receiving Process module enables you to define how various depots (hubs, ware-
houses or repair centers) process their inbound products, and subsequently store/deliver
them to their internal locations.

There are two types of Receiving Processes—Standard and Custom.

Access and Permissions

Actions User Permissions Needed

To view Receiving Pro-
cess:

"Read" on ServiceMax Processes, ServiceMax Config Data and
SFM Event.

To create or edit Receiv-
ing Process:

"Create" and "Update" on ServiceMax Processes, ServiceMax Con-
fig Data and SFM Event.

To delete Receiving Pro-
cess:

"Delete" on ServiceMax Processes, ServiceMax Config Data and
SFM Event.

Standard and Custom Receiving Processes Screen

To access the Receiving Process module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Receiving Process button.

4. Click the Go button.
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The Standard Receiving Processes and Custom Receiving Processes areas display as
shown in the figure below.

Figure 1: Standard and Custom Receiving Processes

Standard Receiving Processes
As shown in Figure 1, in the Standard Receiving Processes area, you can:

View a standard receiving process.

Clone a standard receiving process.

Return to ServiceMax Setup Home.

Custom Receiving Processes
As shown in Figure 1, in the Custom Receiving Processes area, you can:

Create a new custom receiving process.

Edit an existing custom receiving process.

Clone a custom receiving process.

Delete a custom receiving process.

Creating a New Custom Receiving Process

To create a new custom receiving process:

1. Select a custom receiving process by checking the Select checkbox for the appro-
priate process name.

2. Click the Edit button.

The Setup Receiving Process screen displays.

Receiving Process
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3. Click the General Info tab, enter a Process Name, Process ID, and a Description
for your process (Figure 2).

Figure 2: General Info Tab

4. In the Receiving Console Configuration area, select up to 3 fields to display in the RMA
using the corresponding picklists (Figure 3).

5. In the Receiving Console Configuration area, select up to 2 fields to display in the RMA
Line using the corresponding picklists (Figure 3).

Figure 3: Receiving Console Configuration

6. Click either the Receipt Qualification tab or the Receipt Qualification button loc-
ated at the bottom right corner of the screen.

Receipt Qualification

7. Using the expression builder below, indicate how the RMA record qualifies for the
receiving process (Figure 4). Select an existing criteria from the Use an existing cri-
teria from the list picklist, or you can create a new criteria by clicking the Create
New link.

Figure 4: Expression Builder- RMA Record
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8. Using the expression builder below, indicate how the RMA line records qualify for the
receiving process (Figure 5). Select an existing criteria from the Use an existing cri-
teria from the list picklist, or you can create a new criteria by clicking the Create
New link.

Figure 5: Expression Builder - Line Records

9. In the Reconciliation Rules area, select action items in the respective picklists.

Figure 6: Reconciliation Rules

10. In the Installed Product And Entitlement area, complete the following (Figure 7):

a. If applicable, check the Resolve Unexpected Serial Number To Installed
Product checkbox.

b. Complete the text boxes for the Optional Custom Web Service to Resolve
Installed Product.

c. If applicable, check the Perform Entitlement Check For Resolved Serial
Numbers checkbox.

Figure 7: Installed Product and Entitlement

11. Click either the Updates on Receipt tab or the Updates on Receipt button located
at the bottom right corner of the screen.

Updates on Receipt

12. Select items from the Field Names,Operator, and Value picklists to configure the
automatic field updates to the RMA record when the lines are received. Add or delete

Receiving Process
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lines using the and/or buttons.

Figure 8: Configure the Automatic Field Updates (RMA Records)

13. Select items from the Field Names,Operator, and Value picklists to configure the
automatic field updates to the RMA lines when the line item is received. Add or delete

lines using the and/or buttons.

Figure 9: Configure the Automatic Field Updates (RMA Lines)

14. Click either the Events and Links tab or the Events and Links button located at
the bottom right corner of the screen.

Events and Links

15. In the Configure Custom Events area, complete the Namespace prefix andWeb
service class name text boxes for After Receipt, After Delivery, and After Clos-
ure.

Figure 10: Configure Custom Events

16. Click either the Delivery Qualification tab or the Delivery Qualification button loc-
ated at the bottom right corner of the screen.

Delivery Qualification

17. Use the expression builder in Figure 11 to indicate how the RMA qualifies for Delivery.
Select an existing criteria from the Use an existing criteria from the list picklist,
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or you can create a new criteria by clicking the Create New link.

Figure 11: Expression Builder: Qualifying RMA for Delivery

18. Use the expression builder in Figure 12 to indicate how RMA lines qualify for Delivery.
Select an existing criteria from the Use an existing criteria from the list picklist,
or you can create a new criteria by clicking the Create New link.

Figure 12: Expression Builder: Qualifying RMA lines quality for Delivery

19. Click either the Updates after delivery tab or the Updates after delivery button
located at the bottom right corner of the screen.

Updates After Delivery

20. Configure the automatic field updates (Field Name,Operator, Value) to the RMA

record when all the lines are delivered (Figure 13). Add or delete lines using the

and/or buttons.

Figure 13: Configure Automatic Field Updates (All the Lines are Delivered)

21. Configure the automatic field updates (Field Name,Operator, Value) to the RMA

lines when the line item is delivered (Figure 14). Add or delete lines using the

and/or buttons.

Figure 14: Configure Automatic Field Updates (Line Item is Delivered)

22. Click either the Config Work Order tab or the Config Work Order button located at
the bottom right corner of the screen.

Receiving Process
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Config Work Order

23. In the Config Work Order Generation Rules area, select a criteria when a work order is
created (Figure 15).

Figure 15: Configure Work Order Generation Rules

24. Click Quick Save to save the custom receiving process and remain on the page, or
click Save and Close to save the process and close the Custom Receiving Process
screen.

Editing a Custom Receiving Process
The steps for editing a Custom Receiving Process are similar to creating a New Custom
Receiving Process.

You can move through the tabs or buttons (General Info, Receipt Qualification,
Updates on Receipt, Events and Links, Delivery Qualification, Updates after
Delivery, and Config Work Order) in any order.

The steps for the Receiving Process are described in a linear fashion in this section, but
you can update these sections in any order.

To create edit a custom receiving process:

1. In the Custom Receiving Processes area, click the New button.

The Setup Receiving Process screen displays.

2. Click the General Info tab, enter a Process Name, Process ID, and a Descrip-
tion for your process.

3. In the Receiving Console Configuration area, select up to 3 fields to display in the RMA
using the three corresponding picklists (Figure 16).

Editing a Custom Receiving Process 1059



4. In the Receiving Console Configuration area, select up to 2 fields to display in the RMA
Line using the two corresponding picklists (Figure 16).

Figure 16: Receiving Console Configuration

5. Click either the Receipt Qualification tab or the Receipt Qualification button loc-
ated at the bottom right corner of the screen.

Receipt Qualification

6. Using the expression builder, indicate how the RMA record qualifies for the receiving
process (Figure 4). Select an existing criteria from the Use an existing criteria
from the list picklist, or you can create a new criteria by clicking the Create New
link.

7. Using the expression builder below, indicate how the RMA line records qualify for the
receiving process (Figure 5). Select an existing criteria from the Use an existing cri-
teria from the list picklist, or you can create a new criteria by clicking the Create
New link.

8. In the Reconciliation Rules area, select action items in the respective picklists.

Figure 17: Reconciliation Rules

9. In the Installed Product And Entitlement area, complete the following (Figure 18):

a. If applicable, check the Resolve Unexpected Serial Number To Installed
Product checkbox.

Receiving Process
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b. Complete the text boxes for the Optional Custom Web Service to Resolve
Installed Product.

c. If applicable, check the Perform Entitlement Check For Resolved Serial
Numbers checkbox.

Figure 18: Installed Product and Entitlement

10. Click either the Updates on Receipt tab or the Updates on Receipt button located
at the bottom right corner of the screen.

Updates on Receipt

11. Select items from the Field Names,Operator, and Value picklists to configure the
automatic field updates to the RMA record when the lines are received. Add or delete

lines using the and/or buttons.

Figure 19: Configure the Automatic Field Updates (RMA Records)

12. Select items from the Field Names,Operator, and Value picklists to configure the
automatic field updates to the RMA lines when the line item is received. Add or delete

lines using the and/or buttons.

Figure 20: Configure the Automatic Field Updates (RMA Lines)

13. Click either the Events and Links tab or the Events and Links button located at
the bottom right corner of the screen.

Events and Links

14. In the Configure Custom Events area, complete the Namespace prefix andWeb
service class name text boxes for the After Receipt, After Delivery, and After
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Closure.

Figure 21: Configure Custom Events

15. Click either the Delivery Qualification tab or the Delivery Qualification button loc-
ated at the bottom right corner of the screen.

Delivery Qualification

16. Use the expression builder in Figure 21 to indicate how the RMA qualifies for Delivery.
Select an existing criteria from the Use an existing criteria from the list picklist,
or you can create a new criteria by clicking the Create New link.

Figure 22: Expression Builder: Qualifying RMA for Delivery

17. Use the expression builder in Figure 22 to indicate how RMA lines qualify for Delivery.
Select an existing criteria from the Use an existing criteria from the list picklist,
or you can create a new criteria by clicking the Create New link.

Figure 23: Expression Builder: Qualifying RMA lines quality for Delivery

18. Click either the Updates after delivery tab or the Updates after delivery button
located at the bottom right corner of the screen.

Updates After Delivery

19. Configure the automatic field updates (Field Name,Operator, Value) to the RMA

record when all the lines are delivered (Figure 23). Add or delete lines using the

Receiving Process
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Receiving Process

and/or buttons.

Figure 24: Configure Automatic Field Updates (All the Lines are Delivered)

20. Configure the automatic field updates (Field Name,Operator, Value) to the RMA

lines when the line item is delivered (Figure 24). Add or delete lines using the

and/or buttons.

Figure 25: Configure Automatic Field Updates (Line Item is Delivered)

21. Click either the Config Work Order tab or the Config Work Order button located at
the bottom right corner of the screen.

Config Work Order

22. In the Config Work Order Generation Rules area, select a criteria when a work order is
created.

23. Click Quick Save to save the custom receiving process and remain on the page, or
click Save and Close to save the process and close the Custom Receiving Process
screen.

Cloning a Custom Receiving Process

To clone a Custom Receiving Process:

1. Select a Custom Receiving Process from the Process list by checking the Select
checkbox for the appropriate process name.

2. In the Custom Receiving Processes area, click the Clone button.

The Setup Receiving Process screen displays.

3. Click the General Info tab, and enter a unique Process Name and Process ID. You
must enter a unique Process Name and Process ID to clone a return process.
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4. Update other sections in the Receiving Process screen as appropriate: Receipt Qual-
ification, Updates on Receipt, Events and Links, Delivery Qualification,
Updates after Delivery, and Config Work Order.

Note: For detailed, step-by-step instructions for the above mentioned
sections, see Creating a New Custom Receiving Processand Editing
a Custom Receiving Process.

5. Click the Save button to save the process and remain in the Setup Return Process
screen. Click the Save and Close button to save the process and return to the Stand-
ard Process and Custom Return Process screen.

Deleting a Custom Receiving Process

To delete a Custom Receiving Process:

1. Check the Select checkbox for the appropriate rule.

2. Click the Delete button.

A warning dialog box displays asking the question, "Are you sure?".

3. Click OK to delete the rule.

Receiving Process
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DELIVERY RULES

Overview
Use this option to configure how received products are delivered (distributed) within a
depot. The rules should be set up for each depot, and are driven by a combination of
account and product attributes.

Access and Permissions

Actions User Permissions Needed

To view Delivery Rules: "Read" on ServiceMax Processes, ServiceMax Config Data and
Location.

To create or edit Delivery
Rules:

"Create" and "Update" on ServiceMax Processes and ServiceMax

Config Data

"Read" on Location.

To delete Delivery Rules: "Delete" on ServiceMax Processes and ServiceMax Config Data.

Setup Delivery Rules Screen

To access the Delivery Rules module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Delivery Rules button.

4. Click the Go button.
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The Setup Delivery Rules screen displays as shown in the figure below.

Figure 1: Setup Delivery Rules

In the Setup Delivery Rules screen:

Create a new rule.

View or edit a rule.

Delete a rule.

Return to ServiceMax Setup Home.

Creating a New Delivery Rule

To create a new rule:

1. Click the New button in the Setup Delivery Rules screen (Figure 1).

2. In the Select Depot picklist, select a Depot (Figure 2).

Figure 2: Select Depot Area

3. In the Rule Name field, enter the Delivery Rule name (Figure 3).

Figure 3: Setting Up Rule Information

Delivery Rules
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Delivery Rules

4. Select the Delivery Type (Manual or Automatic).

5. From the Default Delivery Location picklist, select a delivery location.

6. In the Delivery Rules Details area, click the New button to add a line (Figure 4).

Figure 4: Delivery Rule Details

7. In the Selected Delivery Rule Line's Criteria area, enter a Rule Line Name.

8. In the Rule Criteria area, select an object from the Object Name picklist.

9. Select a field name from the Field Name picklist.

10. Select an operator from the Operator picklist.

11. Enter a value in the Value field.

12. If necessary, enter an expression in the Advanced Expression text box.

13. Select a delivery location from the Deliver To (Location) picklist.

14. Use the and buttons to add or delete rule lines.

15. Click the Save button.

Figure 5: Selected Delivery Rule Line's Criteria

Viewing/Editing a Delivery Rule

To view or edit a Delivery Rule:

1. Check the Select checkbox of the Depot you would like to view or edit (Figure 1).

2. Click the View/Edit button in the Setup Delivery Rules screen (Figure 2).

3. In the Select Depot picklist, select a Depot (Figure 2).
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4. Update the Delivery Type (Manual or Automatic). See Figure 5.

5. Update the delivery location from the Default Delivery Location picklist.

6. In the Delivery Rule Details area, check the Select checkbox.

Figure 6: Delivery Rule Details

7. Click the Edit button to edit items in the rule line (ObjectName, Field Name,Oper-
ator, Value, Advanced Expression, and Delivery To Location). See Figure 6.

8. Use the and button to add or delete rule lines.

9. Click the Save button.

Deleting a Delivery Rule

To delete a Delivery Rule:

1. Check the Select checkbook for the appropriate rule.

2. Click the Delete button.

3. Click OK in the Warning dialog box to delete the rule.

Delivery Rules
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SHIPPING PROCESS

Overview
Use this option to define how various depots (hubs, warehouses or repair centers) would
process outbound products from picking to shipping.

Access and Permissions

Actions User Permissions Needed

To view Shipping Pro-
cess:

"Read" on ServiceMax Processes, ServiceMax Config Data and
SFM Event.

To create or edit Shipping
Process:

"Create" and "Update" on ServiceMax Processes, ServiceMax Con-
fig Data and SFM Event.

To delete Shipping Pro-
cess:

"Delete" on ServiceMax Processes, ServiceMax Config Data and
SFM Event.

Standard and Custom Shipping Processes Screen

To access the Shipping Process module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Shipping Process button.

4. Click the Go button.
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The Standard Shipping Processes and Custom Shipping Processes screens display as
shown in the figure below.

Figure 1: Standard and Custom Shipping Processes

Standard Shipping Processes
As shown in Figure 1, in the Standard Shipping Processes area, you can:

View a standard shipping process.

Clone a standard shipping process.

Return to ServiceMax Setup Home.

Custom Shipping Processes
As shown in Figure 1, in the Custom Shipping Processes area, you can:

Create a new custom shipping process.

Edit an existing custom shipping process.

Clone a custom shipping process.

Delete a custom shipping process.

Creating a New Custom Shipping Process

To create a new custom shipping process:

1. In the Custom Receiving Processes area, click the New button.

The Setup Shipping Process screen displays.

Shipping Process
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Shipping Process

General Info Screen

2. Click the General Info tab, enter a Process Name, Process ID, and a Description
for your process.

Figure 2: General Info Tab-Shipping Process

3. In the Shipment Console Configuration area, select up to 3 fields to display in the Ship-
ment Order using the three picklists (Figure 3).

4. In the Shipment Console Configuration area, select up to 2 fields to display in the Ship-
ment Line using the two picklists (Figure 3).

Figure 3: Shipment Console Configuration

Qualification for Pick and Move Screen

5. Click either the Qualification for Pick and Move tab or the Qualification for Pick
and Move button located at the bottom right corner of the screen.

6. Using the Expression Builder below, indicate how the Shipment Order qualifies to
enter the Pick and Move step. Select between the following two options.

a. Select existing criteria from the Use and existing criteria from the list pick-
list.

b. Or you can create a new criteria by clicking the Or Create new criteria link.
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Figure 4: Expression Builder for Shipment Order

7. Using the Expression Builder below, indicate how the Shipment Line records qualify to
enter Pick and Move. Select between the following two options.

a. Select existing criteria from the Use and existing criteria from the list pick-
list.

b. Or you can create a new criteria by clicking the Or Create new criteria link.

Figure 5: Expression Builder for Shipment Lines

Updates on Pick and Move Screen

8. Click either the Updates on Pick and Move tab or the Updates on Pick and Move
button located at the bottom right corner of the screen.

9. Configure the field updates for the Shipment Record. Select items from the picklists
(Field,Operator, Value).

10. Add or delete lines using the and buttons.

Figure 6: Configure Automatic Field Updates for Shipment Records

11. Configure the field updates for the Shipment Line Record. Select items from the pick-
lists (Field,Operator, Value).

12. Add or delete lines using the and/or buttons.

Figure 7: Configure Automatic Field Updates for Shipment Line Records

Shipping Process
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Shipping Process

Qualification for Pack and Ship Screen

13. Click either the Qualification for Pack and Ship tab or the Qualification for Pack
and Ship button located at the bottom right corner of the screen.

14.  Using the Expression Builder, select the Shipment Order qualifiers for the Pack and
Ship step.

a. Select existing criteria from the Use and existing criteria from the list pick-
list.

b. Or you can create a new criteria by clicking the Or Create new criteria link.

Figure 8: Expression Builder -Pack and Ship for Shipment Order

15. Using the Expression Builder, select the Shipment Line Records qualifiers for the Pack
and Ship step.

a. Select existing criteria from the Use and existing criteria from the list pick-
list.

b. Or you can create a new criteria by clicking the Or Create new criteria link.

Figure 9: Expression Builder- Pack and Ship for Shipment Line Records
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Updates on Pack and Ship Screen

16. Click either the Updates for Pack and Ship tab or the Updates for Pack and Ship
button located at the bottom right corner of the screen.

17. Configure the field updates for the Shipment Record when all lines have been shipped.
Select items from the picklists (Field,Operator, Value).

18. Add or delete lines using the and/or buttons.

Figure 10: Configure Field Updates- Shipment Record (Shipped Lines)

19. Configure the field updates for the Shipment Line Record when line has been shipped.
Select items from the picklists (Field,Operator, Value).

20. Add or delete lines using the and/or buttons.

Figure 11: Configure Field Updates- Shipment Line Record (Shipped Lines)

Custom Events and Links Screen

21. Click either the Custom Events and Links tab or the Custom Events and Links button
located at the bottom right corner of the screen.

22. In the Custom Events on Shipment area, enter the Namespace Prefix,Web Ser-
vice Class Name, andMethod Name for the following: After Pick and Move,
After Shipment, and After Closure.

Figure 12: Custom Events on Shipment Screen

Shipping Process
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Shipping Process

RMA Rules Screen

23. Click either the RMA Rules tab or the RMA Rules button located at the bottom right
corner of the screen.

24. Create the internal RMA rules when shipping to internal locations.

a. To create an internal RMA for a ship confirmation, check the appropriate checkbox.

b. Select an item from the Use this field-map to create RMA picklist.

c. Select an item from the Use this field-map to create RMA Lines picklist.

Figure 13: Rules to create internal RMAs (shipping to internal locations)

25. Create the external (reverse) RMA rules when shipping to supplier locations.

a. To create a supplier RMA for a ship confirmation, select the appropriate check box.

b. Select an item from the Use this field-map to create RMA picklist.

c. Select an item from the Use this field-map to create RMA Lines picklist.

Figure 14: Rules to Create External (Reverse) RMAs (shipping to supplier locations)

Editing a Custom Shipping Process
The steps for editing a Custom Shipping Process are similar to creating a new Custom Ship-
ping Process. For more information and detailed screen shots for each step, see Creating
a New Custom Shipping Process.
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Move through the tabs or buttons (General Info,Qualification for Pick and Move,
Updates on Pick and Move,Qualification Pack and Ship, Updates on Pack and
Ship, Custom Events and Links, and RMA Rules) in any order. The steps for the Ship-
ping Process are described in a linear fashion in this section, but you can update these sec-
tions in any order.

To edit a Custom Shipping Process:

1. Select a Custom Shipping Process from the Process list by checking the Select
check box for the appropriate process name.

2. In the Custom Shipping Processes area, click the Edit button.

The Setup Shipping Process screen appears.

General Info Screen

3. Click the General Info tab, and update the Process Name, Process ID, and
Description if necessary.

4. In the Expression Builder, update how the Case qualifies for the return process, either
by selecting criteria from the picklists or by creating new criteria (Figure 15).

Figure 15: Shipment Console Configuration

Qualification for Pick and Move Screen

5. Click either the Qualification for Pick and Move tab or the Qualification for Pick
and Move button located at the bottom right corner of the screen.

6. Using the Expression Builder below, update how the Shipment Order qualifies to enter
the Pick and Move by updating existing criteria, or creating new criteria.

7. Using the Expression Builder below, update how the Shipment Line records qualify to
enter Pick and Move by updating existing criteria, or creating new criteria.

Shipping Process
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Shipping Process

Updates on Pick and Move Screen

8. Click either the Updates on Pick and Move tab or the Updates on Pick and Move
button located at the bottom right corner of the screen.

9. Configure the field updates for the Shipment Record. Select items from the picklists
(Field,Operator, Value).

10. Add or delete lines using the and buttons.

Figure 16: Configure Automatic Field Updates for Shipment Records

11. Configure the field updates for the Shipment Line Record. Select items from the pick-
lists (Field,Operator, Value).

12. Add or delete lines using the and/or buttons.

Figure 17: Configure Automatic Field Updates for Shipment Line Records

Qualification for Pack and Ship Screen

13. Click either the Qualification for Pack and Ship tab or the Qualification for Pack
and Ship button located at the bottom right corner of the screen.

14. Using the Expression Builder, update the Shipment Order qualifiers for the Pack and
Ship step by selecting existing criteria, or create new criteria.

Figure 18: Expression Builder- Pack and Ship for Shipment Order

15. Using the Expression Builder, update the Shipment Line Records qualifiers for the
Pack and Ship step by selecting existing criteria, or create new criteria.
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Figure 19: Expression Builder- Pack and Ship for Shipment Line Records

Updates on Pack and Ship Screen

16. Click either the Updates for Pack and Ship tab or the Updates for Pack and Ship
button located at the bottom right corner of the screen.

17. Configure the field updates for the Shipment Record when all lines have been shipped.
Update items from the picklists (Field,Operator, Value).

18. Add or delete lines using the and/or buttons.

Figure 20: Configure Field Updates- Shipment Record (Shipped Lines)

19. Configure the field updates for the Shipment Line Record when line has been shipped.
Update items from the picklists (Field,Operator, Value).

20. Add or delete lines using the and/or buttons.

Figure 21: Configure Field Updates- Shipment Line Record (Shipped Lines)

Custom Events and Links Screen

21. Click either the Custom Events and Links tab or the Custom Events and Links
button located at the bottom right corner of the screen.

22. In the Custom Events on Shipment area, update the Namespace Prefix,Web Ser-
vice Class Name, andMethod Name for the following: After Pick and Move,

Shipping Process

1078 Editing a Custom Shipping Process



Shipping Process

After Shipment, and After Closure.

Figure 22: Custom Events on Shipment Screen

RMA Rules Screen

23. Click either the RMA Rules tab or the RMA Rules button located at the bottom right
corner of the screen.

24. If necessary, update the internal RMA rules when shipping to internal locations.

a. Check the Internal RMA on Ship Confirm checkbox.

b. Update the Use this field-map to create RMA picklist.

c. Update the Use this field-map to create RMA Lines picklist.

Figure 23: Rules to create internal RMAs (shipping to internal locations)

25. Update the external (reverse) RMA rules when shipping to supplier locations.

a. Check the Create Supplier RMA on Ship Confirm checkbox.

b. Update the Use this field-map to create RMA picklist.

c. Update the Use this field-map to create RMA Lines picklist.
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Figure 24: Rules to Create External (Reverse) RMAs (shipping to supplier locations)

Cloning a Custom Shipping Process

To clone a Custom Shipping Process:

1. Select a Custom Shipping Process from the Process list by checking the Select
checkbox for the appropriate process name.

2. In the Custom Shipping Processes area, click the Clone button.

The Setup Shipping Process screen displays.

3. Click the General Info tab, and enter a unique Process Name and Process ID. You
must enter a unique Process Name and Process ID to clone a return process.

4. Update other sections in Shipping Process as appropriate: Qualification for Pick
and Move, Updates and Pick and Move,Qualification for Pack and Ship,
Updates on Pack and Ship, Custom Events and Links, RMA Rules.

Note: For detailed, step-by-step instructions for the above mentioned
sections, see Creating a New Custom Shipping Process and Editing
a Custom Shipping Process.

5. Click the Save button to save the process and remain in the Setup Return Process
screen. Click the Save and Close button to save the process and return to the Stand-
ard Process and Custom Return Process screen.

Deleting a Custom Shipping Process

To delete a Custom Shipping Process:

1. Check the Select checkbox for the appropriate rule.

2. Click the Delete button.

A warning dialog box displays asking the question, "Are you sure?".

3. Click OK to delete the rule.

Shipping Process
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SOURCING RULES

Overview
Use this option to define the sourcing and allocation rules for various types of fulfillment
orders (repair or sales orders). Fulfillment processes can be then placed on applicable Ser-
vice Flow wizards.

Access and Permissions

Actions User Permissions Needed

To view Sourcing Rules: "Read" on ServiceMax Processes, ServiceMax Config Data and
Location.

To create or edit Sourcing
Rules:

"Create" and "Update" on ServiceMax Processes and ServiceMax
Config Data
"Read" on Location.

To delete Sourcing Rules: "Delete" on ServiceMax Processes and ServiceMax Config Data.

To access the Sourcing Rules module:

1. From the Home tab, click ServiceMax Setup located under the ServiceMax Admin-
istration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Reverse Logistics button.

3. Click the Sourcing Rules button.

4. Click the Go button.

The Sourcing Rules screen displays as shown in the figure below.

Figure 1: Sourcing Rules Screen
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In the Sourcing Rules screen you can:

Create a new Rule.

Edit an existing Rule.

Clone a Rule.

Delete a Rule.

Return to ServiceMax Setup Home.

Creating a Sourcing Rule

To create a new Sourcing Rule:

1. Click the New button in the Sourcing Rules screen (Figure 1).

2. In the General Info area, enter the Process Name, Process ID, and Description in
the appropriate text boxes (Figure 2).

Figure 2: Setup Fulfillment Process

3. In the Fulfillment Console Configuration area, select up to 3 fields to display in the
header record using the corresponding picklists (Figure 3).

4. In the Fulfillment Console Configuration area, select up to 2 product fields to display
for each line using the corresponding picklists (Figure 3).

Figure 3: Fulfillment Console Configuration Area

Sourcing Rules
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Sourcing Rules

5. Click the Criteria & Mapping tab at the top of the screen, or click the Criteria &
Mapping button located on the right bottom corner of the screen to access the
expression builder.

6. Use the Expression Builder to specify how header records and line records qualify to
complete the fulfillment. See Figure 4.

a. In the expression builder area for header records, select an existing criteria from
the Use Existing Criteria picklist, or you can create a new criteria by clicking the
Create New link.

b. In the expression builder area for line records, select an existing criteria from the
Use Existing Criteria picklist, or you can create a new criteria by clicking the
Create New link.

Figure 4: Expression Builder: Header and Line Records Area

7. Select field maps to create shipment orders and lines from originating customer order
and lines. Update the two picklists: Field map used to create shipment order
from originating customer order and Field map used to create shipment
order lines from originating customer order lines (Figure 5).

Figure 5: Configure Mapping to Create Fulfillment Order

8. Click the Sourcing Rules tab at the top of the screen or click the Sourcing Rules
button located on the right bottom corner of the screen to access the Sourcing Rules
area.
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9. Click the New button to create a new rule (Figure 6).

Figure 6: Sourcing Rules Tab

10. In the Sourcing Rule area, enter the rule name in the Rule Name text box (Figure 7).

Figure 7: Sourcing Rule Area

11. In the Criteria to identify fulfillment path area, select an existing criteria from the Use
Existing Criteria picklist, and click the View/Edit link. Click the Create New to
create a new criteria. See Figure 8.

Figure 8: Criteria to Identify Fulfillment Path Area

12. In the Sourcing Rules area, select a parent depot from the Select Parent Depot pick-
list (Figure 9).

13. Using the left/right arrows, move locations from the Available Good Stock Location(s)
to the Selected Location(s) (Figure 9).

14. In the Selected Location(s) area, use the Up, Down, Top, Bottom buttons to pos-
ition the locations in the desired order (Figure 9).

Sourcing Rules
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Sourcing Rules

Figure 9: Sourcing Rules Area

15. Create a rule sequence by clicking the Rule Sequence button located underneath the
Sourcing Rules area.

a. In the Rules Sequence dialog box, click a rule to select it (Figure 10).

b. Using Up, Down, Top, Bottom arrows to move the process to the desired order.

Figure 10: Rule Sequence Screen

16. Click the Set As Default button to set as the default rule (Figure 6).

17. Click the Save button to save the order.

18. In the Setup Sourcing Rules screen, click the Save and Close button to save the pro-
cess and return to the Sourcing Rules screen.

Cloning a Sourcing Rule
Cloning a Sourcing Rule creates a duplicate process of the original.

To clone a Sourcing Rule:

1. Select a rule to clone by checking the checkbox for the appropriate rule.

2. Click the Clone button in the Sourcing Rules screen.
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3. In the Setup Sourcing Rules screen, enter a new Process Name, Process ID, and
Description. You must change at least the Process Name and the Process ID to clone
a process.

4. Make any necessary changes in the General Info, Criteria & Mapping, and
Sourcing Rules areas by clicking on their respective tabs.

5. Click Quick Save to create the clone process.

6. When finished, click the Save and Close button to save the process and return to
the Sourcing Rules screen.

Deleting a Sourcing Rule

To delete a Sourcing Rule:

1. Check the Select checkbox for the appropriate process.

2. Click the Delete button.

3. Click OK in the warning dialog box to delete the process.

Sourcing Rules
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USING SERVICE PARTS & REVERSE LOGISTICS

Overview
For information about how to use Service Parts & Reverse Logistics, view the following sec-
tions:

Case

Returned Material Authorization (RMA)

Shipment

Fulfillment
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LOCATION (APL)

Overview
Locations are set up by your Administrator in the Depot & Stocking Locations section.
Contact your administrator for more information.
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CASE (SERVICE PARTS & REVERSE LOGISTICS)

Overview
This section includes information about creating a Case, adding Case lines, and Initiate
Return process.

Create a Case
To begin the Return Process, you must first create a Case for the product(s) and add Case
lines.

To create a Case:

1. Navigate to the Case home page.

2. In the Recent Cases area, click the New button.

3. In the Case Information area, enter the full or partial Contact Name or Account
Name in the appropriate text boxes.

4. If necessary, click the Lookup icon to initiate a search.

a. In the Lookup dialog box next to the Search field, click the Go button to search
for the name.

b. Select your Contact or Account name in the Search Results area to populate the
Account and Contact Name fields.

5.  In the Case Information area, select the Status, Priority, Type, and Case Origin
for the Case (Figure 1).
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Figure 1: Case Information Area

6. If required, enter the optional fields in these areas (Description Information,
Product Entitlement, Automatic Entitlement, and Optional).

7. Click the Save button to create the case.

Create Case Lines
After you create the case, add case lines.

To add Case Lines:

1. Click the New Case Lines button in the Case Lines area located below the System
Information area (Figure 2). You can also click/hover over the Case Lines [0] link,
and click the New Case Lines button in the Case Detail area.

Figure 2: New Case Line Button

Your Case number populates in the Case text box in the New Case Line screen.

2. In the Information area of the Case Line Edit window, enter information for the fol-
lowing text boxes: Product,Quantity, Problem Description, and the Serial Num-
ber List. Where available, use the Lookup feature to search any of these fields
(Figure 3).

Case (Service Parts & Reverse Logistics)
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Case (Service Parts & Reverse Logistics)

3. Select a line status from the Line Status picklist.

Figure 3: Case Line Information

Note: If you have more than one quantity, separate each serial number
with a semi-colon.

4. Click the Save button.
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The Case Lines Detail area populates with your product data (Figure 4).

Figure 4: Case Line Detail

Initiate Return
After you have created the Case lines, click the Initiate Returns button located under-
neath the Returns Process area in the ServiceMax Flow Wizard (SFW).

The next step in the process is to convert the Case to an RMA. Proceed to RMA section.

The Routing Rules are evaluated and the Routing engine generates a Route card for each
case line and creates RMA and RMA lines.

Your administrator configures the Entitlement Check, the Routing Rules, and determines
what criteria is used for RMA creation.

Case (Service Parts & Reverse Logistics)
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Case (Service Parts & Reverse Logistics)

Access and Permissions (Initiate Return)

Objects Read Create Update Delete

Case Yes

Case Line Yes Yes

Parts Order Yes Yes Yes

Parts Order Line Yes Yes Yes

Route Card Yes Yes Yes

Route Stop Yes Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

SFM Event Yes

Account Yes

Product Yes

IB Yes

Access and  Permissions (Initiate Return) 1095
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RETURNED MATERIAL AUTHORIZATION (RMA) FOR
(SERVICE PARTS & REVERSE LOGISTICS)

Overview
Returned Material Authorization (RMA) is a document that authorizes products or parts to
be returned to the manufacturer/repair center/warehouse.

There are two steps in the RMA process:

1. The RMA is initiated by a support center engineer or field engineer, along with instruc-
tions for handling the returned products. A copy of the RMA document is given to the
customer to be used as a reference in their shipment.

2. The RMA is processed or closed at the receiving location when the products actually
arrive.

Generating an RMA (Service Parts & Reverse Logistics)
After you create a Case with Case lines, the initiate Returns Process created the RMA, the
RMA lines, and the related Route Cards. The Returns Process evaluates Routing Rules,
checks for Entitlement, and generates the RMA.

Your administrator configures the Routing Rules and Entitlement check. Consult with your
administrator regarding questions and changes to these configurations.

The Returns Process occurs when you click the Initiate Process Entitlement & Route
button located underneath the Returns Process area in the ServiceMax Flow Wizard
(SFW). From there, an RMA is generated.

To generate an RMA for Service Parts & Reverse Logistics:

1. In the Case Line Detail area, click the Case link. (You can also hover over the Case
link to open the Case dialog box, and then click View).

2. In the Service Flow Wizard area, click the Initiate Process- Entitlement & Route
button.
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The engine calculates routes, checks for entitlement, creates a Route Card, and gen-
erates the RMA based on the configurations set up by your administrator.

Figure 1: RMA Created for Case

3. Click the RMA Number link to open the RMA.

The Parts Order Detail screen appears. In this screen, you can verify the Shipping
From and To locations of the product, which were determined by your administrator's
configuration when generating a Route Card.

Figure 2: Parts Order Detail

Returned Material Authorization (RMA) for (Service Parts & Reverse Logistics)
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Returned Material Authorization (RMA) for (Service Parts & Reverse Logistics)

4. At the top of the Parts Order Detail screen, click the Route Card link. The Route Card
Detail area shows the various locations and/or hubs the product will be delivered to
(Figure 3).

Figure 3: Route Card Detail

Note: Your administrator sets up the rules for the Route Card. If you have
any questions regarding the Routing Rules, consult your administrator.

5. In the Route Card Detail area, click the RMA link to view the RMA.

The Parts Order Detail screen updates the Service Flow Wizards area with the fol-
lowing Receiving Process buttons: Receive, Deliver, Pick, and Ship Confirm. The
Service Flow Wizards area will display that the part has come from the customer to
the depot.

Next, the depot must verify that they have received the product. See Processing
Receipts for an RMA (APL).

Processing Receipts for an RMA (Service Parts & Reverse
Logistics)
Once the part or product is received at the specified location or depot in an RMA, you must
process the receipts to complete the RMA cycle.

Processing Receipts for an RMA (Service Parts & Reverse Logistics) 1099



Access and Permissions (Receipt Console)

Object Read Create Update Delete

Parts Order Yes Yes

Parts Order Line Yes Yes Yes

Route Card Yes Yes Yes

Route Stop Yes Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

SFM Event Yes

Work Order Yes Yes

Product Stock Yes Yes Yes

Product Stock History Yes

Stock Serial Yes Yes Yes

Serial History Yes

Account Yes

Product Yes

Location Yes

To process a receipt for an RMA:

1. Click the Receive button located in the Service Flow Wizard area.

2. Scan or enter the Product Code.

3. Scan or enter the Serial Numbers (see figure below).

4. Click the Save button.

Returned Material Authorization (RMA) for (Service Parts & Reverse Logistics)
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Returned Material Authorization (RMA) for (Service Parts & Reverse Logistics)

5. The Receiving Process returns you to the RMA record.

Figure 4: Processing Received Product Items

Figure 5: Product Items Received

Note: The Serial Numbers for the selected line status has changed from
Expected to Received. The 'Received Now' area updates as well.

Delivering Received Products (RMA)
After units are received, they must be delivered to internal locations within the depot
where the next set of activities will occur. There must be at least one delivery rule, set up
by your administrator.

Delivering Received Products (RMA) 1101



Access and Permissions (Delivery Console)

Object Read Create Update Delete

Parts Order Yes Yes

Parts Order Line Yes Yes

Route Card Yes Yes

Route Stop Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

SFM Event Yes

Product Stock Yes Yes Yes

Product Stock History Yes

Stock Serial Yes Yes Yes

Serial History Yes

Account Yes

Product Yes

Location Yes

To deliver received products:

1. From the RMA, click the Deliver button.

The Delivery Console displays a table including the following: Line Number, Product
Code, Product, and Delivery Location. Your administrator may have configured
additional columns.

Note: After Receiving is complete, you might be directed to the Delivery
console. This is an Administrator configured option for the Receiving Pro-
cess.

Returned Material Authorization (RMA) for (Service Parts & Reverse Logistics)
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2. Select a location from the Delivery Location picklist (see Figure 6). The Delivery
Location represents the internal work or stocking centers where units are processed.

3. Click the Save button to complete the delivery of the product(s) to the selected loc-
ations within the depot. Once complete, you are returned to the RMA record.

Figure 6: Delivery Console

The 'Received' and 'Delivered' fields on the parts order line record(s) are updated dur-
ing the Receiving and Delivery process. The checkbox fields are unchecked by
default; when each process is completed, the corresponding checkbox is checked. Fig-
ure 7 represents an example of a Parts Order Lines related list showing the post deliv-
ery state of the 'Received' and 'Delivered?' fields.

Figure 7: Parts Received & Delivered

Note: If products have not reached the last Route Stop, they must be
shipped to the next stop on the Route Card. Otherwise, the products are
handled as determined by the applicable business process. If there is a
next stop available on the Route Card, the Forward Shipment engine gen-
erates a shipment order the next time it is scheduled to run.

See the Shipment and Work Order sections for more information.
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SHIPMENT (SERVICE PARTS & REVERSE LOGISTICS)

Overview
Your Administrator has set up criteria and schedules for Forward Shipment at each depot.
The Forward Shipment engine generates shipment orders based on the applicable Route
Cards. Each shipment order may either return product to the customer or ship to the next
depot in the configured route. There are two processes involved in processing a shipment
order, Pick and Move and Pack and Ship.

Note: The Fulfillment process also generates a shipment order when product
is allocated from a good stock location. See Fulfillment for more information.

Access and Permission (Forward Shipment)

Object Read Create Update Delete

Parts Order Yes Yes Yes

Parts Order Line Yes Yes Yes

Route Card Yes

Route Stop Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

Location Yes

Processing a Shipment Order (Pick and Move)
From the Delivery Location, someone must pick up the parts and ship them. You will
receive notification (email, fax, or phone) when the Shipment engine has completed For-
ward Shipment.
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To ship products to the next hub:

1. Click the Shipment Order number link in the Parts Orders area (Figure 1).

Figure 1: Shipment Order Number

2. If the products are ready for pick up, click the Pick button in the Service Flow Wizard
area.

3. In the Pick and Move console enter or scan the serial number(s) of the product(s) in
the text box titled, Enter Serial Number(s) here (Figures 2 and 3).

4. Click the Save button.

Access and Permissions (Pick and Move Console)

Object Read Create Update Delete

Parts Order Yes Yes

Parts Order Line Yes Yes Yes

Route Card Yes Yes

Route Stop Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

SFM Event Yes

Product Stock Yes Yes Yes

Product Stock History Yes

Stock Serial Yes Yes Yes

Serial History Yes

Account Yes

Product Yes

Location Yes

Shipment (Service Parts & Reverse Logistics)
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Figure 2: Pick Up Products From Delivery Location

Processing a Shipment Order (Ship Confirm)
The Pick Quantity field populates with the number of products received (Figure 3).

Figure 3: Picked Products Quantity

A screen displays and confirms the products that will be shipped.

Processing a Shipment Order (Ship Confirm) 1107



Access and Permission (Ship Confirm Console)

Object Read Create Update Delete

Parts Order Yes Yes

Parts Order Line Yes Yes

Route Card Yes Yes

Route Stop Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

SFM Event Yes

Product Stock Yes Yes Yes

Product Stock History Yes

Stock Serial Yes Yes Yes

Serial History Yes

Account Yes

Product Yes

Location Yes

5. Click the Ship Confirm button (Figure 4).

Figure 4: RP & SP Actions

6. From the Ship Confirm console, click the Save button.

Shipment (Service Parts & Reverse Logistics)
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When the products have been shipped, a checkmark displays in the Shipped checkbox in
the Parts Order Lines area (Figure 5).

Figure 5: Parts Order Lines (Products Shipped)

If the Location Type is designated as Supplier (a product is being shipped to a supplier),
an external RMA is generated.

Note: If a product is being shipped from one hub to another hub, an internal
RMA gets generated on Ship Confirm.

When shipping products between multiple hubs, repeat the steps in the following above
processes: Receive, Delivery, Pick, and Ship. When it reaches the last hub, the Out-
bound Routing rules engine sends the product(s) to the customer.

Before Outbound Routing can take place (sending the product to the customer), the sup-
plier must send the product to a hub via the Receive and Deliver processes.

Note: Each line is associated with an inbound Route card.

To receive and deliver products from a supplier to a hub:

1. Click the Receive button from the RP & SP Actions area (Figure 4).

2. From the Receiving screen, enter or scan the serial number(s) of the product(s) in the
text box titled, Enter Serial Number(s) here.

3. Click the Save button.

4. From the Delivery screen, the Delivery location displays for each product serial num-
ber.

Access and Permission (Ship Confirm Console) 1109



5. If necessary, select the Delivery Location from the picklist for each product.

6. Click the Save button.

The Parts Order Lines area indicates that the supplier has received the products and
delivered them to a hub.

Figure 6: Parts Order Lines (Received and Delivered)

7. From the picklist, set the Priority (based on the criteria in the Outbound Routing con-
figuration).

8. In the Parts Order window, click the Save button to save the external RMA.

Note: The Route Card changes from Inbound to Outbound. An Outbound Rout-
ing card is generated based on the Outbound Routing rules your administrator
has set up.

The next step in the process is to create a shipment order from the Master RMA to the cus-
tomer.

Forwarding Engine
Use Outbound Routing to configure when Outbound routes must be calculated from work
orders and external (reverse) RMAs. Use relevant attributes in work orders and RMAs that
indicate the repair cycle is complete and product is ready to make its return journey to cus-
tomer.

Shipment (Service Parts & Reverse Logistics)
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Access and Permissions

Object Read Create Update Delete

Parts Order Yes

Parts Order Line Yes Yes

Route Card Yes Yes Yes

Route Stop Yes Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

Work Order Yes Yes

Account Yes

Product Yes

Location Yes

External RMA

To create a Shipment Order for Outbound Routing:

1. If you haven't already done so, enter the Address fields in the Shipping From and
To areas in the Master RMA.

2. Click the Save button located in the Additional Information area.

3. Enter a date in the Expected Receipt Date field.

4. Click the Save button located in the Parts Order Detail area to generate a shipment
order (Figure 7).

5. Click the Shipment Order number link to view the details (Figure 7).

Figure 7: Parts Orders (Shipment Order Generated)
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The Shipping From and To area displays the Supplier location that the product was
shipped from and the customer location that the product will be shipped to.

Figure 8: Shipping From and To

After the shipment order is generated, you are ready for the Pick and Ship process, so
the product can be shipped to the customer via the Outbound Routing rules. The Out-
bound Routing rules are configured by your administrator.

6. Click the Pick button in the RP & SP area.

7. In the console, enter or scan the serial number(s) of the product(s) in the text box
titled, Enter Serial Number(s) here.

The Pick Quantity field populates with the number of products received.

8. Click the Save button.

The screen displays and confirms the products that will be shipped.

9. Click the Ship Confirm button.

10. From the Ship Confirm console, click the Save button.

When the products have been shipped, a checkmark displays in the Shipped checkbox in
the Parts Order Lines area.

After the products reach the supplier, it returns to the depot/hub, and then travels to the
customer for its final destination.

Outbound Routing can occur from the work order or external RMA. Your administrator
defines configuration for Outbound Routing. When the part reaches the repair center, you
can also generate a work order instead of an external RMA.

Shipment (Service Parts & Reverse Logistics)

1112 External RMA



FULFILLMENT (SERVICE PARTS & REVERSE LOGISTICS)

Overview
Use the Fulfillment option to define the sourcing and allocation rules for various types of ful-
fillment orders (repair or sales orders). Fulfillment processes can be then placed on applic-
able Service Flow Wizards.

Access and Permissions (Fulfillment Console)

Object Read Create Update Delete

Parts Order Yes Yes Yes

Parts Order Line Yes Yes Yes

ServiceMax Process Yes

ServiceMax Config Data Yes

Location Yes

Product Stock Yes Yes

Allocated Stock Yes Yes Yes

Account Yes

Product Yes

Fulfillment Process:

1. From the SFMWizard, invoke the Fulfillment process.
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The Fulfillment screen appears (Figure 1).

Figure 1: Fulfillment Screen

2. Click the Product line to populate the Stock Available area.

The Stock Available area indicates how many good stock locations have parts avail-
able for the Fulfillment process. If there is no good stock available, the Product line
highlights in pink.

3. If necessary, create product stock.

a. Click the Products link.

b. From Products Home, use the View picklist in the Product Views area to locate
your product.

c. Click the respective product link.

d. In the respective product screen, click the Product Stock link located at the top
of the screen.

e. In the Product Stock area, click the New Product Stock button.

f. Use the Lookup feature to find your location from the Product Stock Edit Inform-
ation area.

g. Update the Status to Available.

h. Indicate the quantity in the Qty field.

i. Click the Save button.

When stock is available, the Product line is highlighted in green indicating the stock at
the Fulfillment path is available.

Fulfillment (Service Parts & Reverse Logistics)
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4. Enter the quantity of product for each location in the Allocated text box (Figure 2).

Figure 2: Allocated Stock to Locations

5. Click the Save button.

6. The Fulfillment screen updates to indicate that the quantities have been fulfilled.

A shipment order gets generated.

7. Click the Back to Parts Order button.

The Fulfillment process is complete. The Shipping process begins the Pick and Move
process and the Ship Confirm process to ship the parts to the Shipment location.

Note: The Serial Number list is blank. You need to manually populate
stock serials, or you can use your existing inventory. The fulfillment serial
number is different from the expect serial number.

Access and Permissions (Fulfillment Console) 1115
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SERVICE PARTS & REVERSE LOGISTICS GLOSSARY

Overview
Glossary terms used in Service Parts & Reverse Logistics (listed in alphabetical order) are
in this section.

Terms

Depot & Stocking Locations

A module that enables administrators to manage locations relevant to Service Parts &
Reverse Logistics. Administrators can define unlimited levels above depots and unlimited
number of locations within a depot for (receiving, delivery, staging, and so on).

Delivery Rules

A module that configures how received products are delivered (distributed) within a depot.
The administrator sets up these rules for each depot.

Depot

The Depot location is a facility where units are handled during receiving, fulfillment, ship-
ping, and repair.

Good Stock

Products that are available to ship are referred to as "good stock."

Receiving Process

Use this option to define how various depots (hubs, warehouses or repair centers) would
process their inbound products and subsequently store/deliver them to their internal loc-
ations.
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Returns Process

Use this option to configure the behavior of customers initiating return of one or more
products from a Case. A typical Initiate Return process would consist of entitlement check,
route calculation, and RMA creation.

Routing Cards:

The Route Card indicates where the product is going. There could be various location or
hub stops.

Your administrator sets up the rules for the routing card. If you have any questions regard-
ing the rules associated with the products, consult your administrator.

Shipping Process

Use this option to define how various depots (hubs, warehouses, or repair centers) would
process outbound products from picking to shipping.

Service Parts & Reverse Logistics Glossary
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LOOKUP FORM FILL USE CASE

Overview
Lookup Form Fill is an SFM capability that enables information to be automatically copied
over to the record being edited when a Lookup field is updated by an end user. This sec-
tion provides additional information about the feature and a detailed administrative use
case.

Note: This functionality is available only when using ServiceMax SFM—it is not
available on custom VF pages or Salesforce page edits.

Role Based Use Case Examples
The Lookup Form Fill feature can be used for various roles as described in the following
examples:

Customer/Product Support: When a serial number is selected from the Lookup
feature, field values from installed products like Product Name, Primary Technician,
Contact, Location, and so on, can be automatically copied over to the record being
edited.

Field Service Technician: When a technician adds products serviced to a Work
Order and selects applicable warranty and warranty terms, warranty start date and
end date can be copied over to the record being edited. (For an illustrated example of
this use case, see Lookup Form Fill.)

Administrator: An administrator can configure a form fill attribute for warranty
information. In this example, the warranty information (start date/end date) auto-
matically populates with the form fill attribute your administrator has configured. For
an example of this use case, see the section below titled: Administrator Use Case.
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Benefits of Using Lookup Form Fill
The benefits of using this feature are listed below:

Accuracy: Eliminates duplicate data entry, which minimizes errors.

Speed: Enables field technicians to complete a service in three steps instead of six.

Efficiency: When records are edited, contextual information can be copied into the
record.

Administrator Use Case (Warranty)
The following scenario is an administrative use case example using Warranty information.
In this example, the administrator configures a Lookup form fill attribute for Warranty start
date and end date, so that this Warranty information will automatically populate into an
end user's record.

First, the administrator needs to define a Warranty map via the SFM Mapping module, and
then select the created map from the Lookup Form Fill Object Mapping picklist from
the SFM Transaction Designer.

To configure a Lookup Form Fill for Warranty information:

1. From the Home tab, click the ServiceMax Setup link located under the ServiceMax
Administration area located on the top left corner of the Home page.

2. In the ServiceMax Setup Home screen, click the Service Flow Manager button.

3. Click the SFM Mapping button.

4. Click the Go button.

Lookup Form Fill Use Case
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Lookup Form Fill Use Case

The Configure SFM Mappings screen displays as shown in the figure below.

Figure 1: Configure SFM Mappings Screen

5. In the Source Object picklist, select Product Warranty.

6. In the Target Object picklist, select Work Detail. The Configure SFM Mapping screen
displays the Field Map for Existing Records tab.

Administrator Use Case (Warranty) 1125



7. Click the New icon. The Field Map for Existing Records tab populates with available
fields for Product Warranty, as shown in the figure below.

Figure 2: Configure SFM Mapping (Field Map for Existing Records)

8. Select End Date as the value for theWarranty End Date field. See figure below.

Lookup Form Fill Use Case

1126 Administrator Use Case (Warranty)



Lookup Form Fill Use Case

9. Select Start Date as the value for theWarranty Start Date field.

Figure 3: Map Fields (Warranty End Date/Start Date)

10. In the Save this map as text box, enter a name for your map. When you click inside
the Input ID Here text box, it automatically populates with an underscore variation
of your map name.

11. Click Save to save your map.

Note: There are two options for choosing values: Click and select an

option from the Value picklist, or click and enter a value in the Value text
field.

Administrator Use Case (Warranty) 1127



Note: If you do not see Warranty End Date and Warranty Start Date as map
field options, you can create custom objects in Salesforce. For information on
how to create custom objects, view the Managing Custom Objects section of
the Salesforce help documentation: https://help.-
salesforce.com/htviewhelpdoc?id=dev_objec-
tedit.htm&siteLang=en_US.

After you have configured your map in the SFM Mapping module, go to the SFM Transaction
Designer & Docs module and update the Page Layout/Screen Designer tab as described in
the instructions below.

12. Click the Back To Setup Home button to return to the ServiceMax Setup Home
page. See figure above.

13. In the ServiceMax Setup Home screen, click the Service Flow Manager button.

14. Click the SFM Transaction & Docs Designer button.

15. Click the Go button.

16. In the SFM Transaction & Docs Designer screen, select the SFM transaction
Add/Edit Products Serviced and click the Screen Designer tab. See figure below.

17. Click inside the Product Warranty text box. See figure below.

Lookup Form Fill Use Case
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Lookup Form Fill Use Case

18. In the Object Mapping picklist, selectWarranty to Work Details.

Figure 4: Screen Designer

19. Click Save to save your settings.

20. Continue to edit your SFM transaction as needed.

See Also:

Lookup Form Fill section of Using the SFM Transaction Screen

Advanced Configuration: SFM Mapping Module

Advanced Configuration: SFM Transaction Designer (Lookup Form Fill section)

Administrator Use Case (Warranty) 1129
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